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Legal Notices
© 2023 Cherwell Software, LLC. All Rights Reserved.

Cherwell, the Cherwell logo, and mApp are trademarks owned by Cherwell Software, LLC and are registered
and/or used in the United States and other countries. ITIL® is a registered trademark of AXELOS Limited. All
other product or company names referenced herein are used for identification purposes only and are or may
be trademarks or registered trademarks of their respective owners.

Some or all parts of the mApp product are covered by one or more claims of U.S. Patent No. 9, 612, 825.

The information contained in this documentation is proprietary and confidential. Your use of this information
and Cherwell Software products is subject to the terms and conditions of the applicable End-User License
Agreement and/or Nondisclosure Agreement and the proprietary and restricted rights notices included therein.

You may print, copy, and use the information contained in this documentation for the internal needs of your
user base only. Unless otherwise agreed to by Cherwell and you in writing, you may not otherwise distribute
this documentation or the information contained here outside of your organization without obtaining Cherwell’s
prior written consent for each such distribution.

The Cherwell Software product suite includes:
• Cherwell Service Management
• Cherwell Asset Management
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CSM Features
CSM provides a large set of configurable features, including Dashboards, Reports, One-Step Actions, and
more.
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Adaptive Layouts
An Adaptive Layout is a design feature that allows a Form to adapt to different dimensions. Use Adaptive
Layouts to design Forms that provide optimal user experiences across a range of devices.
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About Adaptive Layouts
Understand how Adaptive Layouts equip you with the power of adaptive design so that your Forms can
be easily viewed from any device or client window.

Adaptive Design
An Adaptive Layout is a design feature that allows a Form to adapt to different dimensions. Use Adaptive
Layouts to design Forms that provide optimal user experiences across a range of devices.

Adaptive Forms snap to the width of the screen or client window at specific breakpoints, which are defined
in the Adaptive Layout properties. You can design many Adaptive Layouts for a single Form so that it
adapts to multiple screens and client windows of various sizes. For example, if your Users often submit
Incident Forms from laptops and tablets, you may design your Incident Form with two Adaptive Layouts:
one with the dimensions of a laptop screen and another with tablet dimensions. Refer to the adaptive
forms scenarios for detailed examples of the benefits of adaptive design.

The Adaptive Layout feature is automatically enabled for all Forms. When you open the Form Editor, the
system generates a base layout. You can then create, edit, or delete layouts within the editor using the
Adaptive Layout design features. Each Form must contain at least one layout to define the Form's
dimensions. If you do not wish to configure adaptive design for a Form, you can work within the base
layout without creating additional layouts.

Adaptive Layout Presets
If you plan to implement an Adaptive Layout with the same dimensions across many Views or Business
Objects, consider using an Adaptive Layout Preset to save design time. An Adaptive Layout Preset is a
pre-defined set of layout properties that is saved in the Adaptive Layout Preset Manager. When you
create or edit a layout, you can optionally select an Adaptive Layout Preset to populate the new layout's
properties with the pre-defined Preset properties. Refer to the adaptive forms scenarios or the procedures
to create or edit an Adaptive Layout for details.

Adaptive Layout Structure
The Adaptive Layout structure builds upon the current structure of Business Object Views to Forms.

For each Business Object View there is a default Form. For example, the Portal View for Incident utilizes
the Incident Portal Form. You can create as many Forms as you need for a given Business Object View,
but there is always one default Form.

For each Form, there is a base layout. The base layout is added automatically when you create a new
Form. You can change the name or other properties of the base layout by following the procedure to edit
an Adaptive Layout.

Note: If you upgrade your system to version 9.3.0 or later, your existing Forms are preserved and
become the base layouts.

The base layout can be deleted by following the procedure to delete an Adaptive Layout. Remember that
each Form must have a at least one layout, so a layout cannot be deleted if it is the only one within a
Form.

Related information
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Adaptive Forms Scenarios
Design Features for Adaptive Forms
Adaptive Layout Properties
Form Editor
Create an Adaptive Layout
Edit an Adaptive Layout
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Using Adaptive Layouts
Use Adaptive Layouts to enhance the user experience and streamline your design process for Forms.
Explore OOTB Adaptive Layouts and Adaptive Layout Presets to get started using the feature.

When working with Adaptive Layouts, Users can manually define a layout for a Form or select an
Adaptive Layout Preset to use pre-defined dimensions. Use Presets to create Adaptive Layouts with the
same properties for different Views or Business Objects.

When determining the number of Adaptive Layouts to design for a Form and the properties for each
layout, consider the Form's use cases. Ask yourself which devices your Users commonly use to interact
with the Form. For example, if your company issues devices to your Users, look up the dimensions for the
device model before you begin designing.

OOTB Adaptive Layouts
CSM provides an Out-of-the-Box (OOTB) Adaptive Layout for most Portal Forms that targets the screen
dimensions of handheld devices. Portal Forms that include the OOTB layout switch to the appropriate
layout at the defined breakpoints. Use the layout as-is, edit it, delete it, or create your own Adaptive
Layouts within the Form Editor. The default properties for the OOTB Adaptive Layout are defined below:

Property Value

Name Small

Width 414

Height 975

Minimum Width 9

Guide Color Red

OOTB Adaptive Layout Presets
CSM provides the following OOTB Adaptive Layout Presets, available in the Adaptive Layout Preset
Manager. Use these OOTB presets as-is, edit them, delete them, or create your own using the Form
Editor.

Property Value

Name Small

Description Portal form size for handheld devices

Width 414

Height 975

CSM 9.3.0 Features 32

CSM 9.3.0 Features



Property Value

Minimum Width 0

Guide Color Red

Property Value

Name Embedded

Description

Embedded form size for the Small parent layout

Note: Refer to Embedded Form Controls for
more information about the behavior of
Embedded Forms in Adaptive Layouts.

Width 361

Height 425

Minimum Width 0

Guide Color Red

Related information
Adaptive Layout Properties
Design a Form
Edit an Adaptive Layout
Edit an Adaptive Layout Preset
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Adaptive Forms Scenarios
Adaptive Forms leverage adaptive design so that your Users can quickly view and submit Forms from any
device or client window. Use these fictional scenarios to learn how adaptive Forms can improve your user
experience and streamline your design process.

Scenario: Optimizing the Incident Portal Form for Tablets
Curtis and Christine work at the River T Corp. organization:

• Christine is the Design Team Lead who is responsible for visualizing and implementing the overall
design of the River T. Corp Portal. She assigns design tasks to her team members.

• Curtis is a Content Designer who reports to Christine.

River T Corp. recently rolled out 500 tablets for their sales team. In the weekly design team meeting,
Christine discusses feedback she received regarding the Incident Portal Form. When accessing the Form
on the tablet in portrait orientation, the Customer is required to scroll vertically and horizontally in order to
complete all of the required Fields and submit the Incident. To improve the user experience, Christine
assigns a task to Curtis to design a new Adaptive Layout for the Incident Portal Form.

Curtis starts by converting the tablet's screen resolution to device-independent pixels (DIP). The screen
resolution is 1200 x 1920 physical pixels with approximately 283 dots-per-inch (DPI). Using the DIP
conversion formula, Curtis determines that the tablet's screen resolution is 600 x 960 device-independent
pixels.

With these measurements confirmed Curtis is ready to begin designing the layout so that it is optimized
for the tablet screen. Other Forms may also need to be optimized for the 600 x 960 screen size, so
Christine directs Curtis to save the new layout as an Adaptive Layout Preset. As the design team
optimizes other Forms for tablets, they can use the Adaptive Layout Preset to automatically populate the
properties for each layout.

Curtis opens CSM Administrator and creates a new Blueprint. He selects the Incident Business Object
and changes the current View to Portal Default. He clicks Edit Form to open the Form Editor.

To create a new Adaptive Layout, Curtis clicks the Create New button  and defines the following
Adaptive Layout properties:

Property Value

Name Tablet Layout

Description Use this Layout to design Forms that are optimized
for the tablet screen in portrait orientation.

Width 600

Height 960

Icon

Guide Color Yellow
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With the dialog window still open, Curtis clicks Save As Preset. The set of properties is saved in the
Adaptive Layout Preset Manager so that it can be reused for other Forms.

Curtis clicks OK and then makes design changes in the Form Editor so that all Fields fit within the Tablet
Layout boundaries. The changes that Curtis makes to the Tablet Layout do not affect the other Adaptive
Layouts that already exist for the Form. Christine confirms the changes and gives Curtis permission to
publish the Blueprint. When a member of the sales team brings up the Form, CSM recognizes the display
size and automatically renders the Tablet Layout for an optimal user experience.

Scenario: Optimizing Additional Forms for Tablets Using an Adaptive Layout Preset
The River T. Corp sales team is impressed with the Incident Portal Form as it is displayed on their tablets,
so they ask Christine to similarly optimize the Knowledge Article Portal Form.

Christine assigns a task to Curtis to design a new Adaptive Layout for the Knowledge Article Portal Form
with identical dimensions to the Tablet Layout that he created for the Incident Portal Form. Curtis will save
time on this task by using the Adaptive Layout Preset that he defined earlier.

To start, Curtis creates a new Blueprint. He opens the Knowledge Article Form using the Portal Default
View in the Form Editor. Then, he clicks the Create New button  to create a new layout. The Create
Layout dialog opens.

In the dialog, Curtis clicks the Ellipses button  to select an Adaptive Layout Preset. The Adaptive
Layout Preset Manager opens. He navigates to the folder where he saved the Tablet Layout, selects it,
and clicks OK. The Create Layout dialog is automatically populated with the Preset properties, which
were defined to match the tablet screen dimensions in portrait orientation.

Curtis clicks OK and then makes design changes in the Form Editor so that all Fields fit within the Tablet
Layout boundaries. The changes that Curtis makes to the Tablet Layout do not affect the other Adaptive
Layouts that already exist for the Form. Christine confirms the changes and gives Curtis permission to
publish the Blueprint. When a member of the sales team brings up the Form, CSM recognizes the display
size and automatically renders the Tablet Layout for an optimal user experience.

Related information
Adaptive Layout Properties
Blueprints
Create an Adaptive Layout
Create an Adaptive Layout Preset
Defining Adaptive Layout Properties Using Device-Independent Pixels
Form Editor
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Managing Adaptive Layouts
Manage multiple Adaptive Layouts for a single Form, and utilize the Adaptive Layout Preset Manager to
reuse the same properties across multiple Forms.

Adaptive Layouts are managed using the Form Editor. Adaptive Layout Presets are managed using the
Adaptive Layout Preset Manager.

Use the Form Editor to:

• Create an Adaptive Layout

• Edit an Adaptive Layout

• Delete an Adaptive Layout

Use the Adaptive Layout Preset Manager to:

• View an Adaptive Layout Preset

• Create an Adaptive Layout Preset

• Edit an Adaptive Layout Preset

• Delete an Adaptive Layout Preset

• Search for an Adaptive Layout Preset

• Organize an Adaptive Layout Preset

• Copy an Adaptive Layout Preset
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Design Features for Adaptive Forms
Tour the Adaptive Layout design features in the Form Editor.

1. Layout selector: Toggles to the specified layout when you select it from the drop-down of available1. 
layouts.

2. Create, Edit, and Delete buttons: Opens the Create Layout dialog box when you click the Create2. 

New button . Opens the Edit Layout dialog box when you click the Edit button . Opens the
Delete Layout dialog box when you click the Delete button .

3. Visual guide bar: Shows the display name and the width for each of the configured layouts.3. 
Toggles to the selected layout when you click anywhere in the guide color for the layout. A triangle
appears next the name of the layout that is currently selected. Right-click anywhere in the guide
color to edit the layout's properties or to delete it. Define the guide color for a layout by editing its
properties.

4. Horizontal ruler: Indicates width in device-independent pixels. Use this ruler to measure the point4. 
where a horizontal scroll bar will appear. For example, for a layout with a width of 1200 DPI, a
horizontal scroll bar will appear on devices with screen widths that are 1199 DPI or smaller unless
you create additional layouts.
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5. Vertical ruler: Indicates height in device-independent pixels. Use this ruler to measure the point5. 
where a vertical scroll bar will appear. For example, for a layout with a height of 800 DPI, a vertical
scroll bar will appear on devices with screen heights that are 799 DPI or smaller unless you create
additional layouts.

6. Layout boundaries: The width boundary indicates the width of the layout. The height boundary
indicates the height of the layout. The space beyond the layout boundaries is grey to indicate that
Fields in that space will not render on the layout.

7. Status bar: Shows the properties for the selected layout, including display name, icon, guide color,7. 
and size.
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Managing Controls in Adaptive Layouts
Understand how controls behave within and between Adaptive Layouts.

Control Placement
When you create a new layout, the controls from the currently selected layout will be copied to the new
layout.

Controls are added and removed exclusively in existing layouts. When you add a new control to a layout,
the control is not added to the Form's other layouts. Similarly, when you remove a control from one layout,
it will not be removed from the others.

You may copy and paste controls between layouts. A pasted control will be placed at the same position as
in the original layout, and this may result in the control being placed outside of the layout boundaries.

CAUTION: The entire control must be positioned within the layout boundaries to render. Controls
that overlap layout boundaries will not display for Users.

Control Z-Ordering
Control z-order is unique to each layout. If you set the z-order on one layout, it will not affect the z-order
for the Form's other layouts.

Embedded Form Controls
Embedded Forms can leverage adaptive design if you have created Adaptive Layouts for the Embedded
Form. For example, if multiple layouts have been created for the Task Form, and then that Form is
embedded in an Incident Form, the embedded Task Form will switch to the appropriate Task layout when
the Incident Form switches to a different Incident layout.

The layout for the Embedded Form is determined by the size of the Embedded Form Control.

Tab Order
Tab order is unique to each layout. If you set the tab order on one layout, it will not affect the tab order for
the Form's other layouts.
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Adaptive Layout Properties
Specify Adaptive Layout properties to define the size and descriptive elements of the Layout.

Property Description Notes

Use Preset
Layout

For an Adaptive Layout, you may optionally select
a Preset to populate the layout's properties with
the Preset properties.

Use the Adaptive Layout Preset
Manager to select an existing
Preset.

Name
For an Adaptive Layout or a Preset, this is the
name of the layout that will be displayed in the
guide bar, status bar, and Preset Manager.

This property is required.

Description
For an Adaptive Layout or a Preset, this is a
description of the layout. This field is blank by default.

Minimum
Width

For an Adaptive Layout or a Preset, this is the
breakpoint at which a horizontal scroll bar will
appear for Users.

Define using device-independent
pixels.

Width
For an Adaptive Layout or a Preset, this is the
breakpoint at which the Form will snap to another
Layout (when one exists).

Define using device-independent
pixels.

Height
For an Adaptive Layout or a Preset, this is the
height at which a vertical scroll bar will appear for
Users.

Define using device-independent
pixels.

Icon
For an Adaptive Layout or a Preset, this is the
image that will be displayed in the status bar and
Preset Manager.

Use the Image Manager to select
an existing image or import a
new one.

Guide color
For an Adaptive Layout or a Preset, this is the
color that will represent the layout in the guide bar.

Save as
Preset

For an Adaptive Layout, after specifying the
properties, click this button to save the layout as a
Preset.

The new Preset will be saved in
the Adaptive Layout Preset
Manager.

The Save as Preset button is
disabled until you give the Preset
a unique name.

After saving the layout as a
Preset, you cannot edit the
Preset properties from the Create
Layout dialog. Refer to Edit an
Adaptive Layout Preset.

Related information
Adaptive Layout Preset Manager
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Create an Adaptive Layout
Create an Adaptive Layout Preset
Image Manager
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Defining Adaptive Layout Properties Using Device-
Independent Pixels

Understand the role of device-independent pixels in designing adaptive Forms that look the same across
different devices and screen resolutions, and learn how to convert between physical pixels and device-
independent pixels.

Device-independent pixels (DIP) is an artificial unit of measurement that measures the logical space
consumed by content on a display. Cherwell utilizes device-independent pixels to define UI elements for
Dashboards and Forms. When the Dashboard or Form is rendered on a specific device, the browser
gathers information about its DIP dimensions and renders the Dashboard or Form appropriately for the
device's pixel density. This ensures that the visual elements retain their logical sizes across many devices
with different densities.

When designing Adaptive Layouts you must define the height and width of a layout using device-
independent pixels. Screen resolution specifications are usually given in physical pixels, so you may need
to look up the DIP measurements for your device or perform the conversion to DIP yourself before you
begin designing. With some basic device specifications you can easily convert between physical pixels
and device-independent pixels. The conversion formula is slightly different for Android and iOS operating
systems. To start, understand the following terms:

• A physical pixel (px) is defined as a single point of programmable color on a display. Physical
pixels have different sizes depending on the display's resolution: high-resolution screens have a
greater number of relatively small physical pixels while low-resolution screens have a smaller
number of relatively large physical pixels.

• Dots-per-inch (DPI) is also called pixels-per-inch. This measurement indicates the number of
physical pixels that fit in one logical inch on a display. High-resolution screens have smaller physical
pixels, so they will contain more pixels per logical inch than low-resolution screens.

• Density measures the magnitude of pixel density on a display. This measurement is usually
rounded to the nearest half or whole number. One density-independent pixel is equivalent to one
physical pixel on a device with the density 1.0 (also called medium-density or MDPI). Density-
independent pixels are scaled proportionally on higher- or lower-density screens so that one DIP on
a screen with the density 2.0 (XHDPI) encompasses four physical pixels (two across and two down).

The following table shows the measurements for a sample device:

Screen resolution
(physical pixels) Dots-per-inch Density Screen resolution (device-

independent pixels)

1080 x 1920 424 3.0 (XXHDPI) 360 x 640

Convert to DIP for Android Devices
Follow the steps below to convert a device's screen resolution from physical pixels to device-independent
pixels:

1. Verify that you know the screen resolution (in physical pixels) and the DPI measurement for the
device. This information can usually be found in the device specifications.
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2. Use the following conversion formula for Android devices:
px = DIP * (DPI / 160)
For example, using the measurements for the sample device, above:

px = 1 DIP * (424 DPI / 160)

3. Find the result.
In the example, one DIP on a 424 DPI device is equivalent to 2.65 physical pixels.

4. Round this result to the nearest half or whole number to get the density of the device.
For the sample device, the density is 3.0.

5. Divide the screen resolution measurements by the density to convert the measurements to device-
independent pixels.
For example, 1080 becomes 360 and 1920 becomes 640. The sample device's screen resolution is
360 x 640 device-independent pixels.

Convert to DIP for iOS Devices
iOS devices also utilize device-independent pixels, but you may see them referred to as points.
Remember that points and DIP both refer to device-independent pixels. For iOS devices, follow the same
procedure as above using the following conversion formula:

px = points * (DPI / 163)
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Create an Adaptive Layout
Design Forms to adapt to different screen sizes by creating Adaptive Layouts in the Form Editor.

1. Open the Form Editor.

2. In the Form Editor toolbar, click the Create New button .
The Create Layout dialog opens.

3. Define the layout properties.

Tip: Click the Ellipses button to select an Adaptive Layout Preset for the layout. This will
populate the layout's properties with pre-defined properties.

Remember: The height and width properties must be defined in device-independent pixels.
Refer to Defining Adaptive Layout Properties Using Device-Independent Pixels for more
information.

4. Optional: Click Save as Preset to save the layout properties as a Preset in the Adaptive Layout
Preset Manager.
Perform this step if you plan to create layouts for other Forms that utilize the same properties.

5. Click Save.
The layout appears in the Editor as the currently selected layout.

Related information
Adaptive Forms Scenarios
Adaptive Layout Properties
Form Editor
Managing Controls in Adaptive Layouts
Open the Form Editor
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Edit an Adaptive Layout
Change the properties of an existing Adaptive Layout.

1. Open the Form Editor.
2. Select a layout to edit from the guide bar or the layout selector.

3. Click the Edit button .
The Edit Layout dialog opens.

4. Edit the layout properties.

Tip: Click the Ellipses button to select an Adaptive Layout Preset for the layout. This will
populate the layout's properties with pre-defined properties.

Remember: The height and width properties must be defined in device-independent pixels.
Refer to Defining Adaptive Layout Properties Using Device-Independent Pixels for more
information.

The Save button is activated when you edit one or more properties.
5. Optional: Click Save as Preset to save the layout properties as a Preset in the Adaptive Layout

Preset Manager.
Perform this step if you plan to create layouts for other Forms that utilize the same properties.

6. Click Save.
The layout is displayed as the currently selected layout with the new properties.

Related information
Adaptive Layout Properties
Form Editor
Open the Form Editor
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Delete an Adaptive Layout
Delete an Adaptive Layout to remove it from the Form Editor.

Note: If the Form utilizes only one layout, that layout cannot be deleted.

1. Open the Form Editor.
2. Select a layout to delete from the guide bar or the layout selector.

3. Click the Delete button .
The Delete Layout dialog opens.

4. Click OK.
The selected layout is deleted and no longer appears in the Editor.

Related information
Form Editor
Open the Form Editor
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Adaptive Layout Preset Manager
Use the Adaptive Layout Preset Manager to create, edit, and delete Adaptive Layout Presets.

To open the Adaptive Layout Preset Manager:

• From the Blueprint Editor menu bar in CSM Administrator, click Form>Adaptive Layouts>Manage
Presets.

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.
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4. Manager tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.

5. Main Pane:

Displays items by View (Icon, List, or Details (Grid) and lists search results when a Search is run.

Related information
Adaptive Forms Scenarios
Blueprint Editor Menu Bar
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Create an Adaptive Layout Preset
Create an Adaptive Layout Preset to save a set of properties that can be re-used to define new layouts.

1. Open the Adaptive Layout Preset Manager. Form > Adaptive Layouts > Manage Presets

2. Click the Create New icon .
The Create Preset dialog opens.

3. Define the Preset properties.

Remember: The height and width properties must be defined in device-independent pixels.
Refer to Defining Adaptive Layout Properties Using Device-Independent Pixels for more
information.

4. Click Save.
The Preset appears in the list of configured Presets.

Related information
Adaptive Forms Scenarios
Adaptive Layout Preset Manager
Adaptive Layout Properties
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Edit an Adaptive Layout Preset
Edit an Adaptive Layout Preset to change the Preset's saved properties.

1. Open the Adaptive Layout Preset Manager. Form > Adaptive Layouts > Manage Presets
2. From the list of Presets, select the Preset to edit.

3. Click the Edit icon 
The Edit Preset dialog box appears.

4. Edit one or more properties.
5. Click Save.

The Preset appears with the new properties in the list of configured Presets.

Related information
Adaptive Layout Preset Manager
Adaptive Layout Properties
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Delete an Adaptive Layout Preset
Delete an Adaptive Layout Preset to erase its saved properties and remove it from the Adaptive Layout
Preset Manager.

1. Open the Adaptive Layout Preset Manager. Form > Adaptive Layouts > Manage Presets
2. From the list of Presets, select the Preset to delete.

3. Click the Delete icon 
The Delete Preset dialog box appears.

4. Click Yes.
The Preset is removed from the list of configured presets.

Related information
Adaptive Layout Preset Manager
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Approvals
An Approval is a defined process that automates, regulates, and tracks approving/denying/abstaining
content by one or more designated Users or Teams.
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About Approvals
Use Approvals to request approval for items within a Major Business Object and automatically perform
Actions based on whether designated Approvers approve, deny, or abstain. For example, use an
Approval to approve:

• A Knowledge Article before it can be published.

• A Service Request for new hardware.

• An expense.

An Approval is a Supporting Business Object that can be used in conjunction with a Major Business
Object (ex: When a Knowledge Article reaches the Approval phase, an Approval tab is displayed in the
Form Arrangement of the record). Approvals can be added to any Major Business Object and are made
up of one or more Approval Blocks. Each Approval Block consists of:

• A Trigger Condition: Condition that initiates an Approval (ex: Record reached a specific status).

• Approvers: One or more Users or Teams that provide approval, and the number/percentage of
Users or Team members who must approve a request.

• Actions: One or more Actions that take place when an Approval is approved, denied, or expired (ex:
Change a record status, put a record in a Queue, initiate a One-Step that sends an e-mail
notification, etc.).

You can use multiple dependent Approval Blocks to define multi-level Approvals (different triggers,
Approvers, and Actions for different situations within the same Business Object). For example, an
Emergency Change Request might require that all Emergency Change Board members approve the
change, whereas a regular server change might require only the approval of a hardware Team member.

CSM provides several OOTB Approvals. Use these OOTB Approvals as-is, edit them, or create your own
using the Approval Editor (accessed from within a Blueprint in CSM Administrator).
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Approvals Good to Know
• Approvers can provide approval in the CSM Desktop Client or Browser Client by accessing the

Approval form in the Form Arrangement of a Business Object record.

• Approvals are Supporting Business Objects that are configured in a Blueprint in CSM Administrator.
Approvals are used in conjunction with Major Business Objects.

• Use the Approval Editor in CSM Administrator to add Approvals to a Major Business Object.

• Use the Approval Block Editor to create and edit Approval Blocks. An Approval consists of one or
more Approval Blocks.

• The Approval Editor is opened from the Object Manager (within a Blueprint in CSM Administrator)

• The Approval Block Editor is opened from within the Approval Editor.

• You can use multiple dependent Approval Blocks to define multi-level Approvals (different triggers,
Approvers, and Actions for different situations within the same Business Object). For example, an
Emergency Change Request might require that all Emergency Change Board members approve the
change, whereas a regular server change might require only the approval of a hardware Team
member.

• CSM provides several OOTB Approvals. Use these OOTB Approvals as-is, edit them, or create your
own using the Approval Editor (accessed from within a Blueprint in CSM Administrator).

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to Business Object data and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, refer to Define Business Object Rights.
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Using Approvals
When working with Approvals, Users can:

• Complete the Approval form.

CSM provides the following OOTB Approvals. Use these OOTB Approvals as-is, edit them, or create your
own using the Approval Editor (accessed from within a Blueprint in CSM Administrator).

• Change Approvals (for Emergency Changes and Normal Changes)

• Incident Approvals (for New Employee Requests)

• Knowledge Approvals (before a Knowledge Article is published)
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Approval Form
Approvals require approvers to decide how to respond to a request. In the CSM Desktop Client or
Browser Client, Approvals are responded to using an Approval Form in the Form Arrangement of a
record.

The OOTB Approval form looks similar to the following. It can be opened several ways in the CSM
Desktop Client or Browser Client:

• From an Approval e-mail, click the link to the Approval form.

• In the Approvals tab of a Major Business Object's Form Arrangement, open the Approvals form:
◦ Double-click an existing Approval in the Grid.

◦ On the Form Arrangement toolbar, click View>Form View.

◦ On the Form Arrangement toolbar, click New Approval to open a new Approval form.

1. Approver Name: Name of the required Approval User(s).

2. Approval Team: Name of the required Approval Team(s).

3. Deadline: Date/time by which the Approval must be submitted. If an Approver does not respond by
the deadline, he is considered to have abstained.

4. Response:
◦ Approve: Approve the request.

◦ Deny: Deny the request.

◦ Abstain: Refrain from approving/denying the request.

5. Details: Additional information about the Approval (ex: Approve Emergency Change Request to
begin implementing).

6. Comments: Additional information/explanation regarding the Approval.

CSM 9.3.0 Features 56

CSM 9.3.0 Features



Managing Approvals
Approvals are managed using the Approval Editor and the Approval Block Editor.

Use the Approval Editor to:

• Add an Approval to a Business Object.

• Open the Approval Block Editor.

• Copy an Approval Block.

• Delete an Approval Block.

• Define Approval E-mail Settings.

Use the Approval Block Editor to:

• Create/edit an Approval Block.

Use the Delete Approvals task in the Structure area of the Object Manager to delete all Approvals from a
Business Object.
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Approval Editor
The Approval Editor is a tool within a Blueprint in CSM Administrator that allows you to manage (create,
edit, and delete) Approvals. Use the Approval Editor to perform the following Approval operations:

• View: View a list of defined Approvals.

• Add: Use to access the Approval Block Editor, and then create an Approval Block. Approval Blocks
are listed in the Approvals section of the Approval Editor.

• Edit/Delete: Use to configure Approval Blocks to meet your requirements.

• Copy: Use an existing Approval Block as a starting point or "template" for a similar Approval.

• Organize: Use the up/down arrows   to change the order of selected Approval Blocks.

• Enable E-mail Notifications: Use to define Approval E-mail Settings.

• Define Advanced Options: Use to define an Approval configuration for a Business Object.

There are several ways to open the Approval Editor:

• In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

• In the Object Manager, click a Major Business Object in the Object tree, and then click the Add
Approval Support task in the Structure area.
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Open the Approval Editor
There are several ways to open the Approval Editor:

• In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

• In the Object Manager, click a Major Business Object in the Object tree, and then click the Add
Approval Support task in the Structure area.
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Approval Block Editor
The Approval Block Editor is a tool accessed from within the Approval Editor (in a Blueprint in CSM
Administrator) that allows you to create and edit Approval Blocks. An Approval Block is a defined set of
trigger conditions, Approvers, and Actions for an Approval. An Approval for a Business Object contains
one or more Approval Blocks. You can use multiple dependent Approval Blocks to define multi-level
Approvals (different triggers, Approvers, and Actions for different situations within the same Business
Object). For example, an Emergency Change Request might require that all Emergency Change Board
members approve the change, whereas a regular server change might require only the approval of a
hardware Team member. Use the Approval Block Editor to define the components of an Approval Block.

There are several ways to open the Approval Block Editor:

• In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If you are working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

• In the Object Manager, click a Major Business Object in the Object tree, and then click the Add
Approval Support task in the Structure area.

• In the Approval Editor, click the Approvals page, and then click Add.
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Each Approval Block contains the following components:

1. Name: Display name to use within CSM.

2. Condition: Event that initiates the Approval Block.

3. Approver(s): User(s) or Team that provides approval and the number/percentage of Users or Team
members who must approve a request.

4. Action(s): Operation that takes place when an Approval is approved, denied, or expired.
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Open the Approval Block Editor
There are several ways to open the Approval Block Editor:

• In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If you are working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

• In the Object Manager, click a Major Business Object in the Object tree, and then click the Add
Approval Support task in the Structure area.

• In the Approval Editor, click the Approvals page, and then click Add.
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Add an Approval to a Business Object
Use the Object Manager and Approval Editor to add Approvals to a Major Business Object. When you
add Approvals, you define:

• A Relationship between the Major Business Object and the Approval Business Object (Supporting
Object): Allows data to be shared between the Major Business Object and Approval Business
Object (typically, an Approval is displayed as a tab in the Form Arrangement of a Major Business
Object).

• An Approval Block ID field: Holds the ID of the Approval Block that should be used.

• An Approval configuration: Associates an Approval Relationship and Approval Block ID field with a
Major Business Object, and allows you to define options that determine when Approvals are
generated.

After adding Approvals to a Business Object, use the Approval Editor and the Approval Block Editor to:

• Define Approval E-mail Settings: An e-mail that is automatically sent to Approver(s) when approval
is needed.

• Create an Approval Block: A set of trigger conditions, Approvers, and Actions for an Approval.

• Define Multi-Level Approvals: Multiple dependent Approval Blocks that allow you to define different
triggers, Approvers, and Actions for different situations within the same Business Object.

Note: CSM provides several OOTB Approvals. Use these OOTB Approvals as-is, edit them,
or create your own using the Approval Editor (accessed from within a Blueprint in CSM
Administrator).

To add an Approval to a Business Object:

1. Define a Relationship between the Major Business Object and the Supporting Approval Business
Object (using the Relationship Editor).

2. Define an Approval Block ID field (using the Business Object Editor).

3. Define Approval Configuration for a Business Object (using the Approval Editor).

4. Define an Approval E-mail (using the Approval Editor).

5. Create an Approval Block (using the Approval Block Editor).

6. Define Multi-Level Approvals (using the Approval Block Editor).
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Define an Approval Relationship
Use the Relationship Wizard to define a Relationship between a Major Business Object and the Approval
Object (Supporting Object). A Relationship is required to add an Approval to a Business Object. An
Approval Relationship allows the Major Business Object and Approval Object to share data (typically, an
Approval is displayed as a tab in the Form Arrangement of a Major Business Object).

Note: The Relationship Wizard is available in the Relationship Editor (accessed from within the
Object Manager in a Blueprint).

To define an Approval Relationship:

1. Open the Relationship Editor.

2. Click the Wizard button.

3. Select Approval as the Child Business Object.

4. Select the Many Approvals radio button to allow the Major Business Object to have multiple
Approvals.

5. Select whether Approvals should have a Relationship back to the parent object:
◦ Yes (Recommended): Select this radio button to create a reverse Relationship from Approvals

to the parent object.

◦ No: Select this radio button to not create a reverse Relationship from Approvals to the parent
object.

Tip: We recommend that you create a reverse Relationship so that you can access
Fields in the Major Business Object from the Approval Object.

6. Select the Many [Major Business Objects] radio button to allow Approvals to belong to multiple
Major Business Objects.

Note: In effect, a many-to-many Relationship is created between Approvals and the Major
Business Object. Many-to-many Relationships use join tables to link Business Objects
together. By default, the standard join table is used; however, you can edit this in the
Relationship Properties window after creating the Relationship. For more information, refer
to Define Link Properties for a Relationship.

7. Select Full-Text Search options for the Relationship:
a. Select whether to search Approvals when the Major Business Object and its related items are

searched:
◦ Yes: Select this radio button to search Approvals when the Major Business Object and its

related items are searched.

◦ No: Select this radio button to not search Approvals when the Major Business Object and
its related items are searched.

b. Select whether to search the Major Business Object when Approvals and its related items are
searched.
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◦ Yes: Select this radio button to search the Major Business Object when Approvals and its
related items are searched.

◦ No: Select this radio button to not search the Major Business Object when Approvals and
its related items are searched.

8. Provide a name and description for the Relationship and the reverse Relationship. This is how the
Relationship is identified in the Relationship Editor and throughout the system.

9. Review the Summary page.

10. Click Finish.10. 

The Relationship is added to the Business Object and can be accessed in the Relationship Editor.

11. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define an Approval Block ID Field
Use the Business Object Editor to define an Approval Block ID field to indicate which Approval Block to
use for a Business Object. This Field is stored in the Major Business Object that owns the Approvals, and
holds an internal ID that the system associates with an Approval Block. An Approval process can contain
multiple Approval Blocks, and this Field contains the information the system needs in order to know which
set of Approvals to use (ex: A hardware change might require one set of Approvers and a software
change might require a different set of Approvers).

Good to know:

• While you can customize the name of the Field, the convention is to name it Approval Block ID.

• The Business Object Editor is available in the Object Manager (accessed from within a Blueprint in
CSM Administrator).

To define an Approval Block ID Field:

1. Open the Business Object Editor for the Business Object to which you are adding Approvals.

2. Click the New Field button .

3. Define general information for the Approval ID field:
◦ Name: In the Name column, provide a name for the Field (ex: Approval Block ID).

◦ Type: In the Type column drop-down, select Text.
◦ Size: In the Size column drop-down, select 42. This is the exact length of the internal ID.

4. (Optional) Click the Field Properties button to open the Field Properties window, and then edit
general information and define additional properties for the Field.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Approval Configuration for a Business
Object

Use the Advanced page of the Approval Editor to define the Approval configuration for a Business Object.
This is typically done after defining an Approval Relationship and Approval Block ID field, but before
creating Approval Blocks. When you define an Approval configuration for a Business Object, you select:

• An Approval Relationship.

• Fields in the Major Business Object to hold the Approval description and Approval ID.

• Options to determine when Approvals are generated.

Note: The Approval Editor is available in the Object Manager (accessed from within a
Blueprint in CSM Administrator).

To define the Approval Configuration for a Business Object:

1. Open the Approval Editor.

2. Click the Advanced page.

3. Define the Approval configuration for the Business Object:
a. Relationship Holding Approvals

Select the Approval Relationship you created.

Note: If no Relationships are available in the drop-down, ensure that you defined an
Approval Relationship. Also, ensure that the Business Object has Approval as a
general attribute (defined in Advanced properties; no value is needed).

b. Field Holding Description
Select the Field in the Major Business Object that will contain the description of the Approval.

Note: If you are using OOTB content, this Field is called Description.

c. Field Holding ID of Selected Approval

Select the Approval Block ID field you created.

d. Generate Approvals
Select an option for initiating the Approval to be created:

◦ When trigger condition is true: Select this option to generate Approvals based on the
trigger condition.

◦ When record is saved: Select this option to generate Approvals when the Major Business
Object record is saved and the trigger condition occurs.

4. Click OK.4. 
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5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define an Approval E-mail
Use the Approvals page of the Approval Editor to define an e-mail that is sent to Approver(s) when
approval is needed (using a One-Step). CSM provides an OOTB Approval e-mail that can be customized
to fit the needs of your Approval process.

Note: The Approval Editor is available in the Object Manager (accessed from within a Blueprint in
CSM Administrator).

To define an Approval e-mail:

1. Open the Approval Editor.

2. Click the Approvals page.

3. Select the Notify Approver by E-mail check box below the Approvals list, and then click the Edit
button.

4. Edit the e-mail contents:

◦ Provide text. Click the selector button  (or right-click in the contents area) to insert Tokens
(Fields, Expressions, system functions, Stored Values, and variables) directly into the text.

5. Define additional e-mail properties:
◦ Attach to current <Business Object> History: Select this check box to attach the e-mail to the

current record (ex: Current Incident, current Problem, etc.) as a Journal - Mail History record.

◦ Attach to recipients: Select this check box to attach the e-mail to the Customer Records
associated with recipients in the To, Cc, or Bcc lines. Then, click the Options button to define
which Customer Records to attach the e-mail to.

Note: For more information about e-mail history options, refer to Define Where to
Store E-mail History.

6. Click OK.6. 

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Create/Edit an Approval Block
Use the Approval Block Editor (accessed from within the Approval Editor) to create Approval Blocks. An
Approval Block is a defined set of trigger conditions, Approvers, and Actions for an Approval. An Approval
for a Business Object contains one or more Approval Blocks. When you create an Approval Block, you
define:

• A trigger condition that determines when the block is used.

• List of Approvers.

• Voting standards.

• Action that takes place when the appropriate people have approved or denied the request.

Good to know:

• It is important to list the most detailed Approval Blocks first in the list of Approvals (in the Approval
Editor), because it is possible for multiple blocks to have overlapping trigger conditions. For
example, an Approval Block might be initiated when the status of a Change Request changes to
Approve, and another Approval Block might be initiated when both the status changes to Approve
and the Service Affected is changed to Employee Support. In order for the Approval process to
operate correctly, the second Approval in the example must be listed first.

• You must add an Approval to a Business Object before creating Approval Blocks.

To create an Approval Block:

1. Open the Approval Block Editor.

2. Define general properties for the Approval Block:
◦ Name: Provide a display name to use within CSM.

3. Define Approval Block properties:
a. Define Approval Block trigger conditions.

b. Define Approver properties.

c. Define Approval Action properties.

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

To edit an Approval Block:

1. Open an Approval Block in the Approval Block Editor.

2. Make changes.

3. Click OK.3. 
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Define Approval Block Condition Properties
Use the Trigger Condition page in the Approval Block Editor (accessed from within the Approval Editor) to
define a condition that initiates the Approval process for an Approval Block (ex: Send an Approval request
when the Emergency Change field is checked on the Change Request form). When you define trigger
condition properties for an Approval Block, you define:

• Trigger Condition: A Comparison Clause that determines when the Approval process is initiated.

• Additional Behaviors: An action that occurs when a condition is no longer true (ex: When a User
clears the Emergency Change Field on the Change Request form).

To define Approval Block Condition properties:

1. Open the Approval Block Editor.

2. Click the Trigger Condition page.

3. Define a Trigger Condition by creating a Comparison Clause.

Note: You can create a complex condition using a Comparison Clause(s) and/or Group
Clause(s) by clicking the Advanced button.

4. Define the Action that takes place when the trigger condition is no longer true:
◦ Clear Approvals from block

Select this radio button to remove Approvals created by this Approval Block when the trigger
condition is no longer true.

◦ Leave Approvals
Select this radio button to leave Approvals created by this Approval Block when the trigger
condition is no longer true.

Note: If a new Approval Block meets the trigger condition, leaving Approvals from a
previous block might impact the voting standards for the new Approval Block.

◦ Leave Approvals if condition was changed by block action
Select this radio button to leave the Approvals in place if the defined Approval action causes
the trigger condition to no longer be true. However, if the trigger condition is no longer true
because of a change outside of the Approval process, then the Approvals will be removed.

Tip: We recommend tying Approvals to the lifecycle of a Business Object. If an Object
enters a state of Waiting for Approvals (used to initiate the creation of the Approvals)
without this option, and the action changes the state to Approved, the Approvals will
disappear as soon as the Approvals are complete.

Note: You will generally select this option if you are creating multi-level Approvals
because it allows the Approval to move through the various levels of Approval Blocks
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(it prevents the first-level Approval from being deleted when the Approval advances to
the second-level Approval).

5. Click OK.5. 

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Approver Properties
Use the Approvers page in the Approval Block Editor (accessed from within the Approval Editor) to define
the following approver properties for an Approval Block:

• Number of approvers required for an Approval, including which approvals to count during the voting
process.

• A list of Users and/or Teams to designate as approvers.

• Text to display in the Details field of the Approval.

To define approver properties:

1. Open the Approval Block Editor.

2. Click the Approvers page.

3. Define the number of approvers required for Approval:
◦ All approvers

Select this radio button to require the approval of all designated approvers.

◦ Percentage

Select this radio button to require the approval of a defined percentage of approvers. Then,
provide a percentage or use the Up/Down arrows to increase/decrease the percentage.

◦ Specific number

Select this radio button to require the approval of a defined number of approvers. Then,
provide a number or use the Up/Down arrows to increase/decrease the number.

4. Define which Approvals to count during the voting process. In the drop-down, select one of the
following options:

◦ Count all Approvers

Select this option to count all Approvals associated with a Business Object, whether they are
created by this block, another block, or are manually created by a User.

◦ Count this block only
Select this option to only count the Approvals generated as a part of this block.

Note: We recommend that you select this option if you are creating multi-level
Approvals.

◦ Count block and manual

Select this option to only count the Approvals generated as part of this block or those manually
created by Users. Approvals created by other blocks are ignored.

5. Define approvers for the Approval Block:

CSM 9.3.0 Features 73

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=open_the_approval_block_editor


a. Click the Add button.

Tip: Click the Remove button to delete approvers; use the Up/Down arrows to change
the order of selected approvers.

b. In the drop-down, select a type of approver to add to the list:
◦ Add User

Select this option to add a specific CSM User to the list of approvers.

◦ Add Team
Select this option to add a CSM Team (ex: 1st Level Support, IT Management, etc.) to
the list of approvers.

Note: If you select this option, you also need to select a specific Team and the
voting standards for that Team. While multiple people can vote within a Team, the
Team as a whole only counts as one vote in the overall Approval vote.

◦ Add User based on Expression

Select this option to add a User based on a selected Business Object Field, system
function, Expression, Stored Value, or Metric Value that contains the ID the User (ex: An
approver based on the Expression Change Request.Owned By field will be approved by
the owner of the Change Request).

◦ Add Users from Relationship

Select this option to add an Approval for each User associated with a selected
Relationship.

The Add Approvers Based on Relationship window opens, where you can select a
Relationship, limit records using an Expression, and select a Business Object Field,
system function, Expression, Stored Value, or Metric Value that contains the ID of the
Users in the Relationship.

Note: This option treats each approver separately instead of as a Team (ex: If
there are ten records in a Relationship, then ten approvers will be added to the
Approval). Also, the Approval is based on the User's record (we currently do not
support Customers listed in the Customer - Internal Business Object as
approvers).

6. Define default properties for Approvals:

Note: (Default) is always included in the list of approvers and cannot be deleted. If custom
approval text and a custom deadline are not defined for each approver, the default is used.

◦ Approval Text
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Provide text to include in the e-mail sent to each approver.

◦ Deadline

Select this check box to define a default amount of time to allow for the approver to respond.
Then, define a number and unit of time (hours, days, or months). If the approver does not
respond within this timeframe, he is considered to have abstained.

7. (Optional) Define custom Approval text for each approver (to use instead of the default):
a. Select the Custom Approval Text check box.

b. Provide custom approval text to display in the Details field of the Approval.

c. Select the Append [Major Business Object] Description check box to add the custom
Approval text to the Major Business Object's description.

d. Select the Custom Deadline check box to set a specific deadline for the approver to respond
to the approval request. Then, define a number and unit of time (hours, days, or months).

8. Click OK.8. 

9. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Approval Block Action Properties
Use the Actions page in the Approval Block Editor (accessed from within the Approval Editor) to define
Actions for an Approval Block. When you define Actions, you define what is done based on the state of
the Approval (approved, denied, or when time runs out).

To define Approval actions:

1. Open the Approval Block Editor.

2. Click the Actions page.

3. Define an Action to take place when an Approval is Approved, Denied, or when time runs out (for
example, the Approval deadline passes with insufficient approval to indicate that a record has been
approved or denied):

◦ Set a Field

Select this check box to populate a Field with a defined value. Then, select a Field and
provide a specific value or click the Token Selector to select a Token whose value will be
used for the Field.

◦ Put on a Queue

Select this check box to put the record in a Queue. Then, select a most recently used (MRU)

Queue in the drop-down, or click the Ellipses button  to open the Queue Manager, where
you can select an existing Queue or create a new one.

◦ Run a One-Step

Select this check box to run a One-Step. Then, select a most recently used (MRU) One-Step

in the drop-down, or click the Ellipses button  to open the One-Step Manager, where you
can select an existing One-Step or create a new one.

◦ Executing the Action completes the approval process
Select this check box to end the Approval process when the defined action takes place.

Note: If you do not select this option, additional changes to the record might cause the
Approval to initiate again. However, if you are defining multi-level Approvals, you do
not want to select this option because it will terminate the Approval process.

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Multi-Level Approvals
Use the Approval Block Editor (accessed from within the Approval Editor) to create multi-level Approvals.
You can use multiple dependent Approval Blocks to define multi-level Approvals (different triggers,
Approvers, and Actions for different situations within the same Business Object). For example, an
Emergency Change Request might require that all Emergency Change Board members approve the
change, whereas a regular server change might require only the approval of a hardware Team member.

Multi-level Approvals are also used for requests that require multiple individuals or Teams to provide
approval during each stage of an Approval process. For example, the Networking Team might need to
approve a Change Request before it is sent to the CAB (Change Advisory Board) for approval.

When you define multi-level Approvals, you create multiple Approval Blocks that depend on each other.
Specifically, the action that occurs as a result of the first Approval Block is the trigger condition for the
second Approval Block.

Good to know:

• It is important to list the most detailed Approval Blocks first in the list of Approvals (in the Approval
Editor), because it is possible for multiple blocks to have overlapping trigger conditions. For
example, an Approval Block might be initiated when the status of a Change Request changes to
Approve, and another Approval Block might be initiated when both the status changes to Approve
and the Service Affected is changed to Employee Support. In order for the Approval process to
operate correctly, the second Approval in the example must be listed first.

• In the final Approval Block, a recommended action is to set the Action to take when approval:
Approved field to Approved and the Action to take when approval: Denied field to Denied. It is also
important to select the Executing the action completes the Approval process check box to
complete the Approval process.

• You must add Approval support to a Business Object before adding Approval Blocks.

To define a Multi-Level Approval:

1. Open the Approval Block Editor.

2. Define the trigger condition for the first Approval:
a. Create a condition using a Comparison Clause and/or a Grouping Clause.

Note: You also have the option to click Advanced to define a more complex condition.

b. Select the Leave Approvals if condition was changed by a block action radio button.

Note: This option must be selected because it prevents the first-level Approvals from
being deleted when the Approval advances to the second-level Approval.

3. Define the approvers for the first Approval.

Note: You must select either Count block and manual or Count this block only to include
Approvals related to the first Approval Block.
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4. Define the Action for the first Approval.

Note: You must clear the Executing the action completes the approval process check
box so that the second level of Approvals can occur (this action serves as the trigger
condition for the second level of Approvals).

5. Click OK.5. 

6. Click the Add button on the Approvals page.

7. Define the trigger condition for the second Approval:

Note: The trigger condition of the second Approval should be made true by the action of the
first Approval.

a. Create a condition using a Comparison Clause and/or a Grouping Clause.

Note: You also have the option to click Advanced to define a more complex condition.

b. Select the Leave Approvals radio button.

Note: This option is recommended for the second level of Approvals so that the
Approval remains connected to the Business Object after the condition is no longer
true.

8. Define the approvers for the second Approval.

Note: You must select Count this block only in the drop-down so that the results from the
first Approval are not counted in the results for the second Approval.

9. Define the action for the second Approval.

10. Define additional Approval Blocks as needed.

11. Click OK.11. 
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Configuring Approvals
To configure Approvals in CSM Administrator, configure Business Object rights for the Approval Business
Object for a security group.
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Attachments
An Attachment is an entity that can be imported and/or linked to in order to supplement information.
Examples include a document, an image, a record, a web page, a Document Repository, etc.
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About Attachments
Attachments include any files that require a separate program to open, including documents (Word, Excel,
etc.), PDFs, pictures (PNG, JPG, etc.), websites, etc. Attachments can either be imported into the CSM
database (accessible from anywhere) or linked (accessible only to Users who have access to the defined
system path). In CSM, record Attachments also include Business Objects, such as Knowledge Articles or
Incidents.

There are three primary types of Attachments in CSM:

• System Attachments:

Files associated with the system that can be referenced directly, used as Knowledge, used in e-
mails, etc.

• Record Attachments:

Attachments connected directly to a specific Business Object record (ex: Incident) that can only be
accessed when working with that specific record. Unlike other Attachments, Record Attachments
can include Business Object Attachments (links to other Business Objects without a Relationship).

• Document Repositories:

Customer accessible collections of documents designed to be accessed using the Portal. Users can
also access Document Repositories using the Document Repository Manager
(CSM>Tools>Attachments>Attachments>Document Repositories).

Note: System and Record Attachments are created, edited, deleted, or organized using the
Attachment Manager.
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Attachments Good to Know
• Attachments that are imported into CSM are searchable within the database.

• Attachments that are linked to CSM are not searchable and are only accessible to Users who have
the defined file path on their computer.

• To open, remove, e-mail, or view the properties of an Attachment, right-click the Attachment in the
Attachment Bar, and select an action from the drop-down.

Always consider the following:

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see configuring Attachments.
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Using Attachments
In CSM, Attachments can be used with:

• E-mail: Add an Attachment to an e-mail sent from the CSM system.

• Knowledge: Add an Attachment as an Attachment Knowledge Source that can be accessed through
a Knowledge Search.

• Records: Add an Attachment to a Business Object record.

• Attachment Manager: Add an Attachment directly to the Attachment Manager.

• Document Repository: Add an Attachment to a Document Repository within the Attachment
Manager.

When working with Attachments, Users can:

• View an Attachment.

• Attach a record to another record.

• Attach a file (Imported).

• Attach a file (linked).

• Attach a web page.

• Attach an image from the clipboard.

• Create a shortcut to an Attachment.
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View an Attachment
An Attachment can be viewed several ways:

• Available Attachments (based on security rights): Use the Attachment Manager.

• From the Attachment bar on a Business Object record:
◦ Click the Attachment.
◦ Right-click the Attachment and select Open.

Note: For a Business Object Attachment, right-click the Attachment and select Go to record,
Go to record in new window, or Quick-view record.

• From a CSM E-mail Attachment bar, click the Attachment.
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View Attachment Properties
To view details of an Attachment such as the date of creation, Attachment type, associated comments,
and where the Attachment originated from:

1. Open a record with an Attachment in the Desktop Client.

2. Right-click the Attachment link in the Attachment bar.

3. Select Properties.

4. Click Close to exit the Properties window.
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E-mail an Attachment
To e-mail an Attachment from a record:

1. Open a record with an Attachment in the Desktop Client.

2. Right-click the Attachment link in the Attachment bar.

3. Select E-mail Attachment.
4. Provide information in the e-mail window. See Send an E-mail from CSM for additional e-mail

details. If your system does not have default e-mail addresses configured, please contact your
System Administrator.

5. Click the Send button to send e-mail with the Attachment.
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Record Attachments
Users can import and use Attachments to supplement information in a record. For example, if a
Knowledge Article mentions a specific internal document in the solution Field, the creator can attach the
document to the Knowledge Article for other employees to reference.
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Attach a Record to Another Record
Use the Attachment button to link a record to another record as an additional reference (ex: Link a
Knowledge Article Record to an Incident Record). Business Object Attachments are linked, and cannot be
searched in connection with the Business Object.

To attach a record to another record:

1. Open a record in the Desktop Client.

2. Click the Attachment button , and then select Objects.

3. Select a Business Object (ex: Knowledge Article).

4. Select the record to link (ex: Knowledge Article 10006).
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Note: Search records using the Search Control located below the toolbar of the Selector.

5. Click OK.5. 
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Import and Attach a File to a Record
Use the Attachment button to import a file directly into the CSM system and attach it to a record as an
additional reference. Imported documents are available anywhere in CSM and are searchable, though
only certain types of documents support searching (ex:Word, Excel, Text, RTF, PDF). Imported
documents increase the size of the CSM database and must be re-imported if a change is made to the
document.

To import and attach a file to a record:

1. Open a record.

2. Click the Attachment button , and then select Attach a file (import).
3. Navigate to a file, and then click Open.
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Link a File to a Record
Use the Attachment button to link a file directly to the CSM system and attach it to a record as an
additional reference. Linked documents cannot be searched using CSM, and do not increase the size of
the database. Users must have access to the network where the file is located to view the document.

To link a file to a record:

1. Open a record.

2. Click the Attachment button , and then select Attach a file (link).
3. Select a file, and then click Open.
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Attach a Web Page to a Record
Use the Attachment button to link a website directly to the CSM system and attach it to a record as an
additional reference.

To link a website to a record:

1. Open a record in the Desktop Client.

2. Click the Attachment button , and then select Attach a web page.

The Browse window opens displaying the web page browser.

3. Browse to the website that you want to attach, and then click OK.
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Attach an Image from the Clipboard to a Record
Use the Attachment button to attach an image to a record as an additional reference. Attached images
from the clipboard are not imported into the Image Manager and are not searchable.

To attach an image from the clipboard:

1. Coy the image to the clipboard by right-clicking the image and selecting Copy
2. Open a record in the Desktop Client.

3. Click the Attachment button , and then select Attach image from clipboard.

4. Name the image, and then click OK.
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Create a Shortcut to an Attachment
Use the Attachment button to add to a record a reference to an existing system Attachment.

• This process uses the Attachment Manager to select an Attachment that has already been imported
into the CSM system.

• A Quick Search will not find records based on words or phrases in these Attachments.

To create a shortcut to an Attachment:

1. Open a record in the Desktop Client.

2. Click the Attachment button , and then select Shortcut to an Attachment.
3. Select an Attachment.

4. Click OK.4. 
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Remove an Attachment
To remove an Attachment from a Record:

1. Open a record with an Attachment in the Desktop Client.

2. Right-click the Attachment link in the Attachment bar.

3. Select Remove Attachment.
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Managing Attachments
System Attachments are managed using the Attachment Manager.

There are several ways to open the Attachment Manager.

For more information about working in CSM Item Managers, refer to the Item Managers documentation.
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Open the Attachment Manager
The Attachment Manager can be opened several ways:

• From the CSM Desktop Client menu bar, click Tools>Attachments.

• From the CSM Desktop Client toolbar, click the Attachments button .

• From an E-mail, click the Attachments button, and then select Attachment Manager.
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Create a System Attachment
Use the Attachment window (accessed from within the Attachment Manager) to create (import or link) a
system Attachment.

To create a system Attachment:

1. Open the Attachment Manager.1. 

2. Select a scope and subfolder (if needed).2. 

3. Click the Create New button.

4. Define general properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

5. Define the Attachment type:
◦ Imported:

Import a document into the CSM system.

◦ Linked to:

Link to a document in a program outside of the CSM system.

Note: Click View to open the selected Attachment and ensure that you selected the
correct Attachment.

6. Click OK.6. 
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Import Attachments from a Directory
Use the Import Attachment from Directory window (accessed from within the Attachment Manager) to
simultaneously import multiple Attachments by importing an entire directory of files into the CSM system.

To import Attachments from a directory:

1. Open the Attachment Manager.

2. Select a scope and subfolder (if needed). Attachments will be imported into this folder.

3. From the Attachment menu bar, click Attachments>Import Directory.

4. Click the Browse button, and navigate to the directory to import.

Tip: Use a Universal Naming Convention (UNC) path, because the directory must be
accessible from the server. The format is: \
\<servername>\<sharename>\<directory>.

5. Include subdirectories:

Select this check box to include all of the sub-folders associated with the selected folder.

6. Replace existing Attachments:

Select this check box to replace all of the current Attachments in the folder with the imported
Attachments.

7. Click OK.7. 
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Configuring Attachments
Complete the following procedures to configure Attachments. Configuration procedures are completed in
CSM Administrator.

To configure Attachments:

1. Configure global file attachments settings:

Define global Attachment settings/rights (ex: Maximum allowable Attachment size and allowable file
types) for CSM.

2. Define file attachment rights for a specific Security Group:

Define Attachments settings/rights on a per Security Group basis (these override the global
Attachment settings on a per Security Group basis).

3. Define file attachment rights for a specific Business Object:

Define view, add, edit, and delete Attachment rights on a per Business Object basis.

4. Configure Attachment security rights:

Define view, add, edit, and delete rights by scope (Blueprint, Global, Role, Site, Team, and User).
Attachment rights are grouped with Application security rights.
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Business Hours
Business Hours are defined hours of operation for a service desk (example: Monday-Friday from 8:00 AM
to 5:00 PM). In CSM, Business Hours are used to drive Automation Processes and confine Target Times.
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About Business Hours
In CSM, Business Hours are used to drive Automation Processes and confine Target Times. Users can
define numerous Business Hours based on the needs of their company (ex: You might want a regular
Business Hours calendar and a separate maintenance Business Hours calendar).

CSM provides several OOTB Business Hours, designed to reflect common Business Hour time frames,
including 8-5 Monday to Friday, Maintenance Window, and Only on Weekends. Use these OOTB
Business Hours as-is, edit them, or create your own using the Business Hours Manager.
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Business Hours Good to Know
• There are several ways to view Business Hours in CSM

• Pin items to a Pinboard (in the Manager) and MRU list (in the CSM Desktop Client menu bar) to
make them easily accessible in CSM.

• CSM provides several OOTB Business Hours, designed to reflect common Business Hour time
frames, including 8-5 Monday to Friday, Maintenance Window, and Only on Weekends. Use these
OOTB Business Hours as-is, edit them, or create your own using the Business Hours Manager.

• When you create new Business Hours, you must update the Created During What Business Hours
Expression to reflect the new hours. If Business Hours overlap, move the preferred hours above the
other hours in the list.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure Business Hours Security Rights.
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Managing Business Hours
Business Hours are managed in CSM using the Business Hours Manager.

Use this tool to:

• View Business Hours.

• Create Business Hours.

• Edit Business Hours.

• Delete Business Hours.

• Search for Business Hours.

• Organize Business Hours.

• Copy Business Hours.

• Import/export Business Hours.

• Find Business Hour dependencies.

• Pin Business Hours.

There are several ways to open the Business Hours Manager.
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For more information about working in CSM Item Managers, refer to the Item Managers documentation.
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Open the Business Hours Manager
To open the Business Hours Manager:

1. The Business Hours Manager can be opened several ways:
◦ From the CSM Administrator main window, click the Automation Processes category, and

then click the Business Hours task.

◦ From the Visual Workflow Process Designer when creating a Visual Workflow Process, click
the Business Hours page.

◦ From the Hours page of the Target Times form, click the Legal Values button .
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View Business Hours
To view Business Hours:

1. Business Hours can be viewed several ways:
◦ Available Business Hours (based on security rights): Use the Business Hours Manager.

◦ From the Visual Workflow Process Designer when creating a Visual Workflow Process, click
the Business Hours page.

◦ From the SLA Target Times form, click the Ellipses button
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Create Business Hours
Use the Business Hours window (accessed from within the Business Hours Manager) to create Business
Hours (times your service desk is operational). When you create Business Hours, you define:

• General properties: Name and description.

• Time zone: Time zone to use for the date and time definitions.

• Default Hours:
◦ Days: Weekdays and weekends.

◦ Hours: Ranges for each day (from-to).

• (Optional) Exceptions: Month/day/hours that are exceptions (ex: For a holiday).

To create Business Hours:

1. Open the Business Hours Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button .

The Business Hours Properties window opens.

4. Define general properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

c. Time zone:

Select a time zone to use for the date and time definitions.

Note: You have the option to select Server Time Zone to set the time based on the server that
is using the Business Hours (Cherwell Application Server, Automation Process Server,
Scheduling Server, etc.). The Time Zone feature should only be used with a three-tier
connection. A two-tier connection causes undesired results.

5. Define default Business Hours:
a. Define days: Select the days for which the Business Hours apply.

◦ Weekdays (Monday-Friday)

◦ Weekend (Saturday, Sunday)

b. Define hours: Select the hours for which the Business Hours apply.
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Note: You can divide the daily hours into multiple sections (ex: To include a lunch break, you
can define the hours as 8:00AM-12:00PM and 1:00PM-5:00PM).

c. Show all days: View and define each day of the week separately.

d. Closed: Define range of days in which the business is closed.

6. (Optional) Define exceptions:
a. Select the day/month/year to define.

b. Select an Action:
◦ No exception: The business is open during the default Business Hours.

◦ Closed: The business is closed for the entire day (ex: Holiday).

◦ Custom: The business is open for a specific period of time that differs from the default
Business Hours.

7. Click OK.7. 
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Configuring Business Hours
To configure Business Hours in CSM Administrator, configure Business Hours security rights.
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Business Objects
A Business Object is a definition-powered business entity that stores data to help organizations manage
their various workflows and business processes. For example, the Incident Business Object embodies
everything about an Incident (example: Who initiated it, how it is categorized, to whom it is assigned, etc.).
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About Business Objects
Use Business Objects to manage data and workflows for business processes (example: Incident
Management). A Business Object can be complex (example: Incident) or simple (example:
IncidentCategory that holds the list of categories that can be used within an Incident).

Business Objects are the heart of CSM and are extremely versatile. You can define various options to
determine what data they contain, how they behave, and how they can be used. For example, you can
define a lifecycle, define what information is tracked, and/or require values to be entered into certain fields
(example: Priority) before records can be saved. Business Object records are represented as Forms and
Grids in CSM.

Business Objects are categorized as:

• Major

A Major Business Object is a stand-alone Business Object that represents a major component of a
business. It can exist by itself and have child objects that are part of its composition (using
Relationships). Examples include Incident, Problem, Change, Knowledge Article, Customer,
Configuration Item, and Service.

• Supporting

'A Supporting Business Object is a Business Object that exists solely to complement, or support, a
Major Object. Examples include Task, Journal, and Approval.

• Lookup

A Lookup Business Object is a Business Object that supplies valid values to other Business
Objects. More precisely, it stores values for Fields that require constrained selections. For example,
the Incident Cause Lookup Object holds values such as Hardware Malfunction, Outage,
Permissions, etc.

• Group
• A Group Business Object is a set of Business Objects that share common Fields. For example, the

Configuration Item Group has Group Members named Computer, Printer, and Telephony
Equipment. A Group Leader (example: Configuration Item) is the Business Object that is the root of
a Group. It stores common Fields that all Group Members share. All Group Members are descended
from the Group Leader.

All Business Objects belong to one or more Business Object Views. Business Object Views allow you to
have multiple instances of a Business Object with different behaviors and appearance for different Users
(example: A Default View for Business Objects accessed from the CSM Desktop Client and a Portal View
for Business Objects accessed from the Portal). Although the rules, behavior, and appearance can differ
among Views, the structure of the Business Object is always the same.

CSM provides several OOTB Business Objects (example: Incident, Problem, Change, etc.). Use these
Business Objects as-is, edit them, or create your own using the Object Manager (accessed from within a
Blueprint in CSM Administrator).
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Within the Object Manager are several Business Object-specific tools, including:

• Business Object Editor: Edit various aspects of a Business Object (properties and Fields).

• Relationship Editor: Add, edit, and delete Relationships for a Business Object.

• Form Editor: Edit the various aspects of a Business Object Form.

• Grid Editor: Edit the various aspects of a Business Object Grid.

Note: Business Objects and their associated Fields, Relationships, Forms, Grids, and Form
Arrangements are created, edited, and deleted within a Blueprint. To commit changes to
your system, you must publish the Blueprint.
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Major Business Objects
Major Business Objects are the only Objects that can have the following properties:

• Have records created from the New menu on the CSM Desktop Client toolbar.

• Be assigned keyboard shortcuts for creating new records and running Quick Searches.

• Have Form Arrangements with tabs and splitters.

• Participate in record locking.

CSM provides the following OOTB Major Business Objects:

• Agreement

• Change Request

• Configuration Item

• Contract

• CSM License Usage

• Customer

• Discussion

• Incident

• Knowledge Article

• Problem

• Service

• Service Cart

• Service Catalog Template

• SLA

• Supplier

• Supplier Catalog Item

• Work Unit

You can use these as-is, edit them, or create your own using a Blueprint.

CSM 9.3.0 Features 114

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=csm_desktop_client_toolbar
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2Fsearching%2Fabout_quick_search.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2Frecord_locking%2Fabout_record_locking.html
https://help.cherwell.com/csh?topicname=about_agreements
https://help.cherwell.com/csh?topicname=about_change_requests
https://help.cherwell.com/csh?topicname=about_configuration_items
https://help.cherwell.com/csh?topicname=csm_license_usage
https://help.cherwell.com/csh?topicname=about_customers
https://help.cherwell.com/csh?topicname=about_incidents_and_service_requests
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2F..%2Fshared%2Fabout_knowledge_articles.html
https://help.cherwell.com/csh?topicname=about_problems
https://help.cherwell.com/csh?topicname=about_services_and_service_catalogs
https://help.cherwell.com/csh?topicname=about_service_carts
https://help.cherwell.com/csh?topicname=about_service_catalog_templates
https://help.cherwell.com/csh?topicname=service_level_agreements_-slas-
https://help.cherwell.com/csh?topicname=about_suppliers
https://help.cherwell.com/csh?topicname=about_supplier_catalog_items
https://help.cherwell.com/csh?topicname=about_work_units
https://help.cherwell.com/csh?topicname=about_blueprints


Supporting Business Objects
Supporting Objects can be displayed on a Major Object's Form Arrangement, or as an embedded Form
(example: Specifics Form within an Incident). In order for Supporting Objects to appear as tabs or
embedded Forms, they must have a Relationship with the Major Object they support (typically, the Major
Object owns the Supporting Object).

1. Parent record.

2. Embedded Form.

3. Form Arrangement.

Note: You can also display a Major Object as a tab on a Form Arrangement (example:
Problem might "support" Incident) or in a drop-down (such as Service) if you configure a
Relationship (example: Incident Links Problem). When you use a Major Object as a tab, it is
read-only. For example, a Problem tab appears on the Incident record to quickly reference
associated Problems, but the Problem records cannot be edited from the tab. To edit the

Problem, click the GoTo button  to navigate to the Problem record, or the Quick View

button  to open the record in a second window for a quick look at the details.

CSM provides several OOTB Supporting Business Objects (example: Journal, Task, Approval, etc.). Use
these as-is, edit them, or create your own using a Blueprint.
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Lookup Business Objects
Lookup Objects are not directly exposed in the interface. They are used to validate or auto-populate
Fields in other Business Objects.

Example: The Incident Category Lookup Object holds all of the valid categories for an Incident. You can
then use the Lookup Object to validate the Category field in the Incident Object. When logging an
Incident, Users can press F3 to view all the valid values for the Category field (valid values are based on
the selected Service). If validation is enforced, Users receive an error if they try to provide a value that is
not included in the Incident Category Lookup Object.

Lookup Objects are typically edited using Table Management either in the CSM Desktop Client or from the
Settings category in CSM Administrator (Settings>Table Management). You can also manage Lookup
Object data as part of a Blueprint or mApp using the Edit Data operation, in which case changes are not
committed to your system until the Blueprint is published.

CSM provides several OOTB Lookup Business Objects (to hold status, categories, priorities, etc.). Use
these as-is, edit them, or create your own using a Blueprint.
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Group Business Objects
Group Objects are used when a number of items share commonality, but each one has some unique
information associated with it. For example, Configuration Items all have Fields in common, such as
Manufacturer and Serial Number. However, a Config-Mobile Device Object might have a SIM Card field,
while a Config-Printer Object might have a Printer Drive Space field. Users can search for a specific
Group Member (ex: Computer) or for any member of the group (ex: Configuration Item), in which case the
results will include matching records from any Group Member (ex: Computer, Printer, etc.).

Any type of object (Major, Supporting, or Lookup) can be a Group Leader or Group Member. You define
Group properties when you create a Business Object.

CSM provides several OOTB Group Business Objects (ex: Configuration Item, Journal, Specifics, etc.).
Use these as-is, edit them, or create your own using a Blueprint.

CSM 9.3.0 Features 117

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=about_blueprints


Business Object Views
A Business Object View is an entity that contains an instance of a Business Object so that data can be
exposed from the same Business Object in different ways, allowing the representation to be more secure
and more personal. For example, use a Portal View to create an instance of a Business Object for
Customers accessing the data from the Portal. Then, create a simpler Portal Incident Form and/or Portal
Grid specifically for Customers.

Business Objects in a View can have their own behavior (properties, rules, Actions, Approvals) and
appearance (Forms, Grids, and Form Arrangements). CSM provides OOTB Business Object Views for
the CSM Desktop Client (Default) and the Portal (Portal Default). You can use these Views as-is, edit
them, or create a new View. To help manage (create, edit, delete, etc.) Business Object Views, CSM
provides the View Manager, accessed from within a Blueprint in CSM Administrator.
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Open the View Manager
Use the View Manager to add a View to a Blueprint and to complete general CSM Item Manager
operations for Business Object Views.

To open the View Manager:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

2. Click the Ellipses button next to the Current View drop-down.

Good to know:

• Copying a View does not copy the Business Objects and related definitions contained in the View.

• Adding a View to a Blueprint does not add Business Objects and related definitions to the Blueprint.
However, deleting a View in a Blueprint will delete the Business Objects and related definitions
contained in the View when the Blueprint is published.

• System is the only available scope. Create subfolders underneath this scope to organize items.• 
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Create/Edit a Business Object View
Use the View Manager to create and edit a Business Object View.

You can:

• Create a Business Object View

• Add Business Objects to a View

• Edit a Business Object View

Creating a Business Object View
To create a Business Object View:

1. Open the View Manager.

2. Click the Create New button.

3. Define properties for the Business Object View.

Property Description

Name
Provide a display name to use within CSM (this
property can be searched in CSM Item
Managers).

Description
Provide a description to use within CSM (this
property can be searched in CSM Item
Managers).

Device

Select a CSM Client where the Business Objects
in the View are exposed:

◦ Smart Client: Makes the Business Objects
in the View available in the Desktop Client.

◦ Browser: Makes the Business Objects in the
View available in the Browser Client.

◦ For Portal: Makes the Business
Objects in the View available for the
Portal.
Note: If a custom Browser View is not
available for a User, the system
defaults to displaying the most
appropriate Desktop Client View.
Typically, creating a custom Browser
View for technicians is not necessary
unless Browser Users need specific
behavioral or look-and-feel
differences. However, creating custom
Views for Portal Users is common
because the behavior and look is
usually completely different.
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4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Adding Business Objects to the View
To add Business Objects to a View:

1. Select the View from the View Manager.

2. In the Object Manager, click a Business Object in the Object tree, and then click the Add to View
task in the Structure area.

3. Select the Create Business Object with empty Forms and Grids option to create an instance of
the Business Object with empty Forms and Grids. This allows you to create new Forms and Grids
for the Business Object instance.

4. Select the Copy Forms and Grids from an existing View option to copy the Forms and Grids from
another Business Object View. Then, in the View drop-down, select an existing View. You can then
modify the copied Forms and Grids as necessary.

5. Select the Only copy default Forms and Grid check box to copy only the default Forms and Grids
from the selected Business Object View. Any secondary Forms or Grids created in View are not
copied. If any secondary Forms are referenced in sub-Forms or on tabs in a Form Arrangement,
then the versions from the Default View are used instead.

6. Click OK.6. 

7. Define/edit Business Object properties for the view, such as Relationships or external data mapping
options.

8. Add additional Business Objects to the View as needed.

Edit a Business Object View
To edit a Business Object View:

1. Open a Business Object View in the View Manager

2. Edit the View properties, and then click OK.

3. Click OK in the View Manager.

4. Make changes (add/edit/delete) to Business Objects within the View.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Business Objects Good to Know
• Every Business Object must have at least one Form and one Grid defined, even if the object is not

exposed in the interface (example: Lookup Objects are often not exposed in the primary interface,
but they are edited in Table Management, which uses Forms).

• Usually, only Major Objects have Form Arrangements.

• Not all Business Objects can or do have Relationships. For more information, refer to the
Relationships Documentation.

• All Business Objects belong to one or more Business Object Views, which allow for multiple
instances of a Business Object with different behaviors and appearance for different Users
(example: A Default View for Business Objects accessed from the CSM Desktop Client and a
simpler Portal View for Business Objects accessed from the Portal). Although the rules, behavior,
and appearance can differ between Views, the structure of the Business Object is always the same.

• CSM provides several OOTB Business Objects (example: Incident, Problem, Change, etc.). Use
these Business Objects as-is, edit them, or create your own using the Object Manager (accessed
from within a Blueprint in CSM Administrator).

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to Business Object data and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, refer to Define Business Object Rights.
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Using Business Objects
Use Business Objects to manage data and workflow for your business processes. CSM provides multiple
OOTB business processes that allow you to effectively solve issues and manage information.

Business Object records are represented as Forms and Grids in the interface. CSM provides records for
the OOTB business processes. When working with these OOTB records, Users can, for example:

• Log an Incident

• Create a Service Catalog

• Log a Problem

• Create a Configuration Item

• Log a Standard Change

• Log a Knowledge Article

Use these as-is, edit them, or create your own.
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Managing Business Objects
Business Objects are managed in CSM Administrator using the Object Manager and the Business Object
Editor.
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Object Manager
The Object Manager is the interface within a Blueprint in CSM Administrator that allows you to manage
(create, edit, and delete) the various aspects of a Business Object and perform various Business Object
operations. Use the Object Manager to:

• Create, edit, and delete Business Objects.

• Manage Business Object structure:
◦ Relationships

◦ Actions

◦ Approvals

◦ Mapping options (to external data)

• Manage Business Object appearance:
◦ Forms

◦ Grids

◦ Form Arrangements (Major Objects only)

• Perform various Business Object operations:
◦ Scan a Business Object for potential problems

◦ Undo Business Object changes within a Blueprint

◦ Add a Business Object to a Blueprint

◦ View Blueprint Changes for a Business Object

◦ Export the Business Object as a Schema

◦ View the Business Object's Publish Log

◦ Manage culture fields for Lookup Objects when Globalization is enabled for your system.

There are several ways to open the Object Manager.
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1. View: Displays the currently selected Business Object View and shows which Business Objects in
the Object Tree are included in the View.

Note: Business Object Views allow different Users to see different instances of a Business
Object. The Default View is the view that all Users will see if a custom view has not been
created. The Business Objects that are not available for a particular View are still listed but
are grayed out and cannot be selected.

2. Object Types: Filters Business Objects by type.

3. Object Tree: Displays Business Objects (in alphabetical order) of the selected type and included in
the selected View.

4. Business Object Tasks: Displays a list of available operations that allow you to edit the structure and
appearance of a Business Object, and perform other operations as necessary (scan for problems,
export a Schema, etc.).
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Open the Object Manager
The Object Manager is opened from within a Blueprint in CSM Administrator:

• When you open a Blueprint (by creating a new one or editing an existing one):
◦ In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

• When working in a Blueprint, return to the Object Manager by doing one of the following:
◦ From the Blueprint Editor menu bar, click View>Object Manager.

◦ On the Blueprint Editor toolbar, click the Home button .

◦ In the Blueprints section of the Blueprint Editor Task Pane, click Object Manager.
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Business Object Editor
The Business Object Editor is the interface within a Blueprint in CSM Administrator that allows you to
manage (create, edit, and delete) the various aspects of a Business Object.

Use the Business Object Editor to:

• Access the Business Object Properties window, and then define basic properties for a Business
Object, as well as some additional options and behaviors.

• Create, edit, or delete Fields for a Business Object.

• Access the Field Properties window, and then define properties for a Field.

Open the Business Object Editor from the Object Manager (within a Blueprint in CSM Administrator):

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area (or double-click a Business Object in the Object tree).

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar to
open the Business Object Editor.
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Open the Business Object Editor
Open the Business Object Editor from the Object Manager (within a Blueprint in CSM Administrator):

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area (or double-click a Business Object in the Object tree).

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar to
open the Business Object Editor.
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Open the Business Object Properties Window
To open the Business Object Properties window:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If you are working on a saved Blueprint, open the existing Blueprint.The Blueprint
Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists the
existing Business Objects.

2. In the Object Manager, click (New Object) in the Object tree, and then click the New Business
Object task from the Structure area.

Note: If you are working on an existing Business Object, open the Business Object Editor for
that Business Object, and then click the Bus Ob Properties button.
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Create/Edit a Business Object
Use the Business Object operations within the Object Manager to create a Business Object. In the Object
tree, click New Object.

In the tasks list, select one of the following operations:

• New Business Object

Opens the Business Object Properties window, and then define basic properties for a new CSM
Business Object.

• New External Business Object

Opens the External Data Wizard, and then establish a connection to an external database and
create a new external Business Object for sharing data with the external database.

• New Directory Service-mapped Business Object (only available if the directory service is
configured):

Opens the User Mapping Wizard to establish a directory service connection and create a CSM
Business Object that is mapped to a directory service Object.

Note: This procedure covers creating a CSM Business Object. For more information about
external Business Objects and Map Customer Object to a Directory Service into Business
Object, refer to their respective documentation.

Good to know:

• You can add a new Group Member to a Group Object by clicking a Group Leader in the Object
tree, and then clicking the New Group Member task in the Structure area.

• When you select an operation that creates a new Business Object, the basic properties of the new
object are based on the currently selected object type. For example, if Major is selected as the
object type, the new Business Object starts as a Major Object; however, this can be changed when
you edit the object's properties.

Creating a Business Object
To create a CSM Business Object:

1. Open the Object Manager.

2. Select a Business Object View, either:
◦ In the drop-down, select an existing View.

◦ Click the Ellipses button  to open the View Manager, and then select an existing Business
Object View or create a new Business Object View.
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3. Select an Object type (Major, Supporting, or Lookup).

Note: Selecting an Object type filters the list of Objects in the Object Manager, and also
automatically selects this type on the General page of the Business Object Properties
window when creating a new Object. Select (or change) the Object type when defining
general properties for the Business Object.

4. Click (New Object) in the Object tree, and then click the New Business Object task from the
Structure area.

5. Define basic Business Object properties:
a. Define general properties for the Business Object.

b. Define process and procedure help.

c. Define Group properties.

6. Define additional Business Object properties:
a. Define lifecycle properties.

b. Define search results properties.

c. Define Attachment options.

d. Define database options.

e. Define history options.

f. Define record locking settings when record locking is enabled for your system.

g. Define Localization options for Lookup Objects when Globalization is enabled for your system.

h. Define advanced properties.

7. Create Fields.

8. Create Relationships for the Business Object.

9. Define Business Object Actions.

10. Add Approval support to the Business Object.

11. Define mapping options for sharing data with external databases:
◦ Map an Existing External Business Object to Import External Data.

◦ Map the Customer Object to a Directory Service.

12. Create Forms for the Business Object (including Summary Forms, Mini-Summary Forms, Mobile
Forms (if applicable), and Portal View Forms (View Only and Edit Existing)).

13. Define Grids for the Business Object.

14. (Major Objects only) Define a Form Arrangement for the Business Object.

15. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Editing a Business Object
To edit a Business Object:
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1. Open a Business Object in the Object Manager.

2. Make changes.

3. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Basic Business Object Properties
Use the Business Object Properties window to define basic properties for a CSM Business Object.

Good to know:

• Business Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements
are created, edited, and deleted within a Blueprint. To commit changes to your system, you must
publish the Blueprint.

To define basic Business Object properties:

1. Open the Business Object Properties window.

2. Define basic properties for the Business Object:
a. Define general properties.

b. Define process and procedure help.

c. Define Group properties.

3. Click OK.3. 

The Business Object Editor opens, where you can add, edit, and delete Fields, or define additional
Business Object properties.

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define General Properties for a Business Object
Use the General page in the Business Object Properties window to:

• Provide generation information .

• Define a Public ID .

• Select a Business Object Type: Major, Supporting, or Lookup.

• Set tracking options.

• Choose Business Object behavior options.

• Define menus and shortcut keys for Major Objects.

Provide General Information for the Business Object
To define general properties for a Business Object:

1. Open the Business Object Properties window.

2. Click the General page.

3. Define general information for the Business Object.

Option Description

Name Provide a display name.

Plural Name

When you provide a display name, the plural name
is automatically populated (an s is added to the end
of the display name; this might need to be edited).
The plural name is used whenever the Business
Object is displayed in text that needs a plural form.

Internal Name

When you provide a display name, the internal
name is automatically populated with the Business
Object display name, but with spaces and
punctuation removed. In most places in the
interface, the display name is used; however, the
internal name is used when accessing the Business
Object using APIs. By default, the internal name is
also used as the custom storage name on the
Database page (except for Group Objects, which
use the Group Leader's storage name).

Note: The storage name can be
overridden in the database properties for a
Business Object. However, it must adhere
to SQL Table naming conventions
(example: Automatically be derived from
the display name, not use invalid values
such as spaces, etc.).

Description (optional) Provide a description.
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Define a Public ID for the Business Object
CSM uses a unique identifier (usually RecID) for each Business Object instance, but this is not User-
friendly. A Public ID allows you to define your own ID that is displayed to Users. This is a single Field that
best represents the Business Object (example: Incident ID for the Incident object, Customer's full name
for the Customer object, etc.).

Important: A Public ID is required for Major Business Objects.

To define a Public ID for a Business Object:

1. Select the Use Public ID check box to use a Public ID for the Business Object.

2. Choose one of these options:
◦ Use Existing Field

In the drop-down, select a Field containing the value that best describes the Business Object
(example: IncidentID for Incident or Full Name for Customer).

◦ Create New Field
Click New to create a new Public ID field, and then provide the following properties:

Option Description

Display Name Type a display name for the Field.

Internal Name

Type an internal name for the Field (what the
system uses internally). This is automatically
populated with the Field name (without spaces
and punctuation), but can be changed if
needed.

Field Size
Use the up/down arrows to increase or
decrease the number of characters the Field
can hold (default is 10).

Use Counter

Select this check box to use a Counter in the
Field. Then, click the Ellipses button to open
the Counter Manager, where you can select an
existing Counter or create a new Counter. You
can do this if you want each new record to have
a new and unique, ever-increasing Public ID.

3. Select the Prefix with Business Object Name check box to display the Business Object name
along with the Public ID. This is useful if the Public ID is numeric (example: An Incident ID of 12345
is displayed as Incident 12345 rather than just 12345).

Note: When you define a Public ID, a window opens asking if you want to create an index.
We recommend clicking Yes so that Public ID can be used in CSM Searches.
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Define Tracking Options
Define tracking options, which creates Fields to track information in the Business Object (example:
Ownership, who created or last modified a record, creation and modification dates). If you clear one of the
tracking check boxes, the selected track Field is deleted from the Business Object.

Tracking options are:

Option Description

Track Creation

Select this check box to track when records are created.
Selecting this check box automatically adds the
following Fields to the Business Object: Created Date
Time, Created By, and Created By ID.

Track Modified

Select this check box to track when records are
modified. Selecting this check box automatically adds
the following Fields to the Business Object: Last Mod
Date Time, Last Mod By, and Last Mod By ID.

Track Owner

Select this check box to track who owns a record.
Selecting this check box automatically adds the
following Fields to the Business Object: Owned By and
Owner ID. The initial record owner is the person who
creates the record.

Track Team Owner

Select this check box to track which Team owns a
record. Selecting this check box automatically adds the
following Fields to the Business Object: Owned By Team
and Owner Team ID.

Note: For more information about the Track Owner and Track Team Owner options, refer to
Record Ownership.

Define Business Object Behaviors
You can set various behaviors, including where the Business Object appears in CSM (example: In Search
Groups, One-Steps, Expressions, etc.).

Option Description

Image
Click the Image button to open the Image Manager, and then
select an existing image or import a new image to represent
the item in the UI.

Uses Queues (Major and Supporting Objects only.) Select this check box to
allow Users to add this Business Object to Queues.

Show in Search Manager

(Major and Supporting Objects only.) Select this check box to
allow Search Groups to be associated with the Business
Object (Business Object is available in the Association drop-
down in the Search Group Manager).
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Option Description

Show in One-Steps

Select this check box to allow One-Steps to be associated
with the Business Object (Business Object is available in the
Association drop-down in the One-Step Manager) and to
define Actions/One-Steps for the Business Object.

Show in Expression Manager
Select this check box to allow Expressions to be associated
with the Business Object (Business Object is available in the
Association drop-down menu in the Expression Manager).

Show in Table Management

(Supporting and Lookup Objects only.) Select this check box
to allow values to be provided for the Business Object via
Table Management. By default, this is selected for Lookup
Business Objects so that Users can easily add new values.

Show in E-mail Address Book

Select this check box to show the Business Object in the CSM
Address Book (in the Show Names From drop-down). Then,
select the Field that holds the e-mail address value (you might
need to create this Field). Typically, this is used for Customer
and UserInfo Objects.

Note: When first creating a Business Object, there is
not an appropriate Field to hold the e-mail address.
You must first create the Field and then edit the
Business Object to set this option.

Show in Contact Manager

Select this check box to show the Business Object in the
Contact Manager (in the Customer Type to Show drop-down
menu). Then, select the Field to use to alphabetize records.
This is selected by default for the Customer Business Object/
Group Members. Typically, it is only selected for other objects
if they represent external Customer data.

Allow spell-checking

Select this check box to turn on spell-checking for the Fields in
the Business Object. This checks for spelling errors in content
that is provided in Business Object records. You can specify
which Fields should be selected on a Field-by-Field basis.

Define Menu and Shortcut Keys
For Major Objects, you can define menus and shortcut keys.

Option Description

New Record

Select a keyboard command to use as a shortcut to
create a new Business Object record in CSM
(example: CTRL+SHIFT+I creates a new Incident
record).
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Option Description

Quick Search

Select a keyboard command that can be used to
change the Search Control to this object in the CSM
Desktop Client Task Pane and set the focus to the
Search Control so that the User can provide search
terms to run a Quick Search of the Business Object.

Note: To enable the Quick Search keyboard
shortcut, you must select Show in Quick
Search on the Search Results page. When
this shortcut key is used in CSM, the Quick
Search selector will automatically be
changed to the appropriate Object, and the
cursor will be placed in the Search Control
ready for the User to provide a keyword to
search.

Show on New Menu
Select this check box to show the New Record
keyboard shortcut on the New menu on the CSM
Desktop Client menu bar and toolbar.
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Define Process and Procedure Help Properties for
a Business Object

Use the Process and Procedure Help page in the Business Object Properties window to provide
additional information to Users who work with a Business Object.

Good to know:

• If you do not see the Process and Procedure Help page, close the Blueprint (after saving) and go to
Settings>Edit System Settings. Click the Help page, and then select Show Process and
Terminology Help. For more information, refer to Configure Global Help Settings.

• If the Process and Terminology section does not appear on the CSM Desktop Client Task Pane,
ensure it is enabled in the User Task Pane and Search Control Settings.

To define process and procedure help:

1. Open the Business Object Properties window.

2. Click the Process and Procedure Help page.

3. Define process and procedure help:

Option Description

Process and Procedure Text
Provide text to display in the Process and
Terminology section of the CSM Desktop Client
Task Pane.

Additional Help URL

(Optional.) Provide a URL to display to navigate to
additional information. Then, click the Ellipses
button to navigate to the URL and ensure it is
correct.

Information is Relevant to ITIL

Select this check box if the process and procedure
text is relevant to ITIL (IT Infrastructure Library).
An icon  is displayed in the Process and
Terminology section of the CSM Desktop Client
Task Pane to indicate that the Business Object is
related to an ITIL process.

Information is Relevant to KCS

Select this check box if the process and procedure
text is relevant to KCS (Knowledge-Centered
Support) standards. An icon  is displayed in the
Process and Terminology section of the CSM
Desktop Client Task Pane to indicate that the
Business Object is related to a KCS process.

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

CSM 9.3.0 Features 142

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=close_a_blueprint
https://help.cherwell.com/csh?topicname=configure_global_help_settings
https://help.cherwell.com/csh?topicname=configure_user_task_pane_and_search_control_settings
https://help.cherwell.com/csh?topicname=csm_open_business_objects_properties_window
https://help.cherwell.com/csh?topicname=csm_desktop_client_task_pane
https://help.cherwell.com/csh?topicname=csm_desktop_client_task_pane
https://help.cherwell.com/csh?topicname=csm_desktop_client_task_pane
https://help.cherwell.com/csh?topicname=csm_desktop_client_task_pane
https://help.cherwell.com/csh?topicname=csm_desktop_client_task_pane
https://help.cherwell.com/csh?topicname=csm_desktop_client_task_pane
https://help.cherwell.com/csh?topicname=publish_a_blueprint
https://help.cherwell.com/csh?topicname=save_a_blueprint


Define Group Properties for a Business Object
Use the Group page in the Business Object Properties window to define whether a Business Object is:

• Not a member of a Group: Does not belong to a Group.

• Group Leader: Is the leader (root) of a Group, and stores common Fields that all Group Members
share.

• Member of Group: Belongs to an existing Group, which means it descends from a Group Leader
and shares common Fields with other Group Members. However, each Group Member has some
unique information associated with it.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

Good to know:

• Add a Group Member directly to a Group Object by clicking a Group Leader in the Object tree, and
then clicking the New Group Member task in the Structure area.

To define Group properties for a Business Object:

1. Open the Business Object Properties window.

2. Click the Group page.

3. Define Group properties:
◦ Not a Member of a Group: Select this radio button if the Business Object will not be a Group

Leader or Group Member.

Note: If you select this option, the Group page will no longer be available in the Business
Object Properties window after the Business Object is created and its basic properties are
defined.

◦ Group Leader: Select this radio button to make the Business Object a Group Leader (the root
of a Group). When you create Business Objects to be Group Members under this Group
Leader, they will be listed in the Group Members section.

◦ Member of _____ Group: Select this radio button to make the Business Object a member of
an existing Group. Then, select the Group Leader in the drop-down (the existing Group
Members will be listed in the Group Members section).

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Additional Business Object Properties
After you define the basic properties for a Business Object, you can define some additional options and
behaviors. Use the Business Object Properties window to define the following additional properties:

• Lifecycle: Workflow states and behaviors (if applicable).

• Search Results: Options for including the Business Object in CSM Searches (ex: Quick Search)
and how to display a list of records in search results.

• Attachment properties: What types of Attachments are allowed for the Business Object.

• Database properties: Options for setting up a database table that represents the Business Object.

• History properties: How to keep history records (ex: Track e-mail communication, lifecycle state
changes, etc.).

• Record Locking: Override Global Record Locking settings for the Business Object and define
settings specifically for the Business Object.

• Localization: For Lookup Business Objects, enable support for translation of Lookup values. See
Enable Localization Support for a Lookup Table and Define Localization Properties for a Business
Object.

• Advanced properties: Advanced options and attributes for the Business Object.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

Good to know:

• The pages that are available in the Business Object Properties window vary depending on the type
of Business Object (Major, Supporting, Lookup, or Group).

• The Record Locking page only appears in the Business Object Properties window if record locking
is enabled for your system.

• You might see additional pages in the Business Object Properties window depending upon options
you have configured. For example, if LDAP is configured, you will see a page for LDAP attributes
that are mapped to a Business Object’s Fields. If you are sharing data with an external database,
you will see an External Data page and possibly an External Search page. If you are creating or
editing a Business Object within a mApp, you will see a mApps page.

• Business Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements
are created, edited, and deleted within a Blueprint. To commit changes to your system, you must
publish the Blueprint.

To define additional Business Object properties:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.
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The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar
to open the Business Object Editor.

c. Click the Bus Ob Properties button.

2. Define additional properties for the Business Object:

Note: You can also return to the basic properties you defined and edit them, if needed.

a. Define lifecycle properties.

b. Define search results properties.

c. Define Attachments properties.

d. Define database properties.

e. Define history properties.

f. Define record locking settings.

g. Define advanced options.

h. Define localization support (Lookup Business Objects only)

3. Click OK.3. 

The Business Object Editor opens, where you can add, edit, and delete Fields.

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Lifecycle Properties for a Business Object
Use the Lifecycle page in the Business Object Properties window to define the following:

• State field: Which Field in the Business Object holds the lifecycle state value.

• States: List of lifecycle states (ex: New, In Progress, Closed etc.) and which ones are designated as
final and recall.

• Queue options: Whether Business Object records are automatically added to or removed from
Queues based on lifecycle states.

The lifecycle states defined on this page can be used throughout the system to determine behaviors. For
example, you can define automatic Actions that are executed when a record changes states, require a
Field to contain a value before a record can change states, or order the lifecycle states in a Lookup
Object and then use it to validate Status fields.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

To define lifecycle properties for a Business Object:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar
to open the Business Object Editor.

c. Click the Bus Ob Properties button.

2. Click the Lifecycle page.

3. Select the Has Lifecycle check box. You must select this check box to define lifecycle states.

4. Define lifecycle states for the Business Object:
◦ State Field: In the drop-down, select a Field (ex: Status) to hold the value (ex: New, In

Progress, Closed, etc.) of the lifecycle state.

◦ States: Lists the lifecycle states that have been defined for the Business Object.
◦ Click Add to add a lifecycle state.
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◦ Click Edit to edit a selected lifecycle state.

◦ Click Delete to delete a selected lifecycle state.

◦ Final State: Click this button to designate a selected lifecycle state as a final state. A final state
generally indicates that a Business Object record has completed its lifecycle. Common values
include Closed, Retired, or Completed.

◦ Recall State: Click this button to designate a selected lifecycle state as a recall state. A recall
state indicates that a Business Object record that was in a final state has been reopened. This
allows for special behavior and security to limit who can recall a record and what can be done
with a recalled record.

◦ Clear State: Click this button to clear the final or recall designation from a selected lifecycle
state.

Note: The Clear State button is only active if you have a final or recall state selected.

◦ Not in Final State Text: Provide text that describes Business Object records that are not in a
final state (ex: Open). This is useful for Search Groups (ex: A search for Open Incidents will
return all Incident records in a state other than Closed, which is the final state). If a specific
value is not provided, the system will build a string based on the final state (ex: Not closed).

◦ Show Goto Final State Option in Application (the gavel): Select this check box to display the

Gavel button  on the CSM Desktop Client toolbar. Users can click this button as a shortcut
option to put Business Object records in a final state.

5. Define Queue options based on the defined lifecycle states. This allows Business Object records to
be automatically added to or removed from Queues when their states change:

Note: These options are only available if Uses Queues is selected on the General page in
the Business Object Properties window.

◦ Auto-add to User Queue: Select this check box to automatically add a Business Object record
to the User’s Queue when it enters its initial lifecycle state and the record is associated with a
particular User.

◦ Remove from User Queue when put in Final State: Select this check box to automatically
remove a Business Object record from the User’s Queue when it reaches a final state.

◦ Field with User ID: In the drop-down, select the Business Object Field that holds the ID
of the User.

◦ Auto-add to Team Queue: Select this check box to automatically add a Business Object record
to a Team’s Queue when it enters its initial lifecycle state and the record is associated with a
particular User.

◦ Remove from Team Queue when put in Final State: Select this check box to automatically
remove a Business Object record from the Team’s Queue when it reaches its final state.

◦ Field with Team ID: In the drop-down, select the Business Object Field that holds the
ID of the Team.

◦ Remove from All Queues when put in Final State: Select this check box to automatically
remove a Business Object record from all Queues when it reaches its final state.
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6. Click OK.6. 

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Search Results Properties for a Business
Object

Use the Search Results page in the Business Object Properties window to define the following:

• Full-Text and Quick Search: Whether to enable Full-Text and/or Quick Search for a Business Object.

Note: Both Quick Search and Knowledge Search use Full-Text Search. If you enable Full-
Text Search, the list of Fields is indexed for fast lookup.

• Card view: Search results appear in a more web-like interface, as a list or as large or medium cards.

• Link text: The text that appears as links in a search results list of records (using either an Expression
or Field values).

• Body text: The text that appears underneath the link text in a search results list of records (using
Field values).

• Image: An image to accompany the search results.

The options defined on the Search Results page determine how a Search Results list of records appears
in CSM. The following figure shows an example of a Search Results list of records with link text and body
text, as well as labels and subtitles included.
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Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

To define search results properties for a Business Object:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar
to open the Business Object Editor.

c. Click the Bus Ob Properties button.

2. Click the Search Results page.

3. Define general search results properties:
◦ Include in Full-Text Search: Select this check box to enable Full-Text searching for the

Business Object.

◦ Show in Quick Search: Select this check box to make the Business Object available in Quick
Search.

Note: You can only select Show in Quick Search if Include in Full-Text Search is also selected.

4. Enable card view: Select this check box to display search results in a card view format. Then, select
a default view (how the results list is displayed when it first opens; Users can change the view):

◦ Results list: Select this radio button to display search results in a web-like search results list.

◦ Large: Select this radio button to display search results as large cards (ideally, 310x155).

◦ Medium: Select this radio button to display search results as medium cards (ideally, 150x150).

5. Define link text options. This is what will be displayed as a link in a search results list:
◦ Expression: Select this radio button to use an Expression to determine the link text. Then,

select a most recently used (MRU) Expression in the drop-down, or define one using either:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.
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◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ List of Fields: Select this radio button to use the values from a list of Fields as the link text in a
search results list.

◦ Add: Click this button to add Fields to the list (you can add multiple Fields at the same
time).

◦ Delete: Click this button to delete a selected Field from the list (you can only delete one
Field at a time).

Tip: Use the Up/Down arrows   to change the order of the selected Fields. The
Field values will be displayed in this order in the search results list.

◦ Includes Label: Click a Field, and then select this check box to include the Field name in
the search results list along with the Field's value. Fields that include labels are indicated
by an icon .

◦ Show Last Modified Subtitle: Select this check box to display a subtitle underneath the link
with information regarding when and by whom the Business Object record was last modified.

6. Define body text options. This is what will be displayed under the link text in a search results list.
◦ List of Fields: Select which Fields contain the values to be displayed under the link text in a

search results list.
◦ Add: Click this button to add Fields to the list (you can add multiple Fields at the same

time).

◦ Delete: Click this button to delete a selected Field from the list (you can only delete one
Field at a time).

Tip: Use the Up/Down arrows   to change the order of the selected Fields. The
Field values will be displayed in this order in the search results list.

◦ Includes Label: Click a Field, and then select this check box to include the Field name in the
search results list along with the Field's value. Fields that include labels are indicated by an
icon .

7. Define conditions for displaying an image in a search results list of records:
◦ Show Result Image: Select this check box to define an Expression that determines when a

search results image is displayed. Then, select a most recently used (MRU) Expression in the
drop-down, or define one using either:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Results List Image Size: In the drop-down, select a size for the image to show in the results list
view (48x48, 32x32, or 16x16).
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◦ Card View Image Size: Select a size for the image to show in card view, either:
◦ Zoom to fill: Select this radio button to have the image zoom to fill the width of the picture

area, and crop as necessary.

◦ Best Fit: Select this radio button to have the image centered or resized to best fit the
available image space. If the image is smaller than the available image space, it is
centered in the picture area. If it is larger than the available image space, it shrinks to fit
the picture area.

Example: Images can be used for a Group Object (ex: Journal), with a specific image for
each Group Member in the search results list (ex: An envelope icon for Journal - Mail
History, a notepad icon for Journal - Note, etc.). You can use Expressions to show
different images for each Group Member based on status or other conditions (ex: A
closed envelope if a Journal - Mail History record is flagged as Unread, and an open
envelope if it is flagged Read). Images are also useful for Search Results List Widgets
(ex: Customer's picture next to their posted discussion topics in the Portal). If card view
is enabled and no image is used, a gray area will show where the image would be.

8. Click OK.8. 

9. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Attachments Properties for a Business
Object

Use the Attachments page in the Business Object Properties window to define which types of
Attachments Users can attach to a Business Object (ex: Imported files, Attachment Manager
Attachments, etc.).

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

To define Attachment properties for a Business Object:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar
to open the Business Object Editor.

c. Click the Bus Ob Properties button.

2. Click the Attachments page.

3. Define Attachment options:
◦ Allow Imported File Attachments: Select this check box to allow Users to import files directly

into CSM and attach them to the Business Object. In CSM, Attach a file (import) will be
available from the Attachment menu on a record.

◦ Allow Linked File Attachments: Select this check box to allow Users to link files that are on a
network drive directly to CSM and attach them to the Business Object. In CSM, Attach a file
(link) will be available from the Attachment menu on a record.

◦ Allow Linked URLs: Select this check box to allow Users to link websites to CSM and attach
them to the Business Object. In CSM, Attach a web page will be available from the Attachment
menu on a record.

◦ Allow Attachment Manager Attachments: Select this check box to allow Users to select
Attachments from the Attachment Manager and reference them from the Business Object. In
CSM, Shortcut to an Attachment will be available from the Attachment menu on a record.
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◦ Allow Arbitrary Business Object Attachments: Select this check box to allow Users to
reference other Business Objects as Attachments. In CSM, Objects will be available from the
Attachment menu on a record, with a list of available Business Objects:

◦ Allow Any Major Business Objects: Select this radio button to allow any Major Business
Object to be referenced as an Attachment. In CSM, all Major Business Objects will be
listed when Users select Objects from the Attachment menu.

◦ Allow the Following Business Objects: Select this radio button to select specific Business
Objects that can be referenced as Attachments. Then, select one or more Business
Objects in the list. In CSM, only the selected Business Objects will be listed when Users
select Objects from the Attachment menu.

Note: An arbitrarily attached Business Object can be accessed from the Attachment Bar
on the record to which it is attached, but it is not related to the Business Object and
therefore is not available for searching, navigation, etc. To allow searching, etc., consider
showing an appropriate Relationship on the Attachment Bar.

4. Define options for showing Relationships on the Attachment Bar. This allows you to display related
Business Objects in the Attachment Bar.

◦ Relationships Shown on Attachment Bar: Select which Relationships to show on the
Attachment Bar for the Business Object. This allows Users to reference related Objects as
Attachments.

◦ Attachment Menu Text: Provide text to display on the Attachment menu, or leave it blank to
use the default menu text (Choose a <child Business Object name here>).

Note: This is typically used for related items that are either rarely used or are not
important enough to warrant creating a tab in the Form Arrangement to show related
data. It also allows the User to select a record to display on a tab without exposing the
toolbar on the tab. We recommend adding only one-to-one Relationships to the
Attachment Bar, unless you expect only a few items from a one-to-many Relationship
to be attached.

5. Click OK.5. 

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.

CSM 9.3.0 Features 155

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2Fattachments%2Fattach_a_record_to_another_record.html
https://help.cherwell.com/csh?topicname=publish_a_blueprint
https://help.cherwell.com/csh?topicname=save_a_blueprint
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2Fgrids%2Fcreate-edit_a_business_object_grid.html


Define Database Properties for a Business Object
Use the Database page in the Business Object Properties window to define how to set up the database
table that represents a Business Object, including:

• Update options: Whether to enable pessimistic updates (Business Object record cannot be saved if
another User has just edited it).

• Indexes: Which Fields in the Business Object to use to create indexes (expedites searching and
record retrieval).

• Primary key: Which index to use as the table key (typically RecID).

Good to know:

• The Business Object Properties window is available in the Business Object Editor (accessed from
within the Object Manager in a Blueprint).

• All Business Objects are stored as database tables in SQL Server. Group Objects are stored in one
table (ex: The Customer table also includes all of its Group Members), except for linked External
Business Objects.

• Encrypted Fields are not stored in database tables, and cannot be indexed.

To define database properties for a Business Object:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar
to open the Business Object Editor.

c. Click the Bus Ob Properties button.

2. Click the Database page.

3. Define general database properties:
◦ Custom Storage Name: This is the name that will be used for the database table that

represents the Business Object. The Custom Storage Name is automatically populated with
the Business Object's Internal Name defined in general properties (modified as necessary to
be a legal SQL table name).
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Note: We recommend that you do not change the Custom Storage Name unless you have a
specific reason. If the name is changed, it must adhere to SQL Table naming conventions (ex:
Automatically be derived from the display name, not use invalid values such as spaces, etc.).

◦ Pessimistic Updates: Select this check box to enable pessimistic updates when Business
Object records are saved. This prevents Users from simultaneously editing records and
overwriting each other's updates.

Note: Normally, the system uses optimistic updates for saving Business Object records. With
optimistic updates, if two Users edit the same record, and then both save the record, the
changes from the last User to save the record will overwrite the changes made by the first
User. If pessimistic updates are enabled, the last User to save a record will receive a message
that the record cannot be saved because another User has just edited the record. In most
cases, using record locking is a better option.

4. Define indexes for the Business Object. Indexes speed up searching and record retrieval.

Tip: Create indexes for Fields that you expect Users to search frequently. The system automatically
creates indexes for values that it typically looks for (ex: RecID), but it is recommended that you
create indexes for the Field that holds the Public ID of an Object and for any other Fields you expect
Users to search. The system automatically creates an index for the Public ID field if you selected to
create one when you defined the Field (on the General page).

◦ Add Index: Click this button to add an index.

To add an index:

◦ Click Add Index.

An expanded view of the new index opens.

◦ Define index attributes:
◦ Name: Provide a name for the index.

◦ Primary Key: Select this box to make the index the table key. This is automatically
selected for the index on RecID (which is automatically created when you create a
Business Object).

◦ Clustered Index: Select this box to use the index to physically order the rows in the
database table. This is automatically selected for the index on RecID (which is
automatically created when you create a Business Object).

Note: Each Business Object (table) can have only one primary key and one
clustered index. If you designate more than one index as the primary key or
clustered index, you will receive an error when you click OK in the Business Object
Properties window. By default, the index for the RecID field is designated as the
primary key and the clustered index. If you assigned a RecID attribute to a different
field, then the index for the field with the RecID attribute should be the primary key
and clustered index.
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◦ Unique Index: Select this box if each of the columns in the index must have a
unique set of values so that multiple rows in the database cannot be identical. For
example, if the columns in the index are First Name and Last Name, there cannot
be two rows in the table with the values John Smith.

◦ Define the Business Object Fields that contain the values for the index in the database
table:

◦ Click Add to select Fields to include in the database index.

The Add Field to Index window opens.

◦ Click a Field to select it.

◦ Define a sort order for the Field values:
◦ Select the Ascending radio button to sort the values for the Field in

ascending order.

◦ Select the Descending radio button to sort the values for the Field in
descending order.

◦ Select Include Column to include the Field value in the index. This is an advanced
optimization feature that can be used to include additional columns needed by
queries without pulling the data from the actual table, while keeping the index key
small and efficient.

Tip: Click the Delete button to delete a selected Field from the index. Use the Up/

down arrows   to change the order of the Fields in the index. When building
indexes, the order of columns is important. Typically, the column that most limits
the results should be the first column in the index. However, following this guideline
might require many additional indexes to achieve required performance from the
database, as each index requires SQL to perform additional work for each insert,
update, and delete. In such cases, it is advisable to put columns used by many
different queries first in an index.

Note: Include columns do not have to be ordered.

◦ Click OK.◦ 

◦ Click the down arrows  to expand an existing index. From an expanded index, you can:
◦ Edit the index.

◦ Delete the index.

5. Click OK.5. 

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define History Properties for a Business Object
Use the History page in the Business Object Properties window to define options for tracking historical
information for the Business Object, including:

• History Relationship: The Business Object's Relationship to the history Object. History is tracked
using a related Group Object whose members track different types of information.

• Group Members: Which of the Group Object's members to use to track each type of history.

• How to track Field changes: Whether to track each Field change in a separate history record or
combine all changes into one, and whether to track changes for all Fields in the Business Object or
just certain ones.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

Good to know:

• In the OOTB system, the Journal Object is used to track Business Object history.

To define history properties for a Business Object:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar
to open the Business Object Editor.

c. Click the Bus Ob Properties button.

2. Click the History page.

3. Select the Business Object's Relationship to the history Object:
◦ History Relationship: In the drop-down, select the Relationship of the primary Business

Object to the history Object (ex: Incident Owns Journals).

Note: If a Relationship does not already exist, you must create one.

4. Select which of the history Object's Group Members to use for each type of history:
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◦ Manual History: Select the Business Object to use for tracking history records that are
manually added by Users.

◦ Lifecycle History: Select the Business Object to use for tracking changes to the primary
Object's lifecycle.

Note: This is only applicable if the primary object has a lifecycle. For more information, see
Define Lifecycle Properties for a Business Object.

◦ Customer Request: Select the Business Object to use for tracking Customer requests. This is
used in the Browser Client and Portal to track requests against a record (ex: Withdraw a
record, close it, etc.).

◦ Mail History: Select the Business Object to use for tracking e-mail correspondence.

◦ Queue History: Select the Business Object to use for tracking when records are added to or
removed from a Queue (Uses Queues must be selected on the General page).

◦ Knowledge History: Select the Business Object to use for associated Knowledge. If a
Knowledge source is configured to transfer its contents into a Journal - History object when the
Knowledge item is used, then a Journal - Knowledge History record is created.

◦ Change/Audit History: Select the Business Object to use for tracking change/audit logs.

◦ Chat History: Select the Business Object to use for tracking remote support session details.

5. Define options for tracking changes to Fields in the Business Object. Select one of the following
options from the Track Field Changes menu:

◦ No Tracking: Select this option to not track Field changes.

◦ Record per Change: Select this option to have one history record created for each Field that is
changed.

◦ Combine Changes: Select this option to have one history record created for all changes made
to a Business Object before it is saved.

◦ All Fields: Select this check box to track changes for all Fields in the Business Object.
Otherwise, tracking is done on a Field-by-Field basis (on the General page in the Field
Properties window, check Track Changes to Field for each Field you want to track).

6. Click OK.6. 

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.

CSM 9.3.0 Features 161

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2Fe-mail%2Ftrack_e-mail_correspondence_in_journal_-_mail_history_records.html
https://help.cherwell.com/csh?topicname=configure_the_remote_support_history_journal
https://help.cherwell.com/csh?topicname=publish_a_blueprint
https://help.cherwell.com/csh?topicname=save_a_blueprint
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2Fgrids%2Fcreate-edit_a_business_object_grid.html


Define Record Locking Settings for a Business
Object

You can override Global Record Locking settings for any Major Object using the Record Locking page in a
Major Business Object's Business Object Properties window if record locking is enabled for your system.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

Each Business Object can have one and only one record locking configuration; you cannot configure
different record locking configurations per View (ex: One for default View and one for Portal View). We
recommend configuring record locking on the default Business Object View.

To configure Record Locking settings for a Business Object:

1. Open the Business Object Properties window for a Major Business Object:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Major Business Object in the Object tree, and then click the
Edit Business Object task in the Structure area.

c. Click the Bus Ob Properties button.

2. Click the Record Locking page.

3. Select the Override the Global Locking Defaults check box.

4. Define record locking settings for the selected Major Business Objects:
a. Lock Type: Select one lock type from the following:

◦ None: Select this radio button to not enforce or inform record locking even though it is
enabled for the system.

◦ Enforced: Select this radio button to prevent Users from editing a record when it is
locked by another User (the lock holder).

◦ Informational: Select this radio button to warn Users when a record is currently locked by
another User so that Users do not attempt to edit the same record. If two Users do edit
the same record, CSM gives Users the option to merge the edits.

b. Lock Record Upon Editing: Select this check box to automatically lock the record when a User
attempts to edit the record. If not selected, Users must manually lock records.

c. Unlock Record Upon Saving: Select this check box to automatically unlock the record when a
User saves the record. If not selected, the record remains locked until the User ends his
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session (if configured), until the lock expires (if configured), or until the record is manually
unlocked.

d. Lock Expires After: Select this check box to enable lock expiration. Then, specify the time
limit in minutes (ex: 30). If not selected, the record remains locked until the User ends his
session (if configured), until the record is saved (if configured), or until the record is manually
unlocked.

e. Minutes Before Lock Expiration to Notify Users: If locks expire after a certain amount of time,
select this check box to notify Users of impending expiration and allow renewal. Then, specify
the number of minutes before expiration to notify Users (ex: 3 minutes). This only works in
the CSM Desktop Client.

f. Maximum Number of Records a User Can Have Locked at One Time (Per Business Object
Type): Specify the maximum number of records a User can have locked at one time, per
Business Object (ex: Each User can lock only 10 Incidents at a time).

5. (Optional) Restore Global Lock Settings: Click this button to revert to the default Global Record
Locking settings.

6. Click OK.6. 

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Localization Properties for a Business
Object

If Globalization is enabled for your system, you can enable localization support in Business Objects. You
can also select which Text Fields within those objects can show translated values to Users.

This enables you to have multiple versions of the same Field (one for each culture).

Note: If translated Lookup Table values are not appearing as expected, verify that validated
specific culture Fields are validated against the correct culture field. For example, the German
version of the validated Status Field should validate to a German field. For more information, see
Define Validation Properties for a Field.
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Define Advanced Properties for a Business Object
Advanced Users can use the Advanced page in the Business Object Properties window to define the
following:

• Advanced Options: Whether or not to make a Business Object cacheable or read-only, or to
associate a color with the Business Object.

• Attributes: Additional pieces of information (or meta-data) that can be associated with the Business
Object. Some attributes are automatically set, but others must be provided manually.

Note: Only advanced Users should define attributes. For more information about attributes,
please contact Cherwell Support.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in a Blueprint).

To define advanced properties for a Business Object:

1. Open the Business Object Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Business Object task in the Structure area.

The Business Object Editor opens.

Tip: You can also click the Edit Business Object button  on the Blueprint Editor Toolbar
to open the Business Object Editor.

c. Click the Bus Ob Properties button.

2. Click the Advanced page.

3. Define advanced options:
◦ Read-only: Select this check box to protect the data in the Business Object from being edited.

In CSM, Users will only be able to view the data but will not be allowed to make changes to it.

◦ Cacheable: Select this check box to have the Business Object cached for use as a validation
table. This allows the values from the Business Object to be cached instead of retrieved from
the database each time they are needed, which can improve system performance.

Note: This is the default setting for Lookup Business Objects. You might not want to cache a
Lookup Object if you expect it to change frequently or if it is very large (3MB or more). Also,
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even if a Business Object is marked for caching, the system might not cache it if it contains too
much data.

◦ Include Large Text Fields in Cache: Select this check box to also cache large text Fields (Max
Allowed and Max Searchable are checked in Field Properties) and Rich Text Fields.

Note: Large text Fields and Rich Text Fields are rarely used for validation/auto-fill. Unless
there is a need to cache these Fields, it is recommended that you do not select this check box
to reserve memory space.

◦ Associated Color: Click the Color Selector button  to open the Color Selector and select a
color to associate with the Business Object (ex: For use in Visualizations).

4. Define attributes for the Business Object:
◦ General Attributes: Click the down arrow  to expand the General Attributes section. Then,

click an empty row and provide the attribute name and associated value (if applicable). For
example, you can add the Location Aware attribute to Customer records so that users can
map records.

◦ Database Attributes: Click the down arrow  to expand the Database Attributes section.
Then, click an empty row and provide the attribute name and associated value (if applicable).

Note: Database attributes are used to indicate special attributes used for a Business Object’s
database table. Most of these are set by the system.

5. View additional advanced information for the Business Object:
◦ Business Object ID: Click this button to open a window that displays the internal ID that is

used for the Business Object. This ID can be used instead of the Business Object’s name in
many places in the system (this is particularly useful when accessing the system via the API).
The ID is used internally so that Business Objects can be renamed without breaking any
Relationships.

◦ Find Dependencies: Click this button to scan the Business Object for a list of other definitions
in the system that use this Business Object. When the scan is finished, the Definition
Dependencies window opens, listing the dependent definitions.

6. Click OK.6. 

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Business Object Actions
Use the Business Object Actions window (accessed from the Object Manager within the Blueprint Editor)
to define Actions/One-Steps that can be launched from various areas within a Business Object, including:

• Menu Actions: Actions available from an Actions menu on the menu bar for a Business Object.

• Task Pane Actions: Actions available in the Task Pane for a Business Object.

• Action Toolbar: Actions available on a Business Object's toolbar.

• Context Menu Actions: Actions available in an Actions context menu when a User right-clicks a
Business Object in a Grid or search results list.

• Print Options: One-Steps or Reports available from the File>Print menu in a Business Object.

• Automatic Actions: Actions that are automatically performed when a Business Object is created or
saved, or when it changes status.

Good to know:

• To define Actions/One-Steps for a Business Object, you must select the Show in One-Steps check
box on the General page of the Business Object Properties window.

• Automatic Actions can be defined for Supporting Objects, but they are only executed if the object is
used stand-alone. For example, if an Approval has a save Action and is edited as part of a Change
Request, the Action will not be executed. However, if the Approval is edited stand-alone, the Action
will be executed.

• Business Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements
are created, edited, and deleted within a Blueprint. To commit changes to your system, you must
publish the Blueprint.

To define Business Object Actions:

1. Open the Business Object Actions window for a Business Object:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If you are working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Define menu Actions.

3. Define Task Pane Actions.

4. Define toolbar Actions.

5. Define context menu Actions.

6. Define print options.

CSM 9.3.0 Features 167

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=blueprint_editor
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2F..%2Fshared%2Fdefine_print_options_for_a_business_object.html
https://help.cherwell.com/csh?topicname=publish_a_blueprint
https://help.cherwell.com/csh?topicname=create_a_blueprint
https://help.cherwell.com/csh?topicname=open_an_existing_blueprint
https://help.cherwell.com/csh?topicname=blueprint_editor
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2F..%2Fshared%2Fdefine_print_options_for_a_business_object.html


7. Define automatic Actions.

8. Click OK.8. 

9. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Note: Before publishing a Blueprint that contains Business Objects, ensure that each
Business Object has at least one Form and one Grid defined and that all of the appropriate
Fields have been created.
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Define Menu Actions for a Business Object
Use the Menu page in the Business Object Actions window (accessed from the Object Manager within the
Blueprint Editor) to create a Business Object-specific Actions menu. Users can select these Actions from
the CSM Desktop Client Menu Bar (ex: Incident Actions menu) when working with records for a particular
Business Object.

To create an Actions menu:

1. Open the Business Object Actions window for a Business Object:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Menu page.

3. Add Actions to the Business Object Actions menu:
a. Click the Add Action button.

Tip: Click the Delete button to remove a selected Action from the list. Use the Up/Down
arrowsto change the order of the selected Actions.

b. Select Actions to add to the menu:
◦ Add One-Step Action: Opens the One-Step Manager, where you can select an existing

One-Step or create a new one.

◦ Add Command Action: Opens the Command Manager, where you can select a
command.

◦ Add Dashboard Action: Opens the Dashboard Manager, where you can select an
existing Dashboard or create a new one.

◦ Add Report Action: Opens the Report Manager, where you can select an existing Report
or create a new one.

◦ Add Calendar Action: Opens the Calendar Manager, where you can select an existing
Calendar or create a new one.

◦ Add Search Action: Opens the Search Group Manager, where you can select an existing
Search Group or create a new one.

◦ Add Visualization Action: Opens the Visualization Manager, where you can select an
existing Visualization or create a new one.

◦ Add Action Catalog Action: Opens the Widget Manager, where you can select an existing
Action Catalog Widget or create a new one.

◦ Add Folder: Adds a folder so that you can organize Actions into subcategories.
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4. Define general properties for each new Action:
◦ Action: Displays the name of the Action as it is recognized by CSM (ex: Name of a

Dashboard).

Tip: Click the Ellipses button to open the Action Manager and select a different Action.

◦ Display text: Provide text to display on the Action.

◦ Image button:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

◦ Help text: Provide a tooltip to display when the cursor is on the Action.

5. (Optional) Define Expressions for conditionally displaying and enabling the Action:
◦ Visible: Select this check box to show/hide the Action based on an Expression. Then, select or

define an Expression, using either:
◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then

select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Enabled: Select this check box to enable/disable the Action based on an Expression. Then,
select or define an Expression, using either:

◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

6. Define additional options for the Action:
◦ Begin Group: Select this check box to display a vertical line or space (depending on the User's

selected style) before the toolbar item, separating it from other Actions on the toolbar.

7. Click OK.7. 

8. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Task Pane Actions for a Business Object
Use the Task Pane page in the Business Object Actions window (accessed from the Object Manager
within the Blueprint Editor) to define Actions that appear on the CSM Desktop Client Task Pane for a
particular Business Object (ex: Incident). Users can select these Actions from a Business Object-specific
Actions section on the CSM Desktop Client Task Pane (example: Incident Actions) when working with
records for a particular Business Object.

To add Actions to a Business Object Task Pane:

1. Open the Business Object Actions window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Task Pane page.

3. Add Actions to the Business Object Task Pane:

Tip: Click the Delete button to remove a selected Action from the list. Use the Up/Down arrows to
change the order of the selected Actions.

a. Click the Add Action button.

b. Select Actions to add to the menu:
◦ Add One-Step Action: Opens the One-Step Manager, where you can select an existing

One-Step or create a new one.

◦ Add Command Action: Opens the Command Manager, where you can select a
command.

◦ Add Dashboard Action: Opens the Dashboard Manager, where you can select an
existing Dashboard or create a new one.

◦ Add Report Action: Opens the Report Manager, where you can select an existing Report
or create a new one.

◦ Add Calendar Action: Opens the Calendar Manager, where you can select an existing
Calendar or create a new one.

◦ Add Search Action: Opens the Search Group Manager, where you can select an existing
Search Group or create a new one.

◦ Add Visualization Action: Opens the Visualization Manager, where you can select an
existing Visualization or create a new one.

◦ Add Action Catalog Action: Opens the Widget Manager, where you can select an existing
Action Catalog Widget or create a new one.
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◦ Add Folder: Adds a folder so that you can organize Actions into subcategories.

4. Define general properties for each new Action:
◦ Action: Displays the name of the Action as it is recognized by CSM (example: Name of a

Dashboard).

Tip: Click the Ellipses button to open the Action Manager and select a different Action.

◦ Display text: Provide text to display on the Action.

◦ Image button:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

◦ Help text: Provide a tooltip to display when the cursor is on the Action.

5. (Optional) Define Expressions for conditionally displaying and enabling the Action:
◦ Visible: Select this check box to show/hide the Action based on an Expression. Then, select or

define an Expression, using either:
◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then

select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Enabled: Select this check box to enable/disable the Action based on an Expression. Then,
select or define an Expression, using either:

◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

6. Define additional options for the Action:
◦ Begin Group: Select this check box to display a vertical line or space (depending on the User's

selected style) before the toolbar item, separating it from other Actions on the toolbar.

7. Click OK.7. 

8. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Toolbar Actions for a Business Object
Use the Toolbar page in the Business Object Actions window (accessed from the Object Manager within
the Blueprint Editor) to create a special Actions toolbar for a Business Object. Users can display the
Actions toolbar as part of the CSM Desktop Client toolbar and select Actions on it when working with
records for a particular Business Object.

To create an Actions toolbar:

1. Open the Business Object Actions window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Toolbar page.

3. Add Actions to the Actions toolbar:
a. Click the Add Action button.

Tip: Click the Delete button  to remove a selected Action from the list. Use the Up/Down
arrows to change the order of the selected Actions.

b. Select Actions to add to the toolbar:
◦ Add One-Step Action: Opens the One-Step Manager, where you can select an existing

One-Step or create a new one.

◦ Add Command Action: Opens the Command Manager, where you can select a
command.

◦ Add Dashboard Action: Opens the Dashboard Manager, where you can select an
existing Dashboard or create a new one.

◦ Add Report Action: Opens the Report Manager, where you can select an existing Report
or create a new one.

◦ Add Calendar Action: Opens the Calendar Manager, where you can select an existing
Calendar or create a new one.

◦ Add Search Action: Opens the Search Group Manager, where you can select an existing
Search Group or create a new one.

◦ Add Visualization Action: Opens the Visualization Manager, where you can select an
existing Visualization or create a new one.

◦ Add Action Catalog Action: Opens the Widget Manager, where you can select an existing
Action Catalog Widget or create a new one.

◦ Add Folder: Adds a folder so that you can organize Actions into subcategories.
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4. Define general properties for each new Action:
◦ Action: Displays the name of the Action as it is recognized by CSM (ex: Name of a

Dashboard).

Tip: Click the Ellipses button to open the Action Manager and select a different Action.

◦ Display text: Provide text to display on the Action.

◦ Image button:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

◦ Help text: Provide a tooltip to display when the cursor is on the Action.

5. (Optional) Define Expressions for conditionally displaying and enabling the Action:
◦ Visible: Select this check box to show/hide the Action based on an Expression. Then, select or

define an Expression, using either:
◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then

select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Enabled: Select this check box to enable/disable the Action based on an Expression. Then,
select or define an Expression, using either:

◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

6. Define additional options for the Action:
◦ Begin Group: Select this check box to display a vertical line or space (depending on the User's

selected style) before the toolbar item, separating it from other Actions on the toolbar.

◦ Show Text on Button: Select this check box to show the display text on the button along with
the image. Clear this check box to only show the image.

7. Click OK.7. 

8. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Context Menu Actions for a Business Object
Use the Context Menu page in the Business Object Actions window (accessed from the Object Manager
within the Blueprint Editor) to define context menu Actions for a Business Object. Users can right-click on
a Business Object record in a Grid or search results list (including Grids/search results shown on a
Dashboard) to access a context menu with the defined Actions.

Note: The way in which context menu Actions are made available differs in the Browser Client.
For more information, refer to the Browser Client Documentation.

To create a context menu for a Business Object:

1. Open the Business Object Actions window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Context Menu page.

3. Add Actions to the Business Object Actions context menu:
a. Click the Add Action button.

Tip: Click the Delete button  to remove a selected Action from the list. Use the Up/Down
arrows to change the order of the selected Actions.

b. Select Actions to add to the context menu:
◦ Add One-Step Action: Opens the One-Step Manager, where you can select an existing

One-Step or create a new one.

◦ Add Command Action: Opens the Command Manager, where you can select a
command.

◦ Add Dashboard Action: Opens the Dashboard Manager, where you can select an
existing Dashboard or create a new one.

◦ Add Report Action: Opens the Report Manager, where you can select an existing Report
or create a new one.

◦ Add Calendar Action: Opens the Calendar Manager, where you can select an existing
Calendar or create a new one.

◦ Add Search Action: Opens the Search Group Manager, where you can select an existing
Search Group or create a new one.
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◦ Add Visualization Action: Opens the Visualization Manager, where you can select an
existing Visualization or create a new one.

◦ Add Action Catalog Action: Opens the Widget Manager, where you can select an existing
Action Catalog Widget or create a new one.

◦ Add Folder: Adds a folder so that you can organize Actions into subcategories.

4. Define general properties for each new Action:
◦ Action: Displays the name of the Action as it is recognized by CSM (ex: Name of a

Dashboard).

Tip: Click the Ellipses button to open the Action Manager and select a different Action.

◦ Display text: Provide text to display on the Action.

◦ Image button:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

◦ Help text: Provide a tooltip to display when the cursor is on the Action.

5. (Optional) Define Expressions for conditionally displaying and enabling the Action:
◦ Visible: Select this check box to show/hide the Action based on an Expression. Then, select or

define an Expression, using either:
◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then

select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Enabled: Select this check box to enable/disable the Action based on an Expression. Then,
select or define an Expression, using either:

◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

6. Define additional options for the Action:
◦ Begin Group: Select this check box to display a vertical line or space (depending on the User's

selected style) before the toolbar item, separating it from other Actions on the toolbar.

7. Click OK.7. 

8. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Print Options for a Business Object
Use the Print Options page in the Business Object Actions window (accessed from the Object Manager
within the Blueprint Editor) to define One-Steps or Reports that can be run from a Business Object's Print
menu. Users can select these Actions from the CSM Desktop Client menu bar (File>Print) when working
with records for a particular Business Object.

To define print options:

1. Open the Business Object Actions window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Print Options page.

3. Add Actions to the Business Object's Print menu:
◦ Click the Add button to open the Action Manager. Then, select a One-Step or Report, or

create a new one.

◦ Click the Remove button to remove a selected Action from the list.

◦ Click the Make Default button to make the selected One-Step or Report the option the default
selection when a User clicks Print from a Business Object's file menu. This is also the print
option that will run (without prompting) when a User clicks the Print button on the toolbar.

◦ Use the Up/Down arrows to change the order of the selected options.

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Automatic Actions for a Business Object
Use the Automatic Actions page in the Business Object Actions window (accessed from the Object
Manager within the Blueprint Editor) to set up One-Steps that automatically run when a Business Object is
created, saved, or changes status.

Good to know:

• Although any One-Step can be executed as part of an automatic Action, we recommend using only
One-Steps that do not require User feedback because Business Objects can be created and saved
without User interaction. For example, the E-mail and Event Monitor can automatically create and
save records. In addition, the Browser Client can execute automatic Actions, but does not allow for
feedback (ex: Prompts).

To create a list of Automatic Actions:

1. Open the Business Object Actions window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If you are working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Actions task in the Structure area.

2. Click the Automatic Actions page.

3. Add Actions to the list of the Automatic Actions:
a. Select a category (Create Actions, Save Actions, or State Change Actions).

b. Click the Add button  to open the One-Step Manager, and then select an existing One-Step
or create a new one.

c. Click OK.c. 

4. Define general properties for each new Action:
◦ Action: Displays the name of the One-Step as it is recognized by CSM.

Tip: Click the Ellipses button to open the Action Manager and select a different Action.

◦ Notes: Provide information that further describes or clarifies the Automatic Action. If the One-
Step has a description, it is displayed here.

◦ Condition: Select this check box to have the Automatic Action executed based on a condition,
and then select or define an Expression, using either:

◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.
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◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Show Progress: Select this check box to have CSM display a progress indicator while the
One-Step is running.

5. Define when the Automatic Action will be executed:

Note: Create Actions do not have additional options for determining when they are
executed. They are always executed when a new Business Object record is created.

◦ For Save Actions:
◦ Execute on First Save: Select this check box to have the Action automatically executed

for newly created records.

◦ Execute on Additional Saves: Select this check box to have the Action automatically
executed when saving existing records.

◦ Execute Before Saving Record: Select this check box to have the Action automatically
executed immediately before the Business Object record is saved.

Note: Certain options within a One-Step will not occur when it is used as an automatic
Action. For example, if a One-Step is run before the record is saved and includes the
option to save the current record, the record will not be saved twice. Also, if the One-
Step initiates a save, the Actions will not be rerun a second (and possibly recursive)
time.

◦ For State Change Actions:
◦ State: In the drop-down, select the status that will trigger the Automatic Action.

◦ Execute Before Saving Record: Select this check box to have the Action automatically
executed when the Business Object record changes to the selected status. Clear this
check box to have the Action automatically executed when the Business Object record is
saved after reaching the selected status.

6. Click OK.6. 

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Scan a Business Object
Use the Business Object Scan operation in the Object Manager to periodically check for potential errors in
a Business Object that you are creating or editing. The scan will look for missing items and alert you to
any changes you need to make.

To scan a Business Object:

1. Open the Object Manager.

2. Click a Business Object in the Object tree, and then click the Scan for Problems task in the
Structure area.

If the scan is successful, a success window opens.

If the scan detects errors, an error window opens.

Examples: You will receive warnings if you create a Business Object without also creating a Form
and Grid, if the Business Object does not contain the necessary Fields (ex: It must have an E-mail
Address field to be included in the CSM Address Book), a Form references a Field that has been
deleted, the Business Object does not have any database indexes, etc.
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Undo Business Object Changes within a Blueprint
Use the Undo Changes Made in Blueprint operation in the Object Manager to undo any changes you
have made to a Business Object within a work in progress Blueprint. This removes all Business Object
changes (within a particular Business Object View) from a Blueprint file before it has been published.

Good to know:

• The Undo Changes Made in Blueprint operation is available only for Business Objects that have
been edited within the open Blueprint.

• Undoing changes to a Business Object only removes the changes from a working Blueprint file. If
you have published the Blueprint, the changes have already been applied to your system and can
only be removed using a rollback Blueprint (created when you publish a Blueprint). Publish a
Rollback Blueprint file to undo changes made after the Blueprint has been published.

• An Edit icon, along with italicized text and an asterisk, indicates which Business Objects have been
changed within the open Blueprint (in the selected View). For example,  indicates that
the Incident Business Object has been edited.

To undo Business Object changes:

1. Open the Object Manager

2. Select the Business Object View in which the Business Object changes were made.

3. Click a Business Object in the Object tree, and then click the Undo Changes Made in Blueprint
task in the Structure area.

4. Click Yes to remove the Business Object changes from the working Blueprint file. This also removes
any changes to Forms, Grids, Form Arrangements, Relationships, and Actions within the Blueprint.

CSM 9.3.0 Features 181

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=publish_a_blueprint
https://help.cherwell.com/csh?topicname=publish_a_rollback_blueprint_file_to_undo_changes
https://help.cherwell.com/csh?topicname=publish_a_rollback_blueprint_file_to_undo_changes


Add a Business Object to a Blueprint
Use the Add to Blueprint operation in the Object Manager to add a Business Object and its associated
Forms, Grids, and Form Arrangements to a Blueprint. Items added to a Blueprint will completely overwrite
the existing ones in your system when the Blueprint is published.

To add a Business Object to a Blueprint:

1. Open the Object Manager.

2. Click a Business Object in the Object tree, and then click the Add to Blueprint task in the
Structure area.

3. Define which Business Object definitions to include in the Blueprint:
◦ Add Business Object: This check box is read-only. It indicates that the Business Object is

included in the Blueprint.

◦ Add Associated Relationships: Select this check box to add the Business Object's
Relationships to the Blueprint.

◦ Add Associated Forms: Select this check box to add the Business Object's Forms to the
Blueprint.

◦ Add Associated Grids: Select this check box to add the Business Object's Grids to the
Blueprint.

◦ Add Associated Arrangements: Select this check box to add the Business Object's Form
Arrangements to the Blueprint.

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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View Blueprint Changes for a Business Object
View Blueprint changes for a Business Object to see which definitions associated with a particular
Business Object will be changed by the active Blueprint when it is published. When you view Blueprint
changes for a Business Object, you can:

• Select how to display changes (group by Business Object, Definition Type, or View).

• Search for specific Business Object changes.

• Remove Business Object changes from the Blueprint.

• Compare the Business Object changes with the original system definitions.

Note: The Blueprint Changes window for a particular Business Object is similar to the
Blueprint Changes window, except that it only shows changes that were made to a particular
Business Object within a Blueprint.

The Blueprint Changes window for a Business Object can be opened from the Object Manager within an
existing Blueprint.

To open the Blueprint Changes window for a Business Object:

1. In CSM Administrator, open an existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. Click a Business Object in the Object tree, and then click the View Blueprint Changes for
<Business Object> task in the Structure area.

Note: The View Blueprint Changes for <Business Object> operation is only available if
changes have been made to the selected Business Object within the open Blueprint.
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1. Display: Groups changes in the tree by Business Object, Definition, or View.
◦ By Business Object: Groups changes by the Business Object.

◦ By Definition Type: Groups changes by the types of definitions associated with the Business
Object (ex: Forms).

◦ By View and then Business Object: Groups changes by View (ex: Default, Portal Default) and
then by Business Object.

◦ By View and then Definition Type: Groups changes by View (ex: Default, Portal Default) and
then by the types of definitions associated with the Business Object (ex: Forms).

2. Search: Searches for changes by keyword or phrase.
a. In the Search Box, provide a word or phrase to search for. The drop-down displays the most

recently used (MRU) searches.

b. Click Go to run the search. The items containing the specified word or phrase are displayed
within their hierarchical structure.

3. Business Object Changes Tree: Displays changes in a hierarchical tree grouped by the selected
display option.

◦ Click the arrow next to a category (Business Object, Definition Type, or View) to expand it and
view its changes. Click the arrow again to collapse it.

Tip: Right-click a category or change to open a context menu, and then select options to
expand/collapse the tree, remove changes, or compare definitions.

4. Remove/Compare:
◦ Click Remove to remove a selected item from the Blueprint (it is not removed from the

system).

◦ Click Compare to compare the Business Object change with the existing system definition.
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Note: Remove and Compare are only enabled when an individual change is selected.
Changes cannot be removed or compared by selecting display categories (Business
Object, Definition Type, or View). A change can only be compared if an existing
definition is edited or updated in the Blueprint; newly added definitions cannot be
compared (there is nothing to compare them to).
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Export a Business Object Schema
A Business Object Schema is a collection of meta-data that is exported from your system as a single
document (.html, .rtf, .txt, or .xml) to textually expose definitions associated with a particular Business
Object. Use a Business Object Schema to quickly and easily scan the characteristics of a Business
Object.

Note: To export a Schema that contains meta-data for multiple Business Objects within a
Blueprint, refer to Export a Blueprint Schema.

You can export the following meta-data for a Major, Supporting, or Lookup Object:

• Properties

• Lifecycle

• Fields (and Field Properties)

• Relationships (and Relationship properties)

• One-Steps

• Approvals

• Automation Processes
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To export a Business Object Schema:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Object Manager, click a Business Object in the Object tree, and then click the Export
Business Object Schema task in the Structure area.
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3. Select the items (meta-data) to export in the Schema:
◦ Business Object Properties

◦ Business Object Lifecycle

◦ Fields

◦ Relationships

◦ One-Steps

◦ Approvals

◦ Automation Processes

4. Click OK.4. 

5. Provide a location, filename, and file type (.html, .rtf, .txt, or .xml) for the Schema, and then click
Save.

The selected meta-data is exported to a Schema file. You can then open and view the Business
Object Schema in a viewing tool, such as Microsoft Word.
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View the Business Object Publish Log
Use the Business Object Publish Log to view detailed information about definitions associated with a
particular Business Object that have been published to your system (using a Blueprint).

Note: The Business Object Publish Log is similar to the Blueprint Publish Log, except that it only
shows changes that were made to a particular Business Object within one or more Blueprints.

The log tracks the following details in a Grid:

• A short description of the change made to a Business Object's definitions when the Blueprint was
published.

• Type (ex: Form) and name (ex: Incident) of the Business Object definitions that were changed.

• User Name of the person who published the Blueprint.

• Dates/times that the Blueprint publish was initiated and completed.

• Scope of the Business Object definition, as well as the scope owner (if applicable).

• User-defined name of the Blueprint file (.bp) in which the Business Object changes were published.

• Business Object association (the name of the Business Object for which you are viewing the Publish
Log).

• The view (ex: Portal Default) that the Business Object changes apply to (if applicable).

• The path where the Blueprint files were saved (if applicable).

The Business Object Publish Log can be opened from the Object Manager within a Blueprint.

To open the Business Object Publish Log:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. Click a Business Object in the Object tree, and then click the View Publish Log task in the
Structure area.

The Publish Log opens for the selected Business Object.
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1. Menu Bar. Click the File menu to perform the following operations:
◦ Clear Log: Select this option to clear all entries in the log, or to clear all entries prior to a

specified date.

◦ Export: Select this option to export the Grid of Publish Log data to a file.

◦ Print: Select this option to print the Grid of Publish Log data.

◦ Close: Select this option to close the Publish Log window.

Tip: You can also select Clear Log, Export, and Print in a context menu by right-clicking an
item in the Publish Log.

2. Toolbar: Shows the View drop-down, which is how the Publish Log is filtered.
◦ All Records: Shows everything related to a Business Object that was published in a Blueprint.

◦ Definition Type: Shows all Business Object definitions of a particular type (ex: Form). When
selecting this option, a Definition drop-down is displayed on the toolbar, and then select a
definition type.

◦ Only Definition Changes: Shows only the Business Object definitions that were changed by
a published Blueprint.
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◦ Particular User: Shows the Business Object definitions that were published by a particular
User. When selecting this option, a User drop-down is displayed on the toolbar, and then
select a User.

◦ View: Shows the Business Object definitions that apply to a particular View (ex: Default).
When selecting this option, a View drop-down is displayed on the toolbar, and then select a
View.

3. Refresh: Click this button to refresh the data in the Publish Log.

4. Main Pane: Displays the Grid of Publish Log data, filtered by View.
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Configuring Business Objects
To configure Business Objects in CSM Administrator, Configure Business Object rights for a Security
Group.

CSM 9.3.0 Features 192

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=define_business_object_rights_-access_to_data-


Fields
A Field is a basic unit of information (example: ID, last name, address, etc.) that is specific to a Business
Object (example: Incident, Problem, Service, Customer, etc.). Each Field holds a single piece of data and
has a unique name and properties to define the types of values it can contain and how it behaves. Fields
can be stored in the database along with the Business Object, or calculated on the fly.
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About Fields
Use Fields to store and/or display information that is relevant to a Business Object. Fields can be exposed
in CSM using Field Controls on a Form to display relevant information (example: Status), or to allow
Users to provide or select data (example: Description, Priority, Category, Sub-category, etc.).

Each Field can hold one of the following types of information:

•  Text: Letters, numbers, and/or special characters. Text Fields are the most versatile type of
Field, and are usually the main Fields displayed in a Form (example: Name, Description, Status,
etc.). They can be either plain text (no special formatting) or Rich Text (special formatting and
embedded images).

•  Number: Digits, including whole numbers and decimals, negative numbers, and currency.
Number Fields can be used to record statistics (example: How many times an Incident has been
escalated), calculate numbers (example: Total Tasks associated with an Incident), and track time
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(example: How long it takes to complete a Task) and costs (example: Actual cost of an emergency
change).

•  Date/Time: Dates and/or times. Date/time Fields can be used to track deadlines (example: SLA
Respond By Deadline, Review By Deadline), when records are created, modified, or change status,
and when certain events are scheduled (example: Service blackouts, CI downtimes, etc.).

•  Logical: True or false. Logical fields can be used to track activities (example: Responded to the
Customer) and items of interest to management (example: Resolved on First Call), and to flag
important records (example: VIP Customer, has an SLA, etc.).

Fields can have any of the following properties:

• Required: Must contain a value before a Business Object can be saved, or before it enters the next
lifecycle state.

• Read-Only: Value cannot be edited or updated.

• Calculated: Value is calculated by evaluating an Expression.

• Validated: Must contain a value from a defined set of values (example: Validation table, list, range,
etc.).

• Auto-populated: Automatically filled in based on defined conditions (example: When another
Field's value changes, using a Group Map, etc.).

You can also define when certain properties apply (example: Always, never, based on lifecycle states or
on another Field, System Function, Stored Value, Expression, etc.).

CSM provides many Fields for its OOTB Business Objects. Use these as-is, edit them, or create your own
using the Business Object Editor (accessed from within a Blueprint in CSM Administrator).
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Fields Good to Know
• Use the Business Object Editor (accessed from within a Blueprint in CSM Administrator) to define

and edit the various aspects of a Field. In the Business Object Editor, you can:
◦ Create, edit, or delete Fields for a Business Object.

◦ Access the Field Properties window, where you can define and edit properties for a Field.

• Fields in major Business Objects can be encrypted to prevent unauthorized access to sensitive
information (ex: Identity information, financial data, etc.).

• Business Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements
are created, edited, and deleted within a Blueprint. To commit changes to your system, you must
publish the Blueprint.

• CSM provides many Fields for its OOTB Business Objects. Use these as-is, edit them, or create
your own using the Business Object Editor (accessed from within a Blueprint in CSM Administrator).

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to Business Object data and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit security groups). For more
information, refer to Define Business Object Rights.
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Using Fields
Use Fields to view and provide the basic units of information (ex: Name, date, descriptions, etc.) that are
relevant to a Business Object. When working with Fields, Users can:

• Provide data in Business Object Forms. For example:
◦ Log an Incident

◦ Create a Service Catalog

◦ Log a Problem

◦ Create a Configuration Item

◦ Log a Standard Change

◦ Log a Knowledge Article

• Display a Stored Value in a Field on a Form (ex: Company Name).

• View Field values from Grids and Search Results Lists.

• Insert Fields as Tokens in One-Steps, Expressions, Searches, etc. that have a Business Object
association.
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Managing Fields
Fields are managed in CSM Administrator using the Business Object Editor, accessed from within a
Blueprint in CSM Administrator. Use this tool to:

• Create, edit, or delete Fields for a Business Object.

• Access the Field Properties window, where you can define and edit properties for a Field.
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Create/Edit a Field
Use the Business Object Editor and/or the Field Properties window to create and edit Fields for a
Business Object.

To create a Field for a Business Object:

1. Open the Business Object Editor.

2. In an empty row (marked by a Create New icon) in the Business Object Editor Grid, provide general
information for the new Field:

Option Description

Name Provide a display name for the Field.

Type Select a Field type (Text, Number, Date/Time, or
Logical).

Size Select a Field size, which can vary by Field type.

Tip: You can edit general information for an existing Field directly in the Business Object
Editor Grid. Or, click the Field Properties button to open the Field Properties window, where
you can edit general information as well as detailed properties for a selected Field. Use the
Up/Down arrows in the Business Object Editor to change the order of selected Fields.

3. Click the Field Properties button.

4. Define or edit Field properties:
a. Define general properties for a Field.

b. Define process and procedure help for a Field.

c. Define detailed properties for a Field.

d. Define validation/auto-populate properties for a Field.

e. Define Group Properties for a Field (only applicable if Field belongs to a Group Object).

f. Define advanced properties for a Field.

g. Click OK.g. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Editing a Field
To edit a Field:
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1. Select a Field in the Business Object Editor.

2. Make changes:
◦ Edit general Field properties directly in the Business Object Editor Grid.

◦ Click the Field Properties button to open the Field Properties window and edit additional
properties. Then, click OK.

3. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Open the Field Properties Window
To open the Field Properties window:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task or open an existing Blueprint..

2. The Blueprint Editor opens, showing the Object Manager in its Main Pane.
3. Slick a Business Object in the Object tree, and then click the Edit Business Object task in the

Structure area.
4. Click a new or existing Field, and then click the Field Properties button.
5. You can then:

◦ Define Detailed Properties for a Field.
◦ Define Process and Procedure Help Properties for a Field
◦ Define Detailed Properties for a Field
◦ Define Validation/Auto-Population Properties for a Field
◦ Define Advanced Properties for a Field
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Define General Properties for a Field
Use the General page in the Field Properties window to define general properties for a Field.

To define general properties for a Field:

1. Open the Field Properties window.

2. Click the General page.

3. Define general information for the Field:

Option Description

Name Provide a display name for the Field.

Internal Name

When you provide a display name, the internal
name is automatically populated with the Field
display name (can be changed if needed). The
internal name is the name given to the Field in the
Business Object's database table. An internal
name can only have letters, digits, and underscore
characters.

(Optional) Description Provide a description.

Field Type Select a Field type (Text, Number, Date/Time, or
Logical).

Track Changes to Field

Select this check box to track changes made to the
Field in the Business Object's history.

Note: For Field changes to be tracked, the
Business Object must have a history
Relationship and Track Field Changes
defined on the History page of the
Business Object Properties window. This
check box must be selected if the Field will
be encrypted (enabled in Advanced
properties); decrypting Fields is tracked in
Journal-History records.

4. Define general Field properties (varies based on Field type):
◦ Define properties for a Date/Time Field.

◦ Define properties for a Number Field.

◦ Define properties for a Text Field.

Note: Logical Fields do not have any additional User-defined general properties. They
can hold only one of two values: True or False (alternatively, Yes or No).
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5. Click OK.5. 

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define General Properties for a Date/Time Field
Select the Date/Time Field type from the General page of the Field Properties window to define a Field
that contains date and/or time information.

To define general properties for a Date/Time Field:

1. Open the Field Properties Window.

2. On the General page of the Field Properties window, select Date/Time in the Field Type drop-down.

3. Define general Date/Time Field properties:

Option Description

Date and Time Select to allow the Field to hold both a date and a
time.

Date only Select to allow the Field to hold a date only.

Time only Select to allow the Field to hold a time only.

Timestamp Select to have the Field hold a system timestamp.

4. Select the Adjust for time zones check box to have the Field automatically adjust the date and/or
time based on your computer's time zone settings.

5. Click OK.5. 

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define General Properties for a Number Field
Select the Number Field type from the General page of the Field Properties window to define a Field that
contains numeric information.

To define general properties for a Number Field:

1. Open the Field Properties Window.

2. On the General page of the Field Properties window, select Number from the Field Type drop-down.

3. Define the digit and decimal properties for the Field.

Option Description

Whole Digits Provide the number of whole digits the Field is
allowed to hold.

Decimal Digits Provide the number of digits that can appear after
the decimal point in the Field.

Note: Whole digits cannot contain more than 9 digits if you do not include decimals and
cannot contain more than 27 digits if you use decimals. The combined number of whole
digits plus the number of decimal digits cannot be greater than 38.

4. Select the Allow negative numbers check box to allow the Field to contain negative numbers.

5. Select the Holds Currency check box to make the Field a Field that holds currency values. Then,
select a Currency Culture in the drop-down to show the appropriate currency symbol in the Field
(example: English (United States) shows the dollar sign in front of the currency value). The system
default is based on your computer's region and language settings.

6. Click OK.6. 

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define General Properties for a Text Field
Select the Text Field type from the General page of the Field Properties window to define a Field that
contains text. The properties vary depending on whether the Field is plain text or Rich Text.

Note: Rich Text Fields cannot be encrypted.

To define general properties for a Text Field:

1. Open the Field Properties Window.

2. On the general page of the Field Properties window, select Text from the Field Type drop-down.

3. Define whether the Field is plain text or Rich Text:
◦ Plain Text: Select this option to store plain text with no formatting or images in the Field.

◦ Rich Text: Select this option allow Rich Text formatting in the Field.

4. If you selected Plain Text, define these properties:

Option Description

Length
Select to define a specific length for the Field. Then,
provide the maximum number of characters the Field
can contain.

Max Allowed Select to allow the maximum number of characters in
the Field (creates a "text" Field type in SQL Server).

Max Searchable
Select to allow the maximum number of characters for
searchable text Fields (creates a "varchar 8000" field
in SQL Server).

Allow Multiple Lines Select to allow the Field to contain two or more lines of
text.

Allow Spell-Check

Select this check box to turn on spell-checking for the
Field. This will check for spelling errors in content that
is provided in the Field.

This option is only available if spell-checking is
enabled in the Business Object's general properties.
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Option Description

Format

Select to use a Format to enforce how characters and
digits are displayed in the Field (example: Phone
number format). You can use either:

◦ Stored Format: Click the Ellipses button  to
open the Stored Format Manager, where you can
select an existing Format or create a new one.

◦ Custom Format: Click the Custom Format

button  to open the Custom Format Builder,
where you can create a custom Format to use
only for this scenario.

5. If you selected Rich Text, define properties described in Enable Rich Text on Business Object
Fields.

6. Define additional Field properties:
◦ Include in Full-Text Search: Select this check box if the Field should be indexed for Full-Text

Search (used by CSM Quick Search and Knowledge Search).

◦ Holds: Select a hold property that identifies the type of data contained in the Field. For
example, set a record ownership "Holds" property on an Owned By Field to identify the name
in the Field as a record owner.

7. Click OK.7. 

8. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Process and Procedure Help Properties for
a Field

Use the Process and Procedure Help page in the Field Properties window to provide additional
information to Users.

Good to know:

• If you do not see the Process and Procedure Help page, verify that the Show Process and
Terminology Help setting is enabled. For more information, see Configure Global Help Settings.

• If the Process and Terminology section does not appear on the CSM Desktop Client Task Pane,
verify that it is enabled in the User Task Pane and Search Control Settings.

To define process and procedure help for a Field:

1. Open the Field Properties window.

2. Click the Process and Procedure Help page.

3. In the Process and Procedure Text box, provide text that includes important information for Users
who work with the Field. The text you provide is shown in the CSM Desktop Client Task Pane when
the Field is selected.

4. Optionally, in the Additional Help URL box, provide a URL to an external site. Then, click the
Ellipses button to navigate to the URL and ensure it is correct.

5. Select the Information is Relevant to ITIL check box to add an icon  to the Process and
Terminology section of the CSM Desktop Client Task Pane.

6. Select the Information is Relevant to KCScheck box to add a KCS (Knowledge-Centered Support
icon  to the Process and Terminology section of the CSM Desktop Client Task Pane.

7. Click OK.7. 

8. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Detailed Properties for a Field
Use the Properties page in the Field Properties window to:

• Define General Behaviors for Fields

• Define Field Behaviors Based on Lifecycle State

Note: Encrypted Fields cannot have default or calculated values, or set values based on lifecycle
state.

1. Open the Field Properties window.

2. Click the Properties page.

3. Define general behaviors for the Field.

4. Define behaviors based on lifecycle state.

5. Click OK.5. 

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define General Behaviors for Fields
Setting Required Fields

Setting Read-only Properties

Setting Default Values

Setting Calculated Values

Setting Required Fields
Select the Required for Save check box to always require the Field to contain a value before the
Business Object can be saved.

You can also click the down arrow to expand the section and select another option.

Option Description

Always required for save
Select to always require the Field to contain a value
before the Business Object can be saved. This is the
same as selecting Required for Save.

Never required for save Select to never require the Field to contain a value before
the Business Object can be saved.

Field
Select to use a logical Field to determine whether the
Field is required before the Business Object can be
saved. Then, select a Field in the drop-down.

Function
Select to use a System Function to determine whether
the Field is required before the Business Object can be
saved. Then, select a System Function in the drop-down.

Stored Value

Select to use a Stored Value to determine whether the
Field is required. Then, select a most recently used
(MRU) Stored Value in the drop-down, or click the
Ellipses button to open the Stored Value Manager,
where you can select an existing Stored Value or create
a new one.
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Option Description

Expression

Select to use an Expression to determine whether the
Field is required before the Business Object can be
saved. You can use either:

• Stored Expression: Click the Ellipses button to
open the Expression Manager, and then select an
existing stored Expression or create a new stored
Expression. Stored Expressions can be reused in
numerous places in CSM.

• Custom Expression: Click the Custom Expression
button to open the Custom Expression Builder, and
then create a custom Expression specifically for this
scenario.

Setting Read-only Properties
Select the Read-only check box to make the Field to prevent Users from adding provide data for the
Field.

You can also click the down arrow to expand the section and define additional read-only options.

Option Description

Always read-only Select to make the Field always read-only.

Never read-only Select to prevent the field from ever being the Field
read-only.

Field
Select to use a logical Field to determine whether the
Field is read-only. Then, select a Field in the drop-
down.

Function
Select to use a System Function to determine
whether the Field is read-only. Then, select a System
Function in the drop-down.

Stored Value

Select to use a Stored Value to determine whether
the Field is read-only. Then, select a most recently
used (MRU) Stored Value in the drop-down, or click
the Ellipses button to open the Stored Value
Manager, where you can select an existing Stored
Value or create a new one.

CSM 9.3.0 Features 211

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2Fexpressions%2Fabout_expressions.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2Fsystem_functions%2Fabout_system_functions.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fbusiness_objects%2F..%2Fstored_values%2Fabout_stored_values.html


Option Description

Expression

Select this radio button to use an Expression to
determine whether the Field is read-only. You can use
either:

• Stored Expression: Click the Ellipses button to
open the Expression Manager, and then select
an existing stored Expression or create a new
stored Expression. Stored Expressions can be
reused in numerous places in CSM.

• Custom Expression: Click the Custom
Expression button to open the Custom
Expression Builder, and then create a custom
Expression specifically for this scenario.

Property changes based on lifecycle

Select to make the Field read-only when the Business
Object is in a selected lifecycle state. Then, select a
lifecycle state in the drop-down.

Note: Options based on lifecycle state only
appear if the Business Object has defined
lifecycle states.

Use default setting

Select to use the default options for the selected
lifecycle state. Clear the check box to select another
option for determining whether the Field is read-only
when the Business Object is in the selected lifecycle
state.

Setting Default Values
Provide a default value to use as the initial value of the Field until a User changes the value.

Click the down arrow to expand the section and select an additional option.

Option Description

Legal Values 

Click the Legal Values button to open the Quick Selector
for the Field and select a valid value to use as the default.

Note: If the Field is validated, the Legal Values
button is activated. Click it to open the Quick
Selector for the Field and select a valid value.

Value

Select to define your own default value. If the Field is
validated, the Legal Values button is activated. Select it to
open the Quick Selector for the Field and select a valid
value to use as the default value.
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Option Description

Function
Select this radio button to use a System Function to
determine the Field's default value. Then, select a System
Function in the drop-down.

Stored Value

Select to use a Stored Value to determine the Field's
default value. Then, select a most recently used (MRU)
Stored Value in the drop-down, or click the Ellipses button
to open the Stored Value Manager, where you can select
an existing Stored Value or create a new one.

Expression

Select this radio button to use an Expression to determine
the Field's default value. You can use either:

• Stored Expression: Click the Ellipses button to open
the Expression Manager, and then select an existing
stored Expression or create a new stored
Expression. Stored Expressions can be reused in
numerous places in CSM.

• Custom Expression: Click the Custom Expression
button to open the Custom Expression Builder, and
then create a custom Expression specifically for this
scenario.

Property changes based on lifecycle

Select to use the default value when the Business Object
is in a selected lifecycle state. Then, select a lifecycle state
in the drop-down.

Note: Options based on lifecycle state only
appear if the Business Object has defined
lifecycle states.

Use default setting

Select to use the (default) options for the selected lifecycle
state. Clear the check box to select another option for
determining the Field's default value when the Business
Object is in the selected lifecycle state.

Setting Calculated Values
Select the Calculated Value check box to use an Expression to calculate a value for the Field. Then, click
the Ellipses button to open the Expression Manager, where you can select an existing stored Expression
or create a new stored Expression to calculate the Field's value.

You can also click the down arrow to expand the section and select an option for defining a calculated
value.

Option Description

None
Select to not use a calculated value for the Field.
Selecting this radio button will clear the Calculated
Value box.
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Option Description

Expression

Select this radio button to use an Expression to
calculate a value for the Field. You can use either:

• Stored Expression: Click the Ellipses button to
open the Expression Manager, and then select
an existing stored Expression or create a new
stored Expression. Stored Expressions can be
reused in numerous places in CSM.

• Custom Expression: Click the Custom
Expression button to open the Custom
Expression Builder, and then create a custom
Expression specifically for this scenario.

Property changes based on lifecycle

Select o have the Field's value calculated when the
Business Object is in a selected lifecycle state. Then,
select a lifecycle state in the drop-down.

Note: Options based on lifecycle state only
appear if the Business Object has defined
lifecycle states.

Use default setting

Select to use the (default) options for the selected
lifecycle state. Clear the check box to select another
option for calculating the Field's value when the
Business Object is in the selected lifecycle state.

Setting Values Before Saving
Provide a value in the Value to set before save box to set in the Field before the Business Object is
saved.

You can also click the down arrow to expand the section and define additional value options.

Option Description

Legal Values 

Click the Legal Values button to open the Quick
Selector for the Field and select a valid value to use.

Note: If the Field is validated, the Legal Values
button is activated. Click it to open the Quick
Selector for the Field and select a valid value.

Set to blank Select to clear the Field of any values when the
Business Object is saved.
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Option Description

Value

Select to define a value to set for the Field when the
Business Object enters its final state. Then, type a value.

Note: If you provided a value in the section
heading (next to Value to set before save), this
radio button is automatically selected and the
value you provided is displayed here.

Field Select this radio button to set the value with another
Field's value. Then, select a Field in the drop-down.

Function
Select this radio button to use a System Function to
determine the Field's value. Then, select a System
Function in the drop-down.

Stored Value

Select to use a Stored Value to determine the Field's
value. Then, select a most recently used (MRU) Stored
Value in the drop-down, or click the Ellipses button to
open the Stored Value Manager, where you can select
an existing Stored Value or create a new one.

Expression

Select this radio button to use an Expression to
determine the Field's value. You can use either:

• Stored Expression: Click the Ellipses button to
open the Expression Manager, and then select an
existing stored Expression or create a new stored
Expression. Stored Expressions can be reused in
numerous places in CSM.

• Custom Expression: Click the Custom Expression
button to open the Custom Expression Builder, and
then create a custom Expression specifically for
this scenario.
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Define Field Behaviors Based on Lifecycle State
Options based on lifecycle state only appear if the Business Object has defined lifecycle states.

Setting Final State Behaviors

Setting Values for Final States

Setting Required for State Change Properties

Setting Values Before State Changes

Setting Final State Behaviors
Select the Required for <final state> check box to require the Field to contain a value before the
Business Object can enter its final state (example: Closed).

You can also click the down arrow to expand the section and select another option.

Option Description

Always required for <final state> Select to always require the Field to contain a value
before the Business Object can enter its final state.

Never required for save Select to never require the Field to contain a value
before the Business Object can enter its final state.

Field
Select to use a logical Field to determine whether the
Field is required before the Business Object can enter
its final state. Then, select a Field in the drop-down.

Function

Select to use a System Function to determine whether
the Field is required before the Business Object can
enter its final state. Then, select a System Function in
the drop-down.

Stored Value

Select to use a Stored Value to determine whether the
Field is required before the Business Object can enter
its final state. Then, select a most recently used (MRU)
Stored Value in the drop-down, or click the Ellipses
button to open the Stored Value Manager, where you
can select an existing Stored Value or create a new
one.
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Option Description

Expression

Select this radio button to use an Expression to
determine whether the Field is required before the
Business Object can enter its final state. You can use
either:

• Stored Expression: Click the Ellipses button to
open the Expression Manager, and then select an
existing stored Expression or create a new stored
Expression. Stored Expressions can be reused in
numerous places in CSM.

• Custom Expression: Click the Custom
Expression button to open the Custom
Expression Builder, and then create a custom
Expression specifically for this scenario.

Setting Values for Final States
Provide a value to set when the Business Object enters its final state.

You can also click the down arrow to expand the section and define additional options.

Option Description

Set to blank

Select to clear the Field of any values when the
Business Object enters its final state.

Note: If the Field is validated, the Legal Values
button is activated. Click it to open the Quick
Selector for the Field and select a valid value.

Value

Select to define a value to set for the Field when the
Business Object enters its final state. Then, provide a
value.

Note: If you provided a value in the section
heading (next to Value to set for <final state>),
this radio button is automatically selected and
the value you provided appears here.

Field Select to set the value with another Field's value. Then,
select a Field in the drop-down.

Function
Select this radio button to use a System Function to
determine the Field's value. Then, select a System
Function in the drop-down.
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Option Description

Stored Value

Select to use a Stored Value to determine the Field's
value. Then, select a most recently used (MRU) Stored
Value in the drop-down, or click the Ellipses button to
open the Stored Value Manager, where you can select
an existing Stored Value or create a new one.

Expression

Select to use an Expression to determine the Field's
value. You can use either:

• Stored Expression: Click the Ellipses button to
open the Expression Manager, and then select an
existing stored Expression or create a new stored
Expression. Stored Expressions can be reused in
numerous places in CSM.

• Custom Expression: Click the Custom Expression
button to open the Custom Expression Builder, and
then create a custom Expression specifically for
this scenario.

Setting Required for State Change Properties
Click the down arrow to expand the "Required for state change" changes based on lifecycle section,
and then select an option for requiring the Field to contain a value before the Business Object's state can
be changed.

Option Description

State

Select a lifecycle state. You can select a different option
for each lifecycle state to determine whether the Field
requires a value before the Business Object is changed
from the selected lifecycle state.

Note: Select (default) to define default options
for requiring the Field to contain a value before
the Business Object's state can be changed.
These default options can be used for any (or
all) selected lifecycle states.

Use default setting Select to use the (default) options for the selected
lifecycle state.

Always required for state change Select to always require the Field to contain a value
before the Business Object's state can be changed.

Never required for save Select to never require the Field to contain a value before
the Business Object's state can be changed.

Field
Select to use a logical Field to determine whether the
Field is required before the Business Object's state can
be changed. Then, select a Field in the drop-down.
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Option Description

Function

Select to use a System Function to determine whether
the Field is required before the Business Object's state
can be changed. Then, select a System Function in the
drop-down.

Stored Value

Select to use a Stored Value to determine whether the
Field is required before the Business Object's state can
be changed. Then, select a most recently used (MRU)
Stored Value in the drop-down, or click the Ellipses
button to open the Stored Value Manager, where you can
select an existing Stored Value or create a new one.

Expression

Select to use an Expression to determine whether the
Field is required before the Business Object's state can
be changed. You can use either:

• Stored Expression: Click the Ellipses button to
open the Expression Manager, and then select an
existing stored Expression or create a new stored
Expression. Stored Expressions can be reused in
numerous places in CSM.

• Custom Expression: Click the Custom Expression
button to open the Custom Expression Builder, and
then create a custom Expression specifically for this
scenario.

Setting Values Before State Changes
Click the down arrow to expand the "Value to set before state change" changes based on lifecycle
section and define options for setting a value in the Field when the Business Object's lifecycle state
changes.

Option Description

State

Select a lifecycle state. You can select a different
option for each lifecycle state to determine the Field's
value before the Business Object is changed from
the selected lifecycle state.

Note: Select (default) to define default
options for requiring the Field to contain a
value before the Business Object's state can
be changed. These default options can be
used for any (or all) selected lifecycle states.

Use default setting Select to use the (default) options for the selected
lifecycle state.

Set to blank Select to clear the Field of any values when the
Business Object's state changes.
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Option Description

Value

Select to define a value to set for the Field when the
Business Object enters its final state. Then, provide a
value.

Note: If the Field is validated, the Legal
Values button is activated. Click it to open
the Quick Selector for the Field and select a
valid value.

Field Select to set the value with another Field's value.
Then, select a Field in the drop-down.

Function
Select to use a System Function to determine the
Field's value. Then, select a System Function in the
drop-down.

Stored Value

Select this radio button to use a Stored Value to
determine the Field's value. Then, select a most
recently used (MRU) Stored Value in the drop-down,
or click the Ellipses button to open the Stored Value
Manager, where you can select an existing Stored
Value or create a new one.

Expression

Select this radio button to use an Expression to
determine the Field's value. You can use either:

• Stored Expression: Click the Ellipses button to
open the Expression Manager, and then select
an existing stored Expression or create a new
stored Expression. Stored Expressions can be
reused in numerous places in CSM.

• Custom Expression: Click the Custom
Expression button to open the Custom
Expression Builder, and then create a custom
Expression specifically for this scenario.
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Define Validation/Auto-Population Properties for a
Field

Use the Validation/Auto-Population page in the Field Properties window to set validation, auto-population
and foreign key settings for a Field.

Note: Encrypted Fields cannot be validated or auto-populated.

To define validation/auto-population properties for a Field:

1. Open the Field Properties window.

2. Click the Validation/Auto-Populate page.

3. Perform these tasks as they apply:
◦ Define Validation Properties for a Field

◦ Define Auto-population Properties for a Field

◦ Storing Foreign Keys for Validated and Auto-populated Fields

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

5. If you enabled security for Lookup Tables, review and modify Lookup Object security rights to
ensure that Users can access values for validated Fields.
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Define Validation Properties for a Field
Validation ensures that a defined set of values (ex: Validation table, list, range, etc.) is used for Field
selections.

There are multiple ways to validate Fields:

• Validate a Field From a Table

• Validate With Range

• Validate from a List

• Use Other Validation Types

Note: If a Group Object (example: Configuration Item) is used to validate a Field, the legal values
for the Field will include all Group Members. If the Group Object has full-text search enabled,
Users can use wildcard characters to search for a legal value when populating the Field.

Validate a Field From a Table
You can validate using values from a Field in a selected Business Object. To see values, Users can press
F3 or click the Legal Values button.

Tip: When you create Forms, use a drop-down for the Field Form Control to present valid values
in a list.

To validate a Field from a table:

1. From the Validation/Auto-Populate page, select the Validate from Table check box.

2. In the Table drop-down, select a Business Object to use to validate the Field:
◦ Lookup Tables: Select this option to show only Lookup Objects in the drop-down menu.

◦ All Tables: Select this option to show all Business Objects in the drop-down menu.

3. Click the Edit Table Data button to open the Data Editor, where you can edit the data contained in
the selected Business Object.

4. In the Field drop-down, select another Field to use to validate the Field.

5. Select the Validation is enforced check box to enforce validation (Users can only select from
values in the validation table). Clearing this check box allows Users to enter values that are not in
the validation table.

6. Select the Selecting values triggers fill check box to use this Field as a trigger for auto-populating
another Field (the other Field is auto-populated when the value for this Field changes).

7. Select the On conflict use first match check box to automatically use the first value in the
validation table if multiple rows contain the same value. Otherwise, the User is prompted to select
which row to use.

8. In the Limit Values area, add constraints to limit the list of values that are available to the User. For
example, you can limit the list of Sub-Categories that are displayed on an Incident based on the
value selected for the Category field.
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a. Click Add to add a constraint or filter.

b. Define the constraint:
◦ Field: Select a Field in the Business Object you are currently working with.

◦ Operator: Select an operator (example: Equals).

◦ Value: Select a value for the Field. Applicable values include:
◦ Fields

◦ Expressions

◦ Metric Values

◦ Prompts

◦ Stored Values

◦ System Functions

c. Click OK.c. 

9. Add additional constraints as necessary. When limiting values change, clear Field's value (normal):
Select this check box to clear the Field's value when any of the constraint values change.

10. In the Custom Error box, provide an error message that is displayed to the User when an invalid
value is selected for a Field.

Validate With Range
You can define a Range Expression that ensures the Field's value is between two values (example:
Priority between 1 and 5, percent between 1 and 100, date within a specified time period).

Applicable values include:

• Fields

• Expressions

• Metric Values

• Stored Values

• System Functions

To validate with range:

1. From the Validation/Auto-Populate page, select the Validate with range check box.

2. From the Left of Range list, provide a value to use as the left boundary for the range. Or, select a
value for the Field in the drop-down.

3. From the Left Operator list, select an operator for the left value in the range.

4. The Field to Check shows the Field that is being validated.

5. From the Right Operator list, select an operator for the right value in the range.

6. From the Right of Range list, provide a value to use as the right boundary for the range. Or, select
a value for the Field in the drop-down.
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Note: Right operators and values are only available if the left operator is Less Than or Less
or Equal.

7. The Expression property shows the range Expression using the selected range values and
operators.

8. In the Custom Error box, provide an error message that is displayed to the User when an invalid
value is selected for a Field.

Validate from a List
You can create a list of valid values for the Field. This is useful if you have a handful of values that are
unlikely to change, and you do not want to define a Lookup Business Object to hold the values.

To validate from a list:

1. From the Validation/Auto-Populate page, select the Validate from list check box.

2. Provide a value in the New box, and then click Add.

Tip: You can also add values to the list by clicking an empty row and entering the value. Use
the Up/Down arrows to change the order of selected values.

3. In the Custom Error box, provide an error message that is displayed to the User when an invalid
value is selected for a Field.

Use Other Validation Types
To use other validation types:

1. From the Validation/Auto-Populate page, select the Other Validation Types check box to use
another type of validation for the Field.

2. Select one of these options:
◦ Select the Expression option to use an Expression to determine whether the Field is valid.

You can use either a stored Expression or a custom Expression.

◦ Select the Valid Team or Workgroup option to use a selected Team or Workgroup as valid
values for the Field.

◦ Select the Valid Bus Ob Nameoption to use the names of specific Business Object types as
valid values for the Field. You can use:

◦ All Business Objects

◦ Major Business Objects

◦ Supporting Business Objects

◦ Lookup Business Objects

◦ Group Business Objects

◦ Members of a Group.
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Note: Select the Include Group Leaders check box to include the names of
Group Leaders in the valid values for the Field.

3. In the Custom Error box, provide an error message that is displayed to the User when an invalid
value is selected for a Field.

CSM 9.3.0 Features 225

CSM 9.3.0 Features



Define Auto-population Properties for a Field
You can use auto-population properties to automatically fill a Field value in based on defined conditions.

For example, when a User selects a value for the Status Field, another Field can be automatically
populated with the descriptive text of the Status. Or, when a value is provided in one Field (Approve
Reason), another Field (example: Approve Date Time) can be automatically populated with the date/time
and the name of the User who made the change.

Use these methods to auto-populate a Field:

• Auto-populate Based on Changes Made to a Table

• Auto-populate Using a Group Map

Auto-populate Based on Changes Made to a Table
You can automatically fill in the Field's value when another Field's value changes. This allows additional
values to be retrieved from a validation table when a value is selected for one Field.

To auto-populate when a change is made to a table:

1. From the Validation/Auto-Populate page, select the Auto-populate check box.

2. From the Populate when there is a change in table drop-down, select a Business Object that,
when changed, will trigger auto-populating the Field.

3. From the Fielddrop-down, select a Field from the selected Business Object that, when changed, will
trigger auto-populating the Field (the trigger field).

Note: Typically, the selected Business Object is the same as the one containing the Field
being auto-populated, but it can also be a Business Object that has a 1-1 Relationship with
the Business Object containing the Field being auto-populated.

4. Select one of these Populate with options:

Option Description

Field from <validation table> lookup table

Select this radio button to populate the Field with a
value from a Field in the table used to validate the
selected trigger Field. Then, select a Field in the
drop-down.

Note: This option is only available if the
selected trigger Field is validated from a
table.

Value

Select this radio button to auto-populate the Field
with a defined value. Then, provide a value. Click
the Legal Values button for a list of valid values
(only available if the Field is validated).
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Option Description

Field
Select this radio button to auto-populate the Field
with a value from another Field in the Business
Object. Then, select a Field in the drop-down.

Function
Select this radio button to auto-populate the Field
using a System Function. Then, select a System
Function in the drop-down.

Stored Value

Select this radio button to auto-populate the Field
using a Stored Value. Then, select a most recently
used (MRU) Stored Value in the drop-down, or click
the Ellipses button to open the Stored Value
Manager, where you can select an existing Stored
Value or create a new one.

Expression
Select this radio button to auto-populate the Field
using an Expression. You can use either a stored
Expression or a custom Expression.

Business Object ID

Select this radio button to auto-populate the Field
using the Business Object ID. This option is only
available if the selected trigger Field is validated
using a Business Object name.

Action Name

Select this radio button to auto-populate the Field
using the Action Name. This option is only available
if the Field holds an Action Name (the hold property
is set to Action Name in the Field's general
properties).

5. Select the Only populate if Field is empty check box to only populate the Field if it does not
contain a value.

Auto-populate Using a Group Map
You can use Group Maps to map values in Fields to members of a Group Object. This allows the system
to select the appropriate Group Member within a Relationship. For example, a Specifics ID Field could
use a Specifics Group Map that would populate the Field with the ID of a Specifics Group Member
(example: Hardware Specifics or Software Specifics), and then show the appropriate Specifics Form in
the Business Object.

To auto-populate using a Group Map:

1. From the Validation/Auto-Populate page, select the Populate Using Map check box.

2. From the Group Map drop-down, select an existing Group Map. Or, click the Group Map button to
open the Group Map Manager, where you can select an existing Group Map or create a new one.
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Group Map Manager
Use the Group Map Manager to complete general CSM Item Manager operations for Group Maps.

There are several ways to open the Group Map Manager:

• From the Blueprint Editor menu bar, click Managers>Group Maps.

• In the Field Properties window (Validation/Auto-Populate page), check Populate Using Map, and
then click the Group Map button .

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.
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4. Culture selector:

Displays the cultures available for platform and content strings in your system, so you can change
languages as you work with items. Available only if globalization features are enabled.

Manager tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.

5. Main Pane:

Displays items by View (Icon, List, or Details (Grid) and lists search results when a Search is run.

Good to know:

• For more information about working in CSM Item Managers, refer to the Item Managers
documentation.
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Open the Group Map Manager
There are several ways to open the Group Map Manager:

• From the Blueprint Editor menu bar, click Managers>Group Maps.

• In the Field Properties window (Validation/Auto-Populate page), check Populate Using Map, and
then click the Group Map button .
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Create a Group Map
Use the Group Map Editor (accessed through the Group Map Manager) to create Group Maps. When you
create a Group Map, you define:

• Name and description of the Group Map.

• The Group Object to which Field values are mapped.

• The Business Object, Fields, and values to use for the map.

To create a Group Map:

1. Open the Group Map Manager.

2. Select a Business Object association.

Note: If you opened the Group Map Manager from the Field Properties window, the
Association is automatically set to the Business Object associated with the Field.

3. Click the Create New button.

4. Define general properties for the Group Map.

Option Description

Name
Provide a display name to use within CSM (this
property can be searched in CSM Item
Managers).

Description (Optional)
Provide a description to use within CSM (this
property can be searched in CSM Item
Managers).

5. Define the Business Objects and Fields to use for the Group Map.

Option Description

Map to Group Select a Group Leader to which values are
mapped.

Starting Business Object

Select the Business Object that contains the Field
to be auto-populated. If you opened the Group
Map Manager from the Field Properties window,
the starting Business Object is automatically set
to the Business Object associated with the Field.

First map Field
Select a Field from the starting Business Object
that will be the primary Field whose values
determine which Group Member to map to.
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Option Description

Second map Field (Optional)
Select a Field from the starting Business Object
that will be the primary Field whose values
determine which Group Member to map to.

6. Map rows to define the Group Member to which Fields are mapped based on the values they
contain.

Tip: To add the first map row, select values in the drop-downs. To add new rows after that,
click New Row.

Option Description

Value in Field 1

Select a value from the Group Object for the first
mapped Field. The Field is mapped to the
appropriate Group Member based on the value in
this Field.

Value in Field 2

Select a value from the Group Object for the
second mapped Field. The Field is mapped to the
appropriate Group Member based on the value in
this Field as well as the value in Field 1.

Tip: Click the Valid Values button to open
the Quick Selector for the mapped
Field(s), where you can select valid
values.

Group Member
Select a Group Member to which the selected
Field(s) will be mapped when they contain the
defined the values.

7. Select the Map should use all Group Members check box if the map should use all of the
members in a Group Object.

8. Click OK.8. 
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Define Group Properties for a Field
Use the Group page in the Field Properties window to define the Group Members for which a Field is
available. The Group page is only available if the Field is part of a Group Object.

To define Group properties for a Field:

1. Open the Field Properties window:

2. Click the Group page.

3. Define Group properties.

Option Description

Just this Group Member
Select this radio button to make the Field
available only to the Business Object being
edited.

All Group Members Select this radio button to make the Field
available to all members in the group.

These Group Members

Select this radio button to make the Field
available only to select Group Members. Then,
select the Group Members where the Field will
be available.

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Storing Foreign Keys for Validated and Auto-
populated Fields

You can store foreign keys for Fields that are validated from Lookup tables and that enforce validation.
This ensures that changes to Lookup table values are updated in existing records because record IDs are
used rather than text values.

Foreign keys support globalization efforts because they ensure that Users see correct values after they
have been translated. See Update Foreign Keys for Validated Fields.

Good to know:

• When you enable foreign keys for a Field, the keys also apply to values that are auto-populated
from that Field.

• Foreign keys are propagated to one level. For example, foreign keys enabled for a Supporting
Business Object will not propagate to a parent Business Object.

• Users cannot manually enter values for Comparison Clauses for a Field after foreign keys are
enabled.

• The "like" and "not like" operators used for queries are not supported with foreign-key-enabled
Fields.

To store foreign keys for a Field:

1. On the Validation/Auto-Populate page, verify that the Field validates from a table and that
validation is enforced.

2. Select the Store foreign key check box.
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3. For complex validation scenarios, you may need to define a foreign key relationship. For more
information, see Defining Foreign Key Relationships.

4. Click OK.

5. Publish your Blueprint.

6. On the Publish Options dialog, select the Update validation foreign keys check box. This ensures
that values are updated in existing records.
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Note: Certain elements, such as Search Query values, Expressions, and One-Steps, are not
automatically updated when you update foreign keys, but they will continue to function properly
because the record ID is used rather than a text value.
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Defining Foreign Key Relationships
Complex validation scenarios may require you to define a foreign key relationship that correctly links
values in a Lookup Table to the validated Field. This ensures that values that were identified by name
before you enabled foreign keys are correctly identified by ID in existing search conditions and
Expressions after you enable foreign keys.

This is particularly important if duplicate values with the same name exist.

For example, the Asset Status Field is validated using the Status Field in the CI Status Lookup Table and
uses CI Type as a constraint. As CIs are created, the CI Status values are assigned for each CI Type and
searches are evaluated against the CI Status and CI Type values. Since the values are referenced by
name, the duplicate values do not negatively impact Searches or Expressions.

Once you enable foreign keys, however, values are searched by ID rather than name, and you may have
unexpected results when you use Searches and Expressions created before you enabled foreign keys.

To solve this problem, create a relationship between the CI and CI Status tables. Once the relationship is
configured, Searches and Expressions evaluate against the CI Status value only, rather than the CI
Status and CI Type values.

Process for Defining a Foreign Key Relationship
The general process for defining a foreign key relationship is:

1. Define a foreign key relationship for a Field that:
◦ Is validated from a Lookup Table that may contain duplicate values referenced by name.

◦ Has values limited by a constraint.

2. Create or update validation settings for the Field where you defined the foreign key relationship.

3. Update validation foreign keys when you publish your Blueprint.
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Example: Defining a Foreign Key Relationship for
Asset Status Field

This example explains how to configure a foreign key relationship for the Asset Status Field in the
Configuration Item Group Leader.

The example assumes that the Asset Status Field is validated using the Status Field in the CI Status
Lookup Table and uses CI Type as a constraint. By adding a foreign key relationship to the Asset Status
Field, you ensure that values are correctly stored for the Field when it is used by Group Members.

Example: Defining the Foreign Key Relationship
To define a foreign key relationship for the Asset Status Field:

1. Create a Blueprint.

2. From the Object Manager, select the Configuration Item (CI) Group Leader, and then click Edit
Group.

3. Open the Asset Status Field to the Validation/Auto-populate page.

4. Select the Store foreign key check box.

5. Click Create.
The foreign key relationship that links Configuration Item to the Lookup Table CI Status is created.

CSM 9.3.0 Features 238

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=group_business_objects
https://help.cherwell.com/csh?topicname=create_a_blueprint


6. Click OK.

Example: Creating Unique Lookup Values
In some cases, duplicate values may exist in the Lookup Table used in your foreign key relationship. You
must create a new table to store unique values that can be correctly referenced as foreign keys.

In this example, you will create a new Lookup Table to consolidate duplicate Status Field values in the CI
Statuses Lookup Table.

To consolidate duplicate CI Status Field values:

1. From the Object Manager, select Lookup Tables, and then select the CI Status Lookup Table.

2. Select Edit Data.

3. Make note of the duplicate values in the Status Field. In this example, you may see these values:
◦ Active

◦ Down

◦ Expired

◦ In Repair

◦ In Stock

◦ In Testing

◦ New

◦ Ordered

◦ Planned

◦ Etc.

4. Close the Data Editor, and then create a new Lookup Table. For this example, use the name Status
Value.

5. Click OK.

6. Add a Status Field to the new table, and then add the Status Field to the table's Default Form.

7. Return to the Object Manager, and then open the Data Editor.

8. Add a single value for each duplicate value found in step 4.
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9. Close the Data Editor.

Example: Setting Validation for the Foreign Key Relationship
After you create a Lookup Table that stores unique values for your foreign key relationship, you must
enable validation on Field used as part of the relationship.

In this example, you would set the Status Field in the CI Status Lookup Table to validate from the Status
Field in the newly created Status Value Lookup Table.

Important: The Field used in the foreign key relationship must also store foreign keys.
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Blueprint Scan Errors for Foreign Key
Relationships

If foreign key relationships are not defined correctly, you may receive errors and warnings when you scan
a Blueprint.

Error/Warning Symptom Solution

Fields using table validation,
that store foreign keys, have
constraints, and for which there
are multiple legal values,
should have a foreign key
relationship defined.

You defined foreign keys for a Field without
defining a foreign key relationship.

Define a foreign key
relationship for the Field
referenced in the error.

When a foreign key relationship
is specified, the Field being
validated against must also
store foreign keys.

You are using a Field to validate values for
the foreign key Field, but the validation Field
does not store foreign keys.

Select the Store Foreign Key
check box for the validation
field.

For solution examples, see Defining Foreign Key Relationships.
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Define Advanced Properties for a Field
Use the Advanced page in the Field Properties window to define database options, attributes, and more.

To define advanced properties for a Field:

1. Open the Field Properties window.

2. Click the Advanced page.

3. Define database options for the Field.

4. Define attributes for the Field.

5. Define localization options for the Field.

6. Set value splitting options.

7. View advanced Field information.

8. Enable encryption for the Field.

9. Click OK.9. 

10. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Define Database Options
Use database options to store the Field in the database, allows nulls, and recalculate Field values when a
Business Object is loaded.

To set database options for a Field:

1. Select the Stored in database check box to store the Field's value in the database table that
represents the Business Object. Clear this check box only if this is a calculated Field that gets its
value from other Fields stored in the database.

2. Select the Allow nulls check box to allow the Field to be stored in the database even if it does not
contain a value.

Note: The Allow Nulls option is not selected by default when a User creates a new logical
Field.

3. Select the Recalculate after load check box to recalculate the Field’s value each time the Business
Object is loaded.

4. Provide a Custom storage name to use for the database column that represents the Field. If the
custom storage name is populated by default, it is recommended that you do not change it.

Define Attributes
Attributes are additional pieces of information (or meta-data) that can be associated with a Field. Some
attributes are automatically set, but others must be provided manually. For example, a Knowledge
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Category general attribute indicates that a Field contains a category that should be submitted for
Knowledge review.

Database attributes are used to indicate special attributes used for a Business Object’s database table.
Most of these are set by the system. Only advanced Users should define attributes. For more information
about attributes, please contact Cherwell Support.

To define attributes for a Field:

1. Click the down arrow  to expand the General Attributes section or the Database Attributes
section.

2. Click an empty row and provide the attribute name and associated value (if applicable).

Define Localization Options
Use these options to enable localization support for Fields and to view current and specific culture
information for the Field. Localization options are available in systems where Globalization is enabled.

• Supports Localization
For a Current Culture Field, you can select or clear this check box to enable localization for the
Field.

• Current Culture Field
For a Specific Culture Field, you can see the Current Culture Field.

• Culture
For a Specific Culture Field, you can see the culture for the Field you are editing.

Note: For more information about Localization settings for Lookup objects, see About
Globalization and Lookup Tables.

Define Presentation Options
Presentation options enable you to define how and where the Field is exposed to Users.

You can:

• Exclude from Form
Select this check box to exclude the Field from being displayed in all Forms (including summary
forms and mini-summary Forms). In addition, the Field will not be available in the Field Editor.

• Exclude from Grid
Select this check box to exclude the Field from being displayed in all Grids. In addition, the Field will
not be available in the Grid Editor.

• Category
Select this check box to separate the Field into a folder based on category. Then, select a category
in the drop-down, or provide a new category in the field. When the Field is displayed (example: In
the Form Editor, anywhere you can select a Field as a token, etc.), it is categorized by folder
(example: Common, System, etc.).
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Set Value Splitting Options
Use value splitting to split a name Field into various components. For example, you can split a Full Name
Field into last name, first name, middle initial, and suffix into separate Fields in the Business Object.

You can also view and add values for the title and suffix name components.

View Advanced Information
View additional advanced information for the Field:

• Field ID
Click this button to see the Field's internal ID. This ID can be used instead of the Field name in
many places in the system. For example, the ID is used internally so that Fields can be renamed
without breaking any Relationships.

• Find Dependencies
Click this button to scan the Field for a list of other definitions in the system that use this Field. When
the scan is finished, the Definition Dependencies window opens, listing the dependent definitions.

Enable Encryption for the Field
You can enable encryption for Fields in Major Business Objects. Minor objects cannot be promoted to
major objects to enable encryption.

Field encryption requires:

• Encryption keys

• The Business Object's history properties and the Field's General Properties must be set to track
Field changes.

Before encrypting Fields, review the best practices.

To enable encryption for the Field:

1. Select the Enable Field Encryption check box.

2. In the drop-down, select an encryption key (encryption keys are managed using the Server
Manager).

Note: Once a Field is encrypted (encryption is enabled and the Blueprint published), it cannot be
reverted to an unencrypted Field. To revert it an unencrypted Field, it must be deleted and re-
created, resulting in the loss of any data stored in the Field.
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About Encrypted Fields
: 3-Minute Video

An encrypted Field is a Field within CSM that can contain encoded data Field to prevent unauthorized
access to sensitive information (ex: Identity information, financial data, etc.). Encrypted Fields can be
exposed in CSM using Field Controls on a Form. When an encrypted Field is added to a Form, it is

accompanied by a button control with a decrypt command . In new records, encrypted Fields are
enabled and blank. Data entered into an encrypted Field is masked when the decrypt/encrypt button is
clicked or when the record is saved (in the Browser Client, tabbing out of an encrypted Field also masks
the data). The values are encrypted when the record is saved. In existing records, encrypted Fields

appear as read-only masked text boxes. Users with viewing rights can click the decrypt button  to view
data in encrypted Fields. All encryption/decryption attempts are tracked in Journal-History records
(enforced) and Splunk server logs (optional). Entering and viewing data in an encrypted Field requires
Business Object rights.

Encrypted Fields are more restricted than regular Fields. Encrypted Fields:

• Cannot be searched, displayed in Grids, or used in many of the areas where regular Fields can (ex:
One-Steps, Expressions, Widgets, etc.).

• Cannot be used in Reports as parameters or results.

• Are stored in a database table separate from Business Objects, and cannot be indexed.

• Cannot have default or calculated values, or set values based on lifecycle state.

• Cannot use validation or auto-population.

• Are limited to a maximum of 255 characters.
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• Cannot be permanently decrypted or converted back to unencrypted Fields.

• The following cannot be encrypted:
◦ Rich Text Fields

◦ Attachments

◦ E-mails

◦ Stored Values

◦ Public IDs

Enabling Field-Level Encryption requires some configuration. For best results, follow these best practices
for encrypting Fields.
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Using Encrypted Fields
Use encrypted Fields to include and protect sensitive data relevant to a Business Object (ex: Identity
information, financial data, etc.). When working with encrypted Fields, Users can:

• Provide sensitive, plain text data in new Business Object records.

• Decrypt encrypted Fields in existing Business Object records.

Good to know:

• Working with encrypted Fields requires Business Object rights.

• When a new record is created, encrypted Fields are blank and editable. However, when the record
is saved, the Field is converted to read-only to prevent unauthorized editing of encrypted data.

• Data entered into encrypted Fields appears as plain text. Data is masked when the encrypt/decrypt
button is clicked or when the record is saved. In the Browser Client, tabbing out of an encrypted
Field also masks the data. Data is not actually encrypted until the record is saved.

• Data in an encrypted Field must be explicitly decrypted by clicking the encrypt/decrypt button. All
decryption attempts are recorded in Journal-History records and in Splunk logs (if configured).
Decrypted data appears as plain text, but is masked again as soon as the User saves the record or
navigates away.

• Encrypted Fields:
◦ Cannot be searched, displayed in Grids, or used in many of the areas where regular Fields

can (ex: One-Steps, Expressions, Widgets, etc.).

◦ Cannot be used in Reports as parameters or results.

◦ Are stored in a database table separate from Business Objects, and cannot be indexed.

◦ Cannot have default or calculated values, or set values based on lifecycle state.

◦ Cannot use validation or auto-population.

◦ Are limited to a maximum of 255 characters.

◦ Cannot be permanently decrypted or converted back to unencrypted Fields.

CSM 9.3.0 Features 248

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=define_business_object_rights_-access_to_data-


Configuring Field-Level Encryption
Complete the following procedures to configure Field-Level Encryption. Configuration procedures are
completed in the Server Manager and in CSM Administrator.

Important: To work with encryption keys, you must be an administrator with access to the
Cherwell Server Manager. If you have a hosted environment, please contact Cherwell Support for
assistance with encryption keys. SaaS Customers must review and sign a Field-Level Encryption
addendum before working with Support to create encryption keys.

Good to know:

• Creating encryption keys does not create a backup. You must still export the key files (.ckf) and
store them in a secure location.

• Encryption can only be enabled on Fields where the Business Object's history properties and the
Field's General Properties are set to track Field changes.

• View-level auditing is enforced, and all attempts to decrypt an encrypted Field are recorded in
Journal-History records. Business Objects containing encrypted Fields must have a history
Relationship to Journals, which can be displayed in the Form Arrangement.

• Compliance logging can optionally be enabled to track decryption attempts in Splunk server logs.
The Splunk Integration is included in hosted environments by default.

• CSM does not currently support encryption of Attachments.

• The Web API does not have access to view any encrypted fields. Encryptions are not available in
the Public API.

• Field-Level Encryption is supported in multi-lingual environments (all localized versions of CSM).

• Before encrypting Fields, review the best practices.

To configure Field-Level Encryption:

1. Configure encryption keys: In the Server Manager, create encryption keys. We recommend creating
a separate key for each Major Business Object in which you plan to use Field-Level Encryption.

2. Enable Field-Level Encryption: In a Blueprint in CSM Administrator, enable encryption for Business
Object Fields using encryption keys.

3. Add encrypted Fields to the appropriate Forms: Open a Form in the Form Editor, and add the

encrypted Field in the desired location. A Button Control with the Decrypt Field command  is also
automatically added for your convenience. The button is not tied to the Field Control, and should be
treated as a separate control.

4. Publish the Blueprint.

5. Define security rights for encrypted Fields: Use the Business Objects tab in the Security Group
Manager to define who has access to view and/or edit encrypted Fields on Forms. Encrypted Fields
do not have any rights selected by default.
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6. Add a Journal tab: Add Journals to the Form Arrangements of the appropriate Business Objects so
that Users can view the history records for all encryption/decryption attempts on encrypted Fields.
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Best Practices for Encrypting Fields
Encrypted Fields are more restricted than regular Fields and require special handling. Encrypted Fields:

• Cannot be searched, displayed in Grids, or used in many of the areas where regular Fields can (ex:
One-Steps, Expressions, Widgets, etc.).

• Cannot be used in Reports as parameters or results.

• Are stored in a database table separate from Business Objects, and cannot be indexed.

• Cannot have default or calculated values, or set values based on lifecycle state.

• Cannot use validation or auto-population.

• Are limited to a maximum of 255 characters.

• Cannot be permanently decrypted or converted back to unencrypted Fields.

For best results, use the following guidelines and considerations when encrypting Fields:

• Back up your CSM database prior to encrypting Fields so that you can restore your system if you
experience unexpected results.

• Create multiple encryption keys, one for each Major Business Object in which you plan to use Field-
Level Encryption.

• To avoid confusion and potential data loss, use different encryption keys for test and production
environments.

• Ensure encryption keys are backed up.

• Do not store data (.czar files) and encryption keys in the same location.

• For best results, create a new Field and encrypt it.

• If it is necessary to encrypt an existing Field, keep the following in mind:
◦ The following Fields cannot be encrypted: RecID, PublicID, automatically created Fields (ex:

Owned By, Owned By ID, Created Culture, etc.), and state Fields (ex: Incident.Status).

◦ Check for dependencies to understand the impact of encrypting an existing Field. If the Field is
used in areas where encrypted Fields cannot be used or displayed, encrypting it could have
unfavorable consequences.

◦ Encrypted Fields are limited to 255 characters. If you encrypt a Field that exceeds this limit, it
will be truncated.

◦ Only text Fields can be encrypted. To encrypt a Field of a different type, convert it to text,
publish the Blueprint, and then encrypt the Field. Ensure the converted text Field is long
enough to avoid truncating values (the limit for encrypted Fields is 255 characters).
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Relationships
A Relationship is an association between two Business Objects that allows data to be pulled together in
meaningful ways. For example, the Incident Business Object is often in a Relationship with the Customer
Business Objects so that Incidents can be associated with the appropriate Customers. When Business
Objects are in a Relationship, one object is known as the parent and the other is the child.
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About Relationships
Use Relationships to connect Business Objects to each other so that they can share data. For example:

• Track Business Object history (ex: Notes, e-mails, record changes, etc.) in a Supporting Object such
as a Journal.

• Show related Business Objects in a Form Arrangement on a record (ex: Show a related Problem on
an Incident record).

• Add Approval support to a Business Object.

Major Business Objects can have two types of Relationships:

• Owns: A Major Business Object (the parent) owns another Business Object (the child, typically a
Supporting Object). The child object belongs to the parent object and exists only as long as the
parent object exists (ex: Incident Owns Journals, Change Request Owns Tasks).

• Link: A Major Business Object (the parent) is linked to another Business Object (the child, typically
another Major Object). One is a parent and one is a child, but the child can exist without the parent
(ex: Customer Links SLA, Problem Links Knowledge Articles).

Supporting Business Objects can have one type of Relationship:

• Owned By: A Supporting Object (the child) is owned by a Major Object (the parent). The child object
belongs to the parent object and exists only as long as the parent object exists.

Relationships cannot be created for Lookup Objects, but Lookup Objects can be selected as children or
parents in Relationships created for Major and Supporting Objects.

A Relationship can be:

• One-to-one: The parent object can link to one instance of a child object (ex: Incident Links Problem).

• One-to-many: The parent object can link to multiple instances of the child object (ex: Incident Owns
Journals).

CSM provides many Relationships for its OOTB Business Objects. Use these as-is, edit them, or create
your own using the Relationship Editor (accessed from within a Blueprint in CSM Administrator).

The Relationship Wizard is the most convenient way to create new Relationships. Advanced Users can
use the Relationship Properties window to define more detailed properties for a Relationship. Both of
these tools are accessed from the Relationship Editor.

Note: A full list of Relationships is beyond the scope of this document. Export a schema document
from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full list of
Relationships associated with a particular type of Business Object (ex: Major). To view a list of
Relationships associated with one particular Business Object (ex: Incident), you can export a
Business Object schema.
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Relationships Good to Know
• Use the Relationship Editor to define and edit the various aspects of a Relationship. In the

Relationship Editor, you can:
◦ Access the Relationship Wizard, where you can quickly create a Relationship.

◦ Access the Relationship Properties window, where you can define or edit detailed properties
for a Relationship.

◦ Delete Relationships.

• Business Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements
are created, edited, and deleted within a Blueprint. To commit changes to your system, you must
publish the Blueprint.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to Business Object data and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit security groups). For more
information, refer to Define Business Object Rights.
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Using Relationships
Use Relationships to connect Business Objects to each other so that they can share data. For example,
you can:

• Track Business Object history in a Supporting Object (ex: Journal). For example:
◦ Track E-mail Correspondence in Journal - Mail History Records.

◦ Add Remote Support Session History to a Business Object.

• View related Business Objects on a parent record:
◦ In a Form Arrangement (ex: Show a related Problem on an Incident record).

Note: If a Form/record in the Form Arrangement is in an owned by Relationship with
the parent Form/record (ex: Incident Owns Journals), then it can by edited; however,
Forms/records in linked Relationships (ex: Incident Links Problem) are read-only.

◦ As an embedded Form (ex: Specifics Forms to gather specific information for an Incident
category).

• Use Approvals (ex: Obtain approval for a Service Request to purchase hardware for a new
employee).

• Send e-mails directly from Business Object records to the active Customers on the record (the
Business Object must have a Relationship to the Customer Object. Refer to Configuring E-mail
Accounts for more information).

• Use Visualizations to view graphical representations of Relationships.

• Select related items on a record (ex: When logging an Incident, select a Customer as the Requestor.
This is based on an Incident Links Customer Relationship).

CSM provides many Relationships for its OOTB Business Objects. Use these as-is, edit them, or create
your own using a Blueprint.

Note: A full list of Relationships is beyond the scope of this document. Export a schema document
from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full list of
Relationships associated with a particular type of Business Object (ex: Major). To view a list of
Relationships associated with one particular Business Object (ex: Incident), you can export a
Business Object schema.
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Managing Relationships
Relationships are managed using the Relationship Editor, accessed from within a Blueprint in CSM
Administrator. Use this tool to:

• Create a Relationship.

• Edit a Relationship.

• Delete a Relationship.
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Relationship Editor
The Relationship Editor is the interface within a Blueprint in CSM Administrator that allows you to manage
(create, edit, and delete) Business Object Relationships. Use the Relationship Editor to:

• Create Relationships, using either:
◦ The Relationship Wizard.

◦ The Relationship Properties window.

• Edit Relationships (using the Relationship Properties window).

• Delete Relationships.

Open the Relationship Editor from the Object Manager (within a Blueprint in CSM Administrator):

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to open the
Relationship Editor.
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1. Business Object Properties: View the Business Object that the Relationships are associated with.
Select the Bus Ob Properties button to open the Business Object Properties window and easily
make changes to the associated Business Object.

2. Relationship Editor Table: By default, associated Relationships are displayed alphabetically by
name. The following details can also be viewed in the Editor Table:

a. Type: Displays whether the Business Object Relationship is a Linked or Owned Relationship.

b. Child: Displays the type of Child Business Object that is associated with the Relationship. For
more information about Child Business Objects and Relationships, see Define General
Properties for a Relationship.

c. Loads: Displays the Load settings for each Relationship. Customizing Load settings may
impact system speed. For more information on customizing Load settings, see Define
Advanced Properties for a Relationship.

d. Size: Displays whether the Relationship is a one-to-one or a one-to-many Relationship. A one-
to-one Relationship means that the Business Object links to only one instance of a Child
Business Object. A one-to-many Relationship allows the Business Object to be linked to
multiple instances of a Child Business Object. For more information, see Create a Relationship
Using the Relationship Wizard.

e. Description: Displays the description added to a Relationship.

3. Relationship Editor Buttons: Use the following buttons to easily edit existing Relationships or
create a new Relationship:

a. Wizard: Opens the Relationship Wizard with the selected Business Object properties pre-
populated (example: Incident). Use the Wizard to create a new Relationship.

b. Add: Opens the Relationship Properties Window, use the Window to create a new
Relationship.
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c. Edit: Opens the Relationship Properties Window for the selected Relationship so that settings
can easily be edited.

d. Delete: Deletes selected Relationship.
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Open the Relationship Editor
Open the Relationship Editor from the Object Manager (within a Blueprint in CSM Administrator):

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to open the
Relationship Editor.
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Relationship Wizard
The Relationship Wizard (accessed from within the Relationship Editor in a Blueprint) is a specialized tool
that automatically creates a new Relationship with all the appropriate properties. Use the Relationship
Wizard to initially and quickly create a new Relationship. Afterwards, you can refine the properties as
needed using the Relationship Properties window (accessed from the Relationship Editor in a Blueprint).
When you create a Relationship using the Relationship Wizard, the wizard:

• Prompts you to define:
◦ General properties (Related Business Object, Relationship type (ex: 1-1, 1-Many), name,

description, etc.).

◦ Link Properties: How to connect parent and child Business Objects to each other.

• Creates a Relationship (and a reverse Relationship, if applicable) with all of the appropriate
properties.
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Create/Edit a Relationship
Use the Relationship Wizard or the Relationship Properties window to create Relationships. The
Relationship Wizard is the most convenient way to create new Relationships. When you create a
Relationship, you define:

• General Properties: Related Business Object, Relationship type (ex: 1-1, 1-Many), name,
description, etc.

• Link Properties: How to connect parent and child Business Objects to each other.

When you create or edit a Relationship using the Relationship Properties window, you can select some
additional options, including:

• Auditing Options: What to track for the Relationship (ex: When related Business Objects are added,
edited, or deleted).

• Advanced Properties: How to handle child objects in a Relationship, define attributes, etc.

Note: The Relationship Wizard and Relationship Properties window are available in the
Relationship Editor (accessed from within the Object Manager in the Blueprint Editor).

To create a Relationship:

1. Open the Relationship Editor

2. Create a Relationship in one of the following ways:
◦ Using the Relationship Wizard.

◦ Using the Relationship Properties window:
◦ Define general properties for a Relationship.

◦ Define link properties for a Relationship.

◦ Define database options for a Relationship.

◦ Define auditing properties for a Relationship.

◦ Define advanced properties for a Relationship.

3. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

To edit a Relationship:

1. Open a Relationship in the Relationship Editor

2. Make changes.

3. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Create a Relationship Using the Relationship
Wizard

The Relationship Wizard is the most convenient way to create new Relationships. When you create a
Relationship using the Relationship Wizard, you define:

• General Properties: Related Business Object, Relationship type (ex: 1-1, 1-Many), name,
description, etc.

• Link Properties: How to connect parent and child Business Objects to each other.

Note: The Relationship Wizard is available in the Relationship Editor (accessed from within
the Object Manager in the Blueprint Editor).

Good to know:

• Business Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements
are created, edited, and deleted within a Blueprint. To commit changes to your system, you must
publish the Blueprint.

• The Relationship Wizard can also be accessed from the Form Arrangement Editor by right-clicking
in the Relationship tree and selecting New Relationship Wizard.

To create a Relationship using the Relationship Wizard:

1. Open the Relationship Editor

2. Click the Wizard button.

3. Select a child Business Object:
◦ If you are creating a Relationship for a Major Object:

◦ Select a Supporting Object to automatically create an Owns Relationship.

◦ Select a Major Object to automatically create a Link Relationship.

◦ If you are creating a Relationship for a Supporting Object:
◦ Select a Major Object to automatically create an Owned By Relationship (the

Supporting Object is owned by the selected Major Object).

4. Define Relationship cardinality (how the parent object relates to the child):
◦ One-to-one: Select this radio button to allow the parent object to link to only one instance of

the child object (ex: Incident Links Problem).

◦ One-to-many: Select this radio button to allow the parent object to link to multiple instances of
the child object (ex: Incident Owns Journals).

5. Select whether the child object should have a Relationship back to the parent.
◦ Yes: Select this radio button to create a reverse Relationship from the child object to the

parent object.

Note: Selecting Yes on this page will create two Relationships (after you finish the wizard):
one from the parent to the child, and one from the child to the parent. The reverse Relationship
can be viewed and edited from the Relationship Editor in the child object.
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◦ No: Select this radio button to not create a reverse Relationship from the child object to the
parent object.

6. Select how the child object relates back to the parent:

Note: The Reverse Relationship Cardinality page only appears if you selected Yes on the
Reverse Relationship page.

◦ One parent: Select this radio button to allow the child object to belong to only one instance of
the parent object.

◦ Many parents: Select this radio button to allow the child object to belong to multiple instances
of the parent object.

Note: If you select Many Parents, and the primary Relationship is one-to-many, the child
Relationship will also be one-to-many. In effect, a many-to-many Relationship exists between
the two objects. Many-to-many Relationships use join tables to link Business Objects together.

7. Select how to link the parent object to the child object. This is done by having one object hold the
RecID of the related object.

Note: This page will not appear if you created a many-to-many Relationship. Many-to-many
Relationships are linked using join tables.

◦ For one-to-one Relationships, select one of the following options:
◦ Child holds the RecID of the parent: Select this radio button to have the child object hold

the ID of the parent object. This is the recommended option because it works for both
one-to-one and one-to-many Relationships.

◦ Parent holds the RecID of the child: Select this radio button to have the parent object
hold the ID of the child object (only works for one-to-one Relationships because the
parent can only hold the ID of one child). Then, select an existing Field in the drop-down,
or click New to add a new Relationship Link field in the parent object.

◦ For one-to-many Relationships:
◦ Select the Field in the child objects to hold the RecID of the parent. You can either select

an existing Field in the drop-down, or click New to add a new Relationship Link field in
the child objects.

Note: These are the default link options and are sufficient for the majority of
Relationships. However, for special cases, you can use the Link page in the Relationship
Properties window for additional link options.

8. Define whether to create a particular Group Member record by default when the Relationship
creates a new child object record.

Note: The Group Leader page only appears if you selected a Group Leader as the child
object.

◦ Yes: Select this radio button to create a particular Group Member record by default when the
Relationship creates a new child object record. Then, select a Group Member in the drop-
down.
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◦ No: Select this radio button to not create a a particular Group Member record by default when
the Relationship creates a new child object record. This means that Users must select the
Group Member to use when a child record is added.

9. Select whether to search the child object when a Full-Text search is run on the parent object and its
related items:

Note: This page only appears if you selected to create a reverse Relationship, and if the
child object has Full-Text search enabled in its Search Results properties.

◦ Yes: Select this radio button to have the child object searched when a Full-Text search on the
parent object includes related items.

◦ No: Select this radio button to not run a Full-Text search on the child object when a Full-Text
search for the parent object includes related items.

If you created a reverse Relationship, and the child object has Full-Text search enabled in its Search
Results properties, you will also be asked whether to search the parent object when a Full-Text
search is run on the child object and its related items:

◦ Yes: Select this radio button to have the parent object searched when a Full-Text search on
the child object includes related items.

◦ No: Select this radio button to not run a Full-Text search on the parent object when the child
object includes related items.

10. Provide a name and description for the Relationship. This is how the Relationship is identified in
the Relationship Editor and throughout the system.

Note: You will also be asked to provide a name and description for the reverse Relationship
if you selected to create one.

11. Review the Summary page.

12. Click Finish.12. 

The Relationship is added to the Business Object and is displayed in the Relationship Editor.

13. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Create a Relationship Using the Relationship
Properties Window

The Relationship Properties window allows you to define and edit detailed properties for a Relationship.
When you create or edit a Relationship using the Relationship Properties window, you define:

• General properties: Name, description, Relationship type, and cardinality.

• Link properties: How to connect parent and child objects.

• (Advanced Users) Database properties: Options for using a foreign key for the Relationship.

• Auditing properties: Options for tracking records within the Relationship.

• (Advanced Users) Advanced properties: How to handle objects that are children in a
Relationship, define attributes, etc.

Note: The Relationship Properties window is available in the Relationship Editor (accessed
from within a Blueprint in CSM Administrator).

Good to know:

• Business Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements
are created, edited, and deleted within a Blueprint. To commit changes to your system, you must
publish the Blueprint.

• The Relationship Properties window can also be accessed from the Form Arrangement Editor by
right-clicking in the Relationship tree and selecting New Relationship or Edit Relationship.

To create a Relationship using the Relationship Properties window:

1. Open the Relationship Editor

2. Click the Add button.

3. Define properties for the Relationship:
a. Define general properties.

b. Define link properties.

c. Define database properties.

d. Define auditing properties.

e. Define advanced properties.

4. Click OK.4. 

The Relationship is added to the Business Object and is available in the Relationship Editor.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define General Properties for a Relationship
Use the General page in the Relationship Properties window to define the following general properties for
a Relationship:

• Name and description.

• Relationship type.

• Relationship cardinality: Whether an object can be related to one or many items.

• Child/parent object in the Relationship.

• Additional options: Relationship uses, reverse Relationships, and Full-Text searching options.

Note: The Relationship Properties window is available in the Relationship Editor (accessed
from within a Blueprint in CSM Administrator).

To define general properties for a Relationship:

1. Open the Relationship Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to
open the Relationship Editor.

c. Click Add to add a new Relationship, or Edit to edit an existing Relationship.

2. Click the General page.

3. Define general information for the Relationship:
a. Name: Provide a display name to use within CSM.

b. (Optional) Description: Provide a description to use within CSM.

4. Select a Relationship Type:
◦ For Major Objects:

◦ Link: Select this radio button to make the Relationship a Link Relationship. A Link
Relationship means that the child Business Object can exist without the parent. Typically,
Major Objects are the child objects in Link Relationships (ex: Incident Links Customer,
Change Request Links Problem).
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◦ Owns: Select this radio button to make the Relationship an Owns Relationship. An Owns
Relationship means that the parent object owns the child object (the child object exists
only as long as the parent does). Typically, Major Objects are the parent objects and
Supporting Objects are the child objects (ex: Incident Owns Journals, Knowledge Article
Owns Approvals).

◦ For Supporting Objects:
◦ Owned By: This is automatically selected when you create a Relationship for a

Supporting Object. An Owned By Relationship means that the Supporting Object (the
child) is owned by a Major Object (the parent), and the child object exists only as long as
the parent does.

5. Select the Number of Related Items:
◦ One: Select this radio button to allow the parent object to be related to only one instance of the

child object (ex: Incident Links Customer).

◦ Many: Select this radio button to allow the parent object to be related to multiple instances of
the child object (ex: Incident Owns Journals).

6. Select the child/parent of the Relationship:
◦ Child/parent: In the drop-down, select a child/parent object:

◦ For a Link Relationship: Select a Major, Supporting, or Lookup Object to be the child
object. Typically, Major Objects are the children in Link Relationships.

◦ For an Owns Relationship: Select a Supporting or Lookup Object to be the child
object.

◦ For an Owned By Relationship: Select a Major, Supporting, or Lookup Object to be
the parent object. Typically, Major Objects are the parents in Owned By Relationships.

◦ Default Group Member: If you selected a Group Leader as the child object, select a Group
Member to create by default when the Relationship creates a new child object record.

7. Define additional options for the Relationship:
◦ Relationship Has Different Uses: Select this check box to qualify the way the Relationship can

be used. Then, select the Field that holds the uses. For example, a Relationship could be
used to associate multiple addresses with a Customer (using a field that holds the multiple
addresses, or uses: home, business, etc.).

◦ Reverse Relationship: Select this check box to select a reverse Relationship (from the child
object back to the parent object).

Note: The reverse Relationship must already exist in order for you to select it here. The
easiest way to create a reverse Relationships is through the Relationship Wizard, which allows
you to create the primary (parent to child) as well as the reverse (child to parent) Relationship.
You can also create a reverse Relationship using the Relationship Properties window for the
child object.

◦ When searching (parent) include (child) in Full-Text search: Select this check box to have the
child object searched when a Full-Text search on the parent object includes related items.

Note: This check box is available only if the parent and child objects have Full-Text search
enabled in their search results properties (defined on the Search Results page of the Business
Object Properties window). If you select this check box, the CSM Desktop Client Quick Search
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Pane for the parent object will display a button  that allows the child to be searched as
well.

8. Click OK.8. 

9. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Link Properties for a Relationship
Use the Links page in the Relationship Properties window (accessed from the Relationship Editor) to
define how Business Objects in a Relationship are linked together. When you define link options, you
determine how the underlying database tables for the Business Objects are joined.

Note: The Relationship Properties window is available in the Relationship Editor (accessed from
within a Blueprint in CSM Administrator).

To define link properties for a Relationship:

1. Open the Relationship Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to
open the Relationship Editor.

c. Click Add to add a new Relationship, or Edit to edit an existing Relationship.

2. Click the Links page.

3. Define how to link the parent and child Business Objects:
◦ Default Link, Storing Parent Key in Child Object: Select this radio button to have the child

object hold the RecID of the parent object. This is the recommended option because it works
for both one-to-one and one-to-many Relationships.

Then, in the Default Link section, select or create a new Field (ex: Parent RecID) in the child
object where the parent object's RecID will be stored.

◦ Default Link, Storing Child Key in Parent Object: Select this radio button to have the parent
object hold the RecID of the child object. This option is only available for one-to-one
Relationships (the parent can only hold the ID of one child).

Then, in the Default Link section, select or create a new Field (ex: Child RecID) in the parent
object where the child object's RecID will be stored.

◦ Use Join Table: Select this radio button to use a third database table to join the database
tables that represent the parent and child objects. The join table will hold the IDs of both the
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parent and child objects. This is how many-to-many Relationships are linked (ex: Multiple
Incidents can link to multiple Configuration Items).

Then, define the type of join table to use:

◦ Standard: Select this radio button to use the standard join table. All joins that use the
standard join table will be stored in the same database table.

◦ Custom: Select this radio button to use a custom join table. Then select an existing table,
or create a new table that is used specifically for the Business Objects in the
Relationship.

To create a custom join table:

◦ Click New.

The Create New Join Table window opens.

◦ Provide a name for the join table.

◦ Define custom join table fields:
◦ Field with Parent ID: Provide the name of the Field in the join table that will

hold the parent object's RecID (by default, ParentID is the name for this
Field).

◦ Field with Parent Type: Provide the name of the Field in the join table that will
hold the parent object's type (ex: Incident, Customer, etc.). By default, Parent
Type is the name for this Field.

◦ Field with Child ID: Provide the name of the Field in the join table that will
hold the child object's RecID (by default, ChildID is the name for this Field).

◦ Field with Child Type: Provide the name of the Field in the join table that will
hold the child object's type (ex: Journal, Approval, etc.). By default, Child
Type is the name for this Field.

◦ Field with Join Reason: Provide the name of the Field in the join table that
will hold the join reason, if applicable (by default, Join Reason is the name for
this Field).

◦ Field with Child Join Reason: Select this check box to create a Field in the
join table to hold the join reason for the reverse Relationship. Then, provide a
name for the Field (by default, Child Join Reason is the name for this Field).

◦ Click OK.◦ 

The custom join table is created with the defined Fields.

Use a custom join table to:

◦ Enhance performance. If you expect to join an extremely large number of records,
having a custom join table allows the join to be stored separately, rather than in a
standard table with all other joins.
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◦ Store additional information related to the join. For example, if you are linking an
Incident to a Vendor, you can build the link through a work order.

Note: The join tables in the drop-down were created for other Relationships. If you select
an existing table, this Relationship will share a database table with the other
Relationships that use the selected table.

◦ Acts as child in join table: Select this check box to store the parent object's type
and ID in the child type and ID fields. For example, in an Incident Links
Configuration Items Relationship, the reverse Relationship (Configuration Items
Link Incident) would have Acts as child in join table selected, allowing both
Relationships to use the same row in the database table.

(Optional) Define a join reason. Join reasons allow you to provide brief information about why
two objects are joined together.

◦ Join Has Reason: Select this check box to enable join reasons for the table. The
subsequent options are available only if this check box is selected.

◦ Prompt User for Join Reason after Add/Link: Select this check box to prompt Users for a
join reason when records are added or linked in a tab in a Form Arrangement.

◦ Join Reason: Provide a reason for the join. This is displayed as the join reason column
header in the Grid view of the Form Arrangement tab. The Grid can be filtered based on
the join reason field.

◦ Join Reason Prompt: Provide custom text to display in the Prompt window that asks
Users for a join reason when records are added or linked in a tab in a Form
Arrangement. If no custom text is provided, the join reason is used.

◦ Provide List of Values: In the drop-downs, select a Business Object and Field to use as
the join reason.

◦ Auto-Populate Join Reason for Reverse Relationship: Select this check box to auto-
populate the join reason for the reverse Relationship.

Note: This option is only available if Provide List of Values is selected and the standard
join table is used. If a custom join table is used, it must have a Child Join Reason field
with a ChildJoinReason attribute. When you create a new custom join table, you can
select the option to create this Field with the appropriate attribute. If you use an existing
custom join table, you might have to manually add the Field (including the attribute) to
the join table (within a Blueprint).

Select an option for auto-populating the join reason for the reverse Relationship, either:

◦ From Field: Select this radio button to the use a value from a Field as the join
reason for the reverse Relationship. Then, in the drop-down, select a Field from the
Business Object selected in the Provide List of Values drop-down.

◦ Use Same Join Reason for Reverse Relationship: Select this radio button to use
the same join reason for the reverse Relationship as is used for the primary
Relationship.
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◦ Set up custom link: Select this radio button to create custom criteria for linking the parent and
child objects.

◦ Use Constraints: Select this check box to define constraints that limit when a new child is
added to the Relationship.

◦ Define constraints that limit when a new child is added to the Relationship:
◦ Click Add to add a constraint or filter.

◦ Select a Field in the Business Object you are currently working with.

◦ Select an operator (ex: Equals).

◦ Value: Select a value for the Field. Applicable values include:
◦ Fields

◦ Expressions

◦ Metric Values

◦ Prompts

◦ Stored Values

◦ System Functions

◦ Click OK.

◦ Add additional constraints as necessary.

◦ Auto-populate: Select this check box to define fields and values that are auto-populated
when a new child is added to the Relationship.

◦ Define a list of Fields and values that are auto-populated when a child is added to a
Relationship:

◦ Click Add to add a Field that is auto-populated with a defined value.

Tip: Click Edit to edit a selected auto-populated Field. Click Delete to
remove a Field from the list of auto-populated Fields.

◦ Define a Field to auto-populate and the value to use to auto-populate the
Field:

◦ Field: In the drop-down, select a Field from the parent or child object.

◦ Value: In the drop-down, select a value to use to auto-populate the
Field. Applicable values include:

◦ Fields (from the parent or child object)

◦ Expressions

◦ Metric Values

◦ Stored Values

◦ System Functions

◦ Click OK.◦ 

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Database Properties for a Relationship
Use the Database page in the Relationship Properties window to create and enable foreign keys for the
Relationship. Foreign keys establish and enforce a link between tables in a relational database, and are
required by SQL Reporting Services.

Note: The Relationship Properties window is available in the Relationship Editor (accessed from
within a Blueprint in CSM Administrator).

Important: It is recommended that you do not use foreign keys unless you have a specific need to
do so.

To define database properties for a Relationship:

1. Open the Relationship Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to
open the Relationship Editor.

c. Click Add to add a new Relationship, or Edit to edit an existing Relationship.

2. Click the Database page.

3. Define database options:
◦ Use Blueprint Defaults for Foreign Key: Select this check box to use the global database

options defined for Blueprints.

◦ Create Foreign Key for Relationship: Select this check box to create a foreign key for the
Relationship.

◦ Not Enforced/Enforced: Select whether or not to enforce foreign keys.

◦ If enforced, define whether to cascade updates and/or deletes:
◦ Cascading Update: Select this check box to cascade updates. This means that if

row in a related Business Object table containing a key referenced by the foreign
key is updated, all rows that contain the Foreign Keys are also updated with the
new value.
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◦ Cascading Delete: Select this check box to cascade deletes. This means that if row
in a related Business Object table containing a key referenced by the foreign key is
deleted, all rows that contain the foreign keys are also deleted.

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Auditing Properties for a Relationship
Use the Auditing page in the Relationship Properties window to define auditing options for records in the
Relationship. When you enable auditing on a Relationship, you define which changes to child object
records are tracked in the parent object's history records.

To define auditing properties for a Relationship:

1. Open the Relationship Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to
open the Relationship Editor.

c. Click Add to add a new Relationship, or Edit to edit an existing Relationship.

2. Click the Auditing page.

3. Select Enable Auditing to enable auditing for the records within the Relationship. Then, define
auditing options:

For an Owns Relationship:

◦ Audit Adds: Select this check box to track when a child object is added.

◦ Audit Edits: Select this check box to track when a child object is edited.

◦ Audit Deletes: Select this check box to track when a child object is deleted.

◦ Combine Child Changes: Select this check box to have one history record created for all
changes made to a child object before it is saved.

◦ Separate Field Edit Records: Select this check box to track each Field that is edited in the
child object in a separate history record.

Note: This option is only available if you checked Audit Edits.

For a Link Relationship:

◦ Audit Deletes: Select this check box to track when a linked object is deleted.

◦ Audit Linked Records: Select this check box to track when a linked object is added.
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◦ Audit Unlinked Records: Select this check box to track when a linked object is unlinked from
the parent.

Note: Auditing options are not available for Owned By Relationships.

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Advanced Properties for a Relationship
Advanced Users can use the Advanced page in the Relationship Properties window to define the
following properties:

• Advanced Options:

Options for deleting child objects when parent objects are deleted, making records in the
Relationship read-only, reloading the Relationship when constraints change, etc.

• Load Options:

Options for loading Relationship data (load all data, load only keys, or load based on size).

• Groups:

Options for defining Group Member type when child records are added (only applicable if the child
object is a Group Object).

• Attributes:

Additional pieces of information (or meta-data) that can be associated with the Relationship. Some
attributes are automatically set, but others must be provided manually.

To define advanced properties for a Relationship:

1. Open the Relationship Properties window:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

b. In the Object Manager, click a Business Object in the Object tree, and then click the Edit
Relationships task in the Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the Blueprint Editor Toolbar to
open the Relationship Editor.

c. Click Add to add a new Relationship, or Edit to edit an existing Relationship.

2. Click the Advanced page.

3. Define advanced options for the Relationship:
◦ (Owns Relationships only) Delete children with parent:

Select this check box to delete child objects when the parent object is deleted.

◦ Read-only:
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Select this check box to make records in the Relationship read-only. In CSM, Users will be
able to view records for the Relationship, but will not be able to add or remove records.

◦ Load immediately:

Select this check box to load the child object when the parent is loaded. If this is not checked,
the child object might not be loaded until it is needed.

Note: This check box can affect system performance. Only change this setting if
absolutely necessary.

.

◦ (Owns Relationships only) Automatically create record:

Select this check box to automatically create a child object when the parent is created.

.

◦ Children must be in final state before owner can go into final state:

Select this check box to require child objects to be in a final state before the parent object can
be set to its final state. For this setting to be effective, the objects in the Relationship must
have lifecycles defined with a status designated as the final state.

◦ Reload Relationship when constraint Fields change:

Select this check box to reload the Relationship data when a Field that defines one of its
constraints changes values.

Note: Normally, Relationships are loaded and updated based on specialized controls
(tabs, related item selectors, etc.). However, if you have Relationship constraints
based on Fields whose values can change for other reasons, the data in the
Relationship will not be up to date if the values in those Fields change. For example,
the SLA related to an Incident might change based on the selected Incident category
and priority, which are Relationship constraints. When the Priority or Category fields
change, the Relationship should be reloaded to show the relevant SLA.

◦ Don't load when constraints are blank:

Select this check box to not load the Relationship if the Fields that define its constraints do not
contain any values.

◦ (Link Relationships only) Exclude Relationship from Grid customization:

Select this box to prevent Users from personalizing the Tab Grid for linked records that appear
in the parent object's Form Arrangement.

4. Define load options for the Relationship:
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◦ Load Everything (default):

Select this option to load the entire table of related data into memory.

◦ Load Keys:

Select this option to load only the keys for the Relationship, along with pages of records as
needed. If loading from a Grid, the number of Fields is limited to those on the Grid.

◦ Load Based on Size:

Select this option to have the system decide how to load data. If the estimated dataset
exceeds 3 MB, only keys are loaded. If the estimated dataset does not exceed 3 MB, the
entire dataset is loaded. The dataset estimate is based on the definition type, such as the
number of Fields and their type, as well as the amount of text stored in the Fields.

◦ Default Sort Field When Loading Keys:

If loading keys or loading based on size, select a Field from the related Business Object to
determine the order in which the keys are loaded.

◦ Ascending:

Select this option to sort the data in ascending order (ex: 0-10, A-Z) based on the
selected Field.

5. Define advanced Group options for the Relationship:

Note: The Groups section is only available if the child object is part of a group.

a. Click the down arrow to expand the Groups section.

b. Define options for determining the type of Group Member that is created when a child object is
added to the Relationship:

◦ Type is set manually (when added):

Select this radio button to allow Users to select the Group Member that is used as the
child in the Relationship. No member is used until a User selects it.

◦ Type automatically changes based on:
◦ Field:

Select this radio button to use the value from a Field in the parent object to
determine which Group Member to use. Then, select a Field in the drop-down. For
example, in an Incident Links Customer Relationship, Incident might have a
Customer Type field that can hold the values External or Internal.

◦ Expression:
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Select this radio button to use an Expression that returns the Group Member type.

Then, click the Ellipses button  to open the Expression Manager, where you
can select an existing Expression or create a new one; or click the Custom

Expression button  to create a custom Expression.

c. Define additional options for determining when a Group Member is added to the Relationship:
◦ Only auto-create when Group Member type can be determined:

Select this check box to automatically create a Group Member only after the Group
Member type is determined. If the Group Member type is based on a Field or an
Expression, the system will not necessarily know which Group Member to create until the
Field has been populated or the Expression has been evaluated. If you check this option,
the system will wait until there is a value in the Field or until the Expression is evaluated
before it creates a Group Member.

◦ Set Group Member ID in parent:

Select this check box to populate the Group Member Type field in the parent object with
the Group Member's RecID when the Group Member is created.

Note: This option is only available if you selected to determine the Group
Member type based on a Field in the parent object.

◦ Transfer fields when Group type changes:

Select this check box to transfer fields from one Group Member to another when the
Group Member type changes.

6. Define attributes for the Relationship. Database attributes are used to indicate special attributes
used for a Business Object’s database table. Most of these are set by the system.

◦ General Attributes:

Click the down arrow to expand the General Attributes section. Then, click an empty row and
provide the attribute name and associated value (if applicable).

◦ Database Attributes:

Click the down arrow to expand the Database Attributes section. Then, click an empty row
and provide the attribute name and associated value (if applicable).

Note: Only advanced Users should define attributes. For more information about
attributes, please contact Cherwell Support.

7. View additional advanced information for the Relationship:
◦ Relationship ID:
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Select this button to open a window that displays the internal ID that is used for the
Relationship. This ID can be used instead of the Relationship's name in many places in the
system.

◦ Find Dependencies:

Select this button to scan the Relationship for a list of other definitions in the system that use
this Relationship. When the scan is finished, the Definition Dependencies window opens,
listing the dependent definitions.

8. Click OK.8. 

9. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Forms
A CSM Form is a graphical representation of a CSM Business Object that is used to view and input data
directly into the Business Object's Fields using configurable Form Controls (example: Text boxes, combo
boxes, links, buttons, etc.) and an optional Form Arrangement (special tabbed area that displays related
data). When you view an Incident record in CSM, you are viewing the Incident Business Object Form;
each Form Control represents an Incident field.
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About Forms
Example Forms include:

• Incident.

• Problem.

• Change Request.

• Knowledge Article.

• Task.

Forms usually include several different types of Form Controls and a Form Arrangement at the bottom. A

Form is typically identified by the Form icon . A Form Arrangement is typically identified by the Form
Arrangement icon . A Theme controls the colors and styles of the Form and its Controls, and gives the
Form a cohesive look. To tour a sample Form, refer to Tour a Form.

The following types of Forms are available for each Business Object:

• Regular Form: By default, each Business Object has one designated default Regular Form;
however, you can create as many Regular Forms as you need. For example, create one Form for an
internal support team and another for an external support team to show different data, or create
smaller Forms to embed in one larger default Form (example: Toggle between a detailed and
summary view of a Knowledge Article).

• Summary Form: A Summary Form is a smaller Form with a subset of information. Typically, a
Summary Form is used on a Form Arrangement tab where only a subset of information is required
(example: Customer summary, such as name, department, title, and contact information).

• Mini-Summary Form: A Mini-Summary Form is a much smaller Form with a very small subset of
information. Typically, a Mini-Summary Form is used as an Embedded Form when only a very
specific subset of information is required (example: Very brief Customer summary, such as name
and contact information).

• Form Arrangement: A Form Arrangement is a tabbed collection of child Forms and records that
can be dynamically displayed on a parent Form/record to convey related information (example:
Journals or Tasks related to the parent record, or an additional Form for the same record that
displays fields in a different way).

• Form View: A Form View is a Form that has been created specifically for a Business Object View
so that data from a Business Object can be exposed in a more secure and more personal way. For
example, create an Incident Form for the OOTB Portal View so that Customers can access a
simpler Incident Form and Grid.

• Mobile Form: A Mobile Form is a simplified version of a CSM Form that is optimized for users
accessing CSM on a mobile device.

CSM provides a wide variety of OOTB Forms, including an OOTB default Regular Form for each OOTB
Business Object (in some cases, multiple Regular Forms are provided); an OOTB Summary and Mini-
Summary Form for most Major and Supporting Objects (although not all are used); an OOTB Form
Arrangement for each OOTB Major Object; and OOTB Form Views for most Major Objects for the OOTB
Portal View. Use these OOTB Forms as-is, edit them, or create your own.
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To help manage (create, edit, and delete) Forms, CSM provides the Form Editor; to help manage Form
Arrangements, CSM provides the Form Arrangement Editor. Both tools are accessed from within a
Blueprint in CSM Administrator.
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Tour a Form
Forms are highly configurable so no two Forms necessarily look or behave alike.

The following figure shows an example Incident Form. The individual components are the different kinds
of Form Controls: Field Form Controls display and store field data, Standard Form Controls enhance
design and data entry, and Special Form Controls provide advanced CSM functionality. The Form
Arrangement at the bottom provides access to related information, organized by tabs.

1. Label: Identifies the record as an Incident.

2. Link Label: Runs a One-Step to change the status of the record.

3. Label (Expression-Driven Value): Dynamically displays the selected record priority (selected in the
Priority Matrix).

4. Image (Expression-Driven Visibility): Dynamically displays a crown image when the current
Customer is identified as a VIP.
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5. Related Item Selectors: Special Controls that allow you to quickly view related information for
Customers (example: Contact Manager  and Customer Record ), CMDB (example: CI database

 and CI Record ), or a configurable list of values (example: Incident Categorization).

6. Image (Expression-Driven Avatar): Dynamically displays the current Customer's Avatar.

7. Rectangle: Shape to group/highlight an area within the Quick Info Tile. Note: Banner, Ellipse, Line,
and Group Box Shapes are also available.

8. Field Label: Identifies the field to which it is tied.

9. Field Controls (Text Box, Combo Box, Check Box): Enables you to input/select values for a field
(data is saved to the record). Numerous other Field Controls are also available (example: Spinner,
Radio Button, etc.).

Note: The Field type (example: Text, Number, Date/Time, and Logical) determines which
Control is used by default to represent the Field (example: Text Fields use a Text Box;
validated Text Fields use a Combo Box; Number Fields use a Text Box but can use a
Spinner; Rich Text Fields use a Rich Text Box; Date/Time Fields use a Text Box with
Calendar; and Logical Fields use a Check Box).

10. Matrix Selector: Special Control that displays a configurable matrix.

11. Buttons: Run Actions/One-Steps to automate record logging (example: Change Status, Display
Rich Text Editor, display Configuration Map).

12. Form Arrangement: Displays related information, organized by tabs. Some tabs display content
from Relationships; other tabs display additional Incident Forms.

13. Embedded Form: (Not shown) Special Control that displays another Form within the main Form.
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Form Controls
A Form Control is a mechanism that allows you to interact with data on a Form (example: Text Box, List
Box, Button, etc.).

CSM provides the following types of Form Controls:

• Field Form Controls: Displays/stores data from a Business Object Field (example: Text Box,
Combo Box, Rich Text Box, Text Box with Calendar, and Check Box).

• Standard Form Controls: Enhances design and data entry.

Note: Buttons and Link Labels can execute a single Action when clicked (example: Run an
Action). Labels might or might not be tied to a Field Control. Radio Buttons are associated
with a Field.

• Special Form Controls: Special built-in CSM Controls with enhanced functionality (example:
Embedded Form, Matrix Selector, and Related Item Selector).

The following table describes the different Form Controls:

Icon Form Control Description

Field Controls

Text Box

 

Rectangular frame into which you can type text. This can be a single-line
Text Box or a multi-line Text Box (Field property determines the number
of lines).

Use for:

Text fields

Number fields

Combo Box

 

Rectangular frame into which you can either type a value or select a
validated value from a list.

Note: If validation is enforced on the Field, you can only enter valid
values into the Control.

Use for validated:

Text fields

Number fields
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Icon Form Control Description

Rich Text Box

 

Rectangular frame into which you can type/paste Rich Text (formatted
text and/or images). This Control allows access to formatting options
using the Rich Text Zoom window (F8).

Use for Rich Text:

Text fields

Text Box with
Calendar

 

Rectangular frame with a popup calendar, into which you can type a date
or select a date from the calendar popup window.

Use for:

Date/Time fields

Number Box
with Spinner

Rectangular frame into which you can either type a number or select an
incremental number from a list.

Use for:

Number fields

Check Box

 

Square box that is selected (checked) or cleared (unchecked) to indicate
a logical decision (example: Enabled/disabled, on/off, yes/no).

Use for:

Logical fields

Standard Controls

Banner Title and image (example: Company name and logo).

Button Button that is capable of executing a single Action when clicked
(example: Run an Action).

Group Box/
Tabbed Group
Box

"Container" shape around other Controls. Used to organize other
Controls and enhance the appearance/usability of the Form.

Image Custom image. Use to enhance the appearance/usability of the Form.

Label
Text that identifies or enhances other Form elements (example: The
Form itself, area, Control, group of Controls, etc). Often, a label is tied to
and identifies a Field Control.
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Icon Form Control Description

Link Label Underlined text that is capable of executing a single Action when clicked
(example: Run an Action).

List Box Rectangular box with multiple values.

Radio Button List of choices; stores a value for the selection.

Shape Various shapes (Ellipses, Lines, and Rectangles) that organize other
Controls and enhance the appearance/usability of the Form.

Special Controls

Embedded Form
Special Control that provides a "container" frame for one or more
Embedded Forms. The Control's properties define when and how the
Embedded Forms are displayed.

Matrix Selector Special Control that displays a configurable matrix.

Related Item
Selector

Special Control that allows you to quickly access related information in
order to view or populate a Field with a value. In CSM, you can access
the following related information:

• Customer (example: Contact Manager  and Customer Record
)

• CMDB (example: CI database  and CI Record )

• Configurable List of values (example: Incident Categorization)

The following figure shows the different Form Controls.
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Field Form Controls
A Field Form Control is a Form Control that displays and stores data from a Business Object Field. Use a
Field Form Control to:

• Provide data to a Business Object Field (empty record).

• View a stored value from a Business Object Field (completed record).

The Field type determines which Control is used by default to represent the Field (example: Text Fields
use a Text Box). If the Field properties of an existing Field Control change after the Control has been
added to a Form, you should remove and re-add the Control to the Form in order to get the correctly
associated Control to display (example: If you change a Text Field to be a Rich Text Field, you should
remove and re-add the Control so that the Field is represented by a Rich Text Control).

CSM supports the following types of Field Form Controls:

• Text Box: Rectangular frame into which you can type text. A Text Box Control is used with Text and
Number Fields.

• Combo Box: Rectangular frame into which you can either type a value or select a validated value
from a list. A Combo Box is used with validated Text and Number Fields.

• Rich Text Box: Rectangular frame into which you can type/paste Rich Text (formatted text and/or
images). This Control allows access to formatting options using the Rich Text Zoom window (F8).

• Text Box with Calendar: Rectangular frame with a popup calendar, into which you can type a date
or select a date from the calendar popup window.

• Number Box with Spinner: Rectangular frame into which you can either type a number or select
an incremental number from a list.

• Check Box: Square box that is checked or cleared (unchecked) to indicate a binary decision
(example: Enabled/disabled, on/off, yes/no).

 Text,  Number,  Date/Time, and  Logical field.

The following figure shows the Field Form Controls on a Form.

Related concepts
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Configuring Field-Level Encryption
Forms Theme Properties
Related tasks
Add a Field Form Control to a Form
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Field Form Control Properties

Text Field Control Properties
Right-click a Text Field Control and select Control Properties to set the following properties.

Note: Encrypted Fields cannot be validated, so these control properties do not apply.

Property Description

Show Drop-Down Select this check box to display a drop-down of values. Clear the check box to
display a plain text box.

Sort By Select the Field to use to sort the search results (ex: Name).

Ascending Select this check box to list the values in ascending (A-Z, 1-10, etc.) order.

Hide Entry
(Password) Select this check box to hide the values in the Control with dots.

Number Field Control Properties
Right-click a Number Field Control and select Control Properties to set the following properties.

Property Description

Show Spinner Select this check box to display spinner arrows in the Control . Clear the check box
to display a plain text box.

Spinner
Increment

Provide or select the number by which to increase the Counter each time it
increments (ex: 1).

Show Group
Separator

Select an option for displaying number characters (ex: Commas, decimals, etc.).
Select True to display characters, False to hide characters, and System to follow
your system's defined rule.
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Standard Form Controls
A Standard Control is a Form Control that enhances Form design and data entry. CSM provides the
following Standard Controls:

• Banner: Displays a title (text) and image (ex: Company name and logo, title and icon, permanent
contact information, etc.).

• Button: Executes a single Action when clicked (ex: Open a Rich Text zoom window, launch a
Visualization, view related Knowledge Articles, move to the next Form in a multi-Form process, etc.).

• Group Box/Tabbed Group Box: Organizes other Controls in containers to enhance a Form's
appearance and usability.

• Image: Displays a custom image (ex: Company logo, Team icon, personal photo, etc.).

• Label: Textually identifies or enhances other Form elements. Often, a label is tied to and identifies a
Field Control.

• Link Label: Executes a single Action when clicked (ex: Move a record through a workflow, send a
Customer e-mail, submit resolution details to the Knowledge Base, etc.).

• List Box: Displays multiple values from which a User can select (ex: Call sources, list of Services,
distribution list, etc.).

• Radio Button: Presents a list of choices and stores a value for the selection (ex: Show all tabs or
just related tabs in a Form Arrangement, toggle between Embedded Forms, etc.).

• Shapes (Ellipses, Lines, and Rectangles): Organizes other Controls to enhance a Form's
appearance and usability.

The following figure shows the Standard Form Controls on a Form.

Good to know:

• By default, a Standard Control's font, colors (background, foreground, and border), border style, and
background style properties come from the defined Form Theme; however you can define your own
properties, if needed.
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• Image Controls do not support text, background, foreground, or border colors; therefore no colors,
styles, or fonts can be applied.

• To include an ampersand character (&) in a Label or Link Label Control, enter two ampersands (&&).
One ampersand is used to designate a keyboard accelerator, so entering a double ampersand
escapes the accelerator and ensures that a single ampersand is displayed.

• After a Standard Form Control is added to a Form, you can define how the Control looks and
behaves on the Form (ex: Size, alignment, visibility, etc.).
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Special Form Controls
Special Controls are built-in CSM Form Controls with enhanced functionality. CSM provides the following
Special Controls:

• Embedded Form: Displays one or more Embedded Forms using either a Relationship or an
Expression.

• Matrix Selector: Displays a configurable matrix (ex: A priority matrix). One value is selected from
the column header, one from the row header, and the final value is selected from the point where
the row and column intersect.

• Related Item Selector: Allows quick access to critical related information to populate a Field with a
value and/or view the related items (ex: Customer or Configuration Item information).
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Form Themes
A Theme is a set of colors, fonts, images, and styles that can be used by elements on a Dashboard,
Form, or Portal site to give a cohesive look. In a Theme, define colors, fonts, images, and styles for the
different elements on a Form (ex: Form background color, Form Control label fonts, etc.).

For a detailed list of Form-specific Theme properties, see Form Theme Properties.

A Theme is selected as part of a Form's properties.

CSM provides several OOTB Themes. Use these OOTB Themes as-is, edit them, or create them using
the Theme Manager.
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Embedded Forms
An Embedded Form is a Form that can be embedded into another Form as a separate entity.

Use Embedded Forms to maintain and reuse smaller chunks of data, and to conditionally display the right
data at the right time.

For example:

• Show troubleshooting questions on your Incident Form, then replace them with resolution details
when you are ready to close.

• Display your standard Embedded Survey Form in the last step of a Portal Form to solicit Customer
feedback.

• Allow Users/Customers to toggle between simple and detailed Forms so that they can view more
details only when needed.

The following figure shows the default KA Form, whose Main Pane toggles between two Embedded
Forms: Article (simple) and Details (detailed). The simple Article Form shows only the KA Title and
Solution/Workaround. The Details Form shows the KA Title and Solution/Workaround, as well as the
keywords, Service Categorizations, Article Type, etc. Radio buttons allow Users/Customers to toggle
between the two Embedded Forms.

The following figure shows how the KA Form is designed. The links tell CSM which Embedded Form
(Article or Details) to display in the KA Form Main Pane.
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Embedded Forms are created the same way as any CSM Form, but are then added to another Form
using the Embedded Form Control.
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Form Arrangements
A Form Arrangement is a tabbed collection of child Forms and records that can be dynamically displayed
on a parent Form/record to convey related information (example: Journals or Tasks related to the parent
record, or an additional Form for the same record that displays fields in a different way).

A Form Arrangement can display:

• A Form from any configured Relationship: For example, the Incident Business Object is often in
a Relationship with the Journal, Task, Configuration Item, and Problem Business Objects, so any of
those Forms/records can be displayed in the Incident's Form Arrangement. If a Form/record in the
Form Arrangement is in an owned by Relationship with the parent Form/record (example: Incident
Owns Journals), then it can by edited; however, Forms/records in linked Relationships (example:
Incident Links Problem) are read-only.

• Any Form created for the same Business Object: For example, Incident has several Forms that
display Incident fields in different ways (example: Resolution Details, Incident Details, etc.), so any
of these Incident Forms can be displayed on the main (default) Incident Form.

Tip: This is useful for displaying summary information, a subset of information, or
information that is not always visible (example: Details from an Embedded Form).

A typical Form Arrangement might include:

• Journals: Track what occurs during the lifecycle of a record (example: Notes and history).

• Tasks: Track a piece of work that is created and assigned to another CSM User or Team.

• Approvals: Track approving/denying/abstaining content by one or more designated Users or Teams.

• Configuration Items: Track managed assets that make up the CMDB.

• Knowledge Articles: Track records that share Knowledge (example: FAQs, how-tos, workarounds/
solutions, tutorials, processes, reference, etc.) among Users and Customers.

• Discussions: Track discussions with Customers and/or other Users.

The following figure shows an example Incident Form (1) with its Form Arrangement (2). The Incident
Form Arrangement contains important data related to an Incident (example: Journals, Tasks, Resolution
Details, Problems, etc.).
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Good to know:

• A Form Arrangement is highly configurable. You decide which tabs to include, the tab position, and
the tab properties (example: Name, image, visibility, toolbar options, supported views (Form, Grid, or
both), default view, filtering options, etc.).

• Typically, only Major Objects have Form Arrangements; only one Form Arrangement can exist for
each Business Object in a Business Object View.

• Filters can be applied to Form Arrangements to control the child records that are shown on a tab.
Users can add records that violate the filters, however. Once the parent record is saved, the child
records are removed based on the filters. In the Desktop Client, the child records are removed after
the parent record is saved and refreshed.

• Often, Summary Forms are used on a Form Arrangement because they are smaller and typically
show the most important data.

• There are other ways to display "related" data. For example, a Relationship exists between Incident
and Customer but displays using a Related Item Selector and/or a Mini-Summary Form that shows
only the Customer’s phone number and e-mail address.

• You can create stacked zone arrangements for the Portal view of Business Objects.
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CSM provides an OOTB Arrangement for each OOTB Major Business Object. Use these OOTB Form
Arrangements as-is, edit them, or create your own using the Form Arrangement Editor (accessed from
within a Blueprint in CSM Administrator).

CSM 9.3.0 Features 304

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=about_blueprints


Form Views
A Form View is a Form that has been created specifically for a Business Object View so that data from a
Business Object can be exposed in a more secure and more personal way via a Role.

For example, create an Incident Form for the OOTB Portal View so Customers can access a simpler
Incident Form and Grid. This Form might display only required Fields, and Field labels may be changed
so that they sense to a Customer.

After a View is created, you can select it and then create Forms for the View, just as you would any
Business Object.
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OOTB Forms
The possibility for Forms is endless. However, to get you started, CSM provides the following OOTB
Forms:

• Default Regular Form for each OOTB Business Object. In some cases, multiple Regular Forms are
provided. Common examples include:

◦ Incident.

◦ Problem.

◦ Change Request.

◦ Knowledge Article.

◦ Journal.

◦ Task.

• Summary and Mini-Summary Form for most Major and Supporting Objects (although not all are
used).

• Form Arrangement for each OOTB Major Object.

• Form Views of most Major Objects for the OOTB Portal View.
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Using Forms
Using Forms and Form Arrangements varies by Business Object:

• For general information about logging records, refer to About Records.

• For specific information about logging records for OOTB CSM Business Processes, refer to CSM
Business Processes, specifically:

◦ Incident.

◦ Problem.

◦ Change Request.

◦ Knowledge Article.

◦ Journal.

◦ Task.
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View a Form
To View a Form:

• In the CSM Desktop Client main window: When you log or view a record.

• In the CSM Browser Client main window: When you log or view a record.

• In the CSM Portal: When you log or view a record.

• In Cherwell Mobile (simplified Mobile Form): When you view a record.

• In CSM Administrator: When you create/edit a Form.

Note: For general information about logging records, refer to About Records. For specific
information about logging records for OOTB CSM Business Processes, refer to CSM
Business Processes.

CSM 9.3.0 Features 308

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=about_records
https://help.cherwell.com/csh?topicname=csm_business_processes
https://help.cherwell.com/csh?topicname=csm_business_processes


Managing Forms
Forms are managed using the Form Editor, accessed from within a Blueprint in CSM Administrator.

Use this tool to:

• Create a Form.

• Edit a Form.

• Delete a Form.

Note: Within the Form Editor is the Form Wizard, a specialized tool that automatically
creates a new Form with all the appropriate Fields and Control properties.
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Form Editor
The Form Editor is a tool within a Blueprint in CSM Administrator that allows you to manage (create, edit,
and delete) Forms, and to define how a Form and its Controls look and behave.

The Form Editor is dynamic; when you make changes, the changes are immediately reflected in the
preview. Publish the Blueprint to commit the changes. The Form Editor contains:

1. Form menu bar item: Displays Form-specific commands. This menu bar appears on the Blueprint
Editor menu bar only when a Form is active in the Object Manager.

2. Toolbar: Displays common commands for formatting the appearance and behaviors of a Form and
its Form Controls. The Blueprint Editor toolbar is also available with commands for cut, copy, paste,
delete, etc.

3. Adaptive Layout Guide Bar: Shows the breakpoints for the Adaptive Layouts that have been
configured for the Form. A triangle indicates the layout that is currently selected.

4. Form drop-down: Lists the Forms defined for the selected Business Object (ex: Default, Basic Info,
etc.). The currently-selected default Form is displayed at the top of the list as "Default Form."

5. Search Control/Ignore Folders button: Use to quickly locate and display Fields. Use the Search

Control  to quickly locate a Field whose Name and Description contain
a specific word or phrase (ex: OwnedBy). Use the Ignore Folders button  to ignore the
organizational folders and display all Fields at the root of the list.

6. Field tree: Lists the Business Object Fields you can add to the Form (as Controls). Fields are
organized alphabetically and by folder.
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Tip: Create, edit, and delete a Field directly from the Form Editor by right-clicking in the
Field tree.

7. Control tree: Lists the Form Controls you can add to the Form.

8. Form preview: Displays a dynamic preview of the Form.
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Form Menu Bar Item
The Form menu bar item appears on the Blueprint Editor menu bar anytime a Form is active in the Object
Manager. Use the Form menu bar item to access Form-specific commands.

Action Description

New Form Opens the New Form window to create a new named Form.

Delete Form Deletes the selected Form.

Make this the
Default Form

Makes the active Form the default Form (either Regular or Mini-Summary,
whichever is selected) for the Business Object. The default Form is displayed by
default when the Business Object is accessed.

Form Properties Opens the Form Properties window to access defined Form properties, such as
name and Theme.

Change Theme Opens the Select a Theme window to select a defined Theme.

Form Wizard Launches the Form Wizard, which automatically creates a Form with all the
appropriate Fields and Control properties.

Adaptive Layouts

Opens a new menu of options for managing the Form's Adaptive Layouts. Use
this menu to toggle between Adaptive Layouts, edit properties for the selected
Adaptive Layout, create a new Adaptive Layout, delete the selected Adaptive
Layout, or manage Adaptive Layout Presets.

View/Set Tab Order Displays the currently defined tab order (order in which the cursor moves to the
next Field Control when the tab key is pressed). Change the tab order, if needed.

Auto-Select Labels
with Controls

When selected, automatically selects both the Field Label and Control when they
are tied together. This is useful for moving Controls together.

Auto-Move
Contained Controls

When selected, automatically moves all Controls contained within the boundary
box of another Control (ex: Moves all Controls within a Group Box, or Rectangle,
etc.). This is useful for moving Controls together.

Scale Form Opens the Scale Form window, and then select default starting and ending DPI
values to help size and align the Form/Controls if scaled.
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Form Editor Toolbar
Use the Form Editor toolbar to quickly access common commands for formatting the appearance and
behaviors of a Form and its Form Controls. The toolbar is made up of three smaller toolbars:

1. Formatting toolbar

Displays options for formatting Form Control text/label (font, style, size, and alignment), colors/styles
(foreground, background, and border), and behaviors (visibility, anchoring, and image). Also
displays options for accessing a Form background color.

2. Label toolbar

Displays options for defining Form Control labels and wrapping.

3. Design toolbar

Displays options for aligning and placing Form Controls.

4. Adaptive Layouts toolbar

Displays options for managing a Form's Adaptive Layouts.

Good to know:

• Move a toolbar by double-clicking the Grab bar , or by grabbing the Grab bar and then dragging
the toolbar to a new location.

• Re-dock a toolbar to its default location by double-clicking the header banner of an undocked
toolbar.

• Hide a toolbar by right-clicking anywhere in the toolbar area, and then unchecking the toolbar.

• Many of the toolbar options are also available from the Form Editor context (right-click) menu.

Formatting Toolbars (Text, Color/Style, and Behaviors)
Form Control Text/Label
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Button Action Description

Form Control text

There are two different font
modes for Form Control text:

• Theme Font: Uses the
default Theme Control
font.

• Explicit Font: Allows you to
set an explicit font and
other font details on a
Control-by-Control basis.

To switch to Theme mode, select
Theme Font from the top of the
list.

To switch to Explicit mode,
select a font in the drop-down.

Font size

Explicitly sets the Form Control
font size (ex: 10 points).

Note: This option is
available only when
using Explicit Font
mode.

Font style

Adds style to the Form Control
font (bold, underlined, or italics).

Note: This option is
available only when
using Explicit Font
mode.

Horizontally align text
Aligns text left, center, or right on
a horizontal axis within the Form
Control bounding box.

Vertically align text

Aligns text top, middle, or bottom
on a vertical axis within the Form
Control bounding box.
Click the drop-down arrow to
select the alignment option.

Control Color/Style
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Button Action Description

Background color

Click the button to use the most
recently used color (assuming you
have set a color). To explicitly select a
color, click the drop-down arrow to
select a solid color or a gradient. You
can use an Expression to conditionally
change the color.

Text color

Click the button to use the most
recently used color (assuming you
have set a color). To explicitly select a
color, click the drop-down arrow to
select a single color or a gradient. You
can use an Expression to conditionally
change the color.

Border color

Click the button to use the most
recently used color (assuming you
have set a color). To explicitly select a
color, click the drop-down arrow to
select a single color or a gradient. You
can use an Expression to conditionally
change the color.

Border style

Sets the style of the border around the
Form Control (No Border, 3D, or Pixel
width), if there is a border.

Click the button to use the most
recently set style (assuming you have
set a style). To explicitly select a style,
click the drop-down arrow to select a
style.

Note: While you can select 3D
borders for any Form Control,
rounded Shapes do not allow
3D settings.

Control Behavior
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Button Action Description

Visibility

Conditionally controls when the
Form Control appears and
disappears. The visibility is based
on an Expression.

Click the drop-down button to
define a custom Expression. Click
the drop-down arrow to access
options for creating a custom
Expression, selecting a stored
Expression, or clearing the
Expression.

Visibility by Expression

Conditionally controls when the
Form Control is available. The
visibility is based on an
Expression.

Click the drop-down button to
define a custom Expression. Click
the drop-down arrow to access
options for creating a custom
Expression, selecting a stored
Expression, or clearing the
Expression.

Localization options

Enables you to:

• Copy control size and
position from one culture to
another. See Managing
Translated Content on
Forms.

• View translations for Form
Control text. See Viewing
Translations for Definitions.

This option is only available when
Globalization is enabled.

Control anchor

Sets the anchoring behavior of the
Form Control.

Click the button to use the most
recently set anchoring options
(assuming you have set an option).
To explicitly select an anchoring
option, click the drop-down arrow
next to the button to open the
Anchoring window, and then select
an anchoring option.
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Button Action Description

Control image

Defines the image to display on the
Form Control, as well as alignment.

Click the button to open the Image
Manager, and then select an image
to show on the Form Control. Click
the drop-down arrow to access
options for creating a custom
Expression, selecting a stored
Expression, clearing the
Expression, or aligning the image.

Form Background Color

Button Action Description

Form background

Sets the Form background
color.

Click the button to use the
most recently set color
(assuming you have set a
color). To explicitly select a
color, click the drop-down
arrow to select a single color
or a gradient. Use an
Expression to conditionally
change the color.

Label Toolbar (Label Text, Wrap, Style, and Gloss)

Button Action Description

Label Text
Box

Defines the text/label that appears on the currently selected Form Control.

Type the text into the Label text box.

Note: This value only affects the primary selected Form Control.

Expression

Conditionally defines the text that appears on the currently selected Form
Control. You can use either:

• Expression Manager: Select this option to open the Expression
Manager, and then select an existing stored Expression or create a
new stored Expression. Stored Expressions can be reused in
numerous places in CSM.

• Custom Expression: Select this option to open the Custom Expression
Builder, and then create a custom Expression to use only for the active
scenario.
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Button Action Description

Tooltip Defines the tooltip that appears when a User hovers over the Form Control.

Design Toolbar (Alignment, Size, and Order)
For most of the alignment operations, you must select at least two Form Controls. The last selected
Control is the controlling Control, and the Control against which all other selected Controls are sized and
aligned. The controlling Control is identified by black boxes. All other selected Controls are identified by
white boxes.

Button Action Description

Line up
horizontally

Lines up all the selected Form Controls against the left, center, or right
edge of the controlling Form Control.

Line up
vertically

Lines up all the selected Form Controls against the top, middle, or bottom
edge of the controlling Form Control.

Sizing
Sizes all the selected Form Controls to be the same width, the same
height, or both the same height and same width as the controlling Form
Control.

Auto-size Sizes a text Form Control to be exactly the right size to hold all its
contained text. Sizes an image to be its original size.

Bring to Front

Moves a Form Control in front of other Form Controls. Use this if creating
various layering effects.

Note: Not all Form Controls are allowed to be in front or behind
all other Form Controls (ex: Most shapes cannot be on top of
most fields).

Send to Back

Moves a Form Control behind other Form Controls. Use this if you are
creating various layering effects.

Note: Not all Form Controls are allowed to be in front of or behind
all other Controls (ex: Most Shapes cannot be on top of most
Fields).

Activates Guide
Lines

Grid Guide Lines of customizable widths appear to assist with Form
creation. Widgets or Fields automatically align to the width of the guide
lines.

Activates Guide
Snapping

Guide Snapping connects Widgets and Fields to the primary component.
Enabling Guide Snapping assists with creating Forms by making it easier
to move multiple components at once while keeping their spacing or
alignment. A red guide line also appears to assist with horizontal and
vertical alignment.
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Adaptive Layouts Toolbar

Button Action Description

Select an Adaptive Layout

Activates the selected Adaptive
Layout in the Form Editor so
that you can change its design,
edit its properties, or delete it.

Edit an Adaptive Layout

Allows you to edit the properties
of the selected Adaptive
Layout. Refer to Edit an
Adaptive Layout for details.

Create an Adaptive Layout

Allows you to create a new
Adaptive Layout for the Form.
Refer to Create an Adaptive
Layout for details.

Delete an Adaptive Layout

Allows you to delete the
selected Adaptive Layout. Refer
to Delete an Adaptive Layout
for details.
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Form Editor Behaviors
Form Editor Context Menu

Use the Form Editor context (right-click) menu to quickly access common Form Editor operations.

Search for Fields

• Field Search Control : Use to search for a Field by name or description
(ex: "Incident" or "Status").

• Hide/Display Folders option : Use to hide folders in the Field tree, so that all Fields can be
displayed at the root node, regardless of how they are organized/stored in the tree.

Select a Control

• To select a Control, click a Control or click-and-drag (rubber-band) over the Control. This deselects
all other Controls.

• A selected Control is identified by black boxes around the bounding box. The bounding box
represents the Control's vertical and horizontal dimensions.

Select Multiple Controls

• To select multiple Controls:
◦ Hold down the CTRL key while you click each Control in turn.

◦ Click-and-drag (rubber-band) over the Controls you want to select. Any Control that is included
(even partially) in the rubber-band box will be selected.

◦ Press CTRL+A to select all Controls.

• When multiple Controls are selected:
◦ The controlling Control is the last selected Control, and the Control against which all other

selected Controls are sized and aligned.

◦ The controlling Control is identified by black boxes. All other selected Controls are identified by
white boxes.

◦ To change the controlling Control, hold down the SHIFT key and click a different selected
Control.
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Edit Controls

• To delete a Control, click it, and then press the DELETE key.

• To edit the detailed properties of a selected Control, right-click>Control Properties.

• To edit the Field Properties of a selected Field Form Control, right-click>Field Properties.

• To duplicate a Control, press CTRL+Drag.

• To move a Control, drag the Control.

• To move/nudge a Control one (1) pixel, press an ARROW key.

• To maintain aspect ratio when resizing, hold down SHIFT while sizing.
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Design a Form
Form design is important. Before creating a Form, you should:

Consider the following:

• Audience: Who is it for (User or Customer? Technician or Executive? Etc.)?

• Purpose: How will it be used (For detailed call logging? For self-service activities? For read-only
purposes?)?

• Client access: From where will it be accessed (Desktop Client? Browser Client? Portal? Cherwell
Mobile?)?

• Layout: Which Controls will be on it (Field Controls? Standard Controls? Special Controls?) and
what will it look like (colors, font, alignments, etc.)?

• Security: Who can access it?

• Devices: Which devices will be used to access it?

Review the following tips for designing an effective Form:

• Make it useful: Consider the audience and what they need most. Technicians might need very
detailed information, Portal Customers might need more simplified, more colorful Forms with more
User-friendly labels, casual contributors (ex: KA) might need abbreviated details, etc.

• Make it pretty: Do not underestimate the visual experience. Employ visual elements, such as
images, colors, styles, alignment, and layering to convey information and embellish the aesthetic.
Use consistent, browser-friendly fonts and colors (or Themes) to ensure stability and cohesion.

• Make it conditional: Use Expression-driven colors, text, images, and visibility to dynamically
change the way a Control looks and behaves based on a defined condition. For example, display a
Priority bar (Rectangle) in a Quick Info Tile, then conditionally change the color to indicate
importance (ex: Red for Priority 1 and green for lower priorities).
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Open the Form Editor
1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a

New Blueprint task.
The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Current View drop-down, select the Business Object View whose Forms you want to access.
3. In the Business Object tree, click the Business Object whose Forms you want to access.

Tip: Filter the Business Objects by clicking the Major, Supporting, Lookup, or All radio
button.

4. In the Appearance area of the Object Manager, click the Edit Form link.

Tip: You can also click View>View Form on the Blueprint Editor menu bar or click the Form

toolbar button  on the Blueprint Editor toolbar.

Important:
◦ To access a Summary Form, click Edit Summary Form.
◦ To access a Mini-Summary Form, click Edit Mini-Summary Form.
◦ To access a Form Arrangement, click Edit Form Arrangement.

The Form Editor opens displaying the Business Object's default Form. A dynamic Form menu bar
item appears on the Blueprint Editor menu bar so that you can access Form-specific commands.

5. If more than one Form exists for the Business Object, select the Form to open by selecting it in the
Form drop-down (upper-left).
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Create/Edit a Form
Use the Form Wizard to initially and quickly create a new Form. The Form Wizard (accessed from within
the Form Editor in a Blueprint) is a specialized tool that automatically creates a new Form with all the
appropriate Fields and Control properties. Afterwards, you can tweak the Controls and properties as
needed. When you create a Form using the Form Wizard, the wizard:

• Prompts you to select a Form Theme.

• Adds all the appropriate Fields from the Business Object, assigning a Field Form Control and Label
Control.

Warning: If you run the Form Wizard on a Form that has two or more Adaptive Layouts, all of the
layouts will be removed and the base layout's dimensions will be reset.

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to manually create and edit
a Business Object Form. When you create a Form, you:

• Name the Form.

• Select a Theme.

• Select a Form background color.

• (Optional) Edit the Adaptive Layout properties for your Form to change its dimensions.

Note: Each Form consists of at least one Adaptive Layout that defines the Form's targeted
dimensions. This is the base layout that is generated automatically when you upgrade an
existing Form or create a new Form.

• Add one or more Form Controls to the Form: Field, Standard, and Special Controls.

• Define how each Form Control looks and behaves on the Form: Text, tooltip, color, image, size,
alignment, anchoring, layering, visibility, enabling/disabling, tab order.

• (Optional) Make the Form the default Form: Applicable only for Regular and Mini Summary Forms.

• (Optional) Create additional Adaptive Layouts for your Form so that it can be viewed on different
devices.

To create a Form:

1. Open the Form Editor

2. From the Blueprint Editor menu bar, click Form>New Form.

3. Provide a name for the Form, and then click OK.

An empty Form opens in the Form preview pane.

4. Click Form>Form Wizard.

5. Select a Theme to use on the Form, and then click OK.
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The Form Wizard automatically adds all the Fields from the Business Object to the Form and
applies the Theme colors, fonts, and styles.

6. You can then:
◦ Select a Form background color.

◦ Add one or more Form Controls to the Form.

◦ Define how each Form Control looks and behaves on the Form: Text, tooltip, color, image,
size, alignment, anchoring, layering, visibility, enabling/disabling, tab order.

◦ Make the Form the default Form.

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

To edit a Form:

1. Open a Form in the Form Editor

2. Make changes.

Note: To access Form Properties, click Form>Form Properties from the Form Editor menu
bar.

3. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Select a Form Background Color
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to select a background color
for the Form. Colors can come from:

• (Recommended) CSM Themes: All colors defined for the selected CSM Theme.

• System:

Set of colors provided by your Operating System. System colors can greatly vary depending on the
Operating System and browser used to view the color.

• Web:

Set of named Web-safe colors.

• RGB colors:

Customized Red, Green, Blue (RGB) colors.

Good to know:

• If you are using Form Themes, use a Theme color for the Form background (ex: Form background
color). You can select a system, Web, or RGB color; however, if you use a non-Theme color, the
background will not change to another Theme color when you apply a different Theme.

• Theme colors are defined as part of a Theme's definition. Use the Theme Manager to create a
Theme.

• Colors can be solid or can contain gradients.

• Colors can be conditional (Expression-driven): For example, define an Expression to conditionally
change the background color of a Form to red to indicate a surpassed threshold (ex: High priority).

To select a Form background color:

1. Open a Form in the Form Editor.

2. On the Form Editor toolbar, click the drop-down arrow on the Background Color button .

3. Select a color pattern, either:
◦ Solid color: Uses one color (First Color) for the background. Click one color in the list.

◦ Gradient (left-to-right or top-to-bottom, two (2) or three (3) colors): Uses a gradient between
two or three colors (First Color, Second Color, Third Color). Click two/three colors in the list,
and then click Select.

4. Select a background color, either:
◦ Use Expression: Select this check box to use an Expression to conditionally change the color,

and then select or define the condition, using either:

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.
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◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Color category:
◦ (Recommended) Theme:

All colors defined for the selected CSM Theme.

◦ System:

Set of colors provided by your Operating System. System colors can greatly vary
depending on the Operating System and browser used to view the color.

◦ Web:

Set of named Web-safe colors.

◦ Custom:

Customized Red, Green, Blue (RGB) colors.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Form Control to a Form
You can add the following Form Controls to a Form:
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Add a Field Form Control to a Form
Add Field Form Controls to a Form to display and store data from a Business Object Field on a Form.

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to complete this task.

1. Open a Form in the Form Editor.
2. Do one of the following:

◦ From the Form Editor menu bar, click Form>Form Wizard, and then click Yes to confirm that
you want to automatically add all applicable Fields from the Business Object to the Form,
overwriting the existing Form.

◦ Drag-and-drop a Field from the Field tree to the Form.

Tip: If the Field you need does not yet exist, create the Field directly from the Form
Editor by right-clicking in the Field tree. You can also edit and delete an existing Field
by right-clicking in the Field tree.

Remember: If a Field is intentionally excluded from Forms, it does not appear in the
Field tree and cannot be added to the Form. For more information about excluding
Fields from Forms and Grids, refer to Define Advanced Properties for a Field.

◦ Right-click a Field in the Field tree, and then select Add to Form.

Tip: By default, the Label and Control are tied together (that is, they are grouped and move
together). To untie the Label from the Control, right-click the Label/Control group, and then
clear the Label Tied to Control check box.

3. Optional: Set the control properties.
4. Optional: Define how the Field Control looks and behaves on the Form.
5. Publish the Blueprint to commit the changes, or save the Blueprint to continue making other

changes.

Related concepts
Forms Theme Properties
Related tasks
Size A Control
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Add a Standard Form Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Standard Form
Control to a Form.

Good to know:

• Standard Form Controls are highly configurable. You can add endless combinations to a Form, then
define how the Controls look and behave on the Form (ex: Text, tooltip, size, color, border style,
image, alignment, anchoring, layering, visibility, enabling/disabling, and tab order).

• Button, Link Label, List Box, and Radio Button Controls have additional Control properties (Right-
click>Control Properties) that must be configured.

• By default, most Form Controls acquire their text, color, border style, and background style
properties from the defined Form Theme; however you can define your own properties, if needed.

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add a Standard Form Control to a Form (general):

1. Open a Form in the Form Editor.

2. Drag-and-drop a Standard Control from the Standard Control tree onto the Form.

3. Define properties for the Control, if needed (Button, Link Label, List Box, and Radio Button).

4. (Optional) Define how the Form Control looks and behaves on the Form (ex: Text, tooltip, size, color,
border style, image, alignment, anchoring, layering, visibility, enabling/disabling, and tab order).

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Banner Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Banner Control to a
Form.

Good to know:

• A Banner Control is highly configurable; you can add one or many to a Form, then define how the
banner looks and behaves on the Form (ex: Text, size, color, border style, image, alignment,
anchoring, layering, and visibility).

• By default, the Banner Control font, color (background, foreground, and border), border style, and
background style properties come from the defined Form Theme.

• Text, image, and colors can be conditional (Expression-driven).

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add a Banner Control to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop the Banner Control from the Standard Control tree onto the Form.

3. Define the text to display on the banner:
a. In the Label text box on the Form Editor toolbar, provide the text to display on the banner.

b. (Optional) Change the font, font size, font style, and font alignment if needed.

4. Define how the banner looks and behaves on the Form (ex: Size, alignment, etc.).

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Button Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Button Control to a
Form. A Button Control is capable of executing a single Action when clicked (ex: Run an Action/One-
Step).

Good to know:

• A Button Control is highly configurable; you can add one or many to a Form, then define the Action
to execute when the button is clicked, and how the button looks and behaves on the Form (ex: Text,
tooltip, size, color, border style, image, alignment, anchoring, layering, visibility, and enabling/
disabling).

• Text, image, and colors can be conditional (Expression-driven).

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add a Button Control to a Form:

1. Open a Form in the Form Editor

2. Drag-and-drop the Button Control from the Standard Control tree onto the Form.

3. Define the Action to execute when the button is clicked:
a. Right-click the Button Control, and then select Control Properties.

b. In the Choose Action window, click the Ellipses button  to open the Action Manager, then
select the Action to execute.

4. Define the text to display on the button:
a. In the Label text box on the Form Editor toolbar, provide the text to display on the button.

b. (Optional) Change the font, font size, font style, and font alignment if needed.

5. Define how the button looks and behaves on the Form (ex: Size, alignment, etc.).

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Group Box Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Group Box Control
to a Form.

Good to know:

• A Group Box Control is highly configurable; you can add one or many to a Form, then define how
the group box looks and behaves on the Form (ex: Text, size, color, border style, image, alignment,
anchoring, layering, and visibility).

• By default, the Group Box Control text, color, border style, and background style properties come
from the defined Form Theme.

• Text, image, and colors can be conditional (Expression-driven).

• Controls added within the boundaries of a Group Box can all be moved together by simply dragging
the Group Box Control around.

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add a Group Box Control to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop the Group Box Control from the Standard Control tree onto the Form.

3. Define the text to display in the group box:
a. In the Label text box on the Form Editor toolbar, provide the text to display on the Group Box.

b. (Optional) Change the font, font size, font style, and font alignment if needed.

4. Define how the group box looks and behaves on the Form (ex: Size, alignment, etc.).

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add an Image Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add an Image Control to
a Form.

Good to know:

• An Image Control is highly configurable; you can add one or many to a Form, then define the Action
to execute when the image is clicked, and how the image looks and behaves on the Form (ex:
Tooltip, size, color, border style, image, alignment, anchoring, layering, visibility, and enabling/
disabling).

• Image Controls do not support text, background, foreground, or border colors; therefore no colors,
styles, or fonts can be applied.

• Images can be conditional (Expression-driven).

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add an Image Control to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop the Image Control from the Standard Control tree onto the Form.

3. Define the Action to execute when the image is clicked:
a. Right-click the Image Control, and then select Control Properties.

b. In the Choose Action window, click the Ellipses button  to open the Action Manager, then
select the Action to execute.

4. Define the image to display:

a. On the Form Editor toolbar, click the drop-down arrow on the Image button , and then
select one of the following options:

◦ Browse: Opens the Image Manager, where you can select an existing image or import a
new image to display on the Widget.

◦ From Stored Value: Opens the Stored Value Manager, where you can select an existing
Stored Value or create a new Stored Value to use.

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a
custom Expression to use only for this scenario.

◦ Expression Manager: Opens the Expression Manager, where you can select an existing
Expression or create a new stored Expression to use. Stored Expressions can be reused
in numerous places in CSM.

◦ None: Does not use an image.

5. Align the image:
a. Click the drop-down arrow on the Image button, select Image Alignment, and then select an

alignment option within the Control (ex: Top-right).

6. Define how the Image Control looks and behaves on the Form.
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7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Label Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Label Control to a
Form.

Good to know:

• A Label Control is highly configurable; you can add one or many to a Form, then define how the
label looks and behaves on the Form (ex: Text, tooltip, size, color, border style, image, alignment,
anchoring, layering, and visibility).

• By default, Label Control text, colors, and border style come from the defined Form Theme.

• Text, image, and colors can be conditional (Expression-driven).

• To include an ampersand character (&) in a Label Control, enter two ampersands (&&). One
ampersand is used to designate a keyboard accelerator, so entering a double ampersand escapes
the accelerator and ensures that a single ampersand is displayed.

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add a Label Control to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop the Label Control from the Standard Control tree onto the Form.

3. Define the text to display on the label:
a. In the Label text box on the Form Editor toolbar, provide the text to display on the button.

b. (Optional) Change the font, font size, font style, and font alignment if needed.

4. Define how the Form Control looks and behaves on the Form (ex: Size, alignment, etc.).

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Link Label Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Link Label Control
to a Form. A Link Label Control is capable of executing a single Action when clicked (ex: Run an Action/
One-Step).

Good to know:

• A Link Label Control is highly configurable; you can add one or many to a Form, then define the
Action to run when the link label is clicked, and how the the label looks and behaves on the Form
(ex: Text, tooltip, size, color, border style, image, alignment, anchoring, layering, visibility, enabling/
disabling, and tab order).

• Text, image, and colors can be conditional (Expression-driven).

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add a Link Label Control to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop the Link Label Control from the Standard Control tree onto the Form.

3. Define the Action to execute when the link is clicked:
a. Right-click the Link Label Control, and then select Control Properties.

b. In the Choose Action window, click the Ellipses button  to open the Action Manager, then
select the Action to execute.

4. Define the text to display on the link label:
a. In the Label text box on the Form Editor toolbar, provide the text to display on the button.

b. (Optional) Change the font, font size, font style, and font alignment if needed.

5. Define how the Form Control looks and behaves on the Form (ex: Size, alignment, etc.).

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a List Box Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a List Box Control to
a Form.

Good to know:

• A List Box Control is highly configurable. You can add or many to a Form, then define the
associated Field, how to order the values in the list, and whether or not to use images and colors
next to each value to help identify them. You can also define how the list box looks and behaves on
the Form (ex: Text, tooltip, size, color, border style, image, alignment, anchoring, layering, visibility,
enabling/disabling, and tab order).

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add a List Box Control to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop the List Box Control from the Standard Control tree onto the Form.

3. Define what will be listed in the List Box:
a. Right-click the Link Label Control, and then select Control Properties.

b. Define List Box properties:
◦ Associated Field:

Select the Field whose values to display in the List Box.
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◦ Sort By:

Select the Field to use to order the values, as well as an ascending (ex: 0-10, A-Z) or
descending (10-0, Z-A) order. Rarely will the alphabetical order match the order in which
the values should appear in your item, unless you prefix the values with numbers or
letters (example: For status, you would likely want lifecycle order, not alphabetical order);
therefore, it is common to define a field that contains a sequence number purely for
controlling the order (ex: Status Order).

◦ (Optional) Show Image for Each Item:

Select this check box to display an image next to each item, and then define an
Expression to determine which image to display and when to display it.

◦ (Optional) Set Color for Each Item:

Select this check box to display an image next to each item, and then define an
Expression to determine which color to display and when to display it.

4. Define how the Form Control looks and behaves on the Form (ex: Size, alignment, etc.).

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Radio Button Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Radio Button
Control to a Form.

Good to know:

• A Radio Button Control is highly configurable. You can add one or many to a Form, then define the
associated Field (Field that stores the value) and the value to store, and how the radio button looks
and behaves on the Form (ex: Text, tooltip, size, color, border style, image, alignment, anchoring,
layering, visibility, enabling/disabling, and tab order).

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add a Radio Button Control to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop the Radio Button Control from the Standard Control tree onto the Form.

3. Define what the Radio Button will do:
a. Right-click the Link Label Control, and then select Control Properties.

b. In the Radio Button Properties window, define the following:

Associated
Field: Select the Field that will store the radio button's selected ("checked") value.

Value: Provide the value to store in the associated Field (above) when the radio
button is selected.

Example: Add radio button to Show all Tabs. When clicked, a Show all Tabs value is stored in a Tab
Visibility field. A Form Arrangement could then use an Expression to conditionally show/hide tabs
based on the value in the Tab Visibility field.

4. Define the text to display beside the Radio Button:
a. In the Label text box on the Dashboard Editor toolbar, provide the text to display.
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b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

5. Define how the Form Control looks and behaves on the Form (ex: Size, alignment, etc.).

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Shape Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Shape Control to a
Form.

Good to know:

• Shape Controls are highly configurable; you can add one or many to a Form, then define how the
shape looks and behaves on the Form (ex: Text, size, color, border style, image, alignment,
anchoring, layering, and visibility).

• By default, the Shape Control color, border style, and background style properties come from the
defined Form Theme.

• Text, images, and colors can be conditional (Expression-driven).For example, define an Expression
to conditionally change the background color of a Control to red to indicate a priority 1 record.

• Rounded shapes do not allow 3D borders.

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add a Shape Control to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop a Shape from the Standard Control tree onto the Form.

3. (Optional) Define the text to display on the shape:
a. In the Label text box on the Form Editor toolbar, provide the text to display.

b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

4. Define how the Form Control looks and behaves on the Form (ex: Size, alignment, etc.).

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Special Form Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add Special Form
Controls to a Form:
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Add an Embedded Form Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add an Embedded Form
Control to a Form. When you add an Embedded Form Control to a Form, you define:

• Which Form to embed inside the Embedded Control frame: You can embed a Form using a/an:
◦ Relationship: Display a Form from a related Business Object. You can display the related

default Regular Form, Mini-Summary Form, or Summary Form.

◦ Expression: To determine the Form to display (ex: If the "Details" radio button is selected,
show the entire Knowledge Article; if the Article radio button is selected, show a simplified
Knowledge Article with only the most pertinent information).

• Default display text: Message to display in the Embedded Control frame when no Embedded
Forms are available.

• Allow Scroll Bars: Whether or not to add scroll bars to the Embedded Form when it extends past
the Embedded Form Control's borders, or just truncate the Form.

• Form is Read-Only: Whether or not to make the Embedded Form uneditable (read-only), or allow
Users to input values.

To add an Embedded Form Control to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop the Embedded Form Control from the Special Control tree to the Form.

3. Right-click the Control, and then select Control Properties.

4. Define which Form to embed inside the Embedded Control frame using either a/an:
◦ Relationship: Select this radio button to display a Form from a related Business Object. Then,

select the Relationship and which Related Form to display (ex: default Regular Form, Mini-
Summary Form, or Summary Form).

◦ Expression: Select this radio button to use an Expression to determine which Form to display.
Then, define the Expression using either:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

5. Define additional options for the Embedded Form:
a. Display Text when No Current Form: Provide the message to display in the Embedded Control

when no Embedded Forms are available.

b. Allow Scroll Bars: Select this check box to display scroll bars when the Embedded Form
extends past the Control's frame. Clear the check box to truncate the Embedded Form if it
extends past the Control border.

c. Form is Read-Only: Select this check box to make the Form read-only (un-editable by the
User). Clear the check box to allow Users to input values into the Embedded Form.
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6. Click OK.6. 

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Matrix Selector Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Matrix Selector
Control to a Form. When you add a Matrix Selector Control to a Form, you define:

• Validation instructions:
◦ Validation Table: Business Object that supplies all the possible values to the matrix (ex: Priority

Matrix Element). Typically, this is a Lookup Object.

◦ Value Field: Lookup field (Field in the Lookup Object) that supplies the values (ex: Priority).

◦ Order By: Field to use to order the values in the matrix, as well as an ascending (ex: 0-10, A-
Z) or descending (10-0, Z-A) order.

◦ Field to Populate: Field in the Business Object to populate with the final value from the matrix.

• Column properties: Values and order to display in the column header.

• Row properties: Values and order to display in the row.

• Constraints: Expressions that limit when the Field on the Form is populated with the final value
from the matrix.

To add a Matrix Selector Control to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop the Matrix Selector Control from the Special Control tree onto the Form.

3. Right-click the Control, and then select Control Properties.

4. Define the Validation:
a. Validation Table/Field:

Select the Lookup table and Field that supply all the possible values (example: For Incident,
it might be the Status field in the Incident Status Lookup table, with Status values like New, In
Progress, Assigned, etc.).

b. Order By:

Select the Field to use to order the values, as well as an ascending (ex: 0-10, A-Z) or
descending (10-0, Z-A) order. Rarely will the alphabetical order match the order in which the
values should appear in your item, unless you prefix the values with numbers or letters
(example: For status, you would likely want lifecycle order, not alphabetical order); therefore, it
is common to define a field that contains a sequence number purely for controlling the order
(ex: Status Order).

c. Field to Populate: Select the Field to populate with the final value from the matrix.

5. Define column properties:
a. Column Header: Select the Field from the Lookup Object that supplies the value for the

column header in the matrix.

b. Save Column To: Select the Field in the primary Business Object to populate with the column
value selected from the matrix.
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6. Define row properties:
a. Row Header: Select the Field from the Lookup Object that supplies the value for the row

header in the matrix.

b. Save Row To: Select the Field in the primary Business Object to populate with the row value
selected from the matrix.

7. Define constraints that limit when the Field on the Form is populated with the final value from the
matrix:

a. Click Add to add a constraint or filter.

b. Select a Field in the Business Object you are currently working with.

c. Select an operator (ex: Equals).

d. Value: Select a value for the Field. Applicable values include:
◦ Fields

◦ Expressions

◦ Metric Values

◦ Prompts

◦ Stored Values

◦ System Functions

e. Click OK.

f. Add additional constraints as necessary.

8. Click OK.8. 

9. After the Control or Controls are on the Form, use the Form Editor to define how each Control looks
and behaves on the Form (ex: Size, image, alignment, anchoring, layering, visibility, and tab order).

10. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add a Related Item Selector Control to a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add a Related Item
Selector Control to a Form. When you add a Related Item Selector Control to a Form, you define:

• Selector type: Which Selector Control to display. The Customer and CMDB selector types are only
available if the Business Object has a Relationship to the Customer and Configuration Item Group
Leaders. If no Relationship exists, you must create one.

◦ Customer: Provides access to the Contact Manager  and Customer Record .

◦ CMDB: Provides access to the CI database  and CI Record .

◦ Configurable List of values: Provides access to a configurable list of values (ex: Incident
Categorization).

• Relationship: Which Relationship to exploit in the Selector Control. This determines which related
values to display in a Selector Control. For example, the Customer selector on an Incident Form
automatically uses the IncidentLinksCustomer Relationship because it displays Customer
information; the CMDB selector automatically uses IncidentLinksConfiguration Item Relationship
because it displays CI information.

• Optional:
◦ Store Display Text in Field: Field (in the related Object) that provides the values to display in

the Selector Control (typically, name of item). By default, Related Item Selectors display the
related Object's Public ID value (Public ID is defined in Business Object properties). However,
this option allows you to select a different field in the related Object, if needed (ex: Customer
Display Name would provide the names of the Customers in the Contact Manager; Config Item
Display Name would provide the names of the CI in the CMDB).

◦ Default Type Hint Field: Field (in the related Object) that points to the appropriate list of values
when multiple values are available. This is useful if the Selector Control points to a Group
Business Object and you want to specify a different list of values for each Group Member. For
example, Customer might have Contact and Vendor; you could design the Incident form to
have radio buttons for each member, and then depending on which radio button is selected,
the hint field could populate with the Contact ID or the Vendor ID, and the Selector Control
could open with the hinted-at type pre-selected).

◦ Filter: Define one or more filters to constrain (limit) the values displayed in the Selector Control
(ex: Display only Customers from a particular region/office, ordisplay only computers that are
available/active/assigned to someone).

Good to know:

• You can only use Relationships where the child object is configured for SQL Full-Text searching.
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• Searching from the Related Item Selector Control uses SQL Full-Text searching, and searches the
Child records only by columns that have been Full-Text indexed.

• The value that displays in the Related Item Picker Control when a record is selected is the Public ID
value configured in the child object’s properties. If no Public ID is configured in the Child record, the
value record is displayed.

To add a Related Item Selector to a Form:

1. Open a Form in the Form Editor.

2. Drag-and-drop the Related Item Selector Control from the Special Control tree to the Form.

3. Right-click the Control, and then select Control Properties.

4. Select a Selector type. The Customer and CMDB selector types are only available if the Business
Object has a Relationship to the Customer and Configuration Item Group Leaders. If no
Relationship exists, you must create one.

◦ Customer: Select this radio button to add the Customer Selector, which provides access to the
Contact Manager and Customer Record.

◦ CMDB Selector: Select this radio button to add the CMDB Selector, which provides access to
the CI database and Config Item Record.

◦ List of Values: Select this radio button to add a configurable Selector.

5. Select the Relationship to exploit:
a. Relationship: Select the Relationship whose values to display in the Selector. The Customer

selector automatically uses the IncidentLinksCustomer Relationship; the CMDB Selector
automatically uses IncidentLinksConfiguration Item Relationship.

6. (Optional) Define the display text:
a. Store Display Text in Field: Select the Field (in the related object) that provides the values to

display in the Selector Control (typically, name of item).

b. Default Type Hint Field: Select the Field (in the related object) in the related object that points
to the appropriate list of values. This is useful if the Selector Control points to a Group Object,
and you want to specify a different list of values for each Group Member.

7. (Optional) Define one or more filters to constrain (limit) the values displayed in the Control:
a. Click Add to add a constraint or filter.

b. Select a Field in the Business Object you are currently working with.

c. Select an operator (ex: Equals).

d. Value: Select a value for the Field. Applicable values include:
◦ Fields

◦ Expressions

◦ Metric Values

◦ Prompts

◦ Stored Values

◦ System Functions

e. Click OK.
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f. Add additional constraints as necessary.

8. After the Control or Controls are on the Form, use the Form Editor to define how each Control looks
and behaves on the Form (ex: Size, image, alignment, anchoring, layering, visibility, and tab order).

9. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define How a Control Looks and Behaves on a
Form

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to define how a Form
Control looks and behaves on a Form.
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Define and Format Control Text
A Form Control has two different kinds of text, both of which are automatically formatted by a Form
Theme:

• Label: Text to display beside the Control to identify the Control on the Form. By default, the label
text comes from the Field name. The label text format (font/size/style) comes from the Form Theme
(Label Theme item).

• Control: Text to display inside the Control, either provided by a User (ex: Text field) or listed (ex:
Drop-down). By default, the Control text format (font/size/style) comes from the Form Theme
(Control Theme item).

You can manually change any label, and apply different text formats, if needed. Use the Form Editor
(accessed from within a Blueprint in CSM Administrator) to define the label and text format for a Control.

Good to know:

• Label text can be conditional (Expression-driven). For example, define an Expression to change a
label when the status changes.

• Text formatting options include:
◦ Font: Theme or explicit font.

◦ Font size: Point size for font (explicit fonts only).

◦ Font style: Bold, underline, or italics (explicit fonts only).

◦ Alignment: Horizontal (left, center, right) and vertical (top, middle, bottom) alignment of text.

Note: Text color is defined as a foreground color.

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To define and format Control text:

1. Open a Form in the Form Editor.

2. Click a Control.
3. Define a label, either static or conditional text:

◦ Static: In the Label text box, provide the label to display next to the Control.

◦ Expression-driven text (conditional): Click the Expression button , and then define the
Expression (condition) to determine the label, using either:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

4. Define text formatting:
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a. Font: In the Font drop-down on the Form Editor toolbar, select a font, either:
◦ Theme font: Font comes from the Theme.

◦ Explicit font: Font is selected by you.

b. Font style (explicit fonts only): On the Form Editor toolbar, click the Bold, Underline, or Italics
buttons .

c. Font size (explicit fonts only): In the Font Size drop-down  on the Form Editor toolbar,
select a point size (ex: 10).

d. Horizontal alignment: On the Form Editor toolbar, click one of the Horizontal Alignment buttons

(Left, Center, or Right)  to align the text on a horizontal axis within the Control
box.

e. Vertical alignment: On the Form Editor toolbar, click one of the Vertical Alignment buttons
(Top, Middle, or Bottom)  to align the text on a vertical axis within the Control box.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define a Tooltip for a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to define a tooltip for a Form
Control. A tooltip uses an Expression to determine the tooltip text. For example:

• Enter the text and/or Tokens to display in the Expression text box.

• Display text from a Business Object field.
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• Create a Tooltip field to store the tooltip text, then use an Expression to display it.

Good to know:

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To define a tooltip for a Control:

1. Open a Form in the Form Editor.

2. Click a Control.

3. On the Form Editor toolbar, click the drop-down arrow on the Tooltip button , and then define
the Expression (condition) to determine the tooltip text, using either:

◦ Expression Manager: Opens the Expression Manager, where you can select an existing stored
Expression or create a new stored Expression to use. Stored Expressions can be reused in
numerous places in CSM.

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a custom
Expression to use only for this scenario.

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Size A Control
Change the size of a Form Control to a specific size or to match the size of other Controls.

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to define a Control's size.

1. Open a Form in the Form Editor.
2. Click a Control.

Tip: Hold down the SHIFT key while sizing a Control to maintain the proper aspect ratio.

CAUTION: If a label is tied to a Control (Tied to Control option is enabled), both the Control
and label are selected when either item is clicked (essentially, the Control and label are
grouped). Use caution when sizing "grouped" Controls.

3. Do one of the following:

Sizing Method Instructions

Manually size a Control. Click-and-drag one of the handles (white or black
box) to the size you want.

Auto-size a text Control to be exactly the right
size to hold all its contained text.

Click the Auto-size button  on the Form Editor
toolbar.

Note: Auto-size is automatically set on the
following Controls: Check box, Label, Link
Label, and Radio button.

Tip: Auto-size is useful for Expression-
driven labels because it automatically
resizes the label's bounding box to
accommodate dynamic text.

Explicitly size a Control to a specified pixel
height and width.

Right-click>Position (or press CTRL+SHIFT+P)
to open the Control Position and Size window, then
specify the pixel sizes and click OK.
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Sizing Method Instructions

Size several Controls to the same width, height,
or width and height.

Select at least two Controls (the last selected
Control is the controlling Control and is identified by
black boxes), and then click the Make Same Width

button , Make Same Height button , or

Make Same Size button  on the Form Editor
toolbar.

Resize an Image Control to be its original size.
Click the Control, and then click the Auto-size

button .

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

Related concepts
Form Editor Behaviors
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Select a Background, Foreground, and Border
Color for a Control

By default, defined Theme colors are applied to a Control when the Control is added to a Form. You can
manually apply different colors, if needed. We recommend always using Theme colors (named colors on
Theme tab in the Color Selector). If you apply non-Theme colors, Controls will not change to another
Theme color when you apply a different Theme.

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to manually select
background, foreground, and border colors for a Control. Colors can come from:

• CSM Theme (Recommended):

All colors defined for the selected CSM Theme.

• System:

Set of colors provided by your Operating System. System colors can greatly vary depending on the
Operating System and browser used to view the color.

• Web:

Set of named Web-safe colors.

• Custom RGB colors:

Customized Red, Green, Blue (RGB) colors.

Good to know:

• Form Theme colors are defined as part of a Theme's definition. Use the Theme Manager to create a
Theme.

• Each Theme property is named and intended for a specific element on a Dashboard, Form, or
Portal. When the element is added, the item's defined colors, styles, and fonts are applied by default
(ex: Form Control colors, border style, and fonts are automatically applied to a Control when the
Control is added to a Form). Manually apply a different color or style to most elements, if needed.
For example, it is possible to use Form Background Color 1 for text. The key is to use Theme colors,
and to apply colors and styles consistently. If a non-Theme color (ex: System, Web, or RGB) is
applied, the element does not change to another Theme color when applying a different Theme.

• Background, Foreground, and Border color options are available on the Form Editor toolbar and
context (right-click) menu.

• Colors can be solid or can contain gradients.

• Colors can be transparent.

• Colors can be conditional (Expression-driven): For example, define an Expression to conditionally
change the background color of a Control to red to indicate a high priority (ex: Priority 1).

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.
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To select a background, foreground, or border color for a Control:

1. Open a Form in the Form Editor.

2. Click one or more Controls.

3. On the Form Editor toolbar, click the drop-down arrow on the Background Color button , the

Foreground Color button , or the Border color button .

Note: Click the button itself to use the most recently used color (assuming you have set a
color).

4. Select a color pattern, either:
◦ Solid color: Uses one color (First Color) for the background. Click a color in the list.

◦ Gradient (left-to-right or top-to-bottom): Uses a gradient between two colors (First Color and
Second Color). Click two colors in the list, and then click Select.

5. Select a color, either:
◦ Use Expression: Select this check box to use an Expression to conditionally change the color,

and then define the condition, using either:

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Color category:
◦ Theme (Recommended):

All colors defined for the selected CSM Theme.

◦ System:

Set of colors provided by your Operating System. System colors can greatly vary
depending on the Operating System and browser used to view the color.

◦ Web:

Set of named Web-safe colors.

◦ Custom:

Customized Red, Green, Blue (RGB) colors.

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Select a Border Style for a Control
Use the Form Editor to select a border style for a Form Control. Border style options include:

Good to know:

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

• Border styles options are also available from the context (right-click menu).

To select a border style for a Control:

1. Open a Form in the Form Editor.

2. Click one or more Controls.

3. On the Form Editor toolbar, click the drop-down arrow on the Border Style button, and then select
a style from the following:

◦ No Border: No border is added.

◦ 3D Border: Adds a three dimensional border around the Control.

◦ Pixel Width: Adds a fixed pixel width border around the Control.

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Add an Image to a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add an image to a
Control. Images can be:

• Imported: Any image stored in the Image Manager.

• Stored Values: An image stored as a Stored Value (ex: Company logo).

• Conditional (Expression-driven): For example, define an Expression to conditionally display a VIP
icon to indicate a Very Important Customer (ex: a CEO).

• None: Control does not use an image.

• Aligned: To the Top/middle/bottom and left/right/center of the Control.

Good to know:

• Banner, Button, and Link Label Controls support images.

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To add an image to a Control:

1. Open a Form in the Form Editor.

2. Click a Control.

3. On the Form Editor toolbar, click the drop-down arrow on the Image button , and then select
one of the following options:

◦ Browse: Opens the Image Manager to select an image to show on the Control.

◦ From Stored Value: Opens the Stored Value Manager to select an existing/create a new
Stored Value to use.

◦ Custom Expression: Opens the Custom Expression Builder to create a custom Expression to
use only for this scenario.

◦ Expression Manager: Opens the Expression Manager to select an existing stored Expression
or create a new stored Expression to use. Stored Expressions can be reused in numerous
places in CSM.

◦ None: Does not use an image.

4. Align the image:
a. Click the drop-down arrow on the Image button, select Image Alignment, and then select an

alignment option within the Control (ex: Top-right).

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Align a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to align Controls on a Form.

Good to know:

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To align a Control to other Controls:

1. Open a Form in the Form Editor.

2. Select at least two Controls (the last selected Control is the controlling Control and is identified by
black boxes).

3. Do one of the following:
◦ To align several Controls against a horizontal axis (either Left, Middle, or Right), click one of

the Line Up Horizontally buttons  on the Form Editor toolbar.

◦ To align several Controls against a vertical axis (either Top, Middle, or Bottom), click one of the

Line Up Vertically buttons  on the Form Editor toolbar.

◦ To explicitly position a Control to a specified location, right-click>Position (or press
CTRL+SHIFT+P) to open the Control Position and Size window, then specify the Left and Top
location and click OK.

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Anchor a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to anchor Controls on a
Form. Anchoring allows you to make your Controls grow or shrink to use available space. When you
select anchoring options, you select which sides of the Form the Control should be anchored to (you can
use combinations). Options include:

• Left: Control keeps the same distance to the Left edge and moves further away from the Right edge
when the Form gets bigger.

• Top: Control keeps the same distance to the Top edge and moves further away from the Bottom
edge when the Form gets bigger.

• Right: Control keeps the same distance to the Right edge and moves further away from the Left
edge when the Form gets bigger.

• Bottom: Control keeps the same distance to the Bottom edge and moves further away from the Top
edge when the Form gets bigger.

• Left AND Right: Distance between both horizontal edges remains the same, and the Control
stretches to fill the horizontal space when the Form gets bigger.

• Top AND Bottom: Distance between both vertical edges remains the same, and the Control
stretches to fill the vertical space when the Form gets bigger.

• All (Left, Right, Top, and Bottom): Distance between all edges remains the same and the Control
proportionally stretches to fill both the horizontal and vertical space when the Form gets bigger.

Good to know:

• Top Left is the default.

• If the Control is not anchored to any edge, it floats between the two edges.

• Anchoring options are available on the Form Editor toolbar and context (right-click) menu.

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To anchor a Control:

1. Open a Form in the Form Editor

2. Click a Control.

3. On the Form Editor toolbar, click the drop-down arrow on the Anchoring button .

4. Select an anchoring option (you can use combinations; Top Left is the default):

5. Click the Select button to save your changes. If you do not click Select, your changes are
abandoned.

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Layer a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to layer Controls on a Form
(that is, position a Control in front of or behind other Controls).

Good to know:

• Not all Controls can be layered in front of or behind other Controls (ex: Most shapes Controls cannot
be on top of fields).

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To layer a Control:

1. Open a Form in the Form Editor.

2. Select one or more Controls.

3. To position a Control in front of other Controls, click the Control, and then click the Bring to Front

button  on the Form Editor toolbar.

4. To position a Control behind other Controls, click the Control, and then click the Send to Back

button  on the Form Editor toolbar.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Visibility for a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to define when to display or
hide a Control (Visibility) on a Form.By default, a Control is always visible, unless defined (through an
Expression) to be hidden.

Good to know:

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To define visibility for a Control:

1. Open a Form in the Form Editor.

2. Click a Control.

3. On the Form Editor toolbar, click the drop-down arrow on the Visibility button , and then
select one of the following options:

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a custom
Expression to use only for this scenario.

◦ Expression Manager: Opens the Expression Manager, where you can select an existing stored
Expression or create a new stored Expression to use. Stored Expressions can be reused in
numerous places in CSM.

◦ Clear Visibility Expression: Clears any visibility Expression so that the Control is always
visible.

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Enable/Disable a Control
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to define when a Form
Control is enabled/disabled. By default, a Control is always enabled, unless defined (through an
Expression) to be disabled.

Good to know:

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To enable/disable a Control:

1. Open a Form in the Form Editor.

2. Click a Control.

3. On the Form Editor toolbar, click the drop-down arrow on the Enable/Disable button , and
then select one of the following options:

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a custom
Expression to use only for this scenario.

◦ Expression Manager: Opens the Expression Manager, where you can select an existing stored
Expression or create a new stored Expression to use. Stored Expressions can be reused in
numerous places in CSM.

◦ Clear Disabled Expression: Clears any disabling Expression so that the Control is always
enabled.

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Set Tab Order on a Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to set the tab order on a
Form (order in which the cursor moves to the next Field or Button Control when the tab key is pressed).

Good to know:

• Tab order can only be set on new Button Controls; it is not available for Button Controls on existing
Forms that have been published in a Blueprint.

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To set the tab order on a Form:

1. Open a Form in the Form Editor.

2. From the Form menu bar, select Form>View/Set Tab Order.

Small numbers appear above each Field and Button Control, indicating the order in which the cursor
tabs through Fields.

3. Click each Field or Button Control in the order you want to tab.

4. When you are done, select Form>View/Set Tab Order again to save the tab ordering.

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Make a Form the Default Form
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to make a Form the default
Form for the Business Object. The default Form is displayed by default when the Business Object is
accessed.

Good to know:

• You can select a default Regular Form and a default Mini-Summary Form.

• Use this feature when applying a mApp that includes a new Grid; you can swap in the new Grid
without losing your old Grid.

• Because CSM displays the default Form as Default Form, we recommend that you do not name a
Form Default Form. If you already have a Form named Default Form (as is the case in pre-6.00
versions of CSM), we recommend that you rename it.

• See Form Editor Behaviors for tips on working with Controls and the Form Editor.

To make a Form the default Form:

1. Open a Form in the Form Editor.

2. From the Form menu bar, select Form>Make this the Default Form.

3. Click Yes to confirm.

The Form now appears at the top of the Form drop-down list as Default Form.

4. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Managing Form Arrangements
Form Arrangements are managed using the Form Arrangement Editor, accessed from within a Blueprint
in CSM Administrator. Use this tool to:

• Create a Form Arrangement.

• Edit a Form Arrangement.

• Delete a Form Arrangement.
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Form Arrangement Editor
The Form Arrangement Editor is a tool within a Blueprint in CSM Administrator that allows you to manage
(create, edit, delete, etc.) Form Arrangements.

The Form Arrangement Editor is dynamic; when you make changes, the changes are immediately
reflected in the preview. Publish the Blueprint to commit the changes.

1. Relationship tree: Lists the defined Relationships whose child Form/records you can add to the
Form Arrangement. Relationships are organized alphabetically. If a child Form/record is in an owned
by Relationship with the parent Form/record (ex: Incident Owns Journals), then it can by edited;
however, child Forms/records in linked Relationships (ex: Incident Links Problem) are read-only.

Tip: Create, edit, and delete a Relationship directly from the Form Arrangement Editor by
right-clicking in the Relationship tree.

2. Additional Forms tree: Lists Additional Forms defined for the Business Object that you can add to
the Form Arrangement.
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Tip: Access Business Object properties directly from the Form Arrangement Editor by right-
clicking in the Additional Forms tree.

3. Form Arrangement preview: Displays a dynamic preview of the Form Arrangement, including how
each tab looks (toolbar, split view, etc.).

4. Tabs: Displays the tabs currently displayed on the Form Arrangement. To add a new tab, drag-and-
drop a Relationship or Additional Form from the tree onto the Form Arrangement.

5. Tab navigation arrows: Navigates through any tabs that are hidden offscreen.

6. Tab Arrangement context menu: Displays Tab operations so that you can define tab properties:
◦ Tab position: Define where to display the tab labels (above or below the tabs).

◦ Remove tab: Removes the selected tab from the Form Arrangement.

◦ Properties: Opens the Tab Properties window to define general, contents, and filter properties
for the tab.
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Open the Form Arrangement Editor
1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a

New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Current View drop-down, select the Business Object View whose Form Arrangement you
want to access.

3. In the Business Object tree, click the Business Object whose Form Arrangement you want to
access. Tip: Filter the Business Objects by clicking the Major, Supporting, Lookup, and All radio
buttons.

4. In the Appearance area of the Object Manager, click the Edit Form Arrangement link. Tip: You can
also click View>View Arrangement on the Blueprint Editor menu bar.

The Form Arrangement Editor opens displaying the Business Object's default Form Arrangement
(there is only one Form Arrangement per Business Object).
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Create/Edit a Form Arrangement
Use the Form Arrangement Editor (accessed from within a Blueprint in CSM Administrator) to create or
edit a Business Object Form Arrangement. When you create a Form Arrangement, you:

• Add/delete tabs: Define which tabs appear in the Form Arrangement. Tabs can come from a
defined Relationship or from an additional Form defined for the same Business Object.

• Define tab positions: Define where to display the tab labels (above or below the tabs).

• Define tab properties:
◦ General: Name, image, and visibility.

◦ Tab contents: Content to display on the tab, and how (ex: Which Form/Grid, default text, an
optional toolbar, split screen options, and record behaviors).

◦ Filters: Create a filter to limit content from one-to-many Relationships (ex: Filter Journals
based on type). Filters can be pre-applied (ex: Define an Expression to pre-filter the content on
the tab) or User-applied (ex: Define and display a Filter button/drop-down on the tab's toolbar
so that Users can filter their own content).

• Define splitter properties:
◦ General: Sizing properties (initial size and auto-size) for the Form Arrangement.

◦ Splitter position: Where to display the Form Arrangement (on top of/below, or to the right/left)
of the Form.

Good to know:

• Only a major object can have a Form Arrangement, and only one Form Arrangement exists for each
Business Object in a Business Object View.

• A major object can be included in another major object's Form Arrangement; however, the data from
a major object is read-only.

• Often, Summary Forms are used on a Form Arrangement because they are smaller and typically
show the most important data.

• If the Relationship you need does not yet exist, create the Relationship directly from the Form
Arrangement Editor by right-clicking in the Relationship tree. You can also edit and delete an
existing Relationship by right-clicking in the Relationship tree.

• You can create stacked zone arrangements for the Portal view of Business Objects.

To create a Form Arrangement:

1. Open a Form Arrangement in the Form Arrangement Editor.

2. Add/delete a tab:
◦ To add a new tab, drag-and-drop a defined Relationship or Additional Form from the

Arrangement tree onto the Arrangement.

Tip: You can also right-click a defined Relationship or Additional Form, and select
Add Tab.

◦ To delete a tab, right-click the tab, and then select Remove tab.
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3. Define where to display the tab labels, either above or below the tab content:
a. Right-click a tab, and then select Tab Position>Top or Bottom.

Note: Browser Client and Portal Form Arrangements support "Top" only.

4. Define tab properties:
◦ General: Name, image, and visibility.

◦ Tab contents: What content to display on the tab, and how.

◦ Tab Filters: How to filter content.

5. Define splitter properties:
◦ General: Sizing properties (initial size and auto-size) for the Form Arrangement.

◦ Splitter position: Where to display the Form Arrangement (on top of/below, or to the right/left)
of the Form.

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

To edit a Form Arrangement:

1. Open a Form Arrangement in the Form Arrangement Editor.

2. Make changes.

3. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define General Tab Properties for a Form
Arrangement

Use the Tab page in the Tab Properties window to define the following general properties for a Form
Arrangement tab:

• Name: Name to display on the tab. By default, the name either comes from the defined name of the
child object in the Relationship (ex: Journals) or from the name of the additional Form being
displayed (ex: Resolution Details); however, you can provide a name or define an Expression to
conditionally change the name.

• Image: Image, if any, to display on the tab. By default, the image comes either from the defined

image for the child object in the Relationship (ex: Journals icon ) or, in the case of additional
Forms, from the Business Object itself (ex: Resolution Details); however, you can select any image
or define an Expression to conditionally change the image. Hide the image by clearing the Tab
Image check box.

• Visibility: When to display or hide the Tab (ex: Always, only after resolution details are logged, etc.).
By default, a tab is always visible unless you define an Expression to hide the tab.

Note: The Tab Properties window is available in the Form Arrangement Editor (within a
Blueprint in CSM Administrator).

To define general tab properties for a Form Arrangement:

1. Open a Form Arrangement in the Form Arrangement Editor.

2. On a tab, right-click>Properties.

3. Click the Tab page.

4. Define a tab name, using either:
◦ Text: Select this radio button to accept the default name or provide a new name.

◦ Expression: Select this radio button to use an Expression to conditionally provide the name.
Then, define the Expression using one of the following options:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

5. Define the image:
a. Tab Image: Select this check box to display an image on the tab. Clear the check box to hide

an image.

b. Select an image, using either:
◦ Image: Select this radio button to accept the default image or select a new image.
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Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

◦ Expression: Select this radio button to use an Expression to conditionally provide the
image. Then, define the Expression using one of the following options:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager,
and then select an existing stored Expression or create a new stored Expression.
Stored Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the
Custom Expression Builder, and then create a custom Expression specifically for
this scenario.

6. Define the visibility:
a. Tab Visibility: Select this check box to conditionally display/hide the tab. Clear the check box to

always display the tab.

b. Expression: Select this radio button to use an Expression to conditionally display/hide the tab.
Then, define the Expression using one of the following options:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

c. Select the Tab When It Becomes Visible: Select this check box to have the tab selected when
it becomes visible (based on the defined Expression) so that its contents appear in the Form
Arrangement.

7. Click OK.7. 

8. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Tab Contents Properties for a Form
Arrangement

Use the Tab Content page in the Tab Properties window to define what content to display on the Form
Arrangement tab. Options include:

• Form/Grid: Which Form and Grid to display if multiple Forms/Grids are defined for a Business
Object. Grids are not applicable when displaying additional Forms on a tab.

• Default display text: Message to display when no records are available.

• Toolbar: Whether or not to display a configurable toolbar with options to create, delete, link, unlink,
go to, view, and navigate between records; filter content (if filters are defined), print/export a Grid (if
viewing a Grid), and change the splitter display (depending on supported views). Options vary by
Relationship.

• Supported Views: Display tab contents as a Form, as a Grid, or both. These are the views that are
available from the View menu on the toolbar. Horizontal and vertical split options are available. Grid
grouping options are also available.

• Default Views: Supported view to display by default on the tab.

• New record behaviors: Where to add new records in a Grid (ex: Bottom, Top, or Current Row), and
whether or not to allow Users to create new records for members in a Group Business Object (if the
tab represents a Group Business Object).

Note: The Tab Properties window is available in the Form Arrangement Editor (within a
Blueprint in CSM Administrator).

Good to know:

• For more information about Grids, refer to the Grids documentation.

• For more information about the Form Arrangement/Relationship toolbar, refer to CSM Desktop
Client toolbar.

To define tab contents properties for a Form Arrangement:

1. Open a Form Arrangement in the Form Arrangement Editor.

2. On a tab, right-click>Properties.

3. Click the Tab Contents page.

4. Define which Form/Grid to display on the tab:
a. Relationship: By default, this shows the Relationship being represented on the tab. If the tab

shows an additional Form None is displayed.

b. Default Form: Select the Form to display on the tab. Some Business Objects have only one
defined Form.
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c. Grid: Select the Grid to display on the tab. Some Business Objects have only one defined
Grid. Grids are not applicable when displaying additional Forms on a tab.

d. Text to Display When No Record is Loaded: provide the text to display in a tab when no
records are available to display.

5. Define toolbar options for the tab:
a. Show toolbar: Select this check box to show a toolbar on the tab.

b. Show Buttons: Select the buttons to display on the toolbar. Options vary by Business Object
but can include:

◦ New: Select this check box to display a New button on the toolbar, allowing a User to
create a new record directly from the tab.

◦ Delete: Select this check box to display a Delete button on the toolbar, allowing a User to
delete a record directly from the tab.

◦ Link: Select this check box to display a Link button on the toolbar, allowing a User to link
to an existing record.

◦ Unlink: Select this check box to display a Link button on the toolbar, allowing a User to
unlink from an existing record.

◦ Quick View: Select this check box to display a Quick View button on the toolbar, allowing
a User to open a related record in a second window to take a quick look at the details.

◦ Change State: Select this check box to display a Change State button on the toolbar,
allowing a User to directly change the Lifecycle value of the related child record (ex:
Change a Task to In Progress/Closed/Acknowledged, change an Approval to Approve/
Denied/Abstained, etc.).

6. Define a supported view (ex: Display tab contents as a Form, Grid, or both):
◦ Grid: Select this radio button to display tab contents as a Grid.

◦ Grid and Form (Horizontal Split): Select this radio button to display tab contents in a split view,
with the Grid on top and the Form on the bottom.

◦ Form: Select this radio button to display tab contents as a Form.

◦ Grid and Form (Vertical Split): Select this radio button to display tab contents in a split view,
with the Grid on the left and the Form on the right.

7. Define Grid grouping options:
◦ Yes: Select this radio button to display Grid grouping functionality on the tab.

◦ No: Select this radio button to hide Grid grouping functionality on the tab.

◦ Based on Grid Setting (Yes or No): Select this check box to display/hide Grid grouping
functionality based on the global Grid display settings.

◦ Allow User to Show/Hide Grouping Options: Select this check box to allow Users to display or
hide grip grouping options.

8. Define Default View: This is the supported view that is automatically displayed when the tab is first
selected.

◦ Grid: Select this check box to display tab contents as a Grid by default.

◦ Grid and Form (Horizontal Split): Check this box to display tab contents in a split view by
default, with the Grid on top and the Form on the bottom.
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◦ Form: Check this box to display tab contents as a Form by default.

◦ Grid and Form (Vertical Split): Check this box to display tab contents in a split view by default,
with the Grid on the left and the Form on the right.

9. Define new record behaviors:
a. Where to Add New Records in Grid: Select where to add new records in a Grid (ex: Bottom,

Top, or Current Row).

b. Group Members on New Button: Select which members of a Business Object Group can be
created from the New button on the tab's toolbar (this option is only available if the tab
represents a Group Object):

◦ All Group Members: Select this option to display all group members in a drop-down next
to the New button.

◦ Default Only: Select this option to display only the default group member on the New
button.

◦ Specific List: Select this option to display only specific group members in a drop-down

next to the New button. Click the Ellipses button  to open the Group Members
window, and then select which members to display in the drop-down.

c. New Button Adds Default Group Member: Select this check box to add the default group
member as a new record to the tab contents when the New button is clicked. This option is
only available if you select All Group Members or Specific List as options for the New button.

10. Click OK.10. 

11. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Tab Filter Properties for a Form
Arrangement

Use the Filters page in the Tab Properties window to define how content from a one-to-many Relationship
is filtered on the Form Arrangement tab (ex: Filter Journals based on type). Filters can be:

• Pre-applied: Define an Expression to pre-filter the content on the tab.

• User-applied: Define and display a Filter button/drop-down on the tab's toolbar so that Users can
filter their own content. You can also define a default behavior for the Filter button, and include a
Search option so that Users can search for specific data.

• Applied when linking records: Define and display a Filter button/drop-down in the Record Selector
window when adding records to a tab.

Note: The Tab Properties window is available in the Form Arrangement Editor (within a
Blueprint in CSM Administrator). The Filters page is only available for tabs that display child
objects in one-to-many Relationships (ex: Journals, Configuration Items, etc.). Defining
filters when linking records is only available for one-to-many Links Relationships (ex:
Change Requests).

To define a pre-applied filter for a Form Arrangement:

1. Open a Form Arrangement in the Form Arrangement Editor.

2. On a tab, right-click>Properties.

3. Click the Filters page.

4. Define a pre-applied filter:
a. Limit the rows that appear: Select this check box to use an Expression to pre-filter the content

on the tab. Then, define the Expression using one of the following options:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

5. Click OK.5. 

To define a custom User-applied filter for a Form Arrangement:

1. Open the Form Arrangement Editor.

2. On a tab, right-click>Properties.

3. Click the Filters page.

4. Define and display a custom Filter button/drop-down on the tab's toolbar so that Users can filter their
own content:
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a. In the Custom Filters area, create/edit/delete/order custom filters (each custom filter is
displayed in the Filter drop-down):

◦ Add: Click this button to open the Filter window, and then create a new custom filter
(name the filter and define the Expression).

◦ Edit: Click this button to open the Filter window, and then edit an existing custom filter.

◦ Delete: Click this button to delete an existing custom filter.

◦ Up/Down Arrows: Click to change the order in which the custom filters are displayed in
the Filter drop-down.

b. Default Button Behavior: Select a default behavior for when a User clicks the Filter button
(rather than the Filter drop-down arrow).

◦ Show Drop-down List: Select this option to display a drop-down of available filters.

◦ Search Dialog: Select this option to open the Search window, where Users can search
for specific data. This option is only available if the Display Search Option (below) is
checked.

◦ Custom Filter: Select a custom filter to apply.

c. Display Search Option: Select this check box to include a Search option in the Filter drop-
down. The Search option opens a window, where Users can search for specific data.

5. Click OK.5. 

To define filters for a record selector (when adding records to a tab):

1. Open a Form Arrangement in the Form Arrangement Editor.

2. On a tab, right-click>Properties.

The Tab Properties window opens.

3. Click the Filters page.

4. In the Filter List when Linking Records area, define a list of filters that Users can select when adding
records to a tab.

a. Click Add to add a constraint or filter.

b. Define the constraint:
◦ Field: Select a Field in the Business Object you are currently working with.

◦ Operator: Select an operator (ex: Equals).

◦ Value: Select a value for the Field. Applicable values include:
◦ Fields

◦ Expressions

◦ Metric Values

◦ Prompts

◦ Stored Values

◦ System Functions
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c. Click OK.c. 

d. Add additional constraints as necessary.

5. Define additional properties for the filter:
◦ Filter Display Name: Type a name to display next to the filter button in the record selector

window.

◦ Allow User to Choose Records that Don't Meet the Limiting Filter: Select this check box to
allow Users to select records outside of the defined list of filters.

6. Click OK.6. 

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Tab Relationship Options for a Form
Arrangement

Use the Relationship Options page in the Tab Properties window to define options for showing a menu of
join reasons that Users can select when adding child records to a tab in a Form Arrangement.

Note: The Tab Properties window is available in the Form Arrangement Editor (within a Blueprint
in CSM Administrator). The Relationship Properties page is only available for tabs that display
child objects in many-to-many Relationships that are linked with a join table and use a list of
values for the join reason.

To define tab Relationship options for a Form Arrangement:

1. Open a Form Arrangement in the Form Arrangement Editor.

2. On a tab, right-click>Properties.

3. Click the Relationship Options page.

4. Define Relationship options:
◦ Show Join Reason Sub-menu for Linking: Select this check box to display an arrow next to the

link button  in the tab. Users can click the arrow to open a sub-menu and select a join
reason for a child record that is added to the tab.

◦ Custom Field for Menu Text: Select this check box to display values from a selected Field as
options in the join reason sub-menu. Otherwise, the list of values defined in the Relationship's
link properties will be used.

◦ Limit Items for Menu: Select this check box to limit the items that are displayed in the join
reason sub-menu. Then, define an Expression that limits the items, either:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

5. Click OK.5. 

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define General Splitter Properties for the Form
Arrangement

Use the Splitter Properties window (accessed from within the Form Arrangement Editor) to define how to
size the Form Arrangement, with respect to its parent Form.

Note: The splitter is the boundary between the Form and the Form Arrangement. CSM considers
the first zone to be top or left of the splitter; the second zone is considered bottom or right of the
splitter. Typically, the parent Form is displayed in the first zone (and typically on Top), and the
Form Arrangement is displayed in the second zone (and typically on the Bottom); however, you
can change the positions.

Sizing properties include:

• Initial sizing styles: Define the Initial size of the first and second zones when displayed within the
CSM main window (Desktop Client or Browser). Options include:

◦ Percentage: Sizes the first zone to a specified percentage of the available space (ex: 75%),
then sizes the second zone to the remainder of the available space (ex: If first zone is 75%,
the second zone would get 25%).

◦ First: Determines the amount of space required by the first zone, and then attempts to give the
second zone as much space as is required for the content to be displayed without scroll bars
(within some limits described below).

◦ Second: Determines the amount of space required by the second zone, and then attempts to
give the first zone as much space as is required for the content to be displayed without scroll
bars (within some limits described below). If the content is dynamic, the first item is used for
sizing (ex: A tab, which is typical in the second zone, is used to determine the size). If the tab
displays a Grid, the size is not necessarily fixed.

◦ Specific size, in pixels: Sizes the first zone to a specific number of pixels, and then gives the
rest of the available space to the second zone.

• Auto resize splitter: Auto-resizes the zones when the application is resized. If the initial size is set
to a percentage, the zones resize relative to that percentage. If the initial size is set to First or
Second, the zones resize to handle the content within the zones.

• Limit splitter size: Defines a hard limit (percentage of pixels) to how much space the first zone can
take up, regardless of any other sizing factors (ex: If the max percentage is set to 85%, a 900 pixel
high Form displayed within a 1000 pixel high window will be limited to 850, and the second zone will
have the remainder. Even if no max is set, CSM does not allow the main zone to take up so much
space that the second zone is pushed off the window.

Note: The Form Arrangement Editor is accessed from within a Blueprint in CSM
Administrator).

To define general splitter properties for the Form Arrangement:

1. Open a Form Arrangement in the Form Arrangement Editor.
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2. Hover over the Form Arrangement splitter until a two arrow splitter appears , then right-
click>Splitter Properties.

3. Define splitter properties:
a. Initial sizing style: In the drop-down, select an initial sizing style for the first and second zones

when displayed within the CSM main window (Desktop Client or Browser). Options include:
◦ Percentage: Select this option to size the first zone to a specified percentage, giving the

rest of the available space to the second zone. Then, specify the percentage of
available space to give to the first zone.

◦ First: Select this option to allow CSM to determine the amount of space required by the
first zone, and then attempt to give the second zone as much space as it needs be
displayed without scroll bars (within some limits described below).

◦ Second: Select this option to allow CSM to determine the amount of space required by
the second zone, and then attempt to give the first zone as much space as it needs to be
displayed without scroll bars (within some limits described below).

◦ Specific size, in pixels: Select this option to provide a specific number of pixels to size
the first zone, giving the rest of the available space to the second zone. Then, specify the
number of pixels to give to the first zone.

b. Allow auto-resize: Select this check box to auto-resize the zones when the application window
is resized.

c. Limit splitter size when automatically positioning: Select this check box to define a hard limit to
how much space the first zone can take up, regardless of any other sizing factors. Then,
define the maximum size limit, either:

◦ Max percentage: Select this option to limit the first zone to a percentage of the available
space. Then, specify the percentage.

◦ Max pixels: Select this option to limit the first zone to a specified pixel threshold. Then,
specify the number of pixels.

Note: This feature is not supported in the Browser Client or Portal.

4. Click OK.4. 

5. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Splitter Position Properties for the Form
Arrangement

Use the Splitter Position property (accessed from within the Form Arrangement Editor) to define where to
display the Form Arrangement, relative to its parent Form. Options include:

• Top-Bottom: Display Form Arrangement below the parent Form.

• Left-Right: Display Form Arrangement to the right of the parent Form.

• Bottom-Top: Display Form Arrangement above the parent Form.

• Right-Left: Display Form Arrangement to the left of the parent Form

Note: The Form Arrangement Editor is accessed from within a Blueprint in CSM
Administrator).

To define splitter position properties for the Form Arrangement:

1. Open the Form Arrangement Editor.

2. Hover over the Form Arrangement splitter until a two arrow splitter appears , then right-
click>Splitter Position, and select a position from the drop-down. Options include:

◦ Top-Bottom

◦ Left-Right

◦ Bottom-Top

◦ Right-Left

3. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Stacked Zone Options for a Portal Form
Arrangement

Use Stacked Zone Options to define properties for a simple Form Arrangement with stacked zones:

• Mode: Define different Form Arrangements based on which Form is displayed.

• Name: Name to use within CSM for the stacked zone.

• Location of Data: Where the data to display in the stacked zone is retrieved (Business Object or
Relationship).

• Display Mode: How to display the data in the stacked zone (view-only Form, editable Form, or
results list).

• Visibility: When to display or hide the stacked zone. By default, a zone is always visible unless you
define an Expression to hide it.

• Title: Name to display on the stacked zone. By default, the name either comes from the primary
Business Object or from the Relationship; however, you can provide a custom name.

To define Stacked Zone Options for a Form Arrangement:

1. Open the Portal View for a Business Object.

2. Open a Form Arrangement in the Form Arrangement Editor.

3. Click the Stacked Zone button . The Business Object is listed as a stacked zone by default and
cannot be edited or deleted.

4. Select a Mode. This allows you to define different Form Arrangements depending on the Form
being displayed:

◦ Create New: Select this option to define a Form Arrangement for the Business Object's default
Form.

◦ Display: Select this option to define a Form Arrangement for a view-only Form.

Note: Select the Same as Edit Mode check box for the Create New and/or Display
modes to use the same Form Arrangement as defined for the Edit mode.

◦ Edit: Select this option to define a Form Arrangement for an editable Form.

5. Click Add to add a stacked zone to the Form Arrangement.

6. Provide a name for the stacked zone.

7. Define where the data displayed in the stacked zone comes from:
◦ Business Object: Select this radio button to have data from the Business Object displayed (ex:

Resolution Details for an Incident).

◦ Relationship: Select this radio button to have data from a Relationship displayed. In the drop-
down, select a Relationship.

8. Define the display mode:
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◦ View-only Form: Select this radio button to display one of the available Business Object Forms
(either from the primary Business Object, or a related Business Object, if applicable) as a
view-only Form in the stacked zone. Then, in the drop-down, select the Form to display.

◦ Editable Form: Select this radio button to display one of the available Business Object Forms
(either from the primary Business Object, or a related Business Object, if applicable) as an
editable Form in the stacked zone. Then, in the drop-down, select the Form to display.

◦ Result List (Relationships only): Select this radio button to display data from a Relationship in
a Results List. Select the Field to use to order the values in the list, as well as an ascending or
descending order.

9. Define the visibility:
a. Always Visible: Select this radio button to always display the zone.

b. Expression: Select this radio button to use an Expression to conditionally display/hide the
zone. Then, define the Expression using one of the following options:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

10. (Optional) Define whether to show a title for the zone:
a. Select the Show Title check box.

b. Provide a title for the zone (the name of the Business Object or Relationship is there by
default).

c. Click the Image button to open the Image Manager, and then select an existing image orc. 
import a new image to represent the item in the UI.

11. Click OK.11. 

12. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Calendars
A Calendar allows you view time-sensitive Business Object data in a natural format that can be shared
with Teams or an organization.
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About Calendars
Use a CSM Calendar to view:

• All scheduled Changes/Releases for a particular month.

• Your assigned Tasks due on a specific date.

• IT Project schedules.

• Service schedules.

• Note: Calendars display a maximum of 10,000 records.• 

Each User has a designated default Calendar, which opens when the User clicks the Calendar button

 on the CSM Desktop Client toolbar (in the Browser Client, click Calendars from the Browser Client
menu bar). The default Calendar is initially selected in CSM Administrator, Globally or by Role. Users with
appropriate security rights can select their own default Calendar in the CSM Desktop Client. Access
available Calendars using the Calendar Manager.
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Tour a Calendar
Use the Calendar interface to quickly browse and view scheduled items for a particular day, week, or
month. Depending on security rights, you can even edit existing Calendar Items, change times and
durations, and add new Calendar Items.

1. Main Pane: Displays Calendar Items (ex: My Tasks, Team Tasks, etc.).
◦ Hover over a Calendar Item to view more details.

◦ Double-click a Calendar Item to view and update the record.

◦ Right-click in the Main Pane to open a context menu so you can perform various tasks.

2. Calendar View Pane: Displays the view by Day, Work Week, Week, Month, or Timeline. Right-click
inside the calendar to set Time Scales and Time Scale Captions.

3. Dates Pane: Controls which dates are currently displayed on the Calendar.

4. Legend: Controls which Calendar Items are displayed in the Main Pane. Each legend is unique for
the Calendar and is part of creating a Calendar.
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Using Calendars
When working with Calendars, Users can:
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View a Calendar
A Calendar can be viewed several ways:

• Default Calendar:

◦ On the Desktop Client toolbar, click the Calendar button .

◦ From the Desktop Client menu bar click Tools>Calendar>Main Calendar.
◦ From the Browser Client menu bar, click Calendars.

• Available Calendars (based on security rights):

Use the Calendar Manager.

• MRU Calendars:
◦ From the Desktop Client menu bar, click Tools>Calendars, and then select a Calendar from

the MRU list (listed below the line in the menu).

◦ From the Browser Client menu bar, click Calendars, and then select a Calendar from the
MRU list (listed below the line in the menu).
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Change the Calendar View
View Calendar information by:

• Day View: Displays items for a single day.

• Work Week View: Displays items for the defined work week.

Tip: In the Day View and Work Week View, you can also increase or decrease the time increments
displayed in the Calendar (in the column to the left of the main pane where the times are displayed,
right-click>select time increment).

• Week View: Displays items for a single week.

• Month View: Displays items for a single month.

• Timeline View: Displays items for a specified period of time (timeline). You define the timescales
(timescale options only appear when in Timeline View).

• Gantt View: Displays items for an entire project schedule.

Good to know:

• Regardless of the view, the current day (Today) is highlighted.

• Each Calendar has a default view, which is determined when the Calendar is created. If you have
security rights, you can change the default view of an existing Calendar.

• Changing the Calendar view only temporarily changes the view. The next time you view the
Calendar, it displays in the default view.

To change the calendar view:

1. View a Calendar.

2. On the Calendar, right-click>Change View To>select a format to change from the current view.
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View/Edit a Calendar Item
View and edit Calendar Items directly from a Calendar.

Good to know:

• Dates that have Calendar Items to display show up bold in the Dates pane.

To view/edit a Calendar item:

1. View a Calendar.

2. Do one of the following:
◦ Click the arrows at the top of the Dates pane to browse Calendar Items by month/year.

◦ Click a date in the Dates pane to display it (and its Calendar Items) in the main pane.

◦ Click the Today button in the Dates pane to display the current date (and its Calendar Items).

◦ Right-click>Go to Today to display the current date and its items.

◦ Right-click>Go to Date to select a date to display.
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Add a Single Calendar Item
Add any Calendar Item listed in the Legends area to a Calendar directly from the Calendar window.

Good to know:

• Calendar Items that can be added to the Main Pane are displayed in the Legends area and are
determined when the Calendar is created.

• If you have security rights, you can add, edit, or delete the Calendar Items that appear in the
Legends area.

• If you edit the time components that control where the Calendar Item is displayed, the item
automatically moves on the Calendar, and the Calendar display changes to keep the item visible.

To add a Calendar Item:

1. View a Calendar.

2. On the Calendar, right-click>New [Calendar Item].

The New window opens where you can enter the Calendar Item details.

Note: The name of the Calendar Items available for selection will vary depending on what
was defined during Calendar creation.

3. Click OK.3. 

4. Depending on the Calendar Item and security settings, you might be able to perform the following
operations:

◦ To change the date, drag the Calendar Item to a new date/time.

◦ To change the duration, resize the Calendar Item to accommodate the new time.

◦ To change editable details, double-click the Calendar Item (or right-click>Open). The Quick-
View window opens where you can change editable details.

Click OK.

CSM 9.3.0 Features 396

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=view_a_calendar


Navigate through Calendar Items
Navigate through Calendar Items on a Calendar quickly and easily.

Good to know:

• Regardless of the Calendar view (Day, Work Week, Week, Month, or Timeline), the current day is
always highlighted.

• Dates that have Calendar Items to display show up bold in the Dates pane.

To navigate through Calendar Items:

1. View a Calendar.

2. Do one of the following:
◦ Click the arrows at the top of the Dates pane to browse Calendar Items by month/year.

◦ Click a date in the Dates pane to display it (and its Calendar Items) in the main pane.

◦ Click the Today button in the Dates pane to display the current date (and its Calendar Items).

◦ In the main pane, Right-click>Go to Today to display the current date and its items.

◦ In the main pane, Right-click>Go to Date to select a date to display.

◦ Mouse over a Calendar Item to display a description.

◦ Double-click a Calendar Item to open it for viewing/editing.

◦ Use the check boxes in the Legend to show or hide Calendar Items.
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Show/Hide a Calendar Item
Use the check boxes in the Legends area of the Calendar window to hide/show Calendar Items on a
Calendar.

Good to know:

• Each Calendar has a default list of items that can appear, which is determined when the Calendar is
created. If you have security rights, you can add, edit, or delete the Calendar Items that appear in
the Legends area.

To show/hide Calendar Items:

1. View a Calendar.

2. Do the following:
◦ To show a Calendar Item, select the check box next to the item in the Calendar Legends area.

◦ To hide a Calendar Item, clear the check box next to the item in the Calendar Legends area.
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Adjusting Gantt View Time Scales
Gantt View enables you to see items for an entire project schedule. You can adjust the time scales and
captions for Gantt View.

To adjust Gantt View time scales:

1. On the Calendar, right-click>Change View to>Gantt View.

2. Right-click>Adjust Time Scales, and then select from these options:
◦ Year.

◦ Quarter (ex: Q3).

◦ Month.

◦ Week.

◦ Day.

◦ Hour.

◦ 15 Minutes.

3. Right-click>Adjust Time Scale Captions to adjust the frame of the Time Scales (ex: Tuesday,
August 12, 2015 - Tuesday August 12, 2015).
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Managing Calendars
CSM Calendars are managed using the Calendar Manager.

There are several ways to open the Calendar Manager.

Use the Calendar Manager to complete general CSM Item Manager operations for Calendars, including:

• View a Calendar.

• Create a Calendar

• Create a Calendar Item.

• Edit a Calendar.

• Delete a Calendar.

• Search for a Calendar.

• Organize Calendars.

• Copy a Calendar.

• Import/export a Calendar.

• Find Calendar dependencies.

• Add a Calendar to the Desktop Client Task Pane/toolbar.

• Pin a Calendar.
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Open the Calendar Manager
There are several ways to open the Calendar Manager:

• From the CSM Desktop Client menu bar, click Tools>Calendars>Calendar Manager.
• From the Browser Client menu bar, click Tools>Calendars>Calendar Manager.
• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Calendar Manager.

• From Calendar selectors  throughout CSM.
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Create a Calendar
Use the Calendar Properties window (accessed from within the Calendar Manager) to create or edit a
Calendar.

To create a Calendar:

1. Open the Calendar Manager.1. 

2. Select a scope and subfolder (if needed).2. 

3. Click the Create New button .

4. Define general properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

c. Title Text:

Provide a title to display in the banner above the Calendar. If blank, no title is displayed.

5. Define date and time options for the Calendar:
a. Default view: Select the default date format to display. Options are:

◦ Day.

◦ Work Week.

◦ Week.

◦ Month.

◦ Timeline.

b. Work Day Start/End: Select the work hours to display.

c. Include Weekends in week view (Optional): Select this check box to include Saturdays and
Sundays on the Calendar; otherwise, only Monday through Friday is displayed.

6. Select one or more Calendar Items to display on the Calendar (Legend area):

Notes: A Calendar must have at least one Calendar Item. The color displayed to the left of
each Calendar Item is the color the item will be displayed on the Calendar:

a. Click the Add button  to open the Calendar Item window, where you can create a Calendar
Item to display.

b. Fill in the Calendar Item details.
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c. Click OK.c. 

The new Calendar Item is added to the list of Calendar Items.

Note: Click the Edit button to edit a selected Calendar Item; Click the Delete button to remove
a selected Calendar Item from the list; Use the Up/Down arrows to change the order of the
Calendar Items in the Legend area.

7. (Optional) Define additional options:
a. Click the Options button.

b. Availability:

In the drop-down, select a scope.

Note: If you already selected a scope at the beginning, this is auto-filled with your selection.

c. Association:

If applicable, select a more filtered scope (example: A particular Team). <Automatic> applies
scope based on login. If not applicable, this option is grayed out.

d. Custom Image:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

e. Click OK.e. 

8. Click OK.8. 
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Create a Set of Calendar Items
Use the Calendar Item window to create a Calendar Item. Calender Items populate Calendars with a set
of records based on the Query and duration parameters.

To create a Calendar Item:

1. Open the Calendar Item window:
a. Open the Calendar Manager.

b. In the Manager, click a Calendar, and then click Edit  to open the Calendar Properties
window.

c. Click the Add button .

2. Define general information:
a. Business Object: Select the Business Object to show on the Calendar. You can select any

Major Object or any Business Object that allows Search Groups to be defined against it.

b. Item Name: Specify a name for the Calendar Item. This is the way the item will be displayed
on the legend. The default value is based on the selected Business Object, but can be
changed.

c. Query: Select the search to be executed to determine which items should be displayed on the
Calendar. For example, you can limit the search to only open records. For best results, do not
put any date criteria into the query because the Calendar will automatically search for items
based on the currently displayed date range. If you do not specify a query, then all records of
the selected Business Object type that fit into the currently displayed date range will be
displayed.

d. Item color: Select the color to display for the Calendar Item. The system does not enforce the
choice of different colors for different items, but for best results, select distinctive colors for
each item, but avoid very dark colors as the text may be hard to read.

3. Select Fields to determine how items are found and how they are displayed:
a. Start date: This is the date/time Field that controls where items are displayed on the Calendar.

This Field is used when searching only read items that fall within the currently displayed time
range.

b. End date: If set, this controls the length (duration) of the item.

Note: Users may experience performance issues when Calendar Items span across
several weeks or months, particularly in the CSM Browser Client. For best results, use
the Business Object's end date field (example: Scheduled End Date for Change
Requests) or use (None) and instead, use the Default date/time options.

c. Header text: The Field that shows up in the title for the Calendar Item.

d. Prefix with object name: If the header text is not clear (example: If it is a number like the ID
of the Change), then selecting this option will add the name of the object in front of the item in
the title. For a Change Request, that would change 12345 into Change Request 12345.

e. Display text: This is the Field used to fill in the body of the item; it is usually a large text Field
that describes the item.
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4. Define default date/time options to use if appropriate information cannot be found:
a. Duration: If there is no End date, or the End date is empty, this specifies the size of items on

the Calendar. For example, if a task has a start time, but no end, it might make sense to show
it as taking up two (2) hours on the calendar.

b. Start Time: If the Start date does not have a time component, or the time has not been set,
this specifies the default time to use to display the items on the Calendar, rather than having
all of the items show up as starting at midnight.

5. Define display/editing options:
a. Allow edit: Select this check box to allow Users to edit the item directly from the Calendar.

The User must also have appropriate edit rights for the Business Object.

b. Allow dragging: Select this check box to allow Users to move the item (change its time) on
the Calendar. The User must also have appropriate edit rights for the Business Object. Note
that, if you use a system-managed Field for the Start date, such as Created Date/Time, you
should disable this option because you rarely want to allow Users to change this value.

c. Allow resizing: Select this check box to allow Users to resize the item (change its duration)
on the Calendar. The User must also have edit rights for the Business Object and an End date
Field must be specified. Otherwise the item does not have a duration.

d. Allow caching: Select this check box to allow the Calendar to cache Business Object
information in order to make dragging and resizing more efficient.

Note: Caching improves performance but it can cause problems if objects depend on
each other for live values. For example, the Calendar might display multiple objects
that depend on one another to control their legal times.

e. Items shown by default: Select this check box to display the item by default on the Calendar.
If you clear this option, the item still appears on the Calendar Legend, but no data is retrieved
until the User explicitly selects the check box next to it.

6. Click OK.6. 
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Configuring Calendars
Calendar configuration procedures are completed in CSM Administrator.

To configure Calendars:

• Configure Calendar security rights.

• Set Default Calendars.
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Setting Default Calendars
The default Calendar is initially selected in CSM Administrator, Globally or by Role. Users with
appropriate privileges can choose their own default calendar.
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Select a Default Global Calendar
Use the System Settings window in CSM Administrator to select the default Global Calendar.

Good to know:

• If a default Role or User Calendar is selected, it will override the Global default.

• Users with appropriate security rights can select their own default Calendar in the CSM Desktop
Client.

• Customers have limited options and cannot override defaults in the Portal.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default Global Calendar:

1. Open the System Settings window (CSM Administrator>Settings>Edit System Settings).

2. Click Dashboards, etc.

The Dashboards, Calendars, and Visualizations window opens.

3. Click the My Tasks button  to the right of the default Calendar.

The Calendar Manager opens.

4. Select a Calendar to be the default.

Tips: Be sure to select a Calendar that everyone can access (global scope). Create a new
Calendar, if needed.

5. Click OK.5. 
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Select a Default Role Calendar
Use the Role Manager in CSM Administrator to select the default Role Calendar.

Good to know:

• If no default Role Calendar is selected, the Global default will be used.

• Users with appropriate security rights can select their own default Calendar in the CSM Desktop
Client.

• Customers have limited options and cannot override defaults in the Portal.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default Role Calendar:

1. Open the Role Manager.
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2. Click the Role for which you want to select a default Calendar.

The Role Profile opens in the Manager window.

3. Select the default Role Calendar, either:
◦ Use default: Select this radio button to use the default Global Calendar.
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◦ Calendar: Select this radio button to use a default Role Calendar. Then, click the Calendar

button  to open the Calendar Manager, where you can select an existing Calendar or
create a new Calendar to use as the default. Be sure to select a Calendar that everyone in that
Role can access.

4. Click Save .

CSM 9.3.0 Features 412

CSM 9.3.0 Features



Select a Default User Calendar
Use the CSM options window (Dashboards & Calendars page) in the CSM Desktop Client to select a
User default Calendar.

Good to know:

• A User must have security rights to override the Global/Role defaults and select her own User
default.

• If a User default is not selected, either the Global or Role default will be used.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default User Calendar:

1. From the CSM Desktop Client toolbar, click Tools>Options.

2. Click the Dashboards & Calendars page.

3. Select a default User Calendar, either:
a. Use default: Select this radio button to use the default Global or Role Calendar (depends on

which one the system administrator has selected).

b. Calendar: Select this radio button to use a default User Calendar instead of the default Global/

Role Calendar. Then, click the Calendar button  to open the Calendar Manager, where
you can select an existing Calendar or create a new Calendar to use as the default.

4. Click OK.4. 
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Color Selector
The Color Selector is a tool that allows Users to select from a set of colors and apply them to various
elements within CSM (example: Dashboards, Form Controls, Reports, etc.). The available sets of colors
(Theme, System, Web, and/or Custom) depend on the location in CSM from which the Color Selector is
accessed.
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About the Color Selector
Use the Color Selector to:

• Define a set of colors for a Theme.

• Apply colors to design elements within CSM (ex: Dashboards, Portal sites, Forms, etc.).

• Select color values for use in Stored Values and Expressions.

In general, the Color Selector can be used to select colors for:

• Themes: Defined set of colors that can be applied to elements on a Dashboard, Form, or Portal site.

• Backgrounds, foregrounds, borders, and/or text for various CSM elements, including:
◦ Background colors for Dashboards, HTML pages (both internal and external), Forms, and

Portal sites.

◦ General Widget appearance, as well as specific aspects of certain Widgets (ex: Threshold
colors for a Gauge Widget).

◦ General appearance of Form Controls.

◦ General appearance of Report controls (when creating or editing Reports in the Report
Designer).

• Stored Values and Expressions that use color values.

Colors can be solid or contain gradients, transparent, or conditional (Expression-driven) and are
categorized as follows (represented as tabs in the Color Selector):

• CSM Theme:

All colors defined for the selected CSM Theme. The different elements on a Dashboard, Form, or
Portal site (ex: Dashboard background color, Form Control text colors, Portal banner colors, etc.)
have defined colors based on a Theme. We recommend always using Theme colors when available
to give a cohesive look. However, you can apply non-Theme colors (System, Web, or Custom) if
needed. If you apply non-Theme colors to elements within CSM, they will not change to another
Theme color if you apply a different Theme.

• System:

Set of colors provided by your Operating System. System colors can greatly vary depending on the
Operating System and browser used to view the color.

• Web:

Set of named Web-safe colors.

• Custom:

Customized Red, Green, Blue (RGB) colors.
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Note: Available color categories vary depending on the location from which the Color
Selector is accessed (ex: Theme colors are only available for Dashboards, Forms, and
Portal sites).
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Counters
A Counter is a Token that automatically increases a defined initial value (number) by a defined increment.
Counters can be used while designing Forms, Dashboards, Automation Processes, Expressions, One-
Steps, etc.
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About Counters
Use a Counter to increment:

• Record IDs (example: Incident, Problem, Change, etc.)

• Purchase Orders

• Asset Tags

• Discussion counts

In CSM, Counters can be used by Expressions to increment values in:

• Fields (ex: Record ID values).

• One-Steps (ex: On a Purchase Order to generate a new tracking number).

CSM provides several OOTB Counters. Use these OOTB Counters as-is, edit them, or create new
Counters using the Counter Manager.

CSM 9.3.0 Features 418

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fcounters%2F..%2Fexpressions%2Fabout_expressions.html


Counters Good to Know
• A Counter is typically identified by the Counter icon .

• Pin items to a Pinboard (in the Manager) and MRU list (in the CSM Desktop Client menu bar) to
make them easily accessible in CSM.

Always consider the following:

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure Counter Security Rights.
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Using Counters
When working with Counters, Users can:
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View a Counter
A Counter can be viewed several ways:

• Available Counters (based on security rights): Use the Counter Manager.

• From an Expression or Query that uses the Counter Metric.

• From the Token Selector.
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Add a Counter to a Stored Expression
To add a Counter to a Stored Expression:

1. Open a Stored Expression:
◦ Using the Expression Manager.

◦ By clicking the Ellipses button, when available.

2. In the Editor drop-down menu, select Counter.
3. In the Counter area, click the Ellipses button to open the Counter Manager, and then select an

existing Counter or create a new Counter.

4. Click OK.4. 
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Add a Counter to a Custom Expression
To add a Counter to a Custom Expression:

1. Open the Custom Expression Builder:

a. Click the Custom Expression button , when available (ex: When setting a value in a One-
Step or Field).

The Custom Expression window opens.

2. In the Expression area, click the down arrow, then expand Counters, and then select a Counter to
add to the Expression.

3. Click OK.3. 
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Managing Counters
Counters are managed using the Counter Manager.

There are several ways to open the Counter Manager.

Use the Counter Manager to complete general CSM Item Manager operations for Counters, including:

• View a Counter.

• Create, Reset, or Change a Counter.

• Edit a Counter.

• Delete a Counter.

• Search for a Counter.

• Organize Counters.

• Copy a Counter.

• Import/export a Counter.

• Find Counter dependencies.

• Pin a Counter.
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Open the Counter Manager
The Counter Manager can be opened several ways:

• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Counters.

• From the Token Selector in Queries and Expressions.
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Create, Reset, or Change a Counter
Use the Counter window (accessed from within the Counter Manager) to create, reset, or change a
Counter. When creating a Counter, define the following:

• Name and description

• Initial value

• Increment

• Reset options (value, frequency, and timeframe) (optional): Schedule a reset (ex: Reset every
month).

• Change value (optional): Defines a manual, one-time Counter value change (ex: Change record IDs
to start at 100,000 when migrating from a test to a production system). This reset occurs as soon as
the Blueprint is published and is a one-time only reset.

To create, reset, or change a Counter:

1. Open the Counter Manager.1. 

2. Select a scope and subfolder (if needed).2. 

3. Click the Create New button .

The Counter window opens.

4. Define general properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

5. Define the initial value and increment:
a. Initial Value: Specify the number to use as the starting value (ex: 1).

b. Increment: Specify the number by which to increase the Counter each time it increments (ex:
1).

6. (Optional) Define Counter reset options (Reset Counter section):
a. Select the Reset Value check box.

b. Reset value: Specify the new value.

c. Frequency: Select a reset frequency from the following:

Note: The Counter is checked for reset only when it is requested. The reset occurs (1) second
into the new day/week/month/year/etc.
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◦ Daily: Resets each day.

◦ End of Month: Resets on the last day of each month.

◦ Hourly: Resets at the beginning of each hour.

◦ Weekly: Resets every week on a specified day of the week (Monday-Sunday).

◦ Monthly: Resets every month on a specified day (1-31). Select the day in the Day of
Month drop-down.

◦ Yearly: Resets every year on a specified date. Click the Calendar button  to select
the date.

7. (Optional) Define a manual, one-time Counter value change:

Note: This reset occurs as soon as the Blueprint is published, and is a one-time only reset.

a. Select the Change Counter Value check box.

b. Specify the value to which you want to manually reset the Counter (ex: 100,000).

8. Click OK.8. 
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Reset a Record ID Counter
Reset the Record ID number for each Business Object to ensure that new records begin with the
appropriate value.

The following procedure must be completed for the following Business Object Record IDs:

• Incident ID

• Problem ID

• Change ID

• Knowledge Article ID

To reset the Record ID for Business Objects:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

2. From the Blueprint Editor menu bar, click Managers>Counters.

The Counter Manager opens.

3. In the Manager tree, click the Blueprint folder.

A list of Blueprint-only items opens in the Manager main pane.

4. Right-click the <Business Object> ID (ex: IncidentID) and select Edit.

The Counter opens.

5. Select the Change Counter Value check box.
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6. In the Change Value To field, specify 100000.

Note: We recommend changing this value to 100000 for each Business Object ID, but Users
can select any value to fit the needs of their company.

7. Click OK.7. 

8. Publish the Blueprint to commit the changes (File>Publish Blueprint).
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Configuring Counters
Configuration procedures are completed in CSM Administrator.

To configure Counters:

1. Configure Counter security rights: Configure who can access Counter functionality.

2. Reset or change a default Counter: CSM ships with several default Counters, including Record
Identifier Counters on each default Form. Ensure that Record ID Counters are appropriate on
specific Forms.
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Dashboards
A Dashboard is a configurable, interactive, and insightful console capable of initiating commands and
Actions, and providing real-time, at-a-glance information through the use of filterable, configurable
Widgets (Action Catalogs, Websites, Buttons and Links, Charts, Command Palettes, Gauges, Matrixes,
Search Controls, Search Results, Twitter Feeds, RSS Feeds, and Shapes).
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About Dashboards
Use a Dashboard to monitor critical metrics, analyze and predict trends, drill-down into data, initiate
commands and actions, or display information that might be relevant to a group of Users/Customers.

Example Dashboards include:

• A Global IT Dashboard: Presents critical Business Object data and analytics (ex: Open Incidents
and Tasks, team workloads, closure rates, etc.).

• Business Object Dashboards: Intuitively organize critical Business Object data and analytics into
real-time, at-a-glance control panels (ex: Incident Dashboard, Knowledge Article Dashboard, CMDB
Dashboard, etc.).

• A Personal Dashboard: Presents personal data and analytics (ex: Incidents and Tasks owned by
you or your Team, status, etc.).

• Portal Dashboards: Designed specifically for the Customer Portal to provide Customer-specific at-
a-glance information and navigation functionality, such as links to helpful self-service Actions (ex:
Report an Incident, search Knowledge Articles and FAQs, etc.), a community discussion board, a list
of open records (ex: (Incidents and Problems), contact hours, etc). For more information, refer to
Portal Dashboards.

The following figure shows an example Dashboard with several different types of Widgets. A Theme
controls the fonts, colors, and styles of the Dashboard and its Widgets, and gives the Dashboard a
cohesive look. Configurable filtering, drill-down, and refresh capabilities allow you to view information
when and how you want.

Each User has a designated default:
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• Home Dashboard: Opens when you first log in or when the Home button  is clicked on the CSM
Desktop toolbar or Browser Client menu bar.

• Heads-Up Display (HUD): Pops up a transparent Dashboard that can be accessed from anywhere
in the application when you press F4.

• Dashboard Theme: Colors, styles, and fonts to give the Dashboard a cohesive look and feel.

The default Dashboards (Home and HUD) and Dashboard Theme are initially selected in CSM
Administrator, either Globally or by Role. If a User has security rights, she can select her own User default
Dashboards and Dashboard Theme in the CSM Desktop Client. Access available Dashboards using the
Dashboard Manager.

CSM provides several OOTB Dashboards, designed to help facilitate common service desk operations.
Use these OOTB Dashboards as-is, edit them, or create your own using the Dashboard Manager and the
Dashboard Editor.

Note: CSM also provides a variety of configurable Widgets to empower your Dashboards. For
more information about Widgets, refer to the Widgets documentation.

CSM also provides a stand-alone Dashboard Viewer that allows non-CSM Users to view Dashboards
without consuming a license.
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Tour a Dashboard
Dashboards are highly configurable so no two Dashboards necessarily look or behave alike.

The following figure shows an example Dashboard. The individual components are different kinds of
Widgets.

1. Text Widget (Expression-driven): Displays the current day and date.

Note: A text Widget is technically a Gauge Widget.

2. Link Widget: Opens another Dashboard (ex: Global IT Dashboard).

3. Gauge Widget (Text): Displays the current number of open records (ex: Incidents) by type. Double-
click the number to drill down into the data. Widgets can drill-down into a list of relevant records or
another Dashboard, or they can initiate a command (ex: Run a report).

4. Gauge Widget layered on a Shape Widget with Text (Expression-driven background colors, text,
images, and visibility): Displays alert colors, images, and messages when a threshold is passed (ex:
SLA warnings and breaches). Double-click the number to drill down into troubled records.

5. Image Widget: Displays an image to indicate that an SLA has been breached.

6. Chart Widget (Stacked Bar): Displays workloads by department.

7. Filter Widget: Filters all Widgets by time (ex: Today, Yesterday, Within last week, etc.).

8. Chart Widget (Doughnut): Displays Task workloads by department.

9. Matrix Widget: Displays daily record closure rates.
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The following types of Widgets are also available for use on Dashboards:

• Action Catalog Widget: Displays a self-building and dynamic list (catalog) of executable Actions.

• Browser Widget: Displays a website or an HTML Page (ex: Your company's website).

• Command Palette Widget: Displays a list of one or more executable Actions (run a command or
display a CSM Item).

• RSS Feed Widget: Displays frequently updated information, such as news or blog entries, from a
particular feed.

• Search Widget: Displays a Search Control that can be used to run Quick Searches or specific
searches.

• Search Results List Widget: Displays a list of records that meets search criteria.

• Twitter Feed Widget: Displays entries from a Twitter account or search.

Tip: In the Desktop Client, use the Dashboard context (right-click) menu to quickly access
common Dashboard operations.
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Dashboards Good to Know
• A Dashboard can be viewed several ways (example: Toolbar, Dashboard Manager, etc.) and from all

CSM clients.

• A Dashboard Theme controls the colors and styles of the Dashboard and its Widgets, and gives the
Dashboard a cohesive look. The Dashboard Theme is defined as part of the Dashboard's Display
properties but can be overridden at a Global, Role, User, or Widget level. For more information, see
Dashboard Themes.

• The default Dashboards (Home and HUD) and Dashboard Theme are initially selected in CSM
Administrator, either Globally or by Role. If a User has security rights, she can select her own User
default Dashboards and Dashboard Theme in the CSM Desktop Client. A system administrator can
clear Role and User defaults (for a specific User/Role or all), resetting the defaults to the Global-
defined settings (File>Clear Settings in the User Manager or Role Manager).

• Filter the data on a Dashboard to show only a subset of data by selecting options in the
Dashboard's filter (example: Show only today's data). Filtering is configurable, so behaviors vary.
For more information, see Dashboard Filtering.

• Drill down into a Chart, Gauge, or Matrix Widget by double-clicking the Widget. The Widget can be
defined to drill down into a list of records or another Dashboard, or to initiate a command (example:
Run a report). If specifically defined, the drill-down Dashboard will honor filters. For more
information, see Dashboard Drill-Down.

• Each Dashboard is assigned a Theme. For more information about Themes, refer to About Themes
and Dashboard Themes.

• Manually refresh a Dashboard by pressing F5 on your keyboard. Refresh is configurable, so
behaviors vary. For more information, see Dashboard Refresh.

• Good design is important. Before creating a Dashboard, see Design a Dashboard. See Dashboard
Editor Behaviors for tips on working with Widgets.

• Dashboards might behave differently in the CSM Browser Client. For more information about
Browser Client Dashboards, refer to the Browser Client documentation.

• The Dashboard Viewer (stand-alone application) allows you to view a Dashboard without consuming
a license, so you can give one to every manager in your company.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure Dashboard Security Rights.
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Dashboard Filtering
Chart, Gauge, and Matrix Widgets can be filtered at the Dashboard level or individually:

• Dashboard filtering: A Filter Widget can be added to a Dashboard to filter all Widgets on the
Dashboard by the same criteria (ex: Have all Widgets on the Dashboard display only Today's data).

When a Filter Widget is used on a Dashboard, the Filter Widget's properties define how the filter
looks and behaves. The Dashboard's Filter properties define filtering persistence.

• Widget filtering: A Widget can also have its own defined date range filter (ex: Widget shows only
data within the last year).

Filtering Persistence
A Dashboard's Filter properties define whether or not filtering is persistent (that is, whether or not the
Dashboard remembers the last filter you used and automatically displays it the next time you view the
Dashboard, even between sessions). If persistence is not defined, the Widget's default filtering criteria is
used each time the Dashboard is accessed.
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Drill-Down Filtering
Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering (Filter
Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to show only
Today's data and then drill down into another Dashboard, then the drill-down Dashboard will also be
filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard displays any filtering
criteria. Users can remove the filter by clearing the filters.
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Dashboard Themes
A Theme is a set of colors, fonts, images, and styles that can be used by elements on a Dashboard,
Form, or Portal site to give a cohesive look. In a Theme, define colors, fonts, images, and styles for the
different elements on a Dashboard (ex: Dashboard background color, colors for charts and gauges, alert
colors, label fonts, etc.). For a detailed list of Dashboard-specific Theme properties, see Dashboard
Theme Properties.

Note: Widgets significantly vary by type, so Theme properties and how they can be applied also
vary significantly (ex: Image Widgets do not have text).

A Theme is selected as part of a Dashboard's Display properties.
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If configured, a Dashboard Theme can be overridden by a:

• Widget Theme: Chart, Gauge, and Matrix Widgets can have their own colors and styles and can be
configured to override the Dashboard Theme. Gauge Threshold colors can also override Theme
Alert colors.

• Global Dashboard Theme: The default Dashboard Theme selected for the entire system.

• Role Dashboard Theme: The default Dashboard Theme selected for a Role.

• User Dashboard Theme: The Theme selected by the User.

• View Theme: A system administrator, or anyone with rights, has the ability to set a Theme for each
View, which essentially resets the default Global Theme.
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CSM provides several OOTB Themes. Use these OOTB Themes as-is, edit them, or create them using
the Theme Manager.
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Heads-Up Display (HUD)
The Heads-Up Display (HUD) is a transparent, pop-up Dashboard that can be accessed from almost
anywhere in CSM by pressing F4 on your keyboard. (Pressing F4 a second time closes the HUD.)
Because the HUD is transparent, you can see your work page behind the display. The contents of the
HUD are created the same way as any other Dashboard.

Each User has a default HUD. This default (either Global or Role) is initially selected in CSM
Administrator; however, if Users have security rights, they can select their own default HUD in the CSM
Desktop Client. Other Dashboards are accessed using the Dashboard Manager.

Tip: Select your default Home Dashboard as your default HUD so that you can keep it active
while you work.
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Dashboard Drill-Down
Drill down on a Chart, Gauge, and Matrix Widget to see more detailed data by double-clicking a Widget.
Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a record to view it in detail.

• Execute a command: Drill-down executes a command (ex: Display an Action Catalog, Calendar,
Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-Step,
search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (ex: A Dashboard dedicated to the
Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (ex: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

• None: Drill-down is not allowed.

Examples include:

• Configure each series line on an MTTR by Priority Chart Widget to drill down into a list of records by
priority (ex: All P1s, all P5s).
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• Configure a Planned/Unplanned Changes Chart Widget to run/display a report (command) that
shows all Planned Changes in an organized format.

• Configure an Incident Gauge to drill down into a more detailed Incident Dashboard.

• Configure a Customer Satisfaction Gauge Widget to drill down into a more detailed Survey
Dashboard.

Dashboard drill-down is configured as part of a Widget's Drill-Down properties.
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Note: Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors
filtering (Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a
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Dashboard to show only Today's data and then drill down into another Dashboard, then the drill-
down Dashboard will also be filtered to show only Today's data. A Filter bar at the top of a drill-
down Dashboard displays any filtering criteria. Users can remove the filter by clearing the filters.
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Dashboard Refresh
You can refresh Dashboards and Widgets automatically or manually, refreshing Widgets individually or all
at once. CSM refresh capabilities include:

• Scheduled Dashboard refresh.

• Scheduled Widget refresh.

• Manual refresh.

Scheduled Dashboard Refresh
A scheduled Dashboard refresh is an automatic refresh that occurs at a defined rate (ex: Every 5
minutes). The refresh rate is defined as part of the Dashboard Refresh properties, and can refresh:

• All Metrics: Reloads the current Metric value every time the Dashboard is refreshed. If not selected,
each Metric is refreshed according to its own refresh rate. For more information, refer to the Metrics
documentation, specifically Metric Caching.

• All Widgets Every X minutes: Refreshes all Widgets on a scheduled basis. If not selected, each
Widget is refreshed only according to its own refresh rate.

• Individual Widgets on their Own Schedules (only available if the Refresh All Widgets Every X
Minutes check box is selected): Refreshes each Widget according to its defined refresh rate, in
addition to the Dashboard's refresh rate.
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Scheduled Widget Refresh
Most Widgets on a Dashboard can have their own scheduled refresh that is defined as part of the
Widget's properties (ex: Every 5 minutes).
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A Dashboard's Refresh properties determine whether or not to:

• Refresh the Widgets on a different schedule: Use the Dashboard's scheduled refresh instead.

• Allow the Widgets to refresh themselves: In addition to the Dashboard's scheduled refresh.

Manual Refresh
Users can manually refresh a Dashboard at any time (right-click>Refresh or F5). A manual refresh obeys
the Dashboard's defined refresh properties.

Note: Metrics are updated only when their values are no longer considered fresh. This means that
a Dashboard/Widget refresh does not necessarily update a Metric value. For more information,
refer to the Metrics documentation, specifically Metric Caching.
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OOTB Dashboards
The possibility for Dashboards is endless. However, to get you started, CSM provides the following OOTB
Dashboards:

• Global IT Dashboard: Presents critical Business Object data and analytics (ex: Open Incidents and
Tasks, team workloads, closure rates, etc.).

• My Work: Presents personal data and analytics (ex: Incidents and Tasks owned by you or your
Team, status, etc.).

• Reporting Dashboard: Serves as an at-a-glance panel for running popular reports.

• Business Object Dashboards: Intuitively organize critical Business Object data and analytics into
real-time, at-a-glance control panels. Examples include:

◦ Changes Dashboard.

◦ CMDB Dashboard.

◦ Incident Dashboards (Incidents Dashboard and Incident Details Dashboard).

◦ Problems Dashboard.

◦ Requests Dashboard.

◦ Supplier Dashboards.

• Tech Dashboards: Tech Dashboards are designed for service desk technicians, and provide
personal workload and status information, available by individual, team, and queue (ex: Assigned
records, assigned Tasks, breached SLAs, etc.).

• IT Management Dashboards: IT Management Dashboards are designed for IT executives, service
desk managers, and technicians to provide strategic, tactical, and operational views of an IT
organization.

• Portal Dashboards: Portal Dashboards are designed for Customers accessing the CSM default
Portal Site, and provide Customer-specific at-a-glance information and navigation functionality, such
as links to helpful self-service Actions (ex: Report an Incident, search Knowledge Articles and FAQs,
etc.), a community discussion board, a list of open records (ex: Incidents and Problems), contact
hours, etc.

Use these OOTB Dashboards as-is, edit them, or create your own using the Dashboard Manager and
Dashboard Editor.
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OOTB Global IT Dashboard
CSM provides an OOTB Global IT Dashboard that presents critical Business Object data and analytics
(ex: Open Incidents and Tasks, team workloads, closure rates, etc.).

CSM 9.3.0 Features 451

CSM 9.3.0 Features



OOTB My Work Dashboard
CSM provides an OOTB My Work Dashboard that presents personal data and analytics (ex: Incidents and
Tasks owned by you or your Team, status).
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OOTB Reporting Dashboard
CSM provides an OOTB Reporting Dashboard that serves as an at-a-glance panel for running popular
reports.
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OOTB Technician Dashboards
CSM provides several OOTB Tech Dashboards. Technician Dashboards are intended for service desk
technicians, and provide personal workload and status information, available by individual, team, and
queue.

OOTB Technician Dashboards include:

• IT Home: Provides overviews and drill-down into three more specific IT Dashboards.

• Queues: Provides queue workload and status.
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• My Team: Provides team workload and status.

• Reporting: Provides high-level record counts.
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OOTB IT Management Dashboards
CSM provides several OOTB IT Management Dashboards. IT Management Dashboards are intended for
IT executives, managers, and technicians, and provide strategic, tactical, and operational views of an IT
organization.

OOTB IT Management Dashboards include:

• IT Executive: Provides a strategic view of the IT organization's workload and performance.

• IT Service Desk Manager: Provides a tactical view of service desk operations.
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• IT Technician: Provides an operational view of IT technician workload.
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Using Dashboards
When working with Dashboards, Users can filter the data shown on the Dashboard, drill down into data,
initiate a One-Step, refresh the Dashboard, select a User Dashboard Theme, and set the currently viewed
Dashboard as the default.
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View a Dashboard
A Dashboard can be viewed several ways:

• Default Dashboard:

◦ On the Desktop Client toolbar, click the Home button .

◦ On the Browser Client menu bar, click the Home button .

• Default Heads-Up Display (HUD):
◦ Press F4 on your keyboard.

◦ From the Desktop Client menu bar, click Dashboards>Heads-Up Display.

• Available Dashboards (based on security rights): Use the Dashboard Manager.

• MRU Dashboards:
◦ From the Desktop Client menu bar, click Dashboards, and then select a Dashboard from the

MRU list (listed below the line in the menu).

◦ From the Browser Client menu bar, click Dashboards, and then select a Dashboard from the
MRU list (listed below the line in the menu).

• Available Dashboards without logging in to CSM (and without consuming a license): Use the
Dashboard Viewer (click Start>All Programs>Cherwell Service Management>Tools>Dashboard
Viewer).
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Filter a Dashboard
Filter the data on a Dashboard to show only a subset of data (ex: Show only today's data).

Good to know:

• Dashboard filtering is configurable, so behaviors can vary. For more information, see Dashboard
Filtering.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

.

To filter a Dashboard:

1. View a Dashboard.

2. On the Dashboard, click the drop-down arrow on the Filter, and then select a filtering option (ex:
Today).
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Drill Down into Dashboard Data
Drill down on a Chart, Gauge, and Matrix Widget to see more detailed data. Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a record to view it in detail.

• Execute a command: Drill-down executes a command (ex: Display an Action Catalog, Calendar,
Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-Step,
search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (ex: A Dashboard dedicated to the
Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (ex: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

Good to know:

• Dashboard drill-down is configurable, so behaviors can vary. For more information, see Dashboard
Drill-Down.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

To drill down into Dashboard data:

1. View a Dashboard

2. On the Dashboard, double-click a Widget to drill down into the data.

3. Click the Back button  on the toolbar to navigate back to the Dashboard.
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Initiate a One-Step/Action from a Dashboard
Initiate a One-Step/Action by clicking a Widget on a Dashboard. Typically, One-Steps/Actions are
configured to work with buttons and links; however, they can be also be initiated as drill-down behaviors.

To initiate a One-Step/Action from a Dashboard:

1. View a Dashboard

2. On the Dashboard, click the Widget. Drill-down Actions require a double-click.
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Manually Refresh a Dashboard
Dashboards and Widgets might be defined to refresh on their own schedules; however, you can manually
refresh a Dashboard at any time.

Good to know:

• Dashboard refresh is configurable, so behaviors can vary. For more information, see Dashboard
Refresh.

• Metrics are updated only when their values are no longer considered fresh. For more information,
refer to the Metrics documentation, specifically Metric Caching.

To manually refresh a Dashboard:

1. View a Dashboard

2. On the Dashboard, right-click>Refresh or press F5.

Note: In the CSM Browser Client, click the Refresh button .
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Select a User Dashboard Theme
A Dashboard Theme is a set of set of colors, styles, and fonts that can be applied to a Dashboard to give
the Dashboard and its Widgets a cohesive look.

Good to know:

• The ability to select a User Dashboard Theme is based on two things: security rights and permission
from the Dashboard (that is, the Allow User's Chosen Theme to Override the Dashboard Theme
check box is selected on the Dashboard's Display page).

• Dashboard Theme behaviors can vary. For more information, see Dashboard Themes.

To select a User Dashboard Theme:

1. View a Dashboard

2. On the Dashboard, right-click>User Theme, and then select a Theme in the drop-down:
◦ The default Dashboard Theme is listed at the top.

◦ The currently selected Theme is checked.

◦ Most Recently Used (MRU) Themes are listed in alphabetical order.

◦ Click More to open the Theme Manager, and then select an existing Theme or create a new
Theme.

Note: In the CSM Browser Client, click the Theme drop-down button, and then select
a Theme in the drop-down.

CSM 9.3.0 Features 466

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=configure_dashboard_security_rights
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fdashboards%2F..%2F..%2Fshared%2Fdashboard_themes.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fdashboards%2F..%2Fthemes%2Fcreate_a_theme.html


Set the Current Dashboard to be the Default
Each User has a default Home Dashboard, which is displayed when the User first logs in or when the

Home button  is clicked on the CSM Desktop toolbar or Browser Client menu bar.

Good to know:

• The default Dashboards (Home and HUD) and Dashboard Theme are initially selected in CSM
Administrator, Globally or by Role.

• The ability to select default User Dashboards is based on Dashboard security rights. The ability to
select a default User Theme is based on Theme security rights.

• You can also select default Dashboards and a default User Dashboard Theme in the CSM Desktop
Client Options window (Tools>Options>Dashboards & Calendars).

To set the current Dashboard to be the default:

1. View a Dashboard

2. On the Dashboard, right-click>Set as default or click Dashboards>Set as default.
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Managing Dashboards
CSM Dashboards are managed using the Dashboard Manager and the Dashboard Editor.

Use the Dashboard Manager to complete general CSM Item Manager operations for Dashboard,
including:

• View a Dashboard.

• Create a Dashboard.

• Edit a Dashboard.

• Delete a Dashboard.

• Search for a Dashboard.

• Organize Dashboards.

• Copy a Dashboard.

• Import/export a Dashboard.

• Find Dashboard dependencies.

• Add a Dashboard to the Desktop Client Task Pane/toolbar.

• Pin a Dashboard.

Use the Dashboard Editor to:

• Select a Dashboard background color.

• Size the Dashboard background.

• Add one or more Widgets to the Dashboard.

• Define how each Widget looks and behaves on the Dashboard: Text, size, color, style and gloss,
image, alignment, anchoring, layering, and visibility.

Good to know:

• Good design is important. Before creating a Dashboard, see Design a Dashboard.

• See Dashboard Editor Behaviors for tips on working with Widgets.
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Open the Dashboard Manager
The Dashboard Manager is available in most CSM clients. For example, from the CSM Desktop Client
menu bar, click Dashboards>Dashboard Manager.

You can also use these methods to open the Dashboard Manager:

• From the Browser Client menu bar, click Dashboards>Dashboard Manager.
• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Dashboard Manager.
• From Settings in the CSM Desktop Client (Tools>Options>Dashboards & Calendars page).

• From within the Site Manager in CSM Administrator.

• From Dashboard selectors throughout CSM.

• From the Dashboard Viewer menu bar, click Dashboards>Dashboard Manager.
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Dashboard Editor
The Dashboard Editor is a tool within the Dashboard Manager that helps you define how a Dashboard
and its Widgets look and behave.

The Dashboard Editor preview is dynamic; when you make changes, the changes are immediately
reflected in the preview. Click OK to commit the changes. Also accessible from the Dashboard Editor are
the Widget Manager and Widget properties.

The Dashboard Editor can be opened in several ways.

1. Toolbar: Displays common commands for formatting the appearance and behaviors of a Dashboard
and its Widgets.

2. Widget list: Lists the existing Widgets that you can add to the Dashboard. Use the Search Control
and Hide Folder options to locate Widgets. Tips: You can create a new Widget or open the Widget
Manager by right-clicking a Widget in the list.

3. Dashboard preview: Displays a dynamic preview of the Dashboard. Changes are committed to the
published Dashboard when you click OK.

4. Main Pane: Displays a workspace for designing a Dashboard.
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Dashboard Editor Toolbar
Use the Dashboard Editor toolbar to quickly access common operations for formatting the appearance
and behaviors of a Dashboard and its Widgets. The toolbar is made up of three smaller toolbars:

1. Formatting toolbar: Displays options for formatting Widget text (font, style, size, and alignment),
Widget colors/styles (foreground, background, and border), and Widget behaviors (visibility,
anchoring, and image). Also displays options for accessing Dashboard properties, selecting a
Dashboard background color, accessing Editing buttons (Cut/Copy/Paste, Undo/Redo, Grid/Guide
snaps, and Zoom).

2. Label toolbar: Displays options for defining Widget labels and wrapping.

3. Layout toolbar: Displays options for aligning and placing Widgets.

Good to know:

• Move a toolbar by double-clicking the Grab bar , or by grabbing the Grab bar and then dragging
the toolbar to a new location.

• Re-dock a toolbar to its default location by double-clicking the header banner of an undocked
toolbar.

• Hide a toolbar by right-clicking anywhere in the toolbar area, and then clearing the check box for the
toolbar.

• Many of the toolbar options are also available from the Dashboard Editor context (right-click) menu.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

Formatting Toolbar (Text, Color/Style, and Behaviors)

Button Action Description

Widget Text
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Button Action Description

Font

There are two different font modes for Widget
text:

• Theme Font: Uses the default system font.

• Explicit Font: Allows you to set an explicit
font and other font details on a Widget-by-
Widget basis.

To switch to Theme mode, select Theme Font
from the top of the list.

To switch to Explicit mode, select a font in the
drop-down.

Font Size (Explicit)

Explicitly sets the Widget font size (ex: 10 points).

Note: This option is available only when
using Explicit Font mode.

Font Style (Bold, Underline, Italic)

Adds style to the Widget font (bold, underlined, or
italics).

Note: This option is available only when
using Theme Font mode.

Font Size (Relative)

Relatively sets the Widget font size to be small,
medium, or large.

Note: This option is available only when
using Theme Font mode.

Horizontally Align Text

Aligns text left, center, or right on a horizontal axis
within the Widget bounding box.

Note: Applicable for Link, Button, and
Text Widgets.
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Button Action Description

Vertically Align Text

Aligns text top, middle, or bottom on a vertical
axis within the Widget bounding box.

Note: Applicable for Link, Button, and
Text Widgets.

Widget Color/Style

Background color

Sets the background color of the Widget.

Click the button to use the most recently used
color (assuming you have set a color). To
explicitly select a color, click the drop-down arrow
to select a solid color or a gradient. You can use
an Expression to conditionally change the color.

Foreground color

Sets the text color for the Widget.

Click the button to use the most recently used
color (assuming you have set a color). To
explicitly select a color, click the drop-down arrow
to select a single color or a gradient. You can use
an Expression to conditionally change the color.

Border color

Sets the color of the border around the Widget, if
there is a border.

Click the button to use the most recently used
color (assuming you have set a color). To
explicitly select a color, click the drop-down arrow
to select a single color or a gradient. You can use
an Expression to conditionally change the color.
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Button Action Description

Border style

Sets the style of the border around the Widget
(No Border, 3D, or Pixel width), if there is a
border.

Click the button to use the most recently set style
(assuming you have set a style). To explicitly
select a style, click the drop-down arrow to select
a style.

Note: While you can select 3D borders
for any Widget, rounded Shapes do not
allow 3D settings.

Available from context menu only. Background style

Changes the background shape of the Widget.

Select options such as square, rounded corner,
tab and rounded tab.

Note: Not all styles are compatible with
all types of Widgets.

Available from context menu only. Background gloss Makes a Widget glossy (adds a slightly glowing
and reflective background).

Widget Behavior

Visibility

Conditionally controls when the Widget appears
and disappears. The visibility is based on an
Expression.

Click the drop-down button to define a custom
Expression. Click the drop-down arrow to access
options for creating a custom Expression,
selecting a stored Expression, or clearing the
Expression.

Anchoring

Sets the anchoring behavior of the Widget.

Click the button to use the most recently set
anchoring options (assuming you have set an
option). To explicitly select an anchoring option,
click the drop-down arrow next to the button to
open the Anchoring window, and then select an
anchoring option.

CSM 9.3.0 Features 474

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fdashboards%2F..%2Fexpressions%2Fabout_expressions.html


Button Action Description

Image

Defines the image to display on the Widget, as
well as alignment.

Click the button to open the Image Manager, and
then select an image to show on the Form
Control. Click the drop-down arrow to access
options for creating a custom Expression,
selecting a stored Expression, clearing the
Expression, or aligning the image.

Dashboard Properties

Dashboard Properties

Opens the Dashboard Properties window, and
then change the name, description, title text,
Business Object association, scope, image,
Display options, Filter options, and Refresh
options.

Dashboard Background Color

Sets the Dashboard background color.

Click the button to use the most recently set color
(assuming you have set a color). To explicitly
select a color, click the drop-down arrow to select
a single color or a gradient. Use an Expression to
conditionally change the color.

Editing Buttons

Cut

Moves the selected item to the clipboard, and
then paste the item into a new location.

Note: CTRL+X also works. Multiple
Widgets can be cut at one time. Select
multiple Widgets by rubber-banding or by
holding down the SHIFT key while
selecting.
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Button Action Description

Copy

Creates a new item whose properties are the
same as the copied item. The new item can then
be named and customized.

Note: CTRL+C also works. Multiple
Widgets can be copied at one time.
Select multiple Widgets by rubber-
banding or by holding down the SHIFT
key while selecting.

Paste

Inserts an item from the clipboard to a new
location.

Note: CTRL+V also work. Multiple
Widgets can be copied at one time.
Select multiple Widgets by rubber-
banding or by holding down the SHIFT
key while selecting.

Undo Undoes the last operation. Unlimited per session.

Redo Repeats the last operation. Unlimited per session.

Snap to Grid Precisely aligns a Widget on a grid. Set the grid
snap width (drop-down).

Snap to Guide

Precisely aligns a Widget to other items.

Note: Press SHIFT+DRAG to ignore
snapping.

Zoom

Zooms in/out on the Dashboard.

Note: CTRL+SCROLL also works.

Label Toolbar (Label Text, Wrap, Style, and Gloss)
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Button Action Description

Label Text Box

Defines the text that appears on the
currently selected Widget.

Type the text into the Text toolbar.

Note: This value will only
affect the primary selected
Widget.

Expression

Conditionally defines the text that
appears on the currently selected
Widget. You can use either:

• Expression Manager: Select
this option to open the
Expression Manager, and then
select an existing stored
Expression or create a new
stored Expression. Stored
Expressions can be reused in
numerous places in CSM.

• Custom Expression: Select
this option to open the Custom
Expression Builder, where you
can create a custom
Expression to use only for the
active scenario.

Wrap Toggles text wrap On and Off.

Layout Toolbar (Alignment, Size, and Order)

For most of the alignment operations, you must select at least two Widgets. The last selected Widget is
the controlling Widget, and the Widget against which all other selected Widgets are sized and aligned.
The controlling Widget is identified by black boxes. All other selected Widgets are identified by white
boxes.

Button Action Description

Line up horizontally
Lines up all the selected Widgets
against the left, center, or right
edge of the controlling Widget.
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Button Action Description

Line up vertically
Lines up all the selected Widgets
against the top, middle, or bottom
edge of the controlling Widget.

Sizing

Sizes all the selected Widgets to be
the same width, the same height,
or both the same height and same
width as the controlling Widget.

Auto-size

Sizes a text Widget to be exactly
the right size to hold all its
contained text. Sizes an Image
Widget to be its original size.

Bring to Front

Moves a Widget in front of other
Widgets. You can use this if you
are creating various layering
effects.

Note: Not all Widgets are
allowed to be in front or
behind all other Widgets
(ex: Most shapes cannot
be on top of most graphical
Widgets, such as Charts
and Gauges).

Send to Back

Moves a Widget behind other
Widgets. Use this if creating
various layering effects.

Note: Not all Widgets are
allowed to be in front of or
behind all other Widgets
(ex: Most Shapes cannot
be on top of most graphical
Widgets, such as Charts
and Gauges).
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Dashboard Editor Behaviors
Dashboard Editor Context Menu

Use the Dashboard Editor context (right-click) menu to quickly access common Dashboard Editor
operations.

Search for Widgets

• Widget Search Control : Use to search for a Widget by name (ex:
Incident or My), description, or type (ex: Gauge).

• Hide/Display Folders option : Use to hide folders in the Widget tree, so that all Widgets can be
displayed at the root node, regardless of how they are organized/stored in the tree.

Select a Widget

• To select a Widget, click a Widget or click-and-drag (rubber-band) over the Widget. This deselects
all other Widgets.

• A selected Widget is identified by black boxes around the bounding box. The bounding box
represents the Widget's vertical and horizontal dimensions.

.

Select Multiple Widgets

• To select multiple Widgets:
◦ Hold down the CTRL key while you click each Widget in turn.

◦ Click-and-drag (rubber-band) over the Widgets you want to select. Any Widget that is included
(even partially) in the rubber-band box will be selected.

◦ Press CTRL+A to select all Widgets.

• When multiple Widgets are selected:
◦ The Controlling Widget is the last selected Widget, and the Widget against which all other

selected Widgets are sized and aligned.

◦ The Controlling Widget is identified by black boxes. All other selected Widgets are identified by
white boxes.

◦ To change the Controlling Widget, hold down the SHIFT key and click a different selected
Widget.

Edit Widgets
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• To delete a Widget, click it, and then press the DELETE key.

• To edit the detailed properties of a selected Widget, right-click>Widget Properties.

• To undo/redo the previous operation, click the Undo  or Redo  button. Unlimited per session.

• To cut, copy, or paste in a Dashboard or between Dashboards, click the Cut , Copy , or

Paste  button. CTRL+X, CTRL+C, and CTRL+V also work. Multiple Widgets can be copied and
pasted at one time. Select multiple Widgets by rubber-banding or by holding down the SHIFT key
while selecting.

• To duplicate a Widget, press CTRL+Drag.

• To move a Widget, drag the Widget.

• To move a Widget 1 pixel (nudge), press an ARROW key.

• To move a Widget exactly 10 pixels, press SHIFT+ARROW key.

• To precisely align a Widget on a grid, toggle Snap to Grid  to ON. You can also set the grid
snap width (drop-down). Press SHIFT+DRAG to ignore snapping.

• To precisely align a Widget to other items, toggle Snap to Guide  to ON. Press SHIFT+DRAG
to ignore snapping.

• To zoom in/out on a Dashboard, slide the Zoom control . CTRL+SCROLL
also works.

• To pan across a Dashboard, press SPACE BAR+MOUSE.

• To maintain aspect ratio when resizing, hold down SHIFT while sizing.

• To wrap text in a Text Widget bounding box, click the Text Wrap button .
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Dashboard Editor Keyboard Shortcuts

Key Action

CTRL+A Select All

CTRL+C Copy

CTRL+V Paste

CTRL+X Cut

CTRL+Y Redo

CTRL+Z Undo

CTRL+SHIFT+P Opens the Position and Size window, and then specify an exact location
(left and top) and size (width and height)

CTRL+SCROLL Zoom in/out

CTRL+DRAG Duplicate

SHIFT+DRAG Ignore grid and guideline snapping

SHIFT+SIZE Maintain aspect ratio

SPACE+MOUSE Pan window

Mouse Left Button

or

Double-click selected Widget

Edit Widget properties

ARROW keys Move selected items 1 pixel at a time

SHIFT+ARROW keys Move selected items 10 pixels at a time

CTRL+ARROW keys Resize selected items 1 pixel at a time
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Open the Dashboard Editor
The Dashboard Editor can be opened from the Dashboard Manager.

The Dashboard Editor can be opened several ways:

• From within the Dashboard Manager, click the New button. The Dashboard Editor is automatically
opened after you define Dashboard properties.

• From within the Dashboard Manager, click the Dashboard to edit, and then do one of the following:
◦ Right-click>Edit.
◦ Click File>Edit.
◦ Click the Edit button.

• On a Dashboard, right-click>Edit [Dashboard].
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Design a Dashboard
Dashboard design is important. Before creating a Dashboard, you should consider the audience, purpose,
client access, scope, layout, and security.
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Dashboard Design Considerations
Consider the following before creating a Dashboard:

• Audience: Who is it for (User or Customer? Technician or Executive? Etc.)?

• Purpose: How will it be used (For at-a-glance statistics? For trending? For navigation? Etc.)?

• Client access: From where will it be accessed (Desktop Client? Browser Client? Portal? Cherwell
Mobile?)?

• Scope: Global, Role, Team, User?

• Layout: Which Widgets will be on it (Charts? Gauges? Twitter Feeds?) and what will it look like
(colors, font, alignments, etc.)?

• Security: Who can access each Widget?
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Dashboard Design Tips
Following are some tips to help you design an effective Dashboard:

• Make it useful: Consider the audience and what they need most. Executives might want at-a-
glance statistics and trending, a manager might want quick access to reports, and a Technician
might want a list of relevant records.

• Make it pretty: Do not underestimate the visual experience. Employ visual elements, such as
images, colors, styles, alignment, and layering to convey information and embellish the aesthetic.
Use consistent, browser-friendly fonts and colors (or Themes) to ensure stability and cohesion.

• Make it conditional: Use Expression-driven colors, text, images, and visibility to dynamically
change the way a Widget looks and behaves based on a defined condition. For example, display an
SLA Widget on a Dashboard. When an SLA is in jeopardy of being breached, change the label to
indicate a surpassed threshold (expression-driven text), change the background color to red
(expression-driven color), display a warning icon (expression-driven image), and then display a
warning message (expression-driven visibility).
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Create/Edit a Dashboard
Create or edit a Dashboard to define its properties and save it in the Dashboard Manager.

Note:  3-Minute Video: Create a Dashboard.

For more information about Dashboards, refer to the Building a Dashboard course available in the
Cherwell Video Learning Library (subscription-based).

Create a Dashboard

1. Open the Dashboard Manager. and select a scope and subfolder (if needed).

2. Click the Create New button . The Dashboard Properties page opens.

3. On the main page, define the general properties for the Dashboard.

4. Click the Display page to define the display options.

5. Click the Filter page to define the filter options.

6. Click the Refresh page to define the refresh options.

7. (Optional) Click the Options button to define additional options.

8. Click OK.8. 

The Dashboard Editor opens, where you can then:

◦ Size the Dashboard background.

◦ Select a Dashboard background color.

◦ Add one or more Widgets to the Dashboard.

◦ Define how each Widget looks and behaves on the Dashboard: Text, size, color, image,
alignment, anchoring, layering, and visibility.

Edit a Dashboard

1. Open a Dashboard in the Dashboard Editor

2. Make changes.

Tip: To access Dashboard Properties, click the Dashboard Properties button  on the
Dashboard Editor toolbar.

3. Click OK.3. 
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Select a Dashboard Background Color
Use the Dashboard Editor to select a background color for the Dashboard. Colors can come from:

• (Recommended) CSM Themes: All colors defined for the selected CSM Theme.

• System:

Set of colors provided by your Operating System. System colors can greatly vary depending on the
Operating System and browser used to view the color.

• Web:

Set of named Web-safe colors.

• RGB colors:

Customized Red, Green, Blue (RGB) colors.

Good to know:

• If you are using Dashboard Themes, use a Theme color for the Dashboard background (ex: A Form
Background color). You can select a system, Web, or RGB color; however, if you use a non-Theme
color, the background will not change to another Theme color when you apply a different Theme.

• Theme colors are defined as part of a Theme's definition. Use the Theme Manager to create a
Theme.

• Colors can be solid or can contain gradients.

• Colors can be conditional (Expression-driven): For example, define an Expression to conditionally
change the background color of a Dashboard to red to indicate a surpassed threshold (ex: Open
Incidents surpassed 100 count threshold).

To select a Dashboard background color:

1. Open a Dashboard in the Dashboard Editor

2. On the Dashboard Editor toolbar, click the drop-down arrow on the Background Color button

.

3. Select a color pattern, either:
◦ Solid color: Uses one color (First Color) for the background. Click a color in the list.

◦ Gradient (left-to-right or top-to-bottom): Uses a gradient between two colors (First Color and
Second Color). Click two colors in the list, and then click Select.

4. Select a background color, either:
◦ Use Expression: Select this check box to use an Expression to conditionally change the color;

then, select or define the condition, using either:

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.
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◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Color category:
◦ (Recommended) Theme: All colors defined for the selected CSM Theme.

◦ System:

Set of colors provided by your Operating System. System colors can greatly vary
depending on the Operating System and browser used to view the color.

◦ Web:

Set of named Web-safe colors.

◦ Custom:

Customized Red, Green, Blue (RGB) colors.

5. Continue making changes, or click OK to save and close the editor.5. 
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Size a Dashboard Background
Use the Dashboard Editor to size a Dashboard background to a target dimension.

Good to know:

• Build a Dashboard to target dimensions (ex: A Wallboard, a standard laptop screen, etc.); otherwise,
your Dashboard might be too small or too large for the resolution of the screen on which it is most
often displayed.

• Use the grid points to precisely size the background.

• To increase the size of the Dashboard without moving any anchored Widgets, hold down the SHIFT
key while resizing the Dashboard. The Widgets maintain their current locations.

To size a Dashboard background:

1. Open a Dashboard in the Dashboard Editor

2. Click-and-drag the sizing border around the Dashboard to adjust its height and width.

3. Continue making changes, or click OK to save and close the editor.3. 
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Add a Widget to a Dashboard (General)
Use the Dashboard Editor to add one or many Widgets to a Dashboard simply by dragging them onto
your Dashboard.

Good to know:

• Many Widgets have their own properties (ex: Refresh and filter properties). When a Widget is added
to a Dashboard, the Dashboard can either honor the Widget's properties or override them.

• Button and Link Widgets have additional Widgets properties (Right-click>Control Properties) that
must be configured after being added to a Dashboard (ex: You have to define the Action to
execute).

• By default, most Widgets acquire their text properties (font family, size, and style), color
(background, foreground, and border), border style, and background style properties from the
defined Dashboard Theme; however, you can define your own properties, if needed.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add a Widget to a Dashboard (general):

1. Open a Dashboard in the Dashboard Editor

2. Drag-and-drop a Widget from the Widget pane onto the Dashboard.

3. Configure/edit the Widget properties, if needed:
a. Right-click the Widget, and then select Widget Properties.

4. (Optional) After the Widget(s) are on the Dashboard, use the Dashboard Editor to define how each
Widget looks and behaves on the Dashboard (ex: Text properties (font, font size, font style, text
wrap), size, color (background, foreground, and border), background style and gloss, border style,
alignment, anchoring, layering, and visibility).

5. Continue making changes, or click OK to save and close the editor.5. 

Note: For detailed information about adding the different types of Widgets, see Add a Button
Widget to a Dashboard, Add an Image Widget to a Dashboard, Add a Link Widget to a
Dashboard, Add a Text Widget to a Dashboard, and Add a Shape Widget to a Dashboard.
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Add a Button Widget to a Dashboard
Use the Dashboard Editor to add Button Widget to a Dashboard. A Button Widget is capable of executing
a single Action when clicked (ex: Run an Action/One-Step).

Good to know:

• A Button Widget is highly configurable. Add one or many to a Dashboard, then define the Action to
execute when the button is clicked, and how the button looks and behaves on the Dashboard (ex:
Text, size, color, background style and gloss, border style, image, alignment, anchoring, layering,
and visibility).

• Text, image, and colors can be conditional (Expression-driven).

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add a Button Widget to a Dashboard:

1. Open a Dashboard in the Dashboard Editor

2. Drag-and-drop the Button Widget from the Shapes, Etc. tree onto the Dashboard.

3. Define the Action to execute when the button is clicked:
a. Right-click the Button Widget, and then select Widget Properties.

b. Click the Ellipses button  to open the Action Manager, then select the Action to execute.

4. Define the text to display on the button:
a. In the Label text box on the Dashboard Editor toolbar, provide the text to display on the

button.

b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

5. Define how the Button Widget looks and behaves on the Dashboard (ex: Size, alignment, etc.).

6. Continue making changes, or click OK to save and close the editor.6. 
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Add an Image Widget to a Dashboard
Use the Dashboard Editor to add an Image Widget to a Dashboard.

Good to know:

• An Image Widget is highly configurable. Add one or many to a Dashboard, then define the image,
and how the image looks and behaves on the Dashboard (ex: Text, size, alignment, anchoring,
layering, and visibility).

• Image Widgets do not support text, background, foreground, or border colors; therefore no colors,
styles, or fonts can be applied.

• Images can be conditional (Expression-driven). For example, display a warning icon when an SLA is
in jeopardy of being breached and a clock icon after an SLA has been breached.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add an Image Widget to a Dashboard:

1. Open a Dashboard in the Dashboard Editor

2. Drag-and-drop the Image Widget from the Shapes, Etc. tree onto the Dashboard.

3. Define the image to display:

a. On the Dashboard Editor toolbar, click the drop-down arrow on the Image button , and
then select one of the following options:

◦ Browse: Opens the Image Manager, where you can select an existing image or import a
new image to display on the Widget.

◦ From Stored Value: Opens the Stored Value Manager, where you can select an existing
Stored Value or create a new Stored Value to use.

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a
custom Expression to use only for this scenario.

◦ Expression Manager: Opens the Expression Manager, where you can select an existing
Expression or create a new stored Expression to use. Stored Expressions can be reused
in numerous places in CSM.

◦ None: Does not use an image.

4. Align the image:
a. Click the drop-down arrow on the Image button, select Image Alignment, and then select an

alignment option within the Widget (ex: Top-right).

5. Define how the Image Widget looks and behaves on the Dashboard (ex: Size, alignment, etc.).

6. Continue making changes, or click OK to save and close the editor.6. 
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Add a Link Widget to a Dashboard
Use the Dashboard Editor to add a Link Widget to a Dashboard. A Link Widget is capable of executing a
single Action when clicked (ex: Run an Action/One-Step).

Good to know:

• A Link Widget is highly configurable. Add one or many to a Dashboard, then define the Action to run
when the link is clicked, and how the link looks and behaves on the Dashboard (ex: Text, size, color,
background style and gloss, border style, image, alignment, anchoring, layering, and visibility).

• Text, image, and colors can be conditional (Expression-driven).

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add a Link Widget to a Dashboard:

1. Open a Dashboard in the Dashboard Editor

2. Drag-and-drop the Link Widget from the Shapes, Etc. tree onto the Dashboard.

3. Define the Action to execute when the link is clicked:
a. Right-click the Link Widget, and then select Widget Properties.

b. Click the Ellipses button  to open the Action Manager, then select the Action to execute.

4. Define the text to display on the link:
a. In the Label text box on the Dashboard Editor toolbar, provide the text to display in the link.

b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

5. Define how the Link Widget looks and behaves on the Dashboard (ex: Size, alignment, etc.).

6. Continue making changes, or click OK to save and close the editor.6. 
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Add a Text Widget to a Dashboard
Use the Dashboard Editor to add a Text Widget to a Dashboard.

Good to know:

• A Text Widget is highly configurable. Add one or many to a Dashboard, then define the text, and
how the text looks and behaves on the Dashboard (ex: Size, color, background style and gloss,
border style, image, alignment, anchoring, layering, and visibility).

• By default, Text Widget text, color, and border style properties come from the defined Dashboard
Theme.

• Text and colors can be conditional (Expression-driven). For example, use an Expression to display
the current date and time.

• A Text Widget is technically a simple Gauge Widget.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add a Text Widget to a Dashboard

1. Open a Dashboard in the Dashboard Editor

2. Drag-and-drop the Text Widget from the Shapes, Etc. tree onto the Dashboard.

3. Define the text to display in the Widget:
a. In the Label text box on the Dashboard Editor toolbar, provide the text to display.

b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

4. Define how the Text Widget looks and behaves on the Dashboard (ex: Size, alignment, etc.).

5. Continue making changes, or click OK to save and close the editor.5. 
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Add a Shape Widget to a Dashboard
Use the Dashboard Editor to add a Shape Widget (ex: Ellipses, Rectangles, and Tabs) to a Dashboard.

Good to know:

• A Shape Widget is highly configurable. Add one or many to a Dashboard, then define how the
shape looks and behaves on the Dashboard (ex: Text, size, color, style and gloss, image, alignment,
anchoring, layering, and visibility).

• By default, most Shape Widgets acquire their text (font, size, and style), color (background,
foreground, and border), border style, and background style properties from the defined Dashboard
Theme; however, you can define your own properties, if needed.

• Text, image, and colors can be conditional (Expression-driven).

• Rounded shapes do not allow 3D borders.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add a Shape Widget to a Dashboard

1. Open a Dashboard in the Dashboard Editor

2. Drag-and-drop the Shape Widget from the Shapes, Etc. tree onto the Dashboard.

3. (Optional) Define the text to display on the shape:
a. In the Label text box on the Dashboard Editor toolbar, provide the text to display.

b. (Optional) Change the font, font size, font style, font alignment, and text wrap, if needed.

4. Define how the Shape Widget looks and behaves on the Dashboard (ex: Size, alignment, etc.).

5. Continue making changes, or click OK to save and close the editor.5. 
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Define How a Widget Looks and Behaves on a
Dashboard

Use the Dashboard Editor to define how a Widget looks and behaves on a Dashboard.
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Define and Format Widget Text
Use the Dashboard Editor to define and format Widget text. A Widget has different kinds of text:

• Label: Text to display in the Widget header to identify the Widget. By default, the Widget label
comes from the Widget title.

• Data: Data to display inside the Widget (ex: Numbers, charts, etc.).

You can manually change any label and apply different fonts, if needed.

Good to know:

• Label text can be conditional (Expression-driven). For example, define an Expression to change a
label when a threshold is surpassed ("Too Many Open Incidents!").

• Text wrapping in labels can be turned On or Off.

• Text formatting options include:
◦ Font: Theme or explicit font family.

◦ Font size: Point size for an explicit font, or relative size (small/medium/large) for a Theme font.

◦ Font style: Bold, underline, or italics (explicit fonts only).

◦ Font alignment: Horizontal (left, center, right) and vertical (top, middle, bottom) alignment of
text ONLY on a Text, Button, or Link Shape Widget.

Note: Text color is defined as a foreground color.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To define and format Widget text:

1. Open a Dashboard in the Dashboard Editor

2. Click a Widget.
3. Define a label, either static or conditional text:

◦ Static: In the Label text box, provide the label to display in the Widget.

◦ Expression-driven text (conditional): Click the Expression button , and then define the
Expression (condition) to determine the label, using either:

◦ Custom Expression: Select this option to open the Custom Expression Builder, and then
create a custom Expression specifically for this scenario.

◦ Expression Manager: Select this option to open the Expression Manager, and then select
an existing stored Expression or create a new stored Expression. Stored Expressions
can be re-used in numerous places in CSM.

4. Define text formatting:
a. Font: In the Font drop-down on the Dashboard Editor toolbar, select a font family, either:

◦ Theme font: Font comes from your default system font (ex: Segoe UI).

◦ Explicit font: Font is selected by you.
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b. Font style (explicit fonts only; Theme font defines this): On the Dashboard Editor toolbar, click
the Bold, Underline, and/or Italics buttons .

c. Font size, either:

◦ Exact (explicit font): In the Font Size drop-down , select a point size (ex: 10).

◦ Relative (Theme font): On the Dashboard Editor toolbar, click the Small/Medium/Large

button .

d. Horizontal alignment (Text, Button, or Link Shape Widgets only): On the Dashboard Editor

toolbar, click one of the Horizontal Alignment buttons (Left, Center, or Right)  to
align the text on a horizontal axis within the control box (ex: Left, Center, or Right).

e. Vertical alignment: On the Dashboard Editor toolbar, click one of the Vertical Alignment buttons
(Top, Middle, or Bottom)  to align the text on a vertical axis within the control box (ex:
Top, Middle, or Bottom).

5. Continue making changes, or click OK to save and close the editor.5. 
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Size a Widget
Use the Dashboard Editor to define a Widget's size. Widgets can be:

• Manually sized.

• Auto-sized.

• Explicitly sized.

• Sized the same as other Widgets.

Good to know:

• Hold down the SHIFT key while sizing a Widget to maintain the proper aspect ratio.

• Press the CTRL+ARROW keys to resize a Widget one (1) pixel at a time.

• To resize an Image Widget to be its original size, click the Widget, and then click the Auto-size

button .

• Auto-size is useful for Expression-driven labels because it automatically resizes the label's bounding
box to accommodate dynamic text.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To size a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click a Widget.
3. Size the Widget using one of the following options:

◦ To manually size a Widget, click-and-drag one of the handles (white or black box) to the size
you want.

◦ To auto-size a text Widget to be exactly the right size to hold all its contained text, click the

Auto-size button  on the Dashboard Editor toolbar.

◦ To explicitly size a Widget to a specified pixel height and width, right-click>Position (or press
CTRL+SHIFT+P) to open the Control Position and Size window, then specify the pixel sizes
and click OK.

◦ To size several Widgets to the same width, height, or width and height, select at least two
Widgets (the last selected Widget is the Controlling Widget and is identified by black boxes),

and then click the Make Same Width button , Make Same Height button , or Make

Same Size button  on the Dashboard Editor toolbar.

4. Continue making changes, or click OK to save and close the editor.4. 

CSM 9.3.0 Features 499

CSM 9.3.0 Features



Select a Background, Foreground, and Border
Color for a Widget

By default, defined Theme colors are applied to a Widget when the Widget is added to a Dashboard. You
can manually apply different colors, if needed; however, if you apply non-Theme colors, Widgets will not
change to another Theme color when you apply a different Theme.

Use the Dashboard Editor to manually select background, foreground, and border colors for a Widget.
Colors can come from:

• CSM Theme (Recommended): All colors defined for the selected CSM Theme.

• System: Set of colors provided by your Operating System. System colors can greatly vary
depending on the Operating System and browser used to view the color.

• Web: Set of named Web-safe colors.

• Custom RGB colors: Customized Red, Green, Blue (RGB) colors.

Good to know:

• Dashboard Theme colors are defined as part of a Theme's definition. Use the Theme Manager to
create a Theme.

• Each Theme property is named and intended for a specific element on a Dashboard, Form, or
Portal. When the element is added, the item's defined colors, styles, and fonts are applied by default
(ex: Form Control colors, border style, and fonts are automatically applied to a Control when the
Control is added to a Form). Manually apply a different color or style to most elements, if needed.
For example, it is possible to use Form Background Color 1 for text. The key is to use Theme colors,
and to apply colors and styles consistently. If a non-Theme color (ex: System, Web, or RGB) is
applied, the element does not change to another Theme color when applying a different Theme.

• Chart, Gauge, and Matrix Widgets can have their own colors and styles and can be defined to
override Theme colors.

• Image, Button, Filter, and Search Widgets do not support backgrounds; therefore, no background
color or style can be applied.

• Image Widgets do not support text, background, foreground, or border colors; therefore no colors,
styles, or fonts can be applied.

• By default, Text Gauge Widgets have a transparent background. To manually add a background,
right-click the Widget, select a background style, and then select a background color and border
color.

• Background, Foreground, and Border color options are available on the Dashboard Editor toolbar
and from the context (right-click) menu.

• Colors can be solid or can contain gradients.

• Colors can be transparent.

• Colors can be conditional (Expression-driven): For example, define an Expression to conditionally
change the background color of a Widget to red to indicate a surpassed threshold (ex: Open
Incidents surpassed 100 count threshold).
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• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To select a background, foreground, or border color for a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click one or more Widgets.

3. On the Dashboard Editor toolbar, click the drop-down arrow on the Background Color button

, the Foreground Color button , or the Border color button .

Tip: Click the button itself to use the most recently used color (assuming you have set a color).

4. Select a color pattern:
◦ Solid color: Uses one color (First Color) for the background. Click a color in the list.

◦ Gradient (left-to-right or top-to-bottom): Uses a gradient between two colors (First Color and
Second Color). Click two colors in the list, and then click Select.

5. Select a color, either:
◦ Use Expression: Select this check box to use an Expression to conditionally change the color.

Then, define the condition, using either:
◦ Custom Expression: Click the Custom Expression button to open the Custom

Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Select a color category:
◦ Theme (Recommended): All colors defined for the selected CSM Theme.

◦ System: Set of colors provided by your Operating System. System colors can greatly
vary depending on the Operating System and browser used to view the color.

◦ Web: Set of named Web-safe colors.

◦ Custom: Customized Red, Green, Blue (RGB) colors.

6. Continue making changes, or click OK to save and close the editor.6. 
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Select a Background Style and Gloss for a Widget
Use the Dashboard Editor context menu (right-click) menu to select a background style/gloss for any
Widget that has a background. Options include:

• Square background.

• Rounded Corner background.

• Tab background.

• Rounded Tab background.

• Ellipse background.

• No background.

• Gloss: Adds a slightly glowing and reflective background to the Widget.

Good to know:

• Image Widgets do not have a background.

• If a Widget is set to No background, style and gloss cannot be seen.

• Widgets with transparent components (ex: Shapes, pipeline charts, text, etc.) show a gloss very
clearly. Gloss on Widgets whose content covers most of the Widget is not as noticeable.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To select a background style and gloss for a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click one or more Widgets.

3. Right-click>style, and then select a style for the background. Options include:
◦ Square background.

◦ Rounded Corner background.

◦ Tab background.

◦ Rounded Tab background.

◦ Ellipse background.

◦ No background.

4. Right-click>Glossy to add a slightly glowing and reflective background to the Widget.

5. Continue making changes, or click OK to save and close the editor.5. 
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Select a Border Style for a Widget
Use the Dashboard Editor to select a border style for a Widget. Border style options include:

• No Border

• 3D Border

• 1, 2, 3 and 4 pixel width

Good to know:

• Border style options are available on the Dashboard Editor toolbar and from the context (right-click
menu).

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To select a border style for a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click one or more Widgets.

3. On the Dashboard Editor toolbar, click the drop-down arrow on the Border Style button, and then
select a style from the following:

◦ No Border: No border is added.

◦ 3D Border: Adds a three dimensional border around the Widget.

◦ Pixel Width: Adds a fixed pixel width border around the Widget.

4. Continue making changes, or click OK to save and close the editor.4. 
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Add an Image to a Widget
Use the Dashboard Editor to add an image to a Widget. Images can be:

• Imported: Any image stored in the Image Manager.

• Stored Values: Images used as Stored Values (ex: Company logo).

• Conditional (Expression-driven): For example, define an Expression to conditionally display a
warning icon to indicate a surpassed threshold (ex: Open Incidents surpassed 100 count threshold).

• None: Widget does not use an image.

• Aligned: To the Top/middle/bottom and left/right/center of the Widget.

Good to know:

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To add an image to a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click a Widget.

3. On the Dashboard Editor toolbar, click the drop-down arrow on the Image button , and then
select one of the following options:

◦ Browse: Opens the Image Manager, where you can select an existing image or import a new
image to display on the Widget.

◦ From Stored Value: Opens the Stored Value Manager, where you can select an existing
Stored Value or create a new Stored Value to use for the image.

◦ Custom Expression: Opens the Custom Expression Builder, where you can create a custom
Expression to use only for this scenario.

◦ Expression Manager: Opens the Expression Manager, where you can select an existing
Expression or create a new stored Expression to use. Stored Expressions can be reused in
numerous places in CSM.

◦ None: Does not use an image.

4. Align the image:
a. Click the drop-down arrow on the Image button, select Image Alignment, and then select an

alignment option within the Widget (ex: Top-right).

5. Continue making changes, or click OK to save and close the editor.5. 
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Align a Widget
Use the Dashboard Editor to align Widgets on a Dashboard. Widgets can be aligned:

• To the Dashboard grid.

• To each other.

Good to know:

• Use Snap to Grid and Snap to Guide to precisely align Widgets. Press SHIFT+DRAG to ignore grid
and guide snapping.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To align a Widget on a Dashboard:

1. Open a Dashboard in the Dashboard Editor.

2. Click a Widget.

3. Click the Snap to Grid button  to enable grid snapping, and then drag the Widget around the
grid to precisely align it to the grid points.

To align a Widget to other Widgets:

1. Open a Dashboard in the Dashboard Editor

2. Select at least two Widgets (the last selected Widget is the controlling Widget and is identified by
black boxes).

3. Do one of the following:
◦ To align several Widgets against a horizontal axis (either Left, Middle, or Right), click one of

the Line Up Horizontally buttons  on the Dashboard Editor toolbar.

◦ To align several Widgets against a vertical axis (either Top, Middle, or Bottom), click one of the

Line Up Vertically buttons  on the Dashboard Editor toolbar.

◦ To enable guide snapping, click the Snap to Guide button  on the Dashboard Editor
toolbar, and then drag the Widget near other items to precisely align it.

◦ To explicitly position a Widget to a specified location, right-click>Position (or press
CTRL+SHIFT+P) to open the Control Position and Size window, then specify the Left and Top
location and click OK.

4. Continue making changes, or click OK to save and close the editor.4. 
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Anchor a Widget
Anchoring allows you to make your Dashboard Widgets grow or shrink to use available space. When you
select anchoring options, you select which sides of the Dashboard the Widget should be anchored to (you
can use combinations). Options include:

• Left: Widget keeps the same distance to the Left edge and moves further away from the Right edge
when the Dashboard gets bigger.

• Top: Widget keeps the same distance to the Top edge and moves further away from the Bottom
edge when the Dashboard gets bigger.

• Right: Widget keeps the same distance to the Right edge and moves further away from the Left
edge when the Dashboard gets bigger.

• Bottom: Widget keeps the same distance to the Bottom edge and moves further away from the Top
edge when the Dashboard gets bigger.

• Left AND Right: Distance between both horizontal edges remains the same, and the Widget
stretches to fill the horizontal space when the Dashboard gets bigger.

• Top AND Bottom: Distance between both vertical edges remains the same, and the Widget
stretches to fill the vertical space when the Dashboard gets bigger.

• All (Left, Right, Top, and Bottom): Distance between all edges remains the same and the Widget
proportionally stretches to fill both the horizontal and vertical space when the Dashboard gets
bigger.

Good to know:

• Top Left is the default.

• If the Widget is not anchored to any edge, it floats between the two edges.

• Anchoring options are available on the Dashboard Editor toolbar and from the context (right-click)
menu.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To anchor a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click a Widget.

3. On the Dashboard Editor toolbar, click the drop-down arrow on the Anchoring button .

4. Select an anchoring option (you can use combinations; Top Left is the default):

5. Click the Select button to save your changes. If you do not click Select, your changes are
abandoned.

6. Continue making changes, or click OK to save and close the editor.6. 
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Layer a Widget
Use the Dashboard Editor to layer Widgets (that is, position a Widget in front of or behind other Widgets).

Good to know:

• Layering options are available from the Dashboard Editor toolbar and from the context (right-click)
menu.

• Not all Widgets are allowed to be in front of or behind all other Widgets (ex: Most Shapes cannot be
on top of most graphical Widgets, such as Charts and Gauges).

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To layer a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Select one or more Widgets.

3. To position a Widget in front of other Widgets, click the Widget, and then click the Bring to Front

button  on the Dashboard Editor toolbar.

4. To position a Widget behind other Widgets, click the Widget, and then click the Send to Back

button  on the Dashboard Editor toolbar..

5. Continue making changes, or click OK to save and close the editor.5. 
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Define Visibility for a Widget
Use the Dashboard Editor to define when to display or hide a Widget (Visibility). For example, display an
SLA Widget on a Dashboard. When an SLA is in jeopardy of being breached, display a warning message
(expression-driven visibility). By default, a Widget is always visible, unless defined (through an
Expression) to be hidden.

Good to know:

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

To define visibility for a Widget:

1. Open a Dashboard in the Dashboard Editor

2. Click a Widget.

3. Click the drop-down arrow on the Visibility button , and then select one of the following
options:

◦ Custom Expression: Select this option to open the Custom Expression Builder, and then
create a custom Expression to use only for this scenario.

◦ Expression Manager: Select this option to open the Expression Manager, and then select an
existing stored Expression or create a new stored Expression to use. Stored Expressions can
be reused in numerous places in CSM.

◦ Clear Visibility Expression: Clears any visibility Expression so that the Widget is always visible.

4. Continue making changes, or click OK to save and close the editor.4. 
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Dashboard Properties
Reference the descriptions for the general, display, filter, and refresh properties for Dashboards.

General Properties

Property Description Notes

Name The name of the
Dashboard

Required

This property can be searched in CSM Item Managers

Description The description of the
Dashboard

Optional

This property can be searched in CSM Item Managers

Title Text The title of the Dashboard
that appears in the UI Optional

Associate The Major Business Object
association

Default value: (None)

Associate the Dashboard with a particular Major Business
Object to take advantage of Business Object functionality.

For example, create an Incident Dashboard that is
associated with the Incident Business Object. When you
open this Dashboard, the Quick Search pane automatically
switches to searching Incidents, and the main New button
option defaults to creating a new Incident.

Display Options

Property Description Notes

Theme
The Theme (set of colors, styles, and fonts)
to be used by the different elements
(including Widgets) on the Dashboard

Default value: (None)

Allow User's
chosen Theme to
override
Dashboard Theme

The option to apply the User's Theme to the
Dashboard when it is viewed from the
User's account

Default value: True

Minimum width The minimum width in device-independent
pixels

Default value: 0

If a Dashboard is sized below this
value, a horizontal scroll bar will
appear

Minimum height The minimum height in device-independent
pixels

Default value: 0

If a Dashboard is sized below this
value, a vertical scroll bar will
appear
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Filter Options

Property Description Notes

Initial filter criteria are
the last used criteria

The option to display all Widgets using the Dashboard's last
filtering criteria (in other words, "remember" the last used filter
and automatically display it the next time the Dashboard is
viewed, even between sessions)

Default
option

Initial filter criteria are
the widget default
criteria

The option to display each Widget using the Widget's defined
filtering criteria (either its own filtering criteria or a Dashboard's
criteria)

Refresh Options

Property Description Notes

Refresh reloads all
metrics

The option to reload the current
Metric value every time the
Dashboard is refreshed

Default value: False

If not selected, each Metric is refreshed
according to its own refresh rate.

Refresh all widgets
every: X minutes

The option to refresh all Widgets on
a scheduled basis

Default value: False

When enabled, the default refresh time is 0
minutes.

If not selected, each Widget is refreshed
only according to its own refresh rate.

Also refresh
individual widgets
on their own
schedule

The option to refresh each Widget
according to its defined refresh rate,
in addition to the Dashboard's
refresh rate

Default value: True

This option is activated when Refresh all
widgets every: X minutes is selected.

Additional Options

Property Description Notes

Availability The scope of the Dashboard If you already selected a scope at the beginning,
this is auto-filled with your selection.

Association
The option to select a more
filtered scope (example: a
particular Team)

If not applicable, this option is greyed out.

Custom Image The image to represent the Item
in the UI

Click the Image button to open the Image
Manager, and then select an existing image or
import a new image to represent the item in the UI.
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Configuring Dashboards
Dashboard configuration tasks include setting security rights and selecting default Home Dashboards and
Themes.

To configure Dashboards:

1. Configure Dashboard security rights: Configure who can access Dashboard functionality and data.

2. Configure Dashboard Theme security rights: Configure who can select a Dashboard Theme.

3. Select a default Home Dashboard, HUD, and Dashboard Theme: The default Dashboards (Home
and HUD) and Dashboard Theme are initially selected in CSM Administrator, either Globally or by
Role. Users with security rights can select their own User default Dashboards and Dashboard
Theme in the CSM Desktop Client.
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Select Default Dashboards and Dashboard Themes
Each User has a designated default:

• Home Dashboard: Opens when you first log in or when the Home button  is clicked on the CSM
Desktop toolbar or Browser Client menu bar.

• Heads-Up Display (HUD): Pops up a transparent Dashboard that can be accessed from anywhere
in the application when you press F4.

• Dashboard Theme: Colors, styles, and fonts to give the Dashboard a cohesive look and feel.

The default Dashboards (Home and HUD) and Dashboard Theme are initially selected in CSM
Administrator, either Globally or by Role. If a User has security rights, she can select her own User default
Dashboards and Dashboard Theme in the CSM Desktop Client.
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Select Default Global Dashboards and Dashboard
Themes

Use the System Settings window in CSM Administrator to select a default Global:

• Dashboard.

• Heads-Up Display (HUD).

• Dashboard Theme.

Good to know:

• If a default Role or User Dashboard/HUD is selected, it will override the Global defaults.

• If a User has security rights, she can select her own User default Dashboards and Dashboard
Theme in the CSM Desktop Client.

• Customers have limited options and cannot override defaults in the Portal.• 

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select default Global Dashboards and Dashboard Themes:

1. Open the System Settings window (CSM Administrator>Settings>Edit System Settings).

2. Click the Dashboards, etc. page.
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3. Click the Dashboard button  to the right of the default Dashboard.

The Dashboard Manager opens, where you can select an existing Dashboard or create a new
Dashboard to use as the default.

4. Select a Dashboard to be the default Global Dashboard and default Global HUD. Be sure to select
a Dashboard that everyone can access (Global scope).

5. Select a default Dashboard Theme. Select either:
◦ Dashboard's default Theme: Defined in the Dashboard properties.

◦ Specifically-selected Theme: Theme that you select in the drop-down.

6. Click OK.6. 
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Select Default Role Dashboards and Dashboard
Themes

Use the Role Manager in CSM Administrator to select the default Role:

• Dashboard.

• Dashboard Theme.

• Heads-Up Display (HUD).

Good to know:

• If no default Role Dashboard/HUD is selected, the Global defaults will be used.

• If a User has security rights, she can select her own User default Dashboards and Dashboard
Theme in the CSM Desktop Client.

• Customers have limited options and cannot override defaults in the Portal.• 

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select default Role Dashboards and Dashboard Themes:

1. Open the Role Manager.
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2. Click the Role for which you want to select a default Dashboard.

The Role Profile appears in the Manager window.

3. Select the default Role Dashboard and HUD, either:
◦ Use Default: Select this radio button to use the default Global Dashboard and HUD.
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◦ Dashboard: Select this radio button to use a default Role Dashboard, and then click the
Dashboard button to open the Dashboard Manager to select an existing Dashboard or create
a new Dashboard. Be sure to select a Dashboard that everyone in that Role can access.

4. Select a default Dashboard Theme, either:
◦ Dashboard's default Theme: Defined in the Dashboard properties.

◦ Specifically-selected Theme: Theme that you select in the drop-down.

5. Click Save .
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Select Default User Dashboards and Dashboard
Themes

Use the CSM options window (Dashboards & Calendars page) in the CSM Desktop Client to select a
User default:

• Dashboard.

• Dashboard Theme.

• Heads-Up Display (HUD).

Good to know:

• A User must have security rights to override the Global/Role defaults and select her own default
User default.

• Use the context menu to quickly set a default User Dashboard (right-click>Set as default).

• If a User default is not selected, either the Global or Role default will be used.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default User Dashboards and Dashboard Themes:

1. From the CSM Desktop Client toolbar, click Tools>Options.

2. Click Dashboards & Calendars.
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3. Select a default User Dashboard, either:
◦ Use Default: Select this radio button to use the default Global or Role Dashboard (depends on

which one the system administrator has configured).

◦ Dashboard: Select this radio button to use a default User Dashboard instead of the default
Global/Role Dashboard, and then click the Dashboard button to open the Dashboard
Manager to select an existing Dashboard or create a new Dashboard.

Tip: To make the currently displayed Dashboard the default, right-click the Dashboard
(anywhere where there is not a Widget) and select Set current Dashboard as default.

4. Click OK.4. 
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About the Dashboard Viewer
The Dashboard Viewer is a stand-alone tool that displays a single CSM Dashboard or cycles through a
group of Dashboards (called a Slideshow) without consuming a license.

Use the Dashboard Viewer to:

• View a Dashboard or a Slideshow of multiple Dashboards without consuming a license.

• Project important status data on a large screen or projector without consuming a license.

The following figure shows a Dashboard displayed in the Dashboard Viewer.

By default, the Dashboard Viewer displays the default Home page Dashboard for the User who is logged
in. However, you can configure the viewer to display a different Dashboard or a Slideshow, if needed.

Note: If you drill down to edit data in a Dashboard, the Dashboard Viewer launches CSM, which
requires a license.
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Dashboard Viewer Good to Know
• The Dashboard Viewer is a stand-alone tool that displays a single CSM Dashboard or cycles

through a group of Dashboards (called a Slideshow) without consuming a license.

• Open the Dashboard Viewer by clicking Start > Cherwell Service Management > Tools >
Dashboard Viewer.

• If you drill down to edit data in a Dashboard, the Dashboard Viewer launches CSM, which requires a
license.

• While most Widgets work in the same way as in the application, there are some limitations related to
the Command Palette. Commands that launch other Dashboards will work, but all other commands
will be ignored.
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Using the Dashboard Viewer
When working with the Dashboard Viewer, Users can:

• Open the Dashboard Viewer.

• View a Dashboard or Slideshow in the Dashboard Viewer.
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Dashboard Viewer Window
Use the Dashboard Viewer to complete the following Dashboard operations:

• Configure default options.

• View a Dashboard.

• View multiple Dashboards in a Slideshow.

• Open the Dashboard Manager to create, edit, and delete Dashboards.
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Dashboard Viewer Menu Bar
File

Action Description

Go Home Displays the default Dashboard.

Options Opens the Dashboard Viewer Options window,
where you can configure default options.

Close Closes the Manager.

View

Action Description

Toggle Full-Screen Mode Toggles the window to Full-Screen mode that can be
projected on a larger screen.

Refresh Refreshes the data.

Dashboards

Action Description

Dashboard Manager Opens the Dashboard Manager, where you can
create, edit, and delete Dashboards.

Widget Manager Opens the Widget Manager where you can create,
edit, and delete Widgets.

MRU list Displays the Most Recently Used (MRU) items.

Slideshows

Action Description

Slideshow Manager
Opens the Slideshow Manager, where you can
create, edit, and delete slideshows to display
multiple Dashboards.

Help

Action Description

Help Opens the online help.
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Action Description

Contents Opens the online help.

Report Error Opens the Report Error window so you can report an
error to Cherwell Software.
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Dashboard Viewer Behaviors
• Click File>Go Home to return to the default Dashboard.

• Use the Dashboard MRU menu to display Most Recently Used Dashboards.

• To display the Dashboard Viewer on a large screen, press F11 or click View>Toggle Full-Screen
Mode to go to Full-Screen Mode. In Full-Screen Mode, the application takes up the entire screen,
and the menu bar is temporarily hidden so that only the Dashboard is displayed. Hover over the
menu bar to display it again.

• The Widget Manager and Dashboard Manager are available from the Dashboard Viewer.

• If Widgets are set to refresh on a schedule, the data will automatically be updated as appropriate.
You can also press F5 or click View>Refresh to force all Widgets on the Dashboard to refresh.
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Open the Dashboard Viewer
To open the Dashboard Viewer:

1. Click Start>Cherwell Service Management>Tools>Dashboard Viewer.

Note: Depending on your system, you might be prompted to select a database connection
and log in.
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View a Dashboard or Slideshow in the Dashboard
Viewer

By default, the Dashboard Viewer displays the default Home page Dashboard for the User who is logged
in. However, you can also manually display a Dashboard or Slideshow, if needed.

Good to know:

• You can also configure the viewer to display a different default Dashboard or a Slideshow, if needed

To view a Dashboard or Slideshow in the Dashboard Viewer:

1. To view a Dashboard, click Dashboards>Dashboard Manager, then double-click the Dashboard
to display.

2. To view a Slideshow, click Slideshows>Slideshow Manager, then double-click the Slideshow to
display.
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Configuring the Dashboard Viewer
Complete the following procedures to configure the Dashboard Viewer.

To configure the Dashboard Viewer:

1. Configure Dashboard security rights: Configure who can access Dashboard functionality and data
(including Dashboards, Slideshows, etc.).

2. Define Dashboard Viewer options: Define a default Dashboard/Slideshow and drill-down options.
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Define Dashboard Viewer Options
Use the Dashboard Viewer Options window (accessed from within the Dashboard Viewer) to define the
following:

• Dashboard to Show: Default Dashboard to display when the Dashboard Viewer is opened. You can
select the default Home Dashboard, a specific Dashboard, or a Slideshow.

• Allow Drill-Down: Whether or not to allow Users to drill-down on a Dashboard from within the
Dashboard Viewer (either by clicking a record or double-clicking a Widget). Drill-down does
consume a license.

To Define Dashboard Viewer: Options

1. Open the Dashboard Viewer

2. From the Dashboard Viewer menu bar, click File>Options.

3. Select the default Dashboard to display when the Dashboard Viewer starts:
◦ Home Dashboard: Select this radio button to display the default Dashboard for the currently

logged-in User.

◦ Dashboard: Select this radio button to display an alternative Dashboard. Click the Dashboard
button to open the Dashboard Manager, and then select an existing Dashboard or create a
new Dashboard.

◦ Slideshow: Select this radio button to display a Dashboard Slideshow. Click the Slideshow

button  to open the Slideshow Manager, and then select an existing Slideshow or create a
new Slideshow.

4. Allow drill-down: Select this check box to allow Users to drill down into data on a Dashboard (either
by clicking a record or double-clicking a Widget). When a User drills down, the Dashboard Viewer
launches CSM, automatically logs in the User, and consumes a license.

5. Click OK.5. 
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About Dashboard Slideshows
A Slideshow is a series of Dashboards that displays on a defined cycle. Use a Slideshow to cycle through:

• Company Dashboards.

• Team Dashboards.

• Executive Dashboards.

Slideshow behaviors include the following:

• The Dashboard Viewer cycles through a list of selected Dashboards. When the last Dashboard is
reached, the viewer returns to the first.

• The Time to display each Dashboard controls the amount of time before the next Dashboard is
loaded. The time can be set in hours, minutes or seconds, with 5 seconds the minimum amount of
time between Dashboards.

• When a Slideshow has been created, it can be selected from the Slideshow Manager, or simply
from the MRU (Most Recently Used) list of recently accessed slideshows. You can also specify a
Slideshow to be launched on startup via File>Options.

CSM provides an OOTB Slideshow. Use this Slideshow as is, edit it, or create your own using the
Slideshow Manager.
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Slideshow Manager
Use the Slideshow Manager to complete general CSM Item Manager operations for Slideshows.

The Slideshow Manager is opened from within the Dashboard Viewer.
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Open the Slideshow Manager
To open the Slideshow Manager:

1. From the Windows Start screen, open the Apps screen.

2. In the Cherwell Service Management section, click Dashboard Viewer.
3. From the Dashboard Viewer menu bar, click Slideshows>Slideshow Manager.
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Create a Slideshow
Use the Slideshow properties window (accessed from within the Slideshow Manager) to create a
Slideshow. When you create a Slideshow, you define:

• General properties: Name and description.

• Time to Display Each Dashboard: In hours, minutes, or seconds.

• Dashboards: List of Dashboards to cycle through.

Note: The Slideshow Manager is accessed from within the Dashboard Viewer.

Good to know:

• After a Slideshow is created, it can be run from the Slideshow Manager or from the MRU list of
recently accessed Slideshows.

• You can also specify a default Slideshow to be opened on startup via File>Options.

To create a Slideshow:

1. Open the Slideshow Manager

2. Select a scope and subfolder (if needed).

3. Click the Create New button .
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4. Define general properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

5. Select the Dashboards to include in the Slideshow:
a. Add button: Click this button to add a Dashboard (one at a time). The Dashboard Manager

opens, where you can select an existing Dashboard or create a new Dashboard.

b. Time to Display Each Dashboard: Specify the amount of time (in hours, minutes, or seconds)
to display each Dashboard. Five (5) seconds is the minimum.

c. Up/Down arrows: Use to define the order of the Dashboards in the Slideshow. When the last
Dashboard is displayed, the Dashboard Viewer returns to the first.
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Tip: Click the Remove button to remove the selected Dashboard from the Slideshow.

6. Click OK.6. 
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Document Repositories
A CSM Document Repository is a collection of documents (Attachments) that is used to organize
information. One or more Document Repositories can be used on a Portal Site (example: A Document
Repository for support documents and another for product documents). Display a Document Repository
as a Portal Startup Item or add an Action to a Site menu bar to display a Document Repository.
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About Document Repositories
Use a Document Repository to store items such as public documents, troubleshooting documents, or as
an HR forms repository.

Users can populate and manipulate the contents of a Document Repository via the Attachment Manager
in the CSM Desktop Client, as well as import files directly to the Document Repository in the Portal using
the Import button.

Customers can open documents, upload new documents, edit comments, or replace existing documents
depending on their security rights.

CSM provides an OOTB Document Repository for use in the Portal. However, the Document Repository
must be added to the Portal menu bar in CSM Administrator before Customers can access it. Use this
OOTB Document Repository as-is, edit it, or create new Repositories using the Document Repository
Manager. Then, use the Attachment Manager in the CSM Desktop Client to add documents to the
Repository.

CSM 9.3.0 Features 538

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=define_menu_bar_properties_for_a_portal_site


Document Repositories Good to Know

• A Document Repository is typically identified by the Document Repository icon .

• One or more Document Repositories can be used on a Portal Site (example: Have one for Support
documents and another for Product documents).

• Pin Document Repositories to a Pinboard (in the Document Repository Manager) and MRU list (in
the CSM Desktop Client menu bar) to make them easily accessible in CSM.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure Document Repository Security Rights.
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Using Document Repositories
When working with Document Repositories, Users can:

• View a Document Repository.

• Open a Document in the Document Repository.
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View a Document Repository
A Document Repository can be viewed several ways:

• Available Document Repositories (based on security rights): Use the Document Repository
Manager.

• From the Portal menu bar (if configured).

• From the Attachment Manager.
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Managing Document Repositories
Document Repositories are managed using the Document Repository Manager.

There are several ways to open the Document Repository Manager.

Use the Document Repository Manager to complete general CSM Item Manager operations for Document
Repositories, including:

• View a Document Repository.

• Create a Document Repository.

• Add a Document (Attachment) to a Document Repository.

• Edit a Document Repository.

• Delete a Document Repository.

• Search for a Document Repository.

• Organize Document Repositories.

• Copy a Document Repository.

• Import/export a Document Repository.

• Find Document Repository dependencies.

• Pin a Document Repository.
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Open the Document Repository Manager
To open the Document Repository Manager:

• From the Attachment Manager in the CSM Desktop Client, click Attachments>Document
Repositories... in the menu bar.

• From the CSM Administrator main window, click the Browser and Mobile category, and then click
the Document Repository Manager task.

• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Document Repository
Manager.

• From within the Site Manager in CSM Administrator.
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Create a Document Repository
Use the Document Repository window, accessed from within the Document Repository Manager, to
create a Document Repository.

To create a Document Repository:

1. Open the Document Repository Manager.

2. Click the Create New button.

3. Define the properties for the Document Repository:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Title:

Provide a title to display to Users.

c. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

4. Click OK.4. 

Note: After you create a repository, use the Attachment Manager to add documents to the
repository.
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Add a Document (Attachment) to a Document
Repository

To add a document (Attachment) to a Document Repository:

1. Open the Document Repository Manager.

2. The Manager lists the existing Document Repositories.2. 

3. Select a Document Repository to populate with documents.

4. Click Options>Attachment Manager.

The Attachment Manager opens, listing the available attachments.

5. Select/create Attachments.

6. Click OK.6. 
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Configuring Document Repositories
Configuration procedures are completed in CSM Administrator.

1. Configure Document Repository Items Security Rights.

2. Configure Document Repository Manager Security Rights.
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E-mail
CSM supports sending and receiving e-mail in several different formats (POP3/SMTP, IMAP/SMTP, and
Microsoft® Exchange).
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About CSM E-mail
CSM E-mail consists of several features:

• E-mail accounts and settings: CSM E-mail Accounts enable Users to send e-mail messages directly
from the CSM Desktop Client, Browser Client, or Portal. Automatic e-mails can also be sent from
back-end Automation Processes (example: Using One-Steps). E-mail accounts can be monitored
using the Cherwell E-mail and Event Monitor.

• E-mail and Event Monitor: The Cherwell E-mail and Event Monitor Server is a CSM service that
automatically monitors e-mail accounts and event streams, and then performs specified actions,
such as creating or modifying records based on e-mail content or event details. In addition to
connecting to the database server, it connect to the mail server (example: Microsoft Exchange).

• Outlook® Add-In: The CSM Outlook® Add-In is a CSM client that enables you to interact with CSM
Business Object Records directly from within Microsoft® Outlook®.

Use this system as-is or tailor it to meet the needs of the organization. Design ideas include:

• Edit existing e-mail templates.

• Personalize (or create) notification e-mails.

• Personalize (or create) confirmation e-mails.

• Create a new E-mail Monitor with custom Monitor Items.

• Integrate with Microsoft Outlook®.
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The primary goal of the various CSM e-mail features is to keep a record of all important communication
between stakeholders. Using Incident as an example:

• When an e-mail is sent from within CSM using a configured e-mail account, the e-mail is optionally
associated with the current Incident and the Customer being supported. In addition, a Conversation
ID is included in the message to track the e-mail conversation and associate replies with the
appropriate records. This can be done when the e-mail is sent manually, via a One-Step, or from an
Automation Process.

• When the Customer responds by sending an e-mail to an account monitored by the E-mail and
Event Monitor, the e-mail is automatically associated with the same Incident and Customer. If sent
directly to the technician, the technician can forward it to a monitored account for automatic
processing, or associate it directly using the Outlook Add-In. Once received by the E-mail and Event
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Monitor, additional actions can also automatically be triggered (example: Adding the record to a
CSM Queue).

• The Outlook Add-In can track e-mail correspondence from Microsoft Outlook and interact directly
with CSM Records. With the Add-In, automatically link incoming e-mails to records, execute Actions
against records, and capture e-mail history.
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CSM E-mail Good to Know
• Conversation IDs are the most reliable way CSM uses to ensure that e-mails are associated with the

correct records. For this reason, it is important not to delete Conversation IDs from e-mail
messages.

◦ When Users set up a CSM e-mail account or configure the Outlook® Integration, Users can
choose to have Conversation IDs inserted into outgoing e-mail messages.

◦ When a monitored account receives a reply to this e-mail, the E-mail and Event Monitor can
use the Conversation ID to associate the e-mail with the appropriate record.

◦ If using the Outlook® Add-In, it also uses Conversation IDs to associate e-mails with records.

E-mail Accounts

• The e-mail message window can be resized and the size persists the next time the messaging
system is opened.

• Create and use e-mail templates when a Send an E-mail Action is added to a One-Step or
Automation Process. The e-mail template allows Users to insert standard text, Expressions, system
functions, and variables.

• E-mail accounts enable Users to send e-mail messages directly from within the CSM Desktop Client
or Browser Client.

• Global e-mail accounts are accessed and configured from the E-mail and Event Monitoring category
in CSM Administrator (click Edit E-mail Accounts and Settings).

• Global e-mail accounts can be used to:
◦ Send e-mails from within CSM (with E-mail security rights).

◦ Monitor incoming e-mails using an E-mail Monitor.

◦ Set up multiple global e-mail accounts in CSM Administrator.

• Personal e-mail accounts are accessed and configured from the E-mail Options window in the CSM
Desktop Client (Tools>Options>E-mail page).

◦ Personal e-mail accounts can be used to send e-mail from the CSM Desktop Client or Browser
Client.

• The e-mail options defined when a global e-mail account is configured are set as defaults. Users
can customize the defaults with their own personal e-mail settings (if they have security rights).

• Track e-mail correspondence in Journal - Mail History Records.

• The options for sending e-mail from the Portal vary depending on how the administrator configured
the Portal Actions.

• The ability to access the Address Book is determined by E-mail security rights.

• If a Team or Workgroup is selected as a recipient, the name of the Team or Workgroup is shown on
the To, Cc, or Bcc line with the appropriate prefix (example: Team: 1st Level Support). Teams and
Workgroups are created and configured in CSM Administrator (Security>Edit Teams and
Workgroups). When a Team or Workgroup is created or edited, administrators can also select how
e-mails are sent to Teams or Workgroups. For more information, refer to the Teams and Workgroups
Documentation.
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• To intermingle regular addresses with Teams and Workgroups, separate the entries with semicolons
(example: Team: 1st Level Support; firstname.lastname@company.com).

• A Team or Workgroup cannot be selected as a From Address.
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CSM E-mail Features
CSM E-mail consists of:

• E-mail accounts and settings

• E-mail and Event Monitor

• Outlook Add-In
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About CSM E-mail Accounts
E-mail accounts enable Users to send e-mail messages directly from within CSM using the E-mail
Message window. When sending e-mails:

• Select e-mail recipients from the CSM Address Book.

• Add an attachment to an e-mail.

• Define where to store e-mail history to capture and track e-mail correspondence in Journals.

E-mails can be sent from either a global account (configured by an administrator) or a personal e-mail
account (configured by Users in CSM). Users with E-mail security rights can personalize and use a global
e-mail account. Users can also configure a personal account for special circumstances, such as sending
e-mail from home or an off-site location.

CSM supports the following types of e-mail accounts for both global and personal accounts:

• POP/SMTP (or POP3): A simple and very common mail server format for incoming e-mail.

• IMAP/SMTP (or IMAP4): A more advanced mail protocol than POP and is generally considered
more secure and has additional options for dealing with server-based mail. However, fewer mail
services provide IMAP support.

• Microsoft® Exchange: The Exchange Server handles both incoming and outgoing e-mails. See the
System Requirements for supported versions.

When an e-mail account (either global or personal) is set up, it can also be used in several ways to send
e-mail from various locations or to automate e-mails:

• Create a One-Step with a Send an E-mail Action.

• Add an E-mail Action to toolbars, Menu bars, Dashboards, Action Catalogs, Task Pane, etc.

• Add an E-mail One-Step or Action to an Automation Process.

• Use the E-mail and Event Monitor to monitor an e-mail account (example: Set up a monitor to
automatically create Incident Records from e-mails received in the monitored account).
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Using E-mail Accounts
When working with e-mail accounts, Users can:

• Send e-mail messages from within CSM using the E-mail Message window.
◦ Select e-mail recipients from the CSM Address Book.

◦ Add an attachment to an e-mail.

◦ Define where to store e-mail history.

• Track e-mail correspondence in Journals.
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E-mail Message Window
Use the E-mail Message window to send e-mails from within CSM.

The following figure shows the E-mail Message window in the Desktop Client. The window looks slightly
different in the CSM Web applications because the window has less options in the toolbar, and the Bcc
line is not available.

1. E-mail Recipients: Provide e-mail addresses in the recipient lines, or select recipients from the
CSM Address Book.

2. E-mail Message: Compose and format e-mail messages.

3. E-mail History Attachment Options: Define which records the e-mail is attached to as a Journal -
Mail History Record.
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Send an E-mail from within CSM
Use the E-mail Message window to create and send e-mails directly from within CSM.

To send e-mails, an e-mail account must be set up. Users who have E-mail security rights can personalize
and use a global e-mail account (configured by an administrator) to send e-mails. Also configure a
personal account for special circumstances, such as sending e-mail from home or an off-site location.

To send an e-mail:

1. In the CSM Desktop Client, click File>Send E-mail to send an e-mail from anywhere in the system
(Users select the recipients).

2. Click File>E-mail Current Customer to send an e-mail from a Business Object Record to a
Customer (the recipient is the active Customer on the record).

Note: If CSM cannot find a Customer's e-mail address, it returns an error message:
Customer e-mail address was not found. Ensure the e-mail from a record that has an active
Customer is being sent. If it does and an error is still received, see an administrator.

3. In the Send Via drop-down, select the e-mail account to send the message from.

Note: This is automatically set to the default e-mail account. The default account is set in
CSM Administrator, or by the User if the User has security rights.

4. Select a From Address. If this is not visible and you want to make a selection, click the control
visible fields drop-down  and select From Field.

Note: This is automatically set to the default From Address defined for the account used to
send the e-mail. If using a global e-mail account, the From Settings were defined by an
administrator when configuring global e-mail accounts. Users who have E-mail security
rights can customize the options for From Addresses in a global e-mail account.. If the User
is using a personal e-mail account, the options for From Addresses are defined when
configuring the account.

◦ If the system administrator configured more than one From Address, select one in the drop-
down on the From line.

◦ If allowed to enter an arbitrary From Address, provide an address in the From line or click the
From button to open the Address Book and select an address.

Note: The e-mail system might reject e-mails from arbitrary addresses.

5. Click the To, Cc, or Bcc button to open the Address Book and select e-mail recipients. The Bcc line
is only available in the Desktop Client.

◦ E-mail Current Customer: If selected and CSM can identify a Customer's e-mail address from
the current page (example: From an Incident Record), then the To line is automatically
populated with that address.
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◦ E-mail all members of a Team: Select the Team from the Address Book or provide team:name,
where name is the name of the Team, or Customer Workgroup by typing workgroup:name.

6. Provide a Subject for the e-mail.

7. Compose the message and format it using the E-mail Message toolbars.

8. Select Attachment Options for attaching files, links, etc. to e-mails.

9. Customize where to store e-mail history.

10. Click Send.

If the Esc key is pressed at any point during the message creation, an e-mail message opens. Click OK to
abandon and delete the message.
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Select E-mail Recipients from the CSM Address
Book

Use the CSM Address Book to search for specific names, find names contained in Customer Objects and
groups, or select entire Teams or Workgroups as recipients.

To select e-mail recipients using the Address Book:

1. Click the To, Cc, or Bcc button in the E-mail Message window.

2. Select how to search for names in the Address Book, either:
a. Provide Name or Select from List: Provide a name and click Go to search for a specific name

in the Address Book.

b. Show Names From: Select a Customer Object or group in the drop-down to select recipients
from a list of names contained in the Customer Object or group. The drop-down includes:

◦ Objects containing Customer or User data (example: Customer Group Object, Customer
- Internal Major Object, and UserInfo Lookup Table). For more information, see Business
Objects.

◦ Teams

◦ Workgroups

3. Select a name from the list.

4. Click the line where it should appear on (To, Cc, or Bcc).

5. Click OK.5. 

The selected names are displayed in the E-mail Message window.

6. Send the e-mail.
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Add an Attachment to an E-mail
Use the Attach button on the E-mail Message toolbar to attach files, links, etc. to e-mails sent from within
CSM.

To add an Attachment to an e-mail:

1. In the E-mail Message window, click the arrow next to the Attachments button.

2. Select attachments to add to the e-mail message and send the e-mail.

From
Records

Open the Define Rules for Attachments window and select criteria that defines which
attachments to include in the e-mail. This is useful if the Action is run against records
that contain multiple attachments.

Note: File Attachment rights control the Attachment operations that can be
performed in CSM.

• All Attachments/Files: Select this radio button to include all Attachments/files from
the selected Business Object/directory.

• First: Select this radio button to include the first defined number of Attachments/
files from the selected Business Object/directory. Then, provide a number or use
the up/down arrows to increase/decrease the number.

• Last: Select this radio button to include the last defined number of Attachments/
files from the selected Business Object/directory. Then, provide a number or use
the up/down arrows to increase/decrease the number.

Note: If First or Last is selected, Attachments/files are sorted in alphabetical order
if they are from a directory, and by the order of appearance on the Business
Object's Attachment Bar if they are from a Business Object.

• Include Attachment/File: Select this check box to include Attachments/files based
on file masks (include Attachments/files that contain certain characters, words, file
extensions, etc.). Then, specify the file masks, using semicolons to separate each
mask.

• Exclude Attachment/File: Select this check box to include Attachments/files based
on file masks (include Attachments/files that contain certain characters, words, file
extensions, etc.). Then, specify the file masks, using semicolons to separate each
mask.

• Minimum Size: Select this check box to include Attachments/files that are of a
minimum defined size. Then, provide a number or use the up/down arrows to
increase/decrease the number. In the drop-down, select kilobyte or megabyte.

• Maximum Size: Select this check box to include Attachments/files that are of a
maximum defined size. Then, provide a number or use the up/down arrows to
increase/decrease the number. In the drop-down, select kilobyte or megabyte.
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From
Current
Record

Add Attachments from the current Business Object Record. It opens a sub-menu that
lists the items attached to the current Business Object Record.

Note: This option is only available if sending an e-mail from a Business Object Record
that contains Attachments.

Attachment
Manager

Add Attachments from the Attachment Manager.

Note: This option is only available in the Desktop Client.

Browse Add files from a computer as attachments.
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Define Where to Store E-mail History
Use the e-mail history attachment options in the E-mail Message window to define which Business Object
Records to attach an e-mail to as a Journal - Mail History Record after it is sent. Attach e-mails to:

• Business Objects (example: Incidents).

• Customer Records that CSM identifies from the e-mail addresses of the recipients.

Note: If using a global e-mail account to send an e-mail, it has default e-mail history
attachment options configured. Use the defaults or override them using the e-mail history
attachment options in the E-mail Message window. If using a personal e-mail account to
send an e-mail, define the e-mail history attachment options in the E-mail Message window.

To define e-mail history attachment options:

1. Open an E-mail Message window.

2. Select e-mail history attachment options:

Attach to Current
Item

Attach the e-mail to the current record (for example, current Incident, current
Problem, etc.).

Note: This option is only available if there is a current record.

Attach to
Recipients

Attach the e-mail to any of the Customer Records associated with recipients
in the To or Cc lines.

3. Click the Options button to select recipients.

Note: This option is only available when the Attach to Recipients check box is selected.

a. Define Recipient Attachment Options:
◦ Attach to recipients in To line: Select this check box to attach the e-mail to the records

of Customers that CSM can identify from e-mail addresses in the To line.

◦ Attach to recipients in Cc line: Select this check box to attach the e-mail to the records
of Customers that CSM can identify from e-mail addresses in the Cc line.

◦ Attach to recipients in the Bcc line: Select this check box to attach the e-mail to the
Customer Records of the recipients in the Bcc line.

◦ Attach to parents of recipients (for example, company that contact works for):
Select this check box to attach the e-mail to the parent records of recipients (ex. If an e-
mail recipient is a contact that works for a particular company, the e-mail can be attached
to the Company Record as well as the Customer Record).

b. Click OK.b. 

4. Send the e-mail and it is attached to the specified records.
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Track E-mail Correspondence in Journal - Mail
History Records

In the OOTB system, Journal - Mail History records are used to track e-mail correspondence. When
sending an e-mail from within CSM, a Journal - Mail History Record is created from the e-mail and
attached to the current record and/or the Customer associated with the current record.

The record an e-mail is attached to is based on the e-mail history attachment options selected in the E-
mail Message window, or on the default e-mail history attachment options (if using a global e-mail account
to send the e-mail). Any attachments that were added to the e-mail are also attached to records based on
the default e-mail history attachment options.

Note: Tracking e-mail correspondence on Business Objects requires those Business Objects to
have history Relationships and an object designated specifically for Mail History. In the OOTB
system, Change Request, Configuration Item, Customer, Incident, Knowledge Article, and
Problem have a history Relationship with the Journal object and use Journal - Mail History to track
e-mail correspondence. If you create new objects that need to track e-mail correspondence or to
use a different object to track history, you can configure this history relationship. Refer to Define
History Properties for a Business Object for more information.

Note: The Journals might look different than the example. The Journal's appearance is based on
the Grid view and design. For additional information, refer to Grids.

Use the Journal - Mail History to:

• View a list of all e-mails linked to a particular Business Object Record.

• View the contents of each e-mail.

• Reply to or forward e-mails (using the e-mail menu).

When viewing, replying to, or forwarding an e-mail from the Journal - Mail History, the sender and the e-
mail recipients might see a Conversation ID either in the subject line or the body (depending on the

CSM 9.3.0 Features 564

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=define_default_e-mail_history_attachment_options
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fe-mail%2F..%2Fbusiness_objects%2Fdefine_history_properties_for_a_business_object.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fe-mail%2F..%2Fbusiness_objects%2Fdefine_history_properties_for_a_business_object.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fe-mail%2F..%2Fgrids%2Fabout_grids.html


settings configured for the account). CSM uses Conversation IDs to associate e-mails with the
appropriate records. For this reason, it is important not to delete them from e-mails.
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Configure a Personal E-mail Account
Personal e-mail accounts are configured in the E-mail Options window in CSM (Tools>Options>E-mail
page). From here, customize a global e-mail account with personal settings or add a personal e-mail
account for special circumstances such as sending e-mail from home or an off-site location.

Good to know:

• The ability to define personal e-mail settings depends on E-mail security rights. If an e-mail cannot
be added, edited, copied, or deleted or sent, talk to an administrator.

• If an administrator has set up global e-mail accounts and made them available to Users for sending
e-mails, these accounts are listed in the E-mail Options window (E-mail page) in CSM. If E-mail
security rights have been granted, global e-mail accounts can be edited and the default settings
customized with personal settings.

Use the E-mail Options window in CSM to:

• Define Personal POP or IMAP Account Settings

• Define Personal Microsoft Exchange Account Settings

• Define Options for a Personal E-mail Account
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Define Personal POP or IMAP Account Settings
Users who have E-mail security rights can customize and use a global POP or IMAP account (set up in
CSM Administrator), or add their own personal e-mail account to send e-mail.

Defining personal POP or IMAP account settings requires:

• A name for the e-mail account.

• Incoming and outgoing e-mail server information, including:
◦ The location of the mail server.

◦ Security protocol.

◦ Account credentials.

• Options for adding Conversation IDs to outgoing messages.

A Conversation ID is a unique, alphanumeric identifier that correlates an e-mail message with a
particular conversation so that it can be associated with a CSM Record. CSM inserts Conversation
IDs into e-mails to identify if a particular e-mail is a reply to a previous message that was associated
with a specific Business Object record. A Conversation ID looks similar to the following: {CMI:
ABCD1234}, where ABCD is an identifier for the particular CSM system (set this value in the History
Attachment Options for a global e-mail account), and the numeric indicator is the specific
Conversation ID. The number is automatically incremented for each message.

• From Addresses that are allowed for sending e-mails from CSM.

To set up a POP or IMAP account:

Note: The options for a POP or IMAP account are the same. The Ports are different and are listed
in step 6c.

1. From the CSM Desktop Client Menu bar, click Tools>Options.

The CSM Options window opens.

2. Click the E-mail page.

3. Click Add and select POP account or IMAP account.

Tip: Users can also edit or copy an existing account. Click Edit to modify the settings for an existing
e-mail account. Click Copy to copy the settings for an existing e-mail account, then modify them as
necessary.

The E-mail Options window for a POP or IMAP account opens.

4. Click the Incoming Server page.

5. Define general incoming server (POP or IMAP) settings:
a. Name: Provide a name for the account.
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Note: If editing a global e-mail account, the name of the global account appears here. Change
the name if necessary. Changing the name here does not affect the name of the global
account in CSM Administrator.

6. Specify incoming mail server (POP or IMAP) information:

Note: If editing a global e-mail account, the server information for that account appears
here. If the server information needs to be changed (and the User has the correct security
rights), select the Custom Server check box, and define the custom server and security
protocol settings.

a. Incoming Mail Server: Provide the name of the POP or IMAP server.

b. Security: Select a security protocol in the drop-down:
◦ Auto: Select this option to have CSM figure out the best method to use. It selects the

most secure method available in order to prevent transmission of unencrypted User IDs
and passwords, if possible.

◦ Basic: Select this option to have User IDs and passwords passed as plain text

◦ SSL: Select this option to use SSL encryption (a Server Certificate is required).

◦ SSL with No Authentication (IMAP only): Select this option to use SSL encryption only
(no Server Certificate is required).

◦ TLS (IMAP only): Select this option to use the TLS protocol.

Note: The mail server must support the selected security mode.

c. Custom Port: Select this check box to enter a port for the POP or IMAP server that is different
than the default.

Note: For POP servers, the default port is 110 (the SSL port is 995). For IMAP servers, the
default port is 143 (the SSL port is 993).

7. Enter Account Information:

Note: If editing a global e-mail account, the information for that account appears here. If a
change to the account information (and have security rights), select the Custom Account
Information check box, and provide the custom account information.

a. User Name: Provide the user name for the e-mail account.

b. Password: Provide the password for the e-mail account.

c. Mailbox (IMAP only): Select the mailbox (examplw: Inbox) for the drop-down where incoming
mail should be stored.

8. Click the Outgoing Server page.

9. Define general outgoing server settings:
a. Name: If a name is not specified on the Incoming Server page, provide a name for the

account.
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Note: If editing a global e-mail account, the name of the global account appears here. Change
the name if necessary. Changing the name here does not affect the name of the global
account in CSM Administrator.

10. Specify outgoing mail server (SMTP) information:

Note: If editing a global e-mail account, the server information for that account appears
here. If the server information needs to be changed (and the User has security rights), click
the Custom Server check box, and define the custom server and security protocol settings.

a. Outgoing Mail Server (SMTP): Provide the name of the SMTP server.

b. Security: Select a security protocol in the drop-down:
◦ Auto: Select this option to have CSM to figure out the best method to use. It selects the

most secure method available in order to prevent transmission of unencrypted User IDs
and passwords, if possible.

◦ Basic: Select this option to have User IDs and passwords passed as plain text

◦ SSL: Select this option to use SSL encryption (a Server Certificate is required).

◦ TLS: Select this option to use the TLS protocol.

Note: The mail server must support the selected security mode.

c. Custom Port: Select this check box to enter a port for the SMTP server that is different than
the default (default port is 25, SSL port is 465).

11. Specify Account Information:

Note: If editing a global e-mail account, the information for that account appears here. If the
account information needs to be changed (and User has security rights), click the Custom
Account Information check box and provide the custom account information.

a. Requires Authentication: Select this check box if the SMTP server requires authentication, and
select one of the following options:

◦ Use Same Settings as My Incoming Server: Select this radio button if the user name
and password for the SMTP server are the same as the incoming server.

◦ Log on Using: Select this radio button to specify a user name and password that is
different from the incoming server settings, and provide the user name and password.

12. Define Conversation ID options:

Note: If editing a global e-mail account, the Conversation ID options for that account appear
here. If the Conversation ID options need to be changed (and the User has security rights),
select the Custom Conversation ID Settings check box, and define the custom options.

a. Add Conversation IDs to Outgoing Messages: Select this check box to include Conversation
IDs in outgoing e-mails.

Note: When a Conversation ID is found within an e-mail message, CSM can immediately find
the record (ex: Incident) associated with the various e-mails. If Conversation IDs are not used,
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then it can still identify records, but it has to use less reliable techniques, such as comparing
the details of the subject line.

b. Specify where in the e-mail to include the Conversation ID, either:
◦ Add to Subject Line: Select this radio button to include the Conversation ID in the

subject line of outgoing e-mails.

◦ Add to Body: Select this radio button to include the Conversation ID in the body of
outgoing e-mails.

Note: Do not delete Conversation IDs from e-mail messages. Doing so makes it harder
for CSM to associate Customer replies with the correct record.

13. Click the Test Account button to ensure that e-mails can be sent from within CSM using this
account.

A test e-mail is sent to the current User.

Note: All required Incoming and Outgoing Server information must be filled in before testing
the account.

14. Click OK, or click the Options page and specify the From Addresses that are allowed for outgoing
e-mails.

CSM 9.3.0 Features 570

CSM 9.3.0 Features



Define Personal Microsoft Exchange Account
Settings

If a User has E-mail security rights, they can customize and use a global Microsoft Exchange account (set
up in CSM Administrator) or add their own personal e-mail account to send e-mail. Defining personal
Exchange account settings requires:

• A name for the e-mail account.

• Exchange Server information.

• Account credentials.

• Options for adding Conversation IDs to outgoing messages.

A Conversation ID is a unique, alphanumeric identifier that correlates an e-mail message with a
particular conversation so that it can be associated with a CSM Record. CSM inserts Conversation
IDs into e-mails to identify if a particular e-mail is a reply to a previous message that was associated
with a specific Business Object record. A Conversation ID looks similar to the following: {CMI:
ABCD1234}, where ABCD is an identifier for the particular CSM system (set this value in in the
History Attachment Options for a global e-mail account), and the numeric indicator is the specific
Conversation ID. The number is automatically incremented for each message.

• From Addresses that are allowed for sending e-mails from CSM.

To configure a Microsoft Exchange account in CSM:

1. From the CSM Desktop Client Menu bar, click Tools>Options.

The CSM Options window opens.

2. Click the E-mail page.

3. Click Add.
4. Select Exchange account.

Note: To edit or copy an existing account, click Edit to modify the settings for an existing e-
mail account. Click Copy to copy the settings for an existing e-mail account and modify them
as necessary.

The E-mail Options window for an Exchange account opens.

5. Click the Exchange Server page.

6. Define general account information:
a. Name: Provide a name for the Exchange account.

Note: If editing a global e-mail account, the name of the global account appears here. Change
the name if necessary. Changing the name here does not affect the name of the global
account in CSM Administrator.
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7. Define Exchange Server Info:

Note: If editing a global e-mail account, the server information for that account appears
here. To change the server information (and have security rights), select the Custom
Exchange Server check box, and define the custom server and security protocol settings.

a. Exchange Domain: Provide the name of the Exchange Domain.

b. Server (Client Access): Provide the name of the Exchange Client Access Server.

Note: The Client Access Server might not be the same as the primary Exchange Server.
Client Access is the web service used by CSM to talk to Exchange.

c. Use SSL Connection: Select this check box to use SSL encryption for sending and receiving
e-mails.

Note: This is the default for Microsoft Exchange, but if the digital certificate is not appropriately
configured, disable this option.

d. Allow Invalid Server Certificate: Select this check box to allow e-mails to be sent and received
even when the digital certificate is invalid.

Note: This option is not recommended because it can pose a security risk to the Exchange e-
mail system.

8. Provide Account Information:

Note: If editing a global e-mail account, the information for that account appears here. If the
account information needs to be changed (and the User has security rights), select the
Custom Account Information check box and provide the custom account information.

a. User: Provide the User ID for the Exchange account.

b. Password: Provide the password for the Exchange account.

9. Define Conversation ID options:

Note: If editing a global e-mail account, the Conversation ID options for that account appear
here. If the Conversation ID options need to be changed (and the user has security rights),
click the Custom Conversation ID Settings check box and define the custom options.

a. Add Conversation IDs to Outgoing Messages: Select this check box to include Conversation
IDs in outgoing e-mails.

Note: When a Conversation ID is found within an e-mail message, CSM can immediately find
the record (ex: Incident) associated with the various e-mails. If Conversation IDs are not used,
then it can still identify records, but it has to use less reliable techniques, such as comparing
the details of the subject line.

b. Specify where in the e-mail to include the Conversation ID, either:
◦ Add to Subject Line: Select this radio button to include Conversation IDs in the subject

line of outgoing e-mails.

CSM 9.3.0 Features 572

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=configure_e-mail_security_rights
https://help.cherwell.com/csh?topicname=configure_e-mail_security_rights
https://help.cherwell.com/csh?topicname=configure_e-mail_security_rights


◦ Add to Body: Select this radio button to include Conversation IDs in the body of outgoing
e-mails.

Note: Do not delete Conversation IDs from e-mail messages. Doing so makes it harder
for CSM to associate Customer replies with the correct record.

10. Click the Test Account button to ensure that e-mails can be sent from within CSM using this
account.

A test e-mail is sent to the current User.

Note: All required Exchange Server information must be filled in before testing the account.

11. Click OK, or click the Options page and specify the From Addresses that are allowed for outgoing
e-mails.
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Define Options for a Personal E-mail Account
Use the Options page in the E-Mail Options window to define allowed From Addresses for sending e-mail.

To define from addresses for a personal e-mail account:

1. From the CSM Desktop Client Menu bar, click Tools>Options.

The E-mail Options window opens.

2. Click the E-mail page.

3. Select a POP account, IMAP account, or Microsoft Exchange account that is configured.

The E-mail Options window for a POP, IMAP, or Exchange account opens.

4. Click the Options page.

5. Define general account information:
a. Name: Provide a name for the account.

Note: If these options are defined in the settings for POP or IMAP accounts or for Microsoft
Exchange accounts, then they are displayed here.

Note: If editing a global e-mail account, the name of the global account is displayed here.
Change the name if necessary. Changing the name here does not affect the name of the
global account in CSM Administrator.

6. Set up default From Addresses for e-mail messages sent from this account:
◦ Use Account Default From Address: Select this radio button to use the default From

Address for the account.

Note: This option is only available if editing a global e-mail account that has a default From
Address defined.

◦ Use my e-mail address: Select this radio button to use the e-mail address as the From
Address.

Note: If editing a global e-mail account, this option is only available if the account was
configured to allow the User's e-mail address as a valid From Address.

◦ Other: Select this radio button to specify a From Address other than the account default (if
applicable) or a personal account and provide an e-mail address.

Note: If editing a global e-mail account that has a list of Legal From Addresses, click the down
arrow to open a drop-down and select a Legal From Address. If an arbitrary From Address is
allowed for the account, provide an e-mail address that is not in the list.

7. Click OK.7. 
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About the Cherwell Outlook Add-In
The CSM Outlook® Add-In is a CSM client that enables you to interact with CSM Business Object
Records directly from within Microsoft® Outlook®. Use the Add-In to:

• Automatically link incoming e-mails to CSM Business Object Records.

• Quick view or go to CSM Business Object Records.

• Execute Actions (example: One-Steps™) against records.

• Capture and track e-mail correspondence in Journal - Mail History Records.

• Create new records.

• Insert Attachments and links to records into outgoing e-mails.

The Cherwell Outlook Add-In involves a quick installation and minimal setup to integrate with CSM so that
CSM can begin interacting with Business Object Records directly from Outlook. The way the Add-In
behaves, including which Business Objects that can link e-mails to, is determined by an Outlook
Integration Configuration (set up in CSM Administrator).

Note: Using the Cherwell Outlook Add-In consumes one CSM concurrent license. If the Add-In is
installed, the license is taken while Outlook is running. However, if both the Cherwell Outlook Add-
In and the CSM Desktop Client and/or the CSM Browser Client are used, only a single license is
used.
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Outlook Add-In Good to Know
• The CSM Outlook® Add-In is a CSM client that enables you to interact with CSM Business Object

Records directly from within Microsoft® Outlook®.

• Download and use the Cherwell Outlook Add-In from Microsoft Outlook. The interface includes:
◦ A Cherwell group in the Outlook ribbon to configure the Add-In to connect to CSM and scan

incoming e-mails.

◦ An area at the bottom of each Outlook e-mail to interact directly with linked Business Object
Records.

• Use the Outlook Integration Manager to create Outlook Integration Configurations, which determine
how the Add-In behaves and which Business Objects e-mails can be linked to.

• Specify default Integration Configurations for each Role. Defaults define who sees what in the
Outlook Integration (which Roles can see which Outlook Integrations).

• The Cherwell Outlook Add-In consumes one of the CSM concurrent licenses. If the Add-In is
installed, the license is taken while Outlook is running. However, if both the Cherwell Outlook Add-In
and the CSM Desktop Client and/or the CSM Browser Client are used, only a single license is used.

• System is the only available scope. Create subfolders underneath this scope to organize items.• 

• Use the Manager Context (right-click) menu to quickly access menu bar/toolbar options.
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Cherwell Outlook Add-In Interface
The Outlook Add-In interface options appear in both the inbox and when composing an outgoing e-mail.

1. Cherwell group in the Outlook ribbon. From here:
◦ Configure the Add-In to connect to CSM and scan incoming e-mails.

◦ Automatically link incoming e-mails to records if the Add-In can identify a Customer and a
specific Business Object Record.

◦ Link e-mails that already exist in Outlook, click the Rescan Items button to establish links.
When an e-mail is linked to a record, the e-mail is tracked and stored as a Journal - Mail
History Record on the linked record.

2. At the bottom of each e-mail in Outlook, the Add-In interacts directly with linked Business Object
Records.

◦ Open a quick view of the Customer Record or Business Object Record, or go directly to the
records in CSM.

◦ Execute One-Steps against linked records.

◦ If the Add-In cannot identify a Customer from an incoming e-mail, access the CSM Contact
Manager and manually select a Customer; or associate the e-mail with a recipient (someone
on the To or Cc line of the e-mail).

◦ If the Add-In cannot find one specific Business Object Record to link to, it provides a list of the
most recent records associated with the identified Customer. Select a record from this list and
link an e-mail to it.
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3. In outgoing e-mails (new e-mails, replies, or forwards sent from Outlook), insert links to Business
Object Records, add Attachments, and add recipients.
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Tour the Cherwell Outlook Add-In
The Cherwell Outlook Add-In interacts with Business Object Records directly from Microsoft Outlook.
What each User sees in the Add-In is controlled by Outlook Integration Configurations (defined in CSM
Administrator), as well as by the options defined in the Cherwell Outlook Add-In setup.

In the Inbox (or other monitored folder), expand or close the Add-In by clicking the  or  buttons. If
the Add-In cannot automatically find one specific record to link to, it lists the most recent Business Object
Records (potential link items) for Users to select from and manually link e-mails to. If an e-mail is linked
(either automatically or manually) to a specific Business Object Record, the Add-In lists only the
associated record.

When sending (replying to, forwarding, or sending new) e-mails from Outlook, the Add-In provides a
Cherwell Group in the Outlook ribbon with options for inserting links to Business Objects, inserting
Attachments, and choosing additional recipients.

The Cherwell Outlook Add-In has several pieces of functionality:

1. View or change Customer: Click the Customer's name to open a context menu to select from the
following options:

Note: The Customer that appears here is based on the Customer Identification settings
configured for the Outlook Integration Configuration being used. If a Customer cannot be
found, the Customer shows as Unknown. The Customer Object (example: Customer -
Internal) precedes the Customer's name.

◦ Quick View: Opens the Customer Record in a second window to take a quick look at the
details.

◦ Go to Record: Navigates to the Customer Record in CSM.

Note: Users might have to log in to CSM before opening the Customer Record in CSM.

◦ Choose from Cherwell: Opens the CSM Contact Manager to select a different Customer to
associate with the e-mail.

◦ Choose from Current Recipients: Opens another context menu with a list of the names in
the To line of the e-mail. Select one of the names to associate the e-mail with that person.

◦ Remove Customer Association: Unlinks the e-mail from the Customer (changes the
Customer to Unknown).

Note: If any of the options that change or remove the Customer association are selected, the
Business Object Records listed in the Cherwell Outlook Add-In change to show the most
recent records associated with the newly selected Customer.

2. Select Type of Business Object: Click the Business Object drop-down to select the types of
Business Object Records to list.
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Note: If only one type of Business Object is defined in the Outlook Integration Configuration
(Objects page), only that Business Object appears in the drop-down (example: Incident).

3. View or Link a Business Object Record: Click a Business Object Record from the list of most
recent records (potential link items) to view or open the record, or to link the record to the current e-
mail.

Note: The list of recent Business Object Records (potential link items) is based on the
Business Object settings for the Outlook Integration Configuration being used. It only
appears if the Add-In cannot automatically find one specific record to link an e-mail to. Click
More to expand the list of linkable Business Object Records.

4. View Open Business Objects only: Select this check box to filter the list of potential link items to only
show records that have not been closed

5. Create a New <Business Object (example: Incident)>: Click this button to create a new Business
Object Record from the current e-mail.

6. View Associated Business Object Record (if an e-mail has been automatically or manually linked to
a specific record): Click the associated Business Object Record to open a context menu to view
the record, open the record, or unlink the record.

7. Select Actions: Click the Actions drop-down to select the One-Steps that executes against the
associated Business Object Record.

Note: The One-Steps that appear in the drop-down menu are based on the available
Actions configured for the Outlook Integration Configuration being used.
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8. Select Add-In options for outgoing e-mails:
◦ Insert [Business Object Record (example: Incident 101323)]: Inserts a link to open a linked

Business Object Record in the CSM Desktop Client, Portal, or Browser Client.

Note: This option is only available when sending an e-mail that is linked to a specific Business
Object Record.

◦ Add Attachments: Inserts Attachments from the Business Object Record or Attachment
Manager into the e-mail. Select Attachments in the drop-down.

◦ Add Recipients: Opens the CSM Address Book to select recipients to add to the To, Cc, or
Bcc lines.

CSM 9.3.0 Features 582

CSM 9.3.0 Features



Using the Cherwell Outlook Add-In
 3-Minute Video: Using the Outlook Add-In.

To open the Outlook Integration Manager:

1. In the CSM Administrator main window, click E-mail and Event Monitoring category, and then the
Outlook Integration Manager task.

The Outlook Integration Manager opens in a new window.

Note: Outlook Integration security rights control access to Outlook Integration Manager
functionality and data.

When working with the Cherwell Outlook Add-In, Users can:

• Link or Unlink Outlook E-mails to Customers and Business Object Records: Link an e-mail to a
Customer Record or other Business Object Record, or unlink an e-mail from a Business Object
Record.

• Interact with Business Object Records directly from Outlook: Quick view or open Business Object
Records, execute Actions against linked records, or a create a new record from an e-mail.

• Add Links and Attachments to Outgoing E-mails: Insert links to Business Object Records, insert
Attachments, or add recipients to outgoing e-mails.

• Track Outlook E-mail Correspondence in Journal - Mail History Records: View or create Journal -
Mail History Records from e-mails linked to Business Object Records.
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Link Outlook E-mails to Customers and CSM
Business Objects

CSM attempts to auto-link incoming Outlook e-mails to Customers and Business Objects based on the
Outlook Integration settings configured in CSM Administrator. If it cannot identify a Business Object
Record to auto-link an e-mail to, the Add-In lists the most recent records associated with the identified
Customer. Manually link an e-mail to a record by selecting one of the listed records. If the Add-In
automatically links an e-mail to a Customer and/or Business Object, manually change the association.

To link Outlook E-mails to Customers and CSM Business Objects:

1. Select a Customer to link the e-mail to. Do this if the Customer shows as Unknown, or a change is
needed to who the e-mail is associated with.

a. Click Unknown or the Customer's name.

b. From the context menu, click Choose from Cherwell.

The CSM Contact Manager opens.

c. Choose a name from the Contact Manager and click OK.

The e-mail is now linked to the selected contact.

2. Manually link an e-mail to a Business Object Record.
a. In the list of recent records, click the link button next to the record to link the e-mail to.

b. Click Yes on the verification window.

The e-mail is now linked to the selected record, and a Journal - Mail History Record is created
for that record.

3. Unlink a Business Object Record.
a. Click the linked Business Object Record.

b. From the context menu, click Unlink from [Business Object (ex: Incident 101323)].

The Add-In removes the link to the specific record and shows a list of recent records
associated with the identified Customer.
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Interact with CSM Business Object Records from
Outlook

The Cherwell Outlook Add-In allows Users to access and create Business Object Records directly from
Outlook.

To interact with CSM Business Object Records from Outlook:

1. View or Link a Business Object Record: Click a Business Object Record to open a context menu
and select:

◦ Quick View: Opens the Business Object Record in a second window for a quick look at the
details.

◦ Go to Record: Navigates to the Business Object Record in CSM.

Note: Users might have to log into CSM before they can open the Business Object Record in
CSM.

◦ Link to Record: Links the current e-mail to the selected Business Object Record and creates a
Journal - Mail History Record in CSM.

◦ Unlink from Record: Unlinks the current e-mail from the associated Business Object Record,
and then displays a list of potential link items that can be linked to the e-mail instead.

Note: Unlinking an e-mail from a record does not remove the Journal - Mail History
Record from CSM.

2. Execute Actions against a Business Object Record: Click the Actions drop-down to select One-
Steps that can execute against the associated Business Object Record (example: Create Problem
from Incident).

Note: The Actions Menu is only available when an e-mail is linked to a specific Business
Object Record. The One-Steps that appear in the drop-down are based on the available
Actions configured in CSM Administrator.

3. Create a Business Object Record:
a. Click the New Business Object button (example: Incident).

A Quick View of a new Business Object Record (example: Incident) opens, with the
Description Field populated with the body of the e-mail.
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b. Complete the form with any remaining details (example: Classification), if applicable.

c. Save and close the record.

The record now exists within CSM and can be linked to other e-mails.
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Add Links and Attachments to Outgoing E-mails
The Cherwell Outlook Add-In provides several options when sending (replying to, forwarding, or sending
new) e-mail from Outlook. The Cherwell group in the ribbon (Message tab) allows Users to insert links to
Business Object Records, insert Attachments, and select additional recipients.

The available options are:

1. Insert [Business Object Record (example: Incident 101323)]: Inserts a link to open the Business
Object Record in the CSM Desktop Client, Portal, or Browser Client. Choose any (or all) of the
following options in the drop-down:

a. Link to Cherwell Application: Inserts a hyperlink to launch the CSM Desktop Client and
open the Business Object Record.

b. Link to Customer Portal: Inserts a hyperlink to launch a browser to Cherwell's Customer
Portal browser application.

c. Link to Cherwell Browser Client: Inserts a hyperlink to launch a browser to the CSM
Browser Client application.

Note: To open a Business Object Record in the Portal or Browser Client using links inserted
into an e-mail, the URLs must be specified in the Browser Application Settings.

2. Add Attachments: Inserts Attachments from the Business Object Record or Attachment Manager
into the e-mail. Select the Attachments in the drop-down:

a. Specific Attachment :Inserts specific Attachments from the Business Object Record into the
e-mail. If the linked Business Object contains Attachments, they are listed individually and can
be inserted into the e-mail.

b. Attachment Manager: Opens the Attachment Manager to select Attachments to insert into the
e-mail.

3. Add Recipients: Opens the CSM Address Book to select recipients to add to the To, Cc, or Bcc
lines.
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Track Outlook E-mail Correspondence in Journal -
Mail History Records

When an incoming Outlook e-mail is linked (either automatically or manually) to a Business Object
Record, a Journal - Mail History Record is created from the e-mail and associated with Business Object
Records. Outgoing replies or forwards are also stored as Journal - Mail History Records if the option is
selected to auto-link them when configuring the Add-In. One e-mail can be attached as a Journal - Mail
History Record to multiple Business Object Records (example: An Incident and a Customer Record).

Note: The types of Business Object Records an e-mail can be linked to is based on what was
configured for the Outlook Integration Configuration being used. Based on the behaviors defined
for the Outlook Integration Configuration, e-mail attachments are also imported and attached to
the Business Object Record.

The figure shows an example of a Journal (associated with an Incident Record) that lists several Journal -
Mail History records created from Outlook e-mails.

Note: Journals examples might look different because its appearance is based on the Grid view
and design. For more information about Grids, refer to the Grids documentation.

Use the Journal - Mail History to:

• View a list of all Journal - Mail History Records linked to a particular Business Object Record.

• View the contents of each e-mail stored as a Journal - Mail History Record.

• Reply to or forward e-mails stored as Journal - Mail History Records (using the e-mail menu on the
Journal toolbar).

Note: To send an e-mail from a CSM Business Object Record, there must be a CSM e-mail
account set up. There is an option to store replies and forwards as Journal - Mail History
Records.
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Expressions
An Expression is a combination of explicit values, constants, variables, operators, and functions that
receive input, manipulate the data, and then output the data. In other words, an Expression interprets a
value, and then produces another value as a result (example: The IncidentDurationInDays Expression
calculates the amount of time that elapses between the time an Incident is created and closed).
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About Expressions
Use an Expression to conditionally control appearance and behaviors of CSM features (example:
Dashboards, Forms, etc.).

For example, Users can:

• Control visibility of items on Forms and toolbars.

• Dynamically display text on Forms.

• Calculate times and durations.

• Display colors or images on a Form or Grid.

In CSM, Expressions can be used in:

• Queries: In Comparison Clauses as values to search for in a specified Field.

• One-Steps: In Actions where you can specify values to use in Business Object Fields, e-mail
messages, Tweets, temporary filenames, command-line arguments, URLs, etc.

• Dashboards: To set colors, images, text, and visibility for Widgets.

• Business Objects: To set Field values and properties, and to auto-populate Fields.

• Forms: To set colors, images, and text for Form Controls.

• Mobile Forms: To limit when certain sections are shown on a mobile device and to set values for
section headers.

• Automation Processes: To limit records.

• Approvals: To define/limit trigger conditions, approvers, and set field Actions.

• Constraints: To limit what a Users sees or can select from in a Field, Related Item Selector, tab in a
Form Arrangement, or Prompt.

Expression types include:

• Aggregate: Calculates an Expression against child data in a relationship (example: Counting the
number of Incidents linked to a Problem).

• Case: Works as a group of if-then-else Expressions that are applied together against one field
(example: If the Incident Priority equals 1, then apply the Alert - High color to the Priority alert bar).

• Counter: Uses the Counter to obtain an assigned number (example: Increment the Incident ID).

• Date/Time: Performs date/time calculations (example: Calculate a fifteen minute warning for an
SLA).

• Duration: Calculates the amount of time between two dates (example: The number of hours it takes
to close an Incident).

• Logical: Uses one or more conditions (example: Incident.Status does not equal Closed) to return
either a true or false value.
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• Number: Performs mathematical calculations using a string of tokens and mathematical symbols
(example: Calculate the total cost of a Labor Cost Item by multiplying the work hours by the
monetary rate).

• Text: Displays a string of tokens and text (example: Dynamically control the Last Edited text on the
Incident form).

• User/Customer Data: Allows for efficient retrieval of certain User and Customer data without setting
up a Relationship (example: Display a User's avatar next to a Journal record in an Incident's
Arrangement).

CSM provides several OOTB stored Expressions. Use these OOTB Expressions as-is, edit them, or
create new Expressions using the Expression Manager. Users can also create Custom Expressions on
the fly from the Token Selector.
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Expressions Good to Know
• An Expression is typically identified by the Expression icon .

• Custom Expressions can be created on-the-fly from many places in CSM. Unlike Stored
Expressions, Custom Expressions are only used where they are created and are not stored in the
Expression Manager.

• CSM provides several OOTB stored Expressions. Use these OOTB Expressions as-is, edit them, or
create new Expressions using the Expression Manager. Users can also create Custom Expressions
on the fly from the Token Selector.

• Always consider the following:

◦ CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box◦ 
content in our documentation.

◦ Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For
detailed information, see Configure Stored Expression Security Rights.
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View an Expression
An Expression can be viewed several ways:

• Available Expressions (based on security rights): Use the Expression Manager.

• From an item that uses an Expression (example: Image, Background, text, etc.).

• From the Token Selector.
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Managing Expressions
Expressions are managed using the Expression Manager.

There are several ways to open the Expression Manager.

Use the Expressions Manager to complete general CSM Item Manager operations for Expressions,
including:

• View an Expression.

• Create an Expression.

• Edit an Expression.

• Delete an Expression

• Search for an Expression.

• Organize Expressions.

• Copy an Expression.

• Import/export an Expression.
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• Find Expression dependencies.

• Pin an Expression.

CSM 9.3.0 Features 596

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fexpressions%2F..%2Fitem_managers%2Ffind_csm_item_dependencies.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fexpressions%2F..%2Fitem_managers%2Fpin_a_csm_item.html


Open the Expression Manager
The Expression Manager can be accessed in several ways:

• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Expressions.

• From the Token Selector available in Query Builders, One-Steps, etc.
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Create an Expression
Use the Expression window (accessed from within the Expression Manager) to create a Stored
Expression, which is accessible wherever an Expression is used in CSM.

Note: Unlike Stored Expressions, Custom Expressions are created on the fly, only used where
they are created, and not saved in the Expressions Manager.

When you create an Expression, you define:

• General properties: Name and description.

• Editor (Type): Aggregate, Case, Counter, Date/Time, Duration, Logical, Number, Text, or User/
Customer Data.

• The Expression: Varies by type.

To create an Expression:

1. Open the Expression Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button .

4. Define the general Expression properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

5. Select an Expression type from the Editor drop-down, and then define its properties:
◦ Aggregate

◦ Case

◦ Counter

◦ Date/Time

◦ Duration

◦ Logical

◦ Number

◦ Text

◦ User/Data
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6. Click OK.6. 
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Define an Aggregate Expression
An Aggregate Expression is an Expression that calculates an Expression against child data in a
Relationship (example: Counting the number of Incidents linked to a Problem).

To define an Aggregate Expression:

1. Create an Expression.

2. In the Editor drop-down, select Aggregate.

The Aggregate Expression section opens.

3. Define the Expression:
a. In the Relationship drop-down, select a Relationship (example: Problem Has Linked

Incidents).

Note: Available Relationships are based on the associated Business Object (example:
Problem).

b. In the Function drop-down, select the type of data you want to retrieve:
◦ Count: Number of Relationship occurrences (example: Number of linked Incidents).

◦ Total: Sum of a specified Numerical Expression.

◦ Average: Average of a specified Numerical Expression.

◦ Maximum: Highest returned value of a specified Numerical Expression.

◦ Minimum: Lowest returned value of a specified Numerical Expression.

c. In the Apply Against drop-down Token Selector, select the Field or Numerical Expression for
which you want to apply the Expression. This option is available for Total, Average, Maximum,
Minimum functions.

Tip: Create a Custom Expression on-the-fly by clicking New Custom Expression in
the Token Selector.

d. (Optional) Limit the returned data using an additional Expression:
i. Select the Limit check box.

The Limit fields become active.

ii. Select an Expression:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager,
and then select an existing stored Expression or create a new stored Expression.
Stored Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the
Custom Expression Builder, and then create a custom Expression specifically for
this scenario.
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Note: Unlike Stored Expressions, Custom Expressions are created on-the-
fly, only used where they are created, and not saved in the Expressions
Manager.

4. Click OK.4. 
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Define a Case Expression
A Case Expression is an Expression that works as a group of if-then-else Expressions that are applied
together against one Field (example: If the Incident Priority equals 1, then apply the Alert - High color to
the Priority alert bar).

To define a Case Expression:

1. Create an Expression.

2. In the Editor drop-down, select Case.

The Case Expression section opens.

3. In the If condition is true section, select a type of If statement (Simple, Advanced, or Named
Expression), and then define its properties:

a. Simple: Define an Expression (example: Incident.Priority equals 1):
i. Select a value from the Token Selector in the left-most Value drop-down (example:

Incident.Priority).

ii. Select an operator from the Operator drop-down (example: Equals).

iii. Select a value from the Token Selector in the right-most Value drop-down (example: 1).

The If statement displays in the Cases pane.

Note: The If statement ends with the term empty because the Then statement
has not been defined.

b. Advanced: Click the Edit button to to open the Custom Expression window, and then define a
Custom Expression.

c. Named Expression: Click the Ellipses button  to access the Expression Manager, and
then select a stored Expression or create a new Expression.

4. In the Then assign this value section, define the Then value (example: Alert - High):
a. Value: Select a value from the Token Selector.

b. Value is a color: Define a color value.
i. Select the Value is a color check box.

ii. Click the Color Selector button  to open the Color Selector, and then select an
existing color or create a new color.

The Then value displays in the Cases pane.

5. (Optional) Add related Expressions to the Cases pane (example: If the Priority equals 2, then apply
the Alert - Medium color to the Priority alert bar).

6. Define a default value:
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Note: The Expression will display this value if none of the defined cases are true.

a. Click the Default: empty row in the Cases pane.

The Then assign this value section opens.

b. Value: Select a value from the Token Selector.

c. Value is a color: Define a color value.
i. Select the Value is a color check box.

ii. Click the Color Selector button  to open the Color Selector, and then select an
existing color or create a new color.

The default Then value displays in the Cases pane.

7. Click OK.7. 
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Define a Counter Expression
A Counter Expression is an Expression that is used to obtain an assigned number (example: Increment
the Incident ID).

To define a Counter Expression:

1. Create an Expression.

2. In the Editor drop-down, select Counter.

The Counter Expression section opens.

3. Click the Ellipses button to access the Counter Manager, and then select an existing Counter
(example: IncidentID) or create a new Counter.

4. Click OK.4. 
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Define a Date/Time Expression
A Date/Time Expression is an Expression that performs date/time calculations (example: Calculate a
fifteen minute warning for an SLA).

All Date/Time Expressions are applied against a 24/7 time period by default. Certain Date/Time
Expressions (Date/Time Math, Is Valid Date, Is Valid Date/Time) can also be applied against existing
Business Hours or new Business Hours (created on-the-fly using the Business Hours Manager).

To define a Date/Time Expression:

1. Create an Expression.

2. In the Editor drop-down, select Date/Time.

3. Define the Expression:
a. Select a Date/Time Expression type from the Expression Type drop-down, and define its

properties:
◦ Date/Time Math: Displays calculated value based on a specified Date/Time Field or

Calendar date (example: A 15-minute warning for an SLA).

◦ Is Valid Date: Evaluates as true if the Date parameter falls within the Business Hours for
the selected Calendar.

◦ Is Valid Date/Time: Evaluates as true if the Date/Time parameter falls within the
Business Hours for the selected Calendar. You can also choose a time zone against
which the parameter is evaluated:

◦ None

No time zone is associated with the Date/Time parameter and it is assumed to be
the same time zone specified for the Business Hours calendar specified in the
Working Hours drop-down.

◦ Client time zone:

Associates the time zone of each User's client machine with the Date/Time
parameter.

◦ Server time zone:

Associates the time zone of the Application Server machine with the Date/Time
parameter.

◦ Specific time zone:

Uses a specific time zone.

◦ To Minutes: Displays a Numerical Expression that is applied against a specified time or
Field and converted into minutes.

◦ To Hours: Displays a Numerical Expression that is applied against a specified time or
Field and converted into hours.
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b. Enter positive or negative numbers in the Amount field (found in the Date/Time Math, To
Minutes, and To Hours expression types).

For example, selecting CurrentDateTime() in the Value field, typing 5 in the Amount field, and
selecting Days in the Units field will return a value of 5 days from now.

Typing -7 in the Amount field will return a value of 7 days ago.
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c. From the Calendar Type drop-town, select a Calendar type:
◦ 24/7:

Expression is applied 24/7.

◦ Working Hours:

Expression is only applied during the selected Business Hours (example: Maintenance
Window) or value (example: SLA.Work Hours).

4. Click OK.4. 
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Define a Duration Expression
A Duration Expression is an Expression that calculates the amount of time between two dates (example:
The number of hours it takes to close an Incident).

To define a Duration Expression:

1. Create an Expression.

2. In the Editor drop-down, select Duration.

The Duration Expression section opens.

3. Define the Expression:
a. Select a time period:

Note: Duration Expressions are applied against a 24/7 time period by default.
However, the Expressions can also be applied against existing Business Hours or new
Business Hours (created on-the-fly using the Business Hours Manager).

i. First Date/Time: Select a date/time Field or Calendar date/time to use as the starting
point of the duration (example: Incident.Created Date Time).

ii. Second Date/Time: Select a date/time Field or Calendar date/time to use as the
ending point of the duration (example: Incident.Closed Date Time).

iii. Units: Select the unit of time for which you want to display the duration (example:
Days).

iv. Round: Select the check box to round the unit to the nearest whole number (example:
January 1st to February 10th returns a value of one month instead of 1.37 months).

b. Select a Calendar type from the Calendar Type drop-down:
◦ 24/7: Expression is applied 24/7.

Note: The 24/7 Calendar option is applied by default.

◦ Working Hours: Expression is only applied during the selected Business Hours
(example: Maintenance Window) or value (example: SLA.Work Hours).

4. Click OK.4. 

CSM 9.3.0 Features 608

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fexpressions%2F..%2Fbusiness_hours%2Fabout_business_hours.html


Define a Logical Expression
A Logical Expression is an Expression that uses one or more conditions (example: Incident.Status does
not equal Closed) to return a true or false value.

To define a Logical Expression:

1. Create an Expression.

2. In the Editor drop-down, select Logical.

The Logical Expression section opens.

3. Define the Expression condition:
a. Select a value from the Token Selector in the left-most Value drop-down (example:

Incident.Status).

b. Select an operator from the Operator drop-down (example: Not Equal).

c. Select a value from the Token Selector in the right-most Value drop-down (example: Closed).

Note: If the Field is validated, the Legal Values button displays to the right of the drop-
down. It allows you to choose from a list of appropriate values.

4. (Optional) Add additional related Expressions:

Note: When additional Expressions are added to the Logical Expression, all conditions in
the group must be true for the Expression to return a True value.

a. Click the Advanced button.

The Advanced section opens and displays the defined Expression.

b. Define a Group Expression:

i. Click the New button , and then select Group Expression in the drop-down.

The Grouping section opens.

ii. Select a Grouping condition:
◦ All of the items in the group must be true.

◦ At least one of the items in the group must be true.

The Grouping condition displays in the Advanced section.

5. (Optional) Define an Expression that meets the Group Expression condition:
a. Select a value from the Token Selector in the left-most Value drop-down (example:

Incident.Status).

b. Select an operator from the Operator drop-down (example: Not Equal).

c. Select a value from the Token Selector in the right-most Value drop-down (example:
Resolved).
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Note: If the Field is validated, the Legal Values button  displays to the right of the
drop-down. It allows you to choose from a list of appropriate values.

6. (Optional) Add additional Logical and Group Expression conditions.

7. Click OK.7. 

CSM 9.3.0 Features 610

CSM 9.3.0 Features



Define a Numerical Expression
A Numerical Expression is an Expression that performs mathematical calculations using a string of
Tokens and mathematical symbols (example: Calculate the total cost of a Labor Cost Item by multiplying
the work hours by the monetary rate).

If you need to use a number as part of the Expression, first create a Stored Value to represent that
number, and then include the Stored Value in the Expression. This ensures that the system correctly
converts the number. For example, if you want to divide the Incident.Cost by the number of work days in a
week, create a Stored Value for the number of work days, then use it in the Expression.

To define a Numerical Expression:

1. Create an Expression.

2. In the Editor drop-down, select Number.

The Numerical Expression section opens.

3. Define the Expression:
a. Click the down arrow to open the Token Selector, and then select a value.

Tip: Right-click anywhere in the Expression field to access the Token Selector.

The Token displays in the Expression field.

b. Type a mathematical symbol for the equation (+ to add, - to subtract, * to multiply, or / to
divide).

c. Click the down arrow to open the Token Selector, and then select a value.
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Tip: Right-click anywhere in the Expression field to access the Token Selector.

The Token displays in the Expression field.

4. (Optional) Add additional Tokens and mathematical symbols to the equation.

5. Click OK.5. 

Note: Cherwell follows IEEE standards for rounding numerical values, specifically the round to
nearest, ties to even rule.
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Define a Text Expression
A Text Expression is an Expression that displays a string of Tokens and text (example: Dynamically
control the Last Edited text on the Incident form).

To define a Text Expression:

1. Create an Expression.

2. In the Editor drop-down, select Text.

The Text Expression section opens.

3. Define the Expression.
a. (Optional) In the Expression field, provide the text to display before the Expression (example:

Last Edited).

b. Click the down arrow to open the Token Selector, and then select a value (example:
Incident.LastModifiedDateTime).

Tip: Right-click anywhere in the Expression field to access the Token Selector.

The Token displays in the Expression field.

c. Select the After replacing tokens, evaluate the results as a calculation check box to
display a calculated value instead of the defined numerical equation.

4. (Optional) Add additional text and Tokens to the Expression.

5. Click OK.5. 
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Define a User/Customer Data Expression
A User/Customer Data Expression is an Expression that allows for efficient retrieval of certain User and
Customer data without setting up a relationship (example: Display a User's avatar next to a Journal record
in an Incident's Arrangement).

To define a User/Customer Data Expression:

1. Create an Expression.

2. In the Editor drop-down, select User/Customer Data.

The User Data Expression window opens.

3. Define the Expression:
a. In the Type of User section, select a User type:

◦ User: A User is a service desk professional who logs in and uses CSM to manage
service desk data (example: A technician, manager, designer, system administrator, etc.)
that has a UserInfo record.

◦ Customer: A Customer is an End-User, either an internal employee or an external
individual, who relies on CSM to initiate/fulfill a Service or Product (example: A person
reporting a lost password or requesting a new phone) that has a Customer - Internal
record.

◦ Current User/Customer: Select this radio button to create the Expression using the
currently logged in User or Customer's record data (example: Retrieve the avatar for the
currently logged in User automatically instead of having to set the User record
information manually). Upon selecting this radio button, the User/Customer record ID
drop-down is disabled as the drop-down is no longer required.

b. In the Attribute Name drop-down, select the Attribute that you want to display (example:
Avatar). Attributes include:

◦ Avatar

◦ Department

◦ E-Mail Address

◦ Full Name

◦ Manager ID

◦ Manager Name

◦ Phone Number

c. In the User Record ID drop-down, select the Field that holds the Record ID for the User or
Customer (example: UserInfo.RecID or Customer.RecID).

Note: This setting is only applicable for the User and Customer types. It is unavailable
for the Current User/Customer type setting.

4. Click OK.4. 
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Configuring Expressions
Stored Expression Security rights are configured in CSM Administrator. See Stored Expressions Security
Rights.
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Formats
A Format is a Token formula that controls how characters and digits are displayed in a Text field (example:
When and where to include hyphens, parentheses, spaces, capitalization, etc.).
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About Formats
Use a Format to enforce how the following are displayed:

• Phone numbers: For example, use a Format to make numbers typed into a Field look a certain way:
◦ US: (###) ###-####

◦ International: +## (###) ####-####

◦ Enforce an extension: (###) ###-#### x####

• IPv formats: For example IPv4 (numeric character) or IPv6 (any character) format.

CSM provides a variety of OOTB Stored Formats to help get you started. Use these OOTB Stored
Formats as-is, edit them, or create new Formats using the Stored Format Manager. Custom Formats (not
intended for reuse on other Fields) can also be created for use on a specific Field.
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Formats Good to Know
• A Format is typically identified by the Format icon .

• Formats can use several formulas, including alphanumeric formulas, upper and lowercase formulas,
and insertion points.

• CSM provides a variety of OOTB Stored Formats to help get you started. Use these OOTB Stored
Formats as-is, edit them, or create new Formats using the Stored Format Manager. Custom
Formats (not intended for reuse on other Fields) can also be created for use on a specific Field.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.
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Using Formats
When working with formats, Users can view Formats and add them to Fields.
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View a Format
To view a Format:

• Available Formats (based on security rights): Use the Stored Format Manager.

• From a Field that uses a Format (example: A phone number) in a Business Object (CSM
Administrator>Blueprints>Create a new/Edit Blueprint>"Business Object">"Field">General tab).

• From the Token Selector.
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Add a Format to a Field
In CSM, Formats are used to control how characters and digits are displayed in a Field (example: How a
phone number is displayed). When adding a Format to a Field, there are two types of Formats available:

• Stored Format: Stored Format is a named, stored Formats that can be reused on any Field in CSM.
Stored Formats are managed using the Format Manager.

• Custom Format: A Custom Format is an un-named Format that is defined for use in a specific Field.

To add a Format to a Field:

1. Open the Properties window for the Field to which you want to add a Format:
a. In CSM Administrator, create a Blueprint.

b. In the Object Manager, double-click the Business Object that contains the Field.

c. Double-click the Field.

2. Click the General tab.

3. Check the Format check box.

4. Select the Format to apply:
◦ Click the Ellipses button to open the Stored Format Manager, where Users can choose an

existing Format (Stored Format) or create a Stored Format. Stored Formats can be used over
and over in numerous places.

◦ Click the Custom Format button  to open the Custom Format window, where Users can
create a Custom Format to use only for this scenario. A Custom Format has many of the same
properties as a Stored Format, only it does not have a name or description, and is not
managed through the Stored Format Manager.

5. Click OK.5. 
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Managing Stored Formats
Stored Formats are managed in CSM using the Stored Format Manager.

The Stored Format Manager can be opened in several ways.

Use the Stored Format Manager to complete general CSM Item Manager operations for Stored Formats,
including:

• View a Format.

• Create a Format.

• Edit a Format.

• Delete a Format.

• Search for a Format.

• Organize Formats.

• Copy a Format.

• Import/export a Format.

• Find Format dependencies.
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Note: Custom Formats can also be created for use on a specific Field.
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Open the Stored Format Manager
To open the Stored Format Manager:

• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Formats.
• From the Token Selector available in Query Builders, One-Steps, etc.
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Create a Stored Format
Use the Format window (within the Stored Format Manager) to create a Stored Format. When creating a
Stored Format, define the following:

• General properties: Name and Description.

• Picture: Format formula (in other words, what the Format looks like).

• Case: Uppercase, lowercase, or as entered.

• Direction: Data is entered left-to-right or right-to-left.

Note: Users can also create a Custom Format and add it to the Field.

To create a Stored Format:

1. Open the Stored Format Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button.

The Format window opens.

4. Define general properties for the Format:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

5. Define the picture (formula) for the format:
a. In the Picture field, specify the formula and/or add criteria by clicking an option in the drop-

down. For example, (###) ###-#### would format numbers in a Phone field to (719) 555-5555.

6. Define the case (select one):
◦ Keep casing as entered: Select this option to maintain the case as it is entered into the Field

by the User.

◦ Make uppercase: Select this option to make all characters uppercase (example: AAAA),
regardless of how characters are entered into the Field.

◦ Make lowercase: Select this option to make all characters lowercase (example: aaaaa),
regardless of how characters are entered into the Field.

7. Define the text direction:
a. Characters/Digits Entered at Right and Pushed to Left: Check this box to add data from left-to-

right (example: (719) 555-5555). If not checked, data will be entered from right-to-left
(example: (555) 555-5917).
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8. Click OK.8. 
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Grids
A CSM Grid is a tabular view of CSM data from a Business Object.
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About Grids
CSM uses a Grid to display:

• Search Results List: List of records located through a Quick Search or Search Group.

• Search Results List Widget: List of results on a Dashboard.

• Form Arrangement: List of related records on a tab.

• Contact Manager: List of Customer Records.

• CMDB interface: List of Configuration Item records.

• Table Management interface: List of Lookup values.

• CSM Item Managers: List of CSM Items (example: List of Dashboards in the Dashboard Manager).

You can print, export, and run an Action from most CSM Grids. You can also personalize (sort, filter,
group, size, move, and add/remove columns) your instance of most Grids so that they display only the
data you want and in a way that is meaningful to you. Some personal changes persist so that your
changes display the same way the next time you view the Grid in the same location.

Notes: Business Object Grids (record Grids) also support running Actions. Very large text Fields
do not support sorting. Item Manager Grids support sorting and sizing only. Nested Grids have
limited functionality.

CSM 9.3.0 Features 628

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fgrids%2F..%2Fsearching%2Fabout_quick_search.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fgrids%2F..%2Fsearching%2Fabout_search_groups.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fgrids%2F..%2Fwidgets%2Fsearch_results_list_widgets.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fgrids%2F..%2Fbusiness_objects%2Fform_arrangements.html
https://help.cherwell.com/csh?topicname=contact_manager
https://help.cherwell.com/csh?topicname=cmdb_interface
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fgrids%2F..%2Ftable_management%2Fabout_table_management.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fgrids%2F..%2Fitem_managers%2Fabout_csm_item_managers.html


Tour a Grid
The following figure shows the default Incident Grid in the CSM Desktop Client.

1. Title: Grid title. This might or might not match the name of the Business Object that the Grid
represents. Also, a Business Object might have multiple Grids, so each might have its own name.

2. Group By box: Displays the Grid data grouped by one or more columns so that data can be broken
down into smaller parts or examined it from a different viewpoint (ex: Group Incidents by Priority).
Group a Grid by clicking-and-dragging the column to group the data by into the Group By Box
(located directly above the Grid header).

3. Sort icon: Indicates the column currently sorting the Grid, and if it is in ascending or descending
order ( ). Click the icon to toggle sorting. Click another column heading to sort by that column.

4. Filter icon: Indicates the column data can be filtered. Click the icon to show filtering options
(possible filter values appear in the column's Filter drop-down).

5. Lock icon: Indicates that the column cannot be sorted.

6. Images: Expression-driven images can be used to indicate a condition has been met (ex: Display
breached SLAs with an Alarm Clock image). Grid rows also support expression-driven colors.

7. Grid items: List of all results in the Grid.

8. Context (Right-Click) menus: Shows common Grid operations, such as customize columns,
refresh, print, export, etc.

Grids in the Browser Client and Portal look very similar to Desktop Client Grids, except that Export, Run
Action, and Add/Remove Grid Column options are available on a Grid toolbar rather than from a context
menu or menu bar. Grid grouping is not currently available.
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1. Grid menu bar: Displays actions available for the Grid, including navigation, Actions, and available
columns.

2. Title: Grid title. This might or might not match the name of the Business Object that the Grid
represents. Also, a Business Object might have multiple Grids, so each might have its own name.

3. Sort icon: Indicates the column currently sorting the Grid, and if it is in ascending or descending
order ( ). Click the icon to toggle sorting. By default, the Browser Client sorts Grids using single-
column sorting. To sort the Grid using multiple columns, click the Multi-column sorting button in
the Grid menu bar.

4. Filter icon: Indicates the column data can be filtered. Click the icon to show filtering options
(possible filter values appear in the column's Filter drop-down).

5. Sizing handles: Click the sizing handles, then drag the column to the width you want.

6. Grid item: Each item within a Grid contains its own line of information. Clicking the item opens the
record in the Main Pane.

7. Images: Expression-driven images can be used to indicate a condition has been met (ex: Display
breached SLAs with an Alarm Clock image). Grid rows also support expression-driven colors.

Note: OOTB Business Object Grids use colors and icons to indicate priority and status. The colors
and icons vary based on the Business Object. You can use these settings or define your own
Business Object Grid options.

CSM 9.3.0 Features 630

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=define_business_object_grid_options
https://help.cherwell.com/csh?topicname=define_business_object_grid_options


Grid Persistence
When making changes to a Grid (group, size, move/reorder, and add/remove a column), the changes are
saved to a Personal Grid definition. As a result, changes appear next time the Grid is viewed in the same
location by the same user.

In summary, Grid changes are:

• Persistent: User-specific changes are saved between sessions.

• Personal: Changes affect only the User who makes the changes.

• Location-specific: Changes affect only the Grid in its current location; for example, the same Grid
displayed as part of search results and on a Dashboard is considered a separate entity and persists
on its own.

• Grid changes are remembered until the Grid is reset in the CSM Desktop Client or Administrator, the
settings are cleared (Tools>Options>General>Restore all Customized Grids to the Admin Defaults,
or File>Clear Settings in the Role or User Manager), or a new System Grid definition is
automatically pushed out. If a new System Grid definition is pushed out, a Personal Grid definition
can be reverted manually but the changes in the new definition will be lost.

• The ability to move/reorder, add/remove a Grid column, and group/persist a Grid is enabled in the
System Grid definition (Customization properties). Persistence is enforced through Grid security
rights.

• If Grid grouping persistence is enabled for the Grid and selected from the context menu (select
Remember Current Grouping Between Uses), the grouping persists until:

◦ The Grid is reset or the grouping is cleared.

◦ The settings are cleared (Tools>Options>General>Restore all Customized Grids to the Admin
Defaults, or File>Clear Settings in the Role or User Manager).

◦ A new System Grid definition is automatically pushed out. If a new System Grid definition is
pushed out, then manually revert to the Personal Grid definition but the changes in the new
definition will be lost.

• The Grid's Grouping properties (defined in the Grid's definition in CSM Administrator) controls if the
Grid can be grouped, if the Group By Box shows by default, and if Grouping can be persisted.
Blueprint Display settings define default values.
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About Grid Filtering
Filtering options/values vary according to the type of data in the column (example: Text, Number, Logical
[true/false], etc.) and whether the column can be filtered by multiple values.

• If a Text column has a length greater than max searchable and does not have Full-Text Search
enabled (both for the Field and the Business Object), no filtering options are available. If a Text Field
has a length greater than the max searchable and does have Full-Text Search enabled (both for the
Field and the Business Object), only Full-Text Search operators are available when defining a
Query.

• Grid filtering does not persist.

• Text columns can be filtered by multiple values in their column (example: Multiple statuses); Select
the values to use to filter the column, and then click OK. Create a custom filter by clicking the
Custom button. Date/Time, Number, and Logical (true/false) columns do not support multi-column
filtering.

Sizing Grids

• A Grid column's default width is defined in the Grid's definition (in CSM Administrator).

The following table shows some example filtering options/values, including the option to create a custom
filter.

Filter Description

Empty Shows only rows where there is no value set for the column.

Not Empty Shows only rows where there is any value set for the column.

Letter/
Number
Range Values

Shows only rows that begin with a specified alphabet letter or number range (example:
A-H).

Note: Used only for Text columns. This option is only displayed for columns
that do not have an alternative way of providing values (such as the list of valid
values for the column).

Validated
Values

Shows a list of legal values for the column (example: Record Type). Selecting one of
these values returns all rows where the value in the Field matches that value. In some
places within the system (such as on a tab under a Business Object), this might include
all values in use within the Grid.

Note: Used for fields validated from a table (where the table is cacheable).
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Filter Description

Range

Prompts to provide a start and end date, and then shows only rows where the value in
the column is between those two dates (inclusive).

Note: Used only for date/time columns.

Common
Date/Time
Values

For date/time Fields, shows only rows where the value in the column is within a
common date/time range (example: Today, Yesterday, etc.).

Note: Used only for date/time columns.

Custom

(Desktop
Client only)

Opens the Custom Filter window to define your own filter by defining a Comparison
Clause. A Comparison Clause defines an operator (example: Equals, Less Than, etc.)
and the value to find (example: Value, Field, system function, Expression, or Stored
Value).

Note: For more information about building Comparison Clauses, refer to the
Comparison Clause documentation.
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Grids Good to Know
• Very large text Fields do not support sorting.

• CSM Item Manager Grids support sorting and sizing only.

• Nested Grids have limited functionality.

• Use the Preview button to preview on what a printed Grid will look like.

• OOTB Business Object Grids use colors and icons to indicate priority and status. The colors and
icons vary based on the Business Object. You can use these settings or define your own Business
Object Grid options.

Business Object Grids

• A Business Object Grid is a Grid that displays Business Object data. The Business Object Grid's
properties are stored in a Grid definition.

• The Business Object Grid's definition and security rights combine to control options to move and
group Grids, and to add/remove Grid columns.

• Business Object Grids (record Grids) support running Actions.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups).

Create/Edit Grids

• If a Field is intentionally excluded from Grids, it does not appear in the Field tree and cannot be
added to the Grid. For more information about excluding Fields from Forms and Grids, see Define
Advanced Properties for a Field.

• Use this feature when applying a mApp that includes to new Form; swap in the new Form without
losing the old Form.
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Using Grids
When working with Grids, Users can perform a number of tasks.

Note: Some changes (group, size, move/reorder, and add/remove column) are persistent.

Detailed Tasks:

• Print a Grid.

• Export a Grid.

• Filter a Grid.

• Group a Grid.

• Revert to personal Grid settings.

View a Grid
A Grid can be viewed several ways:

• Search Results: List of records located through a Quick Search or Search Group.

• Search Results List Widget: List of results on a Dashboard.

• Form Arrangement: List of related records on a tab.

• Contact Manager: List of Customer Records.

• CMDB interface: List of Configuration Item records.

• Table Management interface: List of Lookup values.

• CSM Item Managers: List of CSM Items (ex: List of Dashboards in the Dashboard Manager).

• Creating/editing a Business Object Grid (in CSM Administrator).

Run an Action from a Grid
Run a defined Business Object Action directly from a Business Object Grid (record Grid) to quickly initiate
common operations. Actions are defined as part of a Business Object's definition. For information about
Grids in the Browser Client and Portal, see Browser Client Grid Functions.

To run an Action from a Grid in the Desktop Client, select a row (record), and then right-
click>Actions>Select an Action.

Sort a Grid
Sort a Grid in alphabetical or numerical order, in ascending (1-10 or A-Z) or descending order (10-1 or Z-
A), using the Sort icons  in the Grid's header. Also, sort a Grid by multiple columns (ex: Sort by Status,
then sort each Status by Created Date Time).
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A Grid's default sort order is defined in the Grid's definition (in CSM Administrator). A sorting arrow ( )
appears in the Grid header when the Grid is first shown to indicate which column is the default sorting
column.

Grid sorting does not persist in Search and Dashboard Grids or in CSM Web Applications.

To sort a Grid, click the column header to sort, and then click either the up or down arrows.

Tip: To sort multiple columns, Press and hold the Shift key after clicking the first sort column. The
columns are sorted in the same order they are clicked (ex: click the Status column, then hold Shift
while clicking the Created Date Time column).

Size a Grid Column
Size a Grid column to a specific width to set how much data is viewable.

To size a Grid column:

1. In a Grid, hover over the column header to resize until the sizing handles appear.

2. Click the Sizing handles, then drag the column to the desired width.

Move (Reorder) a Grid Column
Rearrange a Grid by moving (reordering) a Grid column to a different location in a Grid.

To move a Grid column, drag-and-drop the column header to a new location in the Grid.

Add/Remove Grid Columns
Business Object Grids are created and managed by a system administrator in CSM Administrator.
However, add and remove columns (Fields) from an instance of the Grid to show only important Fields
(ex: Add the Owned By field to the Incident grid to view record owners). If configured, Fields can be added
from other Business Objects in a Relationship with the Grid (ex. Add the Problem ID Field to view
Problems related to the Incident).

To add/remove a Grid column in the Desktop Client:

1. In a Grid, right-click the Grid header, and select Customize Columns.
The menu expands to show which Fields are currently selected to display on the Grid (displayed
Fields have a check mark). An alphabetical list of uncategorized Fields from the original Grid
definition are also listed (the list is limited).

2. Select the Field you want to add to/remove from the Grid. There are three options:
◦ Click an unselected Field to add it to the Grid.

◦ Click a selected Field to remove it from the Grid.

◦ Click More to access additional Fields, including related Fields.
The Column Customization window opens to select one or more available Fields from the
Business Object to add to the Grid. Currently, selected Fields are already listed in the
Selected Fields box (right column). Available Fields are listed in the Fields box (left column).
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Available Fields are organized by category; uncategorized Fields are listed at the top and are
likely listed in the menu.

3. Select the Fields (columns) to add to the Grid by moving them to the Selected Fields box.

Tip: Click the Reset button to reset the Grid to its current definition (how it looked when the
window opened) or its System Grid definition (how it looked when the system administrator
defined it).
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Print a Grid
Print a Grid to produce a hard-copy version of data.

To print a Grid in the Desktop Client:

1. In a Grid, click File>Print Grid or Right-click>Print Grid.

The Print Grid window opens.

2. Select the columns to print by moving them to the Selected Fields box.

Note: By default, all rows are selected.

3. Use the arrows to move and order fields.

4. Define the printer options:
a. Printer: Select the printer from which to print.

b. Page Setup: Click this button to define basic paper setup options (ex: Paper, orientation, and
margins).

c. Font: Click this button to define the font, font style, and font size for the text on the printed
Grid.

Note: Page Setup and Font options vary according to the driver of the selected printer.

5. Define the print layout options:
a. Force width to single page: Select this box to resize the printed Grid so that it fits on a single

page (does not off trail off the edge).

b. Shade alternate rows: Select this box to add a gray shade to every other row of the Grid.

c. Number pages: Select this box to add a page numbers to the footers of the printed pages.

d. Preview: Click to this button show a preview of the Grid before printing it.
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Export a Grid
Export a Grid to use CSM data in other applications for reporting or display purposes. You can export any
available Field in the Business Object or related Business Object (Business Object in a 1:1 Relationship
with the selected Business Object.

For example:

• Export Customers to a .csv file to use a spreadsheet tool to manage a mass-mail communication.

• Export Priority 1 Incidents to use the data as text in a report or presentation.

• Export Knowledge Articles to include them in a troubleshooting manual.

Export a Grid to the following formats:

Format Desktop Client Browser Client/Portal

.csv X X

.html X  

.txt X  

.rtf X  

.xml X  

.xls (Excel)  X

For information about Grids in the Browser Client and Portal, see Browser Client Grid Functions.

To export a Grid in the Desktop Client:

1. In a Grid, click File>Export Grid or right-click>Export Grid.

Note: Exportable Fields are organized by category; uncategorized Fields are listed at the
top, and are likely listed in the menu. Relationships Fields are listed below the Relationship
node (example: Incident Links Problem Fields).

2. Select the columns to export by moving them to the Selected Fields box.

3. Verify the Truncate long fields check box is selected to truncate exported fields at 300 characters.
Clear the check box to export the entire contents of fields with more than 300 characters.

4. Define the file options:
a. Click the Browse button.

The Chose Export File window opens.

b. Provide a filename for the exported file.

5. Select a file type for the exported file.

6. Click OK to begin the export.
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Filter a Grid
Filter a Grid by a column value so that the Grid shows only the desired data (example: Show only New
Incidents). To show even more specific data, multi-filter a Grid, either by using multiple values in a single
column (example: Show Incidents with a status of Assigned, In Progress, or Pending) or by using multiple
column values (example: Filter by owner, and then by status).

The following figure shows a Grid filtered by status.

The following figure shows a Grid filtered by Customer, and then multiple statuses.

Filters use a simple Comparison Clause to limit the values (example: Owned By = Josh Wilson). Multiple
values in a single column are strung together using or statements (example: Owned By = Josh Wilson or
Clair Wu). Multiple clauses are strung together to create a Query using and statements (example: Owner
= Josh WIlson and Status = Assigned, In Progress, or Pending).
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Filtering options/values vary according to the type of data in the column (example: Text, Number, Logical
[true/false], etc.) and whether the column can be filtered by multiple values.

To filter a Grid in the Desktop Client:

1. In a Grid, hover over the column header to filter, and then click the Filter icon  when it appears.

A Filter list drops down, showing filtering options/values; options/values vary according to the type of
data in the column (example: Number, Text, etc.).

2. Select a filtering option/value, and then click OK.

Note: A check box indicates that multiple values can be selected to filter the Grid.

The Grid filters the data and shows the Grid filtered results. The Filter icon is shown in the header of
the filtering column. The filtering criteria (Comparison Clause/Query) is shown in the Grid footer. If
the Grid is a Search Results Grid, Add, Edit, and Save filter buttons are shown in the Grid footer, as
well.

3. To continue filtering by another column, hover over another column header, click the Filter icon ,
and then select another filtering option/value.

The Grid filters the data again and shows the filtered results.

Note: Click the Custom... button to use the Custom Filter window to define your own filter
by defining a Comparison Clause. A Comparison Clause defines an operator (example:
Equals, Less Than, etc.) and the value to find (example: Value, Field, system function,
Expression, or Stored Value). For more information about building Comparison Clauses,
refer to the Comparison Clause documentation.

To remove the filtering criteria and show the original Grid:

1. Clear the check box next to the criteria.

a. Add the filter to the current query: click the Add to Current Query button .

b. Edit the current Query: click the Edit Current Query button .

c. Save the current Query as a Search Group so that it can be used again: click the Save

Current Query button . The Edit and Save options can also be accessed from the
Searching menu.

For information about Grids in the Browser Client and Portal, see Browser Client Grid Functions.
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Group a Grid
Group data by one or more columns in a Grid to break information down into smaller parts or to examine it
from a different viewpoint. The following figure shows how Incidents can be grouped by Priority, and then
Status. The Group By Box (located directly above the Grid header) shows which columns are currently
being used to group data. The Grid shows a count of the records in the group.

Grid grouping is currently available only in the CSM Desktop Client.

To group a Grid:

1. In a Grid, drag-and-drop the column to use to group the data into the Group By Box (located
directly above the Grid header). Two arrows indicate the intended location of the column header.

Tip: If the Group By Box is not visible, right-click in the Grid header, and then select Show
Group By Box.

The Grid reloads and shows grouping the data by the column header. The Group By Box shows
which column is currently being used to group data.

CSM 9.3.0 Features 643

CSM 9.3.0 Features



2. To further group the data by a second column, drag-and-drop a second column heading to the
Group By Box. Again, two arrows indicate the intended location of the column header.

Tip: Rearrange the groupings by dragging a new column header before, after, or in-between
other column headers.

The Grid refreshes and the data is grouped by the second column header.

3. After the Grid refreshes, Users can:
◦ Expand and collapse data using the Expand and Collapse arrows.

◦ Expand and collapse all grouped rows by selecting the Expand/Collapse All Grouped Rows
options on the Grid Context menu (right-click on the Grid Header).

◦ Have the grouping persist between sessions by selecting the Remember Current Grouping
Between Uses option on the Grid Context menu.

◦ Clear the groupings and return to the main Grid using the Clear Grouping option on the Grid
Context menu.

◦ Reset the grouped Grid to the administrator-defined Grid definition by selecting the Reset
option on the Grid Context menu.

◦ Use any of the CSM Grid capabilities (ex: Print, export, sort, filter, and size). If the system
administrator has allowed customization on the Grid and if the User has the security rights to
customize Grids, columns can be moved/reordered and added/removed from an instance of
the Grid.
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Reset to the System Grid Definition
Override any changes made to a Grid (ex: Grouping, sizing, moving/reordering, and adding/removing
columns) by resetting a Grid to its System Grid Definition. To save time, CSM also has an option to reset
all Grids at once.

To rest a Grid to its System Grid Definition, right-click the Grid header, and then select Reset.

To reset all Grids to their System Grid Definitions:

1. From the CSM Desktop Client menu bar, click Tools>Options.

2. Click the General page on the Cherwell Service Management Options window.

The General Options window opens.

3. Select the Restore All Customized Grids to Admin Defaults check box.

Note: The check box clears itself when OK is clicked.
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Revert to a Personal Grid Definition
If a system administrator adds or removes a column in the original Grid definition, the new Grid definition
is automatically pushed out to every instance of the Grid, thus overriding your personal Grid. You must
then choose to use the new System Grid Definition or revert to your Personal Grid Definition.

Note: This option is available only the first time you view the Grid (after logging in or reloading
your definitions) after the system administrator has made changes.

To revert to a personal Grid definition, right-click the Grid header, and then select Revert to personal
settings.
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Managing Business Object Grids
Grids are managed using the Grid Editor (accessed from within a Blueprint in CSM Administrator). Use
this tool to:

• Create/Edit a Business Object Grid.

• Delete a Business Object Grid.

Note: Within the Grid Editor is the Grid Wizard, a specialized tool that automatically creates
a new Grid with all the appropriate Fields and Grid properties.

To open the Grid Editor:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Business Object tree, click the Business Object to access the desired Grids.

Tip: Filter the Business Objects by clicking the Major, Supporting, Lookup, and All radio buttons.

3. In the Appearance area of the Object Manager, click the Edit Grid link.

Tip: Also access the Edit feature by clicking View>View Grid on the Blueprint Editor menu bar or

clicking the Grid toolbar button  on the Blueprint Editor toolbar.

The Grid Editor opens showing the Business Object's default Grid. A dynamic Grid menu bar item
appears on the Blueprint Editor menu bar to access Grid-specific commands.

4. If more than one Grid exists for the Business Object, select the Grid to open by selecting it in the
Grid drop-down (upper-left).

To view a Business Object Grid in the Grid Editor:

Note: This is only viewable if there is more than one Grid

1. Open the Grid Editor.

2. In the Grid drop-down (upper-left), select a Grid.

The Grid shows in the Grid Editor preview pane. The Grid properties show below the preview.

Note: To view the Grid as it appears to Users, see Using Grids.
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Grid Wizard
The easiest way to create a new Grid with all appropriate Fields to a Grid at once is to use the Grid
Wizard.

The Grid Wizard (accessed from within the Grid Editor in a Blueprint) automatically creates a new Grid
with all the appropriate Fields and Grid properties. Use the Grid Wizard to initially and quickly create a
new Grid. After creating the Grid, tweak the Fields and properties as needed. If creating a Grid using the
Grid Wizard, the wizard:

• Adds all the appropriate Fields from the Business Object to the Grid.

• Sets default Grid properties.
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Grid Editor
The Grid Editor is a tool within a Blueprint in CSM Administrator that allows Users to manage (create, edit,
and delete) Business Object Grids.

The Grid Editor's preview is dynamic. As Users make changes, the changes are immediately reflected in
the preview. Publish the Blueprint to commit the changes.

Grid Menu Bar
Item

Shows Grid-specific commands. This menu bar appears on the Blueprint Editor
menu bar only when a Form Editor is active in the Object Manager.

Toolbar The Grid Editor does not have a dedicated toolbar, but the Blueprint Editor toolbar
is available with commands for cut, copy, paste, delete, etc.

Grid drop-down
Lists the Grids defined for the selected Business Object (ex: Default, Basic Info,
etc.). The currently-selected default Grid is displayed at the top of the list as
Default Grid.

Search control/
Ignore Folders
button

Quickly locates and shows Fields. Use the Search Control to quickly locate a Field
whose Name and Description contain a specific word or phrase (ex: OwnedBy).
Use the Ignore Folders button to ignore the organizational folders and show all
Fields at the root of the list.

Field Tree
Lists the Business Object Fields that can be added to the Grid. Fields are
organized alphabetically and by folder. Fields from Relationships are listed
alphabetically under the Relationship.

Grid Preview Shows a dynamic preview of the Grid (which columns (Fields) are on it, column
widths, and order).

Grid Properties
button Opens the Grid Properties window to define row colors and images for Grids.

Grid title, width,
and sorting Defines title, width, and sorting options for the Grid.

General Grid
Settings

Defines customization options for the Grid (whether or not a User can remove
columns and add/remove Fields).

Grid Groupings Defines customization options for the Grid (whether or not a User can remove
columns and add/remove Fields).
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Create/Edit a Business Object Grid
Use the Grid Editor (accessed from within a Blueprint in CSM Administrator) to create or edit a Business
Object Grid.

To create a Business Object Grid:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Business Object tree, click the Business Object to access the desired Grids.

Tip: Filter the Business Objects by clicking the Major, Supporting, Lookup, and All radio
buttons.

3. In the Appearance area of the Object Manager, click the Edit Grid link.

Also access the Edit feature by clicking View>View Grid on the Blueprint Editor menu bar or

clicking the Grid toolbar button  on the Blueprint Editor toolbar.

4. From the Blueprint Editor menu bar, click Grid>New Grid.

5. Provide a name for the Grid, and then click OK.

6. Add Fields to a Grid: Drag-and-drop Fields from the Field tree into the Grid preview.

To remove a Field from the Grid, click a Field, and then click the Delete button.

7. Use the arrows to define column order or drag-and-drop the column header to a new location.

8. Define Business Object Grid Options:
a. Define row colors and images.

b. Define title, width, and sorting.

c. Define General Incident Grid settings.

d. Define Show grouping properties:

9. Make the Grid the default Grid.

10. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.

To edit a Business Object Grid:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.
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The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Business Object tree, click the Business Object to access the desired Grids.

Tip: Filter the Business Objects by clicking the Major, Supporting, Lookup, and All radio
buttons.

3. In the Appearance area of the Object Manager, click the Edit Grid link.

4. In the Grid drop-down (upper-left), select the Grid to edit.

5. Make any changes.

6. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Business Object Grid Options
To define Business Object Grid options:

1. Row colors and options:
a. Click the Properties button.

b. Define Row image/color Expressions for rows:
i. Expression check box: Enables using an Expression.

ii. Define the Expression:

◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button to open the Custom Expression
Builder, and then create a custom Expression specifically for this scenario.

2. Select a column (Field) and define Grid options:

(Optional) Custom
Column Title

Title to show in the UI. By default, the column is the same name as the Field it
represents. You might want the column name to be to different than the Field
name (ex: More user-friendly)

Width Select on what to base the column width, either based on the Field length (so
that it does not get truncated) or an absolute specified value.

Based on Field Automatically sizes the column width to the actual length of the Field.

Value Defines an actual character width, and then specify the value.

This Column Takes up
All Remaining Space
on the Grid

Automatically sizes the column to take up all remaining space on the Grid

Default to Sorting by
this Column

Defaults to sorting the Grid by the selected column (in other words, when the
Grid is first displayed, this column will determine the sort order of the Grid). By
default, it is in ascending order (select the Descending check box to make it
descending order). A sorting arrow ( ) appears in the Grid header to indicate
that the column is the default sorting column.

Note: Only one column can be the default for the Grid. The Search Group
default sorting overrides this default. Users can also manually change the
sorting

General Incident Grid
Settings Despite these settings, Users also need security rights to customize Grids.

Allow Column Reorder Allows the User to move columns around in a Grid.

Allow Users to Add
and Remove Available
Fields from Grid

Allows Users with rights to add and remove available Fields to the Grid.

CSM 9.3.0 Features 652

CSM 9.3.0 Features



Allow Users to Add
Fields to the Grid from
Appropriate
Relationships

Allows Users with rights to add and remove available related Fields to the Grid.
Related Fields can be added if the Relationship is a 1-1 non-external
Relationship that does not have the "Exclude Relationship from Grid
customization" check box selected on the Advanced page of the Relationship
properties.

Show Grouping  

Radio buttons

• Yes: Displays the Group By box.

• No: Hides the Group By box.

• Based on System Default (Yes or No): Ability to show Group By box is
based on the default Grid display settings (defined in
Blueprint>Tools>Options).

Remember Current
Grouping Between
Uses

Allows grouping persistence.
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Make a Grid the Default Grid
Use the Grid Editor (accessed from within a Blueprint in CSM Administrator) to make a Grid the default
Grid for the Business Object. The default Grid is shown by default when the Business Object is accessed.

To make a Grid the default Grid:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. In the Business Object tree, click the Business Object to access the desired Grids.

Tip: Filter the Business Objects by clicking the Major, Supporting, Lookup, and All radio buttons.

3. In the Appearance area of the Object Manager, click the Edit Grid link.

Tip: Also access the Edit feature by clicking View>View Grid on the Blueprint Editor menu bar or
clicking the Grid toolbar button on the Blueprint Editor toolbar.

4. In the Grid drop-down, select the Grid to open.

5. From the Grid menu bar, select Grid>Make this the Default Grid.

A confirmation window opens.

6. Click Yes to confirm.

The Grid now appears at the top of the Grid drop-down list as Default Grid.

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Configuring Grids
Grid configuration procedures are completed in CSM Administrator.

To configure Grids:

1. Define Business Object Grid Options: Customization properties are defined as part of a Grid's
definition and control the ability to reorder columns and add/remove Fields on a specific Grid.

2. Configure Grid security rights: Configure who can access Grid functionality and data. (Grid security
rights are grouped with Application security rights. For more information, see Configure Application
Security Rights.)

3. Configure global Grid display settings: Enable Grid groupings and define default display options.
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HTML Pages
A CSM HTML Page is an HTML-coded web-like page used to display information on a CSM Customer
Portal Site or in the CSM Browser Client.
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About HTML Pages
HTML Pages can be:

• Internal HTML Pages: HTML pages that Users design and code. Users can insert CSM commands
directly into the page, as well as CSM Images, Tokens, Stored Values, etc.

• External HTML Pages: Existing websites. Users supply the URL.

Use an HTML Page to display:

• A company website as Startup Item on a Portal Site.

• A hardware website or forum on a Portal Site (add an Action to a Site menu bar to display an HTML
page).

• A hard-coded HTML Page that Users design directly in the Browser Client.

CSM provides several OOTB HTML Pages. Use these OOTB HTML Pages as-is, edit them, or create
new HTML Pages using the HTML Page Manager. CSM also provides the HTML Page Editor to help
design and code your own Internal HTML Page.

Note: The HTML Page Editor is useful for building pages. For more advanced options, it is
assumed that Users have a working knowledge of HTML and possibly CSS.
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HTML Pages Good to Know
• Display an HTML Page as a Portal Startup Item, or add an Action to a Portal Site menu bar to

display an HTML page.

• Actions, Dashboards, Visualizations, Calendars, Widgets, and Searches can be viewed, accessed,
or run in the Portal; however, they are managed (created, edited, deleted, etc.) and configured
(security rights and defaults) only in the CSM Desktop Client and CSM Administrator.

Always consider Security rights control access to CSM functionality and are configured in the Security
Group Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure HTML Pages Security Rights
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Managing HTML Pages
HTML Pages are managed in CSM Administrator using the HTML Page Manager and the HTML Page
Editor.

There are several ways to open the HTML Page Manager.

Use the HTML Page Manager to complete general CSM Item Manager operations for HTML Pages,
including:

• Create an External HTML Page.

• Create an Internal HTML Page.

• Edit an HTML Page.

• Delete an HTML Page.

• Search for an HTML Page.

• Organize HTML Pages.

• Copy an HTML Page.

• Import/export an HTML Page.

• Find HTML Page dependencies.

• Pin an HTML Page.
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Open the HTML Page Manager
To open the HTML Page Manager:

• From the CSM Browser Client menu bar, click HTML Pages>HTML Page Manager.
• In the CSM Administrator Main window, click the Browser and Mobile category, and then click the

HTML Page Manager task.

• From within the Site Manager in CSM Administrator.
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HTML Page Editor
Use the HTML Editor to design and code your own HTML page.

To open the HTML Page Editor:

1. In the CSM Administrator Main window, click the Browser and Mobile category. In the Desktop
Client, click create a Browser Widget, click edit Dashboard, define search menu, and select HTML
Page.

2. Select the HTML Page Manager task.

3. Create a new HTML Page or select an existing HTML Page, and then click Edit.

When using a two-tier connection, a CSM login window opens. Provide your User name and
Password to open the HTML Editor tool

Note: If accessing the HTML Editor in the Desktop Client, clicking Cancel when creating a new
page does not delete the page. Select the page, and then click Delete.

CSM 9.3.0 Features 662

CSM 9.3.0 Features



Create an External HTML Page
To create an External HTML Page:

1. Open the HTML Page Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button, and then select External HTML page.

4. Define general properties for the page:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

c. Set background color: Select this check box to apply a background color to the HTML page.
Then, click the Color Selector button to select the color for the page.

5. Define additional options:
a. Click the Options button.

b. Availability: In the drop-down, select a scope.

Note: If you already selected a scope at the beginning, this is auto-filled with your selection.

c. Association:

If applicable, select a more filtered scope (example: A particular Team). <Automatic> applies
scope based on login. If not applicable, this option is grayed out.

d. Custom Image:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

e. Click OK.e. 

6. Define external page options:
a. URL: Type the URL to the external page.

Tip: Click Browse to open a browser window to locate the site.

b. Select a display option:
◦ Open page in new browser window: Click this button to display the HTML page in a new

browser window when it is accessed.
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◦ Display within portal page: Click this button to display the HTML within the Portal
window. Then, specify the size (height) of the embedded window.

7. Click OK.7. 
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Create an Internal HTML Page
To create an Internal HTML Page:

1. In the CSM Administrator Main window, click the Browser and Mobile category, and then click the
HTML Page Manager task.

2. Select a scope and subfolder (if needed).

3. Click the Create New button, and then select Internal HTML page.

4. Define general properties for the HTML Page:
a. Provide a Name (this can be searched in the CSM Item Managers).

b. Provide a Description (this can be searched in the CSM Item Managers).

c. Set background color: Select this check box to apply a background color to the HTML page.

d. Click the Color Selector button to select the color for the page.

5. Define additional options:
a. Click the Options button.

b. Availability: In the drop-down, select a scope.

Note: If you already selected a scope at the beginning, this is auto-filled with your selection.

c. Association:

If applicable, select a more filtered scope (example: A particular Team). <Automatic> applies
scope based on login. If not applicable, this option is grayed out.

d. Custom Image:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

e. Click OK.e. 

6. Click OK.6. 

The HTML Page Editor opens to format the layout/appearance of the HTML page.
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Using HTML Pages
When working with HTML Pages, Users can:

• Create an External HTML Page.

• Create an Internal HTML Page.

To View an HTML Page:

• Available HTML Pages (based on security rights): Use the HTML Page Manager.

• From the CSM Browser Client menu bar, click Pages.

• From the Portal menu bar (if configured).
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Configuring HTML Pages
To configure HTML Pages in CSM Administrator, configure HTML Pages rights.
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Image Manager
Use the Image Manager to complete general CSM Item Manager operations for Images.

Note: Creating a new image in the Image Manager means importing or linking to an image
located on your computer or in a directory. You can import/link multiple images simultaneously by
selecting them from the appropriating location and dragging them into the Image Manager.

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Culture selector:
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Displays the cultures available for platform and content strings in your system, so you can change
languages as you work with items. Available only if globalization features are enabled.

5. Manager tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.

6. Main Pane:

Displays items by View (Icon, List, or Details (Grid) and lists search results when a Search is run.
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Item Managers
CSM Item Managers help manage (view, create, edit, organize, or delete) CSM Items (Dashboards,
Search Groups, One-Steps, etc.).
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About CSM Item Managers

Notes: Some CSM Item Managers can be accessed from multiple places; Browser Client
Managers have limited functionality.

CSM Manager Accessibility

CSM Item Manager Desktop Client CSM Administrator Browser Client Mobile

Action Manager   

Attachment Manager   

Automation Process Manager    

Business Hours Manager   

Calendar Manager
* **

 

Color Palette Editor

Command Manager   

Counter Manager
*

  

Dashboard Manager
*

 

Database Server Objects Manager  
*

  

Document Repository Manager
*

 

Expression Manager
*

  

External Connection Manager  
*

  

Format Manager  
*
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Group Map Manager  
*

  

HTML Page Manager  

Image Manager
*

 

Knowledge Source Manager  
*

  

Metric Manager
*

  

One-Step Manager
*

 

Queue Manager   

Report Manager   

Role Manager    

Search Group Manager
*

 

Site Manager  
*

  

Stored Value Manager
*

  

Team and Workgroup Manager  
*

  

Theme Manager
* **

 

Twitter Account Manager   

User Manager    

Visualization Manager
*

 

Widget Manager
*
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* Note: Some Managers are accessed through the Managers menu in a Blueprint in CSM
Administrator.

**Note: View only.

E-mail and Event Monitoring provides the following CSM Item Managers:

• E-mail and Event Monitoring Manager

• Outlook Integration Manager
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CSM Item Manager Main Window (Typical)
Most CSM Item Managers look and behave similarly, although a few exhibit minute differences.

Note: For more information about specific CSM Managers (example: Dashboard Manager, One-
Step Manager, Calendar Manager, etc.), please refer to their individual documentation.

In general, use CSM Item Managers to complete the following operations:

• Run/Display: Run/display the selected item (example: Runs the selected Search Group, One-
Step™, or Report; displays a Dashboard, Widget, or Calendar).

• View/Display: View a list of available items. Double-click an item to display it in the main window.

• Create , Edit ,, and Delete: Configure items to meet your requirements.

• Search: Use the Search Control to run a search that locates and lists all items whose Display Name
and Description contain a specific word or phrase.

• Organize: Items are organized at the root level by default scope (intended audience); however,
Users can create subfolders to further organize items.

• Copy: Copy existing items as a starting point or template for a similar item.

• Rename: Rename a subfolder or item. Users cannot rename default scopes.

• Import/Export: Import/export item definitions to a .ced file to share items across systems.

• Find Dependencies: Identify where the item is used and what other items it uses, if applicable.

• Add To Task Pane/Toolbar (available only in appropriate CSM Item Managers): Use to add the• 
item to your personal Task Pane or a custom toolbar.

• Pin (available only in appropriate CSM Item Managers): Pin items to a Pinboard (in the Item
Manager) and MRU list (in the CSM Desktop Client menu bar) to make them easily accessible in
CSM.

Note: The pinning functionality allows Users to pin frequently used items to locations that
are easily accessible in CSM. For more information, see Pin a CSM Item.

• Localize: View and set localization properties (in CSM Administrator only).
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1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Culture selector:

Displays the cultures available for platform and content strings in your system, so you can change
languages as you work with items. Available only if globalization features are enabled.

5. Manager tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.

6. Main Pane:
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Displays items by View (Icon, List, or Details (Grid) and lists search results when a Search is run.

Note:

Managers look and behave differently in the Browser Client. For more information, refer to
the Browser Client documentation.
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CSM Item Manager Menu Bar (Typical)
,

File

Action Description

New Creates a new item.

Edit Edits the current selection.

Delete Deletes the current selection.

Rename Renames the current selection.

Import Imports the item definition from a saved Cherwell
Export Definition file (.ced).

Export Exports the current item to a Cherwell Export
Definition file (.ced).

Close Closes the Manager.

Edit

Action Description

Cut Moves the current selection to the clipboard, so you
can then paste it into a new location.

Copy
Creates a new item whose properties are the same
as the copied item. The new item can then be named
and customized.

Paste Inserts the cut or copied item from the clipboard.

Select All Selects all items in the current window.

Localization
Provides options for managing translated values for
items (CSM Administrator only). See Managing
Translations for Individual Definitions.

View

Action Description

Icon Displays items as icons.

List Lists items by Display Name.

Details Lists items in a detailed, sortable Grid (displays
Display Name, Description, Last Modified, etc.).
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Action Description

Show [Items] for...

Selects the scopes to display in the Manager tree.
By default, scopes are displayed for the User/Role
currently accessing the item, but Users can select to
display items for all Users, Roles, Teams, or
Customer Workgroups.

Refresh Refreshes the data.

Find Dependencies Displays other CSM Items using the selected item.

Help

Action Description

Help Opens the online help.

Contents Opens the online help.

Report Error Opens the Report Error window so you can report an
error to Cherwell Software.

CSM 9.3.0 Features 678

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=scope


CSM Item Manager Toolbar (Typical)

Action Description

Create New Creates a new item.

Edit Edits the current selection.

Delete Deletes the current selection.

New Folder Create a new folder.

Parent Folder Navigates up to the parent folder.

View

Displays items as:

• Icon: Images.

• List: List of names (Display Name).

• Details: Detailed, sortable Grid (displays Display Name, Description, Last
Modified, etc.).

Note: Multiple CSM Items provide pinning functionality in the toolbar,

which is indicated by the Pin button . For more information, see
Pin a CSM Item.

Localization Opens localization options for specific items (CSM Administrator only).
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CSM Item Manager Search Control

Action Description

Search Displays the word or phrase to search for. The drop-
down displays the most recently used (MRU) searches.

Go
Runs the search. Search results are displayed in a Grid
(if they are of the same type) or a List (if they are of
different types).
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CSM Item Manager Tree
The CSM Item Manager tree displays items in a hierarchical format, organized by scope and subfolder (if
applicable). The Manager tree also lists any Searches run during the current session.

Using the CSM Item Manager tree, Users can:

• Sort through folders by clicking the Plus button to expand the folder list (if applicable).

• Open folders by clicking the desired folder once. Items in the folder display in the CSM Item
Manager Main Pane.

• Open the CSM Item Manager tree context (right-click) menu to delete, rename, or refresh folders in
the tree.

• Organize CSM Manager items.

Good to know:

• Multiple CSM Items provide pinning functionality in the Manager tree. For more information, see Pin
a CSM Item.

• The ability to organize CSM Items is configured through security rights. For more information, refer
to the Security Rights documentation.
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CSM Item Manager Tree Context Menu
From the CSM Item Manager Tree context (right-click) menu, Users can delete, rename, and refresh the
folders in the Item Manager tree.

Note: Delete and Rename option availability depend upon a User's security rights. For more
information, refer to the Security Rights documentation.

To open the Manager tree context menu:

1. Open a CSM Item Manager.

2. In the Manager tree, right-click a folder.

The context menu opens.

3. With the context menu open, Users can:
◦ Delete: Deletes the folder (with security rights). When selected, Users are prompted Yes

(Delete), No (Cancel).

◦ Rename: Renames the folder (with security rights).

◦ Refresh: Refreshes the folder with the most up-to-date items.
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CSM Item Manager Main Pane
The CSM Item Manager Main Pane displays items by View (Icon, List, or Details (Grid)) for a selected
scope. The Manager Main Pane also lists search results from any Searches run during the current
session.

Using the CSM Item Manager Main Pane, Users can:

• View, display, or run CSM Items.

• Open the CSM Item Manager Main Pane context (right-click) menu to perform a number of actions
with the selected item.
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CSM Item Manager Main Pane Context Menu
From the CSM Item Manager Main Pane context (right-click) menu, Users can perform a variety of tasks
for items displayed in the Main Pane. The context menus differ in available actions between CSM
Administrator and the CSM Desktop Client.

Left: CSM Administrator. Right: CSM Desktop Client.

To open the CSM Item Manager Main Pane context menu:

1. Open a CSM Item Manager.

2. In the Main Pane, right-click an item.

The context menu opens.

CSM Item Manager Main Pane Context Menu Actions

Action Description

New Creates a new item.

Edit Edits the current selection.

Delete Deletes the current selection.

New folder Creates a new folder.

Cut Moves the current selection to the clipboard, so you can then paste it into a new
location.
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Action Description

Copy Creates a new item whose properties are the same as the copied item. The new
item can then be named and customized.

Paste Inserts the cut or copied item from the clipboard.

Rename Renames the current selection.

Pin

Pins items to the Pinboard and MRU list for a specified scope:

• Pin for User ([User])

• Pin for Role ([User's Role])

• Pin for other Role

• Pin for all Users

Localization Opens localization options for a selected definition (CSM Administrator only).

Add to...

Adds the selected item to one of the following:

• Blueprint (CSM Administrator only).

• Task Pane.

• Toolbar.

Refresh Refreshes the data.

Find Dependencies Displays other CSM Items using the selected item.

Note: Multiple CSM Items provide pinning functionality in the context menu. For more information,
see Pin a CSM Item.
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CSM Item Managers Good to Know
• Dependencies are important to note when editing or deleting items in CSM Item Managers. For

example, a Widget might be dependent on a specific Metric in order to show the correct data. Use
the CSM Item Manager to find dependencies between items (example: Dashboards, Reports, One-
Steps, etc.) in the CSM System. This process scans the CSM system to find everything that uses
the selected item.

• A copied item retains the same dependencies as its original. Be sure to find dependencies before
editing the item's copy.

• It is important to rename imported or exported items to ensure existing items are not overwritten.

• The ability to organize CSM Items is configured through security rights. For more information, refer
to the Security Rights documentation.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure CSM Item Manager Security Rights.
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Using CSM Item Managers
When working with CSM Item Managers, Users can perform many tasks, such as viewing and editing
items.
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Open a CSM Item Manager
There are many ways to open CSM Item Managers in CSM:

• From the CSM Desktop Client menu bar (example: Dashboards>Dashboard Manager).

• From the Browser Client menu bar (example: Dashboards>Dashboard Manager or
Tools>Calendars>Calendar Manager).

• From the Blueprint Editor menu bar in CSM Administrator (example: Managers>[Item] Manager).

• From within the other Managers and Editors in CSM (example: Access the Dashboard Manager
from within the Site Manager).

• From various selectors throughout CSM (example: Click Tools>Options>Dashboards &
Calendars in the CSM Desktop Client).

Note: Managers look and behave differently in the CSM Browser Client. For more
information, refer to the Browser Client documentation.
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Search in a CSM Item Manager
Use the CSM Item Manager Search Control (upper-right corner of each Item Manager) to find items by
name or description (example: Find all Attachments that contain the word VPN).

Good to know:

• Press CTRL+F in an Item Manager to put focus on (jump the cursor to) the Search Control.

• Item Manager searches use AND logic.

• Wildcards (*, %) can be used.

• The search includes the name and description of items. For certain Managers (notably Attachment
Manager), the contents of the item will also be searched.

• CSM searches the selected folder and its subfolders. (Typically, the selected folder is scope.)
Examples:

◦ If the root folder (Dashboards in the screenshot) is selected, all scopes and folders are
searched.

◦ If the Team folder is selected, the Team folder and its subfolders are searched.

◦ If a Global subfolder is selected, only that subfolder and its subfolders are searched.

Note: CSM searches only displayed folders (example: If you are not currently viewing
all roles, then all roles would not be searched.

• Search results are displayed in a sortable Grid (Details View) in the Item Manager Main pane (all
other View options are disabled).

• The Search Results Grid displays an additional column called Folder, which includes the scope and
folder (example: Global/Availability or User (Bob)/My Stuff).

• When a search result is selected:
◦ Run, Edit, Delete, and Clipboard drag/drop operations work. Any copy/paste within the folder

will maintain the same scope and folder as the original item.

◦ Add, New, and View buttons are disabled.

• A list of searches for the current session is displayed in the Item Manager Tree so Users can return
to the search at any time during the session.

• Changing the association or closing the Manager clears the current search. Users can also right-
click on the search folder and choose to remove search results.

To search in an Item Manager:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

Note: CSM searches a selected folder and its subfolders, so you can search all folders in
the tree by selecting the top folder, or you can limit the search to a specific folder.

3. Provide a word or phrase in the Search Control.
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Tip: Press CTRL+F to jump your cursor to the Item Manager's Search Control.

4. Click Go or press ENTER.

Search results are displayed in a Grid in the Main pane. A list of searches for the session is
displayed in the Item Manager Tree.

Tip: To sort the results, click the column header to sort: the Up arrow  sorts the column in
ascending order (example: 1-10, A-Z, etc.); the Down arrow  sorts the column in
descending order (example: 10-1, Z-A, etc.).
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View a CSM Item
Use CSM Item Managers to view CSM Items. All available items are displayed in the Manager Main
Pane; however, items can be viewed by scope and subfolder as well. Additionally, the view of the Item
Manager can be changed to display items in different ways: by icon, in a list, or in a detailed grid.

To view CSM Items in the CSM Item Managers:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

Available items display in the Main Pane.
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View Items by Scope
In addition to viewing items by Icon, List, or Details, Users can also change the items they view in the Item
Managers by scope depending upon their security rights and security groups.

For example, Henri is both a Technician and a Service Desk Manager. Initially, he may only be able to
view items based on his Role as a Technician. By selecting to view items in the Item Managers for all his
Roles, Henri can then see items allocated to his Role as a Service Desk Manager as well as a Technician.

To change the view of items in the Item Managers by scope:

1. Open a CSM Item Manager.

2. In the menu bar, click View, and then select from the following options.

Action Description

Show [Items] for all my Roles Displays items for all Roles the current User belongs to
(example: Technician and Service Desk Manager).

Show [Items] for all Roles Displays items for all Roles.

Show [Items] for all Users Displays items for all Users.

Show [Items] for all Teams Displays items for all Teams.

Show [Items] for Customer Workgroups Displays items for Customer Workgroups.
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Change the View of the CSM Item Manager
Within the CSM Item Managers, there are different ways to view CSM Items. Users can view items in the
Manager by:

1. Icon

2. List

3. Details

Good to know:

• In Details view, Users can sort a CSM Manager Grid column in ascending (A-Z) or descending (Z-A)
order.

Sort a CSM Item Manager Grid by column in ascending (A-Z) or descending order (Z-A).

To sort a CSM Manager Grid column:

1. Open the CSM Item Manager.

2. Set the View to Details (View>Details).

3. Click the column header to sort by:
◦ Up arrow  : Sorts the column in ascending order (example: 1-10, A-Z, etc.).

◦ Down arrow  Sorts the column in descending order (example: 10-1, Z-A, etc.).

To change the view of the CSM Item Manager:

1. Open a CSM Item Manager.

2. Click the View button on the toolbar.

3. Select from the following:
◦ Icon: Displays items in the Manager with a large icon and the name of the item below.

◦ List: Displays items in the Manager with small icons and the name of the item immediately to
the side in a list.

◦ Details: Displays items in the Manager with small icons and the details of the item in a Grid.
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Sort a CSM Item Manager Grid Column
Sort a CSM Item Manager Grid by column in ascending (A-Z) or descending order (Z-A).

To sort a CSM Manager Grid column:

1. Open a CSM Item Manager.

2. Set the View to Details (View>Details).

3. Click the column header to sort by:
◦ Up arrow: Sorts the column in ascending order (example: 1-10, A-Z, etc.).

◦ Down arrow: Sorts the column in descending order (example: 10-1, Z-A, etc.).
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Display/Run a CSM Item
Use the CSM Item Managers to display or run CSM Items. Items are viewed in the Manager Main window.
Users can display or run an item by double-clicking it.

Good to know:

• For Run items, Users can also click the Run button at the bottom of the window.

• Managers look and behave differently in the Browser Client. For more information, refer to the• 
Browser Client documentation.

To display/run a CSM Item:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Double-click theCSM Item to display/run.
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Create a CSM Item
Use the CSM Item Managers to create the different CSM Items (example: Dashboard, Report, etc.) in the
CSM system. Typically, the Manager launches a Property window to define the properties/behaviors for
the item.

Good to know:

• Managers look and behave differently in the Browser Client. For more information, refer to the• 
Browser Client documentation.

To create a CSM Item:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. The following actions are available:
◦ Click the Create New button .

◦ In the CSM Item Manager window, right-click>New.

◦ From the CSM Item Manager menu bar, select File>New.

The item's Property page or Editor opens to create a definition.

4. Save changes.
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Edit a CSM Item
Use the CSM Item Manager to edit existing CSM Items (example: Dashboards, Reports, One-Steps etc.).
Edit CSM Items when information needs to be updated (example: Adding a new Field to a Report) or
changed (example: Changing the text in an e-mail One-Step).

Good to know:

• Editing items does not affect past versions (example: Adding a new Field to a Report only adds the
Field for present and future Reports). However, dependencies between CSM Items might be
affected when editing items. For example, a Widget might be dependent on a specific Metric in order
to show the correct data. Editing the Metric to display a different set of data could result in incorrect
data displaying or a broken Widget.

• Dependencies are important to note when editing or deleting items in CSM Item Managers. Click the
Dependencies button to scan CSM for everything that uses the item.

• Managers look and behave differently in the Browser Client. For more information, refer to the• 
Browser Client documentation.

To edit a CSM Item:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Click the CSM Item to edit, and then do one of the following:
◦ In the CSM Item Manager toolbar, click the Edit button.

◦ From the CSM Item Manager window, right-click>edit.
◦ Select the Edit tab in the CSM Item Manager menu bar.

The item's Property page or Editor opens so that you can make changes.

4. Save the changes.
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Delete a CSM Item
Use the CSM Item Managers to delete CSM Items (example: Dashboards, Reports, etc.). For example,
you might want to delete obsolete Searches or Dashboards that are no longer used.

Good to know:

• Deleting items in the CSM Item Managers does not delete the items associated with them (example:
Widgets associated with Dashboards). However, there may be dependencies between CSM Items
that can be affected when deleting items.

• Dependencies are important to note when editing or deleting items in CSM Item Managers. Click the
Dependencies button to scan CSM for everything that uses the item.

• Managers look and behave differently in the Browser Client. For more information, refer to the• 
Browser Client documentation.

To delete a CSM Item:

1. Open the CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Click the CSM Item to delete, and then select one of the following:

◦ Click the Delete  button.

◦ From the CSM Item Manager window, right-click>Delete.

◦ From the CSM Item Manager menu bar, select File>Delete.

4. Click Yes to confirm the deletion.
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Copy a CSM Item
Use the CSM Item Managers to copy and paste existing CSM Items (example: Dashboard, Report, One-
Steps etc.) to use as a starting point or a template for another CSM Item.

Good to know:

• A copied item retains the same dependencies as its original. Be sure to find dependencies before
editing the item's copy.

• A copied item is named Copy of... by default. Rename copied items to avoid confusion between the
original and the copied item.

• Managers look and behave differently in the Browser Client. For more information, refer to the• 
Browser Client documentation.

To copy a CSM Item:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Click the CSM Item to copy, and then select one of the following:
◦ In the CSM Item Manager window, right-click>Copy.

◦ From the CSM Item Manager menu bar, select Edit>Copy.

4. Paste the item using one of the following:
◦ In the CSM Item Manager window, right-click>Paste.

◦ From the CSM Item Manager menu bar, select Edit>Paste.

5. (Optional but recommended) Rename the copied item.
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Import/Export a CSM Item
Use the CSM Item Managers to import/export items (example: Dashboards, Reports, etc.) as .ced files
across CSM systems.

Good to know:

• It is important to rename imported or exported items to ensure existing items are not overwritten.

• Managers look and behave differently in the Browser Client. For more information, refer to the• 
Browser Client documentation.

To export a CSM Item:

1. Open the CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Click the CSM Item to export.

4. From the CSM Item Manager menu bar, select File>Export.

The Export To window opens.

5. Provide a filename and location to export the item as a .ced file.

6. Click Save.

To import a CSM Item:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. From the CSM Item Manager menu bar, select File>Import.

The Import From window opens.

4. Locate a .ced file to import, and then click Open.
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Organize CSM Manager Items
Use the CSM Item Manager tree and Main Pane to organize CSM Items (example: Dashboards, Reports,
One-Steps etc.). Items are organized at the root level by scope (intended audience) and can be further
organized by subfolders. CSM Items in the Managers can be organized within folders by purpose
(example: Portal Dashboards), theme (example: Executive Dashboards), or any categorization that suits
company needs.

Good to know:

• The ability to organize CSM Items is configured through security rights. For more information, refer
to the Security Rights documentation.

• Managers look and behave differently in the Browser Client. For more information, refer to the• 
Browser Client documentation.

To create a subfolder to organize CSM Items:

1. Open a CSM Item Manager.

2. Place your cursor in the scope or subfolder where you want to create the folder.

3. Click the Create a New Folder button.

A new folder is created, with the pending name highlighted.

4. Provide a name for the folder, and then click away from the folder to save the name.

5. Users can now:
◦ Drag-and-drop CSM Items into the folder.

◦ Rename the folder by right-clicking the folder and selecting Rename.
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Find CSM Item Dependencies
In CSM, a dependency is the bond of an item in the system that uses or relies upon another item to
function. For example, a Widget might be dependent on a specific Metric in order to show the correct
data. Use the CSM Item Manager to find dependencies between items (example: Dashboards, Reports,
One-Steps, etc.) in the CSM System. This process scans the CSM system to find everything that uses the
selected item.

Good to know:

• Dependencies are important to note when editing or deleting items in CSM Item Managers.

• The Find Dependencies option can be found in the View menu from the CSM Item Manager menu
bar, as well as the context (right-click) menu in the Manager Main Pane.

• Managers look and behave differently in the Browser Client. For more information, refer to the• 
Browser Client documentation.

To find CSM Item dependencies:

1. Open the CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Run the dependencies scan one of two ways:
◦ Right-click the CSM Item, and then select Find Dependencies.

◦ Select the CSM Item, and then select View (menu bar)>Find dependencies.

A scan runs and results are displayed in the Definition Dependencies window.

4. (Optional) Click the Edit button to change the scope selected for the dependencies scan.

The Scopes used for Dependency Scan window opens.

5. Select the scopes to include, and then click OK.

6. Click the Refresh button to scan for dependencies using the new scope.

Note: Select the Show full path check box to show the full path of the scan. This is useful
when copying or deleting items to ensure dependent items are not affected by changes
made to the selected item.
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Add a CSM Item to the Task Pane or Toolbar,
Toolbar, or Blueprint

Some CSM Item Managers support adding a CSM Item to a personal Task Pane or a custom toolbar
directly from the CSM Item Manager (example: in the Dashboard Manager, add a Dashboard to your
toolbar). Some CSM Item Managers also support adding a CSM Item to a Blueprint from an Item Manager
opened in CSM Administrator. The following CSM Item Managers support adding items to the Task Pane/
toolbar:

• Dashboard Manager

• Search Group Manager

• One-Step Manager

• Visualization Manager

• Calendar Manager

• Report Manager

Note: This feature is not available when accessing the CSM Item Managers from CSM
Administrator. Items cannot be added to Blueprints in the CSM Desktop Client.

To add a CSM Item to the Task Pane/toolbar:

1. Open a CSM Item Manager.

2. Select a scope and subfolder (if needed).

3. Right-click the CSM Item to add to the Task Pane/toolbar, and then select Add To>:
◦ Task Pane: Adds the item to your Task Pane (in the Common Tasks area).

◦ Toolbar: Adds the item to a custom toolbar. Select an existing toolbar or create a new one.

Note: This option is also available from the File menu (File>Add To).

◦ Blueprint: Adds the item to a Blueprint. This option is only available in CSM Administrator.

4. Click OK.4. 
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Pin a CSM Item
Use CSM Item Managers to pin frequently used items to locations that are easily accessible in CSM.
When a CSM Item is pinned, a pin icon displays on the selected item, and the pin is added to the
Pinboard (in the CSM Item Manager tree) and MRU list (in the CSM Desktop Client menu bar, if
applicable).

Pinning is available for the following CSM Items:

• Attachments

• Actions

• Business Hours

• Calendars

• Commands

• Counters

• Dashboards

• Document Repositories

• E-mail and Event Monitors

• Expressions

• HTML Pages

• Knowledge Sources

• One-Steps

• Queues

• Reports

• Search Groups

• Stored Values

• Themes

• Visualizations

Good to know:

• Pin and unpin CSM Items in CSM Item Managers using the CSM Item Manager toolbar or context
menu.

• The number of items that can be pinned to the Pinboard and viewed in the MRU list at one time is
defined in the Cherwell Service Management Options window (Tools>Options>General Options
page>MRU (Most Recently Used) Items section).

• The scope of a CSM Item is identified by a pin icon:

◦ Pins that are visible for the current User are identified by a blue pin icon .

◦ Pins that are visible for the current User's Role are identified by a red pin icon .
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◦ Pins that are visible for an alternate Role of the current User are identified by a red pin icon

.

◦ Pins that are visible to all Users are identified by a green pin icon .

◦ Pins that are visible for multiple scopes are identified by a purple pin icon .

• When a CSM Item is pinned, a pin icon displays on the selected item, and the pin is added to the
Pinboard and MRU list.

• Pinned items display above MRU items in the MRU list and are indicated by a purple pin icon .

• Locate the original scope of a pinned item by right-clicking the item and selecting Pinning>Go to
Item.

• Organize pinned items in the Pinboard folder by using the Up and Down buttons on the CSM Item
Manager toolbar or by right-clicking the item and selecting Pinning>Move Up or Move Down. Users
can also drag-and-drop items to a new location within the same scope. Items in the MRU list display
in this order.

• Managers look and behave differently in the Cherwell Browser Client. For more information, refer to
the Cherwell Browser Client documentation.

• The ability to pin CSM Items is configured through security rights. For more information, refer to the
Security Rights documentation.

To pin a CSM Item:

1. Open a CSM Item Manager.

2. In the CSM Item Manager toolbar, click the down arrow on the Pin button.

3. Select Pinning from the drop-down, and then select a scope for the pin:
◦ Pin for User ([User]): Pin is visible in the current User's Pinboard folder and in the current

User's MRU lists.

◦ Pin for Role ([User's Role]): Pin is visible in the current User's Pinboard folder and in the
current User's MRU lists for the Role that the User is currently using. It is also visible to other
Users who are using the Role.

◦ Pin for other Role: Pin is visible in the current User's Pinboard folder and in the current User's
MRU lists for a Role that the User has, but is not currently using. It is also visible to other
Users who are using the Role.

◦ Pin for all Users: Pin is visible in Pinboard folders and MRU lists for all CSM Users.

A pin icon displays on the selected item, and the pin is added to the Pinboard and MRU list.

4. Users can now:
◦ View pinned items in the Pinboard folder.

◦ View pinned items in the MRU list, if applicable.
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Configuring CSM Item Managers
To configure Item Managers in CSM Administrator, configure Managers security rights.
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Knowledge
A Knowledge Article (KA) is a record that shares Knowledge (example: FAQs, how-tos, workarounds/
solutions, tutorials, processes, reference, etc.) among Users and Customers.
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About Knowledge
CSM consolidates multiple Knowledge Sources into a single, powerful Knowledge Base so that Users can
find relevant information quickly without the use of outside resources. Depending on the configuration of
your system, Users might also have access to Knowledge through the Portal so that they can
independently solve issues. For example, CSM Knowledge can come from many different Knowledge
Sources, including:

• Knowledge Articles (KAs): CSM Business Object dedicated to Knowledge. Use to share identified
solutions with Users and Customers. Note that KAs can also be imported from third-party
Knowledge providers (ex: KnowledgeBroker).

• Business Object records: Closed Incidents or Problems (Known Errors), or any other appropriate
Business Objects.

• Attachments: Imported internal or external documentation.

• Web: Adobe®, Google®, Microsoft TechNet®, Twitter®, Yahoo!®, YouTube®, etc.

In the CSM Desktop Client, Users search for Knowledge using the:

1. Quick Search: Use to search only KAs (or other Business Objects).

2. Knowledge Pane: Use to search all Knowledge Sources. You can search in general or while on a
Business Object record (if configured). Searchable Knowledge Sources and searching options vary
by Business Object so that the Knowledge Search is always appropriate (controlled by your system
administrator through Knowledge Mapping).
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In the Portal, Customers can search for KAs using a Portal Site's configured Search Control or the
Knowledge Article Dashboard. When in a KA in the Portal, Customers can vote on article popularity by
clicking the Like/Dislike buttons, increment Usage Counts by noting whether or not it resolved their issue
(Yes/No), and add feedback by clicking the Add a Comment link.

Knowledge Sources are managed in CSM Administrator, typically by a system administrator, using the
following:

1. Knowledge Source Manager: Use the Knowledge Source Manager to create, edit, delete, and
organize your Knowledge Sources.

2. Knowledge Mapping: Use Knowledge Mapping to determine when and how a Knowledge Source
can be searched/used (ex: A mobile device website might be displayed as a searchable Knowledge
Source while on a Config - Mobile Device record but would not be appropriate when on a Customer
record; a KA might be used to populate a solution Field on an Incident but a website might be
attached).

3. Knowledge Importing: Use the Import Knowledge Wizard to import third-party KAs (from
KnowledgeBroker) into your Knowledge Base.

Knowledge Security is also managed in CSM Administrator, typically by a system administrator. A
Knowledge Team is available to manage your Knowledge Article workflow.
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Knowledge Good to Know
• Use the Knowledge Pane, Search Control, or Quick Search Pane to access Knowledge Sources to

troubleshoot and find solutions.

• Use Knowledge Articles to create Knowledge and share identified solutions with other Users and/or
Customers.

• Knowledge behaves a bit differently in the CSM Browser Client. For more information about Browser
Client Knowledge, refer to the Browser Client documentation.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For detailed
information, see Configure Knowledge Security Rights.

CSM 9.3.0 Features 710

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=csm_desktop_client_search_control
https://help.cherwell.com/csh?topicname=quick_search_pane
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fknowledge%2F..%2F..%2Fshared%2Fabout_knowledge_articles.html
https://help.cherwell.com/csh?topicname=about_the_csm_browser_client
https://help.cherwell.com/csh?topicname=configure_knowledge_security_rights


About Knowledge Articles
A Knowledge Article (KA) is a record that shares Knowledge (ex: FAQs, how-tos, workarounds/solutions,
tutorials, processes, reference, etc.) among Users and Customers. KA examples include:

• How to print a Microsoft Excel worksheet.

• A list of e-mail error messages with potential fixes.

• An overview of a cell phone's location awareness capabilities.

Typically, any CSM User can create, access, comment, and vote on KAs; however, a Knowledge Team is
responsible for approving (through a defined Knowledge Article Approval Process), publishing, and
managing KAs. If configured, Customers in the Portal can also access, comment, and vote on KAs.
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Knowledge Article Good to Know
• A Knowledge Article (KA) is a record that shares Knowledge (ex: FAQs, how-tos, workarounds/

solutions, tutorials, processes, reference, etc.) among Users and Customers.

• Search for one or more KAs that meet a specific criteria by running a Quick Search or a Search
Group. From a record, use the Knowledge Pane to search for KAs.

• Create a new KA by clicking New>New Knowledge Article on the CSM Desktop Client toolbar or
File>New>New Knowledge Article from the CSM Desktop Client menu bar.

• Knowledge Team members have more rights than most Users; they can view and edit more, they
have access to the Knowledge Management Dashboard, they have access to more One-Steps, they
have approval rights, and they can bypass the workflow statuses (going straight to Approval or
Published, or back to Draft and Review).

• CSM provides two Knowledge Dashboards: A Knowledge Article Dashboard for viewing KA metrics
and a Knowledge Management Dashboard for managing the KA workflow.

• CSM implements several OOTB Actions/One-Steps to make KA management more efficient. For
more information about Actions and One-Steps, refer to the Action/One-Step documentation.

• CSM provides several OOTB Automation Processes to automate KA management. For more
information, refer to the Automation Process documentation.

• If enabled (via an Automation Process), an e-mail notification is automatically created and sent to:
◦ The User owner to notify him of ownership.

◦ Team owners to notify them of ownership.

◦ The KA owner when a Journal is added to the KA.

• Journals track what occurs during the record's lifecycle (ex: Notes to track progress or comments;
and History to track important field changes, e-mail correspondence, etc.). View or add Journals by
clicking the Journal tab in the record's Arrangement.

• Attachments supplement records by providing additional details in the form of linked/imported
documents, images, and ad-hoc records. View and manage Attachments using the Attachment

button  and Attachments bar.

• The Quick Info Tile (left) displays important at-a-glance information:
◦ The Status bar indicates the current status of the KA as it moves through its workflow. The

next status is displayed as a link directly beneath the current status. Click the status link to
move the KA to the next status. Some KA status links change the status and move the KA to
the next phase; others initiate an Action/One-Step, as well, to automate the process in some
way (ex: The Request Approval status link initiates the Knowledge Approval Process).

Note: Typically, workflows statuses should be enforced; however, some records do
allow Users (with rights) to bypass statuses (ex: Knowledge Team members can
manually publish KAs without formally sending them for review or approval). To bypass
a status, click one of the alternate statuses in the I Want To section of the Quick Info
Tile.

◦ The Owner section displays the current owner (oneself, a User, or a Team). A KA can be
assigned to a owner in the New and Draft phases by clicking one of ownership links in the
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Quick Info Tile; however, ownership will be automatically reassigned to the Knowledge Team//
Knowledge Team member in the Review phase.

• The workflow bar (top of Main Pane) tracks the KA as it progresses through the KA workflow
phases. Dark gray indicates the current phase.

• The Main Pane toggles between two embedded forms: a simple Article form, which shows the KA
Title and Solution/Workaround, and a more detailed Details form, which shows all KA information on
a single form. Use the Article/Details links to toggle between the two embedded forms.

• Fields:
◦ Required fields are often conditional, meaning some are required to save a record, some are

required to change the status of a record, some are required to "close" the record, etc. You will
be reminded when fields are required, either by a red box around the field or by a reminder
message.

◦ The Solution or Workaround field is a Rich Text field so formatting and images/screenshots
can be used to complement the text. To format the text or embed an image, click the Zoom
button .

◦ Some validated fields can recognize what you are typing and will suggest a value for you (ex:
Type "P" into the field; CSM will suggest the first item it finds that starts with the letter P). Use
your Down Arrow button to scroll through other possible values.

◦ Press F3 is a validated field to open a Selector window, and then select a legal value or create
a new value.

◦ Press TAB to move to the "next" field on the form.

• Saving:

◦ Date, time, and user name information is recorded the first time the form is saved, and each◦ 
time the form is modified.

◦ Saving  triggers an audit of the KA fields that are being tracked for changes (Status, Title,
Solution/Workaround, and Review Date). If a change is detected in one of those fields, a
Journal-History record is created to track the change (ex: a Journal-History record is created to
track adding a solution to the KA or changing the KA status). View the changes in the KA
Journals tab (Arrangement section).
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Knowledge Article Features and Capabilities
CSM Knowledge Management has numerous features and capabilities:

• Knowledge Sources: Use Knowledge from multiple sources (KAs, Business Objects, Attachments,
Web, third-party KnowledgeBroker). Manage your sources using the Knowledge Source Manager.

• Knowledge Mapping: Use Knowledge Mapping to control which Knowledge Sources should be
used, when they should be used, and how to use appropriate solutions.

• Knowledge Import: Import canned Knowledge from third-party knowledge providers (ex:
KnowledgeBroker).

• Searching: Search for Knowledge using the robust CSM Desktop Client Knowledge Pane. Search
from within CSM, a CSM record, or the Portal.

• Security: Secure Knowledge by controlling who can log, approve, publish, and access Knowledge.
Use the built-in Knowledge Team to allow access to the Knowledge Management Dashboard and to
allow security rights to review/approve/publish KAs.

CSM KAs also have numerous features and capabilities:

• Searching: Quickly locate all KAs by running a Quick Search, or search for a particular KA or set of
KAs by refining the search criteria to a word/phrase, timeframe, status, etc. Use Search Group to
save/run commonly-run Searches.

• Search Groups: Use Search Groups to quickly locate/filter KAs, or to automate searching in
Reports or on Dashboards.

• Security: Secure KAs by controlling who can view, create, edit, and delete records. Use the built-in
Knowledge Team to allow access to the Knowledge Management Dashboard and to allow security
rights to review/approve/publish KAs.

• Business Object: Use the dedicated Knowledge Article Business Object to create/manage User or
third-party KAs; configure the Business Object to capture/track only what you want.

• Form: Use the powerful KA Form to log, manage, track, and use KAs. The form provides a Quick
Info Tile to display important at-a-glance information, such as KA ID, Status bar (current and next
status), Popularity bars (Like/Dislike votes), record ownership, voting buttons, and common
operations (I Want To), a workflow bar to track the KA as it progresses through the KA workflow
phases, a Main Pane that toggles between simple and detailed KA information, and an Arrangement
to dynamically display linked child records, such as Journals (to comments and history), Approvals
(to track who approved the KA and when), and Incidents and Problems (to track the source of the
KA, if applicable).

• Workflow: Use the streamlined KA workflow to move a KA from New to Published.

• Creation flexibility: Log a KA manually or from an Incident/Problem.

• Ownership: Assign each KA to a record owner to ensure accountability.

• Approval Process: Use the defined Knowledge Article Approval Process to automate and regulate
approving/denying/abstaining KAs. The Knowledge Approval Process contains automatic
notifications, tracking, and publishing.

• Approval tracking: Use linked Approvals to track who approved/denied/abstained a KA, and when.
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• Linked records: Link child records to a parent KA Record to keep supporting information at your
fingertips and to ensure data relationships. Linked child records are displayed in the KA
Arrangement.

• History and Revision tracking: Use linked Journals to track important status and Field changes.

• User and Customer comment tracking: Use linked Journals to track User and Customer
comments.

• E-mail correspondence tracking: Use linked Journals to track e-mail correspondence with
Approvers.

• Popularity and usage counts: Use voting on KA Forms in CSM and in the Portal to track
popularity and usage. View statistics on the KA Forms and Knowledge Management Dashboard.

• Rich Text: Use Rich Text to complement your Solutions/Workarounds by adding formatting and
images/screenshots.

• Automated review cycle: Use the Review Date to automatically schedule reviews. By default,
reviews are automatically scheduled one year from the publish date.

• Retirement: Retire out-of date KAs.

• Actions/One-Steps: Use powerful Actions and One-Steps to move KAs through their workflow,
initiate common operations (ex: Assign ownership), run Reports, etc. Actions/One-Steps are
available on the KA Form and Dashboards.

• Dashboards: Use the Knowledge Management Dashboard to manage the KA workflow. The
Dashboard displays the number of KAs in each phase of the workflow (New/Draft, Submitted,
Awaiting My Approval, and Up for Review), the number of new Customer/User comments, the Most
Used and Popular KAs, and KA contributions by Team/User. Use the Knowledge Article Dashboard
to view all KAs and to view critical usage counts.

• Reports: Run Reports to show up-to-date statistics (ex: Most/Least Popular KAs and Most Used
KAs).

• Automation Processes: Use Automation Processes to automatically publish KAs (as part of the
Knowledge Approval Process) and send notification e-mails to User Owners and Team Owners.
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Knowledge Article Workflow
The following figure shows the high-level KA process workflow in the OOTB system.
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Note: CSM uses several features to manage the KA workflow (ex: The Knowledge Article Form
helps create, manage, track, and use KAs, One-Steps help move the KA through its workflow,
Automation Processes notify stakeholders via e-mails, an Approval Process enforces Approvals, a
Knowledge Management Dashboard notifies stakeholders and tracks analytics, etc.).

Contributors
A KA typically involves the following contributors. Depending on your workflow and the size of your
organization, many of these contributors might be combined into one person:

• Creator: User who first logs the KA.

• Subject Matter Expert (SME): User who adds technical expertise to the KA.

• Owner: User who manages the KA. This is typically a member of the Knowledge Team. By default,
the Reviewer is the owner (see Reviewer).

• Reviewer: User who ensures that the KA follows company protocol. This is typically a member of
the Knowledge Team.

• Approver: User who ensures that the KA is ready for publication/distribution. This is typically one or
more members of the Knowledge Team.

• Publisher: User who publishes the KA so that it is available to Users and Customers. This is
typically a member of the Knowledge Team.

• Consumer: User or Customer who searches for and uses the KA.

Phases
The KA workflow is broken down into the following phases:

1. New: Creator logs a new KA, adding as much information as possible. Creator assigns ownership to
himself or another User/Team if necessary. Then, creator submits the KA to a SME to add technical
expertise.

2. Draft: SME adds technical expertise to the KA. Then, SME submits the KA to the Knowledge Team
for assessment/review.

3. Submitted: Knowledge Team assigns a reviewer from the Knowledge Team (Reviewer becomes
owner).

4. Review: Knowledge Team reviewer reviews the KA to ensure that the KA follows company protocol.
Then, reviewer submits the KA to the Knowledge Team for approval.

5. Approval: Knowledge Team approves the KA (KA is automatically published as a result of a defined
Approval Process (50% or more approve)). The Knowledge Team can also deny or abstain from
approval. If denied, the KA status changes back to Review and the owner is sent an e-mail, notifying
her of the denial. If abstained, the KA remains inactive until published or denied. A Knowledge Team
member can manually publish the KA, if needed.

6. Published: KA is operational in a live environment and available to consumers. KA is periodically
assessed by the Knowledge Team (KA can be sent back for review/rework or retired, if necessary).
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7. Retired: Expired/out-of-date KA is retired (this status appears only after a KA is retired). KA can be
un-retired (sent back for review/rework), if necessary.

Statuses
A KA progressing through the workflow encounters the following statuses:

Note: KA phases align with KA statuses but this is not the case in every process (ex: Incident
phases are different than Incident statuses).

1. New: KA is being created and submitted to a SME.

2. Draft: KA is being enhanced by a SME and submitted for assessment/review.

3. Submitted: KA is being assessed by the Knowledge Team and assigned to a reviewer (reviewer
becomes owner).

4. Review: KA is being reviewed by a member of the Knowledge Team.

5. Approval: KA is being approved by the Knowledge Team, and then published.

6. Published: KA is operational in a live environment.

7. Retired: KA is retired from use.
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Logging Knowledge Articles
The following instructions are available to walk you through the steps to log a new KA using our OOTB
workflow:

• Log a Knowledge Article: Typical step-by-step instructions for logging a KA.

• Log a Knowledge Article - Detailed: Detailed step-by-step instructions for logging a KA, including
tips, optional steps, and behind-the-scenes information.

Note: CSM provides an OOTB KA workflow with all the features you need to successfully
manage KAs. You can use this workflow as-is, or tailor it to meet the needs of your
organization.
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Log a Knowledge Article
The following procedure walks you through the typical steps to log a KA. The different contributors are
noted in the procedure.

To log a KA:

1. On the CSM Desktop Client toolbar, click New>New Knowledge Article.

A new KA Record is logged with a unique ID and a status of New. The KA enters the New phase.

Note: The KA Form's Main Pane toggles between two Embedded Forms: a simple Article
Form and a more detailed Details Form. When creating a new KA, complete the Details
Form (click the Details link in the upper right corner of the Form).

Note: A KA can also be submitted from an Incident or Problem by clicking one of the Submit
to Knowledge Base links on the Incident/Problem Forms. When submitted from an Incident
or Problem, the KA Description, Service Categorization (service, category, and
subcategory), and Solution/Workaround Fields are automatically populated with information
from the Incident/Problem.

2. The creator completes as much information as he can about the new KA:

Note: The Title and Service fields are required to save the record.

a. Title: Provide a title. The field provides multi-line support using line wrapping, which allows
you to view the title from top to bottom without scrolling horizontally.

b. Solution or Workaround: Provide the details of the solution/workaround.

Tip: Solution or Workaround is a Rich Text field. To format the text or embed an image, click
the Zoom button .

c. Keywords: Provide keywords to use for searching.

Note: The title and description are automatically searchable; however, if there are other terms
that should cause this KA to be found but do not appear in the main text, enter them into the
keywords field. You can also put important terms here to emphasize their importance (which
will make this KA more likely to come up when searching for the term).

d. Visible to Customer Portal: Select this check box to make the KA available to Customers in the
Portal after it is published. This check box is selected by default. If this KA contains information
that a Customer should not access, clear this check box.

e. Classify the KA:
i. Service: Select a Service.

ii. Category: Select a Category.

iii. Subcategory: Select a Subcategory, if appropriate.
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f. Categorize the KA:
i. Article Type: Select the type of KA.

Note: The creator can assign the KA to an owner (himself, another User
(Individual), or a Team) in this phase by clicking one of ownership links in the
Quick Info Tile; however, ownership will be automatically reassigned to the
Knowledge Team/Knowledge Team member in the Review phase. An Automated
Process sends an e-mail to owners to notify them of ownership.

Tip: If the creator wants to save the KA so that he can work on the KA at a later time, he

can do so ( , File>Save, or CTRL+S). The KA is saved with a status of New, and then
appears on the Knowledge Management Dashboard (New/Draft count and Candidates
bar chart) to notify the Knowledge Team of its existence. The creator or anyone with
security rights can then continue to contribute to this KA. Saving also captures a date/
timestamp for the record.

3. The creator submits the KA to a SME:
a. In the Status bar, click Submit New Article.

The KA status changes to Draft and the KA enters the Draft phase.

4. The SME (or anyone with security rights) adds technical expertise to the KA by contributing or
correcting details (ex: Add Solution or Workaround steps, Keywords, Category, Article Type, etc.).

5. When the SME is done adding content, the SME (or anyone with security rights) submits the KA to
the Knowledge Team for review:

a. In the Status bar, click Submit for Review.

The KA status changes to Submitted and the KA enters the Submitted phase. The Submitted KA is
now editable only by the Knowledge Team; however, Users can still add comments by clicking the
Add Comment link in the I Want To section of the Quick Info Tile (a comment is added as a Journal-
Note Record).

6. A Knowledge Team member assigns the KA to a reviewer (herself or another member of the
Knowledge Team) to ensure that the KA follows company protocol (spelling, style guide, etc.).

a. In the Status bar, click Assign for Review.

A window opens, prompting the Knowledge Team member to select a Reviewer from the
Knowledge Team.

b. Select a reviewer, and then click OK.

The KA status changes to Review, the reviewer becomes the owner (the ownership
information appears in the Quick Info Tile and an Automated Process sends an e-mail to
owners to notify them of ownership), and the KA enters the Review phase.

7. The reviewer/owner reviews the KA to ensure that the KA follows company protocol. For example,
she might review for grammar, spelling, company style guide adherence, proper keywords, etc.
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8. After the review is complete, the reviewer/owner requests KA approval from the Knowledge Team:
a. In the Status bar, click Request Approval.

The KA status changes to Approval and the KA enters the Approval phase.

9. Members of the Knowledge Team approve the KA:
a. On the KA Arrangement, click the Approvals tab.

The Approvals tab opens.

b. In the Approval grid, click an Approval Record.

The Approval Form opens. The Name, Team, and Details are populated per the defined
Approval Process rules.

c. (Optional) In the Comments section, provide your feedback.

d. Click Approve.

Knowledge Approval Process Notes:

◦ The KA is automatically published (via the Automation Process Engine) when 50%
approval rate is achieved.

◦ Approvals are not restricted by User so any Knowledge Team member can approve
the KA for any other member.

◦ Approval is not required to publish (any Knowledge Team member can manually
publish the KA by clicking the Publish link in the Status section of the Quick Info Tile.

◦ If an approver denies the KA (clicks the Deny button), the KA status is changed back
to Review and the owner is sent an e-mail, alerting him to the denial.

◦ If an approver abstains (clicks the Abstain button), the KA remains inactive until
published or denied.

The KA is published. The KA status changes to Published, a Review Date is automatically
scheduled for one year from the publish date, and the KA enters the Published phase. In the Publish
phase, the KA is operational in a live environment. The KA can now be searched for/used in CSM
and in the Portal (if allowed).

The KA comes up for review one year from the last publish date. The Knowledge Management
Dashboard alerts the Knowledge Team when KAs are up for review (Up For Review count).

10. A Knowledge Team member periodically reviews the KA:
a. In the Status bar, click Take Ownership and Review.

The Knowledge Team member becomes the owner (or stays the owner), the KA status changes
back to Review, the KA re-enters the Review phase, and the KA repeats the KA workflow so that it
can be republished.
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Log a Knowledge Article - Detailed
The following procedure walks you through detailed step-by-step instructions for logging a KA, including
tips, optional steps, and behind-the-scenes information. The different contributors are noted in the
procedure.

To log a KA:

1. On the CSM Desktop Client toolbar, click New>New Knowledge Article.

Tip: You can also click File>New>New Knowledge Article from the CSM Desktop Client menu bar.

A new KA Record is logged with a unique ID (ex: 10366) and a status of New. The KA enters the
New phase.

Note: The KA Form's Main Pane toggles between two embedded forms: a simple Article
form and a more detailed Details form. When creating a new KA, complete the Details form
(click the Details link in the upper right corner of the form).

Note: A KA can also be submitted from an Incident or Problem (by clicking one of the
Submit to Knowledge Base links on the Incident/Problem forms). When submitted from an
Incident or Problem, the KA Description, Service Categorization (Service, Category, and
Subcategory), and Solution/Workaround fields are automatically populated with information
from the Incident/Problem.

2. The creator completes as much information as he can about the new KA:

Note: The Title and Service fields are required to save the record.

a. Title: Type a title (ex: How To Access the CSM Online Help). The title field provides multi-line
support using line wrapping, which allows you to view the title from top to bottom without
scrolling horizontally.

b. Keywords: Type keywords to use for searching (ex: Online help, help, documentation).

Note: The title and description are automatically searchable; however, if there are other terms
that should cause this KA to be found but do not appear in the main text, enter them into the
keywords field. You can also put important terms here to emphasize their importance (which
will make this KA more likely to come up when searching for the term).

c. Solution or Workaround: Type the details of the solution/workaround (ex: Step-by-step
instructions). This field is a Rich Text field (identified by the Zoom button ), so formatting
and images/screenshots can be used to complement the text.

d. Visible to Customer Portal: Select this check box to make the KA available to Customers in
the Portal after it is published. This check box is selected by default. If this KA contains
information that a Customer should not access, clear this check box.

e. Classify the KA:
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i. Service: Select a Service (ex: Desktop Management).

ii. Category: Select a Category (ex: Misc. Software).

iii. Subcategory: Select a Subcategory, if appropriate (ex: Leave blank).

f. Categorize the KA:
i. Article Type: Select the type of KA (ex: How To):

◦ Error Message

◦ How To

◦ Problem/Symptom

◦ Workflow

Note: The creator can choose to assign the KA to an owner (himself,
another User (Individual), or a Team) in this phase by clicking one of
ownership links in the Quick Info Tile; however, ownership will be
automatically reassigned to the Knowledge Team/Knowledge Team
member in the Review phase. An Automated Process sends an e-mail to
owners to notify them of ownership.

Tip: If the creator wants to save the KA so that he can work on the KA at a later

time, he can do so ( , File>Save, or CTRL+S). The KA is saved with a status of
New, and then appears on the Knowledge Management Dashboard (New/Draft
count and Candidates bar chart) to notify the Knowledge Team of its existence. The
creator or anyone with security rights can then continue to contribute to this KA.
Saving also captures a date/timestamp for the record.

3. The creator submits the KA to a SME:
a. In the Status bar, click Submit New Article.

Note: If the creator is a member of the Knowledge Team, he can bypass statuses in
the KA workflow, and go straight to Approval and Published by clicking the appropriate
links in the I Want To section of the Quick Info Tile.

The KA status changes to Draft and the KA enters the Draft phase. The Draft KA now appears on
the Knowledge Management Dashboard (New/Draft count and Candidates bar chart) to notify the
Knowledge Team of its existence. If the SME is not a member of the Knowledge Team, she must be
manually notified.

4. The SME (or anyone with security rights) adds technical expertise to the KA by contributing or
correcting details (ex: Add Solution or Workaround steps, Keywords, Category, Article Type, etc.).

5. When the SME is done adding content, the SME (or anyone with security rights) submits the KA to
the Knowledge Team for review:

a. In the Status bar, click Submit for Review.
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Note: If the SME is a member of the Knowledge Team, she can bypass statuses in the
KA workflow, and go straight to Approval and Published by clicking the appropriate
links in the I Want To section of the Quick Info Tile.

The KA status changes to Submitted and the KA enters the Submitted phase. The Submitted KA is
now editable only by the Knowledge Team; however, Users can still add comments by clicking the
Add Comment link in the I Want To section of the Quick Info Tile (a comment is added as a Journal-
Note record). The Submitted KA appears on the Knowledge Management Dashboard (Submitted
count and Candidates bar chart) to notify the Knowledge Team that it is ready to be assigned for
reviewed.

6. A Knowledge Team member assigns the KA to a reviewer (herself or another member of the
Knowledge Team) to ensure that the KA follows company protocol (spelling, style guide, etc.). This
reviewer automatically becomes the owner. An Automated Process sends an e-mail to owners to
notify them of ownership.

a. In the Status bar, click Assign for Review.

A window opens, prompting the Knowledge Team member to select a reviewer from the
Knowledge Team.

b. Select a reviewer, and then click OK.

Note: If the KA is not ready for review, the Knowledge Team member can send it back
to the creator or SME (or any selected User) for rework by clicking the Update/Revise
Article link in the I Want To section of the KA Quick Info Tile. If sent back for rework,
the KA status changes back to Draft and the KA repeats the KA workflow. A
Knowledge Team member can also bypass statuses in the KA workflow, and go
straight to Approval and Published by clicking the appropriate links in the I Want To
section of the Quick Info Tile.

The KA status changes to Review, the reviewer becomes the owner (the ownership information
appears in the Quick Info Tile and an Automated Process sends an e-mail to owners to notify them
of ownership)), and the KA enters the Review phase. The KA appears on the Knowledge
Management Dashboard (My Articles for Review and Candidates bar chart) to notify the Knowledge
Team that it needs to be reviewed. If enabled (via an Automation Process), e-mails are also
automatically created and sent to User/Team owners to notify them of ownership.

7. The reviewer/owner reviews the KA to ensure that the KA follows company protocol. For example,
she might review for grammar, spelling, company style guide adherence, proper keywords, etc.

8. After the review is complete, the reviewer/owner requests KA approval from the Knowledge Team:
a. In the Status bar, click Request Approval.

Note: If the KA is not ready for approval, the reviewer/owner can send it back to the
creator or SME (or any selected User) for rework by clicking the Update/Revise Article
link in the I Want To section of the Quick Info Tile. If sent back for rework, the KA status
changes back to Draft and the KA repeats the KA workflow. A Knowledge Team
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member can also bypass statuses in the KA workflow, and go straight to Published or
Retired by clicking the appropriate links in the I Want To section of the Quick Info Tile.

The KA status changes to Approval and the KA enters the Approval phase. The KA then appears on
the Knowledge Management Dashboard to notify the Knowledge Team that it is awaiting approval
(Awaiting My Approval Count). The Approval status triggers the defined Knowledge Article Approval
Process. As a result, an Approval record is created and appears on the Approvals tab
(Arrangement) to track Approvals. An e-mail is also sent to Approvers (members of the Knowledge
Team) to notify them that a KA is awaiting approval.

9. Members of the Knowledge Team approve the KA:
a. In the KA Arrangement, click the Approvals tab.

The Approvals tab opens.

b. In the Approval grid, click an Approval record.

The Approval form opens. The Name, Team, and Details are populated per the defined
Approval Process rules.

c. (Optional) In the Comments field, type your feedback.

d. Click Approve.

Knowledge Approval Process Notes:

◦ The KA is automatically published (via the Automation Process Engine) when 50%
approval rate is achieved.

◦ Approvals are not restricted by User so any Knowledge Team member can approve
the KA for any other member.

◦ Approval is not required to publish (any Knowledge Team member can manually
publish the KA by clicking the Publish link in the Status section of the Quick Info Tile.

◦ If an approver denies the KA (clicks the Deny button), the KA status is changed back
to Review and the owner is sent an e-mail, alerting him to the denial.
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◦ If an approver abstains (clicks the Abstain button), the KA remains inactive until
published or denied.

Note: If the KA is not ready to publish, an approver can: 1) Send it back to the
creator or SME (or any User) for revising or to resubmit for review by clicking
the Update/Revise Article link in the I Want To section of the Quick Info Tile. If
sent back for revision, the KA status changes back to Draft and the KA
repeats the workflow. 2) Send it to back to the reviewer/owner for re-review by
clicking the the Submit for Review link in the I Want To section of the Quick
Info Tile. If sent back for re-review, the KA status changes back to Review and
the KA repeats the workflow. 3) Take ownership and complete the KA revision
herself by clicking the Take Ownership link in the I Want To section of the
Quick Info Tile. If the approver takes ownership, the KA status remains at
Approval.

The KA is published. The KA status changes to Published, a Review Date is automatically
scheduled for one year from the publish date, and the KA enters the Published phase. In the Publish
phase, the KA is operational in a live environment. The KA can now be searched for/used in CSM
and in the Portal (if allowed).

The KA comes up for review one year from the last publish date. The Knowledge Management
Dashboard alerts the Knowledge Team when KAs are up for review (Up For Review count).

10. A Knowledge Team member periodically reviews the KA:
a. In the Status bar, click Take Ownership and Review.

The Knowledge Team member becomes the owner (or stays the owner), the KA status changes
back to Review, the KA re-enters the Review phase, and the KA repeats the KA workflow so that it
can be republished.

Note: If the KA is not ready for review, the reviewer/owner can: 1) Send the KA back to the
creator or SME (or any selected User) for rework by clicking the Update/Revise Article link in
the I Want To section of the Quick Info Tile. If sent back for rework, the KA status changes
back to Draft and the KA repeats the KA workflow or 2) Retire the KA by clicking the Retire
this Article link in the I Want To section of the Quick Info Tile. If needed, a member of the
Knowledge Team, can un-retire a KA. To un-retire a KA, the Knowledge Team member clicks
the Bring Back to Review link in the Status bar (Quick Info Tile). The KA status changes
back to Review and the KA repeats the KA workflow.

Note: For more information about the KA Form fields, see Knowledge Article form. For more
information about the One-Steps that automate the workflow, see Knowledge Article One-
Steps.
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Knowledge Article Design Ideas
CSM provides an OOTB KA workflow with all the features you need to successfully manage KAs. You can
use this workflow as-is, or tailor it to meet the needs of your organization. Design ideas include:

• Fields: Change which Fields are required and when, which Fields support Rich Text, etc.

• Statuses: Change KA statuses and/or the One-Steps that are initiated when a KA enters each
status.

• Form: Change the Form theme (background and text color), tab order, and size. Change the
popularity voting buttons.

• E-mail: Change the templates that are used to create the e-mails sent by One-Steps or Automation
Processes (ex: "Approval Denied" One-Step). The e-mail templates are defined as part of the One-
Step. Or, disable/change when and to whom notifications are sent.

• Automation Processes: Enable/disable the Automation Processes that notify KA User/Team
owners of assignments.

• Approval Process: Change the approval threshold, or which One-Steps are initiated when a KA is
approved, denied, or abstained.

• Review Process: Eliminate the review process and allow any technician to publish articles.

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
down Fields (ex: Article Type).

Note: Detailed step-by-step instructions for the above is beyond the scope of this document.
Refer to the online help for this detailed information.
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Knowledge Article Features
CSM uses several features to manage the KA workflow:
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Knowledge Article Form
Use the KA Form to create, manage, track, and use KAs. The KA Form is made up of four main areas:

1. Workflow bar: Tracks the KA as it progresses through the KA workflow phases. Dark gray indicates
the current phase.

2. Quick Info Tile: Shows important at-a-glance information, such as KA ID, Status bar (current and
next status), Popularity bars (Like/Dislike votes), record ownership, Voting buttons, and common
operations (I Want To).

3. Main Pane: Shows the main form fields. The Main Pane toggles between two embedded forms: a
simple Article form, which shows the KA Title and Solution/Workaround, and a more detailed Details
form, which shows the KA Title and Solution/Workaround, as well as the keywords, Service
Categorizations, Article Type, etc.

4. Arrangement: Dynamically shows linked child records, such as Journals (to track comments, and
important field and status changes), Approvals (to track who approved the KA and when), and
Incidents and Problems (to track the source of the KA, if applicable).

The following table describes the fields on the form.
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Field Description Comments

Quick Info Tile

Important at-a-glance information, such as
KA ID, Status bar (current and next status),
Popularity bars (Like/Dislike votes),
ownership, Voting buttons, and common
operations (I Want To).

 

Knowledge
Article Record Type.

CSM automatically assigns the
Record Type based on type of record
created (New>Knowledge Article).

ID Unique record identifier (ex: 10895). CSM automatically assigns the ID
when the KA is created.

Status Bar Current and next status of the KA as it
progresses through the KA workflow.

KA statuses align with KA phases but
this is not the case in every process
(ex: Incident phases are different than
Incident statuses).

Status

Statuses include:

• New: KA is being created.

• Draft: KA is being enhanced by a
SME.

• Submitted: KA is being assessed by
the Knowledge Team and assigned a
Reviewer.

• Review: KA is being reviewed by a
member of the Knowledge Team.

• Approval: KA is being approved by the
Knowledge Team.

• Published: KA is operational in a live
environment.

• Retired: KA is retired from use.
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Field Description Comments

Next: Status Click the links to move the KA through the
KA workflow. Actions include:

One-Steps (Alt 1 Step from
Relationship, Alt 2 Step from
Relationship, or Next Step from
Relationship): Conditionally changes
the record status to next logical status
(defined by the status values in Table
Management).

Members of the Knowledge Team can
bypass the Draft, Submitted, and
Review Statuses, and go straight to
Approval or Publish by clicking the
appropriate link in the I Want To
section of the Quick Info Tile.

 Submit New Article: Submits the New KA to
a SME for technical expertise.

One-Step (Submit New Article):
Changes KA status to Draft, then pops
up a message to thank the creator.

Draft KA appears on Knowledge
Management Dashboard (New/Draft
count and Candidates bar chart).

 Submit for Review: Submits the KA to the
Knowledge Team for review.

One-Step (Submit for Review):
Changes KA status to Submitted.

KA becomes read-only and is editable
only by Knowledge Team. Users can
still contribute by adding comments
(Add Comment).Starts the

Submitted KA appears on the
Knowledge Management Dashboard
(Submitted Count and Candidates Bar
Chart).

 Assign for Review: Assigns the KA to a
Knowledge Team member for review.

One-Step (Assign to Team Member
for Review): Prompts Knowledge
Team member to select a Reviewer
(also a Knowledge Team member)
and changes KA Status to Review.
The Reviewer automatically becomes
the owner.

Available to only the Knowledge
Team.
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Field Description Comments

 Request Approval: Requests Approval for
the KA from the Knowledge Team.

One-Step (Request Approval):
Changes KA status to Approval.

The Approval status triggers the
defined Knowledge Article Approval
Process. As a result, an Approval
record is created and appears on the
Approvals tab to track Approvals. An
e-mail is also sent to the Approvers
(members of the Knowledge Team) to
notify them that a KA is awaiting
approval.

KA awaiting approval appears on
Knowledge Management Dashboard
(Awaiting My Approval Count).

Available to only the Knowledge
Team.

 

Publish: Manually publishes the KA so that
it is available in CSM for Users and in CSM
and Customers using the Portal. Note: The
Knowledge Article Approval Process
automatically publishes KAs when approved.
This is used to bypass the process.

One-Step (Publish): Changes KA
status to Published and publishes KA.

Available to only the Knowledge
Team.

 
Take Ownership and Review: Makes the
Current User the User owner so that she can
review the KA when it is due for review.

One-Step (Take Ownership and
Review Article): Changes KA status
back to Review (from Published) and
makes the Current User the KA
owner. Also, creates a Journal-History
record to track the change.

Available to only the Knowledge Team
and only when the KA status is
Published.

 Retire this Article: Retires an outdated KA.

One-Step (Next Relationship):
Changes the status to Retired.

Available to only the Knowledge Team
and only when the KA status
published.

Popularity
Bars Voting results.  
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Field Description Comments

Likes Number of Like votes.  

Dislikes Number of Dislike votes.  

Owned By Record owner.  

User owner

-select owner-

Name of the User owner. Click the link to
first select a Team, and then a User owner
(User is limited by Team).

Typically, the owner is the Reviewer and a
member of the Knowledge Team.

One-Step (Assign to Individual):
Launches the Choose Team window,
where a User can choose an Owned
By Team for the record; then,
launches the Choose User window,
where a User can choose a Primary
User from the already-selected Team.

Ownership is automatically reassigned
to the Knowledge Team/Knowledge
Team member in the Review phase.

Available to only the Knowledge Team
when KA status is Submitted,
Reviewed, or Published because the
KA is read-only to Users (and editable
only by the Knowledge Team).

Avatar Photo/graphic associated with the User
owner (from User Profile).  

Team owner

-select team-

Name of the owner Team. Click the link to
select a Team owner.

One-Step (Assign to Team): Launches
the Choose Team window, where a
User can choose an Owned By Team
for the record.

Ownership is automatically reassigned
to the Knowledge Team in the Review
phase.

Available to only the Knowledge Team
when KA status is Submitted,
Reviewed, or Published because the
KA is read-only to Users (and,
editable only by the Knowledge
Team).

Owner E-mail
Address Owner's e-mail address (from User Profile).  

Owner Phone
Number Owner's phone number (from User Profile).  

I Want To Common operations (initiate Actions/One-
Steps).  
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Field Description Comments

Take
Ownership

Click the link to make yourself (Current
User) the User owner for the KA.

One-Step (Take Ownership): Makes
the Current User the Primary User of
the record.

Ownership is automatically reassigned
to the Knowledge Team in the Review
phase.

Available to only the Knowledge Team
when KA status is Submitted,
Reviewed, or Published because the
KA is read-only to Users (and editable
only by the Knowledge Team).

View/Detailed
Date/Time Info

Click the link to open the Information
window, and then view current status,
created date and time, creator name, and
last edited date and time. Time Date/time
format is MM/DD/YYYY HH:MM.

One-Step (Date Time Stamps Popup):
Displays details for all the date/
timestamps to give a historical view.

Add Comment
Click the link to open the Prompt window,
and then provide a comment about the KA if
it is read-only.

One-Step (Add Comment): Creates a
Journal-Note record to capture the
comment; the Journal appears on the
Journals tab (Arrangement area).

Available only when KA status is
Submitted, Review, or Published
because the KA is read-only to Users
(that is, editable only by the
Knowledge Team).

Update/Revise
Article

Click the link to send the KA back to the
creator or SME (or any User) for revising.

 

One-Step (Assign Published Article for
Redraft) reverts KA from Published to
Draft Status and prompts Knowledge
Team member to select any User as
the owner so that the owner can
revise the KA. Also, creates a Journal-
History record to track the change; the
Journal appears on the Journals tab
(Arrangement area).

Available to only the Knowledge Team
and only when the KA status is
Published.
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Field Description Comments

Alternate
statuses

Click the links to bypass the workflow
statuses, and send the KA straight to
Approve or Published, or back to Review or
Draft. The options vary depending on the
phase.

Available to only the Knowledge
Team.

Voting Captures popularity votes. Used for reporting.

Like Button Click to "Like" the KA.

One-Step (Like Increment):
Increments the appropriate Popularity
Count by one (1). You can only vote
once per User.

Dislike Button Click to "Dislike" the KA.

One-Step (Dislike Increment):
Increments the appropriate Popularity
Count by one (1). You can only vote
once per User.

Workflow Bar
Displays the KA workflow phases as it
progresses through the workflow. Dark gray
indicates the current phase.

KA phases align with KA statuses but
this is not the case in every process
(ex: Incident phases are different than
Incident statuses).
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Field Description Comments

 

Workflow phases include:

• New: Creator creates a new KA, and
then submits the KA to a SME to add
technical expertise.

• Draft: SME adds technical expertise to
the KA, and then submits the KA to the
Knowledge Team for assessment/
review.

• Submitted: Knowledge Team assigns
a Reviewer from the Knowledge Team.

• Review: Knowledge Team Reviewer
reviews the KA to ensure that KA
follows company protocol, and then
submits the KA to the Knowledge Team
for approval.

• Approval: Knowledge Team approves
the KA (KA is automatically published
as a result of a defined Approval
Process (50% or more approve)). The
Knowledge Team can also deny or
abstain from approval. If denied, the
KA status is changed back to Review
and the owner is sent an e-mail,
notifying her of the denial. If abstained,
the KA remains inactive until published
or denied. A Knowledge Team member
can manually publish the KA, if
needed.

• Published: KA is operational in a live
environment. KA is periodically
reviewed by the Knowledge Team and
can be retired, if necessary.

• Retired: Expired/out-of-date KA is
retired (this option appears only after a
KA is published).

 

Main Pane   
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Field Description Comments

Article/Details
links

Toggles the Main Pane between two
embedded forms:

• Article (simple): Shows only the KA
Title and Solution/Workaround.

• Details (detailed): Shows the KA Title
and Solution/Workaround, as well as
the keywords, Service Categorizations,
Article Type, etc.

 

Usage count Number of time the KA was used by a User
(in CSM) or Customer (in Portal).  

Review (Date) Scheduled review day/month/year for the
selected KA.

Used to allow the KA to be periodically
reviewed to ensure that it is correct/
updated.

One-Step (Reset Review Date on
Publish) automatically schedules a
review one year from the last publish
date (Review field).

*Title

Title for the KA. Try to match what people will
be searching/browsing for. Tip: Include
feature name and recognizable words, such
as How To Reset a Password.

*Required.

Solution or
Workaround

Details of the solution or workaround. Use
detailed information, such as step-by-step
instruction, when necessary.

The Solution or Workaround field is a
Rich Text field, so formatting and
images/screenshots can be used to
complement the text.

Keywords

List of keywords, separated by commas and
a space, related to the KA that can help with
categorization and searching. Select
synonyms, related terms, regional versions,
usual typos, etc.

 

Classify KA Classification/Categorization.

When submitted from Incident or
Problem, the KA is automatically
classified according to the source's
classification.
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Field Description Comments

*Service

Service that the KA relates to:

• Account Management

• Conferencing/Presentation

• Desktop Management

• E-mail/Calendaring

• Employee Support

• Enterprise Apps

• IT Service Desk

• Network Services

• Printing

• Telephony/Fax

• Web Services

*Required.

Autofilled when created from an
Incident or Problem.

Category Service Category that the KA relates to (ex:
Mobile Client).

Autofilled when created from an
Incident or Problem.

Subcategory Service Subcategory that the KA relates to
(ex: Submit Incident).

Not always applicable. Autofilled when
created from an Incident or Problem.

Article Type

Type of KA:

• Error message

• How To

• Problem/Symptom

• Workflow

Autofilled if the KA is imported from a
third-party KnowledgeBroker.

Domain Technology domain. Autofilled and only used for imported
third-party KAs.

Statistics

Current statistics, which include:

• Article Used: Number of time the KA
was Used by a User or Customer.

• Article Source: Source of KA, either
CSM or a third-party KnowledgeBroker.

• Last Imported: Imported Date and
Time, if imported from a third-party
KnowledgeBroker.

Usage is tracked using the Use
Solution button (in CSM) and the
Resolve Issue votes (in the Portal).
Usage is used for reporting.

Arrangement Dynamically displays child records that are in
a relationship with the KA.  
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Field Description Comments

Journals

Displays related Journal-Note records that
are created to track User and Customer
comments, and Journal-History records that
are created to track changes to the KA
Status, Title, and Solution fields.

For more information, see Knowledge
Article Journals.

Approvals

Lists linked Approval records that are
created as part of the Knowledge Article
Approval Process to track approving/
denying/abstaining KAs.

For more information, see Knowledge
Article Approval Process.

Note: For more information about the KA One-Steps, see Knowledge Article One-Steps.
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Knowledge Article Portal Form
The KA Portal form is a simplified version of the CSM form. A Customer can edit the KA if they are the
owner; otherwise, most fields are read-only. Only members of the Portal Workgroup Manager Security
Group have the rights to create new KAs in the Portal. Customers can contribute by adding comments,
voting on popularity, and providing feedback on whether the KA resolved the issue (this increments the
Usage Count):

The following table describes the fields on the form.

Item Description Comments

Main Form

Title Title of the KA.  

Description Description of the KA.  

Did you like this article?

Like Button Click to "Like" the KA.
One-Step (Like Increment): Increments the
appropriate Popularity Count by one (1). You can
only vote once per session.

Dislike Button Click to "Dislike" the KA.
One-Step (Dislike Increment): Increments the
appropriate Popularity Count by one (1). You can
only vote once per session.

Did this resolve your issue?

Yes
Click this link to indicate that
the KA helped resolve your
issue.

One-Step (Issue resolved via Portal - show usage):
Increments the KA Usage Count by one (1) when a
Customer (in the Portal) indicates that this KA
resolved her issue. Also, pops up a message to
thank the Customer for her feedback.

No

Click this link to indicate that
the KA did not resolve your
issue. You are prompted to
create a new Incident.

One-Step (Issue not resolved via Portal-log Incident):
Prompts a Customer (in the Portal) to create a new
Incident if the KA did not resolve her issue. Also,
pops us a message that an Incident has been
created and how to track it.

I Want To...

Add Comment

Click the link to launch the
Prompt window, and then
provide a comment about the
KA.

One-Step (Add Comment): Creates a Journal-Note to
capture the comment; the Journal appears on the
Journals tab (Arrangement area).
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Knowledge Article Journals
CSM provides the following OOTB KA Journal types:

• Journal - Note: Tracks User notes/comments. For example, a User might add a comment to a KA.

• Journal - Customer Request: Tracks Customer requests/comments.a KA in the Portal.

• Journal - History: Tracks important Field changes. Tracked Fields are configurable and are defined
in the Business Object definition.

• Journal - Mail History: Tracks e-mail correspondence. For example, e-mails sent for receipt,
follow-up, resolution, and questions. For example, Approvals notifications.

Note: History Journals are automatically created by CSM. Notes are manually created in
CSM, either by clicking New Journal or by clicking an Add Comment link. Customer
Requests are manually created in the Portal.

Each Journal Type has its own unique form. Journals are child records, so they are linked to and available
from their parent records (access Journals by clicking the Journals tab in the parent record's
Arrangement).
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Knowledge Article Approval Process
The Knowledge Article Approval Process is a defined Approval Process that automates, regulates, and
tracks approving/denying/abstaining KAs. The process contains automatic notifications, tracking, and
publishing Actions.

In CSM, an Approval is a Supporting Business Object that is used with a Major Business Object (ex: a
KA) to provide support in a workflow where approvals must be obtained. Approvals are configured in a
Blueprint in CSM Administrator.

The Knowledge Article Approval Process rules are as follows:

• Approval Process is triggered by the KA status changing to Approval.

• An Approval record is created and appears on the Approvals tab (Arrangement area) to track
Approvals. The Name, Team, and Details are populated per the defined Approval Process rules.

• Approvers are members of the Knowledge Team. Approvals are not restricted by User so any
Knowledge Team member can approve the KA for any other member.

• The KA is automatically published (via the Automation Process Engine) when 50% approval rate is
achieved. The KA enters the Published phase.

• If an Approver denies a KA (clicks the Deny button), the KA status changes back to Review and an
e-mail is sent to the current owner to notify them of the denial.

• If an Approver abstains (clicks the Abstain button), the KA remains inactive until published or
denied.

Note: Approval is not required to publish a KA so any Knowledge Team member can
manually publish the KA by clicking the Publish link in the Status bar of the Quick Info Tile.
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Knowledge Management Dashboard
CSM provides an OOTB Knowledge Management Dashboard to help you manage the KA workflow.

Note: By default, the Knowledge Management Dashboard is available only to members of the
Knowledge Team and is stored in the Dashboard Manager>Dashboards>Team>Knowledge
Management folder.

The following table describes the items on the Dashboard.

Item Description Widget
Type Widget Name Widget Uses:

New/Draft Number of New/Draft KAs
(Status = New or Draft).

Text
Gauge New Articles New or Drafted

Articles Search Group
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Item Description Widget
Type Widget Name Widget Uses:

Submitted

Number of KAs submitted to
Knowledge Management
Team (Status = Submitted);
KA is editable only by
Knowledge Management
Team (read-only to everyone
else).

Text
Gauge Submitted Articles Submitted Articles

Search Group

Awaiting my
Approval

Number of KAs awaiting my
approval (Status =
Approval).

Text
Gauge

Awaiting My
Approval

My KB Approvals
Search Group

Overdue

Number of KAs awaiting my
approval (Status = Approval)
that are passed their
approval deadline.

Text
Gauge

Awaiting My
Approval Overdue

My Overdue KA
Approvals Search
Group

Up for Review
Number of KAs up for
review in the next month (or
selected timeframe).

Text
Gauge Up for Review

Published Articles
Search Group, range
= filter

Customer
Comments

Number of Customer
comments on the KA (added
to a KA in the Portal).

Text
Gauge

New
Crowdsourcing
Comments

New Crowdsourced
Comments Search
Group

Submitted
Today

Number of Customer
comments submitted today.

Text
Gauge

New
Crowdsourcing
Comments

New Crowdsourced
Comments Search
Group, range = Today

Team
Comments

Number of Team comments
on the KA (added to a KA in
CSM).

Text
Gauge

New Team
Comments

New Team Comments
Search Group

Submitted
Today

Number of Team comments
submitted today.

Text
Gauge

New Team
Comments

New Team Comments
Search Group, range
= Today

Most Used
Articles

Lists the most used KAs
(based on Usage Counts). Button Action Most Used Articles

Report

Most Popular
Lists the most popular KAs,
based on Like/Dislike
counts.

Button Action Most Popular Articles
Report

Least Popular
Lists the least popular KAs,
based on Like/Dislike
counts.

Button Action Least Popular Articles
Report

Candidates Number of KAs in queue to
be published, by Status. Bar Chart Publish

Candidates Graphs by Status

My Articles for
Review

Number of KAs owned by
me awaiting my review.

Search
Results
List

My Articles for
Review

My Working KB
Articles
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Item Description Widget
Type Widget Name Widget Uses:

Team
Contribution

Number of KAs created by
each User. Bar Chart Team Member

Contributions
Bars represent
Created By values

Updated
Articles

Number of KAs created by
each User. Bar Chart

Updated
Knowledge
Articles

Bars represent Last
Modified Date Time
values
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Knowledge Article One-Steps
CSM provides the following OOTB KA One-Steps.

One-Step Description/Actions Association Executed From

Status      

Alt 1 Step from
Relationship

Conditionally change the KA status to next
logical status (defined by the KA status
values in Table Management) and/or initiate
the next appropriate One-Step.

Knowledge
Article

 

KA Form: Status:
<Next Status>

 

Alt 2 Step from
Relationship

Next Step from
Relationship

Form      

Ownership Assigns record ownership.   

Assign to
Individual

Launches the Choose Team window, where
a User can choose an Owned By Team for
the record; then, launches the Choose User
window, where a User can choose a Primary
User from the already-selected Team.

Available to only the Knowledge Team when
KA status is Submitted, Reviewed, or
Published because the KA is read-only to
Users (and editable only by the Knowledge
Team).

Knowledge
Article

KA Form: Assign
to Individual or
Owned By links

Assign to Team

Launches the Choose Team window, where
a User can choose an Owned By Team for
the record.

Available to only the Knowledge Team when
KA status is Submitted, Reviewed, or
Published because the KA is read-only to
Users (and is editable only by the Knowledge
Team).

Knowledge
Article

KA Form: Assign
to Individual or
Owned By Team
links

Take Ownership

Makes the Current User the Primary User of
the record.

Available to only the Knowledge Team when
KA status is Submitted, Reviewed, or
Published because the KA is read-only to
Users (and editable only by the Knowledge
Team).

Knowledge
Article

KA Form: Take
Ownership link (I
Want To section)
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One-Step Description/Actions Association Executed From

Popularity      

Like Increment Increments the KA's Like votes by one (1)
when the User clicks the Like button.

Knowledge
Article

KA Form: Like
button

Other      

Add Comment

Creates a Journal-Note record each time a
User clicks the Add Comment link on the KA
Form.

Use to allow Users to contribute to the KA
after it is submitted and only editable by the
Knowledge Team.

Available only when KA status is Submitted,
Review, or Published because the KA is
read-only to Users (and editable only by the
Knowledge Team).

Knowledge
Article

KA Form: Add
Comment link (I
Want To section)

Assign
Published Article
for Redraft

Reverts KA from Published to Draft Status,
and then prompts Knowledge Team member
to select any User as the owner so that the
owner can revise the KA. Also, creates a
Journal-History record (Audit) to track the
change.

Available to only the Knowledge Team and
only when the KA status is Published.

Knowledge
Article

KA Form: Update/
Revise Article link
(I Want To
section)

Popularity      

Like Increment Increments the KA's Like votes by one (1)
when the User clicks the Like button.

Knowledge
Article

KA Form: Like
button

Note: A full list of One-Steps is beyond the scope of this document. Export a schema document
from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full list of One-Steps
associated with a particular type of Business Object (ex: Major).
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Knowledge Article Search Groups
CSM provides numerous KA Search Groups. Notable KA Search Groups include:

Search Group Returns Association Executed From

All Knowledge
Articles All KAs, regardless of status. Knowledge

Article

Updated Knowledge Articles
Widget, User-selectable
Last Modified Date Time
range; Knowledge
Management Dashboard

Articles with
Dislike Votes

KAs by their "Dislike" count, in
descending order. KAs with the
most dislikes will be at the top of
the Search Results.

Knowledge
Article

Least Popular Articles
Report; Knowledge
Management Dashboard

Articles with Like
Votes

KAs by their "Like" count, in
descending order. KAs with the
most likes will be at the top of the
Search Results.

Knowledge
Article

Most Popular Articles
Report; Knowledge
Management Dashboard

Articles with
Usage Count

KAs by their usage count, in
descending order. KAs with the
most usage will be at the top of
the Search Results.

Knowledge
Article

Most Used Articles Report;
Knowledge Management
Dashboard

My KB Approvals KAs awaiting my (Current User)
approval.

Knowledge
Article

Awaiting My Approval
Widget; Knowledge
Management Dashboard

My Overdue KB
Approvals

Overdue KAs awaiting my
(Current User) approval.

Knowledge
Article

Awaiting My Approval
Overdue Widget; Knowledge
Management Dashboard

My Working KB
Articles

KAs that are owned by me
(Current User), and are not yet
published.

Knowledge
Article

My Articles for Review
Widget; Knowledge
Management Dashboard

New Team
Comments

KAs with User comments (on the
CSM KA Form).

Knowledge
Article

New Team Comments
Widget; Knowledge
Management Dashboard

Published
Articles KAs with a status of Published. Knowledge

Article

Up For Review Widget;
User-selectable date range;
Knowledge Management
Dashboard

Submitted
Articles

KAs that have been submitted to
the Knowledge Team for Review
or Approval.

Knowledge
Article

Submitted Knowledge
Article Widget; Knowledge
Management Dashboard
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Knowledge Article Reports
CSM provides the following OOTB KA Reports.

Report Description Association Executed From

Least
Popular
Articles

Bar chart shows the top ten least
favorite KAs, ranked by number of
Dislike votes. KA details display below
the chart.

Knowledge
Article

Knowledge Management
Dashboard, Most Used Articles
button; uses Articles with
Dislike Votes Search Group.

Most
Popular
Articles

Bar chart shows the top ten most
favorite KAs, ranked by number of
Like votes. KA details display below
the chart.

Knowledge
Article

Knowledge Management
Dashboard, Most Popular
button; uses Articles with Like
Votes Search Group.

Most Used
Articles

Bar chart shows top ten most used
KAs, ranked by usage counts. KA
details display below the chart.

Knowledge
Article

Knowledge Management
Dashboard, Least Popular
Articles button; uses Articles
with Usage Count Search
Group.
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Knowledge Management Security
CSM provides special security for Knowledge Management, including an OOTB Knowledge Team.

Note: For more information about CSM Security, refer to the Security documentation.
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Knowledge Team
The OOTB Knowledge Team is called Knowledge Management. This Team is responsible for reviewing,
publishing, and managing KAs. Because of their special responsibilities, members of the Knowledge
Team have access to more Knowledge Article Tools. For example, members can:

• Access the Knowledge Management Dashboard.

• Edit a KA in any workflow phase. (Others Users can edit only in the New or Draft phase.)

• Approve/Deny/Abstain KAs.

• Send the KAs back for review/revision.

• Bypass the workflow statuses and go straight to Approval or Published.

• Bypass the Knowledge Article Approval Process and manually publish a KA.

• Access KA-related One-Steps.
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Using Knowledge
When working with Knowledge in the CSM Desktop Client, Users can:

• View the Knowledge Pane.

• Search for Knowledge using the Knowledge Pane.

• Search for Knowledge Articles in the Quick Search Pane.

• Search for Knowledge Articles from a record and use a found solution.

• Search for Knowledge Articles in the Portal.
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Knowledge Pane
Use the CSM Desktop Client Knowledge Pane in the CSM Desktop Client main window to quickly search
the configured Knowledge Sources in your Knowledge Base. The pane has the following behaviors:

• Dynamic: Searchable Knowledge Sources and options vary by Business Object. This ensures that
the Knowledge Search is always appropriate (ex: A mobile device website might available as a
searchable Knowledge Source while on a Config - Mobile Device record but would not be
appropriate when on a Customer Record).

• Collapsible and dockable: Display the pane when and where you need it. By default, the Knowledge
Pane is located on the right side of the CSM Desktop Client main window.

1. Toolbar: Displays a row of buttons for available operations.

2. Search Control: Find all Knowledge Sources that contain a specific word or phrase.
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3. Search Options: Define the scope of the search to filter the results.

4. Results Pane: View Knowledge Sources found as a result of the search.

Note: Security rights control access to CSM functionality and are configured in the Security
Group Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups).
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Open the Knowledge Pane
To open the Knowledge Pane:

1. Open the Knowledge Pane:
◦ From the CSM Desktop Client, click the Knowledge tab on the right side of the CSM Main

Pane and then click the Pin button  to dock the pane.

◦ From the CSM Desktop Client menu bar, click View>Knowledge.
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Knowledge Pane Toolbar

Item Action

Run Knowledge search.

Populate search field with text from the current record (CTRL+K keyboard shortcut):

• Pull text from the field the system administrator has configured as the search field (ex: Text
in the Incident Description area).

• Highlight the text to search and click this button. (If any text is highlighted, the search will
pull the highlighted text rather than the contents of the search field.)

• Noise words (ex: and, or, the, etc.) are automatically removed from the pulled text and a
single version of each word is searched.

Populate search field with text from the current record and immediately search
(CTRL+SHIFT+K). Equivalent to pressing CTRL+K and then clicking the Go button.

Stop the current search.

Search is based on the current record type.

Search is a general Knowledge Search.

Search all words (AND is used to separate words in search). The system finds records that
contain all of the search words (with the exception of noise words such as "the," "will," etc.). For
example, if you search for the words "printer driver," the system finds all records that contain
both words.

Search any of the words (OR is used to separate words in search). The system finds records
that contain any of the search words (with the exception of noise words). For example, if you
search for the words "printer driver," the system finds all records containing the word "printer" or
the word "driver," and also finds records that have both words.

CSM 9.3.0 Features 758

CSM 9.3.0 Features



Knowledge Pane Search Control
The Knowledge Pane Search Control allows you to create a unique Knowledge Search, or run a previous
Search again.

To run a search using the Knowledge Pane Search Control:

1. Provide a word or phrase in the Search Control text box.

Tip: Click the Down Arrow button  on the Search Control to select a word or phrase you have
previously searched.

2. Click the Go button  to run the Search.

The Search Results appear in the Knowledge Search Results Pane.
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Knowledge Pane Options
The Knowledge Pane allows you to define specific Knowledge Sources for each Search (ex: Search KAs,
but not Google or Yahoo). The Knowledge Pane is dynamic so search options vary based on the
Business Object you are searching (ex: You will see a different list of options when working on an Incident
than you will see when working on a Problem). If you are not working with a particular Business Object
(ex: When you view a Dashboard), the Knowledge Pane shows a minimal set of search options.

The following figure is an example list of search options:

Search options include the following behaviors:

• Select the Show Option check box to view options.

• Select a Knowledge Source check box (ex: Knowledge Articles) to search the corresponding
Knowledge Source.

• Click the Blue Down arrow  to view additional options (if available).

• Select the Show Rankings check box to display a number next to each search result indicating its
value as a result (based on how frequently the search term appears, how recently the record was
altered, etc.). If this option is not selected, the results are still displayed in the same order, but
without the ranking number.

Note: Certain option changes will only be applied to future Knowledge searches.
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Knowledge Pane Results
Knowledge Pane Results are based on selected Knowledge Sources. After you run a Knowledge Search,
the results appear in the bottom pane.

The following example shows results for the term "print":

To view result details, click the link associated with the result:
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Tip: Right-click the result to view the record (opens in a new window with limited functionality), go
to the record (opens the record in the CSM Desktop Client main window), or go to record in a new
window (opens in a new window with full functionality).

Note: 

Note: You must click the Browse link  under online resource results to view the content.

Depending on the type of Knowledge Source you select, the information will open in different ways,
including:
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• Attachment links open the attachment file.

• Business Object links open the associated Business Object in a new window.

• Web links open a browser in a new window.

• Knowledge Articles open in a new window.
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Search Knowledge
Use the following tools search Knowledge:

• Knowledge Pane: Search Knowledge Sources from a pane in the CSM Desktop Client main
window.

• Quick Search Pane: Search KAs from a pane in the CSM Desktop Client main window.

• Business Object Record: Search for KAs from any Business Object record

• Portal Search Control: Search for KAs in the Portal using a Site's configured Search Control.
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Search for Knowledge Using the Knowledge Pane
Use the Knowledge Pane to search for Knowledge Sources.

Good to know:

• Click the Browse link  under online resource results to view Web Knowledge.

• If the search is conducted from a record (ex: Incident), you can click the Use Solution button to link
the solution to the record. The way in which the record is linked depends on the configuration (ex:
Data could be copied into the record, a journal entry could be added, or the record could be linked
via a relationship). For Knowledge Articles, clicking the Use Solution button also increments the
KA's Usage Count.

To search for Knowledge using the Knowledge Pane:

1. Open the Knowledge Pane.

2. In the Knowledge Pane toolbar, define Knowledge Pane Search options.

3. In the Search For Field, specify a word or phrase to search (ex: Printing).

4. In the Options section, define Knowledge Pane options.

5. Click the Go button  to run the search.

Knowledge Pane Results open in the Knowledge pane.

6. Click a Knowledge Source link to view the content.

CSM 9.3.0 Features 765

CSM 9.3.0 Features



Search for Knowledge Articles Using the Quick
Search Pane

Use the Quick Search Pane to search for KAs.

Good to know:

• For more information about additional Search criteria options, see CSM Desktop Client Search
Control.

To search for KAs using the Quick Search Pane:

1. Open a Quick Search Pane.

2. Click the down arrow on the Search button, and then select Knowledge Article.

3. In the Search Knowledge Article Field, provide a word or phrase to search (ex: Printing).

4. Define search criteria:
◦ View open <Business Objects> only.

◦ Search a specific timeframe.

◦ Include relationships in the search (ex: Related Business Objects).

◦ Search Attachments (ex: Word or PDF).

5. Click the Go button  to run the search.

The Quick Search Results display in a list or Grid in the Main Pane.
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Search for Knowledge Articles from a Record and
Use the Found Solution

Use an open Business Object record to search for a Knowledge Article and attach a found solution to the
record for future reference.

Good to know:

• To place the information from the Knowledge Article into the current record, you must use the
Knowledge Pane. Searching Knowledge from the CSM Search Control or the Quick Search Pane
does not provide this option.

• If the Knowledge tab is not displayed on the right side of the CSM Desktop Client main window,
right-click the CSM Desktop Client toolbar area and select Knowledge.

• The way in which the record is linked depends on the configuration (ex: Data could be copied into
the record, a journal entry could be added, or the record could be linked via a relationship). For
Knowledge Articles, clicking the Use Solution button also increments the KA's Usage Count.

• The field in which the solution is place is defined using Knowledge Mapping in CSM Administrator.

To search for Knowledge from an open record:

1. Open a record.

2. Open the Knowledge Pane.

3. In the Knowledge Pane toolbar, define Knowledge Pane Search options.

4. In the Search For Field, specify a word or phrase to search (ex: Printing).

5. In the Options section, define Knowledge Pane options.

6. Click the Go button  to run the search.

Knowledge Pane Results open in the Knowledge pane.

7. Select a Knowledge Article that you want to view.

The Knowledge Article opens in a new window.

8. Click the Use Solution button  to link the Knowledge Article information to the record.

Note: The field in which the solution is place is defined using Knowledge Mapping in CSM
Administrator.

The solution is placed in the defined field.
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Search for Knowledge Articles in the Portal
In the Portal, Customers can search for Knowledge Articles (KAs) using a Portal Site's configured Search
Control or using the Search Knowledge Base field.
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Managing Knowledge Sources
CSM Knowledge is managed using several tools, including:

• Knowledge Source Manager: Use this tool to:
◦ Create a Knowledge Source.

◦ Edit a Knowledge Source.

◦ Delete a Knowledge Source.

◦ Search for a Knowledge Source.

◦ Organize Knowledge Sources.

◦ Copy a Knowledge Source.

◦ Import/export a Knowledge Source.

◦ Find Knowledge Source dependencies.

• Knowledge Mapping: Use this tool to:
◦ Define general Knowledge Sources.

◦ Define Portal Knowledge Search options.

◦ Define Business Object Knowledge Search options.

• Knowledge Importing: Use this tool to:
◦ Import third-party Knowledge Articles.
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Knowledge Source Types
CSM allows you to define three types of Knowledge Sources, including:
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Define an Attachment Knowledge Source
Use an Attachment Knowledge Source to search documents (ex: Microsoft Office documents, PDFs, etc.)
that have been imported into CSM using the Attachment Manager. When you define an Attachment
Knowledge Source, you define:

• General properties: Type of Knowledge Source and display name.

• Search criteria: Search categories and options.

• Solution: Option for the ability to use Attachments as a solution when on a Business Object record.

Good to know:

• Search options for this feature include Global and/or User folders, so ensure that the attachments
you want to search are placed in one or both of the folders.

• The Business Object drop-down is disabled for this type of Knowledge Source.

To define an Attachment Knowledge Source:

1. Open the Knowledge Source Manager.

2. Define general properties:
a. Source: Select Attachment in the drop-down.

b. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

3. Define Search criteria:
◦ Categories: When a search is launched from a Business Object that has categorization (ex:

An Incident with a Network category and Performance subcategory), the categories will be
passed to the Knowledge Source. If you select the Add to Search String option for each of
these categories, then the words that appear in the categories will be added to the list of words
that must be found.

◦ Allow Users to ignore categories: Select this check box to give the User the ability to
specify whether the category values should be included in the search or not. Otherwise, the
category values will always be passed.

◦ Allow User to limit by date: Select this check box to give the User the option to only find
Attachments that were created or modified within a certain period of time (ex: Within the past
week). Otherwise, all Attachments will be searched, regardless of when they were modified.

◦ Search global attachments: Select this check box to search the Global folder of the current
User in the Attachment Manager.

◦ Search User attachments: Select this check box to search the current User's folder in the
Attachment Manager.

4. Define the solution:
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◦ Solution can be put into Business Object Attachment: Select this check box to give Users the
ability to select the Use Solution option (attaches the Knowledge Source to the current record)
if an appropriate Attachment is found.
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Define a Business Object Knowledge Source
Use a Business Object Knowledge Source to search a specific type of Business Object (Incident,
Problem, etc.) as well as its children and attachments. When you define a Business Object Knowledge
Source, you define:

• General properties: Type of Knowledge Source, associated Business Object, and display name.

• Items to search: Scope of the Search.

• Search criteria: Search categories and options.

• Solution: Information that the solution uses and where the information is used.

Good to know:

• Searches that include child records and/or Attachments will run slower and return more results.

To define a Business Object Knowledge Source:

1. Open the Knowledge Source Manager.

2. Define general properties:
a. Source: Select Business Object in the drop-down.

b. Business Object: Select the type of Business Object that you want to search.

c. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

3. Define items to search:
◦ Business Object: Searches all fields of the main Business Object record that have been added

to the full-text index.

◦ Children: Searches all child records (ex: Journals) of the main Business Object.

◦ Attachments: Searches any documents that have been imported or attached to the main
Business Object.

4. Define Search criteria:
◦ Categories: When a search is launched from a Business Object that has categorization (ex: An

Incident with a Network category and Performance subcategory), the categories will be passed
to the Knowledge Source.

◦ Allow Users to ignore categories when searching.

◦ Allow Users to limit by attachment date.

◦ Allow Users to limit to final state: Select this check box to give the User the option to limit the
search to only final (ex: Closed) records.

◦ Additional search criteria: Use the Search Group Manager or the Custom Query Builder to
further define your search criteria (ex: Limit the search to Incidents that have already been
resolved where the Customer approved the solution).

5. Define the solution:
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◦ Solution field: The field that contains the details of the solution. When populating a field,
creating a journal entry, etc., the text from this field will be copied into the target field.

◦ Solution description field: The field that contains text displayed in the Knowledge Pane when a
record is found. Typically, it contains a shorter description (or summary) of the solution.

◦ Solution can be put into:
◦ Field: Data from the solution field that can be placed in a field within the target object.

◦ Journal entry: A new Journal entry can be created on the target object and the data
from the solution field is used for the Journal text.

◦ Attachment: The solution Business Object can be attached to the target object, and
appears on the Attachment bar.

◦ Relationship: The solution Business Object can be added to an existing relationship on
the target object (ex: There is a relationship between Incidents and Problems. If a
Problem is found, it can be added to that relationship.)

6. Click OK.6. 
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Define a Web Knowledge Source
Use a Web Knowledge Source to search a specific website (ex: Google, Yahoo, YouTube). When you
define a Web Knowledge Source, you define:

• General properties: Type of Knowledge Source, display name, image, website, and search text
parameter name.

• Search criteria: Search categories.

• Solution: Option as to how to link the source to a record.

Good to know:

• The Business Object drop-down is not relevant for this type of Knowledge Source.

• To ensure that you typed in the correct Web page, click the View button on the right side of the field
to preview the site.

• Determine the appropriate URL and search parameter by accessing the website and executing a
search. Then, look at the resulting URL in your browser.

To define a web Knowledge Source:

1. Open the Knowledge Source Manager.

2. Define general properties:
a. Source: Select Web in the drop-down.

b. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

c. Image: Select a display image to use within CSM using the Image Manager.

d. Website: Provide the URL of the website.

e. Search text parameter name: Provide the name of the search parameter (specific to the Web
Knowledge Source) that need to be passed on to the search engine.

Note: The value of the parameter will be the list of search words (ex: When searching
Google, the parameter is "q", which generates a search URL, such as http://
www.google.com/search?q=My+Search+Words).

3. Define Search criteria:
◦ Categories: When a search is launched from a Business Object that has categorization (ex: An

Incident with a Network category and Performance subcategory), the categories will be passed
to the Knowledge Source.

4. Define the solution:
◦ Journal: A new Journal entry is created on the target object and the data from the web page is

used for the Journal text.
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◦ Attachment: The URL of the final search result is attached to the target object, and appears on
the Attachment bar.

5. Click OK.5. 
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Knowledge Source Manager
Use the Knowledge Source Manager to complete general CSM Item Manager operations for Knowledge
Sources.

There are several ways to open the Knowledge Source Manager.

Good to know:

• System is the only available scope. Create subfolders underneath this scope to organize items.• 

• Use the Manager Context (right-click) menu to quickly access menu bar/toolbar options.

• For more information about working in CSM Item Managers, refer to the Item Managers
documentation.
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Open the Knowledge Source Manager
To open the Knowledge Source Manager:

1. From the CSM Administrator main window, click the Settings category, and then click the
Knowledge Sources task.

2. From the Knowledge Mapping window, click the Add button.

To open the Knowledge Mapping window:

a. From the CSM Administrator main window, click the Settings category, and then click the
Knowledge Mapping task.
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Create a Knowledge Source
Use the Knowledge Source Manager to create, edit, delete, and organize Knowledge Sources.

To create a Knowledge Source:

1. Open the Knowledge Source Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button .

The Knowledge Source Properties window opens.

4. Select the type of Knowledge Source that you want to create.
◦ Attachment: Search imported documentation (ex: White papers) in the CSM Knowledge

Source system using the Attachment Manager (CSM>Tools>Attachments).

◦ Business Object: Search a specific type of Business Object as well as its children and
attachments.

◦ Web: Search a specific website.

5. Define additional criteria for the search.

Note: Additional search criteria varies based on the type of Knowledge Source you create
(Attachment Knowledge Source, Business Object Knowledge Source, or Web Knowledge
Source). Use this criteria to narrow your search.

6. Click OK.6. 
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Knowledge Mapping
Use Knowledge Mapping to determine when and how a Knowledge Source can be searched and how the
resulting solution can be used. When mapping a Knowledge Source, define:

• What Knowledge Sources can be searched using a General Search, Legacy Self-Service Search,
and/or a [Business Object] Search (ex: A mobile device website is useful as a searchable
Knowledge Sources from a Config - Mobile Device Record).

• What field categories should be included in the search (ex: If Service, Category, and Subcategory
fields are selected for an Incident record, the fields will be included in the search).

• Which Business Object fields should be populated with the found Knowledge (ex: If the Description
field is selected, found solutions are placed in that field).

Open the Knowledge Mapping window from the CSM Administrator main window by clicking the Settings
category, and then clicking the Knowledge Mapping task.

Define Knowledge Mapping options for the following:

1. General Knowledge

2. Self-Service (Portal)

3. Business Object
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Open the Knowledge Mapping Window
To open the Knowledge Mapping window from the CSM Administrator main window, click the Settings
category, and then click the Knowledge Mapping task.
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Define General Knowledge Search Options
Use Knowledge Mapping to determine what Knowledge Sources can be searched during a General
Knowledge Search. Use this for ad-hoc searches or research when you are not working with a particular
Business Object.

Good to know:

• Knowledge Sources must be defined using the Knowledge Source Manager before adding them to
the General Search list.

• Select a Knowledge Source and click Remove to remove it from the list. Select a Knowledge

Source and click the Up/Down buttons   to organize the items in the list.

To add General Search Knowledge Sources:

1. Open the Knowledge Mapping window.

2. From the Search From drop-down, select General Search.

OOTB Knowledge Sources open in the window.

3. Add Knowledge Sources that you want available to Users for general Searches:
a. Click the Add button.

The Knowledge Source Manager opens.

b. Click a Knowledge Source.

c. Click OK.c. 

The new Knowledge Source displays in the Knowledge Sources list.

4. Click OK.4. 
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Define Self-Service Portal Knowledge Search
Options

Use Knowledge Mapping to determine what Knowledge Sources can be searched using the Legacy Self-
Service application.

Good to know:

• Self-Service Knowledge Mapping not apply to the new CSM Portal.

• Users must define Knowledge Sources using the Knowledge Source Manager before adding them
to the Knowledge Sources list.

• The legacy Self-Service application only supports the use of Knowledge with Incidents, which is why
there are no options for specifying an alternate target Business Object.

• In the Legacy Self-Service application, when a Knowledge Search is launched, the User can select
a category that will be used to further the limit the search. The field listed is a field on the Incident
Business Object that is validated based on a list of possible categories.

• Select a Knowledge Source and click Remove to remove it from the list. Select a Knowledge

Source and click the Up/Down buttons   to organize the items in the list.

To add Legacy Self-Service Knowledge Sources:

1. Open the Knowledge Mapping window.

2. From the Search From drop-down, select Self-Service.

OOTB Knowledge Sources open in the window.

3. Define a category and subcategory to further limit the Search.

Note: In the Legacy Self-Service application, when a Knowledge Search is launched, the
User can select a category that will be used to further the limit the search. The field listed is
a field on the Incident Business Object that is validated based on a list of possible
categories.

4. Add Knowledge Sources that you want available for Self-Service Searches:
a. Click the Add button.
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The Knowledge Source Manager opens.

b. Click a Knowledge Source.

c. Click OK.c. 

The Knowledge Mapping window opens displaying in the Knowledge Source list.

5. Define Known Error solution options (where found Known Error solutions should be placed):
◦ Field: Select this check box to place the data from the solution field in a field within the target

Incident Business Object.

◦ Journal entry: Select this check box to create a new Journal entry on the target Incident
Business Object and the data from the solution field is used for the Journal text.

◦ Attachment: Select this check box to add the solution as an Attachment to the target
Business Object and appears on the Attachment Bar.

◦ Relationship: Select this check box to add the solution to an existing relationship on the
target Business Object (ex: There is typically relationship between Incident and Problem; If a
Problem is found, it will be added to the relationship between the two Objects).

6. Click OK.6. 
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Define Business Object Knowledge Search Options
Use Knowledge Mapping to determine what Knowledge Sources can be searched during a Knowledge
Search from a specific Business Object.

Good to know:

• Users must define Knowledge Sources using the Knowledge Source Manager before adding them
to the Knowledge Source list.

• Select a Knowledge Source and click Remove to remove it from the list. Select a Knowledge

Source and click the Up/Down buttons   to organize the items in the list.

To define Business Object Knowledge Sources:

1. Open the Knowledge Mapping window.

2. From the Search From drop-down, select the Business Object for which you want to define the
Knowledge Sources.

3. Define Fields Pulled for Categories options:
a. Categories: Select the field that should be included in the search (ex: If you select Service,

Category, and Subcategory fields for an Incident record, the search will look in these fields for
matching items). The way the category values are used depends on the type and definition of
the Knowledge Source.

b. Source Field for Text Search: Select the field from which the text will be pulled, by default, to
initiate a search. Typically, this is a description field.

4. Add Knowledge Sources that you want available for the Business Object Search:
a. Click the Add button.

The Knowledge Source Manager opens.

b. Click a Knowledge Source.

c. Click OK.c. 

The Knowledge Source displays in the Knowledge Sources list.

5. In the Open <Business Objects> Solution Goes Into section, define where found solutions should be
placed.

◦ Field: The data from the solution is placed in this field within the target Business Object.

◦ Journal entry: A new Journal entry is created on the target Business Object and the data
from the solution is used as the Journal text.

◦ Attachment: The <Business Object> solution is added as an Attachment to the target
Business Object and appears on the Attachment Bar.

◦ Relationship: The <Business Object> solution is added to an existing relationship on the
target Business Object (ex: There is typically relationship between Incident and Problem, so if
a Problem is found, it will be added to the selected field in the related Business Object.)
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6. Click OK.6. 
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Importing Knowledge
CSM integrates with various third-party Knowledge Bases so that canned Knowledge Articles can be
imported into and accessed from within CSM. For example, search canned Knowledge Articles directly
from business process forms (ex: Incident), the Quick Search Pane, or the Knowledge Pane to quickly
resolve issues.

CSM is shipped with Knowledge Articles from KnowledgeBroker, which provides canned Knowledge on a
large variety of topics, such as Microsoft Office and networking. Because KnowledgeBroker. provides
trustworthy information in addition to CSM Knowledge, Users can answer questions and troubleshoot
issues more effectively. For more information about available Knowledge from KnowledgeBroker visit their
website at http://www.kbi.com.

Use CSM Administrator to import Knowledge.
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Configure a Business Object for Knowledge Import
By default, CSM is configured to import Knowledge into the Knowledge Article Business Object. If you are
using an older version of the CSM content, or want to change the way in which the import takes place,
you can do this by setting attributes on the appropriate Business Object and fields.

1. Open Cherwell Administrator.

2. Create a new Blueprint.

3. Specify which business object will be used for Knowledge.
a. Select the appropriate business object, and bring up its properties.

b. On the Advanced options page, expand the General attributes section, and put in place the
"Knowledge" attribute:
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Note: You can have only one business object with this attribute. If you set it on multiple
objects, the first one that the system finds will be used, so it is recommended that you
remove it from any other object.

4. Associate a Field with the Knowledge attribute. Attributes are also used to associate different fields
in the business object with different pieces of Knowledge data. For example, to retrieve the Title of a
Knowledge article into the Title field of the Knowledge business object, bring up the properties of the
field, switch to the Advanced page, and expand the General attributes section. Then add an
attribute with the name "Knowledge" and the Value "Title":

There are a number of values for the Knowledge attribute that can be set:

• Title: The title of the Knowledge article.

• Description: A short description of the article.
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• Details: The details/solution/actions to take to resolve the described issue.

• ProblemType: A general classification of the type of article. Expected values include "How to", "Error
Message", "Problem/Symptom" and "Usage Information".

• Source: The source of the Knowledge. This will be set to KnowledgeBrokers during the import and
can be used to easily differentiate between imported vs. manually created Knowledge articles.

• Domain: The area of Knowledge being addressed, such as MS Office.

• ArticleID: A unique identifier used to associate the Cherwell imported record with the original
KnowledgeBroker article. If this is not set, then Cherwell will not be able to tell whether it is updating
an article vs. importing a new article, and will create multiple versions of the same article.

• Keywords: These are a list of keywords related to the article that can help with categorization and
searching.

• LastImported: When the article was last imported. Note that this may get updated during an import
even if the article didn’t change. The reason for this is to make it simpler to identify articles that are
no longer current.

Note that it is okay to exclude any fields if you don’t particularly want to import that data. However it is
strongly recommended that you include ArticleID.

CSM 9.3.0 Features 790

CSM 9.3.0 Features



Import Knowledge
Use the Import Knowledge Wizard to import third-party Knowledge Bases so that canned Knowledge
Articles can be imported into and accessed from within CSM.

Good to know:

• When you import Knowledge, it might be located in a number of directories. Just point to the root of
the knowledge directory, and CSM finds all of the appropriate files.

• You can create or import Knowledge Articles with embedded screenshots, numbered lists, and other
Rich Text formatting.

To import Knowledge:

1. In the CSM Administrator main window, select the Database category, and then click the Import
Knowledge task.

The Import Knowledge Wizard opens.

2. Read the Welcome information and click Next.

The Server Location page opens.

3. Click the Ellipses button  to navigate to the location of the KnowledgeBroker data.

The Browse For Folder window opens.

4. Select the folder that contains the knowledge data.

5. Click OK.5. 

The window closes to return to viewing the Import Knowledge Wizard.

6. Click Finish.6. 

A message window opens indicating that the import is complete.
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Configuring Knowledge
Configure Knowledge security rights to determine who can access Knowledge functionality.
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Metrics
A CSM Metric is a stored measurement query whose value can be used to measure, monitor, and predict
service desk performance and trends (example: Average time to resolve Incidents).
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About Metrics
Use a Metric to measure, monitor, and predict:

• Input: Work coming into the service desk (example: Logged Incidents)

• Output: Work being completed by the service desk (example: Resolved Incidents).

• Status: Snapshot of data at a specific point in time (example: Open Incidents).

• Timeliness: In regard to SLA agreements of resolve/respond (example: Late Incidents).

• Thresholds: Work exceeding an expectation (example: More than 30 Incidents are open).

• Satisfaction: Level of service appreciation (example: Customer satisfaction rate—average survey
scores or % of surveys where survey scores are above 75%).

• Success: Value and Outcomes (example: First Call Resolution (FCR) rate—% of Incidents closed
on first call); SLA success rate (% of Incidents where SLA was met).

• Trends: Compare points in time (example: Increasing satisfaction).

• Cause: What caused the work (example: Printer Incidents).

• Individual and Team performance: Who is completing the work and how efficient they are
(example: Incidents per Team).

• Averages: Mean Time to Resolve (MTTR), Mean Time Between Failures (MTBF) for CIs, average
response time, etc.

A Metric value can be a:

• Query Value:

Based on a Search Query (ex: Open Incidents, SLAs warnings and breaches, records with unread
Journals, etc.). Queries can contain simple calculation functions (ex: Averages, such as Incident
MTTR).

• Calculation:

Calculated measurement that involves other values (can be other Metrics) and math operator (ex:
FCR rate).

Note: Metric values are stored (cached) on and retrieved from the local machine of the User who
requests the Metric. Once cached, the local User can retrieve any of the cached values for use in
a Gauge Widget, Expression, or Query.

In CSM, a Metric can be used in:

• Expressions:

To conditionally control appearance and behaviors (example: Change a Widget's border color to red
if the FCR rate is less than 75 percent).

• Gauge Widgets:
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To monitor service desk performance on Dashboards (example: Number of records, MTTR, FCR,
success, satisfaction).

• Queries:

To find/filter data (example: Find all surveys where the score is below the Customer satisfaction
rate).

CSM provides several OOTB Metrics to help get you started. Use these OOTB Metrics as-is, edit them, or
create your own using the Metric Manager.
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Metric Caching
To increase performance, Metric values are stored (cached) on and retrieved from the local machine of
the User who requests the Metric. Once cached, the local User can retrieve any of the cached values for
use in a Gauge Widget, Expression, or Query.

How Metric Caching Works
When a Metric value is requested, a query is sent to the CSM database and a result is retrieved. This
result is stored (cached) on the local machine of the User who requested the Metric so that it can be used
as long as it is considered useful (or fresh). The period of time that this cached Metric value is considered
useful varies and is defined in the Metric's definition. Highly dynamic Metric values might be useful for 5
minutes, while very static values might be useful for a month. In any case, when a Metric value exceeds
its usefulness (becomes stale), it needs to be re-queried and re-cached.

Note: The cache value remains in memory until the User exits CSM, after which it is written to a
cache file on disk. Upon re-starting CSM, the values from the cache file are read from the file and
stored in memory for future use. This allows data to be saved when the User is not running CSM.

Metric Caching Example
The Metric value is defined to be useful for up to 10 minutes. The first time the Metric value is requested,
there is nothing in cache, so a query is sent to the database, and the result is stored on the User's
machine. The next time the value is requested, the behavior varies depending on how much time has
elapsed:

• If the Metric value is requested 5 minutes later, then the local cached value will be returned because
the value is still useful ("fresh enough") that a re-query is not required. That is true all the way up to
9 minutes and 59 seconds.

• However, if the Metric value is requested 11 minutes later, then the local cached value is not fresh
enough, so the database will be re-queried.

Frequency
The frequency at which Metric values are cached is determined by three factors:

• Session activity:
Metric values are cached only when a session is active. A User likely closes her session every night
so Metric values will NOT be cached during the inactive session. A Wallboard, which is always
running, might continually cache Metric values for extended periods of time.

• How often the Metric is requested:
Metric values are cached only when requested by a Widget or Dashboard refresh, or by initiating a
Query or Expression. (Metric values are NOT automatically gathered.) For example, an active
Wallboard might predictably auto-refresh every 30 minutes, an active User Dashboard might auto-
refresh every 30 minutes but the individual Widgets might be manually refreshed more often than
that by the User, an Expression might occasionally initiate a request, etc.

• The amount of time the Metric is considered useful (fresh):
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Metric values are re-cached only when their value is no longer considered useful (fresh). This
means that a request might not necessarily re-cache a Metric value. The time that a Metric value is
considered useful (example: 10 minutes, 24 hours, etc.) is defined in the Metric's definition.

Metric values are cached only when a session is active, only when requested, and only when the value is
no longer considered useful (fresh). Consider these factors when viewing Metrics, especially when
trending.

Using Cached Values
Metric values are cached on the local machine of the User who requested the Metric. Once cached, the
local User can retrieve any of the cached values for use in a Gauge Widget, Expression, or Query. Users
can retrieve:

• Current value:
Current Metric value, within context of freshness. In other words, retrieve the current usable (fresh)
value sitting in the User's local cache. If value is no longer considered fresh, the value will be re-
queried and re-cached (that is, synced with the database).

(Advanced property) You can also force a re-query each time the value is requested (that is, sync
with database); however, syncing affects performance and replaces the local cache value on the
User's machine, which could interfere with trending.

• Value from "last cache":
The Metric value from one cache ago (that is, the value that was cached right before the "Current
Value").

• Past value:
A previously cached Metric value that you specify. You can count back (example: From 1 minute
ago), specify by first of the month, quarter/year, or select a value from a specific weekday.

Note: Sometimes, the requested cached Metric value cannot be found (example: Values
were not cached during the time you requested). In this case, CSM returns a cached value
closest to the requested time (this cannot be the current value). If specifically requested,
CSM can instead return a specific defined value or the latest cached value (whatever is
currently sitting in cache; might or might not be considered fresh). To help indicate which
cached value was returned, Users can also select to return the cached value's stored time
and whether or not the returned value was the original requested value or an alternate value.

Local Caching Trade-offs
Local caching improves performance because data is delivered faster and fewer requests are made to a
database. Local cache values are also stored and reusable, so you can use any value at any time. This is
useful for trending.

However, local cached values can:

• Become stale:
Metric values are static for a defined period of time, so values can quickly become outdated.

• Miss a sudden dip or spike:
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Metric values are static for a defined period of time, so you might not cache a sudden change in
data. For example, you might decide to re-cache a Metric value every 60 minutes. If a drastic event
happens at minute 32 but is corrected at minute 35, you will miss it.

• Vary from User to User:
Metric values are cached locally, which means your cached vales and your colleague's cached
values might be different, even if they are cached within a few seconds of each other. For example,
you might calculate a closure rate of 50 percent because your values were 10 open and 5 closed
Incidents. Your colleague might calculate a closure rate of 55 percent because his values were 11
open and 5 closed Incidents.
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Metric Example
First Call Resolution (FCR) rate is a Metric that measures the percentage of Incidents that are closed on
the first call.

FCR rate could be calculated like this:

AllIncidentsClosedonFirstCall/AllClosedIncidents

Metric Definition
The Metric definition would look like this:

All IncidentsClosed on FirstCall/AllClosed Incidents

and would generate a decimal value like this:

.54
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Once created, you could use this Metric on a Gauge Widget, Expression, or Query.

Use the Metric in a Gauge Widget
Here is what the Metric could look like in a Gauge Widget:
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Note that on the Gauge, the Metric is formatted as a percentage.
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Note: You could also build the percentage into the Metric (example:
(AllIncidentsClosedonFirstCall/AllClosedIncidents) *100); however, you would then need to format
the value as a number; otherwise, you'll get an unexpected result (percentage of percentage).
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Use the Metric in an Expression
You could then use the same Metric in an Expression to conditionally change the border color of the
Gauge Widget to an Alert when the percentage falls below a satisfactory level (example: 75 percent).
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Metrics Good to Know
• It is important to understand Metric Caching when creating Metrics. For more information, see Metric

Caching.

• CSM provides several OOTB Metrics to help get you started. Use these OOTB Metrics as-is, edit
them, or create your own using the Metric Manager.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.
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Using Metrics
In CSM, Metrics are used to measure and monitor service desk performance. Metrics can be used in:

• Gauge Widgets.

• Expressions.

• Queries.
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View a Metric
A Metric can be viewed several ways:

• Available Metrics (based on security rights): Use the Metric Manager.

• From a Gauge Widget, Expression, or Query that uses a Metric.
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Use Metrics in Gauge Widgets
A Metric can be used in a Gauge Widget to monitor service desk performance on a Dashboard.

For example, display:

• The total number of Open Incidents.

• Incident MTTR.

• An FCR rate.

• An SLA success rate.

• A Customer satisfaction rate.

A Widget can also use a Metric in an Expression to conditionally change its color if the Metric exceeds a
threshold (example: If there are more than 15 Open Incidents, an Expression can change the Widget
foreground color to an Alert color).
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Use Metrics in Expressions
A Metric can be used in an Expression to conditionally change appearance and behavior:

• Change appearance (color, text, and image):

For example, change a Widget's border color to red if the satisfaction rate (Metric) is less than 75
percent.

• Change availability (visibility/enabling):

For example, enable or make a Widget visible only when the satisfaction rate (Metric) is less than 75
percent.

CSM 9.3.0 Features 810

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fmetrics%2F..%2Fexpressions%2Fabout_expressions.html


Use Metrics in a Query
A Metric can be used in Query Comparison Clauses to find/filter data. For example, find all records where:

• Survey score is below (less than) the Customer satisfaction rate (Metric).

• Respond/resolve times were more than (greater than) SLA success time (Metric)
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OOTB Metrics
CSM provides several Out-of-the-Box (OOTB) Metrics for the following Business Objects:

• Change

• Incident and Service Request

• Portal
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OOTB Change Metrics
There are several OOTB Change Metrics available in the Metrics Manager.

Metric Description Criteria

All Changes Being Assessed Represents the number of Change
records with a status of Assessing.

All Changes Being Assessed Search
Group

All Changes Being Evaluated Represents the number of Change
records being evaluated.

All Changes Being Evaluated Search
Group

All Changes Being Implemented Represents the number of Change
records with a status of Implementing.

All Changes Being Implemented Search
Group

All Changes Being Scheduled Represents the number of Change
records with a status of Scheduling.

All Changes Being Scheduled Search
Group

All Changes in Review Represents the number of Change
records being reviewed. All Changes in Review Search Group

All Changes Waiting Approval Represents the number of Change
records awaiting approval.

All Changes Awaiting Approval Search
Group

All Closed Changes Represents the number of Change
records with a status of Closed. All Closed Changes Search Group

All Denied Changes Represents the number of Change
records with a status of Denied. All Denied Changes Search Group

All New Changes Represents the number of Change
records with a status of New. All New Changes Search Group

All Open Changes Represents the number of open Change
records. All Open Requests Search Group

All Open Emergency (Unplanned)
Changes

Represents the number of open
Emergency Change records.

All Open Emergency (Unplanned
Changes) Search Group

All Open Normal Changes Represents the number of open Normal
Change records.

All Open Normal Changes Search
Group

All Open Standard Changes Represents the number of open
Standard Change records.

All Open Standard Changes Search
Group

All Planned Changes Represents the number of planned
Change records. Planned Changes Search Group

Changes with Linked CIs Represents the number of Change
records link with Configuration Items. Changes with Linked CIs Search Group

High Risk Changes Represents the number of High Risk
Change records. High Risk Changes Search Group

My Approved Changes

Represents the number of Change
records with a status of Approved that
are owned by the currently logged in
User.

My Approved Changes Search Group
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Metric Description Criteria

My Change Approvals
Represents the number of Change
Approval records owned by the currently
logged in User.

My Change Approvals Search Group

My Open Change Requests
Represents the number of open Change
Request records owned by the currently
logged in User.

My Open Change Requests Search
Group

My Pending Approvals
Represents the number of Approvals
with a status of Pending owned by the
currently logged in User.

My Pending Change Approvals Search
Group

My Team's Open Change Requests
Represents the number of open Change
Request records owned by the currently
logged in User's Team.

My Team's Open Change Requests
Search Group

Open Changes Not During
Maintenance Window

Represents the number of open Change
records that are not scheduled during the
maintenance window.

Open Changes Not During Maintenance
Window Search Group

Open Changes with Linked Incidents Represents the number of open Change
records linked to Incidents.

Open Changes with Linked Incidents
Search Group

Open Changes with Linked Problems Represents the number of open Change
records link to Problems.

Open Changes with Linked Problems
Search Group
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OOTB Incident and Service Request Metrics
There are several OOTB Incident and Service Request Metrics available in the Metrics Manager.

• Calculated Metrics

• Closed Incidents

• Closed Service Requests

• My Incidents

• My Service Requests

• Open Incidents

• Open Service Requests

Calculated Metrics

Metric Description Limiting Criteria

Average Age of Open Incidents

Measures all the Incidents that are
open and averages how long they
have been open or not resolved.
This Metric returns an integer
where the measurement used is
counted in hours.

All Open Incidents Search
Group

Average Age of Open Service
Requests

Measures all the Service Requests
that are open and averages how
long they have been open or not
resolved. This Metric returns an
integer where the measurement
used is counted in hours.

All Open Service Requests
Search Group

Down CMDB
Measures the number of
Configuration Items with an Asset
status of Down.

CIs Currently Down Search
Group

First Call Resolution

Measures the number of Incidents
resolved on the first call against all
closed Incidents. This Metric
returns the ratio in a decimal
format and should be displayed as
a percentage on a Dashboard
using the Widget’s properties.

All Incidents Closed on First
Call Search Metric and All
Closed Incidents Search
Group Metric
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Metric Description Limiting Criteria

Incident Mean Time to Resolve
(MTTR)

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction. This Metric returns an
integer where the measurement
used is counted in hours.

MTTR can be calculated by taking
the accumulated Incident
resolution time and dividing it by
the total number of resolved
Incidents within a given time
period defined by the Metric
creator. The accumulated Incident
time is defined by the Customers'
SLAs. The start of an Incident can
be when the Incident was Created
or Assigned. The conclusion of the
Incident can be categorized as
Resolved or Closed.

All Resolved/Closed Incidents
Search Group

Incident MTTR Closed by 1st
Level

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction by 1st Level Support.
This Metric returns an integer
where the measurement used is
hours.

All Resolved/Closed Incidents
by 1st Level Search Group

Incident MTTR Closed by 2nd
Level

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction by 2nd Level Support.
This Metric returns an integer
where the measurement used is
hours.

All Resolved/Closed Incidents
by 2nd Level Search Group

Incident MTTR Closed by 3rd
Level

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction by 3rd Level Support.
This Metric returns an integer
where the measurement used is
hours.

All Resolved /Closed
Incidents by 3rd Level Search
Group

Incident Success Rate

Represents the percentage of all
Incidents resolved within the
Customer's defined SLA
requirements.

All ResolvedClosed Incidents
within Resolution SLA Metric,
All ResolvedClosed Incidents
Metric
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Metric Description Limiting Criteria

MTTR of Major Incidents

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction for Incidents classified
as Major. This Metric returns an
integer where the measurement
used is hours.

All Resolved/Closed Search
Group, Major Incidents
Search Group

MTTR of P1 Incidents

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction for Incidents classified
as Priority 1. This Metric returns
an integer where the
measurement used is hours.

All Resolved/Closed Incidents
Search Group, P1 Incidents
Search Group

MTTR of P2 Incidents

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction for Incidents classified
as Priority 2. This Metric returns
an integer where the
measurement used is hours.

All Resolved/Closed Incidents
Search Group, P2 Incidents
Search Group

MTTR of P3 Incidents

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction for Incidents classified
as Priority 3. This Metric returns
an integer where the
measurement used is hours.

All Resolved/Closed Incidents
Search Group, P3 Incidents
Search Group

MTTR of P4 Incidents

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction for Incidents classified
as Priority 4. This Metric returns
an integer where the
measurement used is hours.

All Resolved/Closed Incidents
Search Group, P4 Incidents
Search Group

My Incident MTTR

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction for Incidents owned by
the currently logged in User. This
Metric returns an integer where
the measurement used is hours.

My Resolved/Closed
Incidents Search Group
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Metric Description Limiting Criteria

My Service Request MTTR

Represents the average time
taken to resolve or close a Service
Request to the Customer's
satisfaction for Requests owned
by the currently logged in User.
This Metric returns an integer
where the measurement used is
hours.

My Resolved/Closed Service
Requests Search Group

My Team's MTTR

Represents the average time
taken to resolve or close an
Incident to the Customer's
satisfaction for Incidents owned by
the currently logged in User's
Team. This Metric returns an
integer where the measurement
used is hours.

My Resolved/Closed Service
Requests Search Group

New CMDB
Measures the number of
Configuration Items with an Asset
status of New.

Percent of Re-Opened Incidents

Represents the percentage of
Incidents re-opened due to
occurrences such as: inadequate
resolution, dissatisfied Customers,
improper Incident documentation,
and Incident re-occurrence.

All Reopened Incidents
Metric, All Open Incidents
Metric

Service Request MTTR

Represents the average time
taken to resolve or close a Service
Request to the Customer's
satisfaction. This Metric returns an
integer where the measurement
used is counted in hours.

All Resolved/Closed Service
Requests Search Group

Closed Incidents

Metric Description Limiting Criteria

All Closed
Incidents

Represents
the number
of Incident
records with
a status of
Closed.

All Closed Incidents Search Group
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Metric Description Limiting Criteria

All Closed
Incidents with
No Close
Date

Represents
the number
of Incident
records with
a status of
Closed that
have no
Closed Date
in the record.

All Closed Incidents with No Closed Date Search Group

All Closed
Incidents
within Past
Month

Represents
the number
of Incidents
with a status
of Closed
within the
past month
(30 days).

All Closed Incidents within Past Month Search Group

All Closed
Incidents
within Past
Week

Represents
the number
of Incidents
with a status
of Closed
within the
past week (7
days).

All Closed Incidents within Past Week Search Group

All Closed
Incidents
within Past
Year

Represents
the number
of Incidents
with a status
of Closed
within the
past year.

All Closed Incidents within Past Year Search Group

All Escalated,
Resolved/
Closed
Incidents

Represents
the number
of escalated
Incident
records that
have a status
of Resolved
or Closed.

All Escalated Incidents Search Group, Resolved/Closed Incidents Search Group
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Metric Description Limiting Criteria

All Incidents
Closed on
First Call

Represents
the number
of Incident
records
where the
Incident was
resolved on
the first call
with the
Customer.
This Metric is
used in the
First Call
Resolution
Metric.

All Resolved/Closed Incidents Closed on First Call Search Group

All Major
Resolved/
Closed
Incidents

Represents
the number
of Major
Incident
records that
have a status
of Resolved
or Closed.

All Resolved/Closed Incidents Search Group, Major Incidents Search Group

All Never
Fixed
Resolved/
Closed
Incidents

Represents
the number
of Incident
records that
have never
been fixed
with a status
of Resolved
or Closed.

All Resolved/Closed Incidents Search Group, Never Fixed Search Group

All Not
Reopened
Resolved/
Closed
Incidents

Represents
the number
of Incident
records that
have not
been
reopened
with a status
of Resolved
or Closed.

All Resolved/Closed Incidents Search Group, Not Reopened Search Group
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Metric Description Limiting Criteria

All Reopened
Resolved/
Closed
Incidents

Represents
the number
of Incident
records with
a status of
Resolved or
Closed that
have been
reopened.

All Resolved/Closed Incidents Reopened Search Group

All Resolved
Incidents

Represents
the number
of Incident
records that
have a status
of Resolved.

All Resolved Incidents Search Group

All Resolved/
Closed
Incidents

Represents
the number
of Incident
records that
have a status
of Resolved
or Closed.

All Resolved/Closed Incidents Search Group

All Resolved/
Closed
Incidents by
1st Level

Represents
the number
of Incident
records that
have been
Resolved or
Closed by
1st Level
Support.

All Resolved/Closed Incidents by 1st Level Search Group

All Resolved/
Closed
Incidents by
2nd Level

Represents
the number
of Incident
records that
have been
Resolved or
Closed by
2nd Level
Support.

All Resolved/Closed Incidents by 2nd Level Search Group

All Resolved/
Closed
Incidents by
3rd Level

Represents
the number
of Incident
records that
have been
Resolved or
Closed by
3rd Level
Support.

All Resolved Incidents by 3rd Level Search Group
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Metric Description Limiting Criteria

All Resolved/
Closed
Incidents for
Account
Management

Represents
the number
of Incident
records for
Account
Management
with a status
of Resolved
or Closed.

All Resolved/Closed Incidents for Account Management Search Group

All Resolved/
Closed
Incidents for
Conferencing/
Presentation

Represents
the number
of Incident
records for
conferencing
or
presentations
with a status
of Resolved
or Closed.

All Resolved/Closed Incidents for Conferencing/Presentation Search Group

All Resolved/
Closed
Incident for
Desktop
Management

Represents
the number
of Incident
records for
Desktop
Management
with a status
of Resolved
or Closed.

All Resolved/Closed Incidents for Desktop Management Search Group

All Resolved/
Closed
Incidents for
E-mail/
Calendaring

Represents
the number
of Incident
records for e-
mail or
calendaring
with a status
of Resolved
or Closed.

All Resolved/Closed Incidents for E-mail/Calendaring Search Group

All Resolved/
Closed
Incidents for
Employee
Support

Represents
the number
of Incident
records for
Employee
Support with
a status of
Resolved or
Closed.

All Resolved/Closed Incidents for Employee Support Search Group
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Metric Description Limiting Criteria

All Resolved/
Closed
Incidents for
Enterprise
Apps

Represents
the number
of Incident
records for
Enterprise
Apps with a
status of
Resolved or
Closed.

All Resolved/Closed Incidents for Enterprise Apps Search Group

All Resolved/
Closed
Incidents for
Network
Services

Represents
the number
of Incident
records for
Network
Services with
a status of
Resolved or
Closed.

All Resolved/Closed Incidents for Network Services Search Group

All Resolved/
Closed
Incidents for
Printing

Represents
the number
of Incident
records for
Printing with
a status of
Resolved or
Closed.

All Resolved/Closed Incidents for Printing Search Group

All Resolved/
Closed
Incidents for
Telephony/Fax

Represents
the number
of Incident
records for
telephony or
fax with a
status of
Resolved or
Closed.

All Resolved/Closed Incidents for Telephony/Fax Search Group

All Resolved/
Closed
Incidents for
Web Services

Represents
the number
of Incident
records for
web services
with a status
of Resolved
or Closed.

All Resolved/Closed Incidents for Web Services Search Group
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Metric Description Limiting Criteria

All Resolved/
Closed
Incidents
from Chat
Session

Represents
the number
of Incident
records from
chat
sessions with
a status of
Resolved or
Closed.

All Resolved/Closed Incidents from Chat Sessions Search Group

All Resolved/
Closed
Incidents
from E-mail

Represents
the number
of Incident
records from
e-mail with a
status of
Resolved or
Closed.

All Resolved/Closed Incidents from E-mail Search Group

All Resolved/
Closed
Incidents
from Event

Represents
the number
of Incident
records from
a CSM Event
with a status
of Resolved
or Closed.

All Resolved/Closed Incidents from Event Search Group

All Resolved/
Closed
Incidents
from Mobile

Represents
the number
of Incident
records from
Cherwell
Mobile with a
status of
Resolved or
Closed.

All Resolved/Closed Incidents from Mobile

All Resolved/
Closed
Incidents
from Phone

Represents
the number
of Incident
records from
a phone call
with a status
of Resolved
or Closed.

All Resolved/Closed Incidents from Phone Search Group
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Metric Description Limiting Criteria

All Resolved/
Closed
Incidents
from Portal

Represents
the number
of Incident
records from
the Customer
Portal with a
status of
Resolved or
Closed.

All Resolved/Closed Incidents from Portal Search Group

All Resolved/
Closed
Incidents
from Social
Media

Represents
the number
of Incident
records from
social media
sites with a
status of
Resolved or
Closed.

All Resolved/Closed Incidents from Social Media Search Group

All Resolved/
Closed
Incidents
from Walk-in

Represents
the number
of Incident
records from
walk-in
requests with
a status of
Resolved or
Closed.

All Resolved/Closed Incidents from Walk-In Search Group

All Resolved/
Closed
Incidents with
CIs

Represents
the number
of Incident
records with
related
Configuration
Items with a
status of
Resolved or
Closed.

All Resolved/Closed Incidents with CIs Search Group

All Resolved/
Closed
Incidents with
Down CIs

Represents
the number
of Incident
records with
related,
downed
Configuration
Items with a
status of
Resolved or
Closed.

All Resolved/Closed Incidents with Down CIs Search Group
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Metric Description Limiting Criteria

All Resolved/
Closed
Incidents with
Resolution
Breach

Represents
the number
of Incident
records with
a status of
Resolved or
Closed that
have an SLA
resolution
breach
(overdue
resolution).

All Resolved/Closed Incidents Overdue Resolution (Breached) Search Group

All Resolved/
Closed
Incidents with
Response
Breach

Represents
the number
of Incident
records with
a status of
Resolved or
Closed that
have an SLA
response
breach
(overdue
response).

All Resolved/Closed Incidents Overdue Resolution (Breached) Search Group

All Resolved/
Closed
Incidents
within
Resolution
SLA

Represents
the number
of Incident
records with
a status of
Resolved or
Closed that
have a
resolution
within the
specified
SLA.

All Resolved/Closed Incidents within Resolution SLA Search Group

All Resolved/
Closed
Incidents
within
Response
SLA

Represents
the number
of Incident
records with
a status of
Resolved or
Closed that
have a
response
within the
specified
SLA.

All Resolved/Closed Incidents within Response SLA Search Group
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Metric Description Limiting Criteria

All Resolved/
Closed
Incidents,
Resolution
Warning

Represents
the number
of Incident
records with
a status of
Resolved or
Closed that
have an SLA
resolution
warning.

All Resolved/Closed Incidents Search Group, Resolution Warning Search Group

All Resolved/
Closed
Incidents,
Response
Warning

Represents
the number
of Incident
records with
a status of
Resolved or
Closed that
have an SLA
response
warning.

All Resolved/Closed Incidents Search Group, Response Warning Search Group

All Resolved/
Closed P1
Incidents

Represents
the number
of Priority 1
(P1) Incident
records with
a status of
Resolved or
Closed.

All Resolved/Closed Incidents Search Group, P1 Incidents Search Group

All Resolved/
Closed P2
Incidents

Represents
the number
of Priority 2
(P2) Incident
records with
a status of
Resolved or
Closed.

All Resolved/Closed Incidents Search Group, P2 Incidents Search Group

All Resolved/
Closed P3
Incidents

Represents
the number
of Priority 3
(P3) Incident
records with
a status of
Resolved or
Closed.

All Resolved/Closed Incidents Search Group, P3 Incidents Search Group
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Metric Description Limiting Criteria

All Resolved/
Closed P4
Incidents

Represents
the number
of Priority 4
(P4) Incident
records with
a status of
Resolved or
Closed.

All Resolved/Closed Incidents Search Group, P4 Incidents Search Group

Closed Service Requests

Metric Description Limiting Criteria

All
Closed
Service
Requests

Represents
the number
of Service
Request
records with
a status of
Closed.

All Closed Service Requests Search Group

All
Resolved
Service
Requests

Represents
the number
of Service
Request
records with
a status of
Resolved.

All Resolved Service Requests Search Group

All
Resolved/
Closed
Service
Requests

Represents
the number
of Service
Request
records with
a status of
Resolved or
Closed.

All Resolved/Closed Service Requests Search Group
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My Incidents

Metric Description Limiting Criteria

My
Assigned
Incidents

Represents
the number
of Incident
records that
have been
assigned to
the
currently
logged in
User.

My Assigned Incidents Search Group

My Closed
Incidents

Represents
the number
of Incident
records that
have been
closed by
the
currently
logged in
User.

My Closed Incidents Search Group

My In
Progress
Incidents

Represents
the number
of Incident
records
owned by
the
currently
logged in
User with a
status of In
Progress.

My In Progress Incidents Search Group

My New
Incidents

Represents
the number
of Incident
records
owned by
the
currently
logged in
User with a
status of
New.

My New Incidents Search Group
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Metric Description Limiting Criteria

My Open
Incident
Tasks

Represents
the number
of Incident
records with
related
Tasks that
are owned
by the
currently
logged in
User with a
status of
Open.

My Open Incident Tasks Search Group

My Open
Incidents

Represents
the number
of open
Incident
records
owned by
the
currently
logged in
User.

My Open Incidents Search Group

My Open
Incidents
and
Service
Requests

Represents
the number
of open
Incidents
and Service
Request
records
owned by
the
currently
logged in
User.

My Open Incidents and Service Requests Search Group

My Open
Incidents
Created
Today

Represents
the number
of open
Incident
records
owned by
the
currently
logged in
User that
were
created
within the
last 24
hours.

My Open Incidents Created Today Search Group
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Metric Description Limiting Criteria

My Open
Incidents
Created
within Last
Week

Represents
the number
of open
Incident
records
owned by
the
currently
logged in
User that
were
created
within the
last seven
(7) days.

My Open Incidents Created within the Last Week

My Open
Incidents
with
Resolution
Breach

Represents
the number
of open
Incident
records
owned by
the
currently
logged in
User with
an SLA
resolution
breach
(overdue
resolution).

My Open Incidents Search Group, Overdue Resolution (Breach) Search Group

My Open
Incidents
with
Resolution
Warning

Represents
the number
of open
Incident
records
owned by
the
currently
logged in
User with
an SLA
resolution
warning.

My Open Incidents with Resolution Warning Search Group
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Metric Description Limiting Criteria

My Open
Incidents
with
Response
Breach

Represents
the number
of open
Incident
records
owned by
the
currently
logged in
User with
an SLA
response
breach
(overdue
response).

My Open Incidents Search Group, Overdue Response (Breach) Search Group

My Open
Incidents
with
Response
Warning

Represents
the number
of open
Incident
records
owned by
the
currently
logged in
User with
an SLA
response
warning.

My Open Incidents with Response Warning Search Group

My Open
Incidents
with
Unread
Journals

Represents
the number
of open
Incident
records
owned by
the
currently
logged in
User with
related
unread
Journals.

My Open Incidents with Unread Journals Search Group
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Metric Description Limiting Criteria

My Open
VIP
Incidents

Represents
the number
of open
Incident
records
owned by
the
currently
logged in
User with
linked VIP.

My Open VIP Incidents Search Group

My
Pending
Incidents

Represents
the number
of Incident
records
owned by
the
currently
logged in
User with a
status of
Pending.

My Pending Incidents Search Group

My
Reopened
Incidents

Represents
the number
of Incident
records
owned by
the
currently
logged in
User with a
status of
Reopened.

My Reopened Incidents Search Group

My
Resolved
Incidents

Represents
the number
of Incident
records
owned by
the
currently
logged in
User with a
status of
Resolved.

My Resolved Incidents Search Group
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Metric Description Limiting Criteria

My
Resolved/
Closed
Incidents

Represents
the number
of Incident
records
owned by
the
currently
logged in
User with a
status of
Resolved or
Closed.

My Resolved/Closed Incidents Search Group

My
Team's
Open
Incidents

Represents
the number
of open
Incident
records
owned by
the
currently
logged in
User's
Team.

My Team's Open Incidents Search Group

My
Team's
Open P1
Incidents

Represents
the number
of open
Priority 1
(P1)
Incident
records
owned by
the
currently
logged in
User's
Team.

My Team's Open P1 Incidents Search Group

My
Team's
Open P2
Incidents

Represents
the number
of open
Priority 2
(P2)
Incident
records
owned by
the
currently
logged in
User's
Team.

My Team's Open P2 Incidents Search Group
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Metric Description Limiting Criteria

My
Team's
Open P3
Incidents

Represents
the number
of open
Priority 3
(P3)
Incident
records
owned by
the
currently
logged in
User's
Team.

My Team's Open P3 Incidents Search Group

My
Team's
Open P4
Incidents

Represents
the number
of open
Priority 4
(P4)
Incident
records
owned by
the
currently
logged in
User's
Team.

My Team's Open P4 Incidents Search Group

My
Team's
Open VIP
Incidents

Represents
the number
of open VIP
Incident
records
owned by
the
currently
logged in
User's
Team.

My Team's Open VIP Incidents Search Group
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My Service Requests

Metric Description Limiting Criteria

My
Assigned
Service
Requests

Represents
the number
of Service
Request
records that
have been
assigned to
the
currently
logged in
User.

My Assigned Service Requests Search Group

My
Closed
Service
Requests

Represents
the number
of Service
Request
records with
a status of
Closed.

My Closed Service Requests Search Group

My In
Progress
Service
Requests

Represents
the number
of Service
Request
records
owned by
the
currently
logged in
User with a
status of In
Progress.

My In Progress Service Requests Search Group

My New
Service
Requests

Represents
the number
of Service
Request
records
owned by
the
currently
logged in
User with a
status of
New.

My New Service Requests Search Group
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Metric Description Limiting Criteria

My Open
Service
Requests

Represents
the number
of open
Service
Request
records
owned by
the
currently
logged in
User.

My Open Service Requests Search Group

My Open
Service
Requests
Created in
the Last
Week

Represents
the number
of open
Service
Request
records
owned by
the
currently
logged in
User that
were
created
within the
last seven
(7) days.

My Open Service Requests Created within the Last Week Search Group

My Open
Service
Requests
Created
Today

Represents
the number
of open
Service
Request
records
owned by
the
currently
logged in
User that
were
created
within the
last 24
hours.

My Open Service Requests Created Today Search Group
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Metric Description Limiting Criteria

My
Pending
Service
Requests

Represents
the number
of Service
Request
records
owned by
the
currently
logged in
User with a
status of
Pending.

My Pending Service Requests Search Group

My
Reopened
Service
Requests

Represents
the number
of Service
Request
records
owned by
the
currently
logged in
User with a
status of
Reopened.

My Reopened Service Requests Search Group

My
Resolved/
Closed
Service
Requests

Represents
the number
of Service
Request
records
owned by
the
currently
logged in
User with a
status of
Resolved or
Closed.

My Resolved/Closed Service Requests Search Group

My
Team's
Open
Service
Requests

Represents
the number
of open
Service
Request
records
owned by
the
currently
logged in
User's
Team.

My Team's Open Service Requests Search Group
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Metric Description Limiting Criteria

My
Team's
Open VIP
Service
Requests

Represents
the number
of open VIP
Service
Request
records
owned by
the
currently
logged in
User's
Team.

My Team's Open VIP Service Requests Search Group

Open Incidents

Metric Description Limiting Criteria

All Assigned
Incidents

Represents
the number
of Incident
records with
a status of
Assigned.

All Assigned Incidents Search Group

All Escalated
Incidents

Represents
the number
of Incident
records with
a status of
Escalated.

All Escalated Incidents Search Group

All In
Progress
Incidents

Represents
the number
of Incident
records with
a status of In
Progress.

All In Progress Incidents Search Group

All New
Incidents

Represents
the number
of Incident
records with
a status of
New.

All New Incidents Search Group

All Open
Account
Management
Incidents

Represents
the number
of open
Incident
records for
Account
Management.

All Open Incidents for Account Management Search Group
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Metric Description Limiting Criteria

All Open
Assigned
Incidents

Represents
the number
of open
Incident
records with
a status of
Assigned.

All Assigned Incidents Search Group

All Open
Conferencing/
Presentation
Incidents

Represents
the number
of open
Incident
records for
Conferencing
or
Presentation.

All Open Incidents for Conferencing/Presentation Search Group

All Open
Desktop
Management
Incidents

Represents
the number
of open
Incident
records for
Desktop
Management.

All Open Incidents for Desktop Management Search Group

All Open E-
mail/
Calendaring
Incidents

Represents
the number
of open
Incident
records for E-
mail or
Calendaring.

All Open Incidents for E-mail/Calendaring Search Group

All Open
Employee
Support
Incidents

Represents
the number
of open
Incident
records for
Employee
Support.

All Open Incidents for Employee Support Search Group

All Open
Enterprise
Apps
Incidents

Represents
the number
of open
Incident
records for
Enterprise
Apps.

All Open Incidents for Enterprise Apps Search Group
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Metric Description Limiting Criteria

All Open
Incident
Tasks

Represents
the number
of open
Incident
records with
related
Tasks.

All Open Incident Tasks Search Group

All Open
Incidents

Represents
the number
of open
Incident
records.

All Open Incidents Search Group

All Open
Incidents
Created
Today

Represents
the number
of open
Incident
records that
were created
within the last
24 hours.

All Open Incidents Created Today Search Group

All Open
Incidents
Created
within Past
Month

Represents
the number
of open
Incident
records that
were created
within the last
month (30
days).

All Open Incidents Created Within Past Month (30 Days) Search Group

All Open
Incidents
Created
within Past
Week

Represents
the number
of open
Incident
records that
were created
within the last
week (7
days).

All Open Incidents Created within Past Week (7 Days) Search Group

All Open
Incidents
from Chat
Session

Represents
the number
of open
Incident
records
logged from
chat
sessions.

All Open Incidents from Chat Sessions Search Group
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Metric Description Limiting Criteria

All Open
Incidents
from E-mail

Represents
the number
of open
Incident
records
logged from
e-mail.

All Open Incidents from E-mail Search Group

All Open
Incidents
from Event

Represents
the number
of open
Incident
records
logged from a
CSM Event.

All Open Incidents from Event Search Group

All Open
Incidents
from Mobile

Represents
the number
of open
Incident
records
logged from
Cherwell
Mobile.

All Open Incidents from Mobile Search Group

All Open
Incidents
from Phone

Represents
the number
of open
Incident
records
logged from a
phone call.

All Open Incidents from Phone Search Group

All Open
Incidents
from Portal

Represents
the number
of open
Incident
records
logged from
the Customer
Portal.

All Open Incidents from Portal Search Group

All Open
Incidents
from Social
Media

Represents
the number
of open
Incident
records
logged from
social media
sites.

All Open Incidents from Social Media Search Group
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Metric Description Limiting Criteria

All Open
Incidents
from Walk-in

Represents
the number
of open
Incident
records
logged from
walk-in
requests.

All Open Incidents from Walk-In Search Group

All Open
Incidents
Linked to
Problems

Represents
the number
of open
Incident
records
linked to
Problems.

All Open Incidents Linked to Problems Search Group

All Open
Incidents with
CIs

Represents
the number
of open
Incident
records with
related
Configuration
Items.

All Open Incidents with CIs Search Group

All Open
Incidents with
Down CIs

Represents
the number
of open
Incident
records with
related,
downed
Configuration
Items.

All Open Incidents with Down CIs Search Group

All Open
Incidents with
Resolution
Breach

Represents
the number
of open
Incident
records that
have an SLA
resolution
breach
(overdue
resolution).

All Open Incidents Search Group, Overdue Resolution (Breach) Search Group
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Metric Description Limiting Criteria

All Open
Incidents with
Response
Breach

Represents
the number
of open
Incident
records that
have an SLA
response
breach
(overdue
response).

All Open Incidents Search Group, Overdue Response (Breach) Search Group

All Open
Incidents with
Resolution
Warning

Represents
the number
of open
Incident
records that
have an SLA
resolution
warning.

All Open Incidents Search Group, Resolution Warning Search Group

All Open
Incidents with
Response
Warning

Represents
the number
of open
Incident
records that
have an SLA
response
warning.

All Open Incidents Search Group, Response Warning Search Group

All Open
Major
Incidents

Represents
the number
of open Major
Incident
records.

All Open Incidents Search Group, Major Incidents Search Group

All Open
Network
Service
Incidents

Represents
the number
of open
Incident
records for
network
services.

All Open Incidents for Network Services Search Group

All Open P1
Incidents

Represents
the number
of open
Priority 1 (P1)
Incident
records.

All Open Incidents Search Group, P1 Search Group
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Metric Description Limiting Criteria

All Open P2
Incidents

Represents
the number
of open
Priority 2 (P2)
Incident
records.

All Open Incidents Search Group, P2 Search Group

All Open P3
Incidents

Represents
the number
of open
Priority 3 (P3)
Incident
records.

All Open Incidents Search Group, P3 Search Group

All Open P4
Incidents

Represents
the number
of open
Priority 4 (P4)
Incident
records.

All Open Incidents Search Group, P4 Search Group

All Open
Printing
Incidents

Represents
the number
of open
Incident
records for
Printing.

All Open Incidents for Printing Search Group

All Open
Telephony/Fax Incidents

Represents
the number
of open
Incident
records for
Telephony or
Fax.

All Open Incidents for Telephony/Fax Search Group

All Open VIP
Incidents

Represents
the number
of open VIP
Incident
records.

All Open VIP Incidents Search Group

All Open Web
Services
Incidents

Represents
the number
of open
Incident
records for
Web
Services.

All Open Incidents for Web Services Search Group
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Metric Description Limiting Criteria

All Pending
Incidents

Represents
the number
of open
Incident
records with
a status of
Pending.

All Open Incidents Search Group

All Reopened
Incidents

Represents
the number
of open
Incident
records with
a status of
Reopened.

All Reopened Incidents Search Group

All Unowned
Incidents

Represents
the number
of open
Incident
records that
do not have
an owner.

All Unowned Incidents Search Group

Open Service Requests

Metric Description Limiting Criteria

All Open
Assigned
Service
Requests

Represents
the number
of open
Service
Request
records with
a status of
Assigned.

All Open Assigned Service Requests Search Group

All Open
Escalated
Service
Requests

Represents
the number
of open
Service
Request
records with
a status of
Escalated.

All Open Escalated Service Requests Search Group

CSM 9.3.0 Features 846

CSM 9.3.0 Features



Metric Description Limiting Criteria

All Open
In
Progress
Service
Requests

Represents
the number
of open
Service
Request
records with
a status of In
Progress.

All Open In Progress Service Requests Search Group

All Open
New
Service
Requests

Represents
the number
of open
Service
Request
records with
a status of
New.

All Open New Service Requests Search Group

All Open
Pending
Service
Requests

Represents
the number
of open
Service
Request
records with
a status of
Pending.

All Open Pending Service Requests Search Group

All Open
Service
Requests

Represents
the number
of open
Service
Request
records.

All Open Service Requests Search Group

All Open
Service
Requests
Created
Today

Represents
the number
of open
Service
Request
records that
were created
within the
last 24
hours.

All Open Service Requests Created Today Search Group
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Metric Description Limiting Criteria

All Open
Service
Requests
Created
within
Past
Month

Represents
the number
of open
Service
Request
records that
were created
within the
last month
(30 days).

All Open Service Requests Created Within Past Month Search Group

All Open
Service
Requests
Created
within
Past
Week

Represents
the number
of open
Service
Request
records that
were created
within the
last week (7
days).

All Open Service Requests Created Within Past Week Search Group

All Open
Service
Requests
with CIs

Represents
the number
of open
Service
Request
records
linked to
Configuration
Items.

All Open Service Requests with CIs Search Group

All Open
VIP
Service
Requests

Represents
the number
of open VIP
Service
Request
records.

All Open VIP Service Requests Search Group

All
Reopened
Service
Requests

Represents
the number
of open
Service
Request
records with
a status of
Reopened.

All Reopened Service Requests Search Group
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Metric Description Limiting Criteria

All
Unowned
Service
Requests

Represents
the number
of open
Service
Request
records that
do not have
an owner.

All Unowned Service Requests Search Group
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OOTB Portal Metrics
There are several OOTB Portal Metrics available in the Metrics Manager.

Metric Description Limiting Criteria

Active
Problems

Measures
the number
of Problems
set as top
issues, the
number of
issues with
a
workaround,
and the
number of
issues
without a
workaround.

Problems Set at Top Issues Metric, Problems with Workaround Metric, Problems with No Workaround
Metric.

Open
Known
Errors in
Portal

Represents
the number
of open
Known
Errors in the
Customer
Portal.

Known Errors in Portal Search Group

Portal
Service
Alert
Color

Represents
the Service
Alert color
in the
Customer
Portal.

Open Known Errors in Portal Metric, Problems Set as Top Issues Metric, Incidents Linked to Problems
Metric
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Managing Metrics
Metrics are managed in CSM using the Metric Manager.

There are several ways to open the Metric Manager.

Use the Metric Manager to complete general CSM Item Manager operations for Metrics, including:

• View a Metric.

• Create a Metric.

• Edit a Metric.

• Delete a Metric.

• Search for a Metric.

• Organize Metrics.

• Copy a Metric.

• Import/export a Metric.

• Find Metric dependencies.

• Pin a Metric.
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Open the Metric Manager
There are several ways to open the Metric Manager:

• From the CSM Desktop Client menu bar, click Dashboards>Metric Manager.
• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Dashboards>Metric

Manager.
• From the Token Selector in Queries and Expressions.

• From a Gauge Widget, right-click Widget>Widget Properties> Values page.
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Create a Metric
Use the Metric Properties window (accessed from within the Metric Manager) to create a Metric.

When you create a Metric, you can choose from these types:

• Query Value:

Based on a Search Query (ex: Open Incidents, SLAs warnings and breaches, records with unread
Journals, etc.). Queries can contain simple calculation functions (ex: Averages, such as Incident
MTTR).

• Calculation:

Calculated measurement that involves other values (can be other Metrics) and math operator (ex:
FCR rate).

Good to know:

• Read Metric Caching before creating Metrics.

• Consider where the Metric will be used (example: Widget, Expression, or Query), how the Metric will
be used (just on a Widget, built into another Metric, etc.), what type of value you are seeking
(decimal, percentage, etc.) before creating Metrics. For example, if the Metric will be used in an
Expression to calculate another Metric value, make sure that the format is consistent—a percentage
value cannot be divided by a decimal value.
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Creating a Query Value Metric
Query Value Metric properties include:

• Limiting Criteria (Query): Which data/records to include in the Metric (example: All Open Incidents).

• Value: Type of value to display in the Metric (example: Number of Records, Function, or Duration).

• Local Cache Value: Amount of time the local cached value is considered useful (fresh) before the
value needs to be updated (re-queried and re-cached) (example: 5 minutes).

To create a Query Value Metric:

1. Open the Metric Manager.
2. Select a scope and subfolder (if needed).
3. Click the Create New button.
4. Define the following Metrics properties:

Option Description

Name
Provide a display name to use within CSM
(this property can be searched in CSM Item
Managers).

Description
Provide a description to use within CSM (this
property can be searched in CSM Item
Managers).

Metric Type
Select the Query Value radio button.

Business Object Select the Business Object whose data to
include in the Metric (ex: Incident).

Note: Only one type of Business
Object can be selected. The drop-
down displays only Major Business
Objects. To display all Business
Objects, select the Show All check
box.
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Option Description

Data Type Select the type of data (format) to return in
the Metric (select one):

◦ Date/Time
◦ Logical
◦ Number
◦ Text

5. Define the limiting criteria (example: All Open Incidents):
a. Click the Limiting Criteria page.
b. Search Criteria: Define which data/records to include (example: All Open Incidents). Use a

custom Search Query or a saved Search Query (Search Group) to locate/filter the data.

◦ Click the Ellipses button  to open the Search Group Manager, and then select an
existing Search Group (saved Search Query) or create a Search Group. Saved
Searches can be used over and over in numerous places.

◦ Click the Custom Query button  to open the Custom Query Builder, and then create
a custom Search Query to use only for this scenario.

6. Define the type of value to display in the Metric:
a. Click the Value page.
b. Select one value to display:

◦ Function: Select this radio button to display a value that calculates an average,
maximum, minimum, or total value based on a selected field. Then, select the function
and field (example: Display an average customer satisfaction rating).

◦ Number of records: Select this radio button to display the number of records that match
the criteria (example: 15 Open Incidents).

◦ Duration Function: Select this radio button to display a value that is calculated based on
an amount of time. Then, select the Start/End fields and the units (duration) (example:
Display the average amount of time that Incidents (meeting your criteria) take to resolve
each day (example: Start field = Created Date/Time, End field = Closed Date/Time, and
Units = Days).

◦ Optimize for database (for best performance): Select this check box to have the system
first check the metric cache for a recent version of the metric (if the current value is less
than 30 seconds old) before querying the database when a metric is loaded. If this option
is disabled, the system will always query the database for the latest value when loading
a metric.

7. Define the local cache value.

Note: Local cache value is the amount of time the local cached value is considered useful
(fresh) before the value needs to be updated (re-queried and re-cached). For more
information about Metric caching, see Metric Caching.

8. Click OK.
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Creating a Calculated Metric
Calculated Metric properties include:

• Calculated Value: Expression to determine the Metric value. For example, FCR rate could be
calculated like this:
(AllIncidentsClosedonFirstCall/AllClosedIncidents)

To create a Calculated Metric:

1. Open the Metric Manager.
2. Select a scope and subfolder (if needed).

3. Click the Create New button .
4. Define the following Metrics properties:

Option Description

Name
Provide a display name to use within CSM
(this property can be searched in CSM Item
Managers).

Description
Provide a description to use within CSM (this
property can be searched in CSM Item
Managers).

Metric Type
Select the Calculated radio button.

Business Object Select the Business Object whose data to
include in the Metric (ex: Incident).

Note: Only one type of Business
Object can be selected. The drop-
down displays only Major Business
Objects. To display all Business
Objects, select the Show All check
box.
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Option Description

Data Type Select the type of data (format) to return in
the Metric (select one):

◦ Date/Time
◦ Logical
◦ Number
◦ Text

5. In the Expression area, click the Selector button  (or right-click in the text box), and then add
Tokens (example: System Functions, Prompts, Expressions, Stored Values, Metrics, and Counters)
and Math Operators (example: Add, Subtract, Multiply, etc.) to create an Expression. Examples
might include:

◦ FCR Rate: (AllIncidentsClosedonFirstCall/AllClosedIncidents) would return a decimal value
like .54.

◦ Percentage of reopened Incidents: (AllReopenedIncidents/AllOpenIncidents)*100 would return
a whole number that is then converted to a percentage value, like 10 percent.

◦ Incident Success rate: (AllResolvedClosedIncidentswithinResolutionSLA/
AllResolvedClosedIncidents)*100 would return a whole number that is then converted to a
percentage value, like 85 percent.

6. (Optional) Right-click in the Expression text to access a context menu with options to delete an item,
access its properties, or add a Modifier (example: Number format).

Note: If using other Metrics in the Expression, you are prompted to define which Metric
values to retrieve for use in the Expression (Metric Properties window pops up when you
add a Metric). For details, refer to Using a Metric Within a Metric.

7. Click OK.

CSM 9.3.0 Features 857

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fmetrics%2F..%2Ftokens%2Fabout_tokens.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fmetrics%2F..%2Fsystem_functions%2Fabout_system_functions.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fmetrics%2F..%2Fprompts%2Fabout_prompts.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fmetrics%2F..%2Fexpressions%2Fabout_expressions.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fmetrics%2F..%2Fstored_values%2Fabout_stored_values.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fmetrics%2F..%2Fcounters%2Fabout_counters.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fmetrics%2F..%2Fmodifiers%2Fabout_modifiers.html
https://help.cherwell.com/csh?topicname=csm_using_metric_within_metric


Using a Metric Within a Metric
To use a Metric within a Metric:

1. Right-click a Metric in the Calculated Metrics window, and then select Properties.
2. Define the Value to Retrieve:

◦ Current value: Current Metric value, within context of freshness. In other words, retrieve the
current usable (fresh) value sitting in the User's local cache. If the value is no longer
considered fresh, the value will be re-queried and re-cached (that is, synced with the
database).

Note: (Advanced property) Select the Reload the current cache value each time
Metric is requested check box to force a re-query each time the value is requested
(that is, sync with database); however, syncing affects performance and replaces the
local cache value on the User's machine, which could interfere with trending.

◦ Value from [last cache]: The Metric value from one cache ago (that is, the value that was
cached right before the Current Value).

◦ Past value: A previously-cached Metric value that you specify. You can count back (example:
From 1 minute ago), specify by first of the month, quarter/year, or select a value from a
specific weekday.

3. Select the Define the Value to Return (Advanced property) check box to determine what happens
when a requested cached Metric values cannot be found. In this case, CSM returns a cached value
closest to the requested time. You can choose:

◦ Retrieved Value:
◦ Last cached value
◦ Cached value closest to requested time: The current value sitting in cache; may or

may not be considered fresh.
◦ Specific value

◦ Stored time of retrieved value
4. Click OK.

CSM 9.3.0 Features 858

CSM 9.3.0 Features



Configuring Metrics
Metric Security rights are configured in CSM Administrator. See Metric Security Rights.
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Modifiers
A Modifier is a Token element that changes the visual format or calculated value of a Token in a One-Step
or Expression.
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About Modifiers
Fields and Tokens (Stored Values, other Expressions) can be added when building One-Steps and
Expressions.

For example, a Field containing the Customer's name can be added to a One-Step that sends an e-mail
to that Customer to make the e-mail more personal. When adding a value, the way the Field appears
depends on its data type:

• Text Fields: Shows the value.

• Number Fields: Shows a standard system format.

• Logical Fields: Shows the text as True or False depending on the value.

• Date/Time Fields: Shows in a sortable, standard format.

• JSON: Shows JSON data.

• JSON Array: Steps through data from a JSON array.

• XML: Shows XML data.

• XML Collection: Steps through data from a set of XML elements that have the same structure.

While this is often sufficient, there are many situations where it is useful to format the value. For example,
when showing a date/time, a User might want to show only the date without the time.

Additionally, a User might want to manipulate the value. For example, the User may only want the first
part of a Field’s value or change a value to be upper-case or lower-case.

Users can apply Modifiers to Tokens inserted into One-Steps and Expressions to format and modify the
value that is ultimately shown or calculated.

CSM 9.3.0 Features 861

CSM 9.3.0 Features



Modify/Format Value Window
Use the Modifiers window to create or edit Modifiers on a particular Token.

The Modifiers window consists of the following:

• A list of Modifiers: Apply multiple Modifiers to the same Token. For example, take the first five
characters of a Field, then upper-case the value and pad the value with leading Xs, etc.

Note: There are no modifiers by default. They must be added manually.

To add additional Modifiers, click the Create New button. Click the Delete button to remove
Modifiers. Modifiers are applied in the order they appear in the list.

• Modifier details: Available Modifiers differ depending on the data type of the selected Token, as well
as additional arguments. A brief description of the Modifier function appears at the bottom of the
window.

CSM 9.3.0 Features 862

CSM 9.3.0 Features



Modifier Types
You can apply the following types of Modifiers to Tokens in CSM:

• Text: Shows a value or string of text (example: The Last Edited text on the Incident form).

• Date/Time: Shows or performs a date/time calculation (example: Calculate a 15 minute warning for
an SLA).

• Numeric: Shows or performs a mathematical calculation using a string of Tokens and mathematical
symbols (example: Calculate the total cost of labor of a Labor Cost Item by multiplying the work
hours by the monetary rate).

• Logical: Uses one or more conditions to return a True or False value (example: Incident.Status
does not equal Closed).

• XML: Use to pull pieces of XML data (example: Returned from a web service call) into CSM in a
usable format.

• JSON: Use to pull pieces of JSON data (example: Returned from a web service call) into CSM in a
usable format.
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Text Modifiers
A Text Token displays a value or string of text (example: The Last Edited text on the Incident form). The
following Modifiers can be applied to Text Tokens.

As XML Returns text as an XML element.

Contains

Determines whether another string is contained within the source string. Example:

• Original Token: Now is the winter of our discontent

• Modifier: Contains (winter)

• Result: True

Ellipse Text

Used to cut off a string if it is too long. If the string is longer than the specified length,
then the value will have an ellipses (…) added to the end.

Note: Spaces are included in the character count for this modifier.

Example:

• Original Token: Now is the winter of our discontent

• Modifier: Ellipse Text (20)

• Result: Now is the winter…

Encode Text

Applies the selected encoding method to text. You can choose from:

• Base 64

• Backslash CR LF

• Backslash Quote

• Double Quote

First Word

Returns the first word in a string.

Example:

• Original Token: Now is the winter of our discontent

• Modifier: First Word

• Result: Now
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Hash Text

Applies cryptographic hashing algorithms to text strings. This enables you to create
encrypted strings you can use to create tokens for APIs and to detect data changes.

Available hash formats:

• MD5

• SHA-1

• SHA-256

• SHA-512

Note: You must disable FIPS-compliant cryptographic algorithms on your
machine to use MD5, SHA-256, or SHA-512 formats.

By default, converted strings are converted to hex format and use UTF-8 encoding. To
shorten the strings, select the Base 64 check box.

Hash MAC
Text

Applies cryptographic hashing algorithms with Message Authentication signing to text
strings. Provide a Hash MAC (Message Authentication Code) Key for an extra level of
security.

Available formats:

• MD5Hash

• SHA1Hash

• SHA256Hash

• SHA512Hash

Note: You must disable FIPS-compliant cryptographic algorithms on your
machine to use MD5, SHA256, or SHA512 hash formats.

By default, converted strings are converted to hex format and use UTF-8 encoding. To
shorten the strings, select the Base 64 check box.

Index of Text

Returns the position of another string within the source string. The index is 0-based, so if
the searched-for text is at the very beginning of the source, then the index will be 0. If the
string is not found, then the return value will be -1.

Example:

• Original Token: Now is the winter of our discontent

• Modifier: Index of Text (winter)

• Result: 11
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Last Word

Returns the last word in a string.

Example:

• Original Token: Now is the winter of our discontent

• Modifier: Last Word

• Result: discontent

Left

Shows the left X-most characters from the original Token.

Note: Spaces are included in the character count for this modifier.

Example:

• Original Token: Now is the winter of our discontent

• Modifier: Left (6)

• Result: Now is

Length of
Text

Counts the number of characters in the string.

Note: Spaces are included in the character count for this Modifier.

Example:

• Original token: Now is the winter of our discontent

• Modifier: Length of Text

• Result: 35

Lowercase

Converts any upper-case characters in the original Token to lower-case.

Example:

• Original Token: Now IS The Winter Of Our Discontent

• Modifier: Lower-case

• Result: now is the winter of our discontent
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Pad Left

Inserts a particular character (or characters) to the left of a value to force the value to be
a particular length.

Example:

• Original Token: ABC

• Modifier: Pad Left (0,7)

• Result: 0000ABC

Pad Right

Inserts a particular character (or characters) to the right of a value to force the value to
be a particular length.

Example:

• Original Token: ABC

• Modifier: Pad Right (0,7)

• Result: ABC0000

Remove

Removes a particular value from the original Token.

Example:

• Original Token: Now is the winter of our discontent

• Modifier: Remove (winter)

• Result: Now is the of our discontent

Remove
Line Breaks

Removes line breaks to make the Token fit on a single line.

Example:

• Original Token: Now is the winter of our discontent,

• Made glorious summer by this son of York.

• Modifier: Remove line breaks

• Result: Now is the winter of our discontent,Made glorious summer by this son of
York.
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Remove
White Space

Removes any white space characters from the Tokens: line breaks, spaces, tabs, etc.

Example:

• Original Token: Now is the winter of our discontent

• Modifier: Remove white-space

• Result: Nowisthewinterofourdiscontent

Replace

Replaces one value in the string with another on every occurrence.

Example:

• Original Token: Now is the winter of our discontent

• Modifier: Replace (winter, summer)

• Result: Now is the summer of our discontent

Right

Shows the right X-most characters from the original Token.

Note: Spaces are included in the character count for this Modifier.

Example:

• Original Token: Now is the winter of our discontent

• Modifier: Right (6)

• Result: ontent

Substring

Shows a certain number of characters from the middle of the Token. The start position
for a text string is considered to be 0, so Substring (0,6) is the equivalent of Left (6).

Note: Spaces are included in the character count for this Modifier.

Example:

• Original Token: Now is the winter of our discontent

• Modifier: Substring (11,6)

• Result: winter
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Text After

Finds a value after a particular word or phrase inside of the Token. There are several
options to control how this Modifier operates:

• Next Word: Displays the next word after the search text.

• Next Number: Displays the next number after the search text. This will skip over
any text until it finds a number.

• To End: Returns all of the text that appears after the text to search for.

• To End of Line: Returns all of the text that appears after text to search for, up until
the end of the line.

This Modifier is often useful when parsing e-mail messages.

Example:

• Original Token: This is regarding Incident: 1234 which is important

• Modifier: Text After (Next Word, Incident: )

• Result: 1234

• Modifier: To End of Line (Next Word, Incident: )

• Result: 1234 which is important

Text Before

Finds a value before a particular word or phrase inside of the Token. There are several
options to control how this Modifier operates:

• From Start: Returns the test that appears before the search text .

• From Start of Line: Returns all of the text that appears before the search text, up
until the end of the line.

• Previous Word: Displays the next word before the search text.

• Previous Number: Displays the next number before the search text.

Text
Between

Returns all of the text that appears between two values in a Token. This Modifier is often
useful when parsing e-mail messages.

Example:

• Original Token: Please enter a description between <Here> and <There>

• Modifier: Text Between (<Here>, <There>)

• Result: and
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Text to
Logical

Converts a Text value to a Logical value. This is useful when reformatting a Text value
based on whether the text result is equal to True or False.

The values True, T, Yes, and 1 are converted to True. Any other values are converted to
False.

Text to
Number

Converts the value in a Text Token to a number. Numeric Modifiers can then be applied
to the result.

Example:

• Original Token: 12345

• Modifier: Text to Number

• Result: 12345 (now available for Numeric Modifiers)

Trim End

Trims specified characters from the end of a text string. Each character in the modifier is
evaluated, regardless of order. Repeated characters are removed.

The following example shows how to trim end characters from a string:

• Original Token: 80906-1234

• Modifier: Trim -1234

• Results: 80906

The following example shows how to trim repeated characters from the end of a string:

• Original Token: 123400005

• Modifier: Trim 05

• Results: 1234

The following example show how to trim characters from the end of a string, regardless
of order:

• Original Token: abcergzxy

• Modifier: Trim yxz

• Results: abcerg
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Trim Start

Trims specified characters from the start of a text string. Each character in the modifier is
evaluated, regardless of order. Repeated characters are removed.

The following example shows how to trim start characters from a string:

• Original Token: 719-386-7000

• Modifier: Trim 719-

• Results: 386-7000

The following example shows how to trim repeated characters from the beginning of a
string:

• Original Token: 000051234

• Modifier: Trim 05

• Results: 1234

The following example show how to trim characters from the beginning of a string,
regardless of order:

• Original Token: abcergzxy

• Modifier: Trim cba

• Results: ergzxy

Uppercase

Converts any lower-case characters in the original Token to upper-case.

Example:

• Original Token: Now IS The Winter Of Our Discontent

• Modifier: Upper-case

• Result: NOW IS THE WINTER OF OUR DISCONTENT

Uppercase
First

Converts only the first character to upper-case. This is often useful when working with
names and proper nouns.

Example:

• Original Token: george

• Modifier: Upper-case first

• Result: George
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URL Encode

Converts a string into a value that can be legally used as a URL.

Example:

• Original Token: This <is> a test

• Modifier: URL Encode

• Result: This%20&lt;is&gt;%20a%20test
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Date/Time Modifier
A Date/Time Token displays or performs a date/time calculation (example: Calculate a 15-minute warning
for an SLA). The format of the Date/Time value must be taken into consideration when applying Date/
Time Modifiers to Tokens.

The following Modifiers can be applied to Date/Time Tokens.

First of
Month

Returns the first day of the month for the specified Date/Time.

Example:

• Original Token: 9/16/2016

• Modifier: First of Month

• Result: 9/1/2016

Last of
Month

Returns the last day of the month for the specified Date/Time.

Example:

• Original Token: 9/16/2016

• Modifier: Last of Month

• Result: 9/30/2016

First of Year

Returns the first day of the year for the specified Date/Time.

Example:

• Original Token: 9/16/2016

• Modifier: First of Year

• Result: 1/1/2016

Last of Year

Returns the last day of the year for the specified Date/Time.

Example:

• Original Token: 9/16/2016

• Modifier: Last of Year

• Result: 12/31/2016
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First of
Week

Returns the first day of the week for the specified Date/Time. In the US, the first day of
the week is Sunday, but this can differ depending on location.

Example:

• Original Token: 9/16/2016

• Modifier: First of Week

• Result: 9/13/2016

Last of
Week

Returns the last day of the week for the specified Date/Time. In the US, the last day of
the week is Saturday, but this can differ depending on location.

Example:

• Original Token: 9/16/2016

• Modifier: Last of Week

• Result: 9/19/2016
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Date/Time Modifier Formats
Date/Time Modifier Formats take the Date/Time values and converts them to text in a number of different
ways. The table below shows all of the supported formats, along with an example. The example date-time
is 12/4/2016 6:14 PM. Using an @ symbol in the format (example: 12/4/2016 @ 6:14 PM) will cause
incorrect modifier outcomes.

After applying a Date/Time format, the resulting value is considered to be Text. Users can then apply any
text operators to the value. For example, if you want to use the result as a number (example: Day), then
you will need to use the Text to Number Modifier.

Note: The formats may change depending on system settings. For example, the Short Date
format is based on the regional settings of the current User’s machine.

Date/Time Modifier Formats

Format Example

Short Date 12/4/2016

Short Time 6:14 PM

Long Date Thursday, December 04, 2016

Short Date & Time 12/4/2016 6:14 PM

Long Date & Time Thursday, December 04, 2016 6:14 PM

Sortable Date & Time 2016-12-04T18:14:13

Day 4

Day (with leading 0) 04

Day of Week (short) Thu

Day of Week (long) Thursday

Month (number) 12

Month (name) December

Year (short) 16

Year (long) 2016

Hour (12-hour) 6

Hour (12-hour with leading 0) 06

Hour (24-hour) 18

Minute 14

Minute (with leading 0) 14

AM/PM PM
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Format Example

Z

Client time zone

Note: For use with the CreatedDateTime
token. MM/dd/yyyy hh:mm:ss tt Z

Custom

Custom requires knowledge of the legal .NET date/
time formats. An example, however would be
something like: yy-M-d ddd which would return
16-12-4 Thu. See this resource for more information
on custom formatting.

Note: There is a Cherwell-specific custom
modifier for a client's local time zone. Use a
capital Z (capitalization is important) with
any date/time field
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Numeric Modifiers
A Numeric Token displays or performs a mathematical calculation using a string of Tokens and
mathematical symbols (example: Calculate the total cost of labor of a Labor Cost Item by multiplying the
work hours by the monetary rate).

The format of the Numeric value must be taken into consideration when applying Numeric Modifiers to
Tokens.

The following Modifiers can be applied to Numeric Tokens.

Absolute
Value

Returns the absolute value of the original.

Example:

• Original Token: -42

• Modifier: Absolute Value

• Result: 42

Format See Numeric Modifier Formats.

Hours to
Time Format

Converts hours to a specified time format:

• DD:HH:MM:SS

• DD:HH:MM

• HH:MM:SS

• HH:MM
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Math

Allows for simple math operators to be applied against the value in the Token.

Note: Users cannot use values from other Tokens as part of the calculation. To use
values from other Tokens in the calculation, use a Numeric Expression.

The Math Modifier supports these operators:

• Add: Adds a specific amount to the value.

• Subtract: Subtracts a specific amount from the value.

• Multiple: Multiplies the value by a specific amount.

• Divide: Divides the value by a specific amount.

• Absolute Value: If the value is negative, the value is made positive. Positive
values will remain unchanged.

• Modulo: Returns the remainder of a division calculation. Examples:
◦ 10%3 returns 1

◦ 5%3 returns 2

◦ 3%10 returns 3

In the last example, 3 is returned because the 3 divided by 10 is 0, with 3 as the
remainder.

Minutes to
Time Format

Converts minutes to a specified time format:

• DD:HH:MM:SS

• DD:HH:MM

• HH:MM:SS

• HH:MM

Number to
Logical

Converts a number to a logical value. This is useful when formatting a result based on
whether the value is 0 or not.

The value 0 will be converted to False. Any other value will be converted to True.

Round

Rounds a number to a specified number of decimal places.

Example:

• Original Token: 33.75

• Modifier: Round (0 places)

• Result: 34
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Seconds to
Time Format

Converts seconds to a specified time format.

• DD:HH:MM:SS

• DD:HH:MM

• HH:MM:SS

• HH:MM

Truncate

Removes the decimal component of a number.

Example:

• Original Token: 33.75

• Modifier: Truncate

• Result: 33
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Numeric Modifier Formats
As with Date/Time Modifiers, Numeric Modifier formats can control the way in which numbers are
displayed. The table below shows the supported options along with an example of each. The examples
are based on the number 12345.67890.

Note: Several of the formats are based on the regional settings of the current User’s machine.

Format Example

Number 12345.68

Number (set decimals) 12345.7 (one decimal place)

General 12345.6789

Currency $12345.68

Currency (set decimals) $12345.678 (three decimal places)

Fixed Point 12345.68

Fixed Point (set decimals) 12345.679 (three decimal places)

Percent 1,234,567.89%

Percent (set decimals) 1,234,567.890% (three decimal places)

Scientific 1.234568E+ 004

Hexadecimal ABCD (from value 43981)

Custom
Requires knowledge of the legal .NET numeric
formats. An example: F3, which would return
12345.679 .

Note: After applying a Numeric format, the resulting value is considered to be Text, so any Text
operators can then be applied to the value.

Note: Cherwell follows IEEE standards for rounding numerical values, specifically the round to
nearest, ties to even rule.
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Logical Modifiers
Logical Tokens use one or more conditions to return a True or False value (example: Incident.Status does
not equal Closed).

There is only one supported operator for Logical Tokens, which is format. The format takes two values:

• Value if True: Value that will be displayed if the logical Token’s value is true.

• Value if False: Value that will be displayed if the logical Token’s value is false.

This allows for more flexible formatting of logical values than simply True or False.
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XML Modifiers
Use XML Modifiers to pull pieces of XML data (example: Returned from a web service call) into CSM in a
usable format. XML modifiers build on each other and typically must be used in conjunction with each
other to return useful values. In addition, Field Tokens can be used in the modifiers.

The following Modifiers can be applied to XML data. The examples use an XML collection that contains a
list of books.

Find Element
Returns an XML element with a specific name.

Example: Return the genre of the first book in an XML collection.

Modifier:
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Result: <genre>Computer</genre>

Find Element Collection
Returns an XML element that contains a series of common child elements.

Example: Find the collection of prices for the last book in the XML collection.

Modifier:

Result: <price><priceUS>48.95</priceUS><priceUK>48.96</priceUK></price>
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Find Element with Attribute
Returns an XML element with a specific name and attribute.

Example: Find a book with the id attribute of B1002.

Modifier: Find Element with Attribute (book .id .b1002)

Result: <book id="B1002"><author>Boberson, Bob</author><title>XML Modifiers and You</
title><genre>Fantasy</genre><price><priceUS>48.95</priceUS><priceUK>48.96</priceUK></
price><publish_date>2016-03-14</publish_date><description>A book about XML modifiers and you.</
description></book>

First Child
Returns the first XML child element of the current element.

Example: Return the first book in the XML collection.

Modifier:
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Result: <book id="B1001"><author>Johns, Jorge</author><title>The Rest API</title><genre>Computer</
genre><price>3.50</price><publish_date>2016-03-15</publish_date><description>An in-depth look at
the Rest API.</description></book>

Has Child Element(s)
Returns whether an XML element has child elements.

Example: Check to see if there are any elements in the provided XML collection.

Modifier: Has Child Element(s) ()
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Result: True

Last Child
Returns the last XML child element of the current element.

Example: Return the last book from the XML collection.

Modifier: Last Child ()

Result: <book id="B1002"><author>Boberson, Bob</author><title>XML Modifiers and You</
title><genre>Fantasy</genre><price><priceUS>48.95</priceUS><priceUK>48.96</priceUK></
price><publish_date>2016-03-14</publish_date><description>A book about XML modifiers and you.</
description><in_stock>false</in_stock></book>

Logical from Element
Returns a logical value from a specified XML element.

Example: Check if the second book in the XML Collection is in stock.

Modifier: in_stock
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Result: False

Number from Element
Returns a numerical value from a specified XML element.

Example: Find the price of the first book in the XML collection.

Modifier: price

Result: 3.5
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String from Attribute
Returns a string value from a specified attribute on the current XML element.

Example: Find the ID of the first book in the XML collection.

Modifier: id

Result: B1001

String from Element
Returns a string value from a specified XML element.

Example: Retrieve the author's name from the first book in the XML collection.

Modifier: author
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Result: Johns, Jorge

XPath (element)
Returns an XML element based on the provided XPath.

Example: Retrieve the US Price of the second book in the XML collection.

Modifier: //book[2]/price/priceUS

Result: <priceUS>48.95</priceUS>
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XPath (value)
Returns a value based on the provided XPath.

Example: Return the value of the second book in the XML collection.

Modifier: //book[2]

Result: <author>Boberson, Bob</author><title>XML Modifiers and You</title><genre>Fantasy</
genre><price><priceUS>48.95</priceUS><priceUK>48.96</priceUK></
price><publish_date>2016-03-14</publish_date><description>A book about XML modifiers and you.</
description>
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JSON Modifiers
Use JSON Modifiers to pull pieces of JSON data (example: Returned from a web service call) into CSM in
a usable format. JSON modifiers build on each other and typically must be used in conjunction with each
other to return useful values. In addition, Field Tokens can be used in the modifiers.

The following Modifiers can be applied to JSON data. The examples use a JSON collection from a store.

Date Time from Element
Returns a date time value from a specified JSON element.

Example: Retrieve the return date value for the bike in the JSON collection.

Modifier:
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Result: 2012-04-23T18:25:43

Find Array
Finds and returns a JSON array from a specified name.
Example: Retrieve the list of books from the store's JSON collection of inventory.

Modifier:
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Result:

Find Object
Finds and returns the JSON object from a specified name.
Example: Retrieve the bicycle object from the JSON collection.

Modifier:

Result:
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{

"color": "red",

"price": 19.95,

"used": "True",

"returnDate": "2012-04-23T18:25:43.511Z"

}

JSON Path (replace)
Uses a JSONpath query to replace a value within a JSON document.
Example: Update the price of the bicycle to 20.95.

Modifier:

Result: (Full JSON value is returned with updated value from replace)

JSON Path (value)
Returns a value based on the provided JSONpath.
Example: Find books with a price less than $8.99.

Modifier:
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Result:

{

"category": "reference",

"author": "Nigel Rees",

"title": "Sayings of the Century",

"price": 8.95

}

Logical from Element
Returns a logical value from a specified JSON element.
Example: Retrieve the previously owned value for the bicycle in the store.

Modifier:
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Result: True

Number from Element
Returns a numerical value from a specified JSON element.
Example: Retrieve the price of the 4th book.

Modifier:

Result: 22.99
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String from Element
Returns a string value from a specified JSON element.
Example: Get the title of the 3rd book in the JSON collection.

Modifier:

Result: Moby Dick

Goto Array Index
Returns the JSON object at the specified index of the JSON array.
Example: Go to the 2nd book in the JSON collection.

Modifier: (array index values start at 0)
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Result:

{

"category": "fiction",

"author": "Evelyn Waugh",

"title": "Sword of Honour",

"price": 12.99

}

CSM 9.3.0 Features 898

CSM 9.3.0 Features



Using Modifiers
When working with Modifiers, Users can access and apply Modifiers.
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Access Modifiers
To access Modifiers while working with One-Steps and Expressions:

1. Right-click to insert new Tokens (example: Fields, Expressions, Stored Values, etc.) or use the
existing Tokens.

2. Double-click the Token text, or right-click and select Modifiers to access available Modifiers for that
Token.

Note: If the Token has custom properties (such as a Prompt option), then double-clicking
displays the properties for the Prompt but not the Modifiers. In this case, Users must use the
right-click (context) menu.

The Modify/Format Value window opens.
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Apply Modifiers
Use the Modify/Format Value window to add Modifiers to Tokens. The type of Modifier you can add
depends on the Token.

To apply a Modifier:

1. Right-click a Token in a One-Step or Expression.

2. From the context menu, select Modifiers.

The Modify/Format Value window opens.

A list of existing Modifiers displays in the left pane.

3. Select a Modifier from the list to edit an existing Modifier. To create a new Modifier, click the Create
New button.

4. Select the type of Modifier you want for the Token from the Modifiers drop-down.

5. Click OK.5. 

The Modifier is applied to the selected Token.

View the new Modifier, as well as existing Modifiers, by opening the Modify/Format Value window for
that Token again.

CSM 9.3.0 Features 901

CSM 9.3.0 Features



One-Steps/Actions
A One-Step™ is an entity that initiates one or more defined Actions (example: Create an Incident record).
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About Actions
An Action is an activity that can be initiated manually (from a button, link, menu bar item, or Widget) or
automatically (from an Automation Process, One-Step™, or E-mail Monitor) to execute a command
(example: Print) or display/run a CSM Item (example: Display a Dashboard or run a Search). Use Actions
to:

• Run a Command, One-Step, Report, or Search.

• Display a CSM Item, such as an Action Catalog, Calendar, Dashboard, Document Repository,
HTML Page, or Visualization.

Note: Actions vary depending on the location from which they are initiated. For example, an
Action to display a Document Repository can be initiated from a Customer Portal menu bar,
but not from a toolbar in the Desktop Client.

In general, CSM Actions can be initiated from the following major areas:

• CSM Desktop Client toolbar.
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• CSM Desktop Client Task Pane.

• Automation Processes.

• One-Steps.

• Business Objects: As record-specific Actions on the CSM Desktop Client toolbar, menu bar, context
menu, and Task Pane. Automatic Actions can also be executed when a Business Object is saved.

• Dashboards: As buttons, links, and Widgets.

• Forms: As buttons and links.

• Customer Portal: Menu Bar, Dashboard Widget, or HTML Page.

In addition, you can initiate Actions from the following:

• Cherwell Outlook Add-In: As record-specific Actions that are run from Microsoft Outlook.

• E-mail and Event Monitor: As Actions for processing monitored e-mails.

• Approvals: As Actions that are run when an Approval is approved, denied, or expired.

• Scheduled Items: As Actions that are run on a scheduled basis.

CSM provides many OOTB Actions on the CSM Desktop Client Task Pane, menu bar, and toolbar, as well
as on Forms, Dashboards, default Portal site, etc. Use these Actions as-is, edit them, or add your own
Actions. To help you add and manage Actions, CSM provides the Action Manager, the Actions menu, and
various CSM Item Managers, including the Command Manager.
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Actions Good to Know
• Actions vary depending on the location from which they are initiated. For example, an Action to

display a Document Repository can be initiated from a Customer Portal menu bar, but not from a
toolbar in the Desktop Client.

• System administrators can add Actions to the CSM Desktop Client toolbar and Task Pane (Global or
Role), Customer Portals, Business Objects, Automation Processes, Dashboards, and One-Steps.

• Users can add Actions to the CSM Desktop Client toolbar and Task Pane (Personal/User),
Dashboards, and One-Steps (and, in some cases, modify the Global or Role defaults created by the
system administrator).

Business Object Actions

• Actions that access or update Business Object data require at least one Business Object to be
available within the One-Step. A Business Object can be made available in a One-Step by:

◦ Selecting a Business Object association (either the current record or an available Business
Object in the Association drop-down on the One-Step Manager toolbar). A Business Object
association can only be selected when a One-Step is first created and cannot be changed for
an existing One-Step.

◦ Creating it using a Create a New Business Object Action preceding the Action that requires
Business Object access (in the One-Step Editor).

◦ Navigating to it using a Go to a Record Action preceding the Action that requires Business
Object access (in the One-Step Editor).

• Some Business Object Actions allow you to select which Business Object to execute against, if
more than one is available within the One-Step. Options can include one or more of the following,
depending on which Business Objects are available:

◦ Original Business Object from the Association (selected when the One-Step is created).

◦ Business Object from a Create a New Business Object Action preceding this Action.

◦ Business Object from a Go To a Record Action preceding this Action.
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Managing Actions
Actions are managed using the following tools:

• Action Manager: Contains various types of Actions, including displaying Action Catalogs,
Calendars, Document Repositories, and Visualizations; executing commands; and running One-
Steps, Reports, and Search Groups. The Actions available in the Action Manager depend on the
location from which you are accessing it.

• Actions Menu: A drop-down menu that contains a list of available Actions.

• CSM Item Managers: When you select an Action from an Actions menu, the appropriate CSM Item
Manager opens, from which you can select the specific CSM Item to display/run (or the specific
command to execute for Command Actions). Click a specific item, edit an item, or create a new
item on the fly. The Managers available from an Actions menu vary depending on your location in
CSM.

• Command Manager: A specific CSM Item Manager that opens when you select a Command Action
from an Actions menu. You can view and click on specific commands, but you cannot create, edit, or
delete them (they are built into the system). The commands might vary depending on where the
Command Manager is accessed.

• One-Step Manager: When creating One-Steps, you select Actions from the Actions pane in the
Visual Workflow One-Step Designer and add them to the Designer Board in the desired sequence. If
you are adding a One-Step to a CSM area, you select it from either the Action Manager (if One-
Steps are one of several types of Actions that can be selected for an area) or One-Step Manager (if
One-Steps are the only type of Action that can be selected for an area).

Note: Adding Actions to some areas might look different than the tools listed above. For
example, Approval Actions are defined in a specific window using a list of check boxes.

Note: Actions vary depending on the location from which they are initiated. For example, an
Action to display a Document Repository can be initiated from a Customer Portal menu bar,
but not from a toolbar in the Desktop Client.
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Action Manager
Use the Action Manager to complete general CSM Item Manager operations for Actions.

Your ability to perform certain operations for items in certain scopes might be limited by your security
rights. However, regardless of security rights, the available operations for commands are extremely
limited because commands are built into the system. For more information, see Command Manager.

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

Click the Clear button  to clear an Action or item that was previously selected for a CSM area.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

In some cases (example: One-Steps), you might see an Association drop-down menu on the
toolbar. This is for Actions and items that are associated with particular Business Objects.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Culture selector:
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Displays the cultures available for platform and content strings in your system, so you can change
languages as you work with items. Available only if globalization features are enabled.

5. Action Pane:

Displays the categories from which Actions, or items that will be initiated through Actions, are
selected. The available categories vary depending on the location from which the Action Manager is
launched.

6. Action tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.

7. Main Pane:

Displays items by View (Icon, List, or Details (Grid) and lists search results when a Search is run.

For certain categories, what you see in the Main pane can also be filtered by Business Object
Association (appears on the toolbar if applicable).
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Actions Available from the Action Manager
The following Actions are available from the Action Manager when you open it from specific areas in
CSM. The Actions that are available for you to add to certain areas depend on where you are accessing
the Action Manager.

Action Description

CSM Area

 

Task
Pane

Business
Object
(Print
Options)

Buttons
and Links

Command
Palette
Widget

Other
Widgets/
Automatic
Actions*

Action
Catalog

Displays an Action
Catalog (Widget).    

Calendar
Displays a
Calendar.   

Command
Executes a
command.   

Dashboard
Displays a
Dashboard.   

Doc
Repository

Displays a
Document
Repository.

  

One-Step Runs a One-Step.

Page
Displays an HTML
page.     

Report Runs a Report.  

Search
Runs a Search
Group.   

Visualization

Displays a
Visualization.   

*Applies to Action Catalog, RSS Feed, and Twitter Feed Widgets. Because One-Steps are the only
Actions that can be added to these Widgets, they are selected directly from the One-Step Manager rather
than the Action Manager. The same is true for Automatic Actions in a Business Object.
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Note: Some Actions might be limited in the Browser Client. Refer to the Browser Client
Documentation for more information.
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Open the Action Manager
There are several ways to open the Action Manager:

• From CSM Administrator:
◦ In the Task Pane Section window (when configuring Global/Role Task Pane settings), click

Add.

◦ In the Menu page of the Site Editor (when defining menu bar properties for a Portal Site), click

the Ellipses button  next to the Action field to select a different Action or clear the selected
Action.

◦ In the Business Object Actions window (when defining Actions for a Business Object), click the

Ellipses button  next to the Action field to select a different Action or clear the selected
Action.

◦ In the Choose Action window (when defining Control properties for a Link Label Control or

Button Control on a Form), click the Ellipses button .

◦ In the Outlook Integration - Condition and Action window (when defining available Actions for

an Outlook Integration configuration), click the Ellipses button  to select a different Action
or clear the selected Action.

• From the CSM Desktop Client:
◦ In the Task Pane Section window (when defining User Task Pane settings), click Add.

◦ From a Dashboard Widget button or link: Right-click Widget Properties.
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Actions Menu
Use the Actions menu (accessible by clicking the Add Action button) to quickly add Actions to areas such
as CSM Desktop Client toolbars, Business Objects, or a Customer Portal.

Depending on where you are accessing the menu, a combination of different types of Actions are
available from the Actions menu:

• Action Catalog: Displays an Action Catalog (Widget).

• Calendar: Displays a Calendar.

• Command: Executes a command.

• Dashboard: Displays a Dashboard.

• Doc Repository: Displays a Document Repository.

• One-Step™: Runs a One-Step™.

• Page: Displays an HTML page.

• Report: Runs a Report.

• Search: Runs a Search Group.

• Visualization: Displays a Visualization.

When you select an Action, the appropriate CSM Item Manager opens. From the Command Manager,
select a specific CSM item to display/run (or specific command to execute for a Command Action). The
items available for you to select might differ depending on where you are adding the Action (example: Edit
commands are available for CSM Desktop Client toolbars but not for a Customer Portal).

Some CSM Item Managers support adding a CSM Item to your personal Task Pane or a custom toolbar
directly from the CSM Item Manager (example: In the Dashboard Manager, add a Dashboard to your
toolbar). For more information, see CSM Item Managers and adding CSM items to the Task Pane or
toolbar.
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Command Manager
Commands are built into the system and can be added to CSM menus, toolbars, Task Panes, Business
Objects, Customer Portals, and Dashboards.

Use the Command Manager, accessed from the Actions menu, to complete the following operations:

• View: Displays commands by Icon (image), List (by name), or Details (sortable Grid view). You can
filter by scope in the Manager tree.

• Search: Runs a search that locates and lists all commands whose display name and description
contain a specific word or phrase. For more information, see Search in a CSM Item Manager.

• Pin Commands to a Pinboard (in the Command Manager) and MRU list (in the CSM Desktop Client
menu bar) to make them easily accessible in CSM.
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Open the Command Manager
There are several ways to open the Command Manager:

• From CSM Administrator:
◦ From the Business Object Actions window (when defining Actions for a Business Object), click

the Actions menu, and then select Add Command Action to add a command to a Business
Object's menu bar, Task Pane, toolbar, or context menu.

◦ From the Menu page of the Site Editor (when defining menu bar properties for a Portal Site),
click the Actions menu, and then select Add Command Action to add a command to the
Portal menu bar.

• From the CSM Desktop Client:
◦ From the New Toolbar window (when creating a User toolbar), click the Actions menu, and

then select Add Command Action to add a command to the User toolbar.

◦ From a Dashboard Widget button or link: Right-click>Widget Properties, select a Command
Action.
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Add Actions to CSM Areas
You can add an Action to the following major CSM areas:

• CSM Desktop Client toolbars.

• CSM Desktop Client Task Pane.

• Dashboards.

• Forms.

• One-Steps.

• Automation Processes.

• Business Objects (as record-specific Actions on the toolbar, menu bar, context menu, and Task
Pane). Automatic Actions can also be executed when a Business Object is saved.

• Portal (menu bar, Dashboard Widget, or HTML Page).

• Cherwell Outlook Add-In (as record-specific Actions you can run from Microsoft Outlook).

• E-mail and Event Monitor (as Actions for processing monitored e-mails).

• Approvals (as Actions that are run when an Approval is approved, denied, or expired).

• Scheduled Items (as Actions that are run on a scheduled basis).
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Add an Action to a CSM Desktop Client Toolbar
You can add Actions to:

• User toolbars: Personal CSM Desktop Client toolbars Users create to initiate Actions that are
important to them.

• Global/Role toolbars: Toolbars a system administrator creates for all Users or for Users in particular
Roles.

For example:

• Run a One-Step (example: Open the Cherwell Support site).

• Display/run a CSM Item (example: Dashboard, Calendar, Visualization, etc.).

• Execute a command (example: Open the Search Group Manager).
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Add an Action to a CSM Task Pane
You can add Actions to:

• Personal Task Pane: Personal CSM Desktop Client Task Panes Users create to initiate Actions that
are important to them.

• Global/Role Task Panes: Task Panes a system administrator creates for all Users or for Users in
particular Roles.

For example:

• Run a One-Step™ (example: Create a Business Object record).

• Display/run a CSM Item (example: Dashboard, Calendar, Visualization, etc.).

• Execute a command (example: Open your CMDB).
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Add an Action to a Dashboard
A Dashboard is a configurable, interactive, and insightful console capable of initiating commands and
Actions. Dashboards provide real-time, at-a-glance information through the use of filterable, configurable
Widgets (Action Catalogs, Websites, Buttons and Links, Charts, Command Palettes, Gauges, Matrixes,
Search Controls, Search Results, Twitter Feeds, RSS Feeds, and Shapes).

Add Actions to the types of Widgets so they can be launched directly from a Dashboard:

• Action Catalog Widget: Displays a self-building and dynamic list (catalog) of executable Actions.

• Command Palette Widget: Displays a list of commands (Actions).

• RSS Feed Widget: Displays frequently updated information, such as news or blog entries, from a
particular feed.

• Twitter Feed Widget: Displays entries from a Twitter Account or search.

• Buttons and Links: Execute single commands.
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Add an Action to a One-Step
A One-Step™ is an entity that initiates one or more defined Actions (example: Create an Incident record).
A One-Step is made up of a series of Actions and can be simple (a few Actions) or complex (multiple
Actions that run under conditional circumstances). Numerous Actions are available to add to a One-Step.

One-Steps are also a type of Action you can add to various areas within CSM:

• CSM Desktop Client Task Pane and various Dashboard Widgets: Select the One-Step category in
the Action Manager and then select a specific One-Step (or create your own).

• CSM Desktop Client toolbar, Business Objects, and Customer Portal: Click Add One-Step Action
in the Actions Menu to open the One-Step Manager and select a specific One-Step (or create your
own).

• Automation Processes: Select One-Step as the type of Action to add to an Automation Process.
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Add an Action to an Automation Process
Automation Processes allow CSM Users to automate behavior by creating rules for the system to follow.
Define Actions for an Automation Process to automatically execute when certain criteria are met
(example: Automatically send an e-mail if a Change Request exceeds its end date by 4 hours). Add
Actions to all three types of Automation Processes:

• Simple Action/Event Process: Launches a One-Step™ or Action after a specific Event occurs.

• Threshold-Based Process: Watches a value and performs an Action after a threshold is crossed.

• Visual Workflow Process: Defines a sequence of time-based and Event-based steps that manage a
Business Object as it passes through various stages.
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Add an Action to a Business Object
Business Object Actions allow you to define which Actions appear in the menu bar, Task Pane, and
toolbar of a specific Business Object. For example:

• Add a Reset Password One-Step™ to an Incident menu bar and/or Task Pane so that Users can
quickly initiate the Action directly from an Incident record.

• Define Actions that execute automatically when a record is saved, updated, or changes status
(example: Send a follow-up e-mail when an Incident changes status).

• Add Actions to link labels and buttons directly on Forms (example: Add a button to an Incident that
launches a command to initiate a remote support session).

Many Actions are available in the OOTB Business Objects to facilitate working with records. Use these
as-is, edit them, or add your own Actions.
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Add an Action to a Customer Portal
Portal Actions are customizable Actions that can be added to/executed from the Portal Menu Bar, a
Dashboard, or an HTML page. For example, you can:

• Display create commands for the Business Objects used on the Portal Site (example: Create
Incident).

• Display common Searches (example: Search My Open Incidents).

• Display a Home button on the Portal menu bar to take Customers back to the Startup Item.

• Display/run a CSM Item (example: Action Catalog, Report, and Document Repository).

• Launch a CSM Item Manager so that a Customer can select a CSM Item to display/run.

• Run a One-Step™ to run one or more other Actions.

• Display an MRU (Most Recently Used) list.

• Display a Business Object drop-down.
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Add an Action to Cherwell Mobile
Cherwell Mobile allows you to run certain One-Steps against Business Object records.

Examples of Mobile Actions/One-Steps include:

• Look up configuration item information using barcode scanning.

• Update a Customer's location.

• Take a picture and attaching it to a record.

• Change status.

• Set priority.

• Create tasks.

Some One-Steps are available by default, either as part of the mobile application or as part of the
Business Object; others are made available through a list of Business Object Actions defined in the
mobile configuration (either global/Role or personal). The available One-Steps can vary per type of
Business Object and are accessed by tapping the Mobile One-Steps button.

• iOS: Mobile One-Step button looks similar to .

• Android: Mobile One-Step button looks similar to .
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About One-Steps
A One-Step is made up of a series of Actions and can be simple (a few Actions) or complex (multiple
Actions that run under conditional circumstances).

Run a One-Step from the One-Step Manager, or from a variety of places within CSM, including buttons
and links on Business Object records, Dashboards, menu bars, and panes. One-Steps can also be
automatically initiated by Automation Processes. You can run a One-Step against a single record, a set of
records, or a predefined Search Group.

Use One-Steps to automate common or repetitive tasks. For example:

• Create a file for all Incidents that have been open for more than a week, and then e-mail it to the
manager (simple example with no conditions).
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• Create a Change Request from an Incident, and then notify the change owner via e-mail (complex
example with multiple Actions and conditions).
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• Run One-Steps from the One-Step Manager or from a variety of places within CSM, including:

• CSM Desktop Client toolbars (either User or Global/Role).

• CSM Desktop Client Task Pane (either User or Global/Role).

• Business Object records (as record-specific One-Steps on the toolbar, menu bar, context menu,
Task Pane, a button, or a link). One-Steps can also be Automatic Actions that are executed when a
Business Object is saved.

• Browser Client (from the menu bar; as buttons, links, and Widgets on Dashboards; as buttons and
links on Business Object records, or as record-specific Actions in a context menu).

• Customer Portal (from a menu bar, Dashboard Widget, or HTML page).

• Dashboards (by clicking Widgets).

• Automation Processes (One-Steps that run automatically based on specified rules).

• Cherwell Outlook Add-In (record-specific One-Steps that run from Microsoft Outlook®).

• E-mail and Event Monitor (One-Steps for processing monitored e-mails).

• Approvals (One-Steps that run when an Approval is approved, denied, or expired).

• Scheduled Items (One-Steps that run on a scheduled basis).

CSM provides several OOTB One-Steps in the CSM Desktop Client and Browser Client (on panes, menu
bars, and toolbars, as well as in Business Objects (to help you work with records) and OOTB Automation
Processes). Use these One-Steps as-is, edit them, or create your own using the One-Step Editor. You
can also add One-Steps (along with many other types of Actions) to various CSM areas. For more
information, see the Actions documentation.
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One-Steps Good to Know
• Run a One-Step from the One-Step Manager or from a variety of places within the CSM Desktop

Client, Browser Client, and Portal (example: Buttons, links, and menu items on task panes, menu
bars, toolbars, Business Objects, etc.).

• One-Steps in the Blueprint scope can be used virtually anywhere in CSM, but they can only be
created and edited in CSM Administrator (if you have security rights). The Blueprint scope is for
One-Steps that administrators do not want Users to edit or delete, such as those that run behind the
scenes (example: Form buttons and links on Forms).

• Note: To run a One-Step that is associated with a particular Business Object (ex: Incident),• 
the same type of record must be active (open or selected in a Grid). If the active record is
from a different Business Object than the One-Step that is trying to run, you will receive an
error.

• One-Steps behave differently in the Browser Client, Customer Portal, and Cherwell Mobile™.

• Actions that access or update Business Object data require at least one Business Object to be
available within the One-Step. A Business Object can be made available in a One-Step by:

◦ Selecting a Business Object association (either the current record or an available Business
Object in the Association drop-down on the One-Step Manager toolbar). A Business Object
association can only be selected when a One-Step is first created and cannot be changed for
an existing One-Step.

◦ Creating it using a Create a New Business Object Action preceding the Action that requires
Business Object access (in the One-Step Editor).

◦ Navigating to it using a Go to a Record Action preceding the Action that requires Business
Object access (in the One-Step Editor).

• CSM provides several OOTB One-Steps in the CSM Desktop Client and Browser Client (on panes,
menu bars, and toolbars, as well as in Business Objects, OOTB Automation Processes, etc. Use
these One-Steps as-is, edit them, or create your own using the One-Step Editor.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure One-Step Security Rights.

• File Attachment rights control the Attachment operations that can be performed using One-Steps.
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One-Steps and Record Locking
The following record locking guidelines apply to One-Steps:

• By default, a One-Step Action that updates a record (including Actions that update or create child
records) honors the record locking behavior of the active record on which the One-Step is run (the
record must be open or selected in a Grid). For more information, refer to Record Locking.

• For One-Steps that update a Business Object, it is best practice to configure the One-Step (in
general properties and conditions) to explicitly acquire a lock before running to ensure that the
active record is locked prior to One-Step execution, not just when a specific Action to update a
record is being executed. That way, a One-Step will not fail if a particular Action cannot acquire a
lock.

• If a One-Step is configured to acquire a lock prior to execution, it can also be configured to explicitly
release the lock after the entire One-Step finishes executing. Otherwise, the lock will be released
according to the record locking behavior configured for the active record (example: If the Business
Object is configured to automatically release locks upon save and the One-Step Action saves the
record, then the lock is released when the One-Step saves the record).
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Using One-Steps
Users can view and run One-Steps.
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View a One-Step
A One-Step can be viewed several ways:

• Available One-Step (based on security rights): Use the One-Step Manager.

• From an item that uses a One-Step (ex: Toolbars, menu bars, Dashboards, etc.).
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Run a One-Step from the One-Step Manager
From the One-Step Manager in the CSM Desktop Client, you can run One-Steps against groups, single
records, or predefined Search Groups. You can also access the One-Step Manager in the Browser Client
to run One-Steps against single records.

You cannot run One-Steps in CSM Administrator. When accessing One-Steps in CSM Administrator, it is
primarily to create, edit, or delete them for Users and/or to add them to various areas within CSM
(example: Business Object Forms, Dashboards, and Automation Processes).

Note: To run a One-Step that is associated with a particular Business Object (example: Incident),
the same type of record must be active (open or selected in a Grid). If the active record is from a
different Business Object than the One-Step that is trying to run, you will receive an error.

To run a One-Step from the One-Step Manager:

1. Open the One-Step Manager.

2. Select a scope and subfolder (if needed).

3. Select a Business Object association, if applicable.3. 

4. Run the One-Step:

◦ Against the active record: Click the Run button  on the One-Step Manager toolbar (or click
File>Run from the menu bar). Double-click the One-Step, or click the Run button at the
bottom of the window.

◦ (Desktop Client only) Against a group of records: Click the Run for Currently Open Group

button  on the One-Step Manager toolbar (or click File>Run for Group from the menu
bar). This runs the One-Step against the active group of records (the group the open record
belongs to, or the group of records shown in a Grid). Configure the One-Step to run against a
specific Search Group (on the Conditions page).
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Run a One-Step from within CSM
Run a One-Step from a variety of places within CSM, including:

• CSM Desktop Client toolbars (either User or Global/Role).

• CSM Desktop Client Task Pane (either User or Global/Role).

• Business Object records (as record-specific One-Steps on the toolbar, menu bar, context menu,
Task Pane, a button, or a link). One-Steps can also be Automatic Actions that are executed when a
Business Object is saved.

• Browser Client (from the menu bar; as buttons, links, and Widgets on Dashboards; as buttons and
links on Business Object records, or as record-specific Actions in a context menu).

• Customer Portal (on a menu bar, a Dashboard Widget, or HTML page).

• Dashboards (as buttons, links, and Widgets).

• Automation Processes (One-Steps that run automatically based on specified rules).

• Cherwell Outlook Add-In (record-specific One-Steps that run from Microsoft Outlook).

• E-mail and Event Monitor (One-Steps for processing monitored e-mails).

• Approvals (One-Steps that run when an Approval is approved, denied, or expired).

• Scheduled Items (One-Steps that run on a scheduled basis).
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Managing One-Steps
One-Steps are managed using the One-Step Manager.

Use the One-Step Manager to complete general CSM Item Manager operations for One-Steps.

Use this tool to:

• View a One-Step.

• Run a One-Step.

• Create a One-Step (using the One-Step Editor).

• Edit a One-Step (using the One-Step Editor).

• Delete a One-Step.

• Search for a One-Step.

• Organize One-Steps.

• Copy a One-Step.

• Import/export a One-Step.

• Find One-Step dependencies.

• Add a One-Step to the Desktop Client Task Pane/toolbar.
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Good to know:

• Use the Manager Context (right-click) menu to quickly access menu bar/toolbar options.

• One-Steps in the Blueprint scope can be used virtually anywhere in CSM, but they can only be
created and edited in CSM Administrator (if you have security rights). The Blueprint scope is for
One-Steps that administrators do not want Users to edit or delete, such as those that run behind the
scenes (example: Form buttons and links on Forms).

• You cannot run One-Steps in CSM Administrator. When accessing One-Steps in CSM
Administrator, it is primarily to create, edit, or delete them for Users and/or to add them to various
areas within CSM (example: Business Object Forms, Dashboards, Automation Processes, etc.).

• For more information about working in CSM Item Managers, refer to the Item Managers
documentation.

• Managers look and behave differently in the Cherwell Browser Client. For more information, refer to
the Cherwell Browser Client documentation.
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Open the One-Step Manager
There are several ways to open the One-Step Manager:

• From the CSM Desktop Client menu bar, click One-Step>One-Step Manager.
• From the Browser Client menu bar, click One-Step>One-Step Manager.
• From the Blueprint Editor menu bar in CSM Administrator, click Managers>One-Step Manager.
• From One-Step selectors throughout CSM (example: When adding One-Steps to various areas

within CSM).

CSM 9.3.0 Features 935

CSM 9.3.0 Features



One-Step Editor
The One-Step Editor is a tool that allows you to easily create simple or complex One-Steps to automate
common or repetitive tasks in CSM. Use the One-Step Editor to create and edit One-Steps in CSM
Administrator or the CSM Desktop Client.

1. Toolbar:

Commonly used One-Step Editor tasks.

2. One-Step Components:
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Tabs that show Designer Boards for the series of Actions that comprise the One-Step (the main
Actions as well as pre-steps and post-steps, if applicable).

3. Aerial View:

View the entire process as you zoom in and out. Also allows you to move the section of the current
process on the Designer Board.

4. Designer Board:

A visual representation of the process.

5. Actions Pane: Actions available to be added to the Designer Boards. These are categorized as:
◦ Common Actions: Actions that are commonly used in One-Steps.

◦ Business Object Actions: Actions that create new Business Objects or require access to
Business Object data.

◦ Advanced Actions: Actions that involve knowledge of advanced concepts and/or more
complex configuration.

6. Step Details:

Details of the currently selected step in the process.

This is where you define properties for the One-Step and for each Action.

The Designer Board for the One-Step Editor includes the following elements:

1. Start Graphic:
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Event or starting point that initiates the process.

Tip: Click the Start Graphic on the Designer Board to define general properties for the
process.

2. Placeholder Graphic:

Holds the steps (Events and/or Actions) that constitute the process.

3. End Graphic:

Indicates the end of the process.
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One-Step Editor Toolbar

Button Action

Save

Undo

Redo

Copy

Add an Action

Delete

Action Condition

Child Record Actions

Define Preferences for the Designer/Editor

Increase or decrease the size of the diagram on the
Designer Board.
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Available One-Step Editor Actions
Multiple Actions are available in the Actions pane of the One-Step Editor. These Actions can be added to
the Designer Board in countless combinations to create simple or complex One-Steps.

Actions are categorized as follows:

• Common Actions: Actions that are commonly used in One-Steps.

• Business Object Actions: Actions that create new Business Objects or require access to Business
Object data.

• Advanced Actions: Actions that involve User knowledge of advanced concepts and/or more complex
configuration.

Several Actions that access Business Object data (example: Update a Business Object) are executed
against whichever Business Object is active, either a Business Object association or a Business Object
from a preceding Action (Create a New Business Object or Go to a Record). For example, if a One-Step
that updates a Business Object is associated with an Incident, then Incident is the active object (the
Update a Business Object Action runs against Incident). If a Create a New Business Object Action is
added to create a Problem record (preceding the Update a Business Object Action), then the Problem
Business Object becomes the active object (the Update a Business Object Action runs against Problem).

Several Actions that access Business Object data (example: Link/Unlink Business Objects) allow you to
select which Business Object to execute against (if more than one Business Object is available within a
One-Step).

Note: Some Actions might be limited in the Browser Client. Refer to the Browser Client One-Steps
for more information.

One-Step Action Description Business Object
Required

Common Actions   

Launch a URL Launches a specified URL. Not required

Print
Creates a document that is automatically sent to
the printer. This Action requires a connection to a
printer.

Not required

Run a Program Launches a program that can be run from a
Windows command line. Not required

Run a Report Runs a Report created using the Cherwell Report
Writer™. Not required

CSM 9.3.0 Features 940

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=browser_client_one-steps


Send a Tweet
Posts a Tweet to a Twitter Account.

Note: This Action requires a Twitter Account.
Not required

Send an E-mail

Automatically sends an e-mail to specified
recipients

Note: This Action requires a CSM E-mail Account.

Not required

Show a Pop-Up

Shows a message to Users, usually asking
whether they want to continue, requesting
additional information, or prompting them to select
from a list of options.

Not required

Write to a File Creates, overwrites, or appends contents to a file. Not required

Business Object Actions   

Create a New Business
Object

Creates a Business Object and optionally sets
values for Fields within the Business Object. Not required

Create a New Child
Business Object

Creates a child record that belongs to the active
Business Object. Required

Delete a Business
Object

Deletes a Business Object, either the active
Business Object or a related Business Object. Required

Go to a Record
Navigates to a specified record based on type and
record ID or a Relationship.

Not required (unless
going to a record in
a Relationship)

Link/Unlink Business
Objects

Links/unlinks records to/from a Relationship. Required*

Step Through Children
Runs the same Actions on each child record of a
Business Object. Required

Transfer Attachments
Transfers Attachments to a file system or Business
Object from another file system or Business
Object.

Required*

 

Transfer Related
Business Objects

Transfers related records from one Business
Object to another. Required*

Update a Business
Object

Updates the value of Fields in the active Business
Object. Required

Work with a Queue
Performs Queue operations against the active
record. Required

Advanced Actions   
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Call a Web Service
Dynamically calls a web service, and then saves
the results as a variable. Not required

Decide Between Multiple
Cases

Branches the One-Step into multiple paths that are
executed based on defined conditions. Not required

Excel Merge
Creates an Excel file using data from CSM.

Requires creating an Excel template.
Not required

Execute a Command
Executes commands, runs reports or Search
Groups, or opens Calendars, Dashboards, or
Visualizations.

Not required

Go to a Field
Navigates to a particular Field or tab in the active
record. Required

Go To Action
Navigates to another One-Step Action, or ends
One-Step execution. Not required

Run Another One-Step Runs another One-Step. Not required

Step Through
Collection

Steps through each item or object in a collection or
array of XML or JSON data. Not required

Update a Variable or
Stored Value

Updates a variable value or Stored Value using a
predefined value, or the value of a User-specific
variable that you create.

Not required

*Select the Business Object for this Action (if more than one Business Object is available within a One-
Step).
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Open the One-Step Editor
The One-Step Editor can be opened several ways:

• From within the One-Step Manager, click the Create New button. The One-Step Editor is
automatically opened after you define One-Step properties (name and description).

• From within the One-Step Manager, click the One-Step to edit, and then do one of the following:
◦ Right-click>Edit.
◦ Click File>Edit.

◦ Click the Edit button .
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Create/Edit a One-Step
Video Resources

• 3-Minute Video: Create a One-Step

• Subscription-based Video Learning Library: Automating with One-Step Branching

• Subscription-based Video Learning Library: Creating a One-Step for an Incident

Use the One-Step Manager and One-Step Editor (accessed from the One-Step Manager) to create a
One-Step.

Note: In the Browser Client and Portal, you can run One-Steps, but you cannot create, edit, or
delete them.

To create a One-Step:

1. Open the One-Step Manager.

2. Select a scope and subfolder (if needed).

3. Select a Business Object association, if applicable.3. 

One-Steps do not need to be associated with a Business Object. Select (None) from the
Association drop-down for general One-Steps that do not need to access any Business Object data
(example: One-Steps that create completely new Business Objects or launch URLs).

4. Click the Create New button.

5. Provide a name and description for the One-Step.

6. Click OK.6. 

7. Define general properties for the One-Step.

8. Define conditions properties for the One-Step.

9. Define the annotation properties for the One-Step.

10. Define Actions for the One-Step.

11. Define pre-/post-steps for the One-Step.

12. Click OK.12. 

Edit a One-Step
To edit a One-Step:

1. Open a One-Step in the One-Step Editor.
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2. Make changes. Click the Start Graphic on the Designer Board to edit One-Step general properties
and conditions.

3. Click OK.3. 
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Define General Properties for a One-Step
Use the Create a new One-Step window and the Start window in the Step Details section of the One-Step
Editor to define the general properties for a One-Step.

To define general properties for a One-Step:

1. Open the One-Step Editor.

2. Click the Start Graphic.

3. In the Step Details section, click the General page.

4. Define general properties. Name and Description are originally defined in the Create a New One-
Step window. However, they can be changed here, if needed.

Option Description

Name Provide a display name to use within CSM (this property can be searched in
CSM Item Managers).

(Optional) Description Provide a description to use within CSM (this property can be searched in
CSM Item Managers).

Business Object Business Object: Shows the Business Object association selected in the
One-Step Manager. This is read only.

5. (Optional) Click the Options button.

Option Description

Availability Select a scope. If you already selected a scope at the beginning, this
is auto-filled with your selection.

Association
If applicable, select a more filtered scope (example: A particular
Team). <Automatic> applies scope based on login. If not applicable,
this option is grayed out.

Custom Image
Click the Image button to open the Image Manager, and then select
an existing image or import a new image to represent the item in the
UI.
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Define the Conditions for a One-Step
Use the Create a new One-Step window and the Start window in the Step Details section of the One-Step
Editor to define the condition properties for a One-Step.

To define condition properties for a One-Step:

1. Open the One-Step Editor.

2. Click the Start Graphic.

3. In the Step Details section, click the Conditions page.

4. In the Allow One-Steps to Run Against drop-down, select an option.

Option Description

Single Record or Group of
Records

Select this option to allow the One-Step to run against the active
record or group of records.

Single Record Select this option to allow the One-Step to run only against the
active record.

Group of Records Select this option to allow the One-Step to run only against the
group of records that is active when the One-Step is launched.

Specific Group Select this option to allow the One-Step to run only against a
specified Search Group.

5. (For Specific Group only) Click the Ellipses button to open the Search Group Manager, and then
select an existing Search Group (saved Search Query) or create a Search Group. Saved Searches
can be used over and over in numerous places.

6. Define a condition that limits when the One-Step runs:

Option Description

Only Allow One-Step to Be
Run Based on Condition

Select this check box to have the One-Step run only when it meets
the criteria of a defined Expression.

Expression Define an Expression that determines when the One-Step runs:

Stored Expression
Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored
Expression. Stored Expressions can be reused in numerous places in
CSM.

Custom Expression Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically
for this scenario.

Error Message
Provide an error message that appears when a One-Step attempts to
run but fails because it does not meet the defined condition. This is
required if you select to run the One-Step based on a condition.
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7. Only Allow This One-Step Process to be Run in the Application: Select this check box to only allow
the One-Step to run in the CSM Desktop Client.

8. Allow One-Step to be Run Even if No Current Record: Select this check box to allow the One-Step
to run even if no record is active.

Note: This option is only available if the One-Step runs against a single a record (either
Single Record or Group of Records or Single Record is selected in the Allow One-Steps to
Run Against drop-down).

9. Show Custom Tokens: To show certain Tokens in One-Step Actions where the Token menu is
available, select the type of Token in the drop-down. For example, select E-mail to make e-mail
Tokens available to be inserted into One-Step Actions so that the One-Step can access e-mail
specific data, such as the sender's e-mail address, the subject line, etc. This is useful for One-Steps
used in an E-mail Monitor.

10. Define record locking options. These options are only available if the One-Step has a Business
Object association.

Options Description

Acquire Lock Before
Running

Select this check box to have the One-Step lock an active record before
executing any Actions, including pre-steps.

Important: Selecting this check box is recommended for One-
Steps that update Business Objects; it ensures that the active
record is locked prior to One-Step execution, not just when a
specific Action to update a record is being executed. That way, a
One-Step will not fail if a particular Action cannot acquire a lock. If
this check box is not selected, the One-Step will still lock an active
record (if the record participates in locking) when it runs Actions to
update that record.

Release Lock After
Running

Select this check box to have the One-Step release any acquired locks after
the entire One-Step finishes running. If this check box is not selected, locks
are released based on the record locking settings configured in CSM
Administrator.

11. Run under Security Group: Select a Security Group under which the One-Step can run. This
determines which Business Object Fields the One-Step can access when it runs.

Option Description

(Default) Current User's
Security Group

Select this option to allow the One-Step to be run under the Security Group
to which the current User belongs.
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Option Description

Alternate Security Group

Select another existing Security Group under which the One-Step is allowed
to run (example: IT Service Desk Manager).

Note: Security rights control which Security Groups are available in
the drop-down. For example, you might only be able to select either
Current User's Security Group (which is subject to change) or the
specific Security Group to which you belong (example: Admin). If
you select Current User's Security Group, then the One-Step runs
under the Security Group to which the current User belongs. If you
select a specific Security Group, then the One-Step runs under that
specific Security Group (example: If you select Admin, then the
One-Step runs under the Admin group, even if your current Security
Group changes).
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Define the Annotations for a One-Step
The annotation options allow an Administrator to communicate the function and purpose of a One-Step.

To define annotation properties for a One-Step:

Provide information for the two text fields.

Option Description

Annotation title (shown in tooltip) This information is shown as a tooltip when a User hovers over an
action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.
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Action Attachments

Use the arrow next to the attachments button  to select the type of attachment:

• Attachment Manager: Adds Attachments from the Attachment Manager.

• Browse: Adds files from a computer directory as attachments.

• Custom: Opens the Custom Filename Builder and provides the name of the file (using text and/or
Tokens) to attach to the e-mail.

• From Records: Opens the Define Rules for Attachments window and selects criteria for which
Business Object Attachments to include in the e-mail. This is useful if the Action is run against
records that contain multiple Attachments.

Note: File Attachment rights control the Attachment operations that can be performed in
CSM.

Option Description

All Attachments/Files Includes all Attachments/files from the selected Business Object/directory.

First
Includes the first defined number of Attachments/files from the selected
Business Object/directory. Then, provide a number or use the up/down
arrows to increase/decrease the number.

Last

Includes the last defined number of Attachments/files from the selected
Business Object/directory. Then, provide a number or use the up/down
arrows to increase/decrease the number. If First or Last is selected,
Attachments/files are sorted in alphabetical order if they are from a
directory, and by the order of appearance on the Business Object's
Attachment Bar if they are from a Business Object.

Include Attachment/File
Includes Attachments/files based on file masks (include Attachments/files
that contain certain characters, words, file extensions, etc.). Then, specify
the file masks, using semicolons to separate each mask.

Exclude Attachment/File
Includes Attachments/files based on file masks (include Attachments/files
that contain certain characters, words, file extensions, etc.). Then, specify
the file masks, using semicolons to separate each mask.

Minimum Size
Includes Attachments/files that are of a minimum defined size, and then
provide a number or use the up/down arrows to increase/decrease the
number. In the drop-down, select kilobyte or megabyte.

Maximum Size
Includes Attachments/files that are of a maximum defined size, and then
provide a number or use the up/down arrows to increase/decrease the
number. In the drop-down, select kilobyte or megabyte.
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Define Actions for a One-Step
Use the Actions pane in the One-Step Editor to add Actions to the One-Step Designer Board. When you
add an Action to the Designer Board, the Action properties window opens in the Step details section,
where you can define specific properties for each Action. Adding or changing which Business Objects are
available within a One-Step affects any Actions that are configured to access a particular Business Object
(example: Adding, moving, or deleting a Create a New Business Object Action or Go to a Record Action,
or moving Actions that were defined to execute against a particular Business Object). Properties that were
based on a particular Business Object must be redefined if the available Business Object changes.

There are some icons that are shown on the Designer Board when working with Actions:

Icon Description

The Go To Action icon shows when it is dragged onto other Actions in the One-
Step that you want the Action to jump to.

A function icon is shown on the Action Graphic (upper left corner) if the Action is
conditional. The Action does not execute if it does not meet the defined
condition.

If you navigate away from an Action without defining all of its required properties,
a Warning icon shows on the Action Graphic on the Designer Board. Click the
Action to return to the Step Details where a warning icon shows next to the
required text boxes. Hover over the icon to show a tooltip that explains what
information is required. In some cases, a More Info link is available. Click the link
to open a pop-up window containing more details about the warning.

To define Actions for a One-Step:

1. Open the One-Step Editor.

2. Add one or more Actions to the Designer Board.

3. In the Step Details section, define the properties for each Action.

4. (Optional) Define conditions that limit when an Action is executed. To add conditions:
◦ Right-click an Action on the Designer Board, and then click Action Condition in the context

menu.

◦ Click the function button on the One-Step Editor toolbar.

◦ Edit the condition by double-clicking the function icon, right-click the Action on the Designer
Board, and select Action Condition, or click the function button on the toolbar.

5. Select Only Run Action [name of Action] if Condition is True check box to define an Expression
that controls when the Action is executed.

6. Define the Expression for the condition:

Option Description

Stored Expression
Click the Ellipses button to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression.
Stored Expressions can be reused in CSM.
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Option Description

Custom Expression
Click the Custom Expression button to open the Custom Expression
Builder, and then create a custom Expression specifically for this
scenario.

CSM 9.3.0 Features 953

CSM 9.3.0 Features



Define a Launch a URL Action for a One-Step
Use the Launch a URL Action to launch a URL. For example, add a One-Step to a Dashboard Widget on
a Customer Portal to launch your company's website when Customers click on a link.

To define a Launch a URL Action:

1. Open the One-Step Editor.

2. Add a Launch a URL Action to the Designer Board.

3. Define general properties for the Launch a URL Action:

Option Description

Name Provide a display name for the Action (this is how the Action is
identified within the One-Step).

URL

Define a URL to launch from this Action. Provide text. Click the
Selector button to insert Tokens (example: Fields, System
Functions, Prompts, Expressions, Stored Values, Metrics, and
Counters) directly into the text.

4. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

5. Click the Ellipses button to navigate to the specified URL to ensure it is correct.

6. Click Save.
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Define a Print Action for a One-Step
Use the Print Action to create a document that is automatically sent to the printer when the One-Step is
run. For example, print certain Fields of an Incident Record (or group of Incident Records) in a memo
format. Fields can be inserted as Tokens, and the Rich Text Zoom window can be used to format the
contents.

If multiple Print Actions within a One-Step are not associated with the same print job, then the contents
from each Action are sent to the printer separately and are typically printed on separate pages.

To define a Print Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Print Action to the Designer Board.

3. Define general properties for the Print Action:

Option Description

Name Provide a display name for the Action (this is how the Action is
identified within the One-Step).

Printer

In the drop-down, select a printer. The menu shows all connected
printers. Click the Page Setup button to open the Page Setup
window and define options for how the document is printed (paper
size, paper source, orientation, and margin size).

4. Define the contents to print:
◦ Provide text. Click the Selector button to insert Tokens (example: Fields, System Functions,

Prompts, Expressions, Stored Values, Metrics, and Counters) directly into the text.

5. Define additional options for the Print Action:

Option Description

When running against a group,
append text together before
printing

If you run the One-Step against a group of records, select this
check box to append them together before they are printed (rather
than printing each record separately).

Associate with a print job

If there are several Print Actions within a One-Step, select this
check box to have the contents for each Print Action printed
together under the same print job, and then provide a name for the
print job. This option is only available if you select the option to
append text together before printing.

6. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.
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7. Click Save.
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Define a Run a Program Action for a One-Step
Use the Run a Program Action to launch any program that can be run from a Windows command line. For
example, add a One-Step to a button, link, menu bar, or task pane of an Incident record so that
Technicians can run a program to reset a password, page a technician, or ping a server directly from a
record.

To define a Run a Program Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Run a Program Action to the Designer Board.

3. Define general properties for the Run a Program Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Filename
Provide the name (using text and/or Tokens) of the program or file to
launch, or click the Ellipses button to navigate to the program or file on
your computer.

Start In

If the program or file should start running in a particular directory, then
provide the name of that directory (using text and/or Tokens), or click the
Ellipses button to browse to the directory on your computer. If no directory
is specified, the current working directory is used (this is usually the
directory from which CSM was launched).

4. Define command-line arguments: Provide any arguments that must be passed to the program
(using text and/or Tokens). Tokens are passed to the program as parameters.

5. Define how the One-Step should interact with the program:

Option Description

Wait for Program to End
before Continuing

Select this check box to have the One-Step wait until the program finishes
executing before continuing to the next Action.

Only available if Wait for
Program to End before
Continuing is selected

Timeout after X Seconds: The One-Step either waits until the program is
finished executing or the specified number of seconds has passed.

Store Exit Code from Program: The CSM stores the program’s return code
for use in future One-Step Actions, and then provides a name for the
variable that will hold the return code (example: Run program result). Then
it is available as a variable in the system. This is not required; however, in
most cases, you want to store the program result so that you can do
something with it (example: Create a Journal - History record that stores the
result).

6. Define how the program should run:
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Option Description

Run

In the drop-down, select the size of window (normal, minimized, or
maximized) to open the program in (applies to command prompt window
as well as the executable program). The command prompt window in the
background (it is not shown on the computer screen).

Custom Run Verb

Uses a custom run verb. This is an additional parameter that tells the
program how to run (if the program requires one). Some common verbs
are new, open, edit, and print. Consult the program’s documentation to find
out what verbs are available. If the program makes its list of supported
verbs available, they are available in the drop-down.

Pause after Run
The One-Step pauses for a few extra seconds after running the program
before continuing to the next Action; the User specifies the number of
seconds the One-Step should pause.

7. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

8. Click Save.
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Define a Run a Report Action for a One-Step
Use the Run a Report Action to run a Report that was created using the Cherwell Report Writer™. For
example, add a One-Step to an Automation Process to periodically run a Report of all open Incidents
assigned to you, and then print the Report or save it to a file.

To define a Run a Report Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Run a Report Action to the Designer Board.

3. Define properties for the Run a Report Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Report Click the Ellipses button  to open the Report Manager and select a
Report for the Action to run.

Data

Select the data to use for the Report:
◦ Use Report Criteria: The Action runs the Report exactly as designed

(example: Against a particular Search Group).

◦ Current Record: The Action runs the Report against the active record
(the single record selected before running the One-Step).

◦ Current Group: The Action runs the Report against the current group
of records. For example, run a Quick Search for all Incidents
containing the word print, and then execute the One-Step. The list of
records resulting from the search become the data for the Report.

4. Define an option for outputting the Report after it runs:

Option Description

Print

Select this radio button to print the Report. Then, select a printer in the
drop-down (the drop-down shows the connected printers).

Click the Settings button to open the Print Options window and define the
number of copies to print and whether or not to collate.
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Option Description

Write to File

Select this radio button to export the report to a file, either:
◦ Specify a filename: Provide text. Click the Selector button to insert

Tokens (example: Fields, System Functions, Prompts, Expressions,
Stored Values, Metrics, and Counters) directly into the text.

◦ Click the Browse button to select an existing file from your computer.
In the drop-down, select a file format.

CSM supports the following export formats:

◦ Adobe PDF

◦ Bitmap

◦ CSV

◦ EMF

◦ Excel

◦ HTML

◦ JPEG

◦ Plain Text

◦ PNG

◦ Rich Text

◦ TIFF

Note: If the Report is exported to an existing file, the
Report overwrites the data in the file. If the Report is not
exported to an existing file, a new file is created.

5. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

6. Click Save.
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Define a Send a Tweet Action for a One-Step
Use the Send a Tweet Action to post a new Tweet to a Twitter account. For example, add a One-Step to a
Twitter button on the Problem Form to tweet the Resolution description when the Problem is closed.

To use Twitter buttons on a Form or Dashboard, first create a Twitter Account and Activate Twitter
Buttons. Tweets are limited to 140 characters. If the total text, including inserted Tokens, exceeds 140
characters, the text is truncated. The Characters Remaining indicator at the bottom of the Send Tweet
window shows how many characters are remaining.

To define a Send Tweet Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Send a Tweet Action to the Designer Board.

3. Define general properties for the Send Tweet Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Account Click the Ellipses button to open the Twitter Account Manager and select
the account to which the Tweet should be posted.

Tweet
Provide text. Click the Selector button to insert Tokens (example: Fields,
System Functions, Prompts, Expressions, Stored Values, Metrics, and
Counters) directly into the text.

4. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

5. Click Save.
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Define a Send an E-mail Action for a One-Step
Use the Send an E-mail Action to quickly send an e-mail when the One-Step is run. For example, click a
link on an Incident record to send a follow-up e-mail to the Customer who submitted the Incident,
providing information or asking a question about the Incident. You can specify the contents of the e-mail,
even inserting Fields from the Incident as Tokens in the subject and/or body.

To send an e-mail using a One-Step, you must have an e-mail account in CSM. For more information,
refer to CSM E-mail Accounts.

To define an E-mail Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Send an E-mail Action to the Designer Board. Click the Zoom button on the toolbar to open
the e-mail message in a separate window.

3. Define e-mail options:

Option Description

Send Via

Select the e-mail account from which e-mails are sent when the One-Step is
run. This is automatically set to your default e-mail account set in CSM
Administrator, or by you (if you have security rights). If your administrator has
configured other accounts, select them in the drop-down. It is best to leave the
default account so it works for every User that runs the One-Step.

Field Visibility Select additional lines to show (From Address, Cc, Bcc, and Attachments).

Attachments 
Click the arrow to add attachments to the e-mail. For more information, see
Action Attachments.

Attach to Recipients Click the arrow to select options for attaching the e-mail to any of the
Customer records associated with recipients in the To, Cc, or Bcc lines after
the One-Step is run and the e-mail is sent.

Attach to Current Record Attach the e-mail to the active record as a Journal - Mail History record after
the One-Step is run and the e-mail is sent. This button is shown only if there is
a Business Object available within the One-Step to which the e-mail can be
attached.

Allow User to Edit 

Click the allow user to edit button on the toolbar to allow the User to edit the
e-mail before clicking Send. If this option is not selected, the e-mail is sent as-
is without allowing the User to view and edit it first. For more information about
e-mail history attachment options, refer to the E-mail Accounts documentation
on where to store e-mail history.

Selector 
Insert Tokens (example: Fields, System Functions, Prompts, Expressions,
Stored Values, Metrics, and Counters) directly into the text.

Name Provide a display name for the Action (this is how the Action is identified within
the One-Step).

To Click to open the Address Book to select the e-mail recipients, or provide
recipient e-mail addresses directly.
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Option Description

Subject Provide a subject for the e-mail.

4. Compose and format a message using the e-mail message toolbars and providing text.

5. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

6. Click Save.
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Define a Show a Pop-Up Action for a One-Step
Use the Show a Pop-Up Action to provide information or to prompt Users to do something. Pop-ups can
be used to ask Users if they want to continue, to request additional information, or to select from a list of
options. For example:

• Use a pop-up with a Prompt to have Users select an Incident owner from a list of names.

• Show a pop-up window with a confirmation message after a Customer adds a comment to the
Portal.

• Show a pop-up window with a list of buttons from which Users can select to return different values
or end One-Step execution.

You can define the appearance of a pop-up window. Pop-up windows can be shown as simple message
boxes and text boxes, as message boxes with selectable radio buttons or commands, etc.

To define a Pop-Up Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Show a Pop-Up Action to the Designer Board.

3. Define General options for the Pop-Up Action.

4. Define Button options for the Pop-Up Action.

5. Define Annotation properties.

6. Click Save.

Define General Pop-Up Actions
To define general properties for the Show a Pop-Up Action:

1. Provide descriptive information for the Pop-Up Action.

Option Description

Name Provide a display name for the Action (this is how
the Action is identified within the One-Step).

Caption Provide a title for the pop-up window that is shown
to the User (using text and/or Tokens).

2. Provide text in the Contents box to show as a message in the pop-up window. Click the Selector
button to insert Tokens (example: Fields, System Functions, Prompts, Expressions, Stored Values,
Metrics, and Counters) directly into the text.

3. From the Format drop-down, define the appearance of the pop-up window:

Option Description

Message Box Select this option to show the pop-up window as a
message box with a Close button.
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Option Description

Text Box Select this option to show the pop-up window as a
text box with an OK button.

Command Button Message Box
Select this option to show the pop-up window with
custom command buttons that represent different
options for the User to select.

Radio Button Message Box

Select this option to show the pop-up window with
custom radio buttons that represent different
options for the User to select.

Note: In the Browser Client, the Command
Button and Radio Button Message boxes
both appear as text boxes with a list of
options from which the User can select.
The functionality is the same as in the
Desktop Client; only the appearance is
different.

4. In the Buttons drop-down, select which buttons to show in the pop-up window:

Option Description

OK (Message Box and Text Box only) Select this option to show only an OK button in the
pop-up window.

OK and Cancel (Message Box and Text Box only)

Select this option to show both an OK button and
a Cancel button in the pop-up window. If a User
clicks the Cancel button, the Action is canceled
and the One-Step stops executing.

Note: If you select the Message Box
option and select to show a Cancel
button, the pop-up window shows an OK
button instead of a Close button.

Custom (Command/Radio Button Message Boxes
only)

Select this option to define custom buttons to show
in the pop-up window.

5. For message boxes, select an icon from Message Box Icon drop-down to show along with the
message in the pop-up window (asterisk, warning, or stop).

Define Button Options for the Pop-Up Action
You can add custom buttons to a Command Button Message Box or a Radio Button Message Box. For
example, create a workflow for an Incident with buttons to create child records, link records, or transfer
Attachments.

To Define custom buttons for a Command Button Message Box or Radio Button Message box:
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1. Click the Buttons page.

2. Click Add.

3. Define properties for the button:

Option Description

Display Text
Provide the value to show on or next to the button
(using text, or clicking the Selector button to insert
a Token).

Result Value Provide the value that the Pop-Up Action returns
when a User clicks the button.

Only show button if condition is true
Select this check box to define an Expression that
determines when the button should be visible. Then
define an Expression.

4. Select the Button Cancels One-Step check box to have the button cancel One-Step execution if a
User clicks it.

5. Click OK.5. 

6. Define additional buttons as necessary.

7. Select the Store User's Selection in Variable check box to store the button's result value as a
variable that can be used in other Actions within the One-Step. Then select an existing variable (if
one was defined in a previous Action within the One-Step) or provide a name for a new variable.

Define Annotation Properties

• Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.
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Define a Write to a File Action for a One-Step
Use the Write to a File Action to create, overwrite, or append contents to a file when the One-Step runs.
For example, add a One-Step to a threshold-based Automation Process to keep a log file of the current
date and time whenever the number of open VIP Incidents exceeds a certain threshold. Use the
Temporary Filename Token to create a temporary file that goes away after a One-Step is finished
executing.

To define a Write to a File Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Write to a File Action to the Designer Board.

3. Define properties for the Write to a File Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Filename

Provide the path and name of the file that you want to create (using text

and/or Tokens), or click the Ellipses button  to select an existing file to
overwrite or append.

Contents Provide text.

Selector
Click the selector button to insert Tokens (example: Fields, System
Functions, Prompts, Expressions, Stored Values, Metrics, and Counters)
directly into the text.

Format Select the format of the file to create, overwrite, or append (plain text, Rich
Text, or HTML).

Make sure file is written

Select when the file should be written:
◦ By End of One-Step Process: The Action keeps the file open during

One-Step execution and writes to it during each step (the file is not
completely written until all of the post-steps are completed).

◦ Before Post-Steps Are Run: The Action writes to the file before any of
the post-steps are executed.

◦ Before Next Sub-Step: The Action writes to the file after each Action in
the One-Step.

The Before Next Post-Steps Are Run or Before Next Sub-Step options
cannot be used with the Rich Text Format (RTF). RTF documents have close
tags that do not allow files to be appended after they are created.

Overwrite existing file Select this check box to overwrite an existing file. Clear the check box to
append the contents to the file.

4. Click the Annotation page, and then define the annotation properties:
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Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

5. Click Save.
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Create a Temporary File
Use the Temporary Filename Token to create a temporary file for a Write to a File Action or an Excel
Merge Action in a One-Step. Use temporary files to create files that do not need a particular name, and to
avoid overwriting the same file multiple times. In addition, temporary files can be deleted after the One-
Step is finished executing.

To create a Temporary File:

1. In a Write to a File Action in a One-Step, right-click in the Filename text box.

2. Click Filenames>New Filename.

3. Define properties for the temporary file:
◦ Name: Provide a name for the temporary file (example: Report). This is the name that appears

in the Token menu under Filenames so that it can be used in other One-Step Actions. This
name is for reference only; it is not the actual name of the file. It is given a unique name
(example: tmp001) wherever it is stored (temporarily or persistently) on a computer. The
Sample area in the Filename Properties window shows what the actual name might look like
(with or without the full path).

◦ Filename Includes a Full Path: Select this check box to include the full path to the User’s
temporary directory (example:
C:\Users\firstname.lastname\AppData\Local\Temp\tmp0001.TMP). Clear the check box to use
only the filename (example: tmp0001.TMP).

Note: In the figure, the temporary file (tmp0001.TMP) is being created in the current
User’s working directory. To specify a particular directory, provide it before the name
you specified for the file. You can also clear the Filename Includes a Full Path check
box and specify the full path in the Filename text box of the Write to a File Action.

◦ Delete File after One-Step Process is Complete: Select this check box to delete the temporary
file after the One-Step finishes executing. Clear this check box to have the file persist. Include
a full path so that CSM can find the location of the file to delete it.

◦ Use Custom Extension: Select this check box to define a custom extension. Then, provide the
extension.

Note: By default, temporary files have a TMP extension. However, if you are creating a
specific type of file, such as a text file (TXT) or a Rich Text Format (RTF) file, consider
using an appropriate extension so that other programs know how to handle the file.

4. Click OK.4. 

The filename is shown in the Token menu under Filenames and can be used again for other One-
Step Actions.
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Define a Create a New Business Object Action for a
One-Step

Use the Create a New Business Object Action to create any Business Object that is allowed in One-
Steps. For example, use a One-Step to automatically create a Problem using values from the active
Incident record.

To define a Create a New Business Object Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Create a New Business Object Action to the Designer Board.

3. Click the General page.

4. Define general properties for the Create a New Business Object Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Business Object

Select a single type of Major Business Object to create. If you selected a
Business Object association when the One-Step was created, it is selected
by default. Select a different one if needed. To display all Business Objects,
select the Show All check box.

Make New Record
Current

Makes the Business Object from the Action the active record after the Action
is executed. This allows Users to immediately edit the record. If this check
box is not selected, the record opens in the background and does not appear
on the screen.

Link to Parent

Links the new Business Object to another Business Object using an existing
Relationship. Select a Relationship that links the two Business Objects. The
Link to Parent option is only available if the Business Object being created
has an existing Relationship with another Business Object that is available
within the One-Step (from a Business Object association, another Create a
New Business Object Action or a Go to a Record Action).

Save Business Object
after Action

Automatically saves the Business Object after the Action executes. The
Business Object is not saved if required Fields do not have a value, or if Field
validation fails.

5. Click the Fields page.

6. Define options for selected Business Object Fields:
a. Filter the Fields tree:

Option Description

Search Control Quickly locate a Field whose Name and Description contain a specific
word or phrase (example: OwnedBy).
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Option Description

Only Show Set Fields 
Shows only those Fields that have values set. This is useful when
going back to edit the Action to quickly see which Field values are set
by the Action.

Ignore Folders 
Ignores the organizational folders and displays all Fields at the root of
the list.

Show Field Values 

Opens a window that shows the Fields and values from the currently
open record. Click a Field, and then click the Select button (selecting a
Field in the window also selects it in the Fields tree). The Show Field
Values button  is only available if a currently open record is the same
as the Business Object the Action is defined to execute against
(example: An Incident record is currently open, and the Action is
defined to execute against an Incident).

b. Select a Field in the Fields tree, and then select one of the following options:

Option Description

Don't Set Field
(Default)

The Action does not have a set value. However, if the Field has a
default or auto-populated value, that value is used.

Clear Value The Action clears any default or auto-populated value that gets
assigned to the Field when the Business Object is updated.

Set Value

The Action sets a specific value. Provide text, or click the Selector
button to insert a Token (Field, System Function, Prompt, Expression,
Stored Value, Metric, Counter, etc.). The available Fields in the Token
Selector reflect the current Business Object (the Business Object being
updated or created by the Action).

If the Field is validated, the Legal Values button is available to allow
selection of a valid value.

Template

The Action creates a custom defined value. Provide text. Click the
Selector button to insert Tokens (example: Fields, System Functions,
Prompts, Expressions, Stored Values, Metrics, and Counters) directly
into the text. The available Fields in the Token Selector reflect the One-
Step Business Object context (from the One-Step association or from a
preceding Create a Business Object Action or Go To a Record Action).

The option to Show Field Values is available in the Tokens menu if a
currently open record is the same as the Business Object the Action is
defined to execute against (example: An Incident record is currently
open, and the Action is defined to execute against an Incident). Select
this option to open a window that shows the Fields and values
contained in the currently open record. Click a Field, and then click the
Select button to insert the Field as a Token.
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Option Description

Append to Current
Value

The Action appends a Set Value or Template Value to any default value
defined for the Field. To avoid duplication of data, this option is disabled
if the Field selected in the Fields tree is also inserted as a Token in the
Template field.

7. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

8. Click Save.
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Define a Create a New Child Business Object
Action for a One-Step

Use the Create a New Child Business Object Action to create a child Business Object that belongs to the
active Business Object. For example, add a Journal History record to an Incident when the One-Step is
run against the Incident.

This Action is executed against whichever Business Object is active, either a Business Object association
or a Business Object from another Action (Create a New Business Object or Go To a Record) preceding
this Action. For example, if the One-Step is associated with Incident, the Incident Business Object is the
active object (this Action runs against Incident). If a Create a New Business Object Action is added to
create a Problem record (preceding this Action), the Problem Business Object becomes the active object
(the Action runs against Problem).

If the active Business Object changes (example: The Action was initially defined to run against Incident,
but a Create a New Business Object Action makes Problem the active Business Object), a warning
appears. The Action properties might need to be modified to reflect the newly active Business Object.

To define a Create a New Child Business Object Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Create a New Child Business Object Action to the Designer Board.

3. Click the General page.

4. Define general properties for the Create a New Child Business Object Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Child Business Object

Select the child Business Object to create. For the Business Object to be
listed in the drop-down, it must have a Relationship in which it is owned by
the parent object. For more information about Relationships, refer to the
Relationships Documentation. The parent object is the active Business
Object.

Make New Record
Current

Create the Business Object from the active record after the Action is
executed. This allows Users to immediately edit the record. If this check box
is not selected, the record opens in the background and does not appear on
the screen.

Group Member If the selected child object is a Group Object (example: Journals), select the
Group Member to have the Action create (example: Journal - History).

Save Business Object
after Action

Automatically save the Business Object after the Action executes. The
Business Object cannot be saved if required Fields do not have a value, or if
Field validation fails.
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Option Description

Evaluate Expressions
from New Child’s
Perspective

Evaluate Expressions from the child object rather than from the parent object.
This option is rarely used; however, it is necessary if the parent and child are
the same type of object. To do calculations within the child (example: Adding
values in multiple Fields), select this check box to ensure that data is pulled
from the child object rather than the parent object.

5. Click the Fields page.

6. Define options for selected Business Object Fields:
a. Filter the Fields tree:

Option Description

Search Control Quickly locate a Field whose Name and Description contain a specific
word or phrase (example: OwnedBy).

Only Show Set Fields 
Shows only those Fields that have values set. This is useful when
going back to edit the Action to quickly see which Field values are set
by the Action.

Ignore Folders 
Ignores the organizational folders and displays all Fields at the root of
the list.

Show Field Values 

Opens a window that shows the Fields and values from the currently
open record. Click a Field, and then click the Select button (selecting a
Field in the window also selects it in the Fields tree). The Show Field
Values button  is only available if a currently open record is the same
as the Business Object the Action is defined to execute against
(example: An Incident record is currently open, and the Action is
defined to execute against an Incident).

b. Select a Field in the Fields tree, and then select one of the following options:

Option Description

Don't Set Field
(Default)

The Action does not have a set value. However, if the Field has a
default or auto-populated value, that value is used.

Clear Value The Action clears any default or auto-populated value that gets
assigned to the Field when the Business Object is updated.

Set Value

The Action sets a specific value. Provide text, or click the Selector
button to insert a Token (Field, System Function, Prompt, Expression,
Stored Value, Metric, Counter, etc.). The available Fields in the Token
Selector reflect the current Business Object (the Business Object being
updated or created by the Action).

If the Field is validated, the Legal Values button is available to allow
selection of a valid value.
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Option Description

Template

The Action creates a custom defined value. Provide text. Click the
Selector button to insert Tokens (example: Fields, System Functions,
Prompts, Expressions, Stored Values, Metrics, and Counters) directly
into the text. The available Fields in the Token Selector reflect the One-
Step Business Object context (from the One-Step association or from a
preceding Create a Business Object Action or Go To a Record Action).

The option to Show Field Values is available in the Tokens menu if a
currently open record is the same as the Business Object the Action is
defined to execute against (example: An Incident record is currently
open, and the Action is defined to execute against an Incident). Select
this option to open a window that shows the Fields and values
contained in the currently open record. Click a Field, and then click the
Select button to insert the Field as a Token.

Append to Current
Value

The Action appends a Set Value or Template Value to any default value
defined for the Field. To avoid duplication of data, this option is disabled
if the Field selected in the Fields tree is also inserted as a Token in the
Template field.

◦ Append to Current Value: Select this check box to have the Action append a Set Value or
Template Value to any default value defined for the Field. To avoid duplication of data, this
option is disabled if the Field selected in the Fields tree is also inserted as a Token in the
Template field.

7. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

8. Click Save.
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Define a Delete a Business Object Action for a
One-Step

Use the Delete a Business Object Action to delete Business Objects, either the active Business Object or
a related Business Object. For example, administrators can use this Action to perform a record cleanup of
Journals, Tasks, etc.

This Action is executed against whichever Business Object is active, either a Business Object association
or a Business Object from another Action (Create a New Business Object or Go To a Record) preceding
this Action. For example, if the One-Step is associated with Incident, the Incident Business Object is the
active object (this Action runs against Incident). If a Create a New Business Object Action is added to
create a Problem record (preceding this Action), the Problem Business Object becomes the active object
(the Action runs against Problem).

Note: If the active Business Object changes (example: The Action was initially defined to run
against Incident, but a Create a New Business Object Action makes Problem the active Business
Object), a warning appears. The Action properties might need to be modified to reflect the newly
active Business Object.

To define a Delete a Business Object Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Delete a Business Object Action to the Designer Board.

3. Define general properties for the Delete a Business Object Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Delete current record The Action deletes the active Business Object record (or current group of
records, if the One-Step is running against a group).

Delete related record
The Action deletes related Business Object record(s). Then, select a
Relationship in the drop-down. The records that are owned by or linked to
the active Business Object are deleted by the Action.

Prompt before deleting
(In application only)

The Action prompts Users before deleting the Business Object. This gives
Users the option to continue with or cancel the Delete a Business Object
Action.

4. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.
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Option Description

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

5. Click Save.
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Define a Go to a Record Action for a One-Step
Use the Go to a Record Action to navigate to a specific Business Object record. For example, click a link
on an Incident record to go to a Major Incident it is linked to. Navigate to a record based on type and
record ID, or based on a Relationship.

To define a Go to a Record Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Go to a Record Action to the Designer Board.

3. Define general properties for the Go to a Record Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Go to an arbitrary record
Select this radio button to go to a record based on a Business Object and
record ID (the record does not have to be in a Relationship with the active
Business Object).

Business Object
In the drop-down, select the Business Object record to go to. The drop-
down displays only Major Business Objects. To display all Business
Objects, select the Show All check box.

Group member
If the selected Business Object is a Group Object, click the Selector button
to open the Token menu, and then select a Token that holds the name or
record ID of the Group Member.

Record ID

Click the Selector button to open the Token menu and select a Token that
holds the ID of the record to go to. For example, if you select the
Incident.CustomerID field, and it has a value of 123, the Go to a Record
Action searches for a Customer whose record ID is 123.

Go to current record in a
relationship Go to a record based on a Relationship (navigate to a related record).

Relationship Select a Relationship. The drop-down lists all existing Relationships for the
active Business Object.

Make New Record Current

Create the Business Object from the active record after the Action is
executed. This allows Users to immediately edit the record. If this check box
is not selected, the record opens in the background and does not appear on
the screen.

4. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.
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5. Click Save.
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Define a Link/Unlink Business Object Action for a
One-Step

Use the Link/Unlink Business Object Action to link or unlink a Business Object in a Relationship. The Link/
Unlink Business Object Action adds records to or removes them from a Relationship, which adds/removes
them from tabs in Form Arrangements. For example, link critical Configuration Items to the active Incident.

Link Relationships are the only type of Relationships to which Business Objects can be linked/unlinked
using this Action. Records can only be linked to/unlinked from an existing Relationship. If a Relationship
does not already exist, create one. If a Relationship is not already displayed as a tab in a Form
Arrangement, linking/unlinking records in the Relationship does not add or remove tabs in the Form
Arrangement; it only adds or removes records in existing tabs.

To define a Link/Unlink Business Object Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Link/Unlink Business Object Action to the Designer Board.

3. Define general properties for the Link/Unlink Business Object Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Link Add records to the selected Relationship.

Unlink Remove records from the selected Relationship.

Business Object Select the Business Object to link/unlink.

Link to Relationship Select the Relationship to which the Business Object records are linked/
unlinked.

4. Define which records to link/unlink:

To link records:

Option Description

Records Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Ellipses 

Opens the Search Group Manager; select an existing Search Group
(saved Search Query) or create a Search Group. Saved Searches can be
used over and over in numerous places.

Custom Query 
Opens the Custom Query Builder; create a custom Search Query to use
only for this scenario.
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Option Description

Join Reason

Provide a join reason, or click the Selector button to open the Token
menu and insert a Token to use as the join reason. A join reason allows
you to provide brief information about why records are being linked. A join
reason can be provided only if the selected Relationship uses a join table
and has join reasons enabled. If join reasons are used for the Relationship,
and no join reason is provided for this Action, the join reason defined for
the Relationship is used. For more information, refer to Define Links
Properties for a Relationship

Legal Values 

Enabled if there is a list of valid values to use for the join reason. These are
based on the list of values defined for the selected Relationship's join
reason. For more information, refer to Define Links Properties for a
Relationship

To unlink records:

Option Description

Condition Unlink records based on an Expression, and then select an Expression.

Most recently used Select a most recently used (MRU) Expression.

Custom Expression Click the Custom Expression button to open the Custom Expression
Builder, and then create a custom Expression specifically for this scenario.

5. Define link/unlink options:

Option Description

Link/Unlink all found
records

Link/unlink all records found based on the defined search criteria or
condition.

Link/Unlink specific
number of records

Link/unlink a specified number of records, and then provide a number, or
use the up/down arrows to increase/decrease the number. The first x
number of records are linked (up to the defined number of records).

This option is only available if the Relationship is 1-to-many (multiple
records can be linked/unlinked).
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Option Description

Order By (Unlink only)

Select a Field from the related Business Object to use to control the order
in which records are unlinked.

Ascending: Unlink records in ascending order (example: 0-10, A-Z) based
on the selected Field. The alphabetical order rarely matches the order in
which the records should be unlinked, unless you prefix the values with
numbers or letters (example: For status, you would likely want lifecycle
order, not alphabetical order); therefore, it is common to define a Field that
contains a sequence number purely for controlling the order (example:
Status Order).

Selecting (Default) unlinks records in ascending order based on the default
sorting column in the related Business Object's default Grid.

Save Business Object
after Action Automatically save the Business Object after the Action executes.

6. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

7. Click Save.
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Define a Step Through Children Action for a One-
Step

Use the Step Through Children Action to run a sequence of Actions against each child record of a
Business Object. For example, send an e-mail to each Customer that is associated with an Incident to
notify them when an Incident is resolved. To limit the records that the Actions run against, define a
condition (example: Only run Actions against Customer records where the e-mail address is not empty).

If the active Business Object changes (example: The Action was initially defined to run against Incident,
but a Create a New Business Object Action makes Problem the active Business Object), a warning
appears. The Action properties might need to be modified to reflect the newly active Business Object.

To define a Step Through Children Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Step Through Children Action to the Designer Board.

3. Define general properties for the Step Through Children Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Child Business Object

In the drop-down, select the Child Business Object to run Actions against.

Note: For the Business Object to be listed in the drop-down, it must
have a Relationship with the parent object (the active Business
Object).

Order

To run Actions against the child records in a specific order, select a Field in
the drop-down by which the records should be sorted. The drop-down lists the
Fields from the child Business Object selected in the previous step.

Ascending: Select this check box to run through the child records in ascending
order (example: 0-10, A-Z) based on the selected Field. Rarely will the
alphabetical order match the desired order, unless you prefix the values with
numbers or letters (example: For status, you would likely want lifecycle order,
not alphabetical order); therefore, it is common to define a Field that contains
a sequence number purely for controlling the order (example: Status Order).

Reload data in
Relationship

Select this check box to reload Relationship data before the Step Through
Children Action is executed against the child records.

Reloading might be necessary if the Relationship is changed behind the
scenes (example: Through a reverse Relationship). If this check box is
selected, the Relationship is refreshed from the database so that the Action
updates the latest version of the Relationship. In addition, no child Actions are
required if this check box is selected.
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Option Description

Only run against record
where Expression is true

Limit the records that Actions run against, and then define an Expression for
the condition.

Stored Expression
Click the Ellipses button to open the Expression Manager, and then select an
existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

Custom Expression Click the Custom Expression button to open the Custom Expression Builder,
and then create a custom Expression specifically for this scenario.

Record to select after run Define which record to select after all Step Through Children Actions are
completed (Record to Select after Run section).

Original The record that was active prior to execution of the Step Through Children
Action becomes the active record.

First found The first record found by the Step Through Children Action becomes the active
record.

Last found The last record found by the Step Through Children Action become the active
record.

4. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

5. Click Save.

Define Actions to Run Against Child Records

1. Double-click the Step Through Children Graphic. You can also right-click the Action graphic and

select Define Actions for Child Records, or click the Child Record Actions button  on the
One-Step Editor toolbar. A Designer Board opens for the Step Through Children Action.

2. Add Actions to the Designer Board.

3. Define properties for each Action. Changing the child Business Object (in the Child drop-down) after
defining Actions clears the Actions and any conditions associated with them.

4. Click Save to save changes and return to the main Designer Board.

(Optional) Define Conditions that Limit When an Action is Executed

1. Right-click an Action on the Designer Board, and then click Action Condition in the context menu.
You can also click the Expression button on the One-Step Editor toolbar to add conditions to a
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selected Action. To edit the Action condition, double-click the Expression icon, right-click the
Action on the Designer Board and select Action Condition, or click the Expression button on the
toolbar.

2. Select Only Run Action [name of Action] if Condition is True check box to define an Expression
that controls when the Action is executed.

3. Define an Expression for the condition, either:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored Expressions
can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button to open the Custom Expression
Builder, and then create a custom Expression specifically for this scenario.

4. Click OK.4. 

5. Click Save to return to the Designer Board for the main One-Step.
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Define a Transfer Attachments Action for a One-
Step

Use the Transfer Attachments Action to transfer Attachments to a file system or Business Object from
another file system or Business Object. For example, import files from a folder on your computer into
CSM and attach them to an Incident record. You can define rules for including or excluding Attachments
(using masks, file size, etc.).

• This Action allows you to select which Business Object to execute against, if more than one is
available within the One-Step. Options can include one or more of the following, depending on
which Business Objects are available:

◦ Original Business Object from the Association (selected when the One-Step is created).

◦ Business Object from a Create a New Business Object Action preceding this Action.

◦ Business Object from a Go To a Record Action preceding this Action.

• Attachments transferred from a Business Object can be:
◦ Saved to a directory: Attachments are saved as files in a specified directory (they also remain

in the original Business Object).

◦ Moved to another Business Object: Attachments are transferred to another Business Object
(they are no longer in the original Business Object).

◦ Copied to another Business Object: Attachments are duplicated and attached to another
Business Object (they also remain in the original Business Object).

◦ Deleted from the Business Object: Attachments are permanently removed from the Business
Object.

• Files transferred from a directory can be:
◦ Imported: Files are imported into CSM from a specified directory and attached to a selected

Business Object. Imported files become part of the CSM database (increasing its size) and are
not linked to the directory; therefore, they must be re-imported each time the files are changed.

◦ Linked: Files are linked to CSM from a specified directory and attached to a selected Business
Object. Files are located in and accessed from the directory, and Users must have access to
that directory in order to view the files.

◦ Deleted: Files are deleted from the specified directory.

• The ability to transfer Attachments using a One-Step depends on File Attachment rights.

• For more information about Business Object Attachments, refer to the Attachments Documentation.

Define a Transfer Attachments Action for a One-Step

1. Open the One-Step Editor.

2. Add a Transfer Attachments Action to the Designer Board.

3. Click the General page.

4. Define general properties for the Transfer Attachments Action:
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Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

From Attachment Source (the location from which Attachments are transferred)

From Business Object

Select this radio button to transfer Attachments from a Business Object. In
the drop-down, select a Business Object.
Save Business Object after Action: Select this check box to automatically
save the Business Object after the Action executes.

From Directory

Select this radio button to transfer Attachments from a folder in a system
directory and specify a directory. Browse to a folder location on the
computer or use the selector to open the Token menu and insert Tokens
that contain the name of the directory.

5. These options are for the transfer action for the Attachments:

Option Description

Business Object

Save: Save Attachments from the selected Business Object to a directory
and specify a To Directory. Browse to a folder location on the computer or
use the selector to open the Token menu and insert Tokens that contain
the name of the directory.

Move: Move Attachments from the selected From Business Object to
another Business Object. Then, in the drop-down, select a To Business
Object.

Copy: Copy Attachments from the selected From Business Object to
another Business Object. Then, in the drop-down, select a To Business
Object. Save Business Object after Action: Select this check box to
automatically save the Business Object after the Action executes.

Delete: Delete Attachments from the selected From Business Object.

Directory Import: Import files from the defined From Directory into the CSM system
and attach them to a Business Object. Then, select a To Business Object.

Link: Link files from the defined From Directory directly to the CSM system
and attach them to a Business Object. Then, select a To Business Object.
To view linked files, Users must have access to the network where the files
are located.

Delete: Delete files from the selected directory.

6. Action to perform if saving Attachments results in conflicts:

Option Description

Overwrite Overwrite existing Attachments/files in the Business Object/directory with
the transferred Attachments/files if they have the same name.

Skip Skip transferring Attachments/files if they have the same name as the
existing Attachments/files in the Business Object/directory.
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Option Description

Save with a new name
(will append number)

Import, link, save, move, or copy Attachments/files but to give them a new
filename if they have the same name as the existing Attachment/files in the
Business Object/directory.

Prompt before
overwriting

Prompt the User before any Attachments/files are overwritten (works in the
Desktop Client only).

7. Click the Attachments/Files page. If a Business Object is the Attachment source, the Attachments
page is shown. If a File System is the Attachment source, the Files page is shown.

8. Define which Attachments/files to include in the transfer action selected on the General page. For
more information, see Action Attachments. File Attachment rights control the Attachment operations
that can be performed in CSM.

9. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

10. Click Save.
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Define a Transfer Related Business Objects Action
for a One-Step

Use the Transfer Related Business Objects Action to transfer related records from one Business Object to
another. For example, copy the Journals from an Incident to an associated Problem.

If records are transferred to the same type of Relationship, they can be copied or moved (example: Copy
or move Journals from an Incident (Incident Owns Journals) to a Change Request (Change Request
Owns Journals)):

• Copied: Child records are duplicated and added to the target Relationship (they also remain in the
original Relationship).

• Moved: Child records are transferred to the target Relationship (they are no longer in the original
Relationship).

If records are transferred to a different type of Relationship, new records are created in the target
Relationship (example: Create Journals in a Change Request (Change Request Owns Journals) from
Tasks in an Incident (Incident Owns Tasks)).

For more information about Relationships, refer to the Relationships Documentation.

To define a Transfer Attachments Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Transfer Related Business Objects Action to the Designer Board.

3. Click the Transfer From page.

4. Define general properties for the Transfer Related Business Objects Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

From Business Object Select the Business Object from which records will be transferred.

Relationship Select the Relationship from which records will be transferred.

Condition Use an Expression to limit the records that are transferred, and then define
an Expression.

MRU Expression Select a Most Recently Used (MRU) Expression.

Custom Expression Click the Custom Expression button to open the Custom Expression
Builder, and then create a custom Expression specifically for this scenario.
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Option Description

Order By

Select a Field from the related Business Object to control the order in which
records are transferred to the target Relationship.

Ascending: Select this check box to transfer records in ascending order
(example: 0-10, A-Z). Alphabetical order rarely matches the order in which
the records should be transferred, unless you prefix the values with numbers
or letters (example: For status, you would likely want lifecycle order, not
alphabetical order); therefore, it is common to define a Field that contains a
sequence number purely for controlling the order (example: Status Order).

Selecting (Default) transfers records in ascending order based on the default
sorting column in the related Business Object's default Grid.

Save Business Object
after Action Automatically saves the Business Object after the Action executes.

5. Click the Transfer To page.

6. Define properties for transferring records to a Business Object:

Option Description

To Business Object Select the Business Object to which records will be transferred.

Relationship Select the Relationship to which records will be transferred.

Group Member Select a Group Member (only applicable if the selected Relationship
contains a Group Object).

Transfer Related Business Objects

Copy Copy related records to the selected Business Object and Relationship.

Move Move related records to the selected Business Object and Relationship.

For each [Transfer From
Relationship] object
create a [Transfer To
Object] on [Transfer To
Relationship]

Creates a new record in the target Relationship for each of the records
being transferred.

Save Business Object
after Action Automatically save the Business Object after the Action executes.

7. Click the Create Object page to decide what to do with Fields in the new objects being created.

Note: This page is only available if objects are being transferred between two different types
of Relationships. The Fields tree is populated with Fields from the Business Object in the
selected To Relationship. Use Fields from the Business Object in the From Relationship as
Tokens to set values in the To Business Object.

8. Define options for selected Business Object Fields:
a. Filter the Fields tree:
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Option Description

Search Control Quickly locate a Field whose Name and Description contain a specific
word or phrase (example: OwnedBy).

Only Show Set Fields 
Shows only those Fields that have values set. This is useful when
going back to edit the Action to quickly see which Field values are set
by the Action.

Ignore Folders 
Ignores the organizational folders and displays all Fields at the root of
the list.

Show Field Values 

Opens a window that shows the Fields and values from the currently
open record. Click a Field, and then click the Select button (selecting a
Field in the window also selects it in the Fields tree). The Show Field
Values button  is only available if a currently open record is the same
as the Business Object the Action is defined to execute against
(example: An Incident record is currently open, and the Action is
defined to execute against an Incident).

b. Select a Field in the Fields tree, and then select one of the following options:

Option Description

Don't Set Field
(Default)

The Action does not have a set value. However, if the Field has a
default or auto-populated value, that value is used.

Clear Value The Action clears any default or auto-populated value that gets
assigned to the Field when the Business Object is updated.

Set Value

The Action sets a specific value. Provide text, or click the Selector
button to insert a Token (Field, System Function, Prompt, Expression,
Stored Value, Metric, Counter, etc.). The available Fields in the Token
Selector reflect the current Business Object (the Business Object being
updated or created by the Action).

If the Field is validated, the Legal Values button is available to allow
selection of a valid value.

Template

The Action creates a custom defined value. Provide text. Click the
Selector button to insert Tokens (example: Fields, System Functions,
Prompts, Expressions, Stored Values, Metrics, and Counters) directly
into the text. The available Fields in the Token Selector reflect the One-
Step Business Object context (from the One-Step association or from a
preceding Create a Business Object Action or Go To a Record Action).

The option to Show Field Values is available in the Tokens menu if a
currently open record is the same as the Business Object the Action is
defined to execute against (example: An Incident record is currently
open, and the Action is defined to execute against an Incident). Select
this option to open a window that shows the Fields and values
contained in the currently open record. Click a Field, and then click the
Select button to insert the Field as a Token.
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Option Description

Append to Current
Value

The Action appends a Set Value or Template Value to any default value
defined for the Field. To avoid duplication of data, this option is disabled
if the Field selected in the Fields tree is also inserted as a Token in the
Template field.

◦ Append to Current Value: Select this check box to have the Action append a Set Value or
Template Value to any default value defined for the Field. To avoid duplication of data, this
option is disabled if the Field selected in the Fields tree is also inserted as a Token in the
Template field.

9. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

10. Click Save.
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Define an Update a Business Object Action for a
One-Step

Use the Update a Business Object Action to update Field values in the active Business Object. For
example, click a link on an Incident to update its status to a set value (example: Resolved). This Action is
executed against whichever Business Object is active, either a Business Object association or a Business
Object from another Action (Create a New Business Object or Go To a Record) preceding this Action. For
example, if the One-Step is associated with Incident, the Incident Business Object is the active object (this
Action runs against Incident). If a Create a New Business Object Action is added to create a Problem
record (preceding this Action), the Problem Business Object becomes the active object (the Action runs
against Problem). If the active Business Object changes (example: The Action was initially defined to run
against Incident, but a Create a New Business Object Action makes Problem the active Business Object),
a warning appears. The Action properties might need to be modified to reflect the newly active Business
Object.

To define an Update a Business Object Action for a One-Step:

1. Open the One-Step Editor.

2. Add an Update a Business Object Action to the Designer Board.

3. Click the General page.

4. Define general properties for the Update a Business Object Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Business Object Shows the Business Object that the Action will update.

Reload Business Object
Before Update

Reloads the active Business Object before the Action updates it. Reloading
might be necessary if the Business Object is changed behind the scenes. If
this check box is selected, the Business Object is refreshed from the
database so that the Action updates the latest version of the Business
Object. This is sometimes required when doing things like creating objects
(in other Actions) that are not seen by the main object. For example, you
might step through related objects and create a Journal for each associated
Configuration Item. Because those Journals were not created through the
Relationship between the main object and the Journals, they would not be
considered part of the record until the Business Object is reloaded.

Save Business Object
after Action

Automatically saves the Business Object after the Action executes. The
Business Object cannot be saved if required Fields do not have a value, or if
Field validation fails.

5. Click the Fields page.

6. Define options for selected Business Object Fields:

7. Filter the Fields tree:
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Option Description

Search Control Quickly locate a Field whose Name and Description contain a specific
word or phrase (example: OwnedBy).

Only Show Set Fields 
Shows only those Fields that have values set. This is useful when going
back to edit the Action to quickly see which Field values are set by the
Action.

Ignore Folders 
Ignores the organizational folders and displays all Fields at the root of the
list.

Show Field Values 

Opens a window that shows the Fields and values from the currently open
record. Click a Field, and then click the Select button (selecting a Field in
the window also selects it in the Fields tree). The Show Field Values button

 is only available if a currently open record is the same as the Business
Object the Action is defined to execute against (example: An Incident
record is currently open, and the Action is defined to execute against an
Incident).

8. Select a Field in the Fields tree, and then select one of the following options:

Option Description

Don't Set Field (Default) The Action does not have a set value. However, if the Field has a default
or auto-populated value, that value is used.

Clear Value The Action clears any default or auto-populated value that gets assigned
to the Field when the Business Object is updated.

Set Value

The Action sets a specific value. Provide text, or click the Selector button
to insert a Token (Field, System Function, Prompt, Expression, Stored
Value, Metric, Counter, etc.). The available Fields in the Token Selector
reflect the current Business Object (the Business Object being updated or
created by the Action).

If the Field is validated, the Legal Values button is available to allow
selection of a valid value.

Template

The Action creates a custom defined value. Provide text. Click the
Selector button to insert Tokens (example: Fields, System Functions,
Prompts, Expressions, Stored Values, Metrics, and Counters) directly into
the text. The available Fields in the Token Selector reflect the One-Step
Business Object context (from the One-Step association or from a
preceding Create a Business Object Action or Go To a Record Action).

The option to Show Field Values is available in the Tokens menu if a
currently open record is the same as the Business Object the Action is
defined to execute against (example: An Incident record is currently open,
and the Action is defined to execute against an Incident). Select this option
to open a window that shows the Fields and values contained in the
currently open record. Click a Field, and then click the Select button to
insert the Field as a Token.
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Option Description

Append to Current Value

The Action appends a Set Value or Template Value to any default value
defined for the Field. To avoid duplication of data, this option is disabled if
the Field selected in the Fields tree is also inserted as a Token in the
Template field.

9. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

10. Click Save.
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Define a Work with a Queue Action for a One-Step
Use the Work with a Queue Action to perform Queue operations. For example, create a Problem from an
existing Incident (Create a New Business Object Action), and then add the newly created Problem to the
Problem Management Queue.

To define a Work with a Queue Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Work with a Queue Action to the Designer Board.

3. Define general properties for the Work with a Queue Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Operation

◦ Add: Adds the active record to a Queue.

◦ Remove: Removes the active record from a specific Queue or from all
Queues where it exists.

◦ Check Out: Check out the active record from a Queue.

◦ Check In: Check the active record into a Queue.

◦ Suspend: Suspends the active record from a Queue so it cannot be
checked out.

◦ Unsuspend: Unsuspends the active record from a Queue so it is
available for checkout.

Queue

Operations are performed against a specific Queue. Select a most recently

used (MRU) Queue in the drop-down, or click the Ellipses button  to
open the Queue Manager and select a Queue or create a new Queue.

Based on Scope and
Value

The Action makes a selection based on a specified scope and Token Value.
Select the scope in the drop-down. Click the Selector button to open the
Token menu and select a Token that holds the appropriate name or ID.

All Queues (Remove
only) Remove the active record from all Queues to which it belongs.

History Comments

Comments that are attached to the active record's history. Provide text. Click
the Selector button to insert Tokens (example: Fields, System Functions,
Prompts, Expressions, Stored Values, Metrics, and Counters) directly into the
text.

4. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.
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Option Description

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

5. Click Save.
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Define a Call a Web Service Action for a One-Step
Use the Call a Web Service One-Step Action to dynamically call a web service and save the results as a
variable. For example, call a web service that calculates currency, then use the results in a Field. The
results can be saved as a variable in one of the following data types: number, string, or Boolean.

Note: Currently, CSM supports REST and WSDL-based web services using either no
authentication or Basic authentication.

To define a Call a Web Service Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Call a Web Service Action to the Designer Board.

3. Click the General page.

4. Define general properties for the Call a Web Service Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Service
Select the web service to call by clicking the Ellipses button. The Web
Service Manager opens, where you can select an existing web service or
set up a web service.

Account

Select the Web Service Account to use to provide the User ID and
password required to call the web service. This is only enabled if the web
service requires authentication (Basic Security is selected for the web
service) and Accounts were defined for the web service.

5. (Optional) Define how results are stored:

Note: This is not required; however, in most cases, you want to store the result so that you
can do something with it (example: Pop-up results, edit a Business Object, etc.). There are
some cases where you might not save the result (example: Where posting data to the web
service might not return anything; for example, Send a Tweet).

Option Description

Store Results Select this check box to store the result of the web service call. The result
is then available as a variable in the system using the specified name.

Store Return Code

Select this check box to store the error code if the web service call returns
an error (example: Error code 403 indicates that you do not have sufficient
rights, or 408 indicates that the server timed out). It is then available as a
variable in the system using the specified name.
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Option Description

Don't Stop One-Step on
Error

Select this check box to have the One-Step continue executing even if the
web service call returns an error. This allows for the creation of future steps
that show details about the error, or try to handle the error in another way.

Note: This option is only available if the Store Return Code As
check box is selected.

6. Click the Method page.

7. Specify the Method to call on the web service:

Option Description

Method
Select Web Service Method. The Parameters tree on the left shows all
the parameters for the selected Web Service Method. Define a value for
each parameter.

Blank
Select this radio button to not set a value for the parameter. This might or
might not be valid for different web services. If a required parameter is not
provided, the web service will likely generate an error.

Set Value

Select this radio button to manually set the Method value. Provide text.
Click the Selector button to insert Tokens (example: Fields, System
Functions, Prompts, Expressions, Stored Values, Metrics, and Counters)
directly into the text.

8. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

9. Click Save.

CSM 9.3.0 Features 999

CSM 9.3.0 Features



Web Service Good to Know
• A web service has one or more Methods.

• A Method is a call where an action is specified to take place. Pass in zero or more parameters and
optionally get a result back from the Method (example: A calculator web service might have several
Methods: multiply, divide, add, subtract, etc.).

• A parameter is a value that is sent to a Method (example: A login Method might require one
parameter for the username and one parameter for the password).

• Before calling a web service from a One-Step, set up the web service using the Web Service
Manager, which can be accessed either from One-Step (Browser and Mobile>Web Service
Manager), or directly from the Call a Web Service Action in a One-Step.

• Web Service: A web service is a web Application Programming Interface (API) that is accessed via
HTTP/HTTPS.

• WSDL: WSDL (Web Service Description Language) is an XML-based language for describing Web
Services and how to access them. Network services are described as a set of endpoints operating
on messages. WSDL Methods are generated by parsing the WSDL and should not be modified.

• REST: REST (Representational State Transfer) is an approach used to allow simple point-to-point
communication over HTTP.

• Security rights: Using and configuring web services requires security rights.
◦ If you cannot run, add, edit, or delete the Call a Web Service Action in One-Steps, check your

One-Step functionality security rights (CSM Administrator>Security>Edit Security
Groups>[Security Group]>Rights tab>One-Step).

◦ If you cannot call a web service, or view, add, edit, or delete web services using the Web
Service Manager, check your Web Services security rights (CSM Administrator>Security>Edit
Security Groups>[Security Group]>Rights tab>Web Services category).
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Set Up a Web Service
Before calling a web service from a One-Step Action, first set up a web service. When you set up a web
service, you define the following:

• General properties for the web service: Name, description, URL, Service Type (REST or WSDL),
and Security Type (Basic or None).

• Web Service Method: Define one or more Methods (and parameters) that are available from the
web service.

Note: WSDL Methods can be generated by parsing the WSDL definition, if available, and
generally do not need to be modified.

• Web Service Account: User ID and password required to call the web service (only required when
Basic Security is required).

CAUTION: If you delete a Web Service Account that is used by existing One-Steps, the
One-Steps might no longer work as expected. For best results, edit the existing account
information rather than deleting and re-adding it.

Note: The ability to set up a web service requires security rights.

To set up a web service:

1. Open the Web Service Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button .

The Web Service Options window opens, showing two pages (General and Methods; Accounts
appears later if Basic Security is used).

4. Click the General page.

5. Define general properties for the web service:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

It does not have to match the web service, although it is wise to do so.

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

c. URL:
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Provide the URL for the web service (example: http://test.com/webservice/). Click the Selector
button (or right-click in the URL field) to insert Tokens into the URL (example: System
Functions, Expressions, Stored Values, etc.).

Note: The URL can also be used as a value in Expressions and Stored Values for use
in other areas of the system (example: Use different URLs in Stored Values for
development, test, and production environments).

6. Define the Service Type, either:
◦ REST: Manually define the Methods (and parameters) available from the web service (see

below).

◦ WSDL (SOAP 1.1 or SOAP 1.2): Many WSDL web services expose a WSDL file from which
CSM can automatically generate the Methods and parameters that are available from the web
service. To parse the items, provide the full path to the WSDL file in the WSDL URL field
(example: http://www.test.com/service.asmx?WSDL), and then click the Parse WSDL button
when it is enabled. If the web service does not expose a WSDL file, then the Methods (and
parameters) to call must be manually defined (see below).

7. Define the Security Type:
◦ None.

◦ Basic: If Basic is selected, the Accounts page appears to define the Web Service Account
information.

Note: With Basic authentication, credentials are passed as plain text, so we
recommend that you only use it with SSL (https).

8. Define web service call options:
◦ Always call web service from Cherwell Server: Select this check box to make all calls to this

web service from the Cherwell Application Server (rather than from the client). This is usually
done for security reasons, since the web service might be configured to only allow calls from a
specific client machine.

◦ Log calls to this web service: Select this check box to log web service calls to the Application
Server log residing on the server.

Note: The global system settings might override these options.

9. Click the Methods page.

10. Define a Web Service Method:
a. Click the Add button to add a Method.

b. Define general properties for the Method:
i. Name: Provide a name for the Method.

ii. Description: Provide a description for the Method.

iii. (Optional) Endpoint: Provide the additional URL path for the Method. Some services
have an additional endpoint in the URL to access the Method. For example, if the full
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path to an addition Method is http://test.com/webservice/addNumbers, the base URL of
the service is http://test.com/webservice/ and the endpoint would be addNumbers.

Tip: Many web services have variable endpoints. Use variables in the endpoint
URL by enclosing them in braces { } (example: http://test.com/webservice/
{variable}). Provide the variable endpoint parameter directly in the text box, or
click the Selector button to add an endpoint parameter using the Web Service
Parameter window (see step c below). The parameter is automatically enclosed
in braces if you add it using the Web Service Parameter window.

iv. Result Type: Select the data type to use when saving the results:
◦ None.

◦ Text (Default).

◦ Number.

◦ Boolean.

v. Request Type: Select a verb that determines the way a web service is called.
◦ POST.

◦ GET.

◦ PUT.

◦ DELETE.

◦ PATCH.

◦ HEAD.

Note: For most WSDL web services, the Method should be set to POST.
For most REST web services, the Method should be set to GET. Only
override these defaults if indicated by the web service’s documentation.

c. Add the Parameters:

Note: Most Methods require one or more parameters to be passed to the Web Service
Method. For example, addNumbers would likely require passing two numbers that
would be added together.

i. Click the Add button.

ii. Name: Provide a name for the parameter.

iii. Data Type: Select the data type for the parameter (Date/Time, Logical, Number, or Text).

Note: With the WDSL (SOAP 1.1 or SOAP 1.2) Service Type, you can pass a
text parameter that contains XML representing the full SOAP message. The full
SOAP message is included in the web service log if the logging level is set to
Debug (refer to Configure Logging for a CSM Server or Web Application for more
information).

iv. Parameter Type: Select the type of parameter to pass to the Web Service Method:
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◦ Standard: Select this option to use the parameter as a regular element in the body
content (the parameter value is passed as an argument).

◦ Header: Select this option to send the parameter in the header of the call (the
parameter value is added to the message header rather than the body content).

◦ Endpoint: Select this option to use the parameter in the endpoint URL (the
parameter is not passed directly, but is used as a variable in the endpoint URL).

v. Is SOAP Content: Select this check box if the parameter contains an XML value that
includes all of the values (the entire SOAP content) that would otherwise be specified in
individual parameters.

Note: This check box is only shown if WSDL (SOAP 1.1 or SOAP 1.2) is the
selected Web Service Method.

vi. Click OK.vi. 

11. Click the Accounts page.

Note: The page is only shown if Basic is selected as the web service Security Type.

12. Define one or more Web Service Accounts:

Note: The Web Service Account is used when a web service simply requires a User ID and
password to be passed with the web service call. You can define multiple accounts
(example: A basic account and an administrative account) and select the appropriate
account when you define a Call a Web Service Action for a One-Step.

a. Click the Add button.

b. Name: Provide a name for the Web Service Account.

c. Description: Provide a description for the Web Service Account.

d. User ID: Provide the username for the Web Service Account.

e. Password: Provide and confirm the password for the Web Service Account.

f. Click OK.f. 

13. Click OK.13. 
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Open the Web Service Manager
There are several ways to open the Web Service Manager:

• From the CSM Administrator Main window, click the Browser and Mobile category, and then click
the Web Service Manager task.

• From within a One-Step (Create a One-Step>Add a Call a Web Service One-Step Action), click the
Ellipses button.
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Define a Decide Between Multiple Cases Action for
a One-Step

Use the Decide Between Multiple Cases Action to define multiple cases (or paths) that the One-Step
executes next based on defined conditions. With this Action, Users can build branching logic into One-
Steps to create advanced workflows to manage and automate processes. The Decide Between Multiple
Cases Action allows Users to:

• Add an unlimited number of Actions to each path, including other Decide Between Multiple Cases
Actions.

• Use Go To Actions on or before paths to jump into or out of other paths, or anywhere else within the
One-Step. For example, use a Go To Action to conditionally run the Actions in another path after the
current path completes execution.

When a decision Action executes, the cases are evaluated in the order defined in the step details for the
Action. The case with the first true condition is executed, including all of the Actions on its path. The
Decide Between Multiple Cases Action is completed after all of the Actions on the path with the true
condition have been executed. At that point, overall One-Step execution is also completed unless Go To
Actions are used to jump to other Actions within the One-Step.

When you add a Decide Between Multiple Cases Action to the Designer Board, two cases are
automatically created: a default case and a standard case. The default case (indicated with an arrow on
the Designer Board) is executed if none of the conditions for any of the other cases are true. The default
case cannot have conditions and cannot be deleted. There must always be at least one standard case. If
there is only one, it cannot be deleted.

When defining cases, consider the following:

• All cases with Actions on their paths must have conditions defined.

• A case with no Actions on its path (an empty case) has no effect on execution.

• No part of a case with a false condition will be executed, unless a Go To Action jumps to an Action
within that case.

When you add an Action to a case, a new empty case is automatically created if one does not already
exist. This provides a way to easily begin adding Actions to new cases as needed. If a new case is not
needed, it can be deleted in the step details or by deleting the Decide Between Multiple Cases Action.
Empty cases are not deleted when Actions are removed from a case.

A Decide Between Multiple Cases Action is considered one Action even though it can contain an
unlimited number of other Actions on its path. If a decision Action is deleted, the options Delete Action
and Delete Action and Children behave identically: the Decide Between Multiple Cases Action and all of
the Actions on its path are deleted.

Actions cannot be added after a Decide Between Multiple Cases Action. The end of a path is the end of
the sequence of Actions for the overall One-Step. If another Decide Between Multiple Cases Action is
included on a path, it is still treated as one Action in the series of Actions on the path. Go To Actions can
significantly alter execution behavior by jumping in or out of other paths, or anywhere else within the One-
Step.
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Define a Decide Between Multiple Cases Action for a One-Step

1. Open the One-Step Editor.

2. Add a Decide Between Multiple Cases Action to the Designer Board.

3. Define general properties for the Decide Between Multiple Cases Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Define a list of cases

◦ Add: Add a case to the list.

◦ Remove: Remove a selected case from the list.

◦ Clone: Copy a selected case, including all of the Actions on its path.

◦ Edit Case: Edit the name and condition for a selected case.

◦ Up/Down Arrows: Change the order of the cases.

Define a series of One-Step Actions for each case on the Designer Board
(the same way you define Actions for the overall One-Step).

Unlink Remove records from the selected Relationship.

Business Object Select the Business Object to link/unlink.
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Option Description

Link to Relationship Select the Relationship to which the Business Object records are linked/
unlinked.

4. Define a condition for each case:
a. Select a case from the list in the step details and click Edit Case, or double-click the function

icon  before a case on the Designer Board.

b. Define an Expression.

5. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

6. Click Save.
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Define an Excel Merge Action for a One-Step
Use the Excel Merge Action to create Excel files that contain data from CSM. For example, create a One-
Step for a Dashboard that exports Incident data into an Excel file to create a monthly report of all
Incidents within the last 30 days (including total number of Incidents, how many were closed, the
percentage closed on first call, the average time it took to close Incidents, etc.).

Create and use the Temporary Filename Token to create a temporary file that goes away after a One-Step
is finished executing.

To save the data outputs to an Excel file and open the file automatically after the One-Step runs, add a
Post-Step with a Run a Program Action. Specify excel.exe in the Filename text box, and then provide the
name of the saved file as the command-line argument. If you used a Temporary Filename, insert it as the
filename (right-click to open the Token menu, and then click Filenames>[your filename]).

To define an Excel Merge Action for a One-Step:

1. Create an Excel template.

2. Open the One-Step Editor.

3. Add an Excel Merge Action to the Designer Board.

4. Define general properties for the Excel Merge Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Select the template to
use for the Excel Merge
Action

◦ File: Select this radio button if the template is saved to a location
other than the Attachment Manager. Then provide the name of the
template file (using text and/or Tokens), or click the Ellipses button to
navigate to the file on the computer.

◦ File Manager: Select this radio button if the template file is saved in
the Attachment Manager. Then click the Ellipses button to open the
Attachment Manager and navigate to the file.

Save to File Saves the output to a file. Then provide the filename (using text and/or
Tokens) or click the Ellipses button to navigate to the file on your computer.

Print Prints the file. Select the printer from the drop-down.

Page Setup Select paper size, paper source, orientation, and margin size.

5. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.
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6. Click Save.
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Create an Excel Template
To use the Excel Merge Action, first create an Excel template to define what data is retrieved from CSM.
Data can be retrieved from:

• Business Objects (example: Incident)

• Relationships

• Business Object Fields

• Tokens (Counters, Expressions, or Stored Values)

Good to know:

• For best results, use a template from the Attachment Manager as a starting point (example: Incident
Scorecard).

• Templates must be saved with an .xls or .xlt extension.

• Many functions can be defined for an Excel template. For several examples of useful functions, see
Excel Merge Template Functions.

Creating an Excel Template with a Single Business Object

1. Name the first tab of the template <#Config>. CSM uses this page to retrieve data from a Business
Object, Business Object Relationships, and other settings to properly create the file.
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Note: All items must be in the AA column of the worksheet. Use the Excel Hide feature to
hide columns A through Z.

2. Define the Business Object, Relationships, and settings to use for retrieving data from CSM.
a. In the AA column of the worksheet, specify BusinessObject on a row, and then provide the

name of the Business Object (example: Incident) on the following row.

b. Specify Relationships on another row. Leave the rows underneath Relationships blank for a
single object template.

c. Specify Settings on another row. If the One-Step is run against a group of records, specify
RunForAll in the following row to have the file append all of the records together. If this
keyword is not present, a file is generated for each record.

Note: GetField functions do not work against a group of records. Consider using the
lookup function instead (see Excel Merge Template Functions).

3. Define the contents for the Excel file (on another tab/worksheet of the Excel template). This is done
using functions that pull data from CSM.

Note: Functions must be in the following format: <#FunctionName(parameters)>. When
multiple parameters are passed to these functions, a semicolon is used to separate the
values.

a. Define which Fields to pull data from:
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◦ <#BusinessObject.FieldName>: Provide this function to look for the specified Field in the
parent Business Object (example: Specify <#Incident.Status> to retrieve values from
the Status field in Incident Business Objects).

◦ <#GetField(BusinessObjectName;fieldname)>: Provide this function to look for a Field in
a related Business Object (example: Type <#GetField(Customer;Full Name)> to
retrieve a Customer's name from the Customer Business Object related to an Incident).

◦ <#GetField(RelationshipName;fieldname)>: Provide this function to use the specified
Relationship to find the related Business Object.

Note: It is important to use the Relationship name so the correct Business Object
is used, especially if more than one Relationship exists with the same related
Business Object (example: CustomerHasContacts,
CustomerHasPrimaryContact).

Important: Do not use the GetField function if you run an Excel Merge One-Step
against a group of records and also include data from a related Business Object
(example: You want a list of Tasks and also want to include the parent Incident's
Service category). See the section below to create an Excel template with
multiple Business Objects.

b. (Optional) Define which Tokens to pull data from. This is done using the GetCounter,
GetExpression, and GetStoredValue functions, which have the following options:

◦ Use the name of the Counter, Expression, or Stored Value:
◦ <#GetCounter(name)>

◦ <#GetExpression(name)>

◦ <#GetStoredValue(name)>

◦ Use the scope and then the name of the Counter, Expression, or Stored Value:
◦ <#GetCounter(scope;name)>

◦ <#GetExpression(scope;name)>

◦ <#GetStoredValue(scope;name)>

4. Create a named range. CSM uses the named range to structure the report.

CSM 9.3.0 Features 1013

CSM 9.3.0 Features



a. On the Contents tab, select the series of cells containing the functions. Do not select the
column headers.

b. Click Formulas>Define Name, or right-click>Define Name.

c. Provide the name of the Business Object with two underscores on each side (example: _ _
BusinessObject _ _).

5. Save the file in the Attachment Manager or on the computer.
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Creating an Excel Template with Multiple Business Objects

1. Complete the steps to create an Excel template with a single Business Object.

2. Define additional Business Objects and Relationships to use for retrieving data from CSM.
a. In the AA column of the <#Config> worksheet, underneath BusinessObject provide the name

of each additional Business Object to be used.

b. Use the rows underneath Relationships to provide the Relationships between the Business
Objects.

Note: To include multiple Relationships, provide each one in a separate, consecutive
row. Leave the rows underneath Relationships blank to not include any data from
related Business Objects.

3. On the Contents tab, define additional functions to pull Field data from CSM.

Note: The placement of functions will determine the structure of the report. (example:
defining the Field <#Incident.IncidentID> in cell A1 and <#Task.TaskID> in cell B2 will
generate a report with Incident ID values in column A and associated task ID values in
subsequent rows in column B).
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Important: Do not define Fields for multiple Business Objects on the same row. Each row
should handle Fields for a single Business Object.

4. Re-configure the existing named range to accommodate multiple Business Objects, and create
additional named ranges.

a. Expand the named range for the parent Business Object to include all cells containing Fields.
i. Click Formulas>Name Manager.
ii. Select the existing named range (example: __Incident__) and click Edit.
iii. Select and delete the text in Refers To.

iv. Select all cells containing functions. The named range will automatically populate with
the new selection.

v. Click OK.

b. Create a named range for the child Business Object that includes all cells containing child
object Fields.

The following figure shows an example:

When the Excel Merge One-Step retrieves the data from the specified Fields, the parent object data
is listed first, and the child object data is listed underneath (example: Incident data followed by data
from related Tasks).

5. Save the file in the Attachment Manager or on the computer.
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Excel Merge Template Functions

Function Description Syntax Parameters Example

If

A conditional
statement. When
condition is true, the
IfTrue expression is
evaluated; otherwise,
the IfFalse
expression is.

<#if(Condition; IfTrue;
IfFalse)> NA <if(<#value>=1;One;Not One)> writes “One” if the report variable “Value” is

1, and “Not One” if not.
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Function Description Syntax Parameters Example

List

Returns a string with
all values from a
table one after the
other, separated by a
delimiter. If the table
has only one record,
use
<#List(table.field)> to
get the value of the
only record without
having to define any
__table__ named
range.

<#List(dataset name
and column)>

or

<#List(dataset name;
list separator; agg
expression; filter)>

• Dataset name (and
column): Name of
the dataset in which
the values are
returned as a list.
Note that this
dataset doesn't need
to be inside any
named range, since
all of its records are
used anyway. If "agg
expression" is
present, column
name is not needed,
as the columns to
aggregate are taken
from the expression.
If not present,
include the column in
which to aggregate.

• List separator
(optional): If not
present, defaults to a
single space as the
character that
separates the
elements in the list.
To use a semicolon,
write it in quotes (";")
so it is not
considered a
parameter separator.

• Agg expression
(optional): An
expression that is
applied to every
record in the dataset
(any Excel function
is valid here, and
any combination of
Excel functions can
be used). Null values
are ignored and not
added to the list. If
not present, the
values of the column
specified in "dataset
name and column"
are used.

• Filter (optional): If
present, it should be
an expression that
returns true or false.
Any Excel formula is
valid. Only those
records where the
filter value is true are
used in the
aggregate.

• <#List(Employees.Lastname)> returns a string like "Smith Brown
Perez". Because a separator wasn't specified, a single space is used.
If Employees has only one record, you can use this to avoid defining
an "__employees__" named range.

• <#list(employees.lastname;, )> returns a string like "Smith, Brown,
Perez".

• <#list(employees;"; "; <#employees.firstname> & " " &
<#employees.lastname>)> returns a string like "John Smith; Carl
Brown; Jorge Perez". Note that using ";" as a list separator requires
writing it inside quotes.
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Function Description Syntax Parameters Example

Lookup
Searches for a field
description on
another table.

<#lookup(table name;
search key names;
search key
values ;result field)>

• Table name: Master
table that contains
the value.

• Search key names:
A list of columns
containing the
search key on the
master table. It will
normally be just one
column, but if you
need to search by
more than one, you
can separate column
names with a comma
(“,”).

• Result field: The field
of Table name you
want to display.

If you keep a CustomerId on an Orders table and the Customer data on a
Customers table, you can use the following to output the real customer
name for an order:

<#lookup(Customers;CustomerId;<#Orders.CustomerId>;CustomerName)>

Switch

Compares
SwitchValue against
value1, value2, etc.,
in order. If
SwitchValue is equal
to any of the value_n,
then result_n is
returned. You can
provide a default
value as the last
parameter. If no value
matches
SwitchValue, and you
have a default
parameter, then the
default is returned.
The default is inferred
from the number of
arguments: An odd
number of arguments
(3, 5, 7...) don't have
a default value. If the
number of arguments
is even, then the last
parameter is the
default.

<#switch(SwitchValue;
value1; result1; value2;
result2...[default])>

NA

• <#switch(<#value>;1;One;2;Two)> writes “One” if the report variable
“Value” is 1, "Two" if value is 2, and #N/A! if the value isn't 1 or 2.

• <switch(<#value>;1;One;2;Two;Something else)> writes “One” if the
report variable “Value” is 1, "Two" if value is 2, and "Something else" if
the value isn't 1 or 2.
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Define an Execute a Command Action for a One-
Step

Use the Execute Command Action to:

• Execute a command.

• Run a Report or Search Group.

• Open a Calendar, Dashboard, or Visualization.

For example, launch a Visualization of impacted Configuration Items from an Incident record.

To define an Execute a Command Action for a One-Step:

1. Open the One-Step Editor.

2. Add an Execute a Command Action to the Designer Board.

3. Define general properties for the Execute a Command Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Specific Command
Use a specific command for the Action to execute. Then click the Ellipses
button to open the Action Manager and select a command, Calendar,
Dashboard, Search Group, Visualization, etc.

Command from Field

Use a Field from the active Business Object or related Business Objects
that holds a command for the Action to execute. Click the Selector button
to open the Token menu and select a Field. This option is only available if
the One-Step has a Business Object association.

4. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

5. Click Save.
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Define a Go to a Field Action for a One-Step
Use the Go to Field Action to navigate to a particular Field or tab (in the Form Arrangement) in the active
record.

To define a Go to Field Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Go to a Field Action to the Designer Board.

3. Define general properties for the Go to Field Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Go to a Field
The Action navigates to a specified Field in the associated Business Object.
Select a Field in the drop-down. Select Fields from the main object as well
as from related objects.

Go to a Tab by
Relationship

The Action navigates to a tab in the Form Arrangement based on a specified
Relationship. Select a Relationship in the drop-down.

Example: If you select Incident Links Problem as the Relationship, then the
Go to a Field Action navigates to the tab that shows the Problems linked to
the active Incident.

Go to a Tab by Index

The Action navigates to the specified tab number on the active record
(example: If you specify 1, the Action navigates to the first tab in the Form
Arrangement). Provide a number or use the up/down arrows to increase/
decrease the number.

4. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

5. Click Save.
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Define a Go To Action for a One-Step
Use the Go To Action to define criteria for determining which Action the One-Step should execute next.
With the Go To Action, Users can navigate to any other Action within the One-Step or end the One-Step
execution. For example, use a Go To Action in conjunction with a Prompt to prompt Users for a value,
which then determines which Action is executed next.

The Go To Action can be configured to always jump to a selected Action within the One-Step (or end One-
Step execution), or to jump based on a condition. Unless a Go To Action ends One-Step execution, the
Go To Action navigates to the appropriate Action and executes it, and then the One-Step proceeds with

any subsequent Actions. You can drag the Go To icon  onto other Actions in the One-Step that you
want the Action to navigate to. A number on the Go To icon and the Action indicates where the One-Step
will jump.

Drag-and-drop a Go To Action onto the Designer Board to branch the One-Step. The upper path is the
main One-Step, with the branches created by the Go To Action underneath. The main branch is identified
with a Broken Link icon  to indicate that it is no longer the path the One-Step follows (it follows the
branched path).

To define a Go To Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Go To Action to the Designer Board.

3. Provide a display name for the Action (this is how the Action is identified within the One-Step.

4. Define jump options:

Option Description

(Default) Always Jump

Select this radio button to always go to a selected Action within
the One-Step (or end One-Step execution). The branched path is

indicated with a Green Branch icon .

Jump When Condition is True

Select this radio button to go to a selected Action within the One-
Step (or end One-Step execution) if the defined condition is true.

The branched path is indicated with a Green Branch icon .

Jump When Condition is False

Select this radio button to go to a selected Action within the One-
Step (or end One-Step execution) if the defined condition is false.

The branched path is indicated with a Red Branch icon .

5. Define a condition for the Go To Action, either:
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Option Description

Stored Expression

Click the Ellipses button to open the Expression Manager, and
then select an existing stored Expression or create a new stored
Expression. Stored Expressions can be reused in numerous
places in CSM.

Custom Expression
Click the Custom Expression button to open the Custom
Expression Builder, and then create a custom Expression
specifically for this scenario.

6. Define which Action to execute next. In the Jump To drop-down, select one of the following options:

Option Description

End One-Step Execution Select this option to have the One-Step end execution when it
reaches the Go To Action.

Navigate to Another Action

Select any other Action within the One-Step to execute next.

If the Go To Action is used in a Step Through Children Action, you
can only select from the Actions used within the Step Through
Children Action. You cannot select from Actions used in the main
One-Step or in the Pre/Post-Steps.

7. Click the down arrow to expand advanced options. Define advanced options for limiting the
execution of the Go To Action. These limitations ensure that this Action does not lead to an endless
loop in which it is executed an infinite number of times. If either of the following limits is reached, the
entire One-Step is aborted.

Option Description

Maximum Number of Times This
Action can be Executed

Provide a number or use the up/down arrows to increase/
decrease the maximum number of times this Action is executed
(maximum is 1000).

Maximum Time in Seconds This
Action is Allowed to Execute

Provide a number or use the up/down arrows to increase/
decrease the maximum number of seconds this Action is allowed
to execute (maximum is 30).

8. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

9. Click Save.
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Define a Run another One-Step Action for a One-
Step

Use the Run another One-Step Action to run another One-Step. This is useful for creating One-Steps with
common functionality for use inside of other One-Steps. For example, use a Customer Feedback Survey
One-Step that runs from other One-Steps after they run against the Customer's records.

To define a Run Another One-Step Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Run another One-Step Action to the Designer Board.

3. Define general properties for the Run another One-Step Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

One-Step

Select this radio button to select a specific One-Step, and then select a
most recently used (MRU) One-Step in the drop-down. Or, click the
Ellipses button to open the One-Step Manager, and then select an
existing One-Step or create a new one.

Based on Scope and
Value

Select this radio button to have the Action make a selection based on a
specified scope and Token Value. Then, select the scope in the drop-
down. Click the Selector button to open the Token menu and select a
Token that holds the appropriate name or ID.

Number of times the
One-Step should run

Provide a number or use the up/down arrows to increase/decrease the
number of times the One-Step should run. This is useful for running the
same One-Step multiple times. The maximum limit is 100.

4. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

5. Click Save.
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Define a Step Through Collection Action for a One-
Step

Use the Step Through Collection Action to step through each item or object in a collection or array of XML
or JSON data (example: Data returned from a web service call) and store it as a variable for use in CSM.
This allows Users to extract pieces of information that can be used within CSM (example: Create new
records and set Fields using JSON or XML variables).

To define a Step Through Collection Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Step Through Collection Action to the Designer Board.

3. Define general properties for the Step Through Collection Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Collection to Step
Through

Provide the collection for the Action to step through (a variable that is a
JSON Array or XML Collection, such as the result of a web service call).

Order Select the Step Through in Reverse Order check box to have the action
step through the items in the XML or JSON collection in reverse order.

Item variable name

Provide a name for the variable that stores the value of each item in the
specified collection. This variable can be used in child actions (example:
Display values in a popup, populate Fields in a Business Object, etc.). Use
Modifiers on the variable to extract the appropriate pieces of information
from the XML or JSON data.

4. Define child Actions for the Step Through Collection Action:
a. Double-click the Step Through Collection Graphic.

b. Add child Actions to the Designer Board.

c. Define properties for each Action.

d. Click Save to save changes and return to the main Designer Board.

5. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

6. Click Save to return to the Designer Board for the main One-Step.
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(Optional) Define conditions that limit when an Action is executed

1. Right-click an Action on the Designer Board, and then click Action Condition in the context menu.
You can also click the Expression buttonon the One-Step Editor toolbar to add conditions to a
selected Action. To edit the Action condition, double-click the Expression button, right-click the
Action on the Designer Board and select Action Condition, or click the Expression button on the
toolbar.

2. Select Only Run Action [name of Action] if Condition is True check box to define an Expression
that controls when the Action is executed.

3. Define an Expression for the condition:

Option Description

Stored Expression
Click the Ellipses button to open the Expression Manager, and then select
an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

Custom Expression Click the Custom Expression button to open the Custom Expression
Builder, and then create a custom Expression specifically for this scenario.

4. Click OK.4. 
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Define an Update a Variable or Stored Value Action
for a One-Step

Use the Update a Variable or Stored Value Action to update a variable or Stored Value using a predefined
value, or the value of a User-specific variable. When you create User-specific variables, they are available
in other Actions within the One-Step, including pre/post-steps and Expressions. For example, use a One-
Step to prompt a User for a value (example: Name of a Customer), and then store the selected value as a
User-specific variable (rather than in a temporary Field). The variable can be used throughout the One-
Step to take different Actions depending on which value was selected.

When executing a One-Step containing variables, those variables only retain their values while the One-
Step executes. If the One-Step is executed again, the variables have no values until set by this Action. If
this window is canceled, all User-defined variables are removed and no longer available for use.

To define an Update a Variable or Stored Value Action for a One-Step:

1. Open the One-Step Editor.

2. Add an Update a Variable or Stored Value Action to the Designer Board.

3. Define general properties and the type of value to update for the Update a Variable or Stored Value
Action:

Option Description

Name Provide a display name for the Action (this is how the Action is identified
within the One-Step).

Stored Value

Select this radio button to update a Stored Value. Click the Ellipses button to
open the Stored Value Manager, and then select an existing Stored Value, or
create a new one.

If you select a Stored Value that contains User-specific values (or if you use
this Action to update a Stored Value with a User-specific value), the following
warning appears: This Stored Value has a different value for each User. The
value set here will only apply to the current User.

If the User-specific value is not remembered between sessions, you will see
the following additional warning: Also, this value will be reset to the default
value when the application is restarted.

Clear Use-specific
Values and Restore the
Stored Value to Its
Default Value

Select this check box to remove any values a User has defined specifically for
their own use and restore the Stored Value to its default value.

This option is only available if a Stored Value that contains User-specific
values is selected.

Based on Scope and
Value

Select this radio button to have the Action make a selection based on a
specified scope and Token Value. Then, select the scope in the drop-down.
Click the Selector button to open the Token menu and select a Token that
holds the appropriate name or ID.
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Option Description

Variable Select this radio button to define unique variables.

Variable

Provide a name for the variable. This is the name that is shown in the Token
tree for other Actions within the One-Step.

Tip: When you provide a variable name, the Variable radio button is
automatically selected.

Data Type
Select a Data Type (example: Text, Number, Date/Time, Logical, JSON/JSON
Array, XML/XML Collection). If you use XML or JSON data types, the defined
value (below) must use the appropriate JSON or XML syntax.

New Value

Value that will update a variable or Stored Value. A value cannot be defined if
this Action is used to clear User-specific values and return Stored Values to
their default values.

Provide text. Click the Selector button to insert Tokens (example: Fields,
System Functions, Prompts, Expressions, Stored Values, Metrics, and
Counters) directly into the text.

After Replacing Tokens,
Evaluate the Result as a
Calculation

Select this check box to have the value of the variable or Stored Value treated
as a simple Expression that returns a calculated result rather than a string.

Note: This is a powerful feature with almost endless possibilities. For
best results, follow the guidelines below.

4. Click the Annotation page, and then define the annotation properties:

Option Description

Annotation title (shown
in tooltip) This information is shown as a tooltip when a User hovers over an action.

Annotation Describes the purpose and operation of the One-Step. This is an
informational field only, it does not show in the UI.

5. Click Save.

Variable or Stored Value Treated as an Expression Guidelines

• When you create an Expression, use a Token to refer to the values. Tokens are typically selected
from the Token tree, but you can also type specific values or Tokens if necessary.

• Enclose string Tokens and string values with single quotation marks (example: 'Incident.Status' =
'Closed').

• Any Tokens that contain non-alphanumeric characters, start with a digit, or match any of the
following reserved words require special handling:

◦ And

CSM 9.3.0 Features 1028

CSM 9.3.0 Features



◦ Between

◦ Child

◦ False

◦ In

◦ Is

◦ Like

◦ Not

◦ Null

◦ Or

◦ Parent

◦ True

• If a Token meets any of the above conditions, it must be enclosed in either square brackets or back
quotes. For example, Token# must be written as either:

◦ [Token#]:Total * [Token#]

◦ `Token#`:Total * `Token#`

• If a Token enclosed in square brackets contains any square brackets or backslashes within its
name, then you must insert a backslash before the brackets or backslashes. If a Token is enclosed
in back quotes, then it cannot contain any back quotes within its name. For example, a Token
named Token[]\ would be written as either:

◦ Total * [Token[\]\\]

◦ Total * `Token[]\`

• You can use User-defined values within Expressions and compare them to Token values.
◦ Enclose string values in single quotation marks (example: 'StringToken' = 'John'). If a value

includes a single quotation character within its name, then you must insert another single
quotation mark before the character.

◦ Number Tokens do not need to be enclosed in quotation marks (example: NumberToken <=
50.00). You can use decimals and scientific notation in numeric values.

◦ Enclose date values within pound signs (example: #DateToken# < #01/31/82#).

• You can concatenate Expressions using Boolean AND, OR, and NOT operators.Use parentheses to
group clauses and force precedence (the AND operator has precedence over other operators). For
example: (‘StringTokenLastName’ = 'Smith' OR ‘StringTokenLastName’ = 'Jones') AND
‘StringTokenFirstName’ = 'John'

• The following operators are allowed in comparison Expressions:
◦ <

◦ >

◦ <=

◦ >=

◦ <>

◦ =
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◦ IN

◦ LIKE

• The following arithmetic operators can be used in Expressions:
◦ + (addition)

◦ - (subtraction)

◦ * (multiplication)

◦ / (division)

◦ % (modulus)

• The following functions can be used in Expressions:

Convert

Description Converts an Expression to a specified .NET Framework type

Syntax Convert(expression,type)

Arguments
expression: The Expression to convert

type: The .NET Framework type to which the value will be converted.

Example Convert('StringTokenValue,' 'System.Int32')

Exceptions

◦ Boolean can be converted to and from Byte, SByte, Int16, Int32, Int64,
UInt16, UInt64, String, and itself only.

◦ Char can converted to and from Int32, UInt32, String, and itself only.

◦ DateTime can be converted to and from String and itself only.

◦ TimeSpan can be converted to and from String and itself only.

IIF

Description Retrieves one of two values depending on the result of a logical calculation.

Syntax IIF(expr, truepart, falsepart)

Arguments

expr: The Expression to evaluate.

truepart: The value to return if the Expression is true.

falsepart: The value to return if the Expression is false.

Example IIF(TotalTokenName>1000, 'expensive', 'dear')
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Defining Actions Using XML Collections and JSON
Arrays

One-Steps include options for iterating through XML Collections and JSON Arrays and extracting portions
of repeating data. Refer to these tasks and code samples when defining Actions using variables of type
XML Collection or JSON Array.
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Task XML Example JSON Example Notes

Create a variable that
contains XML or JSON
code. This is the XML or
JSON variable.

<Remarks>

  <Remark>

    <Sequence>1</Sequ

ence>

    <QualifierId>RAIL<

/QualifierId>

    <Text>CHICAGO</Te

xt>

  </Remark>

  <Remark>

    <Sequence>2</Sequ

ence>

    <QualifierId>RAIL<

/QualifierId>

    <Text>CHICAGO</Te

xt>

  </Remark>

  <Remark>

    <Sequence>3</Sequ

ence>

    <QualifierId>DEST<

/QualifierId>

    <Text>CALL 24 HR

S B4.</Text>

  </Remark>

</Remarks>

{ "node": [ 

     { "key1": "Va

lue1"}, 

     { "key2": "Va

lue2"},

     { "key3": "Va

lue3"}

  ]  

}

Usually, this is
accomplished by calling a
Web Service and saving
the result as a variable.
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Task XML Example JSON Example Notes

Create another variable to
hold the XML Collection or
JSON Array. This is the
collection variable. Give the
variable the correct data
type.

XML Collection JSON Array

An XML Collection is a
block of XML code that
contains a common tag. In
this example, the common
tag is the Remark tag.

A JSON Array is a block of
JSON code contained in
square brackets that is the
value of a JSON property.
It typically contains a
comma-delimited list of
elements that are strings,
numbers, objects, arrays,
booleans or null. In this
example, the JSON
property containing the
array is "node" and the
array members are objects
with key-value pairs.
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Task XML Example JSON Example Notes

Set the content of the
collection variable as the
XML or JSON variable. Use
the applicable modifier to
select the XML Collection or
JSON Array element.

XPath = "//Remark"

<XPathSearchResult>

  <Remark>

    <Sequence>1</Sequ

ence>

    <QualifierId>RAIL<

/QualifierId>

    <Text>CHICAGO</Te

xt>

  </Remark>

  <Remark>

    <Sequence>2</Sequ

ence>

    <QualifierId>RAIL<

/QualifierId>

    <Text>CHICAGO</Te

xt>

  </Remark>

  <Remark>

    <Sequence>3</Sequ

ence>

    <QualifierId>DEST<

/QualifierId>

    <Text>CALL 24 HR

S B4.</Text>

  </Remark>

</XPathSearchResult>

Find Array ("node")

[ 

     { "key1": "Va

lue1"}, 

     { "key2": "Va

lue2"},

     { "key3": "Va

lue3"}

] 

In this example, the XPath
modifer selects a collection
of Remark elements in the
XML Collection.

The Find Array ("node")
modifier selects the JSON
Array that is associated
with the property "node."
For more complex JSON
objects, consider using
JSONPath expressions.

Remember: XML
Collections and
JSON Arrays are
0-indexed. If you
add modifiers to
extract specific
items from
collections, use
Index(0) to specify
the first item.
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Task XML Example JSON Example Notes

Add a Step Through
Collection Action to the One-
Step Editor and specify the
variable name, ex: Item.

<Remark><Sequence>1</

Sequence>

<QualifierId>RAIL</Qua

lifierId>

<Text>CHICAGO</Text></

Remark>

{ "key1": "Value1"

}

Refer to Define a Step
Through Collection Action
for a One-Step for more
information.
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Define Pre/Post-Steps for a One-Step
Pre- and post-steps are Actions that run before or after the main Actions in a One-Step are executed.
When running a One-Step against a group of records, pre- and post-steps are only executed once,
whereas the main Actions are run once for each record in the group. The pre- and post-step Actions are
configured the same way as the main Actions in a One-Step.

Actions that require accessing information in Business Object records are not applicable for pre- and post-
steps because they do not have access to Fields in the active record. They are designed to run before or
after a record (or an entire group of records) has been processed, so technically there is not yet (or no
longer) an active record (or group of records) when the steps are executed.

To define Pre/Post-Steps for a One-Step:

1. Open the One-Step Editor.

2. Click the Pre-Steps tab or Post-Steps tab.

3. Add one or more Actions to the Designer Board.

4. Define the properties for each Action.
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5. (Optional) Define conditions that limit when an Action is executed:
a. Right-click an Action on the Designer Board, and then click Action Condition in the context

menu.

Tip: You can also click the Expression button on the One-Step Editor toolbar to add
conditions to a selected Action. To edit the Action condition, double-click the
Expression icon, right-click the Action on the Designer Board and select Action
Condition, or click the Expression button on the toolbar.

b. Select Only Run Action [name of Action] if Condition is True check box to define an
Expression that controls when the Action is executed.

c. Define an Expression for the condition, either:
◦ Stored Expression: Click the Ellipses button to open the Expression Manager, and then

select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

d. Click OK.d. 

6. Click Save.
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Configuring One-Steps
One-Step Security rights are configured in CSM Administrator. See One-Step Security Rights.
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Prompts
A Prompt is a display window that requires Users to provide information before proceeding with a process
or Action (example: Specify the reason for putting an Incident into Pending status).

CSM 9.3.0 Features 1039

CSM 9.3.0 Features



About Prompts
Use a Prompt to provide information, such as:

• Name of an Incident owner.

• Start date and end date to search for Change Requests within a certain date range.

• Comments on a Knowledge Article.

In CSM, Prompts can be used in:

• Queries (in Comparison Clauses to prompt Users to select a value to search).

• One-Steps (in One-Step Actions to prompt Users for more information before proceeding with the
One-Step).

• Expressions (to prompt Users to specify a value as part of an Expression).
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When creating a Prompt (using the Define Prompt window), specify how Prompts are displayed to Users,
the type of information being requested (ex: Number, Date/Time, Text, etc.), and whether Users can select
from a list of values or have the ability to enter their own.

CSM also provides several Out-of-the-Box (OOTB) Prompts. Use these OOTB Prompts as-is or create
new Prompts.
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Prompts Good to Know
• When creating a Prompt, specify how a Prompt looks, the type of information to request, and

whether to limit Users to a list of values when they enter information into a Prompt.

• You can determine how Prompts are displayed to Users. For example, you can:
◦ Have the Prompt display a list of values from a Business Object and field. When the Prompt

appears, Users select a value from the list.

◦ Display the Prompt in a variety of ways, such as with a simple text box or in a separate grid.

◦ Have the Prompt read an XML or JSON collection and display the values in a web service
lookup table grid from an entire row or from selected fields in the collection

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.
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Using Prompts
Users can either view Prompts or enter data into a Prompt.
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View a Prompt
To view a Prompt:

1. Available Prompts (based on security rights): Use the Token Selector.

2. From an Expression, One-Step, or Query that uses a Prompt.

3. When executing an Action (example: Select an SLA User on an Incident form) that has an
associated Prompt.
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Enter Data into a Prompt
Use Prompts to provide additional information when working with records, running searches, and
performing various other operations in CSM.

What a Prompt looks like, the type of information you can enter, and whether you can select from a list of
values or type your own value depend on what was specified when the Prompt was created.

To enter data into a Prompt:

• In a traditional Prompt window:
◦ Click the drop-down arrow to select from a list of values, or click the Ellipses button to open a

Quick Selector window (displays Results Grid). Select a value.

Note: In some Prompts, both the drop-down arrow and the Ellipses button might be
available. However, some Prompts might only have one or the other available.

◦ Provide a value to the Prompt field (if allowed).

In a Grid:

◦ In some cases, a Prompt might directly display Results Grid grouped by Business Object
Fields. Select a value from the list.

In a simple list:

◦ In some cases, a Prompt might directly display a list of values in a simple list of values from a
Business Object field. Select a value from the list.

In a web service lookup table grid:

◦ Select a value from the grid.

In a Number Prompt:

◦ Use the up/down arrows to increase/decrease the number in the Prompt field.

◦ Provide a number in the Prompt field.

In a Date/Time Prompt:

◦ In a Date/Time Prompt, click the Date Selector button to open a calendar and select a date,
and then place your cursor next to the hours or minutes and type a time (in HH:MM format).
Or, place your cursor next to the month, day, or year and type the date (in MM/DD/YYYY
format) and time (in HH:MM format).

◦ In a Date only Prompt, click the Date Selector button to open a calendar and select a date, or
place your cursor over the month, day, or year and type a date (in MM/DD/YYYY).

◦ In a Time only Prompt, place your cursor next the hours, minutes, or AM/PM and then use the
up/down arrows to increase/decrease the time and toggle between AM and PM. Or place your
cursor next to the hours or minutes and type a time.
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In a Logical Prompt:

◦ Click the drop-down arrow and select True or False.
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Managing Prompts
Prompts are managed using the Token Selector.
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Create a Prompt
Prompts can be created anywhere the Token Selector is available (Query Builders, One-Step Actions,
Expressions, etc.). Use the Define Prompt window in either CSM or CSM Administrator to define the
properties for a Prompt.

To create a Prompt:

1. Click the Selector button to expand the Token Selector.

2. Expand Prompts, and then click New Prompt.
3. Define general properties for the prompt.

Property Description

Name
Provide a display name for the Prompt. This name
is displayed in the Token tree under the Prompts
category.

Prompt Provide the informational text that is displayed in
the Prompt window when it pops up.

Prompt Type

Select one of these types:
◦ Text: Requests text information from Users,

who can type a word or phrase into the
Prompt window.

Select the Multiline check box to allow
Users to enter more than one line of text in
the Prompt window.

◦ Number: Requests a numeric value from
Users.

◦ Date/Time: Requests a date and time from
Users. Users can select date values from a
calendar.

◦ Logical: Requests Users to select True or
False from a drop-down menu.

◦ Date: Requests a date from Users. Users
can select values from a calendar.

◦ Time:Requests a time from Users.
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Property Description

Default Values

There are several types of default Prompt values:

◦ Text: Provide a word or phrase to use as the
default value.

◦ Number: Provide a number or use the up/
down arrows to increase or decrease the
default number by whole numbers.

◦ Date/Time: Click the Date Selector button to
access the Calendar and select a default
date. Then, click on the time and type a
default time (highlight the hour and type a
number, and then highlight the seconds and
type a number). You can also type the date
into the field.

◦ Logical: Select True or False as the default
value.

◦ Date: Click the Date Selector button to
access the Calendar and select a default
date. You can also type the date into the
field.

◦ Time: Provide a default time to the field or
use the up/down arrows to increase or
decrease the time (highlight the hour and
type a number or use the up/down arrows,
and then highlight the seconds and type a
number or use the up/down arrows).

4. Optionally, for Text Prompts, You can:
◦ Define the Value List for Prompt

◦ Define Constraints

◦ Define List Display Options

5. Select the Re-prompt on Each Occurrence check box to re-prompt the User each time this Prompt
is encountered.

Note: This option is for One-Steps, especially if a One-Step contains a Go To Action that
returns to an Action that includes a Prompt. If this box is checked, the User is prompted
each time the One-Step executes an Action (or returns to an Action) with the same Prompt.
This option is not available for values listed from a collection.

6. Click OK.6. 

The Prompt shows up in the Token tree under the Prompt category and can be used in other places
where the Token tree is available.
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Define the Value List for a Prompt (Text Prompts Only)
To define a list of values that Users can select in the Prompt:

1. In the Value List: drop-down, define whether to display a list of values that a User can select from in
the Prompt window:

Option Description

None
Select this option to have no list of values displayed
for the User (User must type a word or phrase into
the Prompt)

List Values from a Table and Field Select this option to have a list of values displayed
from a Business Object and field you select.

List Values from a Collection

Select this option to have values displayed from an
XML or JSON collection in a web service lookup
table. Then, select a collection (ex: A result from a
web service call saved as a variable). You can use
all fields from the collection, or select (and order)
specific fields to display. The prompt can return an
entire row of JSON or XML, or a value from a single
field that can be stored for later use. See the web
service lookup example for more information.

Important: The selected collection must be
a JSON or XML data type.

Valid Values for a Field

Select this option to have a list of valid values
displayed from a field in the associated Business
Object (ex: Incident).

Note: This option is only available if the
context of the Prompt (ex: One-Step, Query,
or Expression) is associated with a Business
Object.

2. If you select List Values from a Table and Field, select the Business Object that contains the
fields with the values a User can select from in the Prompt window from the Table drop-down. You
can choose to see Lookup Tables or all tables in the list.

Note: You can only select a table if you choose List Values from a Table and Field from
the Value List drop-down. If you select Valid Values for a Field, the Business Object
associated with the Prompt's context (ex: One-Step, Query, or Expression) is shown. To
change the table, you must change the Business Object association for the One-Step,
Query, or Expression where the Prompt is being used.

3. In the Field drop-down, select the Business Object Field that contains the values the User can
select from in the Prompt.
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4. Select the User Can Only Choose Values from the List check box to prevent any values that are
not in the list from being used in the Prompt. If not selected, Users can type any value into the
Prompt.

5. Select the Return Value from Different Field check box to have the Prompt return values from a
field other than the one selected in the Field drop-down. Then, select the Field in the drop-down.

Note: This option is available only if you select List Values from a Table and Field in the
Value List drop-down, and select User Can Only Choose Values from the List.

Define Constraints (Text Prompts Only)
For Text Prompts (excluding values listed from a collection), you can optionally define a list of constraints
or filters to limit the values in a Prompt.

1. Click Add to add a constraint or filter.

2. Select a Field in the Business Object you are currently working with.

3. Select an operator (ex: Equals).

4. Value: Select a value for the Field. Applicable values include:
◦ Fields

◦ Expressions

◦ Metric Values

◦ Prompts

◦ Stored Values

◦ System Functions

5. Click OK.

6. Add additional constraints as necessary.

Define List Display Options (Text Prompts Only)
For text Prompts in which List Values from a Table and Field is selected in the Value List drop-down,
define how to display the list of values.
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Option Description

Auto

Select this option in the drop-down to have the system
choose the best option for displaying the list of values
(with a drop-down button and/or Ellipses button).

Note: In most cases, the Ellipses button is
displayed in the Prompt window, which means
that the system has found the Business Object
(selected from the Table drop-down). The Ellipses
button opens a separate window that displays a
list of values in a grid grouped by the Business
Object Field (selected from the Field drop-down),
and then by the Fields in the Business Object's
default Grid. The drop-down arrow is displayed
only if the Business Object definition is
cacheable, or if the Business Object field
(selected from the Field drop-down) has the
TreatAsCacheableForPrompt general attribute
(defined on the Advanced Properties page of the
Field Properties window). Clicking the drop-down
arrow displays the list of cached values for the
Business Object Field.

Display a Simple Text Box Select this option to display the Prompt window where
Users can type values into a text field.

Display List of Values in a Combo

Select this option to display the Prompt window where
Users can type values into a text field, or select from a list
of values in a drop-down. The drop-down shows values
from the selected Business Object field (in the Field drop-
down).

Show Open Button

Select the check box to show an Ellipses button that
Users can click in the Prompt window to open a separate
Quick Selector window, which displays the list of values
as a grid.

Display List of Values in a Grid

Select this option to have the list of values displayed in a
grid grouped by the selected Business Object field (from
the Field drop-down), and then by the fields in the
Business Object's default Grid. If you select this option,
the Prompt bypasses the Prompt window and immediately
navigates the User to the grid, where they can select a
value from the list.

Note: The default Grid for a Business Object is
configured using the Grid Editor in CSM
Administrator. The ability to configure the Grid
depends on the Grid's grouping properties.
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Option Description

Display List of Values in a Simple List

Select this option to display a list of values in a list that
only shows values from the selected Business Object
field. If you select this option, the Prompt bypasses the
Prompt window and immediately navigates the User to the
list of values.
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Web Service Lookup Example

Overview
CSM Prompts can read an XML or JSON collection and display the values in a lookup table grid from an
entire row or from selected fields in the collection. This allows Users to easily select and use information
from third-party web service calls. For example, create a One-Step that calls a web service, stores the
JSON result in a variable, and then uses the result to create a web service lookup table from which Users
can select a value. The values returned from web service and web service lookup results can be parsed
to populate Business Object Fields, make additional web service calls, or used as a Token in other
Actions.

This example uses the Edmunds Vehicle API web service. The API and any data from it were used in
accordance with the Edmunds Vehicle API Terms of Service for purposes of this example only.

User Workflow:

1. Run a One-Step (from a button, link, etc.).

2. Enter a 4-digit year into the first Prompt.
The web service returns a web service lookup table with a list of vehicle makes and models for the
specified year.

3. Select a vehicle make and model from the web service lookup table.
The selected make, model, and year are passed back to the web service to find available styles for
the vehicle.

4. Select a style for the specified vehicle make, model, and year.
Use the value returned from this selection to populate Business Object Fields, make additional web
service calls, or create a Token for use in other Actions.

The configuration for this workflow is in the following sections.

Set Up a Web Service
Set up a web service that returns a list of vehicle makes, models, and styles:

1. On the General page, define a name, URL, and Service Type for the web service.
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2. Define web service methods for Makes and Styles.

Important: If the web service is configured to return results as JSON or XML, ensure that
JSON or XML is selected as the Result Type in the web service methods.
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The Makes method will return a list of vehicle makes and models by year. The API Key parameter is
set to the key value required to access the API site.
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The Get Styles method will return a list of styles for a vehicle by make, model, and year.

CSM 9.3.0 Features 1057

CSM 9.3.0 Features



Call the Web Service Using a One-Step

1. Create a One-Step.

2. Add a Call a Web Service Action to the One-Step that calls the Edmunds Vehicle API and returns
a list of vehicle makes and models by year (the User will be prompted to enter a year).

3. In the step details, click the General page:
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a. Define a name for the Action (ex: Select a make and model).

b. Select the Edmunds Vehicle API web service created in the previous step.

c. Select the Store Result As check box to store the result of the web service call as a variable.
Provide a name for the variable (ex: Select make and model result).

4. Click the Method page:
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a. In the Method drop-down, select Makes.

b. Select Year (Endpoint parameter).

Note: The parameters are based on those defined for the web service methods when
the web service was set up. The API Key parameter is set to the key value required to
access the API site.

c. Select the Set Value radio button.

d. Right-click in the Value field or click the Token selector  to insert a new Prompt.

e. Create a Prompt that asks Users to enter a four-digit year.

CSM 9.3.0 Features 1060

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=create_a_prompt


When the One-Step runs, and the User enters a year into the Prompt, the value of the year is
passed as a parameter to the Edmunds Vehicle API web service. The web service returns (as
JSON) a list of makes and models by year, which is stored in the Select make and model
result variable.

Display Results in a Web Service Lookup
Use an Update a Variable or Stored Value Action with a Prompt to display vehicle makes, models, and
year (selected in the first prompt) from the web service call in a web service lookup table, and then store
the User's selection in a variable.

1. Add an Update a Variable or Stored Value Action to the One-Step:
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a. Define a name for the Action (ex: Update Selected Make and Model).

b. Select the Variable radio button, and define a name for the variable (ex: Selected Make and
Model). Select JSON as the Data Type.

c. In the New Value field, right-click or click the Token selector  to insert a new Prompt.

d. Create a Prompt that displays the makes, models, and year (selected in the first prompt) from
the web service call in a web service lookup table. Ensure the Prompt type is Text. The
collection to step through must be a JSON or XML data type.

Important: To display selected fields (ex: make, model, and year) in the web service
lookup, you must use the exact names of the columns in the JSON returned from the
web service. If you are unsure of the exact names, you can select the Use all fields
from collection check box to have a list of all columns returned and reference the
exact column names to specify only those you want to display in the web service
lookup table.
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When the One-Step runs, the Prompt will display the web service lookup table with the
specified fields.
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Because the Return entire row as JSON radio button was selected when the Prompt was
created, the entire row of JSON will be returned as the result when the User selects a row in
the web service lookup table. The result is stored in the Selected Make and Model variable.

{
"makes.id": "200000081",
"makes.name": "BMW",
"makes.niceName": "bmw",
"models.id": "BMW_3_Series",
"models.name": "3 Series",
"models.niceName": "3-series",
"years.id": "200468552",
"years.year": "2014"
}

Obtain Vehicle Styles from Web Service
Use another Call a Web Service Action to return a list of styles for the vehicle make and model selected in
the previous section (stored in the Selected Make and Model variable).

1. Add another Call a Web Service Action to the One-Step.

2. In the step details, click the General page:
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a. Define a name for the Action (ex: Get Vehicle Details).

b. Select the Edmunds Vehicle API web service.

c. Select the Store Result As check box to store the result of the web service call as a variable.
Provide a name for the variable (ex: Get Vehicle Details result).

3. Click the Method page:

a. In the Method drop-down, select Get Styles.
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b. For each parameter (make, model, and year):
i. Select the Set Value radio button.

ii. Right-click in the Set Value field or click the Token selector  to insert the Selected
Make and Model variable (from the previous Update a Variable or Stored Value Action).

iii. Right-click the variable for each parameter and add modifiers to return the desired
values from the web service.
Make parameter: Obtain the makes.name value from the JSON result based on the
User's selection in the web service lookup table.

Model parameter: Obtain models.name value from the JSON result based on the User's
selection in the web service lookup table.

Year parameter: Obtain years.year value from the JSON result based on the User's
selection in the web service lookup table.
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Display Vehicle Styles in a Web Service Lookup
After defining the Action to call the web service for a list of vehicle styles, you can have the results
displayed in a web service lookup and show the User's selection in a pop-up.

1. Add a Show a Popup Action to the One-Step:

a. In the Contents area, right-click or click the Token selector  to insert a new Prompt.

b. Create a Prompt that displays a list of style ids and names for the previously selected make
and model in a web service lookup table.
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When the Action runs, the Prompt will display a web service lookup table with the specified
fields.
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Because the Return value from single field radio button was selected when the Prompt was
created, a single styles.name value will be displayed in the popup when the User selects a row
from the web service lookup table.

This value can be used to populate Business Object Fields, make additional web service calls,
or create a Token for use in other Actions.
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Queues
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About Queues
Use Queues to inform Users, Teams, or the entire organization about what to complete by placing all their
assigned records in a defined location. Queues are especially beneficial for large organizations (75 to 100
Users) because they efficiently organize multiple records.

CSM allows you to create and define the following types of Queues:

• User Queues: Queues for specific people (example: Tom is an expert on printers, so all printer
Incidents are assigned to his Queue).

• Team Queues: Queues for teams, so that the first available Team member is assigned the next
record in the Queue.

• Global Queues: Queues that are available to all Users in your CSM system.

Access common Queue functionality from the:

1. CSM Desktop Client Queue pane.

2. CSM Desktop Client menu bar.

CSM provides several OOTB Queues. Use these Queues as-is, edit them, or create your own using the
Queue Manager.
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Queues Good to Know
• A Queue is typically identified by the Queue icon .

• Each Queue can only hold a single type of record (example: Incident, Problem, Change).

• Queues behave a bit differently in the CSM Browser Client. For more information about Browser
Client Queues, refer to the Browser Client documentation.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure Queues Security Rights.
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Using Queues
When working with Queues, users can view Queues, and add, remove, and check out records from a
Queue.
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View a Queue
A Queue can be viewed several ways:

• Available Queues (based on security rights): Use the Queue Manager.

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), click the Queue link
(example: 2nd Level).

• From the CSM Desktop Client menu bar: Tools>Queues>Queue Manager.
• From the CSM Browser Client menu bar: Searches>Queues>Queue Manager.
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Queue Pane
The Queue pane is located in the CSM Desktop Client Task Pane and provides Users with access to
common Queue operations.

Note: If the Task Pane is not visible in the CSM Desktop Client Main window, click the horizontal
Pin icon on the Task Pane tab to display the pane.
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Use the Queue pane (accessed within the CSM Desktop Client Task Pane) to complete the following
operations:
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• Define Queue pane preferences

• Add records to a Queue

• Check out records from a Queue

• Open the Queue Manager
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Define Queue Pane Preferences
Use the Edit Queue Pane Setup window to define Queue pane preferences, such as:

• General preferences: Which Queues are displayed in the Queue pane and how.

• User Queue preferences: If User Queues are displayed in the Queue pane and how.

Good to know:

• CSM automatically creates a primary User Queue for each User for each Business Object in the
system (Incident, Problem, Change, etc.). This allows records to be assigned to Users without
having to manually create each Queue, though Users can also create additional Queues for each
Business Object, and can also rename or otherwise customize these automatic Queues.

• If your organization does not use User Queues, you can keep the current default preferences.

To define Queue Pane preferences:

1. Right-click in the Queue pane (accessed within the CSM Desktop Client Task Pane), and then
select Queue Pane Setup.

2. Define general Queue pane properties:
a. Click the General page.

b. Define general Queue preferences:
i. Show Current Record Status: Select this check box to display the Queue status of the

current record (example: On 2nd Level Queue).

ii. Queues Displayed without Scrolling: Specify the number of Queues to display on the
Queues pane before a scroll bar becomes visible.

Note: Displaying multiple Queues without a scroll bar decreases the space
allowed for other Task Pane items.

iii. Queues to display: Select the Queues to display in the Queue pane.

◦ Add/Remove buttons: Use these buttons to add or remove Queues from the Queue
pane.

Note: When you click the Add button, the Queue Manager opens giving you the
option to select an existing Queue or create a new Queue.

◦ Arrow buttons: Use these buttons to control the order in which Queues are displayed in
the Queue pane.

◦ Queue is only shown if it has items: Select this check box to display the selected
Queue only if it contains records.

3. Define User Queue preferences.
a. Click the User Queues page.

b. Define User Queue preferences:
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i. Show User Queues that Contain Items: Select this check box to display User Queues
in the Queue pane that contain at least one item (example: If Henri's Incident Queue has
at least one item, it would be displayed in the Queue pane).

ii. Position in Queue list: Select the position of User Queues (Above Other Queues or
Below Other Queues) relative to other Queues in the Queue pane.

iii. Which User Queues are Shown?: Select an option to limit User Queues displayed in
the Queue pane.

◦ Primary Business Object Only: Select this radio button to display only the User Queue
for the primary Business Object with which you are assigned to work. This Object is set
based on the current view, and can be modified by the system administrator (example:
Henri's Incident Queue).

◦ All Business Objects: Select this radio button to display User Queues for all Business
Objects that support Queues.

◦ Selected Business Objects: Select this radio button to display only User Queues for a
selected Business Object. Click Add to select the Business Object.

4. Click OK.4. 
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Add a Record to a Queue
You can add a record to a Queue directly from a Business Object record.

To add a record to a Queue:

1. Open a record.

2. Do one of the following:
◦ From the CSM Desktop Client menu bar, click Tools>Queues>Current Record>Add to

Queue.

◦ From the Queue pane (accessed within the CSM Desktop Client Task Pane), click the Add to
Queue button next to the desired Queue.

◦ From the Queue pane (accessed within the CSM Desktop Client Task Pane), right-click and
select Add Current Record to Queue.

◦ On your keyboard, press CTRL+Q.

a. Select the Queue for which you want to add the record. Options include:
◦ Leave the selected Queue as-is.

◦ From the drop-down, select a recently added Queue.

◦ Click the Ellipses button to open the Queue Manager, and then select an existing Queue
or create a new Queue.

◦ Select the User Queue radio button and select the Team and User in the drop-downs.

b. (Optional) Provide custom text for the Queue History Journal record.

3. Click OK.3. 

The record is added to the Queue.
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Remove a Record from a Queue
You can remove a record from a Queue from the CSM Desktop Client main window.

To remove a record from a Queue:

• From an open Queue, right-click a record, and then select Queues>Remove from [Queue Name]
Queue.

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), right-click the On
[Queue Name] Queue text and select Remove from Queue.
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Check Out a Record from a Queue
You can check out a record from a Queue from the CSM Desktop Client main window.

Good to know:

• When a record is checked out to a User from a Queue, all Users who view the Queue status can
see that the User is the Queue owner of the record. This prevents multiple Users from attempting to
work on the same record at the same time. Depending on your system settings, you might only be
allowed to check one record out at a time.

• The record pulled from the Queue is based on the configuration of that Queue (example: Based on
highest priority). The record will never be a record that is already checked out to another User. This
is an effective method of work distribution, because each User has the ability to select the next
record, which will automatically retrieve the appropriate record based on order.

To check out a record from a Queue:

1. A record can be checked out from a Queue several ways:
◦ From the Queue Manager menu bar, click Queues>Check out next record.

◦ From the Queue pane (accessed within the CSM Desktop Client Task Pane), click the Check
Record Out from Queue button .

◦ From the Queue pane (accessed within the CSM Desktop Client Task Pane), right-click the On
[Queue Name] Queue text and select Check out current record.

The record is checked out from the Queue and opens in the CSM Desktop Client Main Pane.
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Managing Queues
Queues are managed using the Queue Manager.

There are several ways to open the Queue Manager.

Use the Queue Manager to:

• View a Queue.

• Create a Queue.

• Add a Queue to the Queue pane.

• Open a Queue as a Group.

• Open a Queue as a Specific Group.

• Edit a Queue.

• Delete a Queue.

• Search for a Queue.

• Organize Queues.
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• Copy a Queue.

• Import/export a Queue.

• Find Queue dependencies.

• Pin a Queue.
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Open the Queue Manager
To open the Queue Manager:

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), click the Queue
button.

• From the CSM Desktop Client menu bar, click Tools>Queues>Queue Manager.
• From the CSM Browser Client, click Searches>Queue Manager.
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Create a Queue
Use the Queue Properties window (accessed from within the Queue Manager) to create a Queue. When
you create a Queue, you define:

• General properties: Name, description, queued Object (example: Incident), priority Field, and Queue
checkout order.

• Behavior properties: Queue limits, behavior, and record ownership transfers.

• History properties: Queue History Journal settings.

To create a Queue:

1. Open the Queue Manager.

2. Select a scope and subfolder (if needed).

3. Select a Business Object association, if applicable.3. 

4. Click the Create New button.

5. Define the following:
a. General properties.

b. Behavior properties.

c. History properties.

6. Click OK.6. 
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Define General Properties for a Queue
Use the General page in the Queue properties window (accessed from within the Queue Manager) to
define general properties for Queues. When you define general properties, you define:

• Name.

• Description.

• Queued Object.

• Priority field.

• Queue checkout order.

To define general properties for a Queue:

1. Open the Queue Manager.

2. Click the Create New button.

3. Click the General page.

4. Define general properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

c. Queued Object:

Select the type of record that can be placed in the Queue.

d. Queue Items are Prioritized:

Select this check box to specify the default order in which the items should be removed from
the Queue. Then, select the Field and whether to retrieve records in ascending or descending
order based on the prioritization (example: Select Incident Priority so that Priority 1 Incidents
are retrieved before Priority 2).

Note: If prioritization is not specified, then records will be retrieved based on order of
creation.

e. Queue Checkout Order:
Select the order of items checked out from a Queue:

◦ Oldest First: Select this radio button to check out the oldest records in the list first.

◦ Newest First: Select this radio button to check out the newest records in the list first.
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◦ Manual: Select this radio button to check out a record based on User selection (User can
check out any record in the Queue).

Note: This selection removes the option to retrieve the next record from the
Queue. If Queue items are prioritized, the records will be retrieved based on the
defined priority. If records have the same priority, the Oldest/Newest value is
applied.

5. Click OK.5. 
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Define Behavior Properties for a Queue
Use the Behavior page (accessed from within the Queue Manager) to define behavior properties for
Queues. When you define behaviors, you define:

• Queue limits.

• Queue behavior.

• Record ownership transfers.

Good to know:

• While a record is suspended in a Queue, it will not automatically be checked out when a User
selects the Next Available record from the Queue.

To define behavior properties for a Queue:

1. Open the Queue Manager.

2. Click the Create New button.

3. Click the Behavior page.

4. Define Queue limits (number based or time based):
◦ Limit User to [Number] records checked out at a time: Select this check box to limit the

number of records that a User can check out of a Queue at one time.

◦ Limit checkout time to [Number] [Timeframe]: Select this check box to limit on the amount
of time a User can keep a record checked out from a Queue (when the specified time passes,
the record will automatically be shown as not checked out). Then,

a. Define Queue behaviors (select all that apply):
◦ Allow items to be suspended from a Queue: Select this check box to allow records to

be suspended until the User removes the suspension.

◦ Checking out an item removes it from the Queue: Select this check box to remove a
record from the Queue when it is checked out.

Note: This option is recommended for Users who will retrieve the record and
complete the work in a single operation.

◦ Automatically refresh count on Task Pane: Select this check box to automatically
update the display of the total number of records in the Queue.

◦ Part of Queue Group: Select this check box to have the Queue belong to a specific
Queue Group, then select the Queue Group from the drop-down. If necessary, click the
Ellipses button to open the Queue Group Manager, which allows you to create a new
Queue Group.

◦ Automatically remove [Business Object] from Queue when [Final State]: Select this
check box to remove the Business Object from the Queue when the lifecycle of the
Business Object is complete (example: If an Incident is closed, it will automatically be
removed from the Queue).
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Note: This option is only available if the Business Object has a lifecycle. Use the
Business Object Editor in CSM Administrator to set lifecycle options.

b. Define record ownership transfers (select all that apply):
◦ When record is put on a Queue: Select this check box to automatically change the owner

of a record to a specific User or Team when the record is placed on the Queue (example:
The Networking Team owns the Networking Queue).

◦ When record is checked out from a Queue: Select this check box to automatically
change the owner of the record to the User who checked out the record.

5. Click OK.5. 
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Define History Properties for a Queue
Use the History page (accessed from within the Queue Manager to define Queue History Journal settings
for the following operations:

• Add to Queue

• Check out/Check in

• Reassign

• Suspend/Unsuspend

• Remove

Good to know:

• Queue History Journal settings for default User Queues can also be set using CSM Administrator
(Settings>Edit User Queue Settings).

• Queue History Journal options are only available if the Business Object supports History, which is
configured using CSM Administrator (Create a New Blueprint>Business Object>Edit Business
Object>Bus Ob Properties button>History page).

To define history properties for a Queue:

1. Open the Queue Manager.

2. Click the Create New button.

3. Click the History page.

4. Define Queue History Journal properties:
a. Set History options for Queue operations (Add to Queue, Check Out, Check In, Reassign,

Suspend, Unsuspend, Remove): Select one of the following options from the corresponding
drop-down:

◦ Auto-generate: Select this option to automatically create a Queue History Journal
record containing default text when the action takes place.

◦ No History: Select this option to create no Queue History Journal record when the
action takes place.

◦ Optional: Select this option to prompt the User to add notes to the Queue History
Journal record when the action takes place. It also allows the User to select not to create
a Queue History Journal record.

◦ Prompt: Select this option to prompt the User to add notes to the Queue History Journal
record when the action takes place, but does not allow the User to cancel the Queue
History record.

Note: Canceling the prompt will cancel the entire Queue operation. If a record is added
to a Queue using an automated process (example: Automation Process), the Optional
and Prompt options will add History, but use default text.

5. Click OK.5. 
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Add a Queue to the Queue Pane
You can add a Queue to the Queue pane using the Queue Manager.

To add a Queue to the Queue pane:

1. Open the Queue Manager.

2. Right-click a Queue and select Add Queue to Queue Pane.

3. Click OK.3. 
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Open Queue as a Group
You can open a Queue as a group, which opens records in a Queue as a list in the CSM Desktop Client
Main Pane, using the Queue Manager.

To open a Queue as a group:

1. Open the Queue Manager.

2. Select a Queue.

3. Click Queues on the Queue Manager menu bar, and then select Open Queue as Group from the
drop-down.

The Queue records open as a list in the CSM Desktop Client Main Pane.
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Open Queue as a Specific Group
You can open a group containing a subset of the records in a Queue using the Queue Manager.

To open a list of specific records in a Queue:

1. Open the Queue Manager.

2. Select a Queue.

3. Click Queues on the Queue Manager menu bar, and then select Open Special from the drop-down.

4. Select the type of group that you want to open:
◦ Available records in the Queue: Select this option to open all records in the Queue that are

not checked out to anyone and are not in a suspended state.

◦ Records checked out to you from the Queue: Select this option to open all records in the
Queue that are currently checked out to the current User.

◦ All records checked out of the Queue: Select this option to open all records in the Queue
that are checked out by any Users.

◦ Records that are suspended in the Queue: Select this option to open a group of all records
in the Queue that are in a suspended state.

The records open in the CSM Desktop Client Main Pane.
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Configuring Queues
Complete the following procedures to configure Queues. Configuration procedures are completed in CSM
Administrator.

To configure Queues:

1. Configure Queue security rights: Configure who can access Queue functionality.

2. Add Queue support to a Business Object: Define if Users should be allowed to add a specific type of
Business Object record to Queues.

3. Define Queue settings based on Business Object lifecycle: Define how Business Object records are
added to or removed from Queues based on lifecycle states.

4. Specify Queue history placement: Define which Business Object to use for tracking when records
are added to or removed from a Queue.

5. Define default User Queue history settings: Define Queue History Journal records to track Queue
operations (example: Add to Queue, check in, check out, reassign, suspend, unsuspend, remove).

6. Transfer ownership to User when record is placed in a User Queue: Define if Users can transfer
record ownership to a specific User when a record is placed in a User Queue.
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Configure Global User Queue Settings
Use the User Queue Settings window in CSM Administrator to define the default options for each
automatically-created User Queue. Global User Queue settings include:

• Create a History Record to track Queue operations: Define Queue History Journal records to track
Queue operations (example: Add to Queue, check in, check out, reassign, suspend, unsuspend,
and remove).

• Transfer ownership when a record is placed in a Queue: Define if Users can transfer record
ownership to a specific User when a record is placed in a User Queue.
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Open the User Queue Settings Window
To open the User Queue Settings window from the CSM Administrator main window, click the Settings
category, and then click the Edit User Queue Settings task.
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Define User Queue History Settings
Use the User Queue History Settings window to define Queue History Journal records to track Queue
operations (example: Add to Queue, check in, check out, reassign, suspend, unsuspend, remove).

To define User Queue History settings:

1. Open the User Queue Settings window.

2. Select Queue History Journal options for Queue operations (Add to Queue, Check Out, Check In,
Reassign, Suspend, Unsuspend, Remove): Select one of the following options from the
corresponding drop-down:

◦ Auto-generate: Select this option to automatically create a Queue History Journal record
containing default text when the action takes place.

◦ No History: Select this option to create no Queue History Journal record when the action
takes place.

◦ Optional: Select this option to prompt the User to add notes to the Queue History Journal
record when the action takes place. It also allows the User to select not to create a Queue
History Journal record.

◦ Prompt: Select this option to prompt the User to add notes to the Queue History Journal
record when the action takes place, but does not allow the User to cancel the Queue History
record.

Notes: Canceling the prompt will cancel the entire Queue operation. If a record is added to a
Queue using an automated process (example: Automation Process), the Optional and Prompt
options will add History, but use default text.

3. Click OK.3. 
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Transfer Ownership When Record is Placed in User
Queue

Use the User Queue History Settings window to define if Users can transfer record ownership to a specific
User when a record is placed in a User Queue.

To transfer record ownership when a record is placed in a User Queue:

1. Open the User Queue Settings window.

2. Select the Transfer ownership to User when record put on User Queue check box.

3. Click OK.3. 
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About Queue Groups
Use Queue Groups to prevent records from being placed in more than one Queue at the same time when
Users have multiple Queues. If the record is assigned to one of the Queues in the group, it will
automatically be removed from any other Queue in the group; however, the record can still be placed on
other Queues that are not members of the group.

The following figure shows a Queue Group`created for the 2nd Level Queue and New Request Queue,
which are both associated with the Incident Business Object. Since an Incident could be added to either
Queue based on the specified fields within the record, the Queue Group prevents the record from being
placed in both the 2nd Level Queue and the New Request Queue.

CSM provides an OOTB Queue Group. Use this Queue Group as-is, edit it, or create your own using the
Queue Group Manager.
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Queue Groups Good to Know
• Queue Groups prevent a record from being in more than one Queue at the same time.

• To be added to a Queue Group, Queues must have a Queued Object that matches the Queue
Group Business Object association.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure Queues Security Rights.

CSM 9.3.0 Features 1101

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=security_rights
https://help.cherwell.com/csh?topicname=configure_queues_security_rights


Viewing Queue Groups
To view Queue Groups:

• From the CSM Desktop Client menu bar, click Tools>Queues>Queue Manager>Queues>Queue
Group.

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), right-click and select
Queue Manager>Queues>Queue Group.
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Managing Queue Groups
Queue Groups are managed using the Queue Group Manager.

Use the Queue Group Manager to complete general CSM Item Manager operations for Queue Groups,
including:

• Create a Queue Group.

• Edit a Queue Group.

• Delete a Queue Group.

• Search for a Queue Group.

• Organize Queue Groups.

• Copy a Queue Group.

• Import/export a Queue Group.
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Open the Queue Group Manager
To open the Queue Group Manager:

• From the CSM Desktop Client menu bar, click Tools>Queues>Queue Manager>Queues>Queue
Group.

• From the Queue pane (accessed within the CSM Desktop Client Task Pane), right-click and select
Queue Manager>Queues>Queue Group.
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Create a Queue Group
Using the Queue Group Manager, Users can create Queues Groups to meet the specific needs of their
company.

Good to know:

• The Queues that you add to the group must have a Queued Object that matches the Queue Group
Business Object association in order for the Queue to be added.

To create a Queue Group:

1. Open the Queue Group Manager.

2. Select a scope and subfolder (if needed).

3. Select a Business Object association.

4. Click the Create New button.

5. Define general properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

6. Click the Add button.

7. Click the Queue that you want to add to the Queue Group.

8. Click OK.8. 

The Queue displays in the Queue Group window.

9. Add additional Queues to the Queue Group.

10. Click OK.10. 
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Record Locking
Record locking is the ability to prevent record editing (or warn that a record is locked) so that multiple
Users do not make simultaneous changes to the same record. Read-only access is still allowed.
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About Record Locking
Use record locking to:

• Prevent data conflicts.

• Prevent access to unsaved/uncommitted edits.

The record locking interface and behaviors vary depending on your system's record locking configuration
(settings and security rights), who is viewing the locked record (lock holder or another User trying to
access the locked record), and the CSM client (Desktop Client, Browser Client, or Portal).

Depending on the configuration:

• Record locking can be either:
◦ Enforced: Prevents Users from editing a record when it is locked by another User (the lock

holder).

◦ Informational: Warns Users when a record is currently being edited by another User so that
Users do not attempt to edit the same record.

• A record can be locked either:
◦ Automatically (implicitly): When a User attempts to edit a record.

◦ Manually (explicitly): When a User clicks the Unlocked button on the CSM Desktop Client
toolbar or CSM Browser Client toolbar.

• A record can be unlocked either:
◦ Automatically: When the lock holder saves an edit, when the lock holder logs out of his

session, or after a configured expiration. Lock holders can be given the option to renew a lock
before it expires.

◦ Manually: When the lock holder clicks the Locked By You button on the CSM Desktop Client
toolbar or CSM Browser Client toolbar.

Tip: A User can manage (view and unlock) all his User locks (records locked by him) using the
Record Locking Manager in the CSM Desktop Client (Edit>User Locks). A system
administrator can manage (view and unlock) Global locks (all locked records for all Users)
using the Record Locking Manager in CSM Administrator (CSM Admin>Settings>Global Lock
Manager).

• A lock can expire and can be renewed before expiration.

Record locking is enabled and configured in CSM Administrator. Global locks are managed (viewed and
unlocked) using the Record Locking Manager in CSM Administrator. With security rights, Users can
alsoview and unlock their own locked records in the CSM Desktop Client.
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Record Locking Good to Know
• Only Major Objects can be locked.

• When a parent record is locked, its entire form is locked, including any child records in the
Arrangement; however, child records can still be changed from another location or through a
different process (example: A User can update a related Task, etc.).

• If two Users simultaneously edit the same record (example: Informational lock allows a User to edit
the record even if another User is currently editing it, or a non-participating entity, such as an
Automation Process, One-Step, Scheduler, or mobile client, edits a record while it is locked), the
User will be given the option to reload or merge simultaneous edits.

• By default, a One-Step honors the record locking behavior of the record on which it is used. For
example, if Incident is configured to lock records, and a One-Step is run to update the active
Incident record (the record is open or selected in the Grid), the One-Step will attempt to lock the
record.

◦ A One-Step will attempt to lock the active record when the specific Action to update a record
executes (including Actions that update or create child records).

◦ One-steps running against a group of records (such as a Search Group), honor the record
locking configuration only on the active record. For any other records in the group, record
locking is bypassed.

◦ If a One-Step Action acquires a lock, the lock is released based on the Business Object's
record locking configuration (example: If the Business Object is configured to automatically
release locks upon save and the One-Step Action saves the record, then the lock is released
when the One-Step saves the record).

◦ If a One-Step attempts to lock a record that is locked by another User, a warning appears
stating that the record is already locked, and One-Step execution fails. If record locking is
informational, One-Step execution only fails if the maximum number of locks is exceeded.

◦ If the One-Step is run against a group of records, and attempts to lock records that are already
locked by other Users, a warning appears stating which records were already locked and
could not be updated; however, the One-Step will update the remaining records in the group.

Note: A One-Step that updates a Business Object can also be configured to explicitly
acquire a lock before running to ensure that the active record is locked prior to One-
Step execution, not just when a specific Action to update a record is being executed.
Acquiring a lock prior to One-Step execution ensures that the One-Step will not fail if a
particular Action cannot acquire a lock. If a One-Step is configured to acquire a lock
prior to execution, it can also be configured to release the lock after the entire One-
Step finishes executing.

• In the Browser client, automatic record locking notifications are not available, so Renew is not an
option. Users are given the option to reload or merge only if they attempt to save changes to an
already changed (and saved) locked record (example: Allowed with informational locking and or a
non-participating entity).

• Cherwell Mobile clients, the Scheduler, Automation Processes, and Users making use of the CSM
Web Service do not participate in record locking, meaning they neither lock a record nor see locks
on a record. This means that if one of these entities needs to edit a locked record, it will be able to
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do so. In the event that simultaneous edits are made to a record, CSM will give Users the option to
merge changes.

• By default, the Customer Portal does not participate in record locking, meaning Customers never
lock a record or "see" a lock on a record. If the Portal is explicitly configured to participate (in
enforced locking), it silently participates, meaning the Customer automatically acquires and releases
locks (so that Users are prevented from editing). The only time a Customer receives a locking
message is if she attempts to edit a record locked by another User. In this situation, the changed
record is automatically reloaded if the Customer attempts to edit the record after the User unlocks
the record.
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Using Record Locking
Users can manually lock and unlock records.
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Manually Lock a Record
Use the Unlocked button on the CSM toolbar on theDesktop Client and Browser Client to manually lock a
record.

Good to know:

• Some systems are configured to automatically lock a record when you start editing it (implicit
locking).

• If your system is configured to explicitly lock a record, you need to manually lock the record before
you can edit the record.

To manually lock a record:

1. Open a record (example: Incident).

2. On the CSM Desktop Client toolbar or CSM Browser Client toolbar, click the Unlocked button.

Tip: You can also click Edit>Unlocked from the CSM Desktop Client menu bar.

To the lock holder (User who locked the record):

◦ The Record Locking button toggles to the Locked By You button so that the User can
manually unlock the record, if needed.

To any User who tries to edit the locked record:

◦ The locked record can be viewed but not updated

Note: If record locking is configured to be informational (rather than enforced), the
record is editable but the User is warned that another User has the record locked. If
two Users simultaneously edit the same record, CSM gives the User the option to
merge the edits.

◦ The Locked By User button indicates that the record is locked by another User (lock holder).
A tooltip indicates whom has the record locked, when it was locked, and when the lock will
expire.

3. The lock holder edits the record.

When locked, several scenarios are possible, depending on the record locking configuration
(settings and security rights):

◦ If record locking is configured to have a lock renewal period (example: 3 minutes), the lock
holder has the option to renew the record lock before it expires.

◦ If record locking is configured to automatically unlock the record after a save, the record will be
automatically unlocked after the lock holder saves the record. The record holder can then
either leave the record or re-lock the record to continue editing.

◦ If record locking is not configured to automatically unlock the record after a save, the lock
holder can manually unlock the record:
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◦ By clicking the Locked By You button on the toolbar.

◦ Using the Record Locking Manager in the CSM Desktop Client.

◦ If the lock holder does not manually unlock the record, the record will be automatically
unlocked when:

◦ The lock expires (if configured).

◦ The lock holder logs out of her session (if configured).

Tip: A system administrator can manage (view/unlock) Global locks (all locked records
for all Users) using the Record Locking Manager in CSM Administrator (CSM
Admin>Settings>Global Lock Manager).
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Manually Unlock a Locked Record
Use the Locked By You button on the CSM toolbar (Desktop Client and Browser Client) to manually
unlock a locked record.

Good to know:

• Some systems are configured to automatically unlock a record: 1) When the lock holder saves an
edit, 2) when the lock holder logs out of his session, or 3) after a configured expiration.

To manually unlock a locked record:

1. On the CSM Desktop Client toolbar or CSM Browser Client toolbar, click the Locked By You button.

Tip: You can also click Edit>Locked By You from the CSM Desktop Client menu bar.

CSM unlocks the record.

To the lock holder (User who locked the record):

◦ The Record Locking button toggles to the Unlocked button so that the User can manually re-
lock the record, if needed).

To any User who was viewing the locked record:

◦ The Record Locking button toggles to the Unlocked button.

◦ If the record was edited by the lock holder, any Users viewing a locked record are given the
option to reload the record if saved edits are detected.

Note: In the Desktop Client, change notifications (reload and merge) can be
configured to be automatic or optional upon an attempt to edit. In the Browser client,
automatic notifications are not available, so Users are given the option to reload and
merge only if they attempt to edit a locked record.

◦ The locked record becomes editable again (enforced record locking only).
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Managing Record Locking
Locked records are managed using the Record Locking Manager.

• Users can manage (view or unlock) all records they lock using the Record Locking Manager in the
CSM Desktop Client (Edit>User Locks).

• A system administrator can manage (view or unlock) Global locks (all locked records for all Users)
using the Record Locking Manager in CSM Administrator (CSM Admin>Settings>Global Lock
Manager).

Note: When on a record, a lock-holder can use the Record Locking button on the CSM
Desktop Client toolbar or CSM Browser Client menu bar to manually lock or unlock the
record.
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Use the Record Locking Manager
Use the Locked Record Manager to:

• View a list of locked records (as a Grid): Shows where the record was locked (example Desktop
Client), who locked the record (record holder), what time the record was locked, and when the lock
will expire (if configured).

• Filter locked records: Filter the list by selecting a CSM Application (example: Desktop Client,
Browser Client, etc.), Locked By (Global Locks only), and/or Lock Type (example: Major Objects).
Clear the filter by clicking Reset Filter.

• Sort the list by clicking the Sorting arrows.

• Unlock all or selected locked records.

• Refresh the list.

• Export or print the Grid list.

To open the User Locks Record Locking Manager (CSM Desktop Client):

• From the CSM Desktop Client menu bar, click Edit>User Locks.

To open the Global Locks Record Locking Manager (CSM Administrator):

• In the CSM Administrator main window, click the Settings category, and then click the Global Lock
Manager task.

When the Record Locking Manager is opened in CSM Administrator, it displays Global locks (all locked
records for all Users). When the Record Locking Manager is opened from the CSM Desktop Client, it
displays User locks (all locked records for the logged-in User).

Note: The Record Locking Manager is not available in the CSM Browser Client or CSM Portal.

CSM 9.3.0 Features 1115

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Frecord_locking%2F..%2Fgrids%2Fexport_a_grid.html
https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Frecord_locking%2F..%2Fgrids%2Fprint_a_grid.html


View and Manually Unlock All User Locks
Users can manage (view/unlock) all records they lock using the Record Locking Manager in the CSM
Desktop Client (Edit>User Locks).

To view all User locks:

1. From the CSM Desktop Client menu bar, click Edit>User Locks.

The Record Locking Manager opens, displaying a Results Grid of all records locked by you
(CurrentUser).

2. Then:
◦ Filter the Grid list (by selecting an Application and Lock Type).

◦ Sort the Grid list by clicking the Sorting arrows.

◦ Refresh the Grid list by clicking the Refresh button.

◦ Print an export the Grid by right-clicking in the window.

3. Click Close to close the Manager.

To unlock all User locks:

1. From the CSM Desktop Client menu bar, click Edit>User Locks.

The Record Locking Manager opens, displaying a Results Grid all records locked by you
(CurrentUser).

2. Click the Select All button to select all records.

3. Click the Unlock Selected Records button.

4. Click Close to close the Manager.
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View and Manually Unlock All Global Locks
A system administrator can manage (view/unlock) Global locks (all locked records for all Users) using the
Record Locking Manager in CSM Administrator (CSM Admin>Settings>Global Lock Manager).

To view all Global locks:

1. In the CSM Administrator main window, click the Settings category, and then click the Global Lock
Manager task.

2. Then:
◦ Filter the Grid list (by selecting an Application and Lock Type).

◦ Sort the Grid list by clicking the Sorting arrows.

◦ Refresh the Grid list by clicking the Refresh button.

◦ Print an export the Grid by right-clicking in the window.

To manually unlock all Global locks:

1. In the CSM Administrator main window, click the Settings category, and then click the Global Lock
Manager task.

2. Click Select All to select all records.

3. Click Unlock Selected Records.
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Configuring Record Locking
Complete the following procedures to configure record locking. All configuration procedures are
completed in CSM Administrator.

To configure record locking:

1. Configure record locking security rights.

2. Enable record locking: Record locking is enabled by default for first-time installations.

3. Configure global Record Locking settings: Configure global record locking settings (default settings
for all Business Objects).

4. Define Record Locking settings for a specific Business Object: Define record locking settings on a
per Business Object basis (these override the Global record locking settings on a per Business
Object basis).
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Enable Record Locking
Record locking is enabled by default in the CSM starter database. Use the Locking page in the System
Settings window in CSM Administrator to enable record locking.

To enable record locking:

1. In the CSM Administrator main window, click the Settings category, and then click the Edit System
Settings task.

2. Click the Locking page.

3. Select the Enable Record Locking check box.

4. Click OK.
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Troubleshooting Record Locking
If the CSM Desktop Client stops responding, manually release record locks using the Record Locking
Manager or wait until the system automatically releases the license based on defined inactivity settings
(configured under CSM Administrator>Security>Licensing>If Client Stops Responding,Auto-
Release License and/or CSM Administrator>Security>Edit Security Settings>Desktop
Client>Logout inactive Users from Cherwell Client). Browser and Mobile Clients automatically log out
Users/Customers after a period of inactivity based on Browser application settings and IIS configuration.
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Reporting
A Report is an aggregation of CSM data that meets defined criteria presented in an exportable, paginated
format. While other CSM tools, such as Dashboards and Widgets, display real-time data convenient for
immediate use, Reports are used to format and export large amounts of data in the system at a particular
point in time. Some of the criteria used to select data can be entered each time a Report is run. This
allows a Report to be reused to generate Reports for different time intervals. Reports can also be
scheduled to automatically run at specific times.
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About Reporting
Reports are created using the Cherwell Report Writer™, which is available through the Report Wizard.

Reports are modified using the Report Designer, and typically run through the Report Manager.

Reports can also be run using a command-driven Widget on a Dashboard or using a One-Step.

Report examples include:

• My open Incidents by category

• Past month Incidents by priority

• Past year service trends

The following Report shows the duration of Incidents occurring over the past year, sorted by priority, and
displayed in descending order as color-coded alert bars.
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Out of the Box (OOTB) Reports
Cherwell provides several Out of the Box (OOTB) Reports. These Reports can be found in the in the
Report Manager when OOTB content has been installed.

For a complete list, refer to the OOTB Reports document posted in the Release Notes area of the
Cherwell Support Portal.
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Report Alternatives
In addition to Reports, CSM provides a variety of tools to help summarize data and analyze metrics.
These tools include:

1. Dashboards/Widgets: Dashboards can display summary information through data-driven Widgets
(such as Chart, Gauge, and Matrix Widgets).

a. See Dashboards for more information on creating and using Dashboards.

b. See Dashboard Drill-Down for more information on accessing the information displayed in
specific Widgets, and Using Grids for information on printing and exporting this data.

2. Search Groups: Search Groups can be used to locate one or more records that meet specific
criteria.

a. See Using Grids for information on sorting, filtering, and grouping the results, as well as
printing and exporting this data.

3. Visualizations: Visualizations can be used to view, print, or export the relationships between
Configuration Items (CIs), personnel, and other related records.

4. Exported Grids: You can export Grids that contain various types of data to multiple formats, such
as .csv and Excel.
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Reporting Good to Know
• After a Report is open in the Preview window, Users cannot navigate back to the CSM Main window

without first closing the Preview window. It is recommended that you have two (2) instances of CSM
open (example: opening CSM again) to easily jump between the Report Preview and CSM.

• Dashboards can provide summary information in the form of data-driven Widgets, and can also run
Reports in the form of command-driven Widgets.

• Some CSM features may behave differently in the CSM Browser Client. For more information, refer
to the Browser Client documentation.
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Tour the Report Suite
There are three main tools used in the Reporting process:

1. The Report Wizard helps you build new Reports using data from Cherwell Report Writer, SQL
Reporting Services, or Crystal Reports.

2. The Report Designer allows you to determine the contents and appearance of Reports.

3. The Report Preview window displays a preview of a Report after it has been created; from here, you
can print or export a Report for distribution.

In addition, the Report Runner allows a User to use the Report Manager to design and run Reports
without a full CSM license.

These tools are accessed through the Report Manager.
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Report Wizard
The Cherwell Report Wizard walks you through creating a new Report using the Cherwell Report Writer,
which is designed to use existing Cherwell Search Groups. The Report Wizard allows you to quickly build
a report that you can later modify using the Report Designer.

The Report Wizard also allows you to create references to external reports.

To open the Report Wizard:

1. Open the Report Manager.

2. Click the Create New button.

The Report Wizard opens.

For more information, see Creating a New Report Using the Report Wizard.
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Report Designer
The Report Designer allows you to configure the appearance, layout, and format of Reports after you use
the Cherwell Report Wizard.

In the Report Designer, bands organize groups of data Controls. Each Control represents an area of the
Report that will be populated with data when the Report is run. From here, you can modify many details of
the control, from font attributes, to colors, to data limitations.

Note: When the Report Designer is open, you cannot work in the CSM Desktop Client unless a
second instance of CSM is open. To open a new CSM Desktop Client instance, on the main
menu, select File>New Window. This will allow you to look at Cherwell data while you are
designing your Report.
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1. Menu bar

2. Action toolbal

3. Format toolbar

4. Layout toolbar

5. Zoom toolbar

6. Control toolbar

7. View toolbar

8. Main pane
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9. Explorer pane and Field List panes

10. Property Grid

11. Group and Sort pane
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Report Bands
The Report Designer uses bands to organize information.

There are different types of bands in the Report Designer.

1. Page Header Band (Top Margin)

Defines text that is printed at the top of each page. This includes page header text and page
numbers (if included in the header) defined on the Report Title, Header, and Footer page of the
Report Wizard.

2. Report Title Band
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Defines the title of a Report. If a chart was added using the Report Wizard, the chart is also included
in this band so that it prints once at the beginning of the Report. However, a chart can also go on
other bands, depending on where they need to be printed in the Report.

3. Column Header Band
Holds the column headings for the rows of data that are displayed in the Report.

Tip: If you delete the Column Header band and want to add it later, use a Page Header
band.

4. Group Header Band

Used to group results by Fields. If the Report is grouped by multiple Fields in the Report Wizard, the
Report will have multiple group header bands.

5. Detail Band

Holds the rows of data that will be output for the Report.

6. Detail Report Band

Used within Reports to show data for related Business Objects. For more information, refer to
Adding Relationships to Reports Using Detail Report Bands.

7. Group Footer Band

Ends the band when a Report is grouped by a particular Field.

8. Page Footer Band (Bottom Margin)

The Page Footer band is printed at the bottom of each page of the Report. This includes page footer
text and page numbers (if included in the footer) defined on the Report Title, Header, and Footer
page of the Report Wizard.
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Report Runner
The Report Runner is a stand-alone tool that allows Users to use the Report Manager, Report Wizard,
and Report Designer without consuming a CSM license.

The Report Runner requires a login, but can be installed without installing the full CSM Desktop Client.
This allows Users who have no need to enter information into CSM to work with Reports.

To open the Cherwell Report Runner:

1. In Program Files, go to Cherwell Service Management>Tools>Report Runner.
2. Select the database to use to run Reports.

3. Log in to the Cherwell Report Writer.

The Report Manager opens.
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Creating Reports
You can use the Report Wizard to create Reports in two primary ways:

• Create a New Report

• Link an External Report to CSM
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Opening the Report Wizard
The Cherwell Report Wizard help you quickly and easily create a new Report using Cherwell Report
Writer.

You can also use the Report Wizard to link a Report created using an external tool, such as SQL
Reporting Services or Crystal Reports, to CSM. Creating a link to an external Report enables the Report
to be run from a Dashboard/Widget, a One-Step, or the Reports Manager.

You can modify a CSM Report created in the Wizard at any time using the Report Designer. Reports
created using external tools must be edited with those tools; however, as long as they remain in the same
location, they do not require further maintenance in CSM.

To open the Report Wizard:

1. Open the Report Manager.

2. Select a scope folder or subfolder from the Manager Tree.

3. Select a Business Object association, if applicable.3. 

4. Click the Create New button.
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Creating a New Report Using the Report Wizard
You can use the Cherwell Report Wizard to creating a new Report step by step using the Cherwell Report
Writer. You can modify a Report created using the Wizard at any time using the Report Designer.

To create a new Report:

1. Open the Report Wizard.

2. Select a Reporting tool: Select Cherwell Report Writer to create a new CSM Report.

3. Select a Business Object and Search Group: Define the data set to use.

4. Select Fields for the Report: Select the specific information Fields to display (example: Incident
Category, Priority, Status).

5. Create calculated Fields (optional): Add custom Fields using string manipulation, math calculations,
and date/time functions.

6. Select the Fields to sort the Report: Specify one or more Fields (including calculated Fields) to
determine how the data will be sorted.

7. Set up the Fields to group the Report data: Specify one or more Fields to use to group data
(example: Group by Incident Subcategory).

8. Pick a date/time format for grouping Fields: Define the display format (DD/MM/YY, MM/DD/YY, etc.)
for Fields grouped using a date/time Field.

9. Define the Report title, set up page headers and footers, and select a chart (the chart is optional).

10. If you select a chart, define the chart characteristics.

11. Click Finish to run the Report and open the Report Designer.

CSM 9.3.0 Features 1137

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=editing_a_report_using_the_report_designer
https://help.cherwell.com/csh?topicname=opening_the_report_wizard


Select a Reporting Tool in the Report Wizard
The Select Reporting Tool page of the Report Wizard) allows you to:

• Create a new Report using the Cherwell Report Writer.

• Link to an existing Report created using SQL Reporting Services, Crystal Reports, or another tool.

To define the Reporting Tool:

1. Select one of the following tools:
◦ Cherwell Report Writer:

Create a new Report using CSM’s built-in Report Writer, designed to use existing CSM Search
Groups and Calculated Fields. The Report Writer uses the Report Designer interface and does
not require writing any Crystal or SQL statements.

◦ SQL Reporting Services:

Create a link in CSM to an existing report created using SQL Reporting Services.

◦ Crystal Reports:

Create a link in CSM to an existing report created using Crystal Reports.

◦ Other:

Create a link in CSM to an existing report created using a reporting tool not listed.

2. Click Next to open the Business Object and Search Group page if you have selected Cherwell
Report Writer, or the Report Location page if you have selected SQL Reporting Services, Crystal
Reports, or Other.
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Select a Business Object and Search Group in the
Report Wizard

The Business Object and Search Group page of the Report Wizard allows you to select the Business
Object (example: Incident) and Search Group (example: My Open Incidents) to use as a data set for the
Report.

You can select only one Business Object and Search Group per Report. You can change the Search
Group used by the Report later, but you cannot change the associated Business Object. For more
information, refer to Editing Report Properties.

You can add data from any Business Objects related to this primary Business Object to the Report. For
example, a Report on Incident Business Objects can also contain the data from the Journal Business
Objects associated with each Incident. More information on Related Business Objects is provided in the
next step of the Wizard, Select Fields for the Report in the Report Wizard.

To set the Business Object and Data for the Report:

1. Select a Business Object from the Business Object drop-down menu.

2. Select a method of retrieving data for the selected Business Object:
◦ Search Group (recommended): Pulls only the Business Object records that fit a defined

search. For example, if the system contains all Incidents that have occurred in the last three
years, but you only want to report on Incidents that are currently open, you can select the
Open Incidents Search Group. See About Search Groups for more information.

◦ All records (not recommended): Pulls all records of the Business Object from the database.
This option becomes increasingly resource intensive as the selected database grows, resulting
in large sets of Report data that take extensive time to process.

3. Click Next to open the Select Fields for Report page.
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Select Fields for the Report in the Report Wizard
The Select Fields for Report page of the Report Wizard enables you to select display Fields for the
Report. The Fields list shows the Business Object selected for the Report, as well as all of its related
Business Objects.

Fields from Business Objects related to the main Business Object (example: Journal Fields related to
Incident) are added to a Detail Report band.

To select Fields to display in your Report:

1. Locate the Field you want to display in the Report in the Fields list.

2. Double-click the Field or use the Move Right arrow to add it to the Selected Fields list.

Note: You must select at least one Field, but to prevent columns from overlapping, do not
select more than seven fields.

3. Click the Up/Down arrows to change the order in which the Fields are displayed.

4. Click Next to open the Create Calculated Fields for Reports page.
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Create Calculated Fields for Reports in the Report
Wizard

The Create Calculated Fields for Reports page in the Report Wizard allows you to optionally add
existing or create new Calculated Fields to include in the Report.

Use Calculated Fields to calculate values based on the data in each row. You can perform string
manipulation, math calculations, and Date/Time functions that use Calendars, such as your company’s
Business Hours.

Note: There are multiple options for using Calculated Fields with Reports. For more information,
see Defining Calculated Fields for a Report .

To add a Calculated Field available only in this Report:

1. Click Add.

2. Specify a Name for the Calculated Field. Note that names cannot contain spaces.

3. Select the Business Object to associate with the Calculated Field.

4. From the Data Type drop-down list, select one of the four data types recognized by the Report
Designer:

◦ Date/Time:

A Date/Time data type allows you to build an Expression to perform date/time calculations
(example: Calculate a fifteen minute warning for an SLA).

◦ Logical:

A Logical data type allows you to build an Expression to use one or more conditions to return a
true or false value (example: Incident.Status does not equal Closed).

◦ Number:

A Number data type allows you to build an Expression to perform mathematical calculations
using a string of Fields and mathematical symbols (example: Calculate the total cost of a
Labor Cost Item by multiplying the work hours by the monetary rate).

◦ Text:

A Text data type allows you to build an Expression to display a string of Tokens and text
(example: Return either "Open" or "Closed," depending on the status of a record).

5. Select the Expression:
◦ Stored Expression:

Click the Ellipses button to select an existing Cherwell Expression. See About Expressions for
more on Expressions.
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◦ Custom Expression:
Click the Expression button to create a custom Expression. For more information, see the
Define Expression topic for the Data Type selected:

◦ Date/Time

◦ Logical

◦ Number

◦ Text

Example
To add a Custom Expression:

1. Click the Expression button.

2. Select the Incidents Closed On1st Call Field in the drop-down arrow  (Incident
Fields>Statistics>Closed on 1st Call).

3. When the Field is in place, right-click the Field.

4. In the drop-down, click Modifiers.
The Modify/Format Value window opens.
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5. Select Format for the Modifier.

6. Specify Yes as the value to display when the logical Field is true.

7. Specify No as the value to display for false.

8. Click OK.8. 

CSM 9.3.0 Features 1143

CSM 9.3.0 Features



Select Sort Fields in the Report Wizard
The Select Sort Fields page of the Report Wizard allows you to specify Fields to use to sort and display
Report data. You can select any Field related to the primary Business Object for the Report.

To select sort Fields:

1. Locate the Field you want to sort Report rows by in the Fields list.

2. Double-click the Field or use the Move Right arrow to add it to the Sort Fields list.

3. Use the arrows to add, remove, and reorder Fields.

The example above will display Incidents sorted first by Incident ID, then Priority, then Status.

Tip: To display results in order of Incident ID, select CreatedDateTime as the sort Field.
Because IncidentID is a text Field, the sort order does not display as expected (1, 2, 3, etc).
Instead, results are ordered as follows: 1, 11, 111, 2, etc. Because records are created in
ascending order, CreatedDateTime will display results in the expected order.

4. Select the Show Bookmarks box to display a list of Field values in the Document Map of the
Report Designer so that a User can click on a value to jump to that group of the Report.

5. Click Next to open the Set up Report Grouping page.
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Set up Report Grouping in the Report Wizard
The Set up Report Grouping page of the Report Wizard allows you select Fields to use to Group data
rows. Each Group you add also adds a Group Header and Footer.

The Group Header is used to label the data included in the Group (example: Subcategory).

By default, the Group Footer includes a Count of the total number of matching records in the Group
(example: Two Incidents listed in the Subcategory). You can use standard and custom metrics to
customize this Field (example: Configure this Field to show the Average value of the Group).

To select Fields to use to Group data:

1. Locate the Field you want to Group Report rows by in the Fields list.

2. Double-click the Field or use the Move Right arrow  to add it to the Group Fields list.

3. Use the arrows to add, remove, and reorder Group Fields.

4. Click Next.

If you use a Date/Time field to group Report data, the Pick a Date/Time Format for Grouping Fields
page opens. Otherwise, the Set Report Title, Header, and Footer page opens.
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Pick a Date/Time Format for Grouping Fields in the
Report Wizard

If you use a Date/Time field to group Report data, use the Pick a Date/Time Format for Grouping Fields
page (accessed from within the Report Wizard) to group results by a specific time period. Example:
Organize the number of incoming Incidents by the day of the week so you can adjust staffing needs
based on the incoming rate.

To select a date/time format for the Field grouping:

1. Select a Date/Time Field to group the Report by on the Set up Report Grouping page.

2. Select the Apply Format to [Grouped Field] check box, and then select a format radio button:
◦ Group by Date

◦ Group by Year

◦ Group by Month

◦ Group by Day of Week

◦ Group by Hour of the Day

◦ Group by Hour and Minute

3. Click Next to open the Set Report Title, Header, and Footer page.
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Set Report Title, Header, and Footer in the Report
Wizard

The Set Report Title, Header, and Footer page of the Report Wizard allows you to define the Report title
and how page Header/Footer bands appear on the Report. You can also select a Report Style and
(optionally) a Chart.

To set the Report title, page header, and page footer:

1. Specify the Report title used to identify the Report in the Report Manager and appear at the top of
the Report.

2. Specify the Report Style that defines the colors, lines, and alignment used in the Report. For more
information, see About Report Styles.

3. (Optional) Select a Chart. By default, the chart is added to the Report title band, but you can move
and modify the chart later in the Report Designer. For more information, see Modifying Charts in the
Report Designer.

4. Select the Page Number check box to add page numbers to the Report.
◦ Set the Location: Top, Middle, Bottom.

◦ Set the Position: Left, Centered, Right.

5. Select the Page Header check box to add a header to each page of the Report.
◦ Specify the header Text.
◦ Set the Position: Left, Centered, Right.

6. Select the Page Footer check box to add a footer to each page of the Report.
◦ Specify the footer Text.
◦ Set the Position: Left, Centered, Right.

7. If you selected a Chart, click Next to go to the Add a Chart to the Report page.

8. If no Chart is included, click Finish.
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Add a Chart to the Report in the Report Wizard
The Add a Chart to the Report page in Report Wizard allows you to create a chart for the Report if you
selected a chart to include on the Set Report Title, Header, and Footer page.

To add a chart to the Report:

1. Select a Chart Type.

2. Specify the chart Title.

3. Specify the X-axis Title.

4. Select the X-axis Field. This is the Business Object Field that will be displayed along the X-axis.

5. Specify the Y-axis Title
6. Select the Y-axis Field. This is the Business Object Field that will be displayed along the Y-axis

Note: The values available for the Y-axis depend upon the argument for the X-axis. Some Y-
axis values are limited to values related to the X-axis argument selected so that the chart will
show meaningful data.

7. Click Finish to run the Report and open the Report Designer.

For information about modifying or adding charts to your Report after you run the Report Wizard, refer to
Working with Charts in Reports .
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Link an External Report to CSM Using the Report
Wizard

You can use the Report Wizard to link a Report created using an external tool, such as SQL Reporting
Services or Crystal Reports, to CSM. This enables the Report to be run from a Dashboard/Widget, a One-
Step, or the Reports Manager. Reports created using external tools must be edited with those tools;
however, as long as they remain in the same location, they do not require further maintenance in CSM.

Important: You must have SQL-level permissions to connection to the Crystal/SQL Database
before you can link to an external Report in CSM. CSM creates a shell with Fields and saves the
file so that it can be accessed through Crystal Reports/SQL Reporting Services, where the report
service pulls the data in and can be designed from Crystal/SQL designer.

To link to an external Report:

1. Open the Report Wizard.

2. Click Next.
3. Complete the following Report Wizard steps:

a. Select a Reporting tool: Select among Crystal Reports, SQL Reports, or Other to link to an
external Report.

b. Specify a Report Location: Select the location of the external Report and define a name and
description to use in Cherwell.

c. Click Finish to run the Report.
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Specify a Report Location in the Report Wizard
The Specify Location page of the Report Wizard allows you to link an external report to CSM by
specifying its location and giving it a name and description to use inside CSM. This step is omitted when
you are creating a new Report using the Cherwell Report Writer.

To specify the location of an external Report:

1. Provide a name and description for the Report.

2. Manually enter or browse to the location of the Report. Include the server name in the file path to
ensure the report can be accessed by all Users.

3. Click Finish to save the reference to the Report in CSM. Modify the Report as needed using the
tools selected.
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Designing Reports
At any point, you can use the Report Designer to modify the appearance or content of a Report.

To open the Report designer:

1. Open the Report Manager.

2. Right-click the Report you want to modify, and then select Design Report.

The following sections contain information about making common Report modifications in the Report
Designer.
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Opening the Report Designer
The Report Designer can be opened several ways:

• When you create a new Report from the Report Wizard, the Report Designer automatically opens.

• To modify an existing Report, from the Report Manager, right-click the Report, and then select
Design Report.
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Working with Bands in Reports
You can add and remove items in the bands to modify the content of a Report.

A selected band is highlighted in blue; unselected bands are gray in the Report Designer.

When a band is selected, you can:

• Reorder bands

Right-click a band and select Move Up or Move Down from the context menu.

• Resize a band

Hold your mouse cursor at the edge of the band until the sizing handles (vertical arrow) appear.
Click and drag the band to resize it.

• Modify the band appearance, behavior, data, design, and layout properties

Use the Properties Grid in the right pane. If this pane has been closed, right-click the band and
select Properties to reopen it.

• Perform tasks for a band

A smart tag  appears on the top border. Click the arrow to open a menu of tasks available for the
band.
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Adding Fields to a Report
A Field in a Report is a data item obtained from the Business Object selected when the Report is created.
Fields can come from the original Business Object, a related Business Object, or be calculated from
Business Object data.

You can add Fields to all Report bands and are represented by the Field icon ( ) in the upper right
corner.

Note: If you add a Field to the Report Header, it will show the value of that field for the first record
found in the data set.

To add Fields to a band in the Report Designer:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Locate the band in which you would like to add a Field.

3. Resize or drag the existing Fields to create space for the new Field.

4. From the Field List, locate the Business Object related to the Report, then expand the list of Fields.

5. Drag a Field from the Field List to the band. You can select Fields from the primary Business
Object and from its defined Relationships.

Note: If you select a Field unrelated to the Business Object, the data results will be empty.

Alternatively, you can drag a new Field on top of an existing Field; this will replace the Field's
contents while retaining the formatting of the original Field.

6. Click the smart tag  to view and edit the Field's properties.

Text

Holds label display text for Fields not bound to Data Fields. For example, the Report
Wizard creates labels for the Column band. Use the Text box to modify these labels.

When used in a Header or Footer band, enter the text label you want to appear in
the Report Output. For Fields in Detail bands, leave this Field blank to populate it
with Report data.

Data Binding Associates a CSM data Field to the label.

Format String
Click the ellipsis to access the Format String Editor. From here, you can select a
uniform format for all data in the Field to be displayed. Choose Date/Time, Number,
Percent, Currency, Special, or General.

Summary
Click the ellipsis to access the Summary Editor and add calculations, such as
counts, to your Report. For more information, refer to Adding a Count to a Report
Group.
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Angle Specifies an angle to rotate text to; this allows labels to be displayed diagonally,
which occupies less horizontal space bu more vertical space.

Bookmark Specifies a section of the Report to open when clicked (optional).

Parent
Bookmark Specifies the parent section of the Report (optional).

Formatting
Rules

Select this option to open the Formatting Rules Editor. From here, you can change
the appearance of result rows based on their contents.

Note: Formatting rules can be used to hide the band under certain
conditions.

Auto Width Enables automatic resizing of the Field depending on the contents of the Report
Details.

Can Grow Allows the Field to take up more space when output is generated, if necessary due to
data length.

Can Shrink Allows the Field to take up less space when output is generated, if possible due to
data length.

Multiline Allows Field to use more than one line.

Word Wrap Allows Field to continue to a new line without manually inserting a line break.

Tip: For more information, refer to Formatting a Field.
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Formatting a Field
The Report Wizard automatically adds labels to bands based on selections you make when you create
your Report. To modify these labels or add labels to new bands, use the Report Designer.

To add labels to Report bands:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Select a band.

3. From the Field List, drag one or more Fields to the band. For more information, refer to Adding
Fields to a Report .

4. Click the smart tag  at the top right corner of a Field.

5. From the Label Tasks window, select options to format your label. For example:
◦ Click the ellipses to the right of the Format String box, select the General tab, and then add a

Prefix for the Field. Example: add Category: to clearly indicate the Field's purpose.

◦ Change the angle to display the label vertically rather than horizontally.

◦ Click the ellipses to the right of the Summary box, and then add a calculation for the Field. Be
sure to select a Summary Running option that matches the band you add a summary to. For
example, if you add a Summary for a Group Header, select the Group option. This ensures
that the calculation applies to the selected band.
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Changing Styles for Bands
When the Cherwell Report Wizard creates a Report, it automatically sets the style for each Report band. If
you add additional bands to your Report in the Report Designer, you need to set their style by line.

To change the style settings of a Report in the Report Designer:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. In the Property Grid drop-down, select the band whose style needs to change.

3. Change the Style to the appropriate band type.
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The Detail Band has Even Style, Odd Style, and Style. If your style is set to have a different look for
even/odd rows, the EvenRowStyle and OddRowStyle is used. Otherwise, the RowDataStyle is used.

4. Click a row to open the drop-down menu to change the style.

For example, to change the Foreground Color, click the row, and then select a color in the drop-
down.

Changes in style in the Report Designer are made automatically upon selection, and you can see the
results as you make changes.
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Adding Relationships to Reports Using Detail
Report Bands

A Detail Report band is used within a Report to show data for related Business Objects. For example, if
you are creating a Report of recent Incidents, you can add a Detail Report band to show information on
the Tasks associated with the Incidents in the Report.

To add a Detail Report band to a Report:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Right-click in any white space in the Report.

3. Hover the cursor over Insert Detail Report.
4. Select the Relationship to include as a Detail Report.

5. From the Field List, expand the Relationship you used for the Detail Report.

6. Drag Fields relevant to the Relationship to your Detail Report band, and then format the Fields. For
more information, see Formatting a Field.

7. Select View>Preview and review your changes. This example shows a Task owned by the Incident.
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Changing the Visibility of a Band in a Report
A Report band can be set to visible or invisible. Invisible bands will not be printed or exported to output.

For example, you can make a band invisible to temporarily omit data from the Report output without
removing the content from the Designer. This is useful if you have not finished refining the contents of a
band but still want to generate a Report, or if a band is temporarily irrelevant to Report recipients.

To change the visibility of bands:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Select the band you want to make visible or invisible.

3. In the Property Grid, locate the Visible property under Behavior in the Property Grid.

4. Select Yes to make the band visible; select No to make it invisible.

CSM 9.3.0 Features 1160

CSM 9.3.0 Features



Modifying Page Number Properties
By default, Report page numbering is added to the bottom of each new Report.

The default format is to show the current page number and total number of pages, with pagination starting
at the first page of the Report (Page 1 of n). This is shown as Page {0} of {1}.

You can modify the page numbering properties as needed for your Report. For example, you can:

• Change the information you include in the Page Number area.

• Change the start page number.

• Modify page number format.

To modify Report page number properties:

1. In the Report Manager, right-click a Report, and then select Design Report.

2. Select the Page Number box at the bottom of the Report, and then click the smart tag  at the top
of the box.

3. Use the Page Info Task window to modify:
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Property Description

Page Information

Determines the data that is shown in the Page
Number area.

By default, Current of Total" Page Numbers is
selected. You can choose:

◦ None: Removes page numbering.

◦ Page Number: Show the current page
number only.

◦ Page Number (Roman, Lowercase)

◦ Page Number (Roman, Uppercase)

◦ Current Date and Time: Shows the current
date and time instead of a page number.

◦ User Name: shows the current machine
user instead of a page number.

Note: Depending on your selection, be
sure to also modify the format so it
matches the page information setting.

Start Page Number Determines the page used to start page count.

Format

Changes display properties. By default, Page is
set at the prefix and of {1} is set as the suffix.
Change the properties to match your Page
Information selection.

4. Use the Page Number property grid to modify additional page number settings, such as text
alignment, layout, and more.
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Working with Groups in Reports
The Report Designer uses Groups to organize Report Results. Groups also enable you to summarize
data for each Group.

For example, you can group results by Team ownership to show the number of Incidents owned by each
Team.
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Adding a Group Using the Report Designer
When you add a Group from the Report Wizard, certain elements are automatically added to your Group:

• Header with display labels set

• A Footer with display labels set

• A Count based on each Field you select for grouping (added to the footer)

When you add Groups through the Report Designer, you must manually add these items. You can also
use the Report Designer to modified the Group elements that are automatically added by the Report
Wizard.

The following steps explain how to use the Report Designer to add the elements that are automatically
provided by the Report Wizard.

To add a Group using the Report Designer:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Select the band to which you want to add a Group, and then click Add a Group.

3. From the list that opens, click the Field you want to Group results by.

Example: select Incident>Owned_by to group Incidents by their owner.

4. In the Group and Sort pane, select or clear the Show Header and Show Footer check boxes,
depending on your needs.

5. Use the Property Grid settings to format the Group Header band. This property is not shown in the
Report output, but changing it helps organize the Report in the Report Designer.

Example: In the Design area, change the name of the band to Owned_by.
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6. From the Field List in the right pane, select a Field for the group and drag it to the Group Header
band.

Example: Incident>Owned_by.

For more information, refer to Adding Fields to a Report .

7. Add a prefix to the Field. For more information, refer to Formatting a Field.

8. Use the Format toolbar to format the display Field as needed.

Example: change the font and font size.

9. Add a count to the Group, following the steps in Adding a Count to a Report Group.
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Adding a Count to a Report Group
You can use the Report Designer to create Counts for groups of results. For example, you can group
Incidents by Team ownership and then add a Count to calculate the number of Incidents owned per Team.

To add a Count to a Report Group:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. Select the band to add the Group to, and then click the Add a Group button.

3. From the list of Fields that opens, select the Field you want to Group results by.

Example: Select Owned_by_Team.

4. From the Field List pane, drag the Fields you want to display as labels on to the Group Header
band. Also, add the Field you want to use to count the number of results in the Group.

Example: Drag Owned_by_Team and Incident_ID to the Group Header band.

5. Click the smart tag.  that appears along the top of Field you want to use for your Count.

Example: Select the smart tag for Incident_ID.

6. In the Label Tasks window, click inside the Summary box, and then set the following options:

Option Description

Bound Field

Indicates the Field bound to the label. You can
change the Field as needed.

Example: Incident.Incident_ID.

Summary function Select Count.

Format String

Select the ellipses to open the FormatString
Editor so you can format your label.

Example: Select General, and then provide a
prefix, such as "Total: {0}." Notice the right pane
shows an preview of your label and data.
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Option Description

Ignore null values Select this check box to ignore empty values.

Summary Running

Choose to show the summary of results by:
◦ Page:

Shows the count by the number of results
per Report page.

◦ Group:

Shows the count by the number of results
for each Group.

◦ Report:

Shows the count by the number of results in
the entire Report.

◦ None

Hides the count.

Example: Select Group to show the number of
Incidents owned by each Team.

7. Click OK.
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Working with Charts in Reports
You can use the Report Designer to customize properties for the chart’s legend, argument axis (x-axis),
value axis (y-axis), data series, series labels, and diagram area at any time in the Report Designer. You
can also run the Chart Wizard, which allows for complex customization of data and appearance.

Unlike the Report Wizard, the Chart Wizard can be used to modify an existing chart.

Note:
Charts provide many options for displaying data in Reports. For more information about using
charts with the DevExpress® XtraReports Designer, refer to:

• The DevExpress® Documentation (free)

• The Creating Reports for Summary Analysis course available in the Cherwell Video Learning
Library (subscription-based).

Modifying Charts in the Report Designer
To modify an existing chart:

1. In the Report Manager, right-click a Report, and then select Design Report.

2. To update multiple elements, run the Chart Wizard. Select the chart, click the smart tag , and
then select Run Designer from the Chart Tasks page.

3. To update individual components, select the chart, and then use the Property Grids for each
individual component (legend, axis, labels, diagram, etc.).
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Adding a New Chart From the Report Designer
You can place charts in any band, but if you place a chart outside of the header or footer band, you must
add a script to switch from one group of data to the next. For more information, refer to Add Scripts to a
Report.

To add a new chart:

1. In the Report Manager, right-click a Report, and then select Design Report.
2. From the Control toolbar, drag the Chart icon to the title or footer band.

3. The Chart Wizard opens.

4. Use the Chart Wizard to create a chart. For example:
◦ Select the type of chart to display (bar, line, etc.).

◦ Define chart data.

◦ Define chart styling.

◦ Add titles and legends.
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Add Scripts to a Report
Advanced Users can use the Cherwell Script Wizard to run scripts on a Report for items that are not
included in the Report Designer interface.

There are currently seven scripts available in the Script Wizard:

• Change Field Color Based On Value: This script can be used to set the color of a Field show on
the Detail band, including related Fields. In addition, you can use operators such as Between,
Between Inclusive, Like, and Empty.

• Chart Shown on Detail Report - Limit to Detail Report Data: This script can be used to restrict
the data displayed in a chart on a Detail Report to that of the Detail Report group.

• Chart Shown On Group - Limit to Group Data: This script can be used to restrict the data
displayed in a chart on a Group Header or Footer to that of the Group Header/Footer instead of
using data from the entire Report.
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• Drill Down - Hide/Show Detail Report: This script can be used to show or hide the Detail Report
when clicking a particular Field on the Master Report, giving the appearance of drilling down into the
Detail Report from the Master Report.

• Drill Down - Hide/Show Particular Fields: This script can be used to show or hide particular Fields
on the Detail band when clicking the hyperlinked Field. For example, you can initially hide the
Description Field, and then show the Description Field upon clicking Incident_ID.

• (Advanced) Group Summary - Create a Custom Summary: This script can be used to create
three event handlers needed in order to implement custom summary functions.

• Group Summary - Show a Percentage: This script can be used to take the ratio of two Fields from
the Group Summary band and show them as a percentage. For example, if you have Total Incidents
and Incidents Reported by Phone, you can create a third Field that shows Percentage of Incidents
Reported by Phone.

Adding a Script Using the Script Wizard
Good to know:

• Scripts only show in the Script Wizard if the items they relate to are present in the Report. For
example, chart scripts only become available if there is a chart in the Group Header or Detail Report
band.

• Added scripts can be viewed in the Scripts tab.

To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer

2. In the Action toolbar, click the Scripts button.
The Script Wizard opens.

3. Select a script to add, and then click Next.
4. Define script properties:

a. Change Field Color Based on Value Script.

b. Chart Show on Detail Report - Limit to Detail Report Data Script.

c. Chart Shown on Group - Limit to Group Data Script.

d. Drill Down - Hide/Show Detail Report Script.

e. Drill Down - Hide/Show Particular Fields Script.

f. Group Summary - Show a Percentage Script.

5. Click Finish.5. 

Previewing a Script
To preview a Report script:

1. Add the script to the Report.

CSM 9.3.0 Features 1171

CSM 9.3.0 Features



2. In the View toolbar, click the Preview button to switch the view to Preview.
Results for the applied scripts show in the Report as the User has designed them.

CSM 9.3.0 Features 1172

CSM 9.3.0 Features



Change Field Color Based on Value Script
The Change Field Color Based on Value script can be used to set the color of a Field show on the Detail
band, including related Fields. For example, you can create a Change Field Color Based on Value script
that changes the Field color to orange so that Incidents with an In Progress status stand out.

Good to know:

• This script is only available for Fields in the Detail Report band. It is not available for Fields in a
Detail Report (example: This script is unavailable for a Detail Report on Journals owned by a
particular Incident; the script can only be run on the Detail band, meaning it can only be run for the
main Incident, not the Incident's Supporting Objects).

• Added scripts can be viewed in the Scripts tab.

To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer

2. In the Action toolbar, click the Scripts button.

The Script Wizard opens.
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3. Select the script, and then click Next.

The Change Field Color Based on Value properties window opens.

4. Define the following properties:
a. Band: The band of the Report housing the Field to run the script on (example: Detail_band is

the default Detail band available for this script).

b. Control name: The Field that the script runs on (example: Col4_Status is the Incident Status
field).

Beneath the Control Name drop-down, the Bound Field is described according to the control
selected. For example, if the control is Col4_Status, the bound Field is Incident.Status,
meaning the Status field is the one that the script runs on.

5. Click Add to add a Field to the Values list.

The Colors Based on Field Value window opens.

6. Select an Operator for the Field:
◦ Empty: Finds all instances in the Report where the Field value is empty.

◦ Equals: Finds all instances in the Report where the Field value equals the selected value.

◦ Like: Finds all instances in the Report where the Field value matches the selected value and
its wildcard (example: Jo% finds Joe, John, Jonathan, etc.).

◦ Not empty: Finds all instances in the Report where the Field value is not empty.

◦ Not equal: Finds all instances in the Report where the Field value does not equal the selected
value.

◦ Not like: Finds all instances in the Report where the Field value does not match the selected
value or its wildcards.

7. Define the value (example: "Status" Equals "In Progress").

8. Select a Text color.
9. Select a Background color.

10. Click OK.10. 

11. In the Script Wizard, click Finish.
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Chart Shown on Detail Report - Limit to Detail
Report Data Script

The Chart Shown on Detail Report - Limit to Detail Report Data script can be used to restrict the data
displayed in a Chart on a Detail Report to that of the Detail Report group.

Good to know:

• This script is only available for charts located in the Detail Report. Reports without a Detail Report or
a chart in the Detail Report will not have this script as an option in the Script Wizard.

• If there is only one Detail Report present, the band is automatically selected in the Script Wizard.

• If there is only one chart in the Detail Report, the chart is automatically selected in the Script Wizard.
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• Added scripts can be viewed in the Scripts tab.

To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer

2. In the Action toolbar, click the Scripts button.

The Script Wizard opens.

3. Select the script, and then click Next.

The Chart Shown on Detail Report properties window opens.

4. Define the following properties:
a. Detail Report: The specific Detail Report housing the chart to run the script on (example:

Incident_Owns_Journal_Detail_Report_Band is the Detail Report for Journals linked to
Incidents in the current Report).

b. Band within Detail Report: The specific band within the Detail Report housing the chart to run
the script on (example: Incident_Owns_Journals_Detail_Band2 is the Detail band of the Detail
Report containing the chart).

c. Chart: The chart the script runs on (example: chart 1 is the only available chart in the Detail
Report).

5. Click Finish.5. 

A notification window opens informing the User that the script has been added.
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Chart Shown on Group - Limit to Group Data Script
The Chart Shown on Group - Limit to Group Data script can be used to restrict the data displayed in a
chart on a Group Header or Footer to that of the Group instead of using data from the entire Report.

Good to know:

• This script is only available for charts located in the Group Header or Footer bands of the Report.
Reports without a chart in the Group Header or Footer bands do not have this script as an option in
the Script Wizard.

• If there is only one Group Header or Footer, the band is automatically selected in the Script Wizard.

• If there is only one chart in the Group Header or Footer, the chart is automatically selected in the
Script Wizard.

• Added scripts can be viewed in the Scripts tab.
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To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer.

2. In the Action toolbar, click the Scripts button.

The Script Wizard opens.

3. Select the script, and then click Next.

The Chart Show on Group properties window opens.

4. Define the following properties:
a. Band: The band of the Report housing the chart (example:

IncidentDurationInDaysRounded_Group_Header is the Group Header containing the chart).

b. Chart: The chart the script runs on (example: chart2 being the only chart available in the
Group Header band).

5. Click Finish.5. 

A notification window opens informing the User that the script has been added.
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Drill Down - Hide/Show Detail Report Script
The Drill Down - Hide/Show Detail Report script can be used to show or hide the Detail Report when
clicking a particular Field on the Master Report, giving the appearance of drilling down into the Detail
Report from that Field. Users can click Fields with hyperlinks to open the Detail Report related to that
Field.

Good to know:
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• This script is only available for Reports that have a Detail Report (a Report featuring linked Major or
Supporting Business Objects) (example: An Incident with Journals Report, Journals being the
Supporting Object).

• Added scripts can be viewed in the Scripts tab.

To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer

2. In the Action toolbar, click the Scripts button.

The Script Wizard opens.

3. Select the script, and then click Next.

The Drill Down - Hide/Show Detail Report properties window opens.

4. Select the Master band (the band that the Field resides in, example: Detail_Band).

5. Select the Hyperlink Field from the drop-down (example: Incident ID).

6. Select the Detail Report to expand when the hyperlinked Field is clicked (if you have more than
one Detail Report).

7. Click Finish.7. 

A notification window opens informing the User that the script has been added.
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Drill Down - Hide/Show Particular Fields Script
The Drill Down - Hide/Show Particular Fields script can be used to show or hide particular Fields on the
Detail band when clicking the hyperlinked Field. For example, you can initially hide the Created Date Time
field until you click the Incident Duration in Days field to get an exact time frame for the Incident's
duration.

Good to know:

• This script is only available when there is more than one Field present in the Report.
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• If there are multiple entries in a group (example: Report Fields are grouped by Incident Duration in
Days), clicking the hyperlinked Field to show/hide another Field shows/hides those Fields for the
grouping, not just the one hyperlinked Field (example: Clicking Incident Duration in Days in a
grouping that has three Incidents shows the Created Date Time for all Incidents in that grouping).

• Added scripts can be viewed in the Scripts tab.

To add a script to a Report using the Script Wizard:

1. Open a Report in the Report Designer.

2. In the Action toolbar, click the Scripts button.

The Script Wizard opens.

3. Select the script, and then click Next.

The Drill Down Fields Report script properties window opens.

4. Select the Detail Band (the band that the Field resides in).

5. Select the Hyperlinked Field from the drop-down (example: Incident Duration in Days).

6. Select the Fields to expand when the hyperlinked Field is clicked check boxes (example:
Created Date Time).

Note: Users can click multiple check boxes in this list.

7. Click Finish.7. 

A notification window opens informing the User that the script has been added.
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Generating Reports
The following methods can be used to generate Report output:
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Running Reports
Reports can be run from the following locations:

• Run a Report Using the Report Manager

• Run a Report Using Dashboards

• Run a Report Using a One-Step

You can also access a Report you have recently run directly from the Tools>Reports> (Report Name)
menu.

Note: Reports that take over 60 minutes to process will generate an error and fail to complete. In
Reports created using CSM 8.2 and later, Rich Text Fields are omitted, which decreases memory
use and processing time. Rich Text Fields are not normally used in Reports. However, this option
must be manually disabled in Report Properties for Reports created prior to CSM 8.2. For more
information, see Editing Report Properties. Additionally, If a Report is set to return Rich Text
Fields, a warning is logged. These log entries are useful for identifying which Reports have run
with the Retrieve Rich Text Fields option enabled without manually checking the Report
Properties. For information on event logging, see Configure Logging for a CSM Server or Web
Application.
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Run a Report from the Report Manager
To run a Report from the Report Manager in CSM Desktop Client:

1. Open the Report Manager.

2. Select the Report you want to run.

3. Right-click the Report and select one of the following options:
a. Run: Runs the Report and opens the Preview window. Alternatively, double-click the Report.

b. Run Special: Run Special is only available if you open the Report Manager when you have
Search Group Results or a single record open. You can then:

◦ Run for current record: Run the Report using only the data in the record currently open
in CSM.

◦ Run for current group: Run the Report using only the data in the Search Group
currently open in CSM.
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Run a Report from a Dashboard
Reports can be run through command-driven Widgets (such as the Command Palette or a Standard
Widget using a Link Action) located on a Dashboard.

To run a Report using an existing Dashboard:

1. Open a Dashboard.

2. Click a Link Widget containing an Action that opens a Report.

The Report Preview window opens.

The example below uses the OOTB Global IT Dashboard. Select Reporting from the left column,
then click the Problem Metrics from the list of Reports on the right to run the Problem Metrics
report.
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Run a Report from a One-Step
You can create a One-Step using the Run a Report Action to run a CSM Report. For example, this One-
Step could then be added to an Automation Process to periodically run a Report of all open Incidents
assigned to a specific User.

To define a Run a Report Action for a One-Step:

1. Open the One-Step Editor.

2. Add a Run a Report Action to the Designer Board.

3. Define properties for the Run a Report Action as follows:
a. Name: Provide a display name for the Action. This is how the Action will be identified within

CSM.

b. Report: Click the Ellipses button  to open the Report Manager, and then select a Report to
run.

c. Data: In the drop-down, select the data to use for the Report:

Data Source Action

Use Report Criteria
Run the Report exactly as designed
(example: against a particular Search
Group).

Current Record
Run the Report against the active record
(the single record selected in CSM before
running the One-Step).
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Data Source Action

Current Group

Run the Report against the current group
of records. For example, run a Quick
Search for all Incidents containing the
word "print," and then execute the One-
Step. The search results become the data
for the Report.

4. Select an output option:

Output Output Specific Options
Print

Choose a connected printer from the drop-
down.
Click Settings to open Print Options and
define the number of copies to print and
whether or not to collate them.

Write to File
Enter a filename; click the Selector button

 to insert Tokens (example: Fields,
System Functions, Prompts, Expressions,
Stored Values, Metrics, and Counters)
directly into the filename.

or

Click the Browse button to open the Select
File window and select an existing file.

Note: If an existing filename is entered or
selected, running the One-Step will overwrite
the existing file. If a new file name is entered,
a new file will be created.
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Output Output Specific Options

Select a file format from the Format drop-
down. The following formats are supported:

◦ Adobe PDF

◦ Bitmap

◦ CSV

◦ EMF

◦ Excel

◦ HTML

◦ JPEG

◦ Plain Text

◦ PNG

◦ Rich Text

◦ TIFF

5. Click Save .
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Previewing Reports
Reports open in the Report Preview window when they are run in any of the following ways:

Run a Report Using the Reports Menu

Run a Report Using Dashboards

Run a Report Using a One-Step

From the Report Preview, you can Print a Report, Export a Report, or send a Report by e-mail.
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Printing Reports
There are several ways to print a Report:
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Print a Report from the Report Manager
To print a Report from the Report Manager:

1. Open the Report Manager.

2. Select the Report you want to print.

3. Right-click, and then select Print.
4. Define the device or program to use to print the Report.

Print a Report from Search Group Results
You can apply a Report to Search Group results, and then print those results.

To print a Report from Search Group results:

1. Open the Search Group Manager.

2. Run a Search Group.

3. With the results displayed, open the Report Manager.

4. Select a Report, and then right-click.

5. Choose how to print the a Report :
◦ Print for current record: Print the Report using only the data in the record currently selected

or open in CSM.

◦ Print for current group: Print the Report using only the data in the Search Group currently
open in CSM.
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Print a Report from the Report Preview
To print a Report from the Report Preview window:

1. Open the Report Preview window.

2. Select one of the following options from the File menu or the Preview toolbar:
a. Print...: Opens the Print window, where you can select a printer, number of copies, page

range, and paper source or file path (if printing to a file).

b. Quick Print: Sends the Report directly to the default printer or program.
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Print a Report from a Business Object Record
To print a Report from a Business Object:

1. Open the Business Object record.

2. Click File>Print.

The Print window opens.

3. Select the Printer to use.

Note: Print Options for a Business Object need to be configured in CSM Administrator.

4. Select the Report (example: Memo Style - Incident) you want to print.

5. Specify the number of copies to print.

6. Optionally, select the Run for group check box to run the Report for the Search Group defined in
the Report rather than limiting it to the single Business Object from which you accessed it.

7. Click OK.
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Exporting Reports
You can export Reports from the Report Manager or the Report Designer.

Reports can be exported to the following file formats:

Report Tool Export Formats

Report Manager

See Export a Report from the Report Manager.

• CED (Cherwell export) - From File menu only.

• CSV

• Excel XML

• HTML

• Images (Bitmap, EMF, JPEG, PNG, TIFF)

• PDF

• RTF

• Text file

• XML

Report Designer (Preview mode)

See Export a Report from the Report Designer

• PDF

• HTML

• MHT

• RTF

• XSL

• XSLX

• CSV

• Text

• Image
◦ BMP

◦ EMF

◦ WMF

◦ GIF

◦ JPEG

◦ TIFF
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Export a Report from the Report Manager
To export a Report as a .CED (Cherwell export) file:

1. Open the Report Manager.

2. Select the Report you want to export.

3. From the File menu, select Export...
4. Enter a File name for the Report.

5. Click Save.

To export a Report from the Report Manager as any other file type (PDF, HTML, MHT, RTF, XLS,
XLSX, CSV, TXT, or Image):

1. Open the Report Manager.

2. Select the Report you want to export.

3. From the Reports menu, select Export To, then select the file type you want to export the Report
as.

4. Enter a File name new for the Report.

5. Click Save.
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Export a Report from the Report Designer
To export a Report from the Report Preview:

1. Open the Report Manager.

2. Double-click the Report you want to export.

The Report runs and automatically opens in the Report Preview window.

3. Select File>Export Document..., then select an export format.

The Export Options window opens (PDF Export Options are shown below).

4. Define the Export Options for the document.

Note: The Export Options available are different for each exported file type.

5. Click OK.
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Scheduling a Report
Reports can be set to run on a regular, scheduled basis using the Scheduler in the CSM Administrator. To
schedule a Report, you must create a new scheduled item using the Report action.

To schedule a Report:

• See Create a Scheduled Item for information on creating a new scheduled item.

• When you Define Action Properties for a Scheduled Item, select the Report action.

• See Define Report Action Options for more information on defining action options for a scheduled
Report.
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Managing Reports
Reports are created, modified, deleted, and organized in the Report Manager.

Use the Report Manager to complete general CSM Item Manager operations for Reports, including:

• Run a Report

• Create a Report

• Manage Report Styles

• Change or Create Report Styles

• Edit a Report

• Delete a Report

• Search for a Report

• Organize Reports

• Copy a Report

• Import/export a Report

• Find Report dependencies

• Pin a Report.
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Editing Report Properties
Use the Report Manager to edit existing Reports and their properties, including name, description, data
source, and Calculated Fields.

1. Right-click the Report you want to edit in the Report Manager.
2. Select Edit Report Properties.

The Report Properties window opens.
3. Edit the properties as follows:

Option Description

Name Provide a display name to use within CSM.

Description Provide a description to use within CSM.

Retrieve Rich Text Fields Select whether or not to retrieve HTML
subfields with the Report data. Default CSM
Reports do not use the information in these
subfields; disabling this option results in
faster performance.

Data Identify the data source for the Report. For
best results, select a Search Group. Using a
Search Group limits Report data to a specific
set of information, resulting in faster
performance and a more precise Report than
using all records. For more information about
Search Groups, see About Search Groups.

Report Culture Select the culture for the Report. In most
cases, this is set to the primary culture for
your system. You can choose a different
culture if Globalization is enabled for your
system and translations are available for the
definitions used by the Report. For more
information, see Using Reports with Multiple
Cultures.

Calculated Fields Create, modify, or delete Calculated Fields
included in the Report. For more information,
refer to Adding Calculated Fields from the
Report Manager.

For more information about Calculated Fields,
see About Search Groups.
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Opening the Report Manager
There are several ways to open the Report Manager:

• From the CSM Desktop Client menu bar, click Tools>Reports>Report Manager.
• From the CSM Browser Client menu bar, click Reports>Report Manager.
• From the stand-alone Report Runner outside of CSM.
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Report Styles Manager
Use the Report Styles Manager to complete general CSM Item Manager operations for Report Styles.

There are several ways to open the Report Styles Manager:

• In the Report Manager, click Reports>Report Styles from the menu bar.

• While running the Cherwell Report Wizard, on the Set Report Title, Header and Footer page, click

the Ellipses button  to the right of the Report style drop-down menu.

CSM 9.3.0 Features 1203

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Freporting%2F..%2Fitem_managers%2Fcsm_item_manager_main_window_-typical-.html


About Report Styles
A Report Style is use to set fonts, colors, borders, and text alignment for the different areas of a Report
including the title, page header and footer, group header and footer, table column headers, data rows,
Detail Reports, and charts. A Report Style can be defined once, then applied to existing or new Reports to
create a consistent look and feel for a set of individually generated Reports.

An existing Report Style can also be modified once to affect all Reports that use that style. Cherwell
Service Management comes with the following pre-defined Report Styles:

• A Touch of Red

• Black and White

• Blue and Gray

• Blue and Red

• Shades of Blue

• Table - Even and Odd Rows

• Table Style

You can customize these styles and create additional styles using the Report Styles Manager.
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Report Styles Good to Know
• The Style Name is shown at the top of all the Report Style options pages. You can rename the style

on any of these pages.

• The General page opens by default in the Report Styles window.
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Define Report Styles Using the Report Styles
Manager

Use Report Styles to define the following properties:

• General Options: Report Title and Title band font, alignment, color, and lines.

• Page Options: Page Header and Page Footer font, alignment, color, and lines.

• Group Options: Group Header and Group Footer font, alignment, color, and lines.

• Column Headers: Column Header band font, alignment, color, and lines.

• Data Options: Detail band (data row) font, alignment, color, lines, and alternating rows.

• Detail Reports: Group Header and Group Footer font, alignment, color, and lines for Detail Reports
within a Report.

• Charts: Chart font, colors, borders, and legend.

To open the Report Styles properties Window:

1. Open the Report Styles Manager.

2. Select one of the following:
◦ Select File>New to create a new Report Style.

◦ Select a Report Style, right-click, then select Edit to modify an existing Report Style.

The Report Style window opens.
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Modify the Report Style as described in the following sections. You can preview the Report Style at
any time using the View Style, View Master/Detail Style, and View Style with chart buttons in the
lower left.
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Define General Options for Report Styles
Use the General page to define the Report Style name and the font, color, and line rule options for the
Report Title as follows:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click the General page.

3. Enter a Style name (example: Blue and Red). The Style Name is used to identify the Report Style in
the Report Styles Manager.

4. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)

◦ Font style (bold, bold italic, italic, regular)

5. Define the Alignment and Color settings:
◦ Text alignment (vertical and horizontal)

◦ Text color
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◦ Background color (the color that appears behind the text in the title only)

6. Select the Draw lines check box if you want to add lines around the title:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

7. Click OK to save and close the Report Style, or proceed to Page options.
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Define Page Options for Report Styles
Use the Report Style Page Options page to define the following:

• Page Header: Font, text alignment, color, and lines of the Page Header band.

• Page Footer: Font, text alignment, color, and lines of the Page Footer band.

To define the Page Header and Footer options for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click Page Options in the Report Styles window.

3. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)

◦ Font style (bold, bold italic, italic, regular)

4. Define the Alignment and Color settings:
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◦ Text alignment (vertical and horizontal)

◦ Text color

◦ Background color (the color that appears behind the text in the title only)

5. Select the Draw lines check box if you want to add lines:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

6. Click OK to save and close the Report Style, or proceed to Group Options.
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Define Group Options for Report Styles
Groups are used to organize and display data into sections to make Reports easier to read. Each Group
of data is displayed with a Group Header band and Group Footer band. Use the Report Style Group
Options to define the following:

• Group Header: Font, text alignment, color, and lines of the Group Header band.

• Group Footer: Font, text alignment, color, and lines of the Group Footer band.

To define the Group Header and Footer options for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click Group Options in the Report Styles window.

3. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)

◦ Font style (bold, bold italic, italic, regular)
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4. Define the Alignment and Color settings:
◦ Text alignment (vertical and horizontal)

◦ Text color

◦ Background color (the color that appears behind the text in the title only)

5. Select the Draw lines check box if you want to add lines:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

6. Click OK to save and close the Report Style, or proceed to Column Headers.

CSM 9.3.0 Features 1213

CSM 9.3.0 Features



Define Column Headers for Report Styles
Use the Column Headers page to define the following:

• Font: Font type, size, and style of the Column Header band of the Report.

• Alignment and Color: Text alignment, color, and background color of the band.

• (Optional) Draw Lines: Add lines to the band.

To define the Column Headers options for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a Report Style.

2. Click Column Headers in the Report Styles window.

3. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)

◦ Font style (bold, bold italic, italic, regular)
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4. Define the Alignment and Color settings:
◦ Text alignment (vertical and horizontal)

◦ Text color

◦ Background color (the color that appears behind the text in the title only)

5. Select the Draw lines check box if you want to add lines:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

6. Click OK to save and close the Report Style, or proceed to Data Options.
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Define Data Options for Report Styles
Use the Data Options page to define the following properties of the data elements displayed in a Report:

• Font: Font type, size, and style of the data rows in the Detail band of the Report.

• Alignment and Color: Text alignment, color, and background color of the band.

• (Optional) Draw Lines: Add lines to the band.

• Use alternating rows: Option for applying different text and color formatting to even and odd rows
within a table.

To define the Data Options for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click Data Options in the Report Styles window.

3. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

CSM 9.3.0 Features 1216

CSM 9.3.0 Features



◦ Font size (example: 22)

◦ Font style (bold, bold italic, italic, regular)

4. Define the Alignment and Color settings:
◦ Text alignment (vertical and horizontal)

◦ Text color

◦ Background color (the color that appears behind the text in the title only)

5. Select the Draw lines check box if you want to add lines:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

6. Select the Use alternating rows check box to alternate data row styles (example: Odd rows have
no color while even rows are blue).

Use this check box to define Alignment, Color, and Line settings for even-numbered rows.

7. Click OK to save and close the Report Style, or proceed to Detail Report Options.
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Define Detail Report Options for Report Styles
Detail Reports are used within Reports to show data for related Business Objects. For example, if you are
creating a Report of recent Incidents, you can add a Detail Report to show information on the Journals
associated with the Incidents in the Report. Use the Detail Report options to define the following.

• Column header font, alignment, color, and lines

• Data font, text alignment, color, and lines of the Group Header band of the Report.

To define the Detail Report options for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click Group Options in the Report Styles window.

For both the Column Header and Data, define the following:

3. Font settings:
◦ Font type (example: Microsoft Sans Serif)
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◦ Font size (example: 22)

◦ Font style (bold, bold italic, italic, regular)

4. Alignment and Color settings:
◦ Text alignment (vertical and horizontal)

◦ Text color

◦ Background color (the color that appears behind the text in the title only)

5. Select the Draw lines check box if you want to add lines:
◦ Select where to place lines using the Top, Bottom, Left, and or Right check boxes.

◦ Enter a Line width to set the thickness of the lines (all lines, Top, Bottom, Left, and/or Right,
will be the same width).

◦ Click the Line color drop-down to define the line color.

6. Click View Master/Detail Style to preview an example Report using a Detail Report at any time.

7. Click OK to save and close the Report Style, or proceed to Column Headers.
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Define Chart Options for Report Styles
Use the Charts page to define the following properties of charts used within the Report:

• Font: Font type, size, and style.

• Colors: Text color, background color, and color palette.

• Chart has Border: Border color and width.

• Chart Legend: Font type, size, style, alignment, and text color.

To define the chart properties for Report Styles:

1. Open the Report Style Window to edit a Report Style or create a New Report Style.

2. Click Charts in the Report Styles window.

3. Define the Font settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 22)
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◦ Font style (bold, bold italic, italic, regular)

4. Define the Color settings:
◦ Text color

◦ Background color for the chart

◦ Palette: There are many color palette choices in the Palette drop-down menu. When you
select a specific palette, the colors are shown to the right of the drop-down menu.

5. Select the Chart has borders check box to add a border to the chart, then:
◦ Define the Border color.

◦ Define the Border width by specifying a number or clicking the incremental arrows  to
change the border width value.

6. Define the Chart Legend settings:
◦ Font type (example: Microsoft Sans Serif)

◦ Font size (example: 10)

◦ Font style (bold, bold italic, italic, regular)

◦ Legend's vertical and horizontal alignment (middle, bottom, and top right, left, and centered)

◦ Text color

7. Click View Style with chart to preview an example Report containing a chart at any time.

8. Click OK to save and close the Report Style.
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Preview a Report Style From the Report Styles
Manager

You can use the Report Styles Manager to preview a Report Style before applying it to a Report.

To preview a Report Style:

1. Open the Report Styles Manager.

2. Right-click the Report Style you want to preview.

3. Click Edit.
4. Select a way to preview the Report Style from the bottom left of the Report Style window:

a. View Style: preview Style in a sample Report

b. View Master/Detail Style: preview Style in a sample Report including a Detail Report

c. View Style with Chart: preview Style in a sample Report including a Chart
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Apply a Report Style to a Report
Report Styles can be changed for individual Reports in the Report Manager.

To change the Report Style applied to a Report:

1. Open the Report Manager.

2. Right-click a Report.
3. From the context menu, click Change Report Style, then select a style.

CSM 9.3.0 Features 1223

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=open_the_report_manager


Delete a Report Style
To delete a Report Style using the Report Styles Manager:

1. Open the Report Styles Manager.

2. Select the Report Style you want to delete.

3. Click the Delete icon  on the menu bar, or right-click and select Delete.

4. Click Yes to confirm the deletion, No to cancel, or Find Dependencies to get a list of CSM items
currently using the Report Style.
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Configuring Reports
Complete the following procedures to configure Reports.

To configure Reports:

• Configure Reports security rights: Configure who can access Report functionality.

• Define Print options for a Business Object: Define which printer the Report goes to as well as the
default Report style.

• Define Calculated Fields for Reports: Determine the best option for adding Calculated Fields to a
Report.
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Defining Calculated Fields for a Report
Calculated Fields enable you to calculate values based on the data in each row.

There are multiple ways to create Calculated Fields. After you create a Calculated Field, you can add it to
any band in the Report.

Method Benefits

Using the Report Wizard

Using the Report Manager

• With the Report Wizard, a Calculated Field is
added at Report creation. You can use the
Report Manager to add a Calculated Field
later.

• Uses a new or existing CSM Expression. This
enables you to reference CSM data, such as
Calendars used by Date/Time Expressions.

• The Report engine treats these Fields as
database Fields without having to add a new
Field to the Business Object.

• Calculated data is accurate at the time of
Report Generation.

Using the Report Designer
• Add Calculated Fields to existing Reports.

• Perform mathematical equations that do not
use CSM Expressions.

Adding a pre-defined, stored CSM Field to your
Report.
To do this:

1. Create a Blueprint.

2. Edit the Business Object, and add a Field.

3. Set calculated value on the Field Properties
page.

4. On the Advanced page, clear the Stored in
database and Recalculate after load check
boxes.

• Use the same Calculated Field in multiple
Reports and for other CSM features.

• Calculations on individual records in the Report
are only updated each time a record is saved.

Adding Calculated Fields from the Report Manager
To add a Calculated Field using the Report Manager:

1. Open the Report Manager.

2. Select a Report, right-click, and then select Edit Report Properties.
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3. Click Calculated Fields.

4. Follow these steps:
a. Click Add.

b. Specify a Name for the Calculated Field. Note that names cannot contain spaces.

c. Select the Business Object to associate with the Calculated Field.

d. From the Data Type drop-down list, select one of the four data types recognized by the Report
Designer:

◦ Date/Time:
A Date/Time data type allows you to build an Expression to perform date/time
calculations (example: Calculate a fifteen minute warning for an SLA).

◦ Logical:
A Logical data type allows you to build an Expression to use one or more conditions to
return a true or false value (example: Incident.Status does not equal Closed).

◦ Number:
A Number data type allows you to build an Expression to perform mathematical
calculations using a string of Fields and mathematical symbols (example: Calculate the
total cost of a Labor Cost Item by multiplying the work hours by the monetary rate).

◦ Text:
A Text data type allows you to build an Expression to display a string of Tokens and text
(example: Return either "Open" or "Closed," depending on the status of a record).

e. Select the Expression:
◦ Stored Expression:

Click the Ellipses button to select an existing Cherwell Expression. See About
Expressions for more on Expressions.

◦ Custom Expression:
Click the Expression button to create a custom Expression. For more information, see
the Define Expression topic for the Data Type selected:

◦ Date/Time

◦ Logical

◦ Number

◦ Text
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Creating Expressions in the Report Designer
To create expressions for Calculated Fields in the Report Designer:

1. Right-click on the Field List, and then select Add Calculated Field.

2. Select the Calculated Field from the Properties Grid.

3. Click the Ellipses in the Expression box to open the Expression Editor.
4. Use the left column to select a category of available inputs and operations, shown below.

Category Contains

Functions

A list of functions that can be applied to the expression. Select a type (All,
Aggregate, Date-Time, Logical, Math, or String) from the drop down to
limit the functions listed. When using a function, you must supply the
Fields, Parameters, or Constants it requires (example follows).

Operators A list of simple mathematical operands that can be used to manipulate
and compare values.

Fields The Fields (variables) available in the Report, acquired from the Report
Business Object.

Constants True, False, and null values that can be manually added to the
expression that will always stay the same.

Parameters
Variables that represent the values entered by the User when Report is
run. Not present in Reports that do not require Parameters each time they
are run.

5. Select a category, and then select an input from the middle column. A description of the input or
operation appears in the right column. When a function is selected, the values it requires and a
description of what will be returned is displayed.

6. Double-click an input to add it to the expression.

7. Basic operations can also be selected from the bar below the main text box.
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Adding Calculated Fields from the Report Manager
To add a Calculated Field using the Report Manager:

1. Open the Report Manager.

2. Select a Report, right-click, and then select Edit Report Properties.

3. Click Calculated Fields.

4. Follow these steps:
a. Click Add.

b. Specify a Name for the Calculated Field. Note that names cannot contain spaces.

c. Select the Business Object to associate with the Calculated Field.

d. From the Data Type drop-down list, select one of the four data types recognized by the Report
Designer:

◦ Date/Time:

A Date/Time data type allows you to build an Expression to perform date/time
calculations (example: Calculate a fifteen minute warning for an SLA).

◦ Logical:

A Logical data type allows you to build an Expression to use one or more conditions to
return a true or false value (example: Incident.Status does not equal Closed).

◦ Number:

A Number data type allows you to build an Expression to perform mathematical
calculations using a string of Fields and mathematical symbols (example: Calculate the
total cost of a Labor Cost Item by multiplying the work hours by the monetary rate).

◦ Text:

A Text data type allows you to build an Expression to display a string of Tokens and text
(example: Return either "Open" or "Closed," depending on the status of a record).

e. Select the Expression:
◦ Stored Expression:

Click the Ellipses button to select an existing Cherwell Expression. See About
Expressions for more on Expressions.

◦ Custom Expression:
Click the Expression button to create a custom Expression. For more information, see
the Define Expression topic for the Data Type selected:

◦ Date/Time

◦ Logical

◦ Number
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◦ Text
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Rich Text
Rich Text is a capability that enables capturing and storing data with embedded images and text
formatting. Formatting capabilities include different fonts, font sizes, styles (bold, italics, underline), and
colors. Some page formatting is also supported, including line spacing and indentation.
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About Rich Text
Use Rich Text in the following areas:

• Large text Fields in Business Object Records (example: Description field in an Incident) and
Journals: Provide and format text and insert images into Fields using Rich Text options in the
Desktop Client, Browser Client, or Portal.

• Knowledge Articles: Create or import Knowledge Articles with embedded screenshots, numbered
lists, and other Rich Text formatting.

• One-Steps: Embed Rich Text Fields in One-Steps.

• E-mail Messages: Use the E-mail and Event Monitor and Outlook Integration Manager to
automatically import Rich Text from e-mails into Rich Text-enabled Fields in CSM Business Objects.
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Rich Text Good to Know
• The default font selected in the Global Rich Text settings applies to all Rich Text Fields that do not

have a default font specified in Field Properties. However, if a default font was selected in the Field
Properties for a specific Field in a Business Object (example: Resolution fields in Problems), it
overrides the default font selected in the Global Rich Text settings.

• The default font selected in Global Rich Text settings overrides any font selections made in the Form
Editor during Form design.

• The maximum size of a Rich Text Field is 4 gigabytes (or 2 gigabytes with Unicode, which supports
double byte languages, such as Chinese). The images are also stored in the Field, with adjustable
size limits as shown below, so the actual size of the data includes the size of images plus the size of
all marked up text. In the database, two Fields (each 4 gigabytes) are actually created, one for the
plain text version of the Field and one for the HTML (Rich Text) version.
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Using Rich Text
You can use Rich Text in:

• Business Object Fields

• Knowledge Articles

• One-Steps that use Rich Text Fields

• E-mails
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Use Rich Text in Business Object Fields
In a Rich Text-enabled Field in a Business Object (example: Incident Description), you can provide and
format text and insert images using Rich Text options.

Good to know:

• To accommodate Rich Text and save space, consider combining some Fields in your Form design
(example: Combine the Description and Solution/Workaround fields in a Knowledge Article).

• If you copy/paste fully formatted Rich Text into a Business Object Field in the Desktop Client, it
might render differently in the Browser Client. For best results, remove the formatting from the
copied text and paste it into the Field as plain text. Then, you can apply formatting using the Rich
Text Editor in CSM.

• Images inserted into Rich Text Fields in the Desktop Client will show up in the Browser Client and
Portal, and vice versa.

To access and use Rich Text:

1. (Desktop Client) Click in a Rich Text Field, and then press F8.

Tip: You can also access the Rich Text Zoom window by right-clicking and selecting Zoom,
or by clicking the Zoom button.

2. (Browser Client and Portal) Click in a Rich Text field, and then click the Toggle Toolbar button.

3. Format text using either the formatting options in the Rich Text Zoom window (Desktop Client), or in
the Rich Text Editor (Browser Client and Portal).

4. Insert hyperlinks:
a. (Desktop Client) Right-click the Rich Text Field or Rich Text Zoom window, and then click

Insert Hyperlink.

Tip: You can also click Insert>Hyperlink from the Rich Text Zoom window menu bar.

b. (Browser Client and Portal) Click the Insert Hyperlink button in the Rich Text Editor.

c. Provide the hyperlink in the popup window.

Tip: In the Browser Client and Portal, you can provide text and a tooltip for the hyperlink. The
text is a name for the hyperlink that shows as linked text instead of the URL, and the tooltip is
a word or phrase that shows when the mouse pointer hovers over the hyperlink. Select Open
Link in New Window to open a separate window when you click on the link.

d. Click OK or Insert.

The hyperlink is inserted into the Rich Text Field.

Tip: You can also copy/paste hyperlinks directly into Rich Text Fields.
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5. Insert images:
a. (Desktop Client) Right-click the Rich Text Field or Rich Text Zoom window, and then select

Images>Open Image.

Tip: You can also click Insert>Picture from the Rich Text Zoom window menu bar.

b. (Browser Client and Portal) Click the Insert Image button on the Rich Text toolbar.

c. Browse to the location of the image you want to insert, select the file, and then click Open.

The image is inserted into the Field at the current cursor position, in the default image format
(JPEG or PNG) configured in the Global Rich Text settings in CSM Administrator.

Tip: In the Desktop Client, you can copy images onto the clipboard (Right-click>Copy
or CTRL+C) and paste them into Rich Text Fields (Right-click>Paste or CTRL+V).
(Copy/paste does not work in the Browser Client or Portal.)

6. Resize images:
◦ (Desktop Client) To resize a single image, right-click the image in a Rich Text Field, and then

select one of the following options from the Images category in the context menu:
◦ Full-size Image: Select this option to resize the image to its full size.

◦ Thumbnail Image: Select this option to resize the image to the default thumbnail size
configured in CSM Administrator (the default size is displayed in parentheses next to the
menu selection).

◦ (Desktop Client) To resize all images in a Rich Text-enabled Field, select one of the following
options from the Images category in the context menu:

◦ Resize All Images: Select this option to open a sub-menu, and then resize images to
either Thumbnail Images (default thumbnail size) or Full-Size Images.

◦ Default Image Size: Select this option to open a sub-menu, and then select to size
images as small thumbnails, medium thumbnails, large thumbnails, or full-size images.

Note: You can only set the default image size if the option was enabled in CSM
Administrator (Allow User to Override Image Display Mode is selected in Field
Properties). Selecting a default image size sets the default way that images are
displayed in all Fields of the same type for a particular Business Object (example: if you
select small thumbnails as the default image size for an image in an Incident
Description field, all images in all Incident Description fields will be sized as small
thumbnails).

◦ (Browser Client and Portal) In the Rich Text Editor for a Business Object Field, select an
image, and then click the Insert Image button.

◦ Image Settings window: Select a radio button to resize the image to a small thumbnail,
medium thumbnail, large thumbnail, or full-size image.

◦ Click Save.

Note: In the Browser Client and Portal, there is no option to resize all images in a Rich
Text-enabled Field. You can only resize one image at a time.
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7. View images in a separate window.
◦ (Desktop Client) Double-click an image to open it in the software associated with the file

extension (example: If the image is a JPEG file, it will open in the image viewer that is
associated with JPEG files on the User's computer).

Tip: You can also click Open Image in External Viewer from the Images category in the
context menu.

◦ (Browser Client and Portal) In the Rich Text Editor for a Business Object Field, select an
image, and then click the Insert Image button. Click the Open Image in New Tab link to open
the image in a new tab in your browser.

8. Click OK in the Rich Text Zoom window (Desktop Client) or Rich Text Editor (Browser or Portal
Client) to save your formatting changes.
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Use Rich Text in Knowledge Articles
You can create or import Knowledge Articles with embedded screenshots, numbered lists, and other Rich
Text formatting. To accommodate Rich Text and save space, consider combining some Fields in the
Knowledge Article Form design (example: Combine the Description and Solution/Workaround fields).

Like in other Business Object Fields, you can open Knowledge Article Rich Text Fields in the Rich Text
Zoom window (click the Zoom button, press F8, or right-click>Zoom).

Note: As part of the CSM Embedded Forms functionality, you can use radio buttons to toggle
between a simple KA Form (with combined Fields) and a Detailed KA Form.

The Portal also supports Rich Text Knowledge Articles. You can view the article content and use the
Toggle Toolbar button to open the Rich Text Editor.
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Create One-Steps that Use Rich Text Fields
Rich Text capability can be used in One-Steps. You can create One-Steps that send e-mails with
formatted text and embedded images to Customers, or that update Incidents with screenshots and
numbered lists.

Good to know:

• When you insert Rich Text Fields into One-Steps, you can select how images are displayed when
One-Steps are executed and Fields are populated with rich content. Right-click the inserted Field,
and then select Display Images As. Click one of the following options: Small Thumbnails, Medium
Thumbnails, Large Thumbnails, or Full Size.

• If you use a One-Step (example: Create Change from Incident) to send the contents of a Rich Text
Field into a plain text Field, the Rich Text formatting and images are stripped out and reverted to
plain text. If you use a One-Step to bring up a Rich Text Zoom window for a Business Object Field,
the system will not recognize any font selections you made for that Field in the Form Editor during
Form design unless the Field already contains text. The system will recognize the Custom Default
font specified in Field Properties or the Global Rich Text Settings.

To create One-Steps that use Rich Text, include one or more of the following One-Step actions:

• Send an e-mail: You can specify the format for the message (Rich Text or plain text), use Rich Text
formatting options for text provided in the e-mail body, and/or insert Rich Text Fields into the e-mail
body.

• Write to a file: You can insert Rich Text or insert Rich Text Fields into file contents.

• Create a new Business Object: You can set Fields that can be automatically populated with Rich
Text content (example: Incident Description).

• Create a child Business Object (example: Journals): You can set Fields that can be
automatically populated with Rich Text content (example: Details).

• Update a Business Object: You can set Fields that can be automatically updated with Rich Text
content.

• Print: You can insert Rich Text Fields to print, or use Rich Text for typed contents.

• Send Tweet: You can insert Rich Text or insert Rich Text Fields into Tweet contents.

• Popup: You can insert Rich Text or insert Rich Text Fields into popup contents.
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Use Rich Text in E-mails
The E-mail and Event Monitor (EEM) and Outlook Integration Manager automatically import Rich Text
from e-mails into Rich Text-enabled Fields in CSM Business Objects. For example, an e-mail monitor
configured to create Incident records from incoming e-mails can populate Incident Description fields with
rich content (example: Embedded screenshots, etc.) contained in the e-mails.

To ensure that Business Object Fields are populated with rich content from e-mails:

1. Configure Rich Text settings for the E-mail and Event Monitor to ensure that images contained in e-
mails are preserved and attached to Business Objects (no special configuration is required for the
Outlook Integration Manager to use Rich Text).

2. Enable Rich Text on the Business Object Fields that the body of the e-mail is configured to be
moved into.

3. Verify that the Rich Text Fields in Business Objects (example: Incidents) created by the EEM or
Outlook Integration Manager are properly formatted after import.

4. If rich content is imported into a plain text Field, ensure that the Rich Text is properly converted to
plain text.

When you send e-mails from the Desktop Client, Browser Client, or Portal, you have the option to send
them in either Rich Text or plain text format.
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Configuring Rich Text
To configure Rich Text in CSM Administrator:

1. Configure Global Rich Text Settings (System Settings in CSM Administrator): Defines how images
(example: Embedded screenshots) are stored and displayed in Rich Text Fields, including file types
and size limits.

2. Enable specific Business Object Fields to use Rich Text.

3. Define Rich Text settings for the E-mail and Event Monitor (EEM): So that rich content from
incoming e-mails is preserved and attached to Business Objects.
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Enable Rich Text on Business Object Fields
You can define various Rich Text options for Business Object fields, including:

• Image Display: Display images in Fields and in the Rich Text Zoom window.

• Image format and size: Override the global settings for image format (JPEG or PNG) and
maximum size (per image and total for all images).

• Spell check: Enable spell check for a Rich Text Field.

• Default font: Font that applies to all Rich Text-enabled Fields of the same type for a particular
Business Object.

Good to know:

• Global Rich Text settings are configured in the System Settings window in CSM Administrator
(Settings>Edit System Settings>Rich Text page).

• In the OOTB system, Rich Text is already enabled on the following Business Object Fields: Incident
Description, Problem Description and Workaround, Knowledge Article Solution, Discussion
Comments, ITPT Project Description, and Journal Details.

• When images in a format other than JPEG or PNG are inserted into a Rich Text Field, they are
converted to the default image format selected for the Field (either JPEG or PNG).

• Image file size increases by as much as 50% when images are embedded and stored with text in a
Rich Text Field. Take this into account when selecting a maximum file size for images.

• Rich Text Fields always have a length of Max Allowed (the maximum number of characters allowed
in a Field).

To enable Rich Text on Business Object Fields:

1. Open the Business Object Editor.

2. In the Business Object Editor Grid, click a Text Field (example: Resolution) for which you want to
enable Rich Text, and then click the Field Properties button.

3. Click the General page.

4. In the Field Properties section, select the Rich Text radio button.

5. Define Rich Text Options for the Field:
a. Form Images Are Displayed As: Select one of the following options in the drop-down to

determine how embedded images are displayed in the Rich Text Field:
◦ Use Global Setting (default): Select this option to display images according to the global

Rich Text setting (Settings>Edit System Settings>Rich Text page). When this option is
selected, the global setting is displayed in parentheses to the right of the drop-down.

◦ No Image Support

◦ Small Thumbnails

◦ Medium Thumbnails

◦ Large Thumbnails

◦ Full Images
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b. Zoomed Images Are Displayed As: Select one of the following options in the drop-down to
determine how embedded images in the Rich Text Field are displayed in the Rich Text Zoom
window:

◦ Use Global Setting (default): Select this option to display images according to the global
Rich Text setting (Settings>Edit System Settings>Rich Text page). When this option is
selected, the global setting is displayed in parentheses to the right of the drop-down.

◦ No Image Support

◦ Small Thumbnails

◦ Medium Thumbnails

◦ Large Thumbnails

◦ Full Images

c. Image Format: Select the image format to use as the default for images embedded in the
Field:

◦ Use Global Setting (default): Select this option to display images according to the global
Rich Text setting for image format (Settings>Edit System Settings>Rich Text page). The
global setting is displayed in parentheses to the right of the drop-down when this option
is selected.

◦ JPEG Format: Select this option to override the default image format so that images are
displayed in the JPEG file format.

◦ PNG Format: Select this option to override the default image format so that images are
displayed in the PNG file format.

d. Override Maximum Size Per Image: Select this check box to deviate from the global Rich Text
setting for the maximum size of a single image embedded into the Field (default is 500
kilobytes).

e. Override Maximum Total Size for Images: Select this check box to deviate from the global Rich
Text setting for the maximum size of all images embedded into the Field (default is 3
megabytes).

f. Allow Spell Check: Select this check box to enable spell checking for the Field. This will check
for spelling errors in content that is provided in the Field.

Note: This option is only available if spell checking is enabled in the Business Object's
general properties.

g. Allow User to Override Image Display Mode: Select this check box to give Users filling out
Business Object Forms in the CSM Desktop Client the option to override the defaults for how
Form images and zoomed images are displayed in Rich Text Fields and the Rich Text Zoom
window.

h. Custom Default Font: Select this check box to specify a default font that applies to all Rich
Text-enabled Fields of the same type for a particular Business Object (example: If you select a
default font for the Problem Resolution field, it applies to all Resolution fields in all Problems).

i. Click the Ellipses button to open the Font window, and then select a Font, Font style,
and Size.

ii. Click OK.ii. 
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Note: When designing a Form in the Form Editor, you can select a Font, Font style, and
Size for a Field, which only apply to that Field in a Business Object. However, if you
specified a Custom Default Font, it overrides any font selections made in the Form Editor
for that same Field.

6. Click OK.6. 

7. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Define Rich Text Settings for E-mails
Use the Rich Text options in the E-mail and Event Monitor to automatically preserve the rich content
contained in incoming e-mails and attach it to Business Objects. Then, when a Business Object (example:
Incident) is updated with the contents of an e-mail, any screenshots contained in the e-mail will also be
included and attached to the Object.

To define Rich Text settings for e-mails:

1. In the CSM Administrator main window, click E-mail and Event Monitoring category, and then click
the E-mail and Event Monitoring Manager task.

2. Select an E-mail Monitor, and then click the Edit button.

The E-mail Event Monitor window opens.

3. Click the Monitors page.

4. Select an item from the list (example: Update Existing Incident), and then click Edit.

The E-mail Event Monitor - Condition and Action page opens.

5. Click the Actions page. 

6. Define Rich Text options for monitored e-mails:
a. Preserve Inline Images Within E-mail Body: Select this check box to preserve any images

within the body of incoming e-mails with the text of the e-mail. Clear this check box to remove
images from the body of incoming e-mails.

b. Attach Inline Images to <Business Object (example: Incident)>: Select this check box to attach
any images within the body of incoming e-mails to the selected Business Object. Clear this
check box to attach only the text of incoming e-mails to the selected Business Object.

7. Click OK.7. 

8. Click Close.

Note: The Outlook Integration also supports Rich Text Fields and imports Rich Text found in
the body of an e-mail into a Rich Text-enabled Field in CSM. It does not require any special
configuration to use Rich Text.
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RSS Feeds
RSS (Really Simple Syndication) is a standard way of publishing frequently updated information, such as
news or blog entries. CSM has the ability to expose data in the RSS format so that the results of various
searches can be displayed within any standard RSS reader on any device.
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About RSS Feeds
Depending on configuration, feeds are either exposed anonymously, or by providing credentials. If
credentials are provided, more data is available and the results can be customized based on the User
account.

Data from CSM can be shown in an RSS reader. In addition to the summary information provided by the
feed, a User can click a link associated with each item to go to the appropriate record in the CSM Web
Applications.
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URLs for RSS Feeds
To read the content of an RSS Feed, provide an appropriate URL to the reader. For example:

http://MyServer/CherwellService/rss.xml?u=Henri&p=password&bo=Incident&q=Open%20Incidents

The first portion of the URL is the address for all RSS Feeds:

http://MyServer/CherwellService/rss.xml

Use https if the server is appropriately configured for SSL. MyServer should be replaced with the address
of the Cherwell Server.

After the address, the rest of the URL (the query string) provides details on the account to use and the
data to retrieve. Query strings are a standard web mechanism for providing arguments as part of a URL.
To specify query string arguments, there must first be a question mark (?) after the main address, followed
by value pairs. The argument name is bo (short for Business Object) and the argument value is Incident.
It is very common for argument names to be only one or two characters long to avoid running into length
limits. For example:

bo=Incident

With the entire URL, it would look like this:

http://MyServer/CherwellService/rss.xml?bo=Incident

Note: The question mark should be in front of the first value pair.

To add multiple values, add an ampersand (&) between each value pair:

bo=Incident&q=MyRecords

Here is the full query:

http://MyServer/CherwellService/rss.xml?bo=Incident&q=MyRecords

Certain characters are not allowed in query strings. Use a simple web search for assistance to find how to
encode other characters. Some examples are:

• Spaces are not allowed, along with most punctuation. To get around this limitation, the query string
must be URL Encoded to replace illegal characters.

• Spaces should be replaced with the sequence "%20" – which indicates the code for a space:

bo=Change%20Request
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Authentication Modes
There are five different authentication modes supported by CSM RSS Feeds. The mode is specified by
providing an argument for the a parameter in the query string. For example, to specify a Customer login,
use:

http://MyServer/CherwellService/rss.xml?a=Customer&u=bob&p=password

For authentication modes that require credentials, the u parameter holds the User ID and the p parameter
holds the password of the User. If a value is not specified for the a parameter, then the default login mode
depends on whether or not a User ID and password is provided. If it is provided, then the default is a CSM
User via Internal Authentication (the same as specifying a=I). If not, then the default is for anonymous
access. The following table lists all of the supported authentication modes.

Note: There are short and long versions of each parameter value.

Mode URL parameter

CSM User, Internal Authentication

This is a standard login/password for a CSM User.

a=I

a=Internal

CSM User, Windows

This is a CSM User, but instead of providing credentials, the User is
authenticated based on the Windows credentials. This only works if accessing
the RSS Feed while on the same domain as the server, and only if the RSS
reader supports standard challenge/response capabilities (Internet Explorer has
this capability).

a=W

a=Windows

Customer/End User, Internal Authentication

This is for a CSM Customer, using the same User ID/password provided for
logging into the CSM Customer Portal.

a=C

a=Customer

Customer/End User/Windows Authentication

This is the same as above, except using Windows credentials rather than a
provided User ID and password. See the note about Windows credentials under
CSM User, Windows.

a=CW

a=CustomerWindows
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Mode URL parameter

Anonymous

In this mode, the RSS Feed is not tied to a particular User, but uses the Security
Group specified as the Anonymous Login in CSM Administrator, (In CSM
Administrator, go to Security>Edit Security Settings).

Not applicable
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Authentication Examples
Here are a few example URLs specifying different logins.

Cherwell User Henri
http://MyServer/CherwellService/rss.xml?a=I&u=Henri&p=password

http://MyServer/CherwellService/rss.xml?u=Henri&p=password

Cherwell Customer Bob http://MyServer/CherwellService/rss.xml?a=C&u=Bob&p=password

Cherwell User via Windows
credentials http://MyServer/CherwellService/rss.xml?a=W

Cherwell Customer via
Windows credentials http://MyServer/CherwellService/rss.xml?a=CW

Anonymous access

http://MyServer/CherwellService/rss.xml

Note: No security flag is necessary. If no credentials are provided,
this is the default.
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Querying RSS Feeds
When working with CSM RSS Feeds, Users can query data using two types of searches:

• Stored Query: Use this option to run a search using a scope to return all results within that scope.

• Full-Text Search: Use this option to run a search using a term and return all results that include that
term.

Stored Query Search

To receive results from a Stored Query search, provide four pieces of information on the query string:

Parameter Description Command

bo parameter Search via the Business Object by providing the name. bo=Incident

t parameter Indicate to receive results from a query search. t=SQ or t=StoredQuery

q parameter

Specify the name of the query (this must be URL encoded to
be legal).

Note: The Stored Query is actually the default option. There is
an option to exclude this parameter altogether.

q=Open%20Incidents

s parameter Specify the scope of the query. s=User

The scope can be Global or User. Global is the default if no scope is provided. Here is a full URL for a
Global Incident search group called Open Incidents:

http://MyServer/CherwellService/rss.xml?u=Henri&p=password&bo=Incident&t=SQ&
q=Open%20Incidents&s=Global

Note: In the real query string, the URL must be on a single line without spaces.

The defaults allow the string to be shortened to:

http://MyServer/CherwellService/rss.xml?u=Henri&p=password&bo=Incident& q=Open%20Incidents

Full-Text Search

As well as running a named search, a search term can be provided against a particular Business Object
and all records that contain that term are returned. To do this, provide three pieces of information:

Parameter Description Command

bo parameter Search via the Business Object by providing the name. bo=Incident
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t parameter Indicate to run a Full-Text Query and receive results from a Full-Text
Search. t=FT or t=FullTex

q parameter Provide the search term to base the query off of. q=e-mail

Put together, the string looks like:

http://MyServer/CherwellService/rss.xml?u=Henri&p=password&bo=Incident&t=FT& q=e-mail

Note: In the real query string, the URL must be on a single line without spaces.
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Links for RSS Feeds
In addition to showing the data from a record, there is a link that takes the viewer to the current record in
CSM. To specify what the link does, provide a value for the l parameter (that is a lower case L):

Mode URL parameter

CSM Desktop Client

The Desktop Client must be installed on the user’s machine.

l=SC

l=SmartClient

CSM Browser Client (default)

The URL to the Browser Client must be configured in CSM Administrator under
Browser and Mobile>Browser Application Settings.

l=T

l=Technician

Cherwell Self-Service

The URL to Self-Service must be configured in CSM Administrator under Browser
and Mobile>Browser Application Settings.

a=SS

a=SelfService

Here is an example URL indicating the links should take the User to the current record inside of the CSM
Desktop application:

http://MyServer/CherwellService/rss.xml?
u=Henri&p=password&bo=Incident&q=Open%20Incidents&l=SC
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Enabling RSS Feeds
RSS Feeds are disabled by default because they could potentially provide inappropriate access to data.

1. Open the Browser Settings window (CSM Administrator>Browser and Mobile>Browser Application
Settings).

2. URLs to Cherwell Browser applications:
◦ Portal: Leave this field with the pre-populated URL.

◦ Browser Client: Leave this field with the pre-populated URL.

3. Enable RSS feeds:
◦ Enable RSS Feeds from Cherwell Service: Select this check box to allow RSS Feeds.

◦ Enable Anonymous RSS Feeds from Cherwell Service: Select this check box to allow
anonymous RSS Feeds. The data available to anonymous feeds is based on the rights
assigned to the Anonymous Security Group selected in CSM Administrator (Security
Settings>General>Security Group when not logged in). In the OOTB database, this is the
Anonymous Browser Security Group.

4. (Optional - For Advanced Users) Max Item Result: Use the web.config file in to set the max amount
of returns for the RSS Feeds (QueryTopCount).

Web-Forms settings and configuration information is stored in an XML file called web.config. By
default, the web.config XML file is installed in the Web-Forms default directory: C:\Program
Files\Cherwell Browser Applications\CherwellWebForms. Modify the default settings and
configurations using the <appSettings> portion of the XML file using any XML Editor (ex: Notepad).

To add the QueryTopCount settings to limit the returns to 250, include the command:

<appSettings>

<add key="TrebuchetDataSource" value="[Common]Cherwell Bro
wser" />

<add key="ErrorHandlingCompatibilityMode" value="true" />

<add key="QueryTopCount" value="250" />

</appSettings>
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Searching
A Search Group is a saved search that finds all records meeting commonly-defined criteria (example:
Find all My Open Incidents). Search Groups are meant to be reused and can be accessed from multiple
places in CSM.
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About Searching
CSM provides an extremely powerful search engine and a host of search tools to help you efficiently and
thoroughly search and filter your CSM data to locate one record or a set or records. Search tools include:

1. Quick Search: A Quick Search is a simple query that quickly finds all records containing a specific
word or phrase (example: Show all records whose description contains the word "phone"). Search
options, such as record type, status, etc., are typically predefined to simplify the search, and vary
depending on the purpose and location of the search. Quick Search is a Full-Text Search, so it
searches all fields that have Full-Text search enabled (even those that are not specified) and finds
similar words, as well. A Quick Search can be accessed from the Quick Search Pane or the CSM
Search Control.

2. Search Group: A Search Group is a saved search that finds all records meeting commonly-defined
criteria (example: Find all My Open Incidents). Search Groups are meant to be reused and can be
accessed from multiple places in CSM.

3. Custom Search: A Custom Search is an exclusive search that finds all records meeting unique
criteria (example: Add search criteria to a Chart Widget). Custom searches are meant to be defined
on-the-fly for unique scenarios, but can also be saved as Search Groups if necessary.

4. Knowledge Search: A Knowledge Search is a search that runs against the Cherwell Knowledge
Base and the Web to quickly find solutions (example: Find information relating to Account
Management). Knowledge Searches can also treat existing records in CSM as Knowledge Sources.
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Note: You can also search within CSM Item Managers. For more information about Item
Manager Searches, see Search in a CSM Item Manager.

At the heart of searching are Queries, which define criteria for retrieving and displaying data. CSM
provides several OOTB Queries (Search Groups and custom), as well as Query Builders to help you
create your own Queries.

CSM also provides a pre-configured Quick Search, a default Search Control, and a multitude of OOTB
Search Groups. Use this search functionality as-is, or tailor it to meet the needs of your organization.
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Search Queries
A Query defines the criteria for retrieving specific data (example: find All Incidents). A Query contains:

• A Grouping Clause: Tells CSM if the Query uses AND (all are true) or OR (any are true) logic.

• One or more additional Clauses (the word or phrase that starts the Query), each comprised of one
or more conditions.

Queries are built using clauses and conditions:

• Clause: A clause combines User specified conditions that are used to narrow the scope of a Query.
CSM provides the following clauses:

◦ Group Clause: A Group Clause is a Query Clause that groups together several Clauses.
When you group Clauses you must decide if all Clauses must be true (AND logic), or if only
one Clause must be true (OR logic), in order to retrieve the record.

◦ Comparison Clause: A Comparison Clause is a Query Clause that finds all records
containing a field with a particular value.

◦ Ownership Clause: An Ownership Clause is a Query Clause that finds records associated
with a particular owner (person or Team).

◦ Related Clause: A Related Clause is a Query Clause that finds Business Objects whose
related Business Object satisfy some of the criteria.

◦ Queue Clause: A Queue Clause is a clause that finds all records that exist or do not exist on
Queues. It also finds records that are available, checked out, and suspended on Queues.

• Condition: A condition is a Dynamic Value that adds to the requirements of a Query, which may
consist of one or more of the following:

◦ Fields: A Field is a basic unit of information (example: ID, last name, address, etc.) that is
specific to a Business Object (example: Incident, Problem, Service, Customer, etc.).

◦ System Functions: A System Function is a built-in placeholder Token that dynamically adds
variable information to a query or string (example: Current User's name).
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◦ Prompts: A Prompt is a display window that requires Users to provide information before
proceeding with a process or Action (example: Specify the reason for putting an Incident into
Pending status).

◦ Expressions: An Expression is a combination of explicit values, constants, variables,
operators, and functions that receive input, manipulate the data, and then output the data. In
other words, an Expression interprets a value, and then produces another value as a result
(example: The IncidentDurationInDays Expression calculates the amount of time that elapses
between the time an Incident is created and closed).

◦ Stored Values: A Stored Value is a named entity that stores commonly used information so
that it can be accessed and/or reused from various places in CSM, such as One-Steps and
Queries.

◦ Metrics: A Metric is a stored measurement query whose value can be used to measure,
monitor, and predict service desk performance and trends (example: Average time to resolve
Incidents).

◦ Operators: An operator is a word or phrase (equals, greater than, contains) that provides the
necessary information for two values to produce an output. The availability of operators
depends on the type of values you choose for a Search Clause.

Note: Search Queries are SQL Queries but prior knowledge of SQL is not needed
because CSM converts the searches to the appropriate SQL Queries behind the
scenes.
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Fields
A Field is a basic unit of information (ex: ID, last name, address, etc.) that is specific to a Business Object
(ex: Incident, Problem, Service, Customer, etc.). Field options only appear in drop-downs when you are
creating a Comparison Clause.

CSM provides you with multiple Field options, including the Field of the current Business Object (ex:
Incident) along with the Fields from related Business Objects (ex: Change Request, Customer, etc).

Note: If you have security rights, you can use the Field Properties window to set Field properties
such as data type, size, read-only, required, and default value.
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Operators
An operator is a word or phrase (equals, greater than, contains) that provides the necessary information
for two values to produce an output. The availability of operators depends on the type of values you
choose for a Search Clause. Operator drop-downs appear in CSM when creating a Comparison Clause.

Operators include:

• Equals: Finds records where value in field equals value in right-most drop-down.

• Not equal: Finds records where value in field does not equal value in right-most drop-down.

• Like: Finds records where the value matches the value and its wildcard in the right-most drop-down.
(example: Jo% will find Joe, John, etc.).

Note: Use % or * as the wildcard character. For example, enter John% to find all records
where the field starts with "John". Do not use the wildcard character at the beginning of the
string if it can be avoided (i.e., %SON), because the underlying database query will be very
slow.

• Not like: Finds all records that do not match a value and its wildcard.

• Empty: Finds all records where the field value is empty.

• Not empty: Finds all records where the field value is not empty.

• Greater than: Finds all records where the value is greater than the value in the right-most drop-
down box.

• Greater or equal: Finds all records where the value is greater than or equal to the value in the right-
most drop-down box.

• Less than: Finds all records where the value is less than the value in the right-most drop-down box.

• Less or equal: Finds all records where the value is less than or equal to the value in the right-most
drop-down box.

• Contains: Does a SQL Server Full-Text search to find records that contain the text in the right-most
drop-down box.

Note: For more information about how to search for "all words" in the right-most drop-down
versus "any words" in the drop-down, see Using All Words/Any Words.

• Is member of team: Use to determine if a particular User's ID is a member of a particular Team's
ID.
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Use All Words/Any Words
The All Words/Any Words feature allows you to run two types of searches.

Button Action Description

Search All Words Search uses all words (AND is used to separate words in search).

Search Any Words Search uses any of the words (OR is used to separate words in search).

Note: These functions do not include words that are irrelevant to the search, such as "the" and
"will".

The All Words/Any Words appear in the following locations by default:

• Quick Search Panes

• Quick Search Query Builder

• Knowledge Search

To hide the All Words/Any Words option, see Hiding the All Words/Any Words Search Option.
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Query Clauses
When you create a Query, you must define one or more clauses. A clause combines User specified
conditions that are used to narrow the scope of a Query. CSM provides the following clause types:

• Comparison Clause: A Comparison Clause is a Query Clause that finds all records containing a
field with a particular value.

• Group Clause: A Group Clause is a Query Clause that groups together several Clauses. When you
group Clauses you must decide if all Clauses must be true (AND logic), or if only one Clause must
be true (OR logic), in order to retrieve the record.

• Ownership Clause: An Ownership Clause is a Query Clause that finds records associated with a
particular owner (person or Team).

• Related Clause: A Related Clause is a Query Clause that finds Business Objects whose related
Business Object satisfy some of the criteria.

• Queue Clause: A Queue Clause is a clause that finds all records that exist or do not exist on
Queues. It also finds records that are available, checked out, and suspended on Queues.
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Define a Comparison Clause
A Comparison Clause is a Query Clause that finds all records containing a field with a particular value.

Use the Query Builder window to create a Comparison Clause.

When you define this type of clause, you define:

• Field: Field for which you want to find a value.

• Operator: Word or phrase (equals, greater than, contains) that provides the necessary information
for two values to produce an output.

• Value: Value for which the clause searches.

Good to know:

• Expressions, Stored Values and system functions appear as folders after the Fields if they are
available.

• Some operators are only shown for particular data types (example: "Like" is only available for text
Fields).

• If the Field is validated, the Legal Values Button  displays on the right of the drop-down. It
allows you to select from a list of appropriate values.

• If Globalization is enabled for your system, you may be able to choose Lookup Object values from
different cultures. For more information, see Using Translated Lookup Table Values in Search
Queries.

To create a Comparison Clause:

1. Open a Query Builder.

2. Click the New button , and then select Comparison Clause.

The Comparison Clause section opens.

3. Select the Field for which you want to find a value (example: Call Source):
a. Click the Down arrow  next to the left-most drop-down to reveal the list of applicable Fields.

b. Select a Field from the list.

The value drop-down (right-most drop-down) automatically populates.

4. Click the Operator drop-down to reveal applicable operators, and then select an operator.

5. Provide a value or click the Down arrow next to the right-most drop-down to reveal applicable
options and Tokens, including:

◦ Fields

◦ System Functions

◦ Prompts
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◦ Expressions

◦ Stored Values

◦ Metric Values

6. Select a value from the list (this is the value the search will look for).

The Comparison Clause displays in the Query.

7. Add additional clauses to refine your search (optional).

Note: If you are using the Stored Query Builder, use the Options button to define additional
options, including availability and icon image.

8. Click OK.8. 
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Define a Group Clause
A Group Clause is a Query Clause that groups together several Clauses. When you group Clauses you
must decide if all Clauses must be true (AND logic), or if only one Clause must be true (OR logic), in order
to retrieve the record.

Use the Query Builder window to create a Group Clause. When you define this type of clause, you define
a conditional phrase. All of the conditions or at least one of the conditions in the clause must be true of all
returned records

To create a Group Clause:

1. Open a Query Builder.

2. Click the New button on the Query Builder toolbar, and then select Group Clause.

The Group Clause area displays.

3. Select one of the following phrases to add to the Query:
◦ All of the items in the group must be true.

◦ At least one of the items in the group must be true.

The phrase displays in the Query.

4. Add additional clauses to refine your search (optional).

Note: If you are using the Stored Query Builder, there is an Options button that allows you
to define additional options, including availability and icon image.

5. Click OK.5. 
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Define an Ownership Clause
An Ownership Clause is a Query Clause that finds records associated with a particular owner (person or
Team).

Use the Query Builder window to create an Ownership Clause. When you define this type of clause, you
define:

• Owner: The type of owner (example: User, Team, Customer) and the specific owner (example: Clair,
1st Level Support, etc.), if applicable.

• Owner's relationship: How the owner is associated with the record (example: Owner is a member of
the Team that owns the record).

Good to know:

• The Ownership Clause section is dynamic. When you select an owner in the drop-down, additional
options (radio buttons or drop-down menus) display in the Ownership Clause section of the window.
The options allow you to narrow the scope of your Query.

• Not all Business Objects support Team ownership. Business Objects can be set up to support Team
ownership by using the Field Editor to add two Fields that hold the Team name and Team ID.

To create an Ownership Clause:

1. Open a Query Builder.

2. Click the New button, and then select Ownership Clause.

3. Select an owner from the Owner is drop-down.
◦ Current User: The User owns the record or is a member/manager of the Team that owns the

record.

◦ Specific User: Name of the User who owns the record, or is a member/manager of the Team
that owns the record.

◦ Specific Team: Name of the Team that owns the record.

◦ Current Customer: The Customer requested the record or is a member/manager of the
associated Customer Workgroup.

◦ Specific Customer: The specified Customer requested the record or is a member/manager of
the associated Customer Workgroup.

◦ Specific Customer Workgroup: Name of the Customer Workgroup that owns the record.

The Ownership Clause displays in the Query.

4. Add additional clauses to refine your search (optional).

Note: If you are using the Stored Query Builder, there is an Options button that allows you to
define additional options, including availability and icon image.

5. Click OK.5. 
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Define a Related Clause
A Related Clause is a Query Clause that finds Business Objects whose related Business Object satisfy
some of the criteria.

Use the Query Builder window to create a Related Clause. When you define this type of clause, you
define:

• Relationship: Existing CSM Relationship between two Business Objects (example: Incident links
Service).

• Value: Number of Business Object records in the relationship (There are exactly 3 Services).

Good to know:

• For each item with "n", a Record number menu appears that allows the number to be selected.

To create a Related Clause:

1. Open a Query Builder.

2. Click the New button on the Query Builder toolbar, and then select Related Clause.

3. Select a related Business Object from the Relationship drop-down.

4. Select a value in the Contains drop-down:
◦ All <related business object>

◦ There is at least one <related business object>

◦ There are no <related business object>

◦ There is exactly 1 <related business object>

◦ There is not exactly 1 n <related business object>

◦ There is more than 1 n <related business object>

◦ There is at least 1 n <related business object>

◦ There are less than 1 n <related business object>

◦ There are 0 or 1 n <related business object>

The clause you created displays in the Query:

5. Add additional clauses to refine your search (optional).

Note: If you are using the Stored Query Builder, there is an Options button that allows you
to define additional options, including availability and icon image.

6. Click OK.6. 
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Define a Queue Clause
A Queue Clause is a clause that finds all records that exist or do not exist on Queues. It also finds records
that are available, checked out, and suspended on Queues. Use the Query Builder window to create a
Queue Clause. When you define this type of clause, you define one of the following Queue types:

• Specific Queue: A Queue Clause containing a Specific Queue finds records on a particular Queue,
such as First Level Support or Hardware.

• User Queue: A Queue Clause containing a User Queue searches records on one of the specialized
Queues that is automatically associated with each User.

• Queue Group: A Queue Clause containing a Queue Group finds records on a set of Queues that
are grouped together.

• Any Queue: A Queue Clause containing a User Queue searches records on one of the specialized
Queues that is automatically associated with each User.

To define a Queue Clause:

1. Open a Query Builder.

2. Click the New button on the Query Builder toolbar, and then select Queue Clause.

3. Define a Queue:
◦ Specific Queue

◦ User Queue

◦ Queue Group

◦ Any Queue

4. Click OK.4. 
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Define a Specific Queue
Use the Queue Clause section of a Query Builder to define a Queue Clause. A Queue Clause containing
a Specific Queue finds records on a particular Queue, such as First Level Support or Hardware. The
Specific Queue section provides you with multiple options to narrow the Query. When you define a
Specific Queue, you define:

• Condition: Queue behavior (example: Record is not on Specific Queue).

• Who: User who checked out the record, if applicable.

• Queue: The specific Queue where the record is located.

To define a Specific Queue:

1. Open a Query Builder.

2. Click the New button on the Query Builder toolbar, and then select Queue Clause.

3. In the Where drop-down, select a condition:
◦ Record is on Specific Queue

◦ Record is not on Specific Queue

◦ Record is checked out to Specific Queue

◦ Record is not checked out from Specific Queue

◦ Record is suspended on Specific Queue

Note: If you select Record is checked out to a Specific Queue, select the specific Team
member from Checked out by drop-down.

4. Click the Ellipses button next to Specific Queue to open the Queue Manager, and then select an
existing Queue.

5. Click OK.5. 
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Define a User Queue
Use the Queue Clause section of a Query Builder to define a User Queue. A Queue Clause containing a
User Queue searches records on one of the specialized Queues that is automatically associated with
each User. When you define a User Queue, you define:

• Condition: Queue behavior (example: Record is not on User Queue).

• Who: User who checked out the record, if applicable.

• User Queue: Team (example: 1st Level Support) and User (example: Current User).

To define a User Queue:

1. Open a Query Builder.

2. Click the New button on the Query Builder toolbar, and then select Queue Clause.

The Queue Clause section displays in the Stored Query window.

3. In the Where drop-down, select a Queue condition:
◦ Record is on Specific Queue

◦ Record is not on Specific Queue

◦ Record is checked out to Specific Queue

◦ Record is not checked out from Specific Queue

◦ Record is suspended on Specific Queue

Note: If you select Record is checked out to a Specific Queue, select the specific
Team member from Checked out by drop-down.

4. Select a specific User's Queue:
a. In the left-most drop-down, select a Team.

b. In the right-most drop-down, select a User.

5. Click OK.5. 
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Define a Queue Group
Use the Queue Clause section of a Query Builder to define a Queue Group. A Queue Clause containing a
Queue Group finds records on a set of Queues that are grouped together. When you define a Queue
Group, you define:

• Where the record is located (example: On a Queue in the group).

• Queue Group where the record is returned from.

Good to know:

• Since Users can manually assign items to Queues, it is helpful to ensure that the same issue cannot
be assigned to more than one Queue. For example, you might an Incident to go to a Hardware
Queue as well as a Survey Queue, so you can track the Customer service experience. In this
instance, you can create a Queue Group containing Hardware and Survey. If an Incident is on the
Hardware Queue and then assigned to the Printer Queue, it will automatically be removed from the
Hardware Queue. This system prevents two different people from working on the same issue. A
Queue Group makes sure that an item can only be assigned to one of the Queues in the group. The
Queue Group section provides you with multiple ways to narrow your Query.

To define a Queue Group:

1. Open a Query Builder.

2. Click the New button on the Query Builder toolbar, and then select Queue Clause.

3. In the Where drop-down, select a condition:
◦ Record is on a Queue in a group

◦ Record is not on a Queue in a group

4. Click the Ellipses button to open the Queue Group Manager, and then select an existing Queue
Group.

5. Click OK.5. 
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Define an Any Queue
Use the Queue Clause section of a Query Builder to define an Any Queue. A Queue Clause containing
Any Queue will search all records that are (or are not) on any Queue that exists in the system. When you
define an Any Queue, you define:

• Condition: Where the record is located (example: Record is on any Queue).

To define an Any Queue:

1. Open a Query Builder.

2. Click the New button on the Query Builder toolbar, and then select Queue Clause.

The Queue Clause section displays in the Stored Query window.

3. In the Where drop-down, select a condition:
◦ Record is on any Queue

◦ Record is not on any Queue

4. Click OK.4. 
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Query Builders
A Query Builder allows you to build Queries through the use of one or more independently created
Clauses. Each Query Builder is dynamic and provides specific options based on the purpose of the Query
you are building.

CSM provides Users with three types of Query Builders:

1. Stored Query Builder: The Stored Query Builder allows you to create a Search Group and save it to
the database as a Search Group (saved search).

2. Quick Search Query Builder: The Quick Search Query Builder allows you to create a Quick Search.

3. Custom Query Builder: The Custom Query Builder allows you to create an exclusive search that
finds all records meeting a unique criteria.

Query Builders can be found in the following locations:

Automation Processes

 Stored Query Builder Quick Search Query Builder Custom Query Builder

Simple Action/Event   

Threshold-based  

Visual workflow  

External Tables

 Stored Query
Builder

Quick Search
Query Builder

Custom Query
Builder

Administrator>Database>Import External
Data>Filter   

Knowledge

 Stored Query Builder Quick Search Query Builder Custom Query Builder

Knowledge Source   

One-Steps

 Stored Query Builder Quick Search Query Builder Custom Query Builder
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Condition Page   

Quick Search

 Stored Query Builder Quick Search Query
Builder Custom Query Builder

Quick Search Pane   

Task Pane Quick Search   

Reporting

 Stored Query
Builder

Quick Search Query
Builder

Custom Query
Builder

Existing Report   

Wizard (Search Group
Page)   

Search Groups

 Stored Query Builder Quick Search Query Builder Custom Query Builder

Business Objects   

Scheduler

 Stored Query Builder Quick Search Query Builder Custom Query Builder

Portal Credentials   

Widgets

 Stored Query Builder Quick Search Query
Builder

Custom Query
Builder

Action Catalog Widget   
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Chart Widget  

Filter Widget  

Gauge Widget  

Matrix Widget  

Search Results List Widget  

Search Widget   
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Stored Query Builder
The Stored Query Builder allows you to create a Search Group and save it to the database as a Search
Group (saved search). Once the Query is created, Users can easily access it within the database and run
it repeatedly.

Access the Stored Query Builder from multiple locations in CSM.

1. Name/Description: Name and describe the Query, so that you can recognize its function.

2. Search Type: Select the Business Object you want the Query to search.

3. Toolbar: Build the Query using these tools.

4. Clause: Add a Clause (Comparison, Group, Ownership, Related, Queue) to the Query.

5. Query: View the Query as you create it and reorganize the Query as necessary.
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6. Options: Determine who can view the Query and which image identifies it in CSM.
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Quick Search Query Builder
The Quick Search Query Builder allows you to create a Quick Search. The Quick Search Query Builder is
dynamic and provides specific options based on the purpose of the Query you are creating.

Access the Quick Search Query Builder from multiple locations in CSM.

The Quick Search Query Builder is composed of the following:

1. Search: Select the type of Business Object you want the Query to search.

2. Toolbar: Build the Query using these tools.

3. Open <Business Object> Only: Select the check box to view records that have not been resolved.

4. Changed: Narrow the timeframe associated with the Query.

5. Clause: Add a clause (Comparison, Group, Ownership, Related, Queue) to the Query.

6. Query: View the Query as you create it and reorganize the order of the Clauses as necessary.
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Custom Query Builder
The Custom Query Builder allows you to create an exclusive search that finds all records meeting a
unique criteria. The Custom Query Builder is dynamic and provides specific options based on the purpose
of the Query you are creating.

Access the Custom Query Builder from multiple locations in CSM.

1. Toolbar: Build the Query using these tools.

2. Clause: Add a clause (Comparison, Group, Ownership, Related, Queue) to the Query.

3. Query: View the Query as you create it and reorganize the order of the clauses as necessary.
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Query Builder Behaviors and Features
Query behaviors include:

• By default, the first line is a Grouping Clause that states <Business Object> where all of the
following are true, which represents the top level Clause that combines all of the other Clauses
together.

Note: This phrase can be changed to <Business Object> where at least one of the
following is true; however, you must choose one option.

• The current selected Clause is indicated by the Green arrow .
• Data relating to the Clause displays as child items below the Green arrow .

Note: As the Clause changes, the Query changes to represent the function of the Clause.

• Click the Green Up/Down arrows next to the Query to move Clauses within the Query.

• Select a Clause and click the Delete button to remove it from the Query.

The Query Builder toolbars provide the following features:

Action Description

New

Create a new:

• Comparison Clause

• Group Clause

• Ownership Clause

• Related Clause

• Queue Clause

Delete Deletes the selected clause.

Copy Creates a copy of the last created clause and adds it to the last string of
the Query.

Move to parent Moves the Clause to parent (CTRL+HOME).

Move to child Moves the Clause to child (CTRL+END).

Sort results by Chooses a specific value to sort the search results by

Sort in ascending order Sorts the search results in ascending order (1-10, A-Z, etc.).

Sort in descending
order Sorts the search results in descending order (10-1, Z-A, etc.).

Sort with multiple
columns Sorts the search results with multiple columns.
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Action Description

Use All Words Inserts an AND to separate the Clauses, so the search finds all words
entered in the Query.

Use Any Words Inserts an OR to separate the Clauses, so the search finds any of the
words entered Query.
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About Quick Search
A Quick Search is a simple query that quickly finds all records containing a specific word or phrase
(example: Show all records whose description contains the word "phone"). Search options, such as
record type, status, etc., are typically predefined to simplify the search, and vary depending on the
purpose and location of the search. Quick Search is a Full-Text Search, so it searches all fields that have
Full-Text search enabled (even those that are not specified) and finds similar words, as well.

Examples include:

• Find all Incidents.

• Find all Incidents about Excel.

• Find all Problems that pertain to printers.

• Find all KAs about printing.

• Find all Customers that are located in New York.

Quick Search Results display in either the Grid or a list format in the CSM Desktop Client Main Pane.
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Quick Searches Good to Know
• Run a Quick Search from the CSM Search Control, Quick Search Pane, CSM Item Managers, etc.

• Display Quick Search results as a list, in a Grid, or in card view. Each provide additional information
about the results. The order of the results is based on relevance (default); however, you can
customize the sort option.

• Quick Search uses SQL Server Full-Text Search for searches. Full-Text Searching must be installed
as part of SQL Server in order for the CSM Quick Search to run properly.

• The Quick Search Pane does not display by default. To display the pane, see Quick Search panes.

• The Quick Search Builder behaves a bit differently in the CSM Browser Client. For more information
about Browser Client Quick Search Builder, refer to the Browser Client documentation.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For detailed
information, see Configure Searches Security Rights.
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Quick Search Pane
Use the Quick Search Pane for searches related to a specific item (example: Incident, Customer, Service,
Vendor, etc.). Additional criteria can also be applied to each Search.

The Quick Search Panes provide the following functionality:

Action Description

Select Object to
Search

Select a specific object to search (example: Incident, Problem, Vendor) from a
drop-down. You can also Select whether to use the All Words/Any Words
feature.

Open Advanced
Editor

Run a refined search of a specific Business Object. A Quick Search window
opens with additional search criteria options.

Note: This type of search is not saved. To generate a Search Group
(saved search), see Create a Search Group.

Open "Business
Objects" only

Limits the search to records that have not reached their final state (example: not
closed).

Note: The lifecycle and terminology vary depending on the Business
Object and scenario (example: "Unapproved Changes only" might
appear when searching Changes). If the Business Object does not
have a "final" or closed state, the check box does not appear.

Search Control
Changed Options Limits the search to records that have changed during a specific timeframe.

Relationships
Includes related Business Objects in the search (example: If the search word
appears in a Journal entry, the Incident to which it is attached will be included in
the search results).

Attachments Includes record Attachments in the search (example: Searches file attachments
in each record).

Sorty by Selects the Business Object field (column) to use to sort the search results.

Descending Sort
Order Sorts the results in descending order (Z-A) instead of ascending order (A-Z).

Search Within
Existing Results

Once you run a search, this option can be used to narrow the results by running
another search within the results.
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CSM Search Control
Use the CSM Search Control to quickly find all records that contain a specific word or phrase. You can
Quick Search all records (example: find all records that contain the word "Printer") or limit the search to
records of a particular type (example: find all Incidents that contain the word "Printer").

When searching a particular Business Object, you can refine the search by defining search options.
Examples of possible searches include:

• Search open records only.

• Search attachments and/or related Business Objects.

• Search a specific timeframe.

• Access the Search Manager to run a Search Group (saved search).

Note: To make a Business Object available in Quick Search: 1) Open Cherwell
Administrator 2) Create a Blueprint 3) Open the Business Object Editor 4) Select the "Show
in Quick Search" check box on the Search Results page.

The CSM Search Control is located in the upper right corner of the CSM Main window.

Search Control behaviors include the following:

• Searches use AND logic.

• Wildcards (*, %) can be used.

• If a Business Object is not specified in the search, results display in a list.

• If a Business Object is specified in the search (example: All Incidents), results display in either a list
or the Grid.

Note: The Search Control is customizable and can vary by Role. The system administrator
decides if it is displayed, which Business Objects can be searched, and what the search
options are. Your default Search Control (either System or Role) is initially set in CSM
Administrator by a system administrator; however, if you have security rights, you can select
your own default.

The CSM Search Control provides you with the following functionality:
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Action Description

Choose Items to
Search

Drops down so that you can select what to search:

• Quick Search: Searches all records that contain a specific word or phrase
(example: find all records that contain the word "printer").

• Specific Search: Searches only records of a particular type (example: find
all Incidents that contain the word "printer").

Quick Search Displays the word or phrase to search for. The drop-down displays the most
recently used (MRU) searches.

Search Options Drops down so that you can refine search options for a specific record type.

Changed Limits the search to records that have changed during a specific timeframe.

Open "Business
Objects" only

Limits the search to records that have not reached their final state (example: not
closed).

Note: The lifecycle and terminology vary depending on the Business Object and
scenario (example: "Unapproved Changes only" might appear when searching
Changes). If the Business Object does not have a "final" or closed state, the
check box does not appear.

Relationships
Includes related Business Objects in the search (example: If the search word
appears in a Journal entry, the Incident to which it is attached will be included in
the search results).

Attachments Includes record Attachments in the search (example: Searches file attachments
in each record).

Sort by Selects the Business Object field (column) to use to sort the search results.

Descending Sort
Order Sorts the results in descending order (Z-A) instead of ascending order (A-Z).

Search Manager Opens the Search Manager where you can create a Search Group.

Close Closes the Search options drop-down box.
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Using Quick Search
When working with Quick Search, Users can run a Quick Search against all records or against records for
a specific Business Object.
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Run a Quick Search Against a Specific Business
Object from the CSM Search Control

Use the CSM Search Control to find records for a specific Business Object that contain a specified word
or phrase.

Good to know:

• Click the Down Arrow button on the Search Control to select a word or phrase you have previously
searched.

• For more information about additional options, see CSM Search Control.

To run a Quick Search against a specific Business Object from the CSM Search Control:

1. Click the Search button, and then select a Business Object to search (example: Incident).

2. In the text box, provide a word or phrase to search for (example: Printing).

3. (Optional) Click the Options button to select additional search criteria:
◦ View open <Business Objects> only.

◦ Search a specific timeframe.

◦ Include Relationships in the search (example: Related Business Objects).

◦ Search Attachments (example: Word or PDF).

◦ Open the Search Manager.

4. Click the Go button to run the search.

The Quick Search Results appear in a list or Grid in the CSM Main Pane.
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Run a Quick Search Against All Records using the
CSM Search Control

Use the CSM Search Control to find all records that contain a specific word or phrase.

Good to know:

• Click the Down Arrow button on the Search Control to select a word or phrase you have previously
searched.

• For more information about additional options, see CSM Search Control.

To run a Quick Search against all records using the CSM Search Control:

1. Provide a word or phrase in the text box.

2. Click the Go button to run the search.

The Quick Search Results appear as a list in the CSM Main Pane.
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Run a Quick Search from the Quick Search Pane
Use the Quick Search Pane to run Searches related to a specific Business Object (example: Incident,
Customer, Service, Vendor, etc.).

Good to know:

• Click the Down Arrow button on the Search Control to select a word or phrase you have previously
searched.

• For more information about additional options, see CSM Search Control.

To run a Quick Search in either the Task Pane Quick Search or the Quick Search Pane:

1. Click the Search button, and then select a Business Object to search (example: Incident).

2. In the search box, provide a word or phrase to search (example: Printing).

3. Specify search criteria (optional):
◦ View open <Business Objects> only.

◦ Search a specific timeframe.

◦ Include Relationships in the search (example: Related Business Objects).

◦ Search Attachments (example: Word or PDF).

4. Click the Go button to run the search.

The Quick Search Results display in a list or Grid in the Main Pane.
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Quick Search Results
When you run a Quick Search, the Search Results display:

1. In the Grid.

2. As a list in the Main Pane.

Toggle between List and Grid formats by clicking View>Results in Grid.

Note: If card view is enabled for a Business Object (in a Business Object's properties in CSM
Administrator), the search results for that object are displayed in a web-like list or as medium or
large cards. Toggle between Grid and Card View formats using the Results as Card View option
in the View menu.

After you have results, click the Search within existing results check box to run another search within
the current results.

Note: For more information about navigating Search Results, see Navigate Search Results.
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About Search Groups
A Search Group is a saved search that finds all records meeting commonly-defined criteria (example:
Find all My Open Incidents). Search Groups are meant to be reused and can be accessed from multiple
places in CSM.

Examples of Search Groups include:

• All Incidents created within the past year.

• All open Requests.

• My open Incidents.

Search Group results display in the CSM Desktop Client Main Pane:

CSM provides several OOTB Search Groups. Use these OOTB Search Groups as-is, edit them, or create
your own using the Search Group Manager.
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Search Groups Good to Know
• Display Search Group results as a list or in the Grid. Each provide additional information about the

results. The order of the results is based on relevance (default); however, you can customize the
sort option.

• CSM provides several OOTB Search Groups. Use these OOTB Search Groups as-is, edit them, or
create your own using the Search Group Manager.

• Search Groups behave a bit differently in the CSM Browser Client. For detailed information about
Browser Client Searches, refer to the Browser Client documentation.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information about security rights, see Configure Searches Security Rights.
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Using Search Groups
Users can view and run Search Groups.
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OOTB Search Groups
CSM provides numerous OOTB Search Groups, which are organized and defined based on the following
Business Objects:

• Incident

• Problem

• Service

• CMDB

• Change

• Release

• Knowledge Article
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View a Search Group
A Search Group can be viewed several ways:

• Use the Search Group Manager (based on security rights) to view available Search Groups.

• From an item that uses a Search Group:
◦ One-Step

◦ Dashboard

◦ Query Builders

◦ Widget

◦ Report
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Run a Search Group
Use the Search Manager to run a Search Group.

To run a Search Group using the Search Manager:

1. Open the Search Group Manager.

2. Select a scope and subfolder (if needed).

3. If applicable, select a more filtered scope (example: A particular Team). <Automatic> applies scope3. 
based on login. If not applicable, this option is grayed out.

4. Double-click the Search Group.
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Search Group Results
When you run a Search Group, the results appear in the CSM Desktop Client Grid format or in card view
format (if enabled for the Business Object) in the CSM Desktop Client Main Pane:

Notice that the results provide additional information regarding the record. While most Grids can be
customized, the following list provides examples of information that can be included:

• Type: Incident, Problem, Service, etc.

• ID Number: Identification number associated with the record

• Customer Name

• Created Date Time: Date and time of creation

• Status: New, Closed, etc.

• Description: Brief explanation provided by the creator of the record

• Resolve By: Resolution due date and time.

Note: To customize the items displayed in search results: 1) Open CSM Administrator 2)
Create a Blueprint 3) Open the Business Object Editor 4) Navigate to the Search Results
page. The "Link text" section defines the first line of the search results. The "Body text"
section defines the list of fields that make up the remaining lines. The "Includes label" box
should be checked if the field name is displayed along with the value.

Card view can also be enabled on the Search Results page for a Business Object to display search
results in a web-like list or as medium or large cards.

To view a specific record in the Grid, click the link associated with any column of the search result you
want to view.

To view a specific record in card view, select an item from the results list or the title link in a card.

The record opens in the CSM Desktop Client Main Pane.

Note: For information on navigating Search Results, see Navigate Search Results.
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Navigate Search Results
Use the Navigation toolbar to navigate between Search Results. The toolbar becomes active after you run
a search and it can be moved/docked based on your specific needs. By default, the Navigation toolbar is
located on the CSM Desktop Client toolbar:

Note: If the Navigation toolbar is not visible, right-click anywhere in the CSM Desktop Client
toolbar section and select Navigation toolbar in the drop-down.

The Navigation toolbar includes the following buttons:

Action Description

Show results Displays the list or Grid of records that were found.

Show current record Displays the currently selected record.

Go to first record Jumps to the first record in set.

Go to previous record Jumps to the previous record in set.

Got to next record Jumps to the next record in set.

Go to last record Jumps to the final record in set.

Card view results have some additional options available:

• Page navigation: Navigate between pages of results (next/previous or by page number).

• Sorting: Sort results based on Business Object fields in ascending or descending order.

• Card Size: Select an option to change the card view (results list view, medium cards, or large cards).

• Execute Actions: Select and run an Action that was defined for the Business Object. In the Desktop
Client, Actions are available in a context menu when you right-click a card. In the Browser Client
and Portal, Actions are available by clicking the ellipses button on a card.

Note: In the Browser Client and Portal, any images or grouping defined for Actions are not
supported in card view.
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Managing Search Groups
Search Groups are managed using the Search Group Manager.

There are several ways to open the Search Group Manager.

Use the Search Group Manager to complete general CSM Item Manager operations for Search Groups,
including:

• View a Search Group.

• Run a Search Group.

• Create a Search Group.

• Edit a Search Group.

• Delete a Search Group.

• Search for a Search Group.

• Copy a Search Group.

• Organize Search Groups.

• Import/export a Search Group.

• Find Search Group dependencies.
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• Pin a Search Group.
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Open the Search Group Manager
To open the Search Group Manager:

• From the CSM Desktop Client menu bar, click Searching>Search Manager.
• From the CSM Desktop Client menu bar, click Searching and select a Search Group from the

bottom-half of the drop-down.

• From the CSM Desktop Client toolbar, right-click and select Customize>Add>Add Action>Add
Search Action.
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Create a Search Group
Use the Stored Query window (accessed from within the Search Group Manager) to create a Search
Group. When you define a Search Group, you define:

• General properties: Name, description, and Business Object to search.

• Clause.

Good to know:

• A Comparison Clause is typically selected by default. To define a different type of clause, click the
Delete button to remove the Comparison Clause.

To create a Search Group (saved search):

1. Open the Search Group Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button.

The Stored Query window opens.

4. Define the general properties for the Search Group:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

c. Select the Business Object you want to search.

5. Click the New button, and then select the type of Clause you want to create:
◦ Comparison Clause: A Comparison Clause is a Query Clause that finds all records

containing a field with a particular value.

◦ Grouping Clause: A Group Clause is a Query Clause that groups together several Clauses.
When you group Clauses you must decide if all Clauses must be true (AND logic), or if only
one Clause must be true (OR logic), in order to retrieve the record.

◦ Ownership Clause: An Ownership Clause is a Query Clause that finds records associated
with a particular owner (person or Team).

◦ Related Clause: A Related Clause is a Query Clause that finds Business Objects whose
related Business Object satisfy some of the criteria.

◦ Queue Clause: A Queue Clause is a clause that finds all records that exist or do not exist on
Queues. It also finds records that are available, checked out, and suspended on Queues.

6. Add additional clauses to refine your search (optional).
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Note: If you are using the Stored Query Builder, there is an Options button that allows you
to define additional options, including availability and icon image.

Results open in the Grid format in the CSM Desktop Client Main Pane.
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Configuring Searches
Complete the following procedures to configure Searches. Security rights are configured in CSM
Administrator.

To configure Searches:

• Search Security rights are configured in CSM Administrator. See Searches Security rights.

• (Optional) Customize Search results lists. See Customizing Search Results Lists.

• (Optional) Hide or show the All Words/Any Words Search option. See Hiding the All Words/Any
Words Toolbar Option.
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Customizing Search Results Lists
To customize the items displayed in Search Results when a list is shown:

1. Open Cherwell Administrator.
2. Create a Blueprint.
3. Select a Business Object from the Object Manager, and then select Edit Business Object.
4. Select Bus Ob Properties, and then navigate to the Search Results page.
5. Set Link Text or Body Text options as they apply:

◦ "Link text" section defines the first line of the Search Results.
◦ The "Body text" section defines the list of Fields that make up the remaining lines.
◦ The Includes label check box should be selected if the Field name is displayed along with the

value.

For more information, see Define Search Results Properties for a Business Object.
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Hiding the All Words/Any Words Search Option
You can hide the All Words/Any Words toolbar buttons for all Users in a security group.
To remove the All Words/Any Words toolbar buttons:

1. Open CSM Administrator.
2. Click the Security category.
3. Select Edit Security Groups.
4. Select the Rights tab.
5. Select Searches from the Category drop-down.
6. Select the Change Full-Text Search Options item.
7. Clear the Allow check box.
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Stored Values
A Stored Value is a named entity that stores commonly used information so that it can be accessed
and/or reused from various places in CSM, such as One-Steps and Queries.
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About Stored Values
Use a Stored Value to store information, such as:

• Organization name.

• Organization image.

• E-mail addresses.

• E-mail signatures.

• Values to toggle on/off integrations (example: Bomgar® and Twitter).

• Alert colors.

For example, use a Stored Value to:

• Store an organization name and image and put them on Dashboards, Forms, Portal Sites, etc. for a
cohesive branding look. Then, if a User changes the Stored Values, the change will affect all
instances in the system.

• Designate the current system as Development or Production. If the system is in a development
environment, Users can set the Current System Stored Value to DEV so that e-mails are sent to test
e-mail accounts rather than to actual Customers (using Automation Processes, Approvals, One-
Steps, etc.). When ready to transition the system to a live environment, set the Stored Value to
Production.

Note: Addresses for e-mail senders and recipients are also set by Stored Values. Refer to
Configure Test and Production Accounts for detailed procedures about setting these Stored
Values, as well as about transitioning the system.
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A Stored Value can be:

• Text (or images).

• Numbers.

• Dates/Times.

• Logical (True/false).

• Color.

In CSM, a Stored Value can be used in/on a:

• Query In Comparison Clauses as values to search for in a specified Field.

• One-Step: In Actions where Users can specify values to use in Business Object Fields, e-mail
messages, Tweets, temporary filenames, command-line arguments, URLs, etc.

• Expression: To set values in Comparison Clauses.

• Dashboard: To set images for Widgets.

• Business Object: To set Field values and properties and to auto-populate Fields.

• Automation Process: To limit records.

• Approvals As values to use in set Field Actions.

• Constraints: As values to limit what a Users sees or can select from in a Field, Related Item
Selector, tab in a Form Arrangement, or Prompt).

• Mobile Form: To limit when certain sections are shown on a mobile device and to set values for
section headers.
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CSM provides several OOTB Stored Values to help get you started. Use these OOTB Stored Values as-
is, edit them, or create your own using the Stored Value Manager.
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Stored Values Good to Know
• Stored Values can be used to store things used often and/or in multiple places (example:

Organization name and image, e-mail addresses and signatures, alert colors, etc.).

• A Stored Value can be text, numbers, dates/times, logical, or colors.

• When creating a Stored Value or assigning a value to an existing Stored Value, Users have the
option to make its value User-specific. This means that each User who uses this Stored Value can
have a "version" of the Stored Value, and update the value to something that is unique to them
(using the Update a Variable or Stored Value Action in a One-Step).

• CSM provides several OOTB Stored Values to help get you started. Use these OOTB Stored Values
as-is, edit them, or create your own using the Stored Value Manager.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For detailed
information, see Configure Stored Value Security Rights.
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Using Stored Values
When working with Stored Values, Users can:

• View a Stored Value.

• Assign values to Stored Values for use in:
◦ Queries: In Comparison Clauses as values to search for in a specified Field.

◦ One-Steps: In Actions where Users can specify values to use in Business Object Fields, e-
mail messages, Tweets, temporary filenames, command-line arguments, URLs, etc.

◦ Expressions: To set values in Comparison Clauses.

◦ Dashboards: To set images for Widgets.

◦ Business Objects: To set Field values and properties and to auto-populate Fields.

◦ Automation Processes: To limit records.

◦ Approvals: As values to use in set Field Actions.

◦ Constraints: As values to limit what a Users sees or can select from in a Field, Related Item
Selector, tab in a Form Arrangement, or Prompt.

◦ Mobile Forms: To limit when certain sections are shown on a mobile device and to set values
for section headers).
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View a Stored Value
To view a Stored Value:

• Use the Stored Value Manager to view available Stored Values (based on security rights).

• From a Query, One-Step, Expression, etc. that uses Stored Values.

• From the Token Selector.
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Assign a Value to a Stored Value
Use the Stored Value Manager to assign values to Stored Values. The assigned values become the
default values, and are stored so that they can be accessed and reused from various places in CSM.

To assign a value to a Stored Value:

1. Open the Stored Value Manager.

2. Select a Stored Value from a scope (and subfolder, if applicable), and then click the Edit button.

3. Assign a value to the Stored Value. A Stored Value can be:
◦ Text (or images).

◦ Numbers.

◦ Dates/Times.

◦ Logical (True/False).

◦ Color.

Note: If you are assigning a value to a default Stored Value, Users might need to
assign a specific value (this will be stated in the description). For example, Bomgar
Stored Values are set to Active, Demo, or Off. See Configuring Stored Values for more
information.

4. (Optional) Select the Value is User-Specific radio button to make the value User-specific. This
means that each User who uses this Stored Value can have a version of the Stored Value, and
update the value to something that is unique to them (using the Update a Variable or Stored Value
Action in a One-Step) rather than using the default value.

Note: If you select this radio button without also selecting Remember the User-Specific
Value Between Sessions, any User-specific values are only available for use during a
User's current CSM session. The Stored Value will return to its default value after Users log
out or close their sessions.

5. Select the Remember the User-Specific Value Between Sessions check box to store any User-
specific values so they are available next time Users log in to CSM.

6. Click OK.6. 
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Managing Stored Values
Stored Values are managed using the Stored Value Manager.

There are many ways to open the Stored Value Manager.

Use the Stored Value Manager to complete general CSM Item Manager operations for Stored Values,
including:

• View a Stored Value.

• Create a Stored Value.

• Edit a Stored Value.

• Delete a Stored Value.

• Search for a Stored Value.

• Organize a Stored Value.

• Copy a Stored Value.

• Import/export a Stored Value.

• Find Stored Value dependencies.

• Pin a Stored Value.
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Open the Stored Value Manager
There are several ways to open the Stored Value Manager:

• In CSM Administrator:
◦ In the CSM Administrator main window, click the Settings category, and then click the Open

Stored Values Manager task.

◦ From the Blueprint Editor menu bar in CSM Administrator, click Managers>Stored Values.

• In the CSM Desktop Client or CSM Administrator:
◦ From within an Update a Variable or Stored Value One-Step Action, click the Ellipses button

next to the Stored Value field.

◦ From the Token Selector available in Query Builders, One-Steps, Expressions, etc., select
Stored Values>Browse.

◦ From the Dashboard Editor, when adding a Stored Value to a Widget Image or an Expression.
◦ Widget Image: Select an image or a Widget, and then click the arrow next to the Image

Selector button  on the Dashboard Editor toolbar and select From Stored Value.

◦ Expression: From the Token Selector, select Stored Values>Browse.
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Create a Stored Value
Use the Stored Value window (accessed from within the Stored Value Manager) to create Stored Values.
When you create a Stored Value, you define:

• General properties: Name and description.

• Type: Text, Number, Date/Time, Logical, or Color.

• Value: Default value for the Stored Value.

• Value is User-specific: Options for making the value User-specific.

• Advanced options: Availability (scope), association (more filtered scope, if applicable), and image.

To create a Stored Value:

1. Open the Stored Value Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button .

4. Define general properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

5. Define the Stored Value type and value:
a. Type: In the drop-down, select the type of Stored Value (ex: Text, Number, Date/Time, Logical,

or Color).

b. Value: Define the value for the Stored Value based on the type selected:
◦ Text: Provide a word or phrase to use as the value.

◦ Number: Specify a number or use the up/down arrows to increase or decrease the
value by whole numbers.

◦ Date/Time: Select a date (MM/DD/YYYY) and time (HH:MM:SS) by clicking the Date
button . Then, click on the time (hours, minutes, or seconds) and use the up/down
arrows to increase or decrease the time.

Tip: Users can also provide numbers to the Date/Time fields. Click the month, day, or
year in the Date field, or the hours, minutes, or seconds in the Time field and type a
number.

◦ Logical: In the drop-down, select True or False.

◦ Color: Click the Color Selector button  to select a color.
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6. (Optional) Define whether to make the value User-specific. This means that each User who uses
this Stored Value can have a "version" of the Stored Value, and update the value to something that
is unique to them (using the Update a Variable or Stored Value Action in a One-Step) rather than
using the default value.

◦ Value is User-specific: Click this radio button to make the value User-specific.

Note: If you click this radio button without also checking Remember the User-specific Value
Between Sessions (below), then any User-specific values are only available for use during a
User's current CSM session. The Stored Value will return to its default value after Users log
out or close their sessions.

◦ Remember the User-specific Value Between Sessions: Select this check box to store
any User-specific values so they are available next time Users log into CSM.

7. Define additional options:
a. Click the Options button.

b. Availability: In the drop-down, select a scope.

Note: If you already selected a scope at the beginning, this is auto-filled with your selection.

c. Association:

If applicable, select a more filtered scope (example: A particular Team). <Automatic> applies
scope based on login. If not applicable, this option is grayed out.

d. Custom Image:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

e. Click OK.e. 

8. Click OK.8. 
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Configuring Stored Values
Complete the following procedures to configure Stored Values. Security rights are configured in CSM
Administrator. Values for the default Stored Values are configured in either CSM Administrator or in the
CSM Desktop Client.

To configure Stored Values:

1. Configure Stored Value security rights: Configure who can access Stored Value functionality.

2. Configure values for the default Stored Values (in the Stored Value Manager): CSM ships with
several default Stored Values, including many to help you implement CSM. Use these as-is, edit
them, or create new ones.

◦ Organization Name and Organization Image Stored Values so that Users can personalize
CSM.

◦ Current System Stored Values that allows Users to configure test and production e-mail
accounts and migrate the system from testing to production.

◦ SLA Model Stored Values that define how an SLA is calculated.

◦ Current System Twitter Integration Stored Value that activates (or disables) Twitter buttons on
a Business Object form (ex: Problem).

◦ Bomgar Remote Support Service Stored Values: If a User has the Bomgar Integration, use
these to control the visibility and behaviors of default One-Steps that execute Bomgar
commands.
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System Functions
A System Function is a built-in placeholder Token that dynamically adds variable information to a query or
string (example: Current User's name).
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About System Functions
A System Function is a built-in placeholder Token that dynamically adds variable information to a query or
string (example: Current User's name).

Use a System Function to add variable and dynamic information, including:

• Date/time information (example: Current date/time, last modified date/time, etc.)

• Current User's information (example: Display name, avatar, phone, e-mail, Team, etc.)

• Current URL information (example: Customer Portal URL, Browser Client URL, etc.)

In CSM, system functions can be used by:

• The system

• Queries
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• E-mails

• Expressions

CSM provides many OOTB System Functions.

System Function Returns

AssociatedFieldsReadOnly()
For Expressions used with Form controls and Field properties,
true if the Field is set to read only. For example, use to change
the border color of a form control when a Field is set to read only.

AssociatedFieldValue()

Returns the value of a Field. Use when a label is linked or
associated with a Field to change the label based on how the
associated Field has been or not been populated. It can also be
used in other Expressions, such as like checking the length of
contents of a Field.

AvailableLicenses(): Total number of CSM licenses currently available for use.

BrowserClientURL() URL link to the Browser Client.

ClientTimeZone() Client's time zone.

CurrentCulture() Current User's culture.

CurrentDateTime() Current date and time.

CurrentLoginID() Current User's Login ID number.

CurrentRoleID() Current User's Role ID number.

CurrentRoleName() Current User's Role.

CurrentUserAvatar() Current User's avatar.

CurrentUserCompanyID() Current User's Company ID number.

CurrentUserCompanyName() Current User's company name.

CurrentUserDefaultTeamID() Current User's default Team ID number.

CurrentUserDefaultTeamName() Current User's default Team name.

CurrentUserDepartmentName() Current User's department name.

CurrentUserDisplayName() Current User's display name.

CurrentUserEmail() Current User's e-mail address.

CurrentUserEmailWithName() Current User's e-mail and name.

CurrentUserLastLanguage() Selected language setting from Windows.

CurrentUserLastLocale() Selected location setting from Windows.

CurrentUserPhone() Current User's phone number.

CurrentUserPortalTimeZoneOffset() Time zone of User's computer.

CurrentUserRecordID() Current User's Record ID number.
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System Function Returns

CurrentUserSLALevel() Current User's SLA level.

CurrentUserTypeID() ID of the Business Object definition that holds User information
(Typically, ID of the UserInfo Business Object).

CurrentUserWebSite() Current User's website name.

HasBusObRight() True if the current User has rights to the Business Object.

IsInBrowser() True if the current User is logged into the Browser Client or
Portal.

IsInBrowserPortal() True if the User is currently operating in the Portal application.

IsInBrowserTechnicianClient() True if the User is currently operating in the Browser Client
application.

LoremIpsum() Use to create records for testing purposes.

NewID() Generates a unique ID (GUID).

PortalURL() URL link to the Portal.

ServerDateTime() Date and time information of the Cherwell Server.

TotalLicenses(): Total number of purchased CSM licenses.

UsedLicenses(): Total number of CSM licenses currently being consumed by
Users.
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About the CurrentCulture System Function
The CurrentCulture System Function contains a User's culture and can be used in Expressions, One-
Steps, etc. to handle different languages and to return a string representation of the culture for the current
thread.

The CurrentCulture System Function can be used with or without globalization features.

For example, CurrentCulture can be used to create e-mail templates in different languages. If
CurrentCulture is set to de-DE, then clicking a button or running a One-Step will initiate the German e-
mail template. If CurrentCulture is set to pt-BR, then clicking the same button or running the same One-
Step will initiate the Portuguese e-mail template.

Each Business Object contains a Created Culture Field. When a new instance of a Business Object is
created, the Field is auto-populated using the CurrentCulture() System Function.
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Table Management
Table Management is a tool that allows Users to quickly manage (add, edit, and delete) values in a
Lookup Object directly from the CSM Desktop Client, without the need for a Blueprint.
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About Table Management
• Add a new value: Add a new Department named Accounting. When a value is added to a Lookup

Object in Table Management, the value is added to the database and becomes available in the
appropriate field's drop-down on the Business Object Form.

• Edit an existing value: Change the name of a department from Accounting to Finance. When a
value is changed in a Lookup Object in Table Management, the value is changed in the database
and in the appropriate field's drop-down on the Business Object Form.

• Delete a value: Remove an unused carrier from the Mobile Carrier.

The following figure shows the Table Management interface.

Not all Lookup Objects are (or should be) available in Table Management. Lookup Tables with intricate
relationships should be disabled because editing or deleting their values could have consequences and
should only be performed by system administrators.

Your system administrator controls which Lookup Objects are available in Table Management by enabling/
disabling the functionality in the general properties of a Lookup Object.

CSM 9.3.0 Features 1332

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Ftable_management%2F..%2Fbusiness_objects%2Fdefine_general_properties_for_a_business_object.html


Table Management Interface
The Table Management interface is a tool that allows you to quickly manage Lookup Object values. Use
the Table Management interface to:

• View Lookup values: View a Grid list of values or a specific value in detail.

• Find a specific Lookup value using filtering and searching options.

• Add, edit, or delete a Lookup Object value.

The Table Management interface can be opened in the CSM Desktop Client or Browser Client.

1. Type: Displays a list of available Lookup Objects. Not all Lookup Objects are or should be available
in Table Management.

2. Show/Hide Search: Shows/hides search and filtering options:
◦ Search: Displays the Lookup Object fields that can be searched using keywords.

◦ Changed: Displays a timeframe filter to refine your search (ex: Anytime, Today, Previous
Month, etc.).

3. Record View: Displays a Grid list of existing values in the selected Lookup Object, or a specific
Customer Record.

Good to know:

• See Table Management Interface Behaviors for tips on working with Lookup values in the Table
Management interface.
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Open the Table Management Interface
To open the Table Management interface:

1. From the CSM Desktop Client menu bar or CSM Browser Client menu bar, click Tools>Table
Management.
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Table Management Interface Behaviors

Menu Bars and Toolbars
Use the CSM Desktop Client menu bar/toolbar and Browser Client menu bar/toolbar to access Table
Management operations, such as:

• Navigating records.

• Switching between Grid view and Current Record view.

• Adding, editing, and deleting Lookup values.

Context Menu (Desktop Client Only)
Use the Table Management context menu to to quickly access common Table Management operations.

Menu Item Description

Go to Record Displays the selected Lookup Object value.

New Creates a new value for the Lookup Object.

Delete Deletes a value from the Lookup Object.

Print Grid Prints the active Grid.

Export Grid Exports the active Grid to a file.

Record Views
There are two ways to view records in the Table Management interface:

• Grid list: Select the Show Results button   on the toolbar to display a Grid list of Lookup
values.

• Current record: Select the Show Current Record button   on the toolbar to display the
selected Lookup value.

Grid Capabilities
When Lookup values are displayed in Grid view, use the CSM Grid capabilities (ex: Print, export, sort,
filter, group, size, move/reorder, and add/remove columns) to display only the data you want and in a way
that is meaningful to you.

Find Lookup Values
Use the filter and search options to find Lookup values.
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Table Management Good to Know
• The Table Management interface can be opened in the CSM Desktop Client or Browser Client.

• The Table Management interface displays Lookup Table values in a Grid. Use the CSM Grid
capabilities (ex: Print, export, run an Action, sort, filter, group, size, move/reorder, and add/remove
columns) to display only the data you want and in a way that is meaningful to you. Click a record to
view it in detail.

• Deleting values might have far-reaching consequences and should only be performed by system
administrators.

• Deleting values is not retroactive; this action removes the value from future Forms while leaving it
intact in past Forms.

Also consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups).
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Using Table Management
When working with Table Management, Users can:
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View Values in a Lookup Object
To view for a value in a Lookup Object:

1. Open the Table Management Interface

2. In the Type drop-down, select a Lookup Object (ex: Mobile Carrier).

The Table Management interface displays Lookup Table values in a Grid. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a value to view it in detail.
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Search for a Value in a Lookup Object
Use the Search/filter feature in the Table Management interface to:

• Search for a specific value in a Lookup Object. Blank finds all values. Search any field (Grid
column), if more than one exists.

• Limit the search to values changed during a specific timeframe (ex: Anytime (all), Today, Within Last
1 Week).

Good to know:

• The Table Management interface displays Lookup Table values in a Grid. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a value to view it in detail.

To search for a value in a Lookup Object:

1. Open the Table Management Interface

2. In the Type drop-down, select a Lookup Object (ex: Mobile Carrier).

3. Click the Show Search button.

The Search and Changed options open.

4. In the Search box, provide the value to search for (ex: Lost My Call Inc). If more than one column
exists, Search any column in the Grid.

5. In the Changed drop-down, select a timeframe to limit the search (ex: Anytime (all), Today, or
Within Last 1 Week).

6. Click the Go button  to initiate the search.

Filtered results are listed in the search results Grid.
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Add a Value to a Lookup Object
Use Table Management to quickly add a value to a Lookup Object directly from the CSM Desktop Client
or Browser Client (ex: Add a new Department named Accounting). When a value is added to a Lookup
Object in Table Management, the value is added to the database and becomes available in the
appropriate field's drop-down on the Business Object Form.

Good to know:

• See Table Management Interface Behaviors for tips on working with Lookup values in the Table
Management interface.

To add a value to a Lookup Object:

1. Open the Table Management Interface

2. In the Type drop-down, select a Lookup Object (ex: Department).

3. On the toolbar (Desktop Client or Browser), click the New button .

Tip: You can also right-click in the Grid, and then select New.

A new record opens with a cursor positioned and blinking in the appropriate field.

4. Provide a value to add to the Field (ex: Accounting).

5. Click Save .

6. On the toolbar, click the Show Results  button to view the new value in the Lookup Object.

The new value is now available in the database and in the appropriate field's drop-down on the
Business Object Form.
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Edit a Value in a Lookup Object
Use Table Management to quickly edit a value in a Lookup Object directly from the CSM Desktop Client
(ex: Change the name of a department from Accounting to Finance). When a value is changed in a
Lookup Object in Table Management, the value is changed in the database and in the appropriate field's
drop-down on the Business Object Form.

Good to know:

• See Table Management Interface Behaviors for tips on working with Lookup values in the Table
Management interface.

To edit an existing value in a Lookup Object:

1. Open the Table Management Interface

2. In the Type drop-down, select a Lookup Object (ex: Department).

3. Double-click the value to edit.

The current record opens with the value to be edited highlighted.

4. Make changes (ex: Change Accounting to Finance).

5. Click Save .

6. On the toolbar, click the Show Results  button to view the changed value.

The new value is now available in the database and in the appropriate field's drop-down is on the
Business Object Form.
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Delete a Value from a Lookup Object
Use Table Management to quickly delete a value in a Lookup Object directly from the CSM Desktop Client
(ex: Remove an unused Mobile Carrier).

CAUTION: Some Lookup Objects have intricate relationships in CSM (ex: Status, Relationship,
Upstream Relationship, or Phase Set), so deleting values might have far-reaching consequences
and should only be performed by system administrators.

Good to know:

• See Table Management Interface Behaviors for tips on working with Lookup values in the Table
Management interface.

To delete a value from a Lookup Object:

1. Open the Table Management Interface

2. In the Type drop-down, select a Lookup Object (ex: Mobile Carrier).

3. Right-click the value to delete, and then click Delete .

4. Click Yes to confirm the delete.

The value is removed from the Lookup Object and is no longer available in the field's drop-down.

5. Click Save .
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Configuring Table Management
Table Management security rights are configured in CSM Administrator. See Configure Application
security rights.
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Themes
A Theme is a set of colors, fonts, images, and styles that can be used by elements on a Dashboard,
Form, or Portal site to give a cohesive look.
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About Themes
Each Theme has defined colors, fonts, images, and styles for the different elements on a Dashboard,
Form, or Portal site (ex: Dashboard background color, Form Control text colors, Portal banner colors,
etc.). When a Theme is applied to a Dashboard, Form, or Portal site, all applicable elements inherit those
properties.

Each Theme has defined colors, fonts, images, and styles for the different elements on a Dashboard,
Form, or Portal site (ex: Dashboard background color, Form Control text colors, Portal banner colors,
etc.). When a Theme is applied to a Dashboard, Form, or Portal site, all applicable elements inherit those
properties.

Each User also has a default Dashboard Theme. The default Dashboard Theme is initially selected in
CSM Administrator, either Globally or by Role. If Users have security rights, they can select their own
User default Dashboard Theme in the CSM Desktop Client. A Dashboard can also be defined to use its
own Theme.

CSM provides several OOTB Themes. Use these OOTB Themes as-is, edit them, or create them using
the Theme Manager and the Theme Editor.
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Dashboard Themes
A Theme is a set of colors, fonts, images, and styles that can be used by elements on a Dashboard,
Form, or Portal site to give a cohesive look. In a Theme, define colors, fonts, images, and styles for the
different elements on a Dashboard (ex: Dashboard background color, colors for charts and gauges, alert
colors, label fonts, etc.). For a detailed list of Dashboard-specific Theme properties, see Dashboard
Theme Properties.

Note: Widgets significantly vary by type, so Theme properties and how they can be applied also
vary significantly (ex: Image Widgets do not have text).

A Theme is selected as part of a Dashboard's Display properties.
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If configured, a Dashboard Theme can be overridden by a:

• Widget Theme: Chart, Gauge, and Matrix Widgets can have their own colors and styles and can be
configured to override the Dashboard Theme. Gauge Threshold colors can also override Theme
Alert colors.

• Global Dashboard Theme: The default Dashboard Theme selected for the entire system.

• Role Dashboard Theme: The default Dashboard Theme selected for a Role.

• User Dashboard Theme: The Theme selected by the User.

• View Theme: A system administrator, or anyone with rights, has the ability to set a Theme for each
View, which essentially resets the default Global Theme.
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CSM provides several OOTB Themes. Use these OOTB Themes as-is, edit them, or create them using
the Theme Manager.
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Dashboard Theme Properties
In a Theme, define the following Dashboard items:

Note: In instances where there is an option for more than one color, the additional colors are used
when a gradient property is set.

• Background: Select the Dashboard Widget background color and Widget face colors. In the figure,
the background color is Silver and the face colors are Coral and Brown. A gradient is shown using
the two colors if the Background style under the Miscellaneous group is set to None or Legacy.

• Charts: Select the Dashboard Widget chart legend background color (red in the figure), legend
border color (white in figure), legend text color (white in figure), chart palette (the bars appear blue),
and grid-line tick color (black in figure).

• Gauges: Select the Dashboard Widget alert colors (high, low, and medium) and gauge pointer color
(Cyan in figure).

• Miscellaneous: Select the Dashboard Gauge Widget background style, either None, Legacy, Flat
(shown in figure), or Chrome.

• Text: Select the Dashboard Widget label colors (navy, purple, and crimson in figure).
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Form Themes
A Theme is a set of colors, fonts, images, and styles that can be used by elements on a Dashboard,
Form, or Portal site to give a cohesive look. In a Theme, define colors, fonts, images, and styles for the
different elements on a Form (ex: Form background color, Form Control label fonts, etc.).

For a detailed list of Form-specific Theme properties, see Form Theme Properties.

A Theme is selected as part of a Form's properties.

CSM provides several OOTB Themes. Use these OOTB Themes as-is, edit them, or create them using
the Theme Manager.
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Forms Theme Properties
In a Theme, define the following Form properties:

Note: In some instances where there is an option for more than one color, the additional colors
are used for a gradient.

• Accent Colors: Select the accent colors used to emphasize a color scheme.

• Alert Colors: Select the alert colors to indicate an alert condition (high, low, and medium).

Note: Accent and alert colors are not automatically applied to any elements. Manually apply
the colors (or any colors for that matter), if needed. Often, these colors are used in
Expressions to conditionally change the color.

• Banner background: Select the banner background colors. The two color options are available for
a variety and to support a gradient.

The figure shows a two-part gradient shading from the light gray to black on the banner and a three-
part gradient on the form background shading from white to red to peru from top to bottom.

• Form background
◦ Form background color: Select the Form background colors.

◦ Background divide point: This is the place on the Form where the gradient colors begin on a
three-point gradient. Scale is 0-999.
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◦ Background style: Select the style of background from None, Solid Color, Tiled Image, or a
gradient left-to-right, top-to-bottom, three part left-to-right, or three part top-to-bottom.

• Group box: Select the group box background, border, and text colors (Group box color is applied by
default. Manually apply Group box 2).

• Label: Select the Label background, border, font, and text colors. In the preview, the text color is
shown as Foreground and Foreground 2. Foreground is applied by default. Manually apply
Foreground 2.
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• Miscellaneous: Select form control colors for the control background color, border color, font (type,
size, and attributes like bold, underline, italic, and strike out), required field border, and text color.

Tip: Specify a font size that fits inside the box boundaries.

• Text: Select the banner font, banner text color, and web form field error text color (not visible in the
preview).
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Portal Themes
A Theme is a set of colors, fonts, images, and styles that can be used by elements on a Dashboard,
Form, or Portal site to give a cohesive look. In a Theme, define colors, fonts, images, and styles for the
different elements on a Portal site (ex: Portal Site header title text, Portal application bar font color, etc.). If
a Theme is changed, refresh the browser to view the changes. For a detailed list of Portal-specific Theme
properties, see Portal Theme Properties.

A Theme is selected as part of a Portal site's properties.
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Portal Theme Properties
In a Theme, define the following Portal properties:

Portal Properties

Note: None of the Portal properties are available to preview.

• App Bar: Select the app bar background color, hover color, image, font, and font color.

• Content: Select the content background color, background image, description font, description font
color, header font, and header font color.

• List: Select the list background color, border color, border style, border thickness, font, font color,
hover font color, hover background color, subtext font, and subtext color.

• Menu:
◦ Menu link: Select the color, link font, link hover background color, link hover color.

◦ Menu list: Select the item background hover color, item link color, item link hover color.

◦ Portal Menu bar: Select the background color (in figure below the large whitespace in preview
area), background image, background image alignment, background image repeat, and list
background color.

• Miscellaneous: Select the Portal icon set type.

• Toolbar: Select the Portal border color, border style, border thickness, background color, font, and
font color.

Header Properties

Note: The Miscellaneous and Text groups are not expanded and not available to preview.

• Background: Select the banner background colors, image, image alignment, image repeat, and
background style.

• Baseline: Select the banner baseline font, font color, and text alignment.

• Miscellaneous: Select the banner image (a single image that can be aligned with the banner, not
the background image) and image alignment.

• Subtitle: Select the banner subtitle font and subtitle font color.

• Text: Select the banner link: active color, color, font, hover color, and visited color.

• Title: Select the banner title font, font color, and text alignment.
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Footer Properties

Note: The Text group is not available to preview.

• Background: Select the footer background colors (two are used in the figure for a gradient), image,
image alignment, image repeat, and background style (solid, left to right gradient, top to bottom
gradient, or image).

• Baseline: Select the footer baseline font, font color, and text alignment.

• Miscellaneous: Select the footer image (a single image that can be aligned with the footer, not the
background image) and image alignment.

• Subtitle: Select the footer subtitle font and subtitle font color (red in figure).

• Text: Select the footer link: active color, color, font, hover color, and visited color.

• Title: Select the footer title font, font color, and text alignment (blue in figure).

Grid Properties

Note: None of the Grids properties are available to preview.

• Alternating row properties: Select the grid alternating row background color, row font, row font
color, and table rows.

• Background: Select the grid background color.

• Border: Select the grid border color, style, and thickness.

• Header: Select the grid header background color, image, image alignment, image repeat, border
color, border style, font, and font color.

• Miscellaneous: Select the grid select row background color.

• Row properties: Select the grid row background color, hover color, font, and font color.
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Themes Good to Know
• A Theme is typically identified by the Theme icon .

• Pin items to a Pinboard (in the Manager) and MRU list (in the CSM Desktop Client menu bar) to
make them easily accessible in CSM.

• Theme properties are organized by Property Area, either Dashboard, Form, or Portal.

• Click the Expand Property Sets icon  next to a property to expand and collapse the property
options.

• Each Theme property is named and intended for a specific element on a Dashboard, Form, or
Portal. When the element is added, the item's defined colors, styles, and fonts are applied by default
(ex: Form Control colors, border style, and fonts are automatically applied to a Control when the
Control is added to a Form). Manually apply a different color or style to most elements, if needed.
For example, it is possible to use Form Background Color 1 for text. The key is to use Theme colors,
and to apply colors and styles consistently. If a non-Theme color (ex: System, Web, or RGB) is
applied, the element does not change to another Theme color when applying a different Theme.

• A Theme is selected as part of a Dashboard's Display properties, a Form's Theme property, or a
Portal Site's Display properties.

• Each User has a default Dashboard Theme. The default Dashboard Theme is initially selected in
CSM Administrator, either Globally or by Role. If Users have security rights, they can select their
own User default Dashboard Theme in the CSM Desktop Client. A system administrator can clear
Role and User defaults (for a specific User/Role or all), resetting the defaults to the Global-defined
settings (File>Clear Settings in the User Manager or Role Manager).

• A system administrator can reset a Global Dashboard Theme and all Form Themes.

• Good Theme design is important. Before creating a Theme, be sure to read Design a Theme.

• The set/reset is a one-time operation. After resetting the Theme, the Theme to Use field is cleared.

• If a Role or User Dashboard Theme is selected, or if a Dashboard/Form has a specific Theme
applied, those Themes override the Global Theme.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For detailed
information, see Configure Theme Security Rights.
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Using Themes
When working with Themes, Users can:

• View a Theme.

• Select a User Dashboard Theme.

To View a Theme:

• Available Themes (based on security rights): Use the Theme Manager.

• On a CSM Desktop Client Dashboard, right-click>User Theme:

Note: The context menu is not available if the Dashboard property Allow User's chosen
theme to override Dashboard theme is check box is cleared.

◦ The default Dashboard Theme is listed at the top.

◦ The currently selected Theme is selected.

◦ MRU Themes are listed in alphabetical order.

◦ Click More to open the Theme Manager and select an existing Theme or import/export a
Theme to/from another system.

• On the Browser Client Dashboard toolbar, click the Themes button .
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Open the Theme Manager
To open the Theme Manager:

1. The Theme Manager can be opened several ways:
◦ From the CSM Desktop Client, right-click a Dashboard, and then click User Themes>More.

◦ On the Browser Client Dashboard toolbar, click the Themes button .

◦ From CSM Administrator, go to the Blueprint/Object Manager toolbar, click
Managers>Themes.

◦ From Theme selectors (  or ) throughout CSM (ex: From the Dashboard Properties
window).
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Color Palette Manager
Use the Color Palette Manager to open the Color Palette Editor to create custom Theme color palettes for
Desktop Client and Browser Client Dashboards.

1. Main Pane:

Displays items by View (Icon, List, or Details) and displays search results when a Search is run.

2. Manager tree:

Displays default color palettes, as well as any custom color palettes that have been created, in
alphabetical order.
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Color Palette Editor
Use the Color Palette Editor to create custom Widget color palettes for Desktop Client and Browser Client
Dashboards. Color palettes are system specific, allowing custom color palettes to be viewed system wide.

Use the Color Palette Manager and Editor to create custom Widget color palettes for Desktop Client and
Browser Client Dashboards. Color palettes are system specific, allowing custom color palettes to be
viewed system wide.

1. Properties Pane: Displays the colors in the selected color palette. Up to 16 colors can be chosen
and their default or custom names populate the fields.

2. Color Fields: A color picker button is located in each of the 16 color fields. Choose from default,
OOTB colors or use RGB color codes to choose custom colors. In CSM, RGB color codes display
as ARGB codes.

3. Sample Chart Widgets: The sample chart widgets provide a preview of how color palette changes
appear across the different Chart Widgets available in CSM.
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Configure Color Palette Security Groups
In order to create or edit Color Palettes, a User must be a part of a Security Group that has Theme
Management enabled. Use the Rights tab in the Security Group Manager to assign Color Palette View,
Edit, Delete, or Create rights to Users.

To assign Color Palette security rights to Users:

1. In the CSM Administrator, select the Security category.

2. Click Edit security groups. The Security Group Manager opens.

3. Select the Rights tab.

4. Select a Security Group from the Group drop-down (example: Administrator).

5. From the Category drop-down, select Themes. Theme Management is the only available Security
Right for the Themes category.

6. Select one or more checkboxes:
a. View: Users in the selected Security Group can view all Color Palette options in the Color

Pattern Manager.

b. Add: Users in the selected Security Group can add new Color Palettes to the system.

c. Edit: Users in the selected Security Group can edit existing Color Palettes.

d. Delete: Users in the selected Security Group can delete custom Color Palettes.

If a User is not part of a Security Group with access to Color Palettes and the Color Palette
Manager, the option is disabled in the Desktop Client (Desktop Client Toolbar > Dashboards >
Color Palette Manager).

7. Repeat Steps 4-6 for all desired Security Groups.

8. Close the Security Group Manager.
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Create Custom Color Palettes
Chart Widget color palettes are visible in Desktop Client and Browser Client Dashboards.

Edit OOTB Color Palettes
All color palettes in the Color Palette Manager can be modified, copied, or deleted.

To edit an OOTB color palette:

1. In the CSM Administrator, click Create a new Blueprint.
2. Select Managers > Dashboards > Color Palette Manager. The Color Palette Manager opens.

3. In the Color Palette Manager, select a Default color palette (example: Berry).

4. Click the Edit button. The Color Palette Editor opens. Color properties for the default color palette
display in the left pane, and sample widgets display in the main pane.

5. Select a default Color Field. The color picker opens. Default colors are listed by name, but a
standard RGB color picker is also available for custom colors.

6. Select a New Color to add to the default color palette (example: Sienna).

7. (Optional): Repeat Steps 5-6.

8. Click Save.

9. Publish the Blueprint.

Create Custom Color Palettes
Create custom Chart Widget color palettes to align with corporate colors, or to differentiate between
departments.

To create a custom color palette:

1. In the CSM Administrator, click Create a new Blueprint.
2. Select Managers > Dashboards > Color Palette Manager. The Color Palette Manager opens.

3. Click the New button.

4. Provide a name for the Color Palette. The Color Palette Editor opens, displaying the default Bright
color palette in the 16 color fields.

Important: The Bright Color Palette is not visible in the Color Palette Manager. However, it
is the default color palette if none are chosen and the default colors for new, custom color
palettes.

5. Select a Color Field. The color picker opens. Default colors are listed by name, but a standard RGB
color picker is also available for custom colors.

6. Select a Color. The field populates with the name or RGB code of the selected color (example:
Magenta or Custom RGB 255, 192, 64, 0).

7. Repeat Steps 4-5 for up to 16 colors.
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Tip: Change a sample color to Transparent if fewer than 16 colors are desired.

8. Click Save.

9. Publish the Blueprint.

Change Color Palettes
Make limited changes and switch color palettes from a Dashboard.

To switch color palettes from the Desktop Client:

1. From the toolbar, click Dashboards > Color Palette Manager.
2. Select a color palette.

3. Click OK. The Dashboard color palette updates.

Note: If changes are not visible, select Help > Reload definitions from the toolbar. If
changes are still not visible, ensure that the Blueprint was published.
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Assign a Color Palette to a Chart Widget
Apply custom color palettes or change the default color palette of Chart Widgets.

Assigning a Color Palette to a Chart Widget in the Widget Manager
Publish a Blueprint to assign a color palette to Chart Widgets:

1. In the CSM Administrator, click Create a new Blueprint.
2. Select Managers > Dashboards > Widget Manager. The Widget Manager opens.

3. Select Display from the Options pane in the Widget Manager.

4. Select a color palette from the color palette drop-down (example: Bright or Custom).

5. Click OK.

6. Repeat Steps 2-5 for any additional Widgets.

7. Publish the Blueprint.

Assigning a Color Palette to a Chart Widget in the Theme Manager
Publish a Blueprint to assign a color palette to Chart Widgets:

1. In the CSM Administrator, click Create a new Blueprint.
2. Select Managers > Themes. The Theme Manager opens.

3. Right-click on a Theme.

4. Select Edit. The Theme Editor opens.

5. Select Dashboards from the Property Areas drop-down.

6. Select the Dashboard widget chart palette field from the Charts section.

7. Choose a color palette from the drop-down (example: Berry or a custom color palette).

8. Click Save. The Theme Editor closes.

9. Close the Theme Manager.

10. Publish the Blueprint.
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Managing Themes
Themes are managed using the Theme Manager and the Theme Editor.

Use the Theme Manager to:

• Create a Theme.

• Set/reset a Theme for a View.

• Edit a Theme.

• Delete a Theme.

• Search for a Theme.

• Organize Themes.

• Copy a Theme.

• Import/export a Theme.

• Find Theme dependencies.

• Pin a Theme.

Use the Theme Editor to:

• Define Theme properties (ex: Colors, styles, etc.).

Good to know:

• Good design is important. Before creating a Dashboard, see Design a Theme.
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Theme Editor
The Theme Editor is a tool within the Theme Manager that helps define colors, fonts, images, and styles
for a Theme. Use the Theme Editor to define colors, fonts, images, and styles for:

• Dashboards.

• Forms: Alert Colors and Controls.

• Portal Sites: Header, Footer, and Grids.

The Theme Editor can be opened several ways from within the Theme Manager. The Theme Editor
preview is dynamic; when changes are made, the changes are immediately reflected in the preview (this
is not available for the Portal Property Area). Click OK to commit the changes.

To open the Theme Editor:

1. The Theme Editor can be opened several ways from within the Theme Manager:
◦ Click the New button .

◦ Click the Theme to edit and then:
◦ Right-click>Edit.
◦ Click File>Edit.
◦ Click the Edit button.

Note: When upgrading to 6.0, any created themes are saved and upgraded. In the Site settings,
the theme (Default) and the Control Style name are combined to create the new theme name. For
example, if there was a site setting in the system prior to 6.0 named Default and a Control Style of
BlueSky, the new name in 6.0 is Default - BlueSky. Rename the 6.0 combined name by editing the
theme.
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1. Property Area: Type of Theme (ex: Dashboard, Form, or Portal). Each Theme area is organized by
a group/category (ex: Background, Text, Miscellaneous, etc.).

2. Properties pane: Movable dockable pane that lists the different properties alphabetically
(ascending) by group/category and then by alphabetically within each group/category (ex: Fonts,
colors, styles, etc.). Find a property by searching, filtering by category or sorting A-Z.

3. Preview Type and toolbar: Item to preview with the Theme properties applied, either a specific
Dashboard, Form, or Portal site, or a reference Dashboard, Form, or Portal site. The Auto toggle
button in the toolbar locks the preview type to the property area value. While that button is clicked, a
property area of forms always shows the reference form (for example). To see a specific form, click
the Auto button again so it is disabled. That allows Users to select any preview regardless of the
property area. This is important when deciding to use Dashboard named colors in a form or vice
versa.

4. Display area: Preview of the Theme applied to a specific or reference Dashboard, Form, or Portal
site.
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Theme Editor Behaviors
Filter Properties

• To view all properties (Dashboard, Form, and Portal), select All from the Property Area drop-down.

• To view properties for a specific area (Dashboard, Form, or Portal), select the area from the
Property Area drop-down.

• Expand an area to view all groups within an area by clicking the arrow.

Sort Properties

Sort properties from A-Z by clicking the Sort button .

Search for a Property

Property Search Control: Use to search for a property by name (ex: Form background color).

Color Selector

• Click the Color Selector button  to open the Color Selector, and then select a color:
◦ Web:

Set of named Web-safe colors.
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◦ Custom:

Customized Red, Green, Blue (RGB) colors.

Text Selector

Click the arrow next to the Font group to expand the font options.

Image Selector

Click the button for any image property to navigate and select an image.
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Reset Property

Right-click on a property name in the to show the Reset option. Click Reset to remove any User-specified
value for that property from the Theme and revert to the global default value for that Theme property.
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Open the Theme Editor
To open the Theme Editor:

1. The Theme Editor can be opened several ways from within the Theme Manager:
◦ Click the New button .

◦ Click the Theme to edit and then:
◦ Right-click>Edit.
◦ Click File>Edit.

◦ Click the Edit button .
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Design a Theme
Good Theme design is important. Before creating a Theme, consider the following:

• Each Theme property is named and intended for a specific element on a Dashboard, Form, or
Portal. When the element is added, the item's defined colors, styles, and fonts are applied by default
(ex: Form Control colors, border style, and fonts are automatically applied to a Control when the
Control is added to a Form). Manually apply a different color or style to most elements, if needed.
For example, it is possible to use Form Background Color 1 for text. The key is to use Theme colors,
and to apply colors and styles consistently. If a non-Theme color (ex: System, Web, or RGB) is
applied, the element does not change to another Theme color when applying a different Theme.

• Contrast is important, so we recommend considering the background and label colors first. If
background colors are dark, use lighter label and accent colors. If background colors are light, use
darker label and accent colors.

• Consider accessibility (ex: Color blindness), translation (ex: What does a color mean in another
locale?), browser capabilities (ex: Do browsers consistently display the color?), and science (ex:
What does the color evoke?) when selecting a color. Colors should please, not irritate.

• Transparent is a color option. Use transparent on backgrounds and borders when a color is not
needed.

• Rich Text fields use their own custom font, style, and size (configured in System Settings). Fields
are not affected by the Control Theme item.

• Widgets significantly vary by type, so Theme properties and how they can be applied also
significantly vary:

◦ By default, Widget labels inherit their font from the default system font. Font size, style, and
alignment must be manually applied.

◦ Chart, Gauge, and Matrix Widgets can have their own colors and styles and can be defined to
override Theme colors.

◦ Theme Alert colors are automatically applied to gauge thresholds (ex: Low, Medium, and
High). Override Theme Alert colors, if necessary or apply Theme Alert colors to other elements
(ex: Alert colors are often used in Expressions to conditionally change a Widget's background
or label color).

◦ Image, Button, Filter, and Search Widgets do not support backgrounds; therefore, no
background color or style can be applied.

◦ Image Widgets do not support text, background, foreground, or border colors; therefore no
colors, styles, or fonts can be applied.

◦ By default, Text Gauge Widgets have a transparent background. To manually add a
background, right-click the Widget, select a background style, and then select a background
color and border color.
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Create a Theme
Use the Theme Editor (accessed from within the Theme Manager) to create a Theme to apply to a
Dashboard, Form, or Portal. When creating a Theme, define:

• Dashboard theme properties: Background, Charts, Gauges, Miscellaneous, and Text.

• Form theme properties: Accent Colors, Alert Colors, Banner background, Form background, Group
box, Label, Miscellaneous, and Text.

• Portal theme properties: App bar, Content, List, Menu, Miscellaneous, and Toolbar. Forms has
property area sub-groups for Header, Footer, and Grids.

Tips:

• Select All in the Property Area drop-down to display all (Dashboard, Form, and Portal) properties in
one list.

• Use the Theme preview to test the font, color, and style combinations.

To create a Theme:

1. Open the Theme Manager

2. Click the Create New button .

The New Theme window opens.

3. Provide a display name to use within CSM (this property can be searched in CSM Item Managers).3. 

4. Click OK.4. 

5. Define Forms properties:
a. From the Property Area drop-down, select Forms.

b. Define Forms properties.

In a Theme, define the following Form properties:

Note: In some instances where there is an option for more than one color, the
additional colors are used for a gradient.

◦ Accent Colors: Select the accent colors used to emphasize a color scheme.

◦ Alert Colors: Select the alert colors to indicate an alert condition (high, low, and
medium).

Note: Accent and alert colors are not automatically applied to any elements.
Manually apply the colors (or any colors for that matter), if needed. Often, these
colors are used in Expressions to conditionally change the color.
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◦ Banner background: Select the banner background colors. The two color options are
available for a variety and to support a gradient.

The figure shows a two-part gradient shading from the light gray to black on the banner
and a three-part gradient on the form background shading from white to red to peru from
top to bottom.

◦ Form background
◦ Form background color: Select the Form background colors.

◦ Background divide point: This is the place on the Form where the gradient colors
begin on a three-point gradient. Scale is 0-999.

◦ Background style: Select the style of background from None, Solid Color, Tiled
Image, or a gradient left-to-right, top-to-bottom, three part left-to-right, or three part
top-to-bottom.
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◦ Group box: Select the group box background, border, and text colors (Group box color
is applied by default. Manually apply Group box 2).

◦ Label: Select the Label background, border, font, and text colors. In the preview, the text
color is shown as Foreground and Foreground 2. Foreground is applied by default.
Manually apply Foreground 2.

n
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◦ Miscellaneous: Select form control colors for the control background color, border color,
font (type, size, and attributes like bold, underline, italic, and strike out), required field
border, and text color.

Tip: Specify a font size that fits inside the box boundaries.

◦ Text: Select the banner font, banner text color, and web form field error text color (not
visible in the preview).

6. Define Dashboard properties:
a. From the Property Area drop-down, select Dashboards.

b. Define Dashboard properties.

In a Theme, define the following Dashboard items:

Note: In instances where there is an option for more than one color, the additional
colors are used when a gradient property is set.

◦ Background: Select the Dashboard Widget background color and Widget face colors. In
the figure, the background color is Silver and the face colors are Coral and Brown. A
gradient is shown using the two colors if the Background style under the Miscellaneous
group is set to None or Legacy.

◦ Charts: Select the Dashboard Widget chart legend background color (red in the figure),
legend border color (white in figure), legend text color (white in figure), chart palette (the
bars appear blue), and grid-line tick color (black in figure).
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◦ Gauges: Select the Dashboard Widget alert colors (high, low, and medium) and gauge
pointer color (Cyan in figure).

◦ Miscellaneous: Select the Dashboard Gauge Widget background style, either None,
Legacy, Flat (shown in figure), or Chrome.

◦ Text: Select the Dashboard Widget label colors (navy, purple, and crimson in figure).

7. Define Portal properties:
a. From the Property Area drop-down, select Portal.
b. Define Portal properties.

In a Theme, define the following Portal properties:

Portal

Note: None of the Portal properties are available to preview.

◦ App Bar: Select the app bar background color, hover color, image, font, and font color.
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◦ Content: Select the content background color, background image, description font,
description font color, header font, and header font color.

◦ List: Select the list background color, border color, border style, border thickness, font,
font color, hover font color, hover background color, subtext font, and subtext color.

◦ Menu:
◦ Menu link: Select the color, link font, link hover background color, link hover color.

◦ Menu list: Select the item background hover color, item link color, item link hover
color.

◦ Portal Menu bar: Select the background color (in figure below the large
whitespace in preview area), background image, background image alignment,
background image repeat, and list background color.

◦ Miscellaneous: Select the Portal icon set type.

◦ Toolbar: Select the Portal border color, border style, border thickness, background color,
font, and font color.

Header

Note: The Miscellaneous and Text groups are not expanded and not available to
preview.

◦ Background: Select the banner background colors, image, image alignment, image
repeat, and background style.

◦ Baseline: Select the banner baseline font, font color, and text alignment.

◦ Miscellaneous: Select the banner image (a single image that can be aligned with the
banner, not the background image) and image alignment.

◦ Subtitle: Select the banner subtitle font and subtitle font color.

◦ Text: Select the banner link: active color, color, font, hover color, and visited color.

◦ Title: Select the banner title font, font color, and text alignment.

Footer

Note: The Text group is not available to preview.

◦ Background: Select the footer background colors (two are used in the figure for a
gradient), image, image alignment, image repeat, and background style (solid, left to
right gradient, top to bottom gradient, or image).

◦ Baseline: Select the footer baseline font, font color, and text alignment.

◦ Miscellaneous: Select the footer image (a single image that can be aligned with the
footer, not the background image) and image alignment.

◦ Subtitle: Select the footer subtitle font and subtitle font color (red in figure).

◦ Text: Select the footer link: active color, color, font, hover color, and visited color.
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◦ Title: Select the footer title font, font color, and text alignment (blue in figure).

Grids

Note: None of the Grids properties are available to preview.

◦ Alternating row properties: Select the grid alternating row background color, row font,
row font color, and table rows.

◦ Background: Select the grid background color.

◦ Border: Select the grid border color, style, and thickness.

◦ Header: Select the grid header background color, image, image alignment, image
repeat, border color, border style, font, and font color.

◦ Miscellaneous: Select the grid select row background color.

◦ Row properties: Select the grid row background color, hover color, font, and font color.

To edit a Theme:

1. Open the Theme Manager

2. Select a Theme, and then click the Edit button .

Tip: Also click File>Edit or right-click>Edit.

The Theme opens in the Theme Manager.

3. Make changes.

Note: To rename a Theme, right-click a Theme in the Theme Manger, and then select
Rename.

4. Click OK.4. 
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Set/Reset a Theme for a View
Use the Set Theme for View option in the Theme Manager to set or reset a Global Theme for selected
items (Dashboards and/or Forms) in a selected View. When setting/reseting a Global Theme, select:

• View: View for which to reset the Global Theme.

• Theme to Use: Theme to push out to all selected items (Dashboards and/or Forms).

• Change Theme On: Whether or not to push out the Theme to all Dashboards and/or Forms in that
View. For example, maybe to reset all Dashboards to a new Theme, but Forms should retain their
existing Theme.

To set/reset a Theme for a View:

1. Open the Theme Manager in CSM Administrator:
a. In the CSM Administrator main window, click the Blueprints category, and then click the

Create a New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object
Manager lists the existing Business Objects.

b. From the CSM Administrator Menu bar, click Managers>Theme Manager.
2. From the Theme Manager Menu bar, click Themes>Set Theme from View.

The Set Theme for View window opens.

3. Define the following:
a. View: Select the View for which to reset the Global Theme (ex: Default or Portal).

b. Theme to Use: Select the Theme to push out to all selected items (Dashboards and/or Forms).

c. Change Theme On: Select the check box to push out the Theme to the selected item
(Dashboard and/or Form) in that View.

4. Click OK.4. 
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Configuring Themes
Complete the following procedures to configure Themes. Configuration procedures are completed in CSM
Administrator. Users who have rights to select a default Theme can perform this task in the Desktop
Client.

To configure Themes:

1. Configure Theme security rights.

2. Select a default Dashboard Theme.
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Tokens
A Token is a dynamic value that controls how information (example: Text, colors, numbers,
measurements, etc.) is interpreted and displayed throughout the system. Defined values can be used
while designing Forms, Dashboards, Automation Processes, One-Steps, Fields, etc.
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About Tokens
Token features include:

• Counters: A Counter is a Token that automatically increases a defined initial value (number) by a
defined increment. Counters can be used while designing Forms, Dashboards, Automation
Processes, Expressions, One-Steps, etc.

• Prompts: A Prompt is a display window that requires Users to provide information before
proceeding with a process or Action (example: Specify the reason for putting an Incident into
Pending status).

• Stored Values: A Stored Value is a named entity that stores commonly used information so that it
can be accessed and/or reused from various places in CSM, such as One-Steps and Queries.

• System Functions: A System Function is a built-in placeholder Token that dynamically adds
variable information to a query or string (example: Current User's name).

Additionally, Expressions, Metrics, and Fields can be used as Tokens for One-Steps and other
Expressions, though they are not limited to Token functionality.
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Some Tokens can be reformatted using Modifiers and Formats that change the visual format or calculated
value of the Token in a One-Step or Expression. For example, a Date/Time field in a One-Step can be
modified to display only the date without the time stamp for ease of use. For more information on applying
a Modifier or Format, refer to the Modifiers or Formats documentation.

The most straight-forward way to access Tokens is through the Token Selector.

CSM provides several Out-of-the-Box (OOTB) Tokens. Use these OOTB Tokens as-is, edit them, or
create new Tokens.
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Token Selector
Use the Token Selector to complete the following Token operations:

• View: View a list of available or Most Recently Used (MRU) Tokens that can be expanded using the
Expand button.

• Add: Add an existing Token by clicking the Token once.

• Browse: Opens the applicable Manager (if available).

• New: Creates a new Token (if available).
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Open the Token Selector
To open the Token Selector:

1. In an Expression: When creating an Expression.

2. In a One-Step: When defining the conditions for a One-Step or Action in the One-Step window.

3. In a Search Query: When building a Search Query.
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Token Context Menu
Use the Token context menu to perform the following operations:

• Delete: Click the Delete button to remove a Token.

Note: This does not remove the Token from the system, only from the item using that Token.

• Properties: Opens the Token's properties to edit the Token (if applicable).

• Modifiers: Opens the Modifiers window to modify the format or value of the Token (if applicable).

To open the Token context menu:

1. Open a One-Step or Expression.

2. Right-click a Token.

Tip: Tokens in One-Steps or Expressions have a gray box around them so they are easily
identified.
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Constraints and Operators
When using Tokens, there are a few smaller functions that can affect how certain Tokens (example:
Prompts, Expressions) work. These include:

• Constraints: A constraint is a limit or filter on what a User can see or select from in a Field, Related
Item Selector, tab in a Form Arrangement, or Prompt.

• Operators: An operator is a word or phrase (equals, greater than, contains) that provides the
necessary information for two values to produce an output. The availability of operators depends on
the type of values you choose for a Search Clause.
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Constraints
A constraint is a limit or filter on what a User can see or select from in a Field, Related Item Selector, tab
in a Form Arrangement, or Prompt. Unlike a Search filter, constraints are settings for specific items on a
Form or Prompt.

For example, Users can constrain:

• Fields on a Form that are specific to a certain Team (example: Employee information displaying only
for the HR Team).

• Values in a Selector Control to show only Customers from a particular region/office, or display only
computers that are available/active/assigned to someone.

• If the Knowledge Article tab shows in the Form Arrangement for a given Problem only when there is
an associated Knowledge Article.

• A Prompt that shows Incident Categories that are visible in the Customer Portal.

Constraints contain three key components: Field (what is being constrained), Operator (how it is being
constrained), and Value (what it is being constrained to).

In the example above, Incident Category.Visible in Portal is the Field that the Prompt constraint is set on.
Equals is the operator, so only an Incident Category that is visible in the Portal triggers the Prompt. True is
the value, so if an Incident Category is visible in the Portal, the Prompt will run. To make the Prompt run
when an Incident Category is not visible in the Portal, set the value to False.

There are several types of constraints:

• Field constraints: Limits placed on Fields.

• Value constraints: Limits place on values in Selectors.

• Form Arrangement constraints: Limits placed on items within a Form Arrangement.

• Prompt constraints: Limits placed on Prompts (example: When a Prompt runs).
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Tokens Good to Know
• The following features can be used as Tokens while not being limited strictly to Token functionality:

◦ Expressions

◦ Metrics

◦ Fields

• Some Tokens can be reformatted using Modifiers and Formats that change the visual format or
calculated value of the Token in a One-Step or Expression. For example, a Date/Time field in a One-
Step can be modified to display only the date without the time stamp for ease of use.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). Before using
Tokens, Users need security rights for the following:

◦ Counters

◦ Expressions

◦ Stored Values
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Using Tokens
Users can view, create, and format Tokens.
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View a Token
To view a Token:

• Available Tokens (based on security rights): Use the Token Selector.

• Counters: From the Counter Manager, or from an Expression or Query that uses the Counter Metric.

• Expressions: From the Expression Manager, or from an item that uses an Expression (example:
Image, Background, text, etc.).

• Prompts: From an Expression, One-Step, or Query that uses a Prompt, or when executing an Action
(example: Select an SLA User on an Incident form) that has an associated Prompt.

• Stored Values: From the Stored Value Manager, or from a Query, One-Step, Expression, etc. that
uses Stored Values.

• System Functions: From the Token Selector.
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Add an Existing Token
Each type of Token has specific conditions under which it can be applied. For example, Formats can only
be applied to Fields. However, Tokens can generally be added using the Token Selector.

To apply an existing Token:

1. Open the Token Selector.

2. Click the Expand button to display available values for the desired Token.

The Most Recently Used (MRU) Tokens are displayed, as well as a Browse option for Tokens that
have their own Managers.

3. Click the Token once to add the Token, or click Browse to open a Manager (if applicable).

CSM 9.3.0 Features 1397

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=open_the_token_selector


Format a Token
Some Tokens can be reformatted using Modifiers and Formats that change the visual format or calculated
value of the Token in a One-Step or Expression. For example, a Date/Time field in a One-Step can be
modified to display only the date without the time stamp for ease of use.

• A Modifier is a Token element that changes the visual format or calculated value of a Token in a
One-Step or Expression.

• A Format is a Token formula that controls how characters and digits are displayed in a Text field
(example: When and where to include hyphens, parentheses, spaces, capitalization, etc.).

To apply a Modifier to a Token in a One-Step or Expression:

1. Right-click a Token in a One-Step or Expression.

2. From the context menu, select Modifiers.

3. Select a Modifier from the list to edit an existing Modifier. To create a new Modifier, click the Create
New button.

4. Click OK.4. 

To apply a Format to a Token:

1. Open the Properties window for the Field to add a Format:
a. In CSM Administrator, create a Blueprint.

b. In the Object Manager, double-click the Business Object that contains the Field.

c. Double-click the Field.

The Field Properties window opens.

2. Click the General tab.

3. Check the Format check box.

4. Select the Format to apply:
◦ Click the Ellipses button to open the Stored Format Manager, where you can select an

existing Format (Stored Format) or create a Stored Format. Stored Formats can be used over
and over in numerous places.

◦ Click the Custom Format button to open the Custom Format window, where you can create a
Custom Format to use only for this scenario. A Custom Format has many of the same
properties as a Stored Format, only it does not have a name or description, and is not
managed through the Stored Format Manager.

5. Click OK.5. 
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Use a Counter Token
A Counter is a Token that automatically increases a defined initial value (number) by a defined increment.
Counters can be used while designing Forms, Dashboards, Automation Processes, Expressions, One-
Steps, etc.

When working with Counters, Users can:

• View a Counter.

• Add a Counter to a Stored Expression.

• Add a Counter to a Custom Expression.

• Create, Reset, or Change a Counter.

Before working with Counters, Users must first configure Counters in CSM Administrator:

• Configure Counter security rights: Configure who can access Counter functionality.

• Reset or change a default Counter: CSM ships with several default Counters, including Record
Identifier Counters on each default Form. Ensure that Record ID Counters are appropriate on
specific Forms.
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Use a Prompt Token
A Prompt is a display window that requires Users to provide information before proceeding with a process
or Action (example: Specify the reason for putting an Incident into Pending status).

When working with Prompts, Users can:

• View a Prompt.

• Enter data into a Prompt.

• Create a Prompt.
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Use a Stored Value Token
A Stored Value is a named entity that stores commonly used information so that it can be accessed
and/or reused from various places in CSM, such as One-Steps and Queries.

When working with Stored Values, Users can:

• View a Stored Value.

• Assign values to Stored Values.

• Create a Stored Value.

Before working with Stored Values, Users must first configure Stored Values in CSM Administrator:

• Configure Stored Value security rights: Configure who can access Stored Value functionality.

• Configure values for the default Stored Values (in the Stored Value Manager): CSM ships with
several default Stored Values, including many to help you implement CSM. Use these as-is, edit
them, or create new ones.
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Use a System Function Token
A System Function is a built-in placeholder Token that dynamically adds variable information to a query or
string (example: Current User's name).
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Managing Tokens
Tokens are managed using the Token Selector and the Token context menu.

Use these tools to:

• Apply an existing Token.

• Create a new Token.

Some Tokens are managed using a Manager window. These include:

• Counters

• Expressions

• Stored Values
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Create a Token Using the Token Selector
In some cases, Tokens can be created using the Token Selector. For example, you can create a new
Prompt in a One-Step that sends an e-mail to a Customer about a password reset.

To create a new Token using the Token Selector:

1. Open the Token Selector.

2. Click the Expand button to expand the list for the Token.

3. Click New [Token].

The Define Properties window for the Token opens.

4. Define the properties for the new Token.

5. Click OK.5. 

The new Token becomes available in the Token Selector for future use.
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Visualizations
A Visualization is an interactive graphical representation of related data, represented as a relationship
chain with colored nodes (boxes) and links (arrows). Defined alerts can also be added to indicate potential
risk.
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About Visualizations
A Visualization is an interactive graphical representation of related data, represented as a relationship
chain with colored nodes (boxes) and links (arrows). Defined alerts can also be added to indicate potential
risk.

Use Visualizations to graphically view any type of Relationship in CSM, including:

• Relationships between Configuration Items (CIs) to assess potential risks for an Incident or Change.

• Relationships between personnel (ex: Executive, manager, technician).

• Relationships between Service Level Agreements (SLAs), Operational Level Agreements (OLAs),
Configuration Items, Underpinning Contracts, and Services.

The following example Visualization is a Configuration Map that shows relational data for an Incident:

Some possible uses of Visualizations include:
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• Configuration map.

• Organizational chart.

• Change sources (Incidents and Problems that feed a Change).

A Visualization always starts from a single primary object and shows other objects related to that object
(and objects related to those objects, and so forth). The lines (links) between objects represent
Relationships (possibly multiple Relationships) and the color of the links indicates a set or chain of
associated Relationships.

There are a number of different ways that Visualizations can be laid out in order to show data
appropriately. Also, if an object is in an alert state (ex: If a server is down), the object can show up in a
different color (see Nodes).

Each User has a designated default Visualization, which displays when the User presses SHIFT+F7 from
the Desktop Client. The default Config Visualization is initially selected in CSM Administrator, Globally or
by Role. Access available Visualizations using the Visualization Manager.

CSM provides several OOTB Visualizations to help visualize common business flows. Use these OOTB
Visualizations as-is, edit them, or create your own using the Visualization Manager.
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Primary Object
Visualizations always have a single primary object that is the core of the data. After the first level of
children is loaded, those children might load additional children, etc. The first issue, however, is
determining the primary object.

A Visualization can be set to always use a specific object as its center. This might make sense for an
organizational chart, where you always want the CEO to be at the top, or if you want to monitor a
particular cluster of servers. If a Visualization is tied to a specific primary object, when the Visualization is
displayed, that object will always be primary.

You can identify the primary object in the diagram by the fact that it is somewhat larger than all of the
other nodes. Also, its public ID is shown in the Search box at the top of the screen. The following figure
shows an example of a Vendor as a primary Visualization object.

For non-specific Visualizations, CSM tries to determine the best starting primary object based on the
record that was active in the system when the Visualization was run. It looks for an appropriate object in
the following ways:

• If the active record in the system is appropriate for the Visualization, it will be used. For example, if
you are currently looking at a Computer CI, and the Visualization is for CIs, then that Computer will
be used.

• If the active record in the system has a Relationship tagged as the Configuration Item Relationship,
and the Visualization is for CIs, then the current record in that Relationship will be used.
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• If the active record in the system has a Relationship tagged as the Customer Relationship, and the
Visualization is for customer data, then the current record in that Relationship will be used.

• If the active record has any Relationship that points to the type of data represented by the
Visualization, then the current record in that Relationship will be used.

• Finally, if no active record can be found, the Visualization will be displayed with no current record.
You will have to use the Search option to find a record. This works like any related item selector. You
can type any appropriate terms into the search box, or you can click on the search icon to display a
list of available records.

Note: You are not locked into only that record. You can always search for a different record
to be the primary object using the Search control in the top bar. Alternatively, if the object
that you would like to be primary is already somewhere in the existing Visualization, you can
right-click on that object and select Visualize to make it primary.
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Link Chains
Link chains are chains of Relationships that tie together objects. For example, suppose you want to see
all of the Knowledge Articles that might relate to a particular Change Request. You might have a chain
that looks like this:

• Change Request

• Problems (via Change Request links Problems)

• Incidents (via Problems link Incidents)

• Knowledge Articles (via Incidents use Knowledge Articles)

The item in parentheses is the Relationship. The first item in the chain is always the main object for the
Visualization. After that, you can choose any objects that relate to Change Requests. Once the Problem
object has been chosen, you can then choose objects related to Problems, etc.

When you add the various items in the chain, you can decide whether or not the intermediate objects
should be displayed. For example, the Visualization could show all of the Problems and Incidents, or
could just show all of the Knowledge Articles linked directly to the Change. For more information, see
Defining a Visualization Link Chain.
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Tour a Visualization
The Visualization window shows Visualizations.

Here, you can:

1. Search: Execute a search for an alternative primary object either using the text box or the Related
Item Selector.

2. Adjust Layout and Controls: Select the graphical display option and which Visualizations are
displayed, their size, and how their data is refreshed.

3. View the Main Pane: View Visualizations.

4. View the Aerial Pane: View an overview of the entire Visualization diagram and the portion that is
currently visible. Drag the white box around to change the portion of the Visualization that is shown
in the main view.

5. Use the legend: Control which links and nodes are displayed in the main Visualization pane.
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◦ Link chains (the arrows that link objects within the Visualization) are the primary way that
nodes are related to one another in a Visualization and are made up of one or more
Relationships. The link chains in a particular Visualization are part of its definition, including
the color to use for the links. You can hide or show the nodes and links that make up a link
chain by using the check box next to the link chain in the legend. The figure below shows a
Visualization with links checked and unchecked in an Annealing layout.

◦ Nodes show what color is associated with each type of node in the Visualization. There are
several ways that a color can be determined:

◦ Alert Color: The alert color is part of the Visualization definition. Only Visualizations that
have alerts defined will show this option in the legend. Note that, if alerts are defined, the
Alert node will show in the legend even if no objects are in an alert state.

◦ Associated Color: An administrator can associate a color with a Business Object (In the
Business Object properties, on the Advanced page within a Blueprint). If a color is
associated with a Business Object, then that color will be used.

◦ Automatically Assigned: If there is no other option, the system will automatically assign
a color to each type of node. Note that there is no guarantee that the same color will be
assigned to the same type of objects on future runs.
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Visualizations Good to Know
• Visualizations are dynamic; however, data must be refreshed in order for some changes made to

Visualization objects in order to get the most up-to-date Visualization possible. See the Visualization
Main Pane documentation for more information.

• Visualizations behave differently in the CSM Browser Client. For more information, refer to Browser
Client Visualizations.
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Using Visualizations
Users can Visualizations, modify their layout, and more.
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View a Visualization
To view a Visualization:

• Default Config Visualization:
◦ In the CSM Desktop Client, press SHIFT+F7.

◦ From the Desktop Client menu bar, click Tools>Visualizations>Config Visualization.

• From a record:

◦ Click the Visualization icon  (ex: View impacted CIs on an Incident record).

• Available Visualizations: Use the Visualization Manager.

• MRU Visualizations:
◦ From the Desktop Client menu bar, click Tools>Visualizations, and then select a

Visualization from the MRU list (listed below the line in the menu).

◦ From the Browser Client menu bar, click Visualizations, and then select a Visualization from
the MRU list (listed below the line in the menu).
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Change the Visualization Layout
Visualizations support a number of different layouts that might be more or less appropriate depending on
the type of data being displayed. The default layout used for a particular Visualization is set by the creator
of the Visualization. Unless the option is disabled by that creator, you can change between the various
layouts to find one that seems most appropriate:

• Annealing: Nodes are arranged using a simulated annealing graph, which uses random
associations to try and arrange the data in the most appropriate way.

• Circular: Nodes are arranged in a circle.

• Clustered: Nodes are arranged using a force-directed layout, as with Spring, but groups of nodes
that seem related are separated out slightly.

• Grid: Nodes are arranged into a Grid.

• Layered: Nodes are arranged in layers, keeping connected nodes as close together as possible.

• Orthogonal: Nodes are arranged horizontally and vertically, attempting to avoid overlaps.

• Spring: Nodes are arranged using a force-directed layout that attempts to keep link lengths
between groups of node to a similar length.

• Topological: Nodes are arranged in a row with as few back-links as possible.

• Tree: Nodes are arranged in a tree, with parents having children. This is a good layout to use if you
will never have nodes that point back to other points in the tree.

To change the Visualization layout:

1. View a Visualization.

2. Use the drop-down menu to select the type of layout.

3. Click the Rearrange Layout button  to refresh the Main pane using the selected layout.
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View Information about a Visualization Node
In addition to the visual queues of the node (color, node name, alert status, etc.), you can view
information about a Visualization node using:

• Tooltips.

• Quick View.

To view information about a Visualization Node:

1. View a Visualization.

2. Do one of the following:
◦ Hover over a node to see tooltips for the record. The field information is based on Search

results settings for the node's Business Object. For details, refer to Configuring Visualization
Tooltips.

◦ Double-click or right-click a node to open a quick-view window of the record.
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Search for a Specific Record in the Visualization
Window

Use the Search box/Related Item Selector in the Visualization window to search through records (ex:
Incident number, Vendor, configuration items, etc.).

To execute a search within the Visualization window:

1. View a Visualization.

2. In the Search box, provide text to search for (ex: Incident 10106). If the Visualization was launched
from a record, this is auto-populated.

3. To select records related to your search, click Related Item Selector.

The Related Item Selector opens in a new window.

Click a record to highlight it, and then click OK.

4. To open the record specified in the search bar, clickGo to Record .
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Go to a Record from the Visualization
You can view a record directly from a Visualization.

Go to a record from a Visualization:

1. View a Visualization.

2. Do one of the following:
◦ Double-click a node to open the record.

◦ (Desktop Client only) Right-click a node to open the context menu, then select either:
◦ Go to record: This option closes the Visualization and makes the selected record the

main record.

◦ Go to record in new window: This options closes the Visualization and takes you to the
selected record, but instead of doing so in the current window, it opens a new window, so
as not to disturb your current record.

CSM 9.3.0 Features 1419

CSM 9.3.0 Features



Show/Hide Visualization Links and Nodes
Each Visualization has a list of links and nodes that can appear, which are determined when the
Visualization is created. To hide or show these items, use the check boxes in the Legends area of the
Visualization window:

To show/hide Visualization links and nodes:

1. View a Visualization.

2. Do one of the following:
◦ To show a link or node, check the item.

◦ To hide a link or node, uncheck the item.

Note: If you have security rights, you can add, edit, or delete the links and nodes that
appear in the Legends area. For more information, see Create a Visualization.

CSM 9.3.0 Features 1420

CSM 9.3.0 Features



Managing Visualizations
Visualizations are managed in CSM using the Visualization Manager.

There are several ways to open the Visualization Manager.

Use the Visualization Manager to complete general CSM Item Manager operations for Visualizations,
including:

• View a list of available Visualizations.

• Create a Visualization.

• Edit a Visualization.

• Delete a Visualization.

• Search for a Visualization.

• Organize Visualizations.

• Copy a Visualization.

• Import/export a Visualization.
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• Find Visualization dependencies.

• Pin a Visualization.
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Open the Visualization Manager
To open the Visualization Manager:

• From the CSM Desktop Client menu bar, click Tools>Visualization>Visualization Manager.
• From the Browser Client menu bar, click Visualizations>Visualization Manager.
• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Visualization Manager.
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Create a Visualization
Use the Visualization Properties window (accessed from within the Visualization Manager) to create or
edit a Visualization.

To create a Visualization:

1. Open the Visualization Manager.

2. Select a scope and subfolder (if needed).

3. Click Create New .

The Visualization Properties window opens.

4. Define the following properties:
◦ General:

Name, Description, Layout, etc.

◦ Links:

Links chains (Relationships) that appear on the Visualization.

◦ Alerts:

Alert conditions to make particular nodes stand out on the Visualization. As well as being a
different color, alert text shows up in the title and on the tooltip for the node.

5. Click OK.5. 
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Define General Visualization Properties
To define general properties for a Visualization:

1. Open the Visualization Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button .

The Visualization properties window opens.

4. Click the General page.

5. Define general properties:
a. Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

b. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

c. Object Type:

Select the Business Object to display in the Visualization (ex: Task, Incident, Vendor, etc).
After you select and save a Business Object, you cannot change this value.

Note: The list is normally limited to major and supporting objects, but if you want to see all
objects in the system, click Show all to include lookup tables.

d. Layout:

Select the default layout (way to arrange nodes on a Visualization).

e. Allow other layouts:

Select this box to allow Users to select different layouts when they view the Visualization.

f. Tie to specific record:

Select this box to tie the Visualization to a specific Business Object rather than record
currently being edited. Then, search for an appropriate record to be the primary object of your
Visualizations.

Note: Normally, when you run a Visualization, it determines the primary object for the
display based on the record currently being edited by the user. However, there are
times when you always want a particular object to be the primary object for a
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Visualization. For example, to see the status of a server farm, you might choose a
controlling server that is related to all of the server farm machines.

6. Click OK.6. 

CSM 9.3.0 Features 1426

CSM 9.3.0 Features



Define a Visualization Link Chain
Use the Links page to define:

• Which Link Chains are displayed on a Visualization.

• Order in which Links Nodes are displayed on the Visualization window legend.

To define a Visualization Link Chain:

1. Open the Visualization Manager.

2. Select a scope and subfolder (if needed).

3. Click Create New .

The Visualization Properties window opens.

4. Click the Links page.

5. Define which Link Chains to display on the Visualization:
a. Click Add.

The Edit Link Chain window opens.

b. Define general properties:

Property Description

Name Provide a name for the link.

Link Color Select a color for the link.

Show this link chain by default

Select this check box to make the chain visible
by default. If you clear this check box, the item
is still displayed on the Visualization legend,
but no data is retrieved until the user explicitly
selects the check box next to it.

c. Click Add, and then select a Business Object to add to the Relationship link chain. A list of all
available objects that are related to the last entry in the list appears.

Example: If we started with Change Requests, we would see only Relationships related to
Changes. After we choose the Relationship to Problems, we would see Problem
Relationships, and so forth.

After you select a Relationship, the Link Member window opens.

Note: When you first open this window, it has only one item, the name of the main
object for the Visualization. In the example above, we have already added one
Relationship.
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d. Specify details of the Business Object in the Link Chain:
◦ Show text on link:

Select this check box to always display text on the Visualization’s link line in the
Visualization. For example, you might put in text like "Depends on" or "Uses."

◦ Show join reason on link:

(Only available if the Relationship uses a join table and has join reasons enabled). Select
this check box to display the join reason on the link line.

◦ Filter, Limit to Type:

Select this check box to limit the displayed nodes to just a single type (if the Relationship
is to a group). For example, when displaying Configuration Items, you could select to
only show Computers.

◦ Filter, Limit by join reason:

(Only available if the Relationship uses a join table and has join reasons enabled). Select
this check box to limit the displayed nodes to ones that have a particular join reason.

◦ Filter, Limit Expression:

Select this check box to limit to use an Expression to limit the records. Only children that
meet the Expression condition will be displayed.

◦ Show this object on Visualization:

Normally, when you put an object into the Visualization, you want nodes to be displayed
for all children. However, you might want the intermediate object to be ignored, and the
children of the "hidden" node be displayed as though they linked directly to the parent.
With the Change/Knowledge Article example, we would turn off this check box for
Problems and Incidents.

e. Click OK.e. 

6. Repeat last link object:

If the parent and the child of the last item in the chain both point to the same type of object (in the
example, Configuration Item), then you can make the Visualization extend the chain via the last
Relationship multiple times. This has the same result as adding the Configuration Item (via CI links
Upstream Items) multiple times into the list.

Example: You have a configuration item A with upstream configuration items B, C and D. If B also
has upstream items E and F, and F has upstream items G and H, all of these would be shown. If you
didn’t repeat, you would just see A, B, C and D.

If the last Relationship in the chain does not have the same parent/child, the repeat option is
disabled.
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7. Suppress links between an object and itself:

Select this check box to ignore Relationships that point directly to themselves. If this check box is
cleared, links are shown via short arrows that go from and to the same object.

Example: If configuration item A had a Relationship to configuration item A, that would not be
shown.
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Define a Visualization Alert
Use the Alerts page (accessed within the Visualization Properties window) to define:

• Alert color.

• Alert condition: To make particular nodes stand out on the Visualization.

As well as being a different color, alert text shows up in the title and on the tooltip for the node.

To define a Visualization alert:

1. Open the Visualization Manager.

2. Select a scop and subfolder (if needed).

3. Click Create New .

The Visualization Properties window opens.

4. Click the Alerts page.

5. Select the color to indicate that a Business Object is in an alert state. The same alert color will be
used for all alert conditions.

6. Define the alert conditions for different types of Business Object. You can only define one alert
condition for each type of Business Object.

a. Click the Add button to add a new alert condition.

The Edit Alert window opens.

b. Alert on Object: Select the Business Object on which to set an alert. Note that the list lets you
select Business Objects that might not necessarily show up on the Visualization.

c. Alert Condition: Define the alert condition, using either:
◦ Custom Expression:

Click the Custom Expression button to open the Custom Expression Builder, and then
create a custom Expression specifically for this scenario.

◦ Stored Expression:

Click the Ellipses button to open the Expression Manager, and then select an existing
stored Expression or create a new stored Expression. Stored Expressions can be reused
in numerous places in CSM.

d. (Optional) Alert Text:

Provide the text to appear in the title and tooltip for nodes in the alert status.

Tip: As well as static text, you can also insert Field values, etc., into the Alert Text by right-
clicking in the Alert Text control, or by clicking the arrow button to the right of the control. For
example, you might insert the Date/Time when the system went down.
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e. Click OK.e. 

7. Click OK.7. 
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Configuring Visualizations
Configure Visualizations with the following tasks:

• Configure Visualizations security rights.

• Select a default global Visualization.

• Select a default Role Visualization.

• Configure Visualization tooltips.
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Select a Default Global Visualization
Use the System Settings window in CSM Administrator to select the default Global Visualization.

Good to know:

• Default Role Visualizations override the Global default Visualization.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default config Global Visualization:

1. Open the System Settings window (CSM Administrator>Settings>Edit System Settings).

2. Click Dashboards, etc.

The Dashboards, Calendars, and Visualizations page opens.

3. Click the Visualization button  to the right of the default Visualization.

4. Select a Visualization to be the default. Be sure to select a Visualization that everyone can access
(Global scope).

5. Click OK.5. 
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Select a Default Role Visualization
Use the Role Manager in CSM Administrator to select the default Role Visualization.

Good to know:

• If no default Role Calendar is selected, the Global default is used.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To select a default Role Visualization:

1. Open the Role Manager.

2. Click the Role for which you want to select a default Visualization.

The Role Profile appears in the Manager window.

3. Select the default Role Visualization:
a. Use default: Select this radio button to use the default Global Visualization.

b. Visualization: Select this radio button to use a default Role Visualization. Then, click the

Visualization button  to open the Visualization Manager, where you can select an existing
Visualization or create a new Visualization to use as the default. Be sure to select a
Visualization that everyone in that Role can access.

4. Click Save.
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Configuring Visualization Tooltips
Users can hover over a Visualization node to get more information about the record:

• Alert text, if applicable

• Public ID

• Field information based on Search results settings for the node's Business Object.

To see which field information is used for Visualization tooltips:

1. Open the CSM Administrator.

2. Create a Blueprint.

3. Open the Business Object Editor for a specific Business Object.

4. Open the Search Results page.

5. The fields selected for these options are used for Visualization tooltips:
◦ Link text: List of fields

◦ Body text: List of fields

CAUTION: If you modify the fields for Visualization tooltips, your change also applies to Search
results.
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Widgets
A Widget is a mechanism that displays information about a Dashboard or Portal Site. Example Widget
types include: Chart, Gauge, and Button.
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About Widgets
A Widget is a mechanism that displays information about a Dashboard or Portal Site. Example Widget
types include: Chart, Gauge, and Button.

CSM Widgets are either:

• Data-driven: Displays CSM or external data (example: Action Catalog, Browser, Chart, Gauge,
Matrix, Search Control, Search Result, Twitter feed, or RSS feed).

• Standard: Enhances design and functionality (example: Button, Image, Link, Text, or Shape
(Ellipses, Rectangle, or Tab)). Buttons and Links can execute a single Action (example: Run an
Action).

CSM provides a variety of highly configurable Widgets:

Icon Widget Description

Data-Driven Widgets

Action Catalog Displays a self-building and dynamic catalog of executable Actions.

Browser Displays a website or HTML Page.

Chart
Displays a data graph. This can be a Bar, Column, Doughnut, Line, Pie,
Pipeline, or Scatter chart (or combination). The icon varies depending on
the type of Chart.

Command Palette Displays a list of executable Actions.

Filter Filters other Widget data by date, lookup table, or Query.

Gauge
Displays a single value and optional range data as a graph. Styles include
linear (horizontal, vertical, and thermometer), numeric (digital and
mechanical), speedometer, and text.

Matrix Displays data from various Queries, broken up into rows and columns.

RSS Feed Displays the latest items from an RSS feed.

Search Displays a Search Control that can be used to run a Quick Search or a
Specific Search.

Search Results
List Displays the results of a search, either as a list of links or in a Grid.

Twitter Feed Displays entries from a Twitter account or Search.

Standard Widgets (Shapes, etc.)
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Icon Widget Description

Button Button that is capable of executing a single Action when clicked (example:
Run an Action).

Image Custom image used to enhance the appearance/usability of a Dashboard.

Link Underlined text that is capable of executing a single Action when clicked
(example: Run an Action).

Text
Text that identifies or enhances other Dashboard elements (example: The
Dashboard itself, area, Widget, group of Widgets, etc.). A Text Widget is
technically a Gauge Widget.

NA Shape Various shapes (Ellipses, Rectangles, and Tabs) that organize other
Widgets and enhance the appearance/usability of the Dashboard.

Tab Group Display plain or rich text in a tabbed format.

CSM provides a plethora of OOTB Widgets, designed to display data on a Dashboard or Portal Site. Use
these OOTB Widgets as-is, edit them, or create your own using the Widget Manager.
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Action Catalog Widgets
An Action Catalog Widget displays a self-building and dynamic list (catalog) of executable Actions.
Actions are displayed as hyperlinks that execute when clicked and can be hierarchically grouped in drill-
down levels. Use the Action Catalog Widget to build a dynamic Service Catalog that is organized by
Category and Service, and is capable of executing Actions that:

• Create categorized Incident and Service Request records.

• Create Tasks.

• Send e-mails.

• Launch Document Repositories.

• Etc.

Note: Action Catalog Widgets can be used on a Dashboard or as a stand-alone Widget in
the Portal.

The Action Catalog style (List, Rounded List, Columns, Rounded Columns, or Metro) controls the fonts,
colors, and layout. Images can be added to enhance navigation and visual experience. Styles are based
on Cascading Style Sheets (CSS) and can vary the functionality of the Action Catalog (example: The
Metro style can display only three levels in a hierarchy, some styles cannot display an image next to the
highest level, etc.).

The following figure shows an example Service Catalog that can be displayed in a Portal. The example
Service Catalog lists Actions (example: One-Time Conference Setup and Request Account) and
hierarchically groups them by Category (example: Equipment Request or Video/Audio Conferencing) and
Service (example: Conferencing/Presentation). When a Customer clicks an Action hyperlink, an Action
executes (example: Request Account creates an Incident record and categorizes it as a Request). The
Action Catalog's theme (example: Metro Blue) controls the fonts, colors, block layout, etc.
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Good to know:

• An Action Catalog Widget is highly configurable; define the Actions list, how and when to display the
Actions, and how to hierarchically group the Actions.

• Note: The OOTB Action Catalog Widget is the Service Catalog. It cannot be embedded in a• 
Dashboard; it is a stand-alone Widget.

• An Action Catalog Widget can be used on a Dashboard or as a stand-alone Widget in the Portal.

• An Action Catalog Widget is built in levels from the bottom up, starting with Actions.

• Each level can have:
◦ Images (except the highest).

◦ Description.

◦ Ascending or descending sort order.

◦ Go To button  to navigate directly to a record.

◦ Options for displaying items:
◦ Display all items no matter how many there are.

◦ Make the Customer drill down to see the items.

◦ Display X number of items and then a More button for displaying more.
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◦ Each level can be shown or hidden.

• Each item in a level can be enabled or disabled.

• Click the Preview button at any time to view the catalog as you build/design it. You can even drill-
down into the groups to see how Actions are hierarchically organized.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.
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Browser Widgets
A Browser Widget displays a website or an HTML Page. Use a Browser Widget to display:

• Your company's website.

• A website that Users access often (a hardware troubleshooting site, a forum, etc.).

• A custom CSM-built HTML Page for an IT or HR department.

The following figure shows an example Browser Widget.

Good to know:

• A Browser Widget is highly configurable; define the website or HTML Page to display, and the
refresh rate.

• Refresh executes only when a Widget is active and being displayed. If you leave a Dashboard and• 
come back to it, the data will be automatically refreshed, and the refresh timer will start over.

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.
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Chart Widgets
A Chart Widget displays one or more data series as a data graph. Use a Chart Widget to display the:

• Number of records created today.

• Number of Incidents by status or department.

• Mean Time to Resolve (MTTR) by priority.

• Number of open and resolved Incidents this week.

• Workload by Team.

The following figure shows several example Chart Widgets.
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CSM provides the following types of charts:

Chart Types

Chart Type Description Example

Bar
A Bar Chart is a chart with horizontally-plotted bars (categories) with lengths
proportional to the values that they represent. Use a Bar Chart to compare
values.
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Chart Type Description Example

Column
A Column Chart is a chart with vertically-plotted bars (categories) with
columns proportional to the values that they represent. Use a Column Chart
to compare values.

Line A Line Chart is a chart that displays information as a series of data points
connected by straight line segments. Use a Line Chart to track patterns.

Scatter
A Scatter Chart is a chart that plots two axes of data points (an x-axis and a
y-axis) as a set of points scattered on a graph. Use a Scatter Chart to track
correlations within an interval.

Doughnut

A Doughnut Chart is a circular chart with a hole in the center that is divided
into sectors (often called slices), each of which represents a proportion to a
whole. The size of each slice is determined by the series value as a
percentage of the total of all values.

Pie
A Pie Chart is a circular chart that is divided into sectors (often called slices),
each of which represents a proportion to a whole. The size of a slice is
determined by the series value as a percentage of the total of all values.

Pipeline
A Pipeline Chart is a funnel chart that displays values as progressively
decreasing proportions. The size of the area is determined by the series
value as a percentage of the total of all values.

Good to know:

• A Chart Widget is highly configurable; define general properties (ex: Title, refresh rate, and filter
exclusion), data series properties (ex: Chart type, Business Object association, data to include,
values for the x- and y-axes, grouping options, custom colors, combine values (clustered, stacked,
or stacked 100), analysis formulas, and drill-down behaviors), x- and y-axes properties, legend
properties, and display properties (ex: Labels, grid lines, tooltips, color palette for items in the chart,
etc.).

• By default, a Chart Widget acquires its font, colors, background style, and border style from the
defined Dashboard Theme; define your own properties, if needed.

• Series combinations must be valid. Bar, Doughnut, Pie, and Pipeline series should be the only data
series in their Chart Widget. Column, Line, and Scatter can be combined in any way or number but
you cannot mix field types (date, number, or text). For more information about data series, see
Define a Series for a Chart Widget.

• Bar and column series can be stacked (series atop each other). For more information about
stacking, see Stacked Bar/Column Charts.

• Typically, on a Chart Widget, the x-axis is the horizontal axis and the y-axis is the vertical axis. On
Bar Charts, the axes are opposite.

• Bar, Column, Line, and Scatter work the same way, differing only in the way the data is presented.
Pie and Doughnut are also similar. Pipeline charts are unique.

• A preview of the Widget (with randomly generated data) is available at the top of the window. Use• 
this to preview your Widget as you build it.
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• Refresh executes only when a Widget is active and being displayed. If you leave a Dashboard and• 
come back to it, the data will be automatically refreshed, and the refresh timer will start over.

• Use refresh on Widgets where the data is likely to change (ex: A Widget displaying Incident data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.

• For more information about Chart Widgets, refer to the Modifying Chart Widgets course available in
the Cherwell Video Learning Library (subscription-based).
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Stacked Bar/Column Charts
A Stacked Bar/Column Chart is a chart that stacks multiple data series on a single horizontal or vertical
bar. The size of each data segment is determined by the series value plotted on a common (discrete) axis
value. Use a stacked bar/column chart to compare amounts by category. Examples include:

• Number of Problems by Team stacked on common Date bars (example: Q1, Q2, Q3, and Q4).

• Number of Incidents by category stacked on common Date bars (April, May, June, etc.).

• Number of priority 1-3 Incidents stacked on common status bars (example: Assigned, Closed, In
progress, etc.).

CSM provides two types of stacked bar/column charts:

• Stacked: Data segment is proportional to its value (therefore, stacks will likely appear staggered or
uneven).

• Stacked 100: Data segments total 100% (therefore, all stacks will be the same height).

Stacked Stacked 100

Multiple stacks are also supported. For example, you can stack series 1 and 2 on a common stack (stack
group 1), and series 3 and 4 on another stack (stack group 2), if needed.

Good to Know:
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• Column series can be stacked in any number of stacks at a single x-value.

• Column series, stacked or not, can still be combined with other series types (example: Line and
scatter).

• Bar series can be stacked in any number of stacks at a single x-value.

• The stacking modes are Clustered (no stacking – default), Stacked, and Stacked100.

• Bars/Columns using the Stacked100 combine mode option must be associated with a y-axis such
that all series associated with that axis use the Stacked100 combine mode.

• Formulas cannot apply to stacked series. Because the origin of the stacked points are not at the x-
axis, stacked series points are not drawn at their actual Cartesian coordinates.

• When a series is grouped, all resulting series use the combine mode as specified for the original
series. For example, if you define a single series as stacked, all the series resulting from the
grouping will be stacked in the same group.

• Stacking is not supported for a continuous numeric x-axis (column and bar). No combine mode
options will be shown for that scenario.

• Point labels will not be shown for stacked points, but will continue to be shown for clustered points.
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Command Palette Widgets
A Command Palette Widget displays a list of one or more executable Actions that can:

• Run a Command, One-Step, Report, or Search.

• Display a CSM Item, such as an Action Catalog, Calendar, Dashboard, Document Repository,
HTML Page, or Visualization.

A Command Palette Widget can have:

• A single Action (ex: Run a One-Step, run a report, display another Dashboard, etc.).

• Several ungrouped Actions.

• A group of similar Actions organized by folders.

The following figure shows an example Command Palette Widget with a group of Actions organized by
folder.

Good to know:

• A Command Palette Widget is highly configurable; define which Actions to execute and how to
group the Actions.

• By default, a Command Palette Widget acquires its text, color, background style, and border style
properties from the defined Dashboard Theme; however, you can define your own properties, if
needed.

• To execute a single Action, drag a button or link from the "Shapes, etc." section of the Widgets tree
in the Dashboard Editor, then right-click the button or link and select Widget Properties from the
context menu. The window opens, allowing you to select a single Action.

• A Button or Link Widget (Shape Widget) can also be used to execute a single Action.
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Filter Widgets
A Filter Widget filters other Widgets (Chart, Gauge, and Matrix) by:

• Date: Filters data by date range (ex: All, Today, Yesterday, Within last 1 week/month/quarter/
year, custom range, etc.).

A Date Filter Widget uses a drop-down to show the filtering options.

• Lookup table values: Filters data by a value in a lookup table (example: Filter Incidents by
Status—Assigned, Closed, In Progress, Assigned, New, etc.).

A Lookup Table Widget uses a drop-down to show the filtering options.

• Query: Filters data using a defined Query (example: My Incidents—Incidents owned by me).

A Query Filter Widget uses a toggle button to turn the filter on/off.

Good to know:

• A Filter Widget is highly configurable; define the Business Object to filter and the filtering option
(example: Date, Lookup value, or Query).

• A Filter Widget must be associated with the same Business Object as the Widget(s) it limits
(example: If the Filter Widget is going to limit Incidents, the Widget must be associated to the
Incident Business Object). A Date/Time filter is the only exception; it can filter Widgets associated
with other Business Objects (example: Problem).

• You can combine filters on a Dashboard (example: Filter by date, status, and User); however, you
can have only one Date/Time filter per Business Object type. If you add multiple Date/Time filters,
only the value from one will be used.

• Consider the criteria you are using to filter your individual Dashboard Widgets before you add a
Filter Widget to a Dashboard. For example, if you are using a Search Group or Date Range to filter
a Widget to a specific date range, consider how a Date/Time Filter (essentially a second filter) on a
Dashboard might conflict with that.

• A Filter Widget does not support a background; therefore, no color or style can be applied.
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Gauge Widgets
A Gauge Widget displays a single data point, possibly with some range data. Use a Gauge Widget to
display the:

• Number of Incidents Opened/Closed today (Text).

• Number of Incidents assigned to me (Text).

• Number of Open Priority 1 Incidents (Thermometer).

• Customer Experience rating (Speedometer).

The following figure shows an example of Gauge Widgets on a Dashboard.

CSM provides several types of gauges:

Gauge Type Example

Horizontal Linear

Numeric (Digital or Mechanical)

Speedometer (Angle, Rectangular, Round, Round Rectangular)
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Gauge Type Example

Text

Thermometer Linear

Vertical Linear

Good to know:

• A Gauge Widget is highly configurable; define general properties (example: Gauge type, title,
Business Object association, refresh rate, and filter exclusion), data to include, values to display,
scale options, threshold options, text and number formats, drill-down behaviors, and display
properties.

• A preview of the Widget (with randomly generated data) is available at the top of the window. Use• 
this to preview your Widget as you build it.

• Refresh executes only when a Widget is active and being displayed. If you leave a Dashboard and• 
come back to it, the data will be automatically refreshed, and the refresh timer will start over.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.

• By default, gauge colors (banner, labels, face, grid line/tick, and threshold) and style (flat, chrome, or
none) come from the defined Dashboard Theme; however you can override some of the properties.
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Matrix Widgets
A Matrix Widget displays data from various Search Queries that are broken up into rows and columns.
Use a Matrix Widget to show by fiscal year or quarter, the number of:

• Incidents

• Problems

• Changes.

Each row can be:

• A time period (example: A row for each month of the year).

• A particular value (example: Each supported category).

Each column can be:

• Determined by a Query (example: The number of Incidents closed in the specified month or for the
specified category).

• Calculated based on other columns.

• A specialized display column for presenting data (a rating could show stars to represent a value, or
a value bar could show how close to target a value approached).

Data can be pulled from multiple Business Objects and can be shown side-by-side.

The following figure shows an example Matrix Widget.

Good to know:

• A Matrix Widget is highly configurable; define general properties (example: Title, associated
Business Object, refresh rate, drill-down, and filter exclusions), rows, columns, and appearance.
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• By default, a Matrix Widget acquires its text, color, border style, and background style properties
from the defined Dashboard Theme; however, you can define your own properties, if needed.

• Refresh executes only when a Widget is active and being displayed. If you leave a Dashboard and• 
come back to it, the data will be automatically refreshed, and the refresh timer will start over.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.
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RSS Feed Widgets
A Really Simple Syndication (RSS) Feed Widget displays frequently updated information, such as news
or blog entries, from a particular feed. The Widget can also launch a One-Step so that you can act on a
feed (example: Create an Incident from a feed or send an e-mail about the feed). One-Step Actions are
displayed on the context menu (the right-click menu) for each item.

The following figure shows an example RSS Feed Widget.

Good to know:

• An RSS Feed Widget is highly configurable; define the RSS feed to display in the Widget, the
maximum number of feeds to display, whether or not to display images, the color of the links, the
refresh rate, and an optional One-Step to initiate from the Widget.

• By default, an RSS Feed Widget acquires its text, color, background style, and border style
properties from the defined Dashboard Theme; however, you can define your own properties, if
needed.

• In most browsers, you can right-click the RSS feed icon  and select Copy Link Location or
Copy Link to copy the URL onto your clipboard. You can then paste it into the RSS Feed URI text
box in the RSS Widget window. A number of technical tools also expose RSS feeds in various ways
(including CSM).

• Before an RSS Feed Widget can be used, you must enable RSS feeds (CSM
Administrator>Browser and Mobile Settings>Browser Settings).

• In order to initiate a One-Step from an RSS Feed Widget, the One-Step must have access to the
contents of the feed. This is done by adding the RSS Item Tokens to the Conditions page of the
One-Step. For example, when you add the RSS Item Tokens, you can then e-mail details contained
in the feed. Refer to the One-Step documentation for more information.
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• Refresh executes only when a Widget is active and being displayed. If you leave a Dashboard and• 
come back to it, the data will be automatically refreshed, and the refresh timer will start over.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.
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Search Results List Widgets
A Search Results List Widget displays a list of records (as links or in a Grid) that meets a search criteria.
Use a Search Results List Widget to display a list of:

• My open Incidents

• My Team's Tasks

• Discussions

The following figure shows an example Search Results List Widget.

Good to know:

• A Search Results List Widget is highly configurable; define the general properties (example: Title
and Business Object association), display properties (example: Grid or as clickable links), search
criteria (ex: Search Group or a custom Search Query), date range, and refresh rate.

• By default, a Search Results List Widget acquires its text, color, border style, and background style
properties from the defined Dashboard Theme; however, you can define your own properties, if
needed.

• Refresh executes only when a Widget is active and being displayed. If you leave a Dashboard and• 
come back to it, the data will be automatically refreshed, and the refresh timer will start over.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.
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Search Widgets
A Search Widget displays a Search Control that can be used to run the following types of searches:

• Quick Search: A Quick Search is a simple query that quickly finds all records containing a specific
word or phrase (example: Show all records whose description contains the word "phone"). Search
options, such as record type, status, etc., are typically predefined to simplify the search, and vary
depending on the purpose and location of the search. Quick Search is a Full-Text Search, so it
searches all fields that have Full-Text search enabled (even those that are not specified) and finds
similar words, as well.

• Specific Search: Quick Search that quickly finds all records of a specific type that contain a specific
word or phrase (example: Show all Incident records that contain the word printer). Options are
predefined for each record type to simplify the search but can be changed when searching.

Note: A Search Widget can be used on a Dashboard or on a menu bar.

The following figure shows an example Search Widget that might appear on a Dashboard, on the CSM
Desktop Client menu bar, or in the Portal.

Good to know:

• A Search Widget is highly configurable; define which type of Search can be run from the Widget
(example: Quick Search, Specific Search, or both), a default Search, and Search behaviors
(example: Business Object to search, watermark, and/or logic, sort, and filters).

• The OOTB Search Widget is the CSM Search Control, located in the upper right corner of the CSM
Main window.

• A Search Widget does not support a background; therefore, no color or style can be applied when
the Widget is added to a Dashboard.
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Twitter Feed Widgets
A Twitter Feed Widget displays entries from a Twitter account or search. The Widget can also launch a
One-Step so that you can act on a feed (example: Create an Incident from a feed or send an e-mail about
the feed). One-Step Actions are displayed on the context menu (the right-click menu) for each item.

The following figure shows an example Twitter Feed Widget.

Good to know:

• A Twitter Widget is highly configurable; define the Twitter account to display, what to display in the
feed (example: User's Tweets or Search Results), the maximum number of Tweets to display, the
color of the links, the refresh rate, and an optional One-Step to initiate from the Widget.

• By default, a Twitter Feed Widget acquires its text, color, border style, and background style
properties from the defined Dashboard Theme; however, you can define your own properties, if
needed.

• Prior to CSM 4.60, it was possible to subscribe to a Twitter feed or search without providing a Twitter
account. However, Twitter no longer allows anonymous access to feeds. Any anonymous Twitter
Widgets will now display an error. Twitter has delayed enforcing this rule, so anonymous Twitter
Widgets might have continued to operate, but CSM has been updated to use the new Twitter API to
avoid all Twitter Widget failures when Twitter finally ends support for their old API.

• Before a Twitter Widget can be used, you must integrate CSM with Twitter by creating a CSM
Twitter account that links to a registered Twitter account.

• A feed can show the contents of a particular account or the results of a search term, such as
references to a particular hashtag (see Twitter’s site for details on various supported search
options).
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• Because Twitter is a world-wide service, ensure that the searches make sense for your company
("Cherwell," for example, also brings up numerous references to the area and river in England from
which we get our name!).

• To initiate a One-Step from a Twitter Feed Widget, the One-Step must have access to the contents
of the feed. This is done by adding the Tweet Tokens to the Conditions page of the One-Step. For
example, when you add the Tweet Tokens, you can then e-mail details contained in the Tweet. For
more information about defining Send Tweet Actions, refer to the One-Step documentation.

• Refresh executes only when a Widget is active and being displayed. If you leave a Dashboard and• 
come back to it, the data will be automatically refreshed, and the refresh timer will start over.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.
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Tab Group Widgets
Use a Tab Group Widget to create a set of tabs. The tabs can contain plain text or rich text to display
formatted text, images, hyperlinks, and more.

Good to know:

• Each Tab Group can have an unrestricted number of tabs.

• Tab Groups do not inherit theme formatting.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.
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Standard Widgets
A Standard Widget is a Widget that enhances the appearance and usability of a Dashboard. CSM
provides the following Standard Widgets:

• Button: Executes a single Action when clicked (example: Run a Report, send an e-mail, create a
new Incident, etc.).

• Image: Displays a custom image (example: Company logo, employee photos, icons to indicate
breached SLAs, etc.).

• Link: Executes a single Action when clicked (example: Drill down into another Dashboard, open the
Dashboard Manager, etc.).

• Text: A "floating" Widget that textually identifies or enhances other Dashboard elements (example:
The Dashboard itself, area, Widget, group of Widgets, etc.).

• Shapes (Ellipse, Rectangle, Rounded Rectangle, Tab, and Rounded Tab): Widgets that can be
used to organize other Widgets to enhance the usability/appearance of a Dashboard.

Good to know:

• Standard Widgets are highly configurable and vary by type.

• A Text Widget is technically a Gauge Widget.

• Button and Link Widgets can execute a single Action.
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• By default, most Shape Widgets acquire their text, colors, border style, and background style
properties from the defined Dashboard Theme; however, you can define your own properties, if
needed.

• Image Widgets do not support text, background, foreground, or border colors; therefore no colors,
styles, or fonts can be applied.

• By default, Text Gauge Widgets have a transparent background. To manually add a background,
right-click the Widget, select a background style, and then select a background color and border
color.
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Widgets Good to Know
• A Widget is a mechanism that displays information about a Dashboard or Portal Site (example:

Chart, Gauge, Button, etc.).

• Pin items to a Pinboard (in the Manager) and MRU list (in the CSM Desktop Client menu bar) to
make them easily accessible in CSM.

• CSM provides a plethora of OOTB Widgets, designed to display data on a Dashboard or Portal Site.
Use these OOTB Widgets as-is, edit them, or create your own using the Widget Manager.

• After you create a Widget, use the Dashboard Editor to add the Widget to a Dashboard. You can
also create Widgets from within the Dashboard Editor.

• After adding a Widget to a Dashboard, define how the Widget looks and behaves on the Dashboard
(example: Label, size, style and gloss, image, alignment, anchoring, layering, and visibility).

• A Dashboard Theme controls the colors and styles of the Dashboard and its Widgets, and gives the
Dashboard a cohesive look. The Dashboard Theme is defined as part of the Dashboard's Display
properties but can be overridden at a Global, Role, User, or Widget level. For more information, see
Dashboard Themes.

• See Dashboard Editor Behaviors for tips on working with Widgets on Dashboards.

• Consider using folders to organize your Widgets. For example, organize your Widgets by Type
(Search Widgets), Dashboard (Default Technician Dashboard), or Automation Process (Incident
Widgets).

• Be descriptive with Widget names so that you can easily identify/sort/search for them in CSM. For
example, consider including in your naming convention the type of Widget or where/how it is used.

• Click the Info button at the bottom of the property page to view the Widget's name, scope, and
folder.

Always consider the following:

• CSM is highly configurable. As a result, a User's system may vary from the Out-of-the-Box content• 
in our documentation.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For more
information, see Configure Dashboard Security Rights.
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Using Widgets
When working with Widgets, Users can:

• View a Widget.

• Interact with Widgets on a Dashboard (refer to Using Dashboards).
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View a Widget
To View a Widget:

• Available Widgets (based on security rights): Use the Widget Manager.

• On a Dashboard.

• Stand-alone Widget in the Portal.
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Managing Widgets
Widgets are managed using the Widget Manager.

There are several ways to open the Widget Manager.

Use the Widget Manager to complete general CSM Item Manager operations for Widgets, including:

• View a Widget.

• Create the following types of Widgets:
◦ Create a Widget (general).

◦ Create an Action Catalog Widget.

◦ Create a Browser Widget.

◦ Create a Chart Widget.

◦ Create a Command Palette Widget.

◦ Create a Filter Widget.

◦ Create a Gauge Widget.
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◦ Create a Matrix Widget.

◦ Create an RSS Feed Widget.

◦ Create a Search Widget.

◦ Create a Search Results List Widget.

◦ Create a Twitter Feed Widget.

◦ Create a Tab Group Widget.

◦ Create a Shape Widget.

• Edit a Widget.

• Delete a Widget.

• Search for a Widget.

• Organize Widgets.

• Copy a Widget.

• Import/export a Widget.

• Find Widget dependencies.

• Pin a Widget.

Note: After you create a Widget, use the Dashboard Editor to add the Widget to a
Dashboard, and then define how a Widget looks and behaves on the Dashboard.
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Open the Widget Manager
There are several ways to open the Widget Manager:

• From the CSM Desktop menu bar, click Dashboards>Widget Manager.
• From the Widget Tree in the Dashboard Editor, right-click>Widget Manager.
• From the Blueprint Editor menu bar in CSM Administrator, click Managers>Dashboards>Widget

Manager.
• From within the Site Manager in CSM Administrator.
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Create a Widget (General)
Use the various Widget Property windows (accessed from within the Widget Manager) to create Widgets.
The Property windows vary depending on the type of Widget.

To create a Widget (general):

1. Open the Widget Manager.

2. Select a scope and subfolder (if needed).

3. Click the Create New button .

The Widget Properties window varies depending on the type of Widget selected in the drop-down.

4. Define general properties:
◦ Name:

Provide a display name to use within CSM (this property can be searched in CSM Item
Managers).

◦ Type:

Select the type of Widget from the following, and then define its properties:

◦ Action Catalog

◦ Browser

◦ Chart

◦ Command Palette

◦ Filter

◦ Gauge

◦ Matrix

◦ RSS Feed

◦ Search

◦ Search Results List

◦ Twitter Feed

◦ Shape

5. Click OK.5. 

Note: After you create a Widget, use the Dashboard Editor to add the Widget to a
Dashboard, and then define how a Widget looks and behaves on the Dashboard. You can
also create Widgets from within the Dashboard Editor.
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Create an Action Catalog Widget
Use the Action Catalog Widget Properties window (accessed from within the Widget Manager) to create
an Action Catalog Widget.

To create an Action Catalog Widget:

1. Create a Widget.

2. In the Type drop-down, select Action Catalog.

3. Define the following properties:
◦ General: Title, image, and description.

◦ Actions: Which Actions to list in the catalog (example: All Services).

◦ Display: How and when the catalog Actions displays (example: Style, text, images, expression
to enable/disable Actions).

◦ (Optional) Groups: How the catalog Actions will be hierarchically grouped, and how the groups
will look and behave (example: By category and subcategory).

4. Click OK.4. 
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Define General Properties for an Action Catalog
Widget

Use the General page (accessed from within the Action Catalog Widget Properties window) to define the
following general properties for an Action Catalog Widget:

• Image: To display inside the Widget bounding box. You can also add an image above the Widget
(header area).

• Title: To display inside the Widget bounding box. You can also add a label above the Widget (header
area).

• Description: To display below the title.

Note: The Action Catalog Properties window is accessed from within the Widget Manager
when you create or edit an Action Catalog Widget.

To define general properties for an Action Catalog Widget:

Example: The following procedures demonstrate how to build an example Service Catalog. The example
Service Catalog is named Service Catalog and displays a globe and a description.

1. Create a Widget.

2. In the Type drop-down, select Action Catalog.

3. Click the General page.
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4. Define general properties:
a. Image button:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.
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The image is shown inside the Widget bounding box, next to the Action Catalog's title (ex: A
Globe).

b. Title:

Provide a title to display at the top of the Widget inside the Widget bounding box. The font,
style, and color are inherited from the Action Catalog's style (defined on the Display page).

c. Description:

Provide a description to use within CSM (this property can be searched in CSM Item
Managers).

5. Click OK.5. 
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Define Actions for an Action Catalog Widget
Use the Actions page (accessed from within the Action Catalog Widget Properties window) to define the
following:

• Action: Which Actions will be listed in an Action Catalog Widget. Actions come from Action Fields.
An Action Field is a Field that is configured to hold Actions (example: "Action Command" or "Action
Name" Hold properties are set on the Field). Each Action value can execute the same default Action
(example: "Create Incident and set prioritization") or each value can have its own unique Action.

• Sort Order: The order in which Actions will be listed in an Action Catalog Widget. Actions are sorted
by the values in a selected Field (example: Subcategory), either ascending (1-10, A-Z, etc.) or
descending (10-1, Z-A, etc.).

Note: The Action Catalog Properties window is accessed from within the Widget Manager
when you create or edit an Action Catalog Widget.

To define Actions for an Action Catalog Widget:

Example: The example Service Catalog lists Actions from the Incident Subcategory Business Object. The
Subcategory Business Object's Action Command Field is configured to hold the Service Actions
(example: One-Time Conference Setup and Request Account). All values execute the same default
Action (Create Incident and set categorization) but you could define a unique Action in Table
Management. Actions are sorted alphabetically from A-Z by Subcategory (Action) name.

1. Create a Widget.

2. In the Type drop-down, select Action Catalog.

3. Click the Actions page.

4. Select the Business Object that contains the Actions to execute from the Widget (example:
Incident Subcategory contains all the Service Actions).

Note: Only Business Objects that contain Action Fields and appropriate for an Action
Catalog are listed. If needed, you can create/configure Action Fields in other Business
Objects by creating Action values, and then setting the Action Command or Action
Command Name Hold Properties on a Field (Field Properties>General tab>Holds drop-

down): 

a. (Optional) To limit the Business Object Actions by some criteria (example:
IncidentSubCategory.Service equals Printing to show only Printing Actions), select the Limit

action records using query check box. Click the Custom Query button  to open the
Custom Query Builder, and then create a custom Search Query to use only for this scenario.

5. Select the Actions to execute from the Action Catalog:
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Note: CSM automatically selects the first Action Field it finds in the selected Business
Object. If you manually select a non-Action Field, you must configure the Field to be an
Action Field by adding the Action Command or Action Command Name Hold property.

a. Action Field: Select the Action Field that contains the Actions to execute (example: Action
Command Field). Each Field value will appear as a hyperlink that executes a defined Action,
either a default Action (set below) or a unique Action (set in Table Management).

Note: To define a unique Action, locate the value in Table Management (Tools>Table
Management), and then select an Action to execute.

b. Default action: Click the Ellipses button  to open the One-Step Manager, and then select a
default One-Step to execute for all hyperlinks or in case there is no Action in the Action Field
(example: "Create Incident and set categorization"). You can also create a new One-Step.

6. Select a sort order for the Actions:
a. Sort order Field: Select the Field to use to sort the Actions (example: Sort Actions

alphabetically from A-Z by Subcategory).

b. Click the Sort in Descending Order button  to toggle the sort order between ascending

(1-10, A-Z, etc.) and descending (10-1, Z-A, etc.). A non-active icon  indicates ascending

order; an active icon  indicates descending order.

7. Click OK.7. 
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Define Display Properties for an Action Catalog
Widget

Use the Display page (accessed from within the Action Catalog Widget Properties window) to define the
following display properties for an Action Catalog Widget.

• How the catalog Actions will display: Style, text, images, etc.

• When the catalog Actions will display: Use an Expression to enable or disable Actions using an
Expression (example: Disable Actions for Users in a specific Security Role).

Note: The Action Catalog Properties window is accessed from within the Widget Manager
when you create or edit an Action Catalog Widget.

To define display properties for an Action Catalog Widget:

Example: Our example Service Catalog uses the Metro Blue theme to display Actions in colorful tiles.
The text to display in the Action hyperlink (example: One-Time Conference Setup and Request Account)
comes from the Subcategory Field. No description or images are used, and no Expressions are used to
enable/disable Actions.

1. Create a Widget.

2. In the Type drop-down, select Action Catalog.

3. 

4. Select a style (color, font, etc.) for the Action Catalog. You have several options that vary by color:
◦ Column

◦ Rounded column

◦ List

◦ Rounded list

◦ Metro

Note: Styles are based on Cascading Style Sheets (CSS) and can vary the
functionality of the Action Catalog (example: The Metro style can display only three
levels in a hierarchy).

Note: If you preview the Cards with Search style, you will see a static example of the
layout, rather than a true preview of your live data.

5. Select the text to display in the Action hyperlink:
a. Title text: Select the Field to provide the text that displays in the hyperlink (example:

Subcategory). Typically, this is your sort order Field, although you can use a unique display
Field.

b. (Optional) Descriptive text: Select the Field to provide a description of the Action. The
descriptive text displays directly under the hyperlink.
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6. (Optional) Select the images to display next to the Action hyperlinks:
a. Show image next to each command: Select this check box to display an image next to each

Action hyperlink, and then select the images, either:
◦ Field with image: Select this radio button to display an image from a Field, and then

select the Field that contains the image.

◦ Expression: Select this radio button to use an Expression to conditionally provide the
image (example: If Subcategory equals Submit Incident, display a green check mark),
and then define the Expression using one of the following options:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager,
and then select an existing stored Expression or create a new stored Expression.
Stored Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the
Custom Expression Builder, and then create a custom Expression specifically for
this scenario.

7. (Optional) Define an Expression to enable/disable the Actions using one of the following options
(example: Disable Actions for Users in a specific Security Role):

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored Expressions
can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

8. Click OK.8. 
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Define Grouping Properties for an Action Catalog
Widget

Use the Groups page (accessed from within the Action Catalog Widget Properties window) to define how
Actions will be grouped in an Action Catalog Widget. Grouping properties include:

• How Actions are hierarchically grouped into levels in an Action Catalog.

• How the groups look and behave.

Note: The Action Catalog Properties window is accessed from within the Widget Manager
when you create or edit an Action Catalog Widget.

Good to know:

• Actions can be hierarchically grouped by another Field in the Business Object (example: In a
Service Catalog, group Actions under Category [Equipment Request and Video/Audio
Conferencing], and Categories under Service [Conferencing/Presentation]).

• Action Catalogs are built in levels from the bottom up, starting with Actions. If the Action is grouped

by a validated Field (identified by a white check mark in a green circle ), you can add another
level above the Action group.

To define grouping properties for an Action Catalog Widget:

1. Create a Widget.

2. In the Type drop-down, select Action Catalog.

3. Click the Groups page.

4. Group your Actions:
a. Groups box: Click the Actions to group (example: Incident Subcategory actions).

b. Group by: Select this check box to dynamically add the name of your Actions group.

c. Group by Field drop-down: Select the Field to use to group the Actions (example: Group
Actions by Category):

Note: If you select a validated Field (identified by a white check mark in a green circle

), you can add another group above the Action group.

A Grouped by line is added to the Groups box showing which Field is used to group the
Actions. The Actions group shifts down. The Display Options button is disabled because you
already defined display options for your Actions.

5. (Optional) Add another group above the Action group:
a. Groups box: Select the group you just added.

The Group by check box dynamically adds the name of the group.
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b. Group by: Select this check box to group by the above group (example: Group Name).

c. Group by Field: Select the Field to use to group the newest group (example: Group Category
by Service):

Another Grouped by line is added to the Groups box showing which Field is used to group the
newest group. The Display Options button is now enabled so that you can define display options for
the group.

6. (Optional) Continue to add groups.

7. Click OK.7. 

Note: The Metro style supports only three levels (groups).
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Define Display Properties for an Action Catalog
Group

Use the Group Display Options window to define how the group levels will look and behave in an Action
Catalog, including:

• General properties: Display name, description, and order.

• Image: Image to display next to each item.

• Visibility: When to show/hide the items.

• Allow drill-down: Whether or not to allow drill-down into the items.

To define display properties for an Action Catalog group:

1. On the Action Catalog Groups page, click the Display Option button.

2. Define general properties for the group:
a. Name: Select the Field to provide the display text (hyperlink). Typically, this is the Field you

used to group items, although you can use a unique display Field.

b. (Optional) Description: Select the Field to provide a description of the group. The descriptive
text displays directly under the hyperlink.

c. Order By: Select the Field to use to sort the Group items (example: Sort Categories

alphabetically from A-Z by Category name). Click the Sort in Descending Order button 
to toggle the sort order between ascending (1-10, A-Z, etc.) and descending (10-1, Z-A, etc.).

A non-active icon  indicates ascending order; an active icon  indicates descending
order.

3. (Optional) Select the images to display next to the group's display text:
a. Show image next to each command: Select this check box to display an image next to each

group's display text, and then select the images:
◦ Field with image: Select this radio button to display an image from a Field, and then

select the Field that contains the image.

◦ Expression: Select this radio button to use an Expression to provide the image (example:
If Category equals Network, display a picture of a Server), and then define the
Expression using one of the following options:

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager,
and then select an existing stored Expression or create a new stored Expression.
Stored Expressions can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the
Custom Expression Builder, and then create a custom Expression specifically for
this scenario.

4. (Optional) Define Expressions for showing/hiding and enabling/disabling Group items (example:
Disable/enable Actions based on Security Role) using one of the following options:
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◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and then
select an existing stored Expression or create a new stored Expression. Stored Expressions
can be reused in numerous places in CSM.

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

5. Define drill-down options for the group:
a. Allow Drill Down: Select this check box to enable drill-down into the group. When drill-down is

enabled, the display text becomes a hyperlink that drills down into the items grouped beneath
it.

b. If drill down is enabled, select the drill-down behavior. You can select from the following:
◦ User must drill-down to see items in this group: Select this radio button to hide all

grouped items, only displaying the items when the hyperlink is clicked.

◦ All group items will be shown even if not drilled-down: Select this radio button to display
all the grouped items below the group's display.

◦ Max items to show without drilling down: Select this radio button to display a defined
number of grouped items before drilling down, and then provide a number.

c. Drill down style: Select a drill-down style. Default uses the Widget's style.

6. Define quick-view options:
a. Allow quick view of Incident Category in a popup window: Select this check box to enable

Quick View for the group. When enabled, the Go To button  appears next to the group and,
when clicked, pops up additional information.

7. Click OK.7. 
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Create a Browser Widget
Use the Browser Widget Properties window (accessed from within the Widget Manager) to create a
Browser Widget.

To create a Browser Widget:

1. Create a Widget.

2. In the Type drop-down, select Browser.
3. Define which HTML Page or website to display in the Browser Widget:

◦ HTML Page: Select this radio button to display an HTML page. Click the Ellipses button 
to open the HTML Page Manager, and then select an existing HTML page or create a new
HTML page (either internal or external). When using a two-tier connection, a CSM login
window opens. Provide your User name and Password to open the HTML Editor tool.

Note: If accessing the HTML Editor in the Desktop Client, clicking Cancel when
creating a new page does not delete the page. Select the page, and then click Delete.

◦ Web Site: Select this radio button to display a website, and then provide the URL of the
website.

4. Define how often to refresh the Widget:
a. Refresh:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

Tip: Use refresh on Widgets where the data is likely to change (ex: A Widget
displaying Incident data).

5. Click OK.5. 
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Create a Chart Widget
Use the Chart Widget Properties window (accessed from within the Widget Manager) to create a Chart
Widget.

To create a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
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3. Define the following properties:
◦ General: Default title, refresh, and exclude from filter properties.

◦ Series: Define one or multiple data series to display in the Chart Widget, and the properties for
each series.
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◦ X-Axis: How the x-axis looks and behaves (ex: Value type and units, and label, indexing, and
value display options).

◦ X-Axis Sorting: How x-axis values are sorted (ex: By type, label, query, Lookup Table, etc.).

◦ Y-Axes: How one or more y-axes look and behave (ex: Labels and scale; the scale can be
calculated or fixed).

◦ Legends: How the legend looks and behaves (ex: Visibility, docking, and alignment).

◦ Display: How the chart itself looks and behaves (ex: Items to show, color palette, animation,
and Dashboard Theme color/style overrides.
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Define General Properties for a Chart Widget
Use the top portion of the Chart Widget Properties window (accessed from within the Widget Manager) to
define the following general properties for a Chart Widget.

• Default title:

Title to display above the Widget to identify it on a Dashboard.

• Refresh:

How often to automatically refresh the Widget (example: Every 5 minutes).

• Exclude from Filter:

Excludes the Widget from being filtered by any and all Dashboard filters (In other words, ignores any
Dashboard filter). Typically, this is selected if the Widget has its own defined Date/Time filter.

Good to know:

• A preview of the Widget (with randomly generated data) is available at the top of the window. Use• 
this to preview your Widget as you build it.

• Refresh executes only when a Widget is active and being displayed. If you leave a Dashboard and• 
come back to it, the data will be automatically refreshed, and the refresh timer will start over.

• Use refresh on Widgets where the data is likely to change (example: A Widget displaying Incident
data).

• A Dashboard's Refresh properties determine whether or not to 1) use the Dashboard's scheduled
refresh instead, and/or 2) allow its Widgets to refresh themselves in addition to the Dashboard's
scheduled refresh. For more information, refer to Dashboard Refresh in the Dashboards
documentation.

To define general properties for a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
3. Define general properties:

Note: These properties apply to the Chart Widget in general. Data series properties are
defined for each individual series.

a. Default Title:

Provide the title to display above the Widget. The font, style, and color is inherited from the
Dashboard on which this Widget resides.
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Note: You can change this title (Controls text box) when you put the Widget on a
Dashboard; however, the title is not dynamic so changes will not be pushed back to
this field. Likewise, if you later change this title in Widget Properties, the changes will
NOT be pushed out to all the places it resides on Dashboards. For more formatting
flexibility, use a "floating" Text Widget to display a label or title for a Widget.

b. Refresh Every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

c. Exclude From Filter:

Select this check box to exclude the Widget from being filtered by any filter (Filter Widget)
being used on a Dashboard. (Dashboard filters limit multiple Widgets/data series at once).
Typically, this is selected if the Widget has its own Date/Time filter.

4. Click OK.4. 

CSM 9.3.0 Features 1488

CSM 9.3.0 Features



Define a Series for a Chart Widget
Use the Series page (in the Chart Widget Properties window) to define the data series to display on a
Chart Widget. You can define one or multiple series:

• Single Series: Allows you to track one data point (example: Number of Incidents by status).

• Multiple series: Allows you to compare values so that you can detect and forecast patterns. For
example:

◦ Mean Time to Resolve Incidents (MTTR vs. Resolved/Closed Incidents).

◦ Mean Time To Resolve Incidents by Priority (P1 vs. P2 vs. P3, etc.).

◦ Trending by Business Object (Number of Incidents, Problems, Changes, and Requests).

Note: The Chart Widget Properties window is accessed from within the Widget
Manager when you create or edit a Chart Widget.

Good to know:
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• You must have at least one series in a Chart Widget (CSM creates one by default).

• Doughnut, Pie, and Pipeline charts contain only one series.

• Bar, Column, Line or Scatter charts can contain multiple series, and can be combined in any way or
number; however, you cannot mix field types. The x-axis can be only dates, or numbers, or text
strings, not a combination.

• Bar and column series can be clustered (side-by-side) or stacked (series atop one another). For
detailed information about stacking, see Stacked Bar Charts.

• The series has a preview with sample data; however, it is a preview of that data series only. The
Widget preview shows all defined series.

• Data series names are listed in reverse order, with the first created data series on top of all the

others. Use the arrow buttons   to change series order.

• To create a new series, click the New button .

• To edit an existing series, click the series, and then click the Edit button . Each series can have
its own individual set of properties.

To define a series for a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
3. Click the Series page.

CSM automatically creates a series (you must have at least one).

4. To create a new series, click the New button . To edit an existing series, click the series, and then

click the Edit button .

5. Define general series properties:
a. Name: Provide a display name to use in CSM. This is displayed on the legends and axes.

b. Series Type: Select a Chart Type:
◦ Bar

◦ Column

◦ Doughnut

◦ Line

◦ Pie

◦ Pipeline

◦ Scatter

c. Business Object: Select the Business Object whose data you want to include in the series.

CSM 9.3.0 Features 1490

CSM 9.3.0 Features



Tip: Only one type of Business Object can be selected. The drop-down displays only
Major Business Objects. To display all Business Objects, select the Show All check
box.

d. Show in Legend: Select this check box to display the name of the series in the Chart Widget
legend.

e. Combine Mode (Bar and Column series only): Select how to draw the data series bars/
columns (select one):

◦ Clustered: Draw bars/columns side-by-side on a common x or y-axis.

◦ Stacked: Stack data series atop one another on a shared x or y axis; the size of each
data segment is proportional to its value (bars/columns will likely appear staggered or
uneven).

◦ Stacked 100: Stack data series atop one another so that the data series total 100% of
the bar/column (bars/columns will be the same height).

f. Stack Group: Select the group key on which to stack the series (example: Stack series 1-2 on
stack group 1, stack series 3-4 are on stack 2).

6. Define options for the different Chart Types (series options vary by Chart Type):
◦ Define options for a Bar, Column, Line, or Scatter Chart Widget.

◦ Define options for a Pie/Doughnut Chart Widget.

◦ Define options for a Pipeline Chart Widget.

7. Click OK.7. 
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Define Options for a Bar, Column, Line, or Scatter
Chart Widget

Define the following options for a Bar, Column, Line, or Scatter Chart Widget series. Each series can have
its own individual set of properties:

• Criteria: Data/records to include in the chart (example: Open Incidents). Data is located/filtered
using a saved Search Query (Search Group) or a custom Search Query.

• X-Axis: Values for the x-axis (example: Dates, Statuses, Priorities, etc.).

• Y-Axis: Values for the y-axis (example: Number of Records, Function, or Duration).

• Grouping: When and how values are grouped (ex: Multiple priority bars are grouped by date).

• Custom Colors: Custom colors for the parts of the chart (example: Bars, columns, line/scatter
points). These override the default Dashboard Theme colors.

• Combine Values: When and how to combine negligible values.

• Analysis: Analysis formulas (example: Forecasting/trend lines).

• Drill-Down: Drill-down behavior (ex: Go to a Record List, Execute a command, or Go to a
Dashboard).

• Point Label Format: Format text and numbers for point labels on a chart series. Formatting options
vary by category (Number, Currency, Percentage, or Custom).

• Display: How to display point label and tooltip values on a chart series (overrides point label
formatting options).
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Define Criteria (Data) for a Bar, Column, Line, or
Scatter Chart Widget

Use the Criteria page (accessed from within the Chart Series window) to define which data/records to
include in the Chart Widget series (ex: Open Incidents). Properties include:

• Search Criteria: Data to include in the chart series (ex: All Incidents). Data is located/filtered using a
saved Search Query (Search Group) or a custom Search Query.

• Date Range: Timeframe for the Search Query (ex: Any Time (default), Within Last 1 Year, User-
selectable, etc.). If a Date Range Widget filter is defined, you must select the Exclude from Filter
check box so that the Widget filter overrides any and all Dashboard filters. If a User-selectable
Widget filter is defined, the Widget filter automatically overrides any and all Dashboard filters.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Anytime is the default date range and does not limit the Widget to any range. Use Anytime when
you will be using a Dashboard filter to globally filter all Widgets on a Dashboard.

• Field used for date range is usually when a record was created or modified but can be based on any
Date/Time field.

To define data for a chart series:

1. Create a Chart Widget

2. In the Chart Series window, click the Criteria page.
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3. Define the search criteria (data to include in the chart series—ex: All Incidents). Data is located
using one the following options:

◦ Saved Search Query (Search Group): Click the Ellipses button  to open the Search Group
Manager, and then select an existing Search Group (saved Search Query) or create a Search
Group. Saved Searches can be used over and over in numerous places.

◦ Custom Search Query: Click the Custom Query button  to open the Custom Query
Builder, and then create a custom Search Query to use only for this scenario.

4. Define a timeframe for the Search Query (Date Range area):
a. Select a range option, either:

◦ Range: Select this radio button to define a date range for the Query, and then select an
existing timeframe (ex: Anytime or Previous Year), or click the New button to define a
new timeframe.

◦ User Selectable: Select this radio button to allow the User/Customer to select the date

range from a drop-down. Then, click the Ellipses button  to open the Multiple Date
Ranges window and select the date ranges to include in the drop-down.
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b. Field used for date range: Select the Field to use to give the range perspective (ex:
LastModDateTime gives Previous Year perspective).

5. Click OK.5. 
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Define the X-Axis Values for a Bar, Column, Line, or
Scatter Chart Widget

Use the X-Axis page (accessed from within the Chart Series window) to define the values to display on
the x-axis of a Bar, Column, Line, or Scatter Chart Widget. Properties include:

• Field Name: Field whose values will be displayed in the chart as bars, columns, lines, or scatter
points (example: Status values—New, Assigned, In Progress, etc.).

Note: In Column, Line, and Scatter Charts, the x-axis is the horizontal axis. In Bar Charts,
the x-axis is the vertical axis because the bars go across the chart.

• Lookup Sorting: The Lookup Table and Field values to use for sorting x-axis values.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:
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• The available fields are limited by value type (  Date/Time,  Number,  Text, and  Logical). If
the field you want is not available, change the x-axis x-value type on the Widget Properties X-Axis
page.

To define the x-axis values for a Bar, Column, Line, or Scatter Chart:

1. Create a Chart Widget.

2. In the Chart Series window, click the X-Axis page.

3. Define the values to display on the x-axis:
a. Field name: Select the Field whose values will be displayed in the chart as bars, columns,

lines, or scatter points (example: Status values—New, Assigned, In Progress, etc.).

Tip: The available fields are limited by value type (  Date/Time,  Number,  Text,
and  Logical). If the field you want is not available, change the x-axis x-value type on
the Widget Properties X-Axis page.

4. Define lookup sorting properties for the x-axis values:
a. Lookup Table: Select a Lookup Table to use to sort x-axis values for the series.

b. Source Field: Select a Source Field from the Lookup Table. Only Fields that are of the same
type as the Field Name selection are shown.

c. Target Field: Select a Target Field from the Lookup Table. Only Fields that are of the same
type specified in the x-axis sorting options are shown.

Note: If a value from a Source Field matches the x-value of a point on the series, the
value from the Target Field for that record is used. Otherwise, the x-value is used as-is.

5. Click OK.5. 
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Define the Y-Axis Values for a Bar, Column, Line, or
Scatter Chart Widget

Use the Y-Axis page (accessed from within the Chart Series window) to define the values to display on
the y-axis of a Bar, Column, Line, or Scatter Chart Widget. Values can be based on:

• The number of records.

• A calculated function (average, maximum, minimum, or total): For example, an average customer
satisfaction rating.

• A calculated duration (average, maximum, minimum, or total based on an amount of time): For
example, the average amount of time that Incidents (meeting your criteria) take to resolve each day.

Note: In Column, Line, and Scatter charts, the y-axis is the vertical axis. In Bar charts, the y-
axis is the horizontal axis because the bars go across the Chart.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define the y-axis values for a Bar, Column, Line, or Scatter Chart:
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1. Create a Chart Widget.

2. In the Chart Series window, click the Y-Axis page.

3. Define the values to display on the y-axis. Values can be:
◦ Number of records: Select this radio button to display the number of records that match the

criteria (example: 15 Open Incidents).

◦ Function: Select this radio button to display a value that calculates an average, maximum,
minimum, or total value based on a selected Field, and then select the function and Field
(example: Display the average cost of Incidents that meet the criteria; Function = Average and
Field = Cost).

◦ Duration function: Select this radio button to calculate a value based on an amount of time,
and then select the Start/End Fields and the units (duration) (example: Display the average
amount of time that Incidents (meeting your criteria) take to resolve each day (example: Start
Field = Created Date/Time, End Field = Closed Date/Time, and Units = Days).

4. Axis Type: Associate the data series with an axis, either:
◦ Primary (default): Select this radio button to associate the data series with the y-axis to the left

of the chart.

◦ Secondary: Select this radio button to associate the data series with the y-axis on the right of
the chart.

Tip: Use a secondary axis when you have two or more data series with ranges that are
very different in magnitude and you want to display details of both (example: Data
series 1 has values ranging from 0 to 5; data series 2 has values ranging from 0 to
2000). Displaying them on the same y-axis would mean data series 1 would look flat.

5. Click OK.5. 
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Define How Values are Grouped for a Bar, Column,
Line, or Scatter Chart Widget

Use the Grouping page (accessed from within the Chart Series window) to define when and how values
are grouped in a Bar, Column, Line, or Scatter Chart Widget. Use this data to further break down your
main field and to view patterns. For example, group:

• Category by status: Displays a bar, column, line, or point for each status within each category.

• Status by owner: Displays a bar, column, line, or point for each owner within a status.

• Status by priority: Displays a bar, column, line, or point for each priority within a status.

The following figures show Incident by Status column charts, ungrouped and then grouped by priority:

Column Chart - Incidents by Status Grouped Column Chart - Incidents by Status, Grouped
by Priority

Note: The Chart Series window is accessed from within the Widget Manager when you create or
edit a Chart Widget, and then add a series.

Good to know:

• Use grouping on simpler charts. Grouping values on multi-series charts and stacked charts can
clutter the data.

To define how values are grouped for a Bar, Column, Line, or Scatter Chart Widget:

1. Create a Chart Widget.

2. 

3. Define how values are grouped:
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a. Group by: Select this check box to enable grouping.

b. Field: Select the Field to use to group values (example: Priority).

c. Units (date/time Fields only): Select the date/time unit to display.

4. Click OK.4. 
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Define a Custom Color for an X-Value in a Bar,
Column, Line, or Scatter Chart Widget

Use the Custom Colors page (accessed from within the Chart Series window) to define a custom color for
a specific x-value on a Bar, Column, Line, or Scatter Chart Widget (example: Make Reopened Incidents
(Status=Reopened) red to signify a higher priority). The x-value is represented by a bar in a bar chart, a
column in a column chart, and a point in a line or scatter chart.

Note: The Chart Series window is accessed from within the Widget Manager when you create or
edit a Chart Widget, and then add a Series.

Good to know:

• By default, bar/column/point colors come from the Chart Color Palette defined in a Dashboard
Theme; selecting a custom color overrides the Dashboard Theme palette.

• Dashboard Theme colors/styles can also be overridden on a per Widget basis (see Display tab).

To define a custom color for an x-value in a Bar, Column, Line, or Scatter Chart Widget:

1. Create a Chart Widget.

2. 

3. Define a custom color for an x-value:
a. Click the Create New button .

b. Provide the value for which you want to select a custom color (example: "Reopened").

c. Click the Color Selector button  to open the Color Selector, and then select a color:
◦ System:
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Set of colors provided by your Operating System. System colors can greatly vary
depending on the Operating System and browser used to view the color.

◦ Web:

Set of named Web-safe colors.

◦ Custom:

Customized Red, Green, Blue (RGB) colors.

d. Click OK.d. 

Tip: Click the Edit button to change a selected color; click the Delete button to remove
a selected color from the list

e. Show a different color for each value: Select this check box to show a different color for each
value. If you do not define custom colors for each value, colors are assigned to each value
based on the Chart Color Palette.

Note: For Bar and Column Charts that do not use grouping, the default behavior is for
every bar/column to be the same color.

4. Click OK.4. 
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Define How Values are Combined for a Bar,
Column, Line, or Scatter Chart Widget

Use the Combine Values page (accessed from within the Chart Series window) to define when and how to
combine negligible values (values so small that they can be ignored) in a Bar, Column, Line or Scatter
Chart Widget. This is useful to remove noise values from a chart that just confuse the real data.
Properties include:

• Combine Negligible Numbers: Enables combining negligible values.

• Values: Values to combine (example: Less or Equal to 1).

• What to do with combined values: Hide (disregard) the values or combine them into a category in
the chart (example: Other).

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define how values are combined for a Bar, Column, Line, or Scatter Chart Widget:

1. Create a Chart Widget.

2. In the Chart Series window, click the Combine Values page.

3. Define the rules for combining negligible values:
a. Combine negligible values: Select this check box to enable combining negligible values.

b. Values: Select the threshold (operator and quantity) for combining the values (example: Less
than a defined quantity of 1).

c. Specify what to do with the negligible values, either:
◦ Hide these values: Select this radio button to hide (disregard) the values (they are not

included in the chart).

◦ Combine into category: Select this radio button to combine the negligible values into a
named category, and then provide a label for the category (example: "Other").

4. Click OK.4. 
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Define Analysis for a Column, Line, or Scatter
Chart Widget

Use the Analysis page (accessed from within the Chart Series window) to define Analysis formulas
(example: Forecasting/trend lines) for a Column, Line, or Scatter Chart Widget. Formulas include:

• Trend Lines: A Trend Line is a straight line that connects two or more points on a chart to indicate a
pattern. Use a Trend Line on your Column, Line, or Scatter Chart Widgets to analyze trends so that
you can more accurately forecast and implement mitigation strategies. For example, use a Trend
Line to display/predict a pattern for:

◦ Number of Incidents that your Service Desk logs.

◦ How long it takes to resolve P1 Incidents.

◦ How many planned and unplanned changes affect your organization.

Note: You can also add an error range above and below the Trend Line.

The following figures show a Chart Widget with a Trend Line, with and without a calculated error
range.

 

Trend Lines are highly configurable, so you define:

◦ Whether or not to display a Trend Line.

◦ Whether or not to display an error range above and below a Trend Line.

◦ Whether or not to display the Trend Line and error range in the Chart Widget legend.

◦ Colors for the Trend Line, error range border, and error range background.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:
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• Trend Lines are available only on Column, Line, and Scatter Charts.

• Trend Lines can be added for one or more series in a chart.

• Forecasting formulas (example: Trend Lines) are not available when individual values are plotted
next to one another in a chart.

• Formulas cannot apply to stacked series. Because the origin of the stacked points are not at the x-
axis, stacked series points are not drawn at their actual Cartesian coordinates.

To define Analysis for a Column, Line, or Chart Widget:

1. Create a Chart Widget.

2. In the Chart Series window, click the Analysis page.

3. Define the formula to use for analyzing the data in the Chart Widget. Currently, Forecasting (Trend
Lines) is the only option.

4. Define the analysis parameters:
a. Regression Type: Select the type of regression for the Trend Line. Currently, only Linear is

supported.

b. Show Approximation Error: Select this check box to display an error range above and below
the Trend Line.

c. Show Approximation in Legend: Select this check box to display the Trend Line (labeled
"Approx") in the Chart Widget legend.

d. Show Error Range in Legend: Select this check box to display the error range (labeled "Error"
in the Chart Widget legend).

5. Define colors for Trend Lines and error ranges (Appearance area):
a. Approximation Line Color: Select a color for the Trend Line.

b. Error Range Border Color: Select a color for the border (top and bottom) of the error range.

c. Error Range Background Color: Select a color for the background (area between the top and
bottom border) of the error range.

6. Click OK.6. 
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Define Drill-Down for a Bar, Column, Line, or
Scatter Chart Widget

Use the Drill-Down Properties page (accessed from within the Chart Series window) to define drill-down
behaviors for a series in a Chart Widget. Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a record to view it in detail.

• Execute a command: Drill-down executes a command/Action (ex: Display an Action Catalog,
Calendar, Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-
Step, search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (ex: A Dashboard dedicated to the
Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (ex: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

• None: Drill-down is not allowed.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Dashboard drill-down is configurable, so behaviors can vary. For more information, see Dashboard
Drill-Down.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

To define drill-down properties for a Chart series:

1. Create a Chart Widget and define a Series.

2. In the Chart Series window, click the Drill-Down page.
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3. Define a drill-down option for the chart:
◦ Go to a Record List: Select this radio button to drill-down into a list of pertinent records.

◦ Execute a command: Select this radio button to execute a command/Action upon drill-down.

Then, click the Ellipses button  to open the Action Manager, where you can select the
command to execute or create a new command/Action.

◦ Go to a Dashboard: Select this radio button to drill-down into another Dashboard. Then, click

the Ellipses button  to open the Dashboard Manager where you can select an existing
Dashboard or create a new Dashboard.

4. Click OK.4. 
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Define Point Label Formats for a Bar, Column, Line,
or Scatter Chart Widget

Use the Point Label Format page (accessed from within the Chart Series window) to define formatting
options for point labels on a chart series. Formatting options vary by category (Number, Currency,
Percentage, or Custom) for a series in a Chart Widget. Each series can have its own individual set of
formatting properties, which include:

• Number: Define decimal places and enable 1000 separator, negative sign, and leading zeros.

• Currency: Define decimal places and symbol.

• Percentage: Define decimal places.

• Custom: Define a custom format string.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define point label formats for a Chart Widget:

1. Create a Chart Widget and define a Series.

2. In the Chart Series window, click the Point Label Format page.

3. Select a category (select one).

4. Define the following number properties (properties vary by category):
◦ Decimal Places: Specify the number of decimal places to display to the right of a decimal point

(example: 5.0 has one decimal place, 5.00 has two decimal places). Zero (0) indicates a whole
number (no decimal place).

◦ Use 1000 Separator: Select this check box to add a separator (example: Comma) when a
number value reaches 1000. Separators vary depending on locale (example: USA, Europe,
etc.).

◦ Show Leading Zeroes: Select this check box to display zeroes (if any) before a decimal place
(example0.7 has a leading zero).

◦ Show Negative Sign: Select this check box to display a negative sign (when applicable) before
a number string (ex: -5.0).

◦ Currency Symbol: By locale (example: English, United States).

◦ Custom: Define a custom format or use an existing one (example:
0,0.00,#.##0,0%,0.00%,0.00E+00, ##0.0E+0).

5. Click OK.5. 
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Define Display Properties for a Bar, Column, Line,
or Scatter Chart Widget

Use the Display page (accessed from within the Chart Series window) to display point label and tooltip
values in the Chart Widget series (ex: Open Incidents).

Good to know:

• Each series can have its own individual display properties.

• Settings defined on this page will override point label format options.

To define display properties for a chart series:

1. Create a Chart Widget.

2. In the Chart Series window, click the Display page.

3. Select a display option:
◦ Show point label number values as a percentage of the series total: Select this check box to

use as point labels the Y values as a percentage of the total of all Y values for the chart series.

◦ Show point label number values as a percentage of the series total: Select this check box to
use as tooltips the Y values as a percentage of the total of all Y values for the chart series.

4. Click OK.4. 
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Define Options for a Doughnut/Pie Chart Widget
Define the following for a Doughnut/Pie Chart Widget:

• Criteria: Data/records to include in the chart. Data is located/filtered using a saved Search Query
(Search Group) or a custom Search Query.

• Slices: Slices to display in the chart.

• Size of Slices: Size of the slices in the chart.

• Custom Colors: Custom colors for specific slices in a chart. These override the default Dashboard
Theme colors.

• Combine Values: When and how to combine negligible values.

• Drill-Down: Drill-down behavior (example: Go to a Record List, Execute a command, or Go to a
Dashboard).
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Define Criteria (Data) for a Doughnut/Pie Chart
Widget

Use the Criteria page (accessed from within the Chart Series window) to define which data/records to
include in the Chart Widget series (example: Open Incidents). Properties include:

• Search Criteria: Data to include in the chart series (example: All Incidents). Data is located/filtered
using a saved Search Query (Search Group) or a custom Search Query.

• Date Range: Timeframe for the Search Query (example: Any Time (default), Within Last 1 Year,
User-selectable, etc.). If a Date Range Widget filter is defined, you must select the Exclude from
Filter check box so that the Widget filter overrides any and all Dashboard filters. If a User-selectable
Widget filter is defined, the Widget filter automatically overrides any and all Dashboard filters.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Anytime is the default date range and does not limit the Widget to any range. Use Anytime when
you will be using a Dashboard filter to globally filter all Widgets on a Dashboard.

• Field used for date range is usually when a record was created or modified but can be based on any
Date/Time field.

To define data for a chart series:

1. Create a Chart Widget.

2. In the Chart Series window, click the Criteria page.

3. Define the search criteria (data to include in the chart series—example: All Incidents). Data is
located using one the following options:

◦ Saved Search Query (Search Group): Click the Ellipses button  to open the Search Group
Manager, and then select an existing Search Group (saved Search Query) or create a Search
Group. Saved Searches can be used over and over in numerous places.

◦ Custom Search Query: Click the Custom Query button  to open the Custom Query
Builder, and then create a custom Search Query to use only for this scenario.

4. Define a timeframe for the Search Query (Date Range area):
a. Select a range option, either:

◦ Range: Select this radio button to define a date range for the Query, and then select an
existing timeframe (example: Anytime or Previous Year), or click the New button to
define a new timeframe.

◦ User Selectable: Select this radio button to allow the User/Customer to select the date

range from a drop-down. Then, click the Ellipses button  to open the Multiple Date
Ranges window and select the date ranges to include in the drop-down.
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b. Field used for date range: Select the Field to use to give the range perspective (example:
LastModDateTime gives Previous Year perspective).

5. Click OK.5. 
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Define Slices for a Doughnut/Pie Chart Widget
Use the Slices page (accessed from within the Chart Series window) to define the values to display in the
Doughnut/Pie Chart Widget. Each value will be a slice. Properties include:

• Field Name: Field whose values will be displayed as slice in the pie chart (example: Status Field—
values might be New, Assigned, In Progress, etc.).

• Lookup Sorting: The Lookup Table and Field values to use for sorting the values of slices.

 

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Fields in the Field Name drop-down are limited to the Widget's selected Field Type (example: Date/
Time, Number, Text, or Logical).

To define slices for a Doughnut/Pie Chart Widget:

1. Create a Chart Widget.

2. In the Chart Series window, click the Slices page.

3. Select the Field and values to display as slices:
a. Field name: Select the Field whose values will be displayed as slices in the doughnut/pie chart

(example: Status values—New, Assigned, In Progress, etc.).

4. Define lookup sorting properties for the values of the slices:
a. Lookup Table: Select a Lookup Table to use to sort values for the series.
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b. Source Field: Select a Source Field from the Lookup Table. Only Fields that are of the same
type as the Field Name selection are shown.

c. Target Field: Select a Target Field from the Lookup Table. Only Fields that are of the same
type specified in the x-axis sorting options are shown.

Note: If a value from a Source Field matches the value of a slice in the series, the
value from the Target Field for that record is used. Otherwise, the slice value is used
as-is.

5. Click OK.5. 
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Define the Size of Slices for a Doughnut/Pie Chart
Widget

Use the Size of Slices page (accessed from within the Chart Series window) to define how the slices are
proportioned in the Doughnut/Pie Chart Widget (that is, the percentage of the circle that each slice takes
up). Slice size can be based on:

• Number of Records.

• Function: Calculated average, maximum, minimum, or total (example: Average customer
satisfaction rating).

• Duration: Calculated average, maximum, minimum, or total based on an amount of time (example:
Average amount of time that Incidents take to resolve each day).

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define the size of slices for a Doughnut/Pie Chart Widget:

1. Create a Chart Widget

2. In the Chart Series window, click the Size of Slices page.

3. Define how the slices will be proportioned, either by:
a. Number of records: Select this radio button to proportion each slice as a percentage of the

total number of records that meet the criteria (example: Open Incidents are 25% of the
Incident records).

b. Function: Select this radio button to proportion each slice as a calculated function (average,
maximum, minimum, or total value) based on a selected Field, and then select the function
and Field (example: Display the average cost of Incidents that meet the criteria; function =
average and Field = Cost).

c. Duration function: Select this radio button to proportion the slices as a calculated percentage
based on an amount of time, and then select the Start/End Fields and the units (duration)
(example: Display the average amount of time that Incidents take to resolve each day
(example: Start Field = Created Date/Time, End Field = Closed Date/Time, and Units = Days)).

4. Click OK.4. 
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Define a Custom Color for a Slice in a
Doughnut/Pie Chart Widget

Use the Custom Colors page (accessed from within the Chart Series window) to define a custom color for
a specific slice (value) in a Doughnut/Chart Widget (example: Make reopened Incidents
(Status=Reopened) red to signify a higher priority).

Note: The Chart Series window is accessed from within the Widget Manager when you create or
edit a Chart Widget, and then add a Series.

Good to know:

• By default, slice colors come from the Chart Color Palette defined in a Dashboard Theme; selecting
a custom color overrides the Dashboard Theme palette.

• Dashboard Theme colors/styles can also be overridden on a per Widget basis (see Display tab).

To define a custom color for a slice in a Doughnut/Pie Chart Widget:

1. Create a Chart Widget

2. In the Chart Series window, click the Custom Colors page.

3. Define a custom color for a slice:
a. Click the Create New button .

b. Provide the value (represented as slice) for which you want to select a custom color (example:
"Reopened").

c. Click the Color Selector button  to open the Color Selector, and then select a color:
◦ System:
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Set of colors provided by your Operating System. System colors can greatly vary
depending on the Operating System and browser used to view the color.

◦ Web:

Set of named Web-safe colors.

◦ Custom:

Customized Red, Green, Blue (RGB) colors.

d. Click OK.d. 

Note: Click the Edit button  to change a selected color; click the Delete button  to
remove a selected color from the list

e. Show a different color for each value: Not applicable for pie/doughnut charts. By default, each
slice is assigned a different color.

4. Click OK.4. 
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Define How Values are Combined for a
Doughnut/Pie Chart Widget

Use the Combine Values page (accessed from within the Chart Series window) to define when and how to
combine negligible values (values so small that they can be ignored) in a Doughnut/Pie Chart Widget.
This is useful to remove noise values from a chart that just confuse the real data. Properties include:

• Combine Negligible Numbers: Enables combining negligible values.

• Values: Values to combine (example: Less or Equal to 1).

• What to do with combined values: Hide (disregard) the values or combine them into a category in
the chart (example: Other).

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define how values are combined for a Doughnut/Pie Chart Widget:

1. Create a Chart Widget

2. In the Chart Series window, click the Combine Values page.

3. Define the rules for combining negligible values:
a. Combine negligible values: Select this check box to combine negligible values.

b. Values: Select the threshold (value and quantity) for combining the values (example: Less
than a defined quantity).

c. Specify what to do with the negligible values:
◦ Hide these values.

◦ Combine into category: Select this check box to combine the negligible values into a
defined category (example: Other), and then provide a label for the category.

4. Click OK.4. 
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Define Drill-Down for a Doughnut/Pie Chart Widget
Use the Drill-Down Properties page (accessed from within the Chart Series window) to define drill-down
behaviors for a series in a Chart Widget. Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a record to view it in detail.

• Execute a command: Drill-down executes a command/Action (example: Display an Action Catalog,
Calendar, Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-
Step, search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (example: A Dashboard dedicated to
the Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (example: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

• None: Drill-down is not allowed.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Dashboard drill-down is configurable, so behaviors can vary. For more information, see Dashboard
Drill-Down.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

To define drill-down properties for a Chart series:

1. Create a Chart Widget and define a Series.

2. In the Chart Series window, click the Drill-Down page.

3. Define a drill-down option for the chart:
◦ Go to a Record List: Select this radio button to drill-down into a list of pertinent records.

◦ Execute a command: Select this radio button to execute a command/Action upon drill-down.

Then, click the Ellipses button  to open the Action Manager, where you can select the
command to execute or create a new command/Action.

◦ Go to a Dashboard: Select this radio button to drill-down into another Dashboard. Then, click

the Ellipses button  to open the Dashboard Manager, where you can select an existing
Dashboard or create a new Dashboard.
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4. Click OK.4. 
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Define Criteria (Data) for a Pipeline Chart Widget
Use the Criteria page (accessed from within the Chart Series window) to define which data/records to
include in the Chart Widget series (example: Open Incidents). Properties include:

• Search Criteria: Data to include in the chart series (example: All Incidents). Data is located/filtered
using a saved Search Query (Search Group) or a custom Search Query.

• Date Range: Timeframe for the Search Query (example: Any Time (default), Within Last 1 Year,
User-selectable, etc.). If a Date Range Widget filter is defined, you must select the Exclude from
Filter check box so that the Widget filter overrides any and all Dashboard filters. If a User-selectable
Widget filter is defined, the Widget filter automatically overrides any and all Dashboard filters.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Anytime is the default date range and does not limit the Widget to any range. Use Anytime when
you will be using a Dashboard filter to globally filter all Widgets on a Dashboard.

• Field used for date range is usually when a record was created or modified but can be based on any
Date/Time field.

To define data for a chart series:

1. Create a Chart Widget

2. In the Chart Series window, click the Criteria page.

3. Define the search criteria (data to include in the chart series—example: All Incidents). Data is
located using one the following options:

◦ Saved Search Query (Search Group): Click the Ellipses button  to open the Search Group
Manager, and then select an existing Search Group (saved Search Query) or create a Search
Group. Saved Searches can be used over and over in numerous places.

◦ Custom Search Query: Click the Custom Query button  to open the Custom Query
Builder, and then create a custom Search Query to use only for this scenario.

4. Define a timeframe for the Search Query (Date Range area):
a. Select a range option, either:

◦ Range: Select this radio button to define a date range for the Query, and then select an
existing timeframe (example: Anytime or Previous Year), or click the New button to
define a new timeframe.

◦ User Selectable: Select this radio button to allow the User/Customer to select the date

range from a drop-down. Then, click the Ellipses button  to open the Multiple Date
Ranges window and select the date ranges to include in the drop-down.

b. Field used for date range: Select the Field to use to give the range perspective (example:
LastModDateTime gives Previous Year perspective).
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5. Click OK.5. 
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Define Slices for a Pipeline Chart Widget
Use the Slices page (accessed from within the Chart Series window) to define the values to display in the
Pipeline Chart Widget. Each value will be a slice. Properties include:

• Slice: Field whose values will be displayed as slice in the pipeline (example: Status Field—values
might be New, Assigned, In Progress, etc.).

• Display:
◦ What labels to display on the slices (Name, Percent, Value).

◦ Where to put the labels (On slices or On side). In the Browser Client, labels can only be placed
on slices.

◦ How to format the labels (Dash before side labels, Color side labels, Space between slices,
and \number of decimals spaces to display in the values. This will be used for both values and
percentages.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Only values from text Fields can be displayed.

• Rarely will the alphabetical order or the validation values match with the order in which they should
appear in the pipeline, unless you prefix the values with numbers or letters (example: For status,
you would likely want lifecycle order, not alphabetical order); therefore, it is common to define a
Field that contains a sequence number purely for controlling the order (example: Status Order).

To define slices for a Pipeline Chart Widget:
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1. Create a Chart Widget.

2. In the Chart Series window, click the Slices page.

3. Select the values to display as slices:
a. Field Name: Select the Field whose values will be displayed as slices in the pipeline (example:

Status Field—values might be New, Assigned, In Progress, etc.).

Note: If the Field you select is validated, the information automatically populates the List of
Slices information.

b. List of Slices: Select the Business Object/Field that supplies the values to the above Field
(Typically, this is a Lookup Object/Field):

i. Business Object: Select the Lookup Object that supplies all the possible values for the
above Field (example: Incident Status).

ii. Value Field: Select the Lookup Field (Field in the above Lookup Object) that supplies
the values (example: Status).

iii. Order By: Select the Field to use to order the values in the pipelines, as well as an
ascending (example: 0-10, A-Z) or descending (10-0, Z-A) order. Note: Rarely will the
alphabetical order match the order in which the values should appear in the pipeline,
unless you prefix the values with numbers or letters (example: For status, you would
likely want lifecycle order, not alphabetical order); therefore, it is common to define a
Field that contains a sequence number purely for controlling the order (example: Status
Order).

c. Show all values, even if no data: Select this check box to display a slice even if there is no
data for it (example: There are no Incidents). The default behavior is to not display a slice if
there are no values for it.

4. Define display options for the slices and values:
◦ Labels on slices: Select this check box to display the values as labels inside each slice. You

can display the name, percentage, and/or actual value.

◦ Labels on side: Select this check box to display the values as labels on the right side of each
slice. You can display the name, percentage, and/or actual value.

◦ Dash before side labels: Select this check box to include an em dash before the side values.

◦ Color side labels: Select this check box to make the side value text the same color as the slice
it represents.

◦ Space between slices: Select this check box to add a small space between the slices.

◦ Decimals: Specify the number of decimals spaces to display in the values. This is used for
both values and percentages.

5. Click OK.5. 
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Define Options for a Pipeline Chart Widget
Define the following for a Pipeline Chart Widget:

• Criteria: Data/records to include in the chart. Data is located/filtered using a saved Search Query
(Search Group) or a custom Search Query.

• Slices: Slices to display in the pipeline chart.

• Size of Slices: Size of the slices in the pipeline chart.

• Custom Colors: Color of the slices in the pipeline chart. These override the default Dashboard
Theme colors.

• Drill-Down: Drill-down behavior (example: Go to a Record List, Execute a command, or Go to a
Dashboard).
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Define the Size of Slices for a Pipeline Chart
Widget

Use the Size of Slices page (accessed from within the Chart Series window) to define how the slices are
proportioned in the Pipeline Chart Widget (that is, the percentage of the pipeline that each slice takes up).
Slice size can be based on:

• Number of Records.

• Function: Calculated average, maximum, minimum, or total (ex: Average customer satisfaction
rating).

• Duration: Calculated average, maximum, minimum, or total based on an amount of time (example:
Average amount of time that Incidents take to resolve each day).

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

To define the size of slices for a Pipeline Chart Widget:

1. Create a Chart Widget

2. In the Chart Series window, click the Size of Slices page.

3. Define how the slices will be proportioned, either by:
◦ Number of records: Select this radio button to proportion each slice as a percentage of the

total number of records that meet the criteria (example: Open Incidents are 25% of the
Incident records).

◦ Function: Select this radio button to proportion each slice as a calculated function (average,
maximum, minimum, or total value) based on a selected Field, and then select the function
and Field (example: Display the average cost of Incidents that meet the criteria; function =
average and Field = Cost).

◦ Duration function: Select this radio button to proportion the slices as a calculated percentage
based on an amount of time, and then select the Start/End Fields and the units (duration)
(example: Display the average amount of time that Incidents take to resolve each day (ex:
Start Field = Created Date/Time, End Field = Closed Date/Time, and Units = Days).

4. Click OK.4. 
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Define a Custom Color for a Slice in a Pipeline
Chart Widget

Use the Custom Colors page (accessed from within the Chart Series window) to define a custom color for
a slice (value) in a Pipeline Chart Widget (ex: Make reopened Incidents (Status=Reopened) red to signify
a higher priority).

Note: The Chart Series window is accessed from within the Widget Manager when you create or
edit a Chart Widget, and then add a Series.

Good to know:

• By default, slice colors come from the Chart Color Palette defined in a Dashboard Theme; selecting
a custom color overrides the Dashboard Theme palette.

• Dashboard Theme colors/styles can also be overridden on a per Widget basis (see Display tab).

To define a custom color for a slice in a Pipeline Chart Widget:

1. Create a Chart Widget

2. In the Chart Series window, click the Custom Colors page.

3. Define a custom color for a slice:
a. Click the Create New button .

4. Select the value (represented as slice) for which you want to select a custom color (example:
"Reopened").

a. Click the Color Selector button  to open the Color Selector, and then select a color:
◦ System:
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Set of colors provided by your Operating System. System colors can greatly vary
depending on the Operating System and browser used to view the color.

◦ Web:

Set of named Web-safe colors.

◦ Custom:

Customized Red, Green, Blue (RGB) colors.

b. Click OK.b. 

Note: Click the Edit button  to change a selected color; click the Delete button  to
remove a selected color from the list

c. Show a different color for each value: Not applicable for a pipeline chart. By default, each slice
is assigned a different color.

5. Click OK.5. 
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Define Drill-Down for a Pipeline Chart Widget
Use the Drill-Down Properties page (accessed from within the Chart Series window) to define drill-down
behaviors for a series in a Chart Widget. Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (print, export, sort, filter, group, size, move, and add/remove columns) to display only the
data you want and in a way that is meaningful to you. Click a record to view it in detail.

• Execute a command: Drill-down executes a command/Action (example: Display an Action Catalog,
Calendar, Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-
Step, search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (example: A Dashboard dedicated to
the Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (example: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

• None: Drill-down is not allowed.

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• Dashboard drill-down is configurable, so behaviors can vary. For more information, see Dashboard
Drill-Down.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

To define drill-down properties for a Chart series:

1. Create a Chart Widget and define a Series.

2. In the Chart Series window, click the Drill-Down page.

3. Define a drill-down option for the chart:
◦ Go to a Record List: Select this radio button to drill-down into a list of pertinent records.

◦ Execute a command: Select this radio button to execute a command/Action upon drill-down.

Then, click the Ellipses button  to open the Action Manager, where you can select the
command to execute or create a new command/Action.

◦ Go to a Dashboard: Select this radio button to drill-down into another Dashboard. Then, click

the Ellipses button  to open the Dashboard Manager, where you can select an existing
Dashboard or create a new Dashboard.

4. Click OK.4. 
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Define an X-Axis for a Chart Widget
Use the X-Axis page (accessed from within the Chart Widget Properties window) to define how an x-axis
looks and behaves in a Chart Widget. Properties include:

• Value Type: Date/Time, Number, Text, or Logical (True/False).

• Value Units (Date/Time value only): Days, Weeks, Months, Quarters, Years, Hours, Minutes, or
Seconds.

• Label: Text to display on the x-axis.

Doughnut and Pie Charts only:

• Label Location: Where to place the labels on a Doughnut/Pie Chart (ex: Inside the slice, Outside
the slice with a line connector, Outside Near the slice aligned in columns with a line connector).

Inside Outside Outside Near

Date/Time and Number values only:

• Axis Represents: Timeline or Numeric Sequence, with values distributed over time/number
line: Distributes data points in order on a continuous timeline or numeric sequence (ex: Earliest to
latest date for Date/Time values and 1-100 for Number values). For example, the following figures
show Column, Line, and Scatter Charts that plot on a timeline (May through November) the # of
Incidents and the # of Requests Resolved on First Call each month. Months with no data points (ex:
August through October) ARE included in the timeline (x-axis).
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Timeline on Column Chart Timeline on Line Chart

  

Timeline on Scatter Chart

• Individual values, with data points next to one another: Plots Individual data points next to one
another with time or numbers for reference. For example, the following figures show Column, Line,
and Scatter Charts that plot the # of Incidents and the # of Requests resolved on First Call, with the
month for reference. Note that months with no data (ex: Aug through October) are NOT included in
the x-axis. Also note that a line is not drawn from one point to the next point in a series when there
is a "missing" x-value between the points (ex: When two or more series do not have the same
number of points, such as FCR Request not having a July data point).
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Individual Values on Column Chart Individual Values on Line Chart

  

Individual Values on Scatter Chart

Note: The Chart Series window is accessed from within the Widget Manager when you
create or edit a Chart Widget, and then add a Series.

Good to know:

• You can have multiple data series in a chart but all series must be the same Value Type (ex: All
Date/Time).

• The x-axis values themselves are defined as part of the series (see Define a Series for a Chart
Widget).

• In Column, Line, and Scatter Charts, the x-axis is the horizontal axis. In Bar Charts, the x-axis is the
vertical axis because the bars go across the chart.
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• Forecasting formulas (ex: Trend Lines) are not available when individual values are plotted next to
one another in a chart.

• Prior to CSM 4.6, all charts plotted individual values on the x-axis (timeline was not available).

To define an x-axis for a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
3. Click the x-axis page.
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4. Define the following properties:
a. X-Value Type: Select the type of data to display on the x-axis (you can have multiple data

series but all series must be the same type of data):
◦ DateTime

◦ Number

◦ Text

◦ Logical (True/False)
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b. X-Value Units (Date/Time value only): Select the date/time units (ticks) to display on the x-
axis (ex: Days, Weeks, Months, Quarters, Years, Hours, Minutes, or Seconds).

c. Label: Provide the text to display on the x-axis.

Tip: Typically, the x-axis is labeled with the name of the Field whose data it displays.

d. Show Label for All Items: Select this check box to display a label for every tick on the x-axis.
Otherwise, the chart only displays labels for some ticks to save space.

e. Label Location (Doughnut/Pie Chart only): Select where to place the labels on a Doughnut/Pie
Chart (ex: Inside, Outside, Outside Near).

f. Axis represents (Date/Time and Number values only): Select one option:
◦ Timeline or Numeric Sequence, with values distributed over time: Select this radio

button to distribute data points in order on a continuous timeline or numeric sequence
(ex: Earliest to latest date for Date/Time values and 1-100 for Number values).

◦ Individual values, with data points next to one another: Select this radio button to
plot individual data points next to one another with time or numbers for reference.

g. Enable Custom Category Placement: Select this check box to enable the placement of one
axis value at either the start or end of the x-axis:

◦ Category Value: Provide the text of the axis label of the category that you want to match.

◦ Placement: In the drop-down, select where on the x-axis to place the category value
(either Start or End).

Note: Custom Category Placement can be enabled for all charts except pie,
doughnut, and pipeline, and does not work for continuous numeric or date/time
axes.

5. Click OK.5. 
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Define X-Axis Sorting Options for a Chart Widget
Use the X-Axis Sorting page (accessed from within the Chart Widget Properties window) to define how to
sort values on the x-axis of a Chart Widget.

To define x-axis sorting options for a Chart Widget:

1. Create a Widget

2. In the Type drop-down, select Chart.
3. Click the x-axis Sorting page.

4. Define the sort order:
◦ Ascending (example: 0-10, A-Z)

◦ Descending (example: 10-0, Z-A)

5. Define the sorting method:
◦ Sort Based on X-Axis Type: Select this radio button to sort x-axis values based on the x-value

of each point (example: If the x-axis field is a number, the points are sorted in numerical
order).

◦ Sort Based on X-Axis Labels: Select this radio button to sort x-axis values in alphabetical order
based on the labels of the x-axis points.

◦ Use Query Sorting: Select this radio button to sort x-axis values based on the query properties
defined in the series criteria (the search query used to retrieve data). Because sorting is done
as part of the query, results are based on the table field type being sorted. This only applies to
single series charts to avoid sort order conflicts between 2 series.

◦ Sort by Y Value: Select this radio button to sort x-axis values based on their corresponding y
values. You can select a number by which to limit the results and show either the top N results
or the bottom N results.

Note: This option is only available for charts with single, non-grouped series.

◦ Sort by Lookup Value: Select this radio button to sort x-axis values using values from a Lookup
Table and Fields.The Lookup Table is selected in the specific x-axis settings for the chart
series. The Lookup Target Field Type (example: Text, Date/Time, Number) is based on the
Target Field selected in the specific x-axis settings for the chart series.

Note: If no specific x-axis sorting settings are defined for a series, the raw x-values are used
(same as when sorting based on x-axis type). Sorting is based on the type of sort fields
(example: Text, Number, etc.), and the sort field types for each series must match.

6. Click OK.6. 
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Define Y-Axes for a Chart Widget
Use the Y-Axes page (accessed from within the Chart Widget Properties window) to define how one or
more y-axes look and behave in a Chart Widget. A Chart Widget can have two y-axes:

• Primary Y-axis (Y1): Left side of chart.

• Secondary Y-axis (Y2): Right side of chart. A secondary y-axis can distinguish the types of mixed
data (from different series) being compared against a common category (x-axis). For example, when
comparing two series of data against a common time period (x-axis), use a primary y-axis for a
series that uses Number of Incidents as its unit of measure, and a secondary y-axis for a series that
uses an Average Customer Satisfaction (rating) as its unit of measure.

The following figure shows a chart that plots two series of data against a common time period. Two
y-axes are used to distinguish the different units of measure (# of Incidents and Average Customer
Sat).

Properties for each axis include:

• Label: Text to display on the y-axis.

• Automatic Scaling: Whether to automatically calculate or manually specify ("fix") the scale values on
the y-axis. If you manually specify the scale values, you must provide a minimum and maximum
value.

Note: The Chart Widget Properties window is accessed from within the Widget Manager
when you create or edit a Chart Widget.

Good to know:
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• A secondary y-axis is optional.

• Scale values on the y-axes can be automatically calculated or "fixed."

• The y-axis values themselves are defined as part of the series (see Define a Series for a Chart
Widget).

To define one or more y-axes for a Chart Widget:

1. Create a Widget

2. In the Type drop-down, select Chart.
3. Click the Y-Axes page.

4. Define the following properties for your primary and secondary y-axes:
a. Label: Provide the text to display on the y-axis.

b. Use automatic scaling: Select this check box to automatically calculate the scale values on the
y-axis. Clear this box to manually define or "fix" the axis, and then define the fixed minimum
and maximum scale values for the axis.

Note: A fixed scale makes sense when you have a clear idea of your range. For example, if
you are showing percentages, and the highest current value is 10%, when automatically
scaled, 10% will be the maximum value, and will appear to fill the entire chart, when really you
want to see that 10% is only a small fraction of the expected value.

5. Click OK.5. 
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Define a Legend for a Chart Widget
Use the Legend page (accessed from within the Chart Widget Properties window) to define how a legend
looks and behaves on a Chart Widget. Properties include:

• Show Legend: Shows/hides a legend.

• Docking: Top, Left, Right, or Bottom, and aligned Near, Center, or Far.

• Alignment: Near, Center, or Far.

• Wrapping: Enable or disable wrapping of legend text.

• Constraint legend width: Set the maximum width of legend item text.

Note: The Chart Widget Properties window is accessed from within the Widget Manager when
you create or edit a Chart Widget.

To define the legend for a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
3. Click the Legend page.

4. Define properties:
a. Show Legend:

Select this check box to display a legend on the chart. The legend identifies the series on the
chart; the text is defined in the Series Name field (Series window).

b. Docking:
Select a docking option for the legend:

◦ Top

◦ Left
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◦ Right

◦ Bottom

c. Alignment:
Select an alignment option for the legend:

◦ Near

◦ Center

◦ Far

5. Wrap Legend Items:

Select this check box to wrap text for legend items to improve readability. Legend items are
arranged in columns and ordered from top to bottom, then left to right.

Legend items are added to fill approximately half of the chart's width (left to right docking) or height
(top or bottom docking). Remaining legend items can be viewed by clicking the ellipses at the
bottom of the legend.

6. Constrain Legend Width

Select this check box to control the width of legend text, and then specify the maximum legend item
width in pixels.

Note: The Wrap Legend Items and Constrain Legend Width options do not apply to
Pipeline charts.

7. Click OK.7. 
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Define Display Properties for a Chart Widget
Use the Display page (accessed from within the Chart Widget Properties window) to define how a Chart
Widget looks and behaves. Properties include:

• Items to Display: X-axis labels, Y-axis labels, grid lines, and tooltips.

• Color Palette: Colors to use for the items in the chart. By default, these colors are defined in the
Dashboard Theme; however, you can override the default palette.

• Allow Animation: Paints the chart items as they display (example: Columns grow to the values).
Note that chart widgets might paint differently in the Browser Client.

• Show Point Labels: Whether to show Y-axis values and/or X-axis labels on each chart point.

• Advanced options:
◦ Override Dashboard Theme colors.

◦ Override the Dashboard style.

Note: The Chart Widget Properties window is accessed from within the Widget
Manager when you create or edit a Chart Widget.

Good to Know:

• By default, chart colors (banner, labels, and bars/columns/lines/slices) and style (flat, chrome, or
none) come from the defined Dashboard Theme; however, you can override some of the properties.

• Whether to show point labels is defined for the entire chart. However, specific point label formatting
options are defined at the series level. Each series can have its own individual set of formatting
properties.

• Typically, the Advanced options are used to maintain "legacy" Dashboard themes and styles (these
are themes and styles that were created prior to CSM 5.00 and its Theme Manager). Ideally you
want to create and use Dashboard Themes that are created with 5.00+ capabilities. For more
information about Dashboard colors and styles, see Dashboard Themes. Overriding the Dashboard
Theme colors/styles affects your Chart Color Palette colors (i.e., the colors that appear on your bars,
columns, lines, and slices).

To define the Display properties for a Chart Widget:

1. Create a Widget.

2. In the Type drop-down, select Chart.
3. Click the Display page.

4. Define properties for the chart legend:
a. Items to display: Select one or more items to display on the chart (not all items apply for all

chart types):
◦ X-axis labels.

◦ Y-axis labels.

◦ Grid lines.
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◦ Tooltips.

b. Color Palette: Select the color palette to use for the items (example: Bars, columns, and
slices) in the chart. By default, these colors are defined in the Dashboard Theme; however,
you can override the default palette.

c. Allow animation: Select this check box to paint the chart items as they display (example:
Columns grow to the values).

d. Show point labels: Select this check box to have labels displayed next to each point on the
chart. In the drop-down, select an option:

i. Show Value: Show Y-values.

ii. Show Label & Value: Show Y-values along with the X-axis labels.

iii. Show Label: Show X-axis labels.

e. Advanced Options:
i. Override Dashboard Theme Colors: Select this check box to override the colors from the

defined Dashboard Theme with the colors from another Theme, and then select the
Theme that will override the default Theme, either:

◦ From Legacy Theme: Select a legacy Theme from previous versions of CSM.

◦ From Specific Theme: Select another defined Dashboard Theme.

ii. Override Dashboard Styles: Select this check box to override the defined Dashboard
Theme's style (Chrome, Flat, or Legacy) with another Theme style, and then select the
Theme style that will override the default Theme:

◦ Legacy

◦ Flat

◦ Chrome

5. Click OK.5. 
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Create a Command Palette Widget
Use the Command Palette Widget Properties window (accessed from within the Widget Manager) to
create a Command Palette Widget.

To create a Command Palette Widget:

1. Create a Widget.

2. In the Type drop-down, select Command palette.

3. To add a group of Actions:
a. Click the Add group button.

A New group is added to the list.

b. Name:

Provide a name for the group.

c. Image:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

d. Highlight the group, and then start adding single commands to it (see next step).

4. To add a single Action:
a. Click the Add command button.

The Action Manager opens, listing the available Actions, organized by category and scope.

b. Click a category, then a scope, then an Action.

Tip: Click the plus sign (+) next to a category to expand it, then navigate through the
scopes to locate the item you want. If the item does not yet exist, click the "category"
button (at the bottom of the window) to launch the item's Manager. From the Manager,
you can create a new item.
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Create a Filter Widget
Use the Filter Widget Properties window (accessed from within the Widget Manager) to create a Filter
Widget.

To create a Date Filter Widget:

1. Create a Widget.

2. In the Type drop-down, select Filter.
3. Select the Business Object whose data you want to filter (example: Incident). Only one type of

Business Object can be selected. The drop-down displays only Major Business Objects. To display
all Business Objects, select the Show All check box.

4. Define a Date Filter:
a. Select the Filter by Date radio button.

b. Ranges: Click this button to open the Multiple Date Ranges window, and then select one or
more date ranges (example: Any time, Today, Within last 1 week, etc.) to display in the drop-
down. If you select multiple data ranges, select a default range (example: Any time) to display
in the filter when the Widget first appears.

c. Filter Field: Select the date/time Field whose value limits the Widget (example: Created Date
Time would limit records to created Any Time, created Today, created within the last 1 week,
etc.; Modified Date Time would limit records to modified Any Time, modified Today, modified
within the last 1 week).

d. Hide Date Filters For Other Widgets On Dashboard: Select this check box to hide any other
date-filtered Widgets on the Dashboard so that this Filter Widget controls the date range.

e. If Widget Has a Date/time Filter, Use Its Field (even If Different Business Object Type): Select
this check box to allow a Widget with its own Date/Time filter to use its defined filtering field
instead of the Dashboard filtering field (example: Dashboard filter uses Created Date Time but
individual Widget uses Modified Date Time).

5. Click OK.5. 

To create a Lookup Table Filter Widget:

1. Create a Widget

2. In the Type drop-down, select Filter.
3. Select the Business Object whose data you want to filter (example: Incident). Only one type of

Business Object can be selected. The drop-down displays only Major Business Objects. To display
all Business Objects, select the Show All check box.

4. Define the lookup values to display in the filter (example: Filter Incidents by status):
a. Select the Filter by Lookup Table radio button.

b. Define the following:
i. Filter Field: Select the Field in the Business Object from which to retrieve values

(example: Status).

ii. Lookup and Field:
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Select the Lookup table and Field that supply all the possible values (example: For
Incident, it might be the Status field in the Incident Status Lookup table, with Status
values like New, In Progress, Assigned, etc.).

iii. Order by:

Select the Field to use to order the values, as well as an ascending (ex: 0-10, A-Z) or
descending (10-0, Z-A) order. Rarely will the alphabetical order match the order in which
the values should appear in your item, unless you prefix the values with numbers or
letters (example: For status, you would likely want lifecycle order, not alphabetical order);
therefore, it is common to define a field that contains a sequence number purely for
controlling the order (ex: Status Order).

5. Click OK.5. 

To create a Query Filter Widget:

1. Create a Widget

2. In the Type drop-down, select Filter.
3. Select the Business Object whose data you want to filter (example: Incident). Only one type of

Business Object can be selected. The drop-down displays only Major Business Objects. To display
all Business Objects, select the Show All check box.

4. Define a Query Filter (example: Show Incidents owned by me):
a. Select the Filter by Query radio button.

b. Define the Query using one of the following options:

◦ Click the Ellipses button  to open the Search Group Manager, and then select an
existing Search Group (saved Search Query) or create a Search Group. Saved
Searches can be used over and over in numerous places.

◦ Click the Custom Query button  to open the Custom Query Builder, and then create
a custom Search Query to use only for this scenario.
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5. Click OK.5. 

Tip: A Query filter uses a button to toggle the filter on/off  on a
Dashboard. Use the Dashboard Editor to define how the button looks and behaves on the
Dashboard (example: Text, colors, visibility, etc.).
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Create a Gauge Widget
Use the Gauge Widget Properties window (accessed from within the Widget Manager) to create a Gauge
Widget.

To create a Gauge Widget:

1. Create a Widget.

2. In the Type drop-down, select Gauge.

The Gauge Widget Properties window opens, displaying several pages (Criteria, Values, Properties,
Thresholds/Numbers, Drill-Down, and Display). Text and Numeric gauges display the Number
Properties page; all other Widgets display the Thresholds page.
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3. Define general properties:
a. Gauge Type: Select the type of gauge:

◦ Horizontal (Linear)

◦ Numeric (Digital or Mechanical)
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◦ Speedometer (Angle, Rectangular, Round, Round Rectangular)

◦ Text

◦ Thermometer (Linear)

◦ Vertical (Linear)

b. Default Title:

Provide the title to display above the Widget. The font, style, and color is inherited from the
Dashboard on which this Widget resides.

Note: You can change this title (Controls text box) when you put the Widget on a Dashboard;
however, the title is not dynamic so changes will not be pushed back to this field. Likewise, if
you later change this title in Widget Properties, the changes will NOT be pushed out to all the
places it resides on Dashboards. For more formatting flexibility, use a "floating" Text Widget to
display a label or title for a Widget.

c. Business Object:

Select the Business Object whose data to include in the gauge (example: Incident data).
Only one type of Business Object can be selected. The drop-down displays only Major
Business Objects. To display all Business Objects, select the Show All check box.

d. Refresh Every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

e. Exclude From Filters:

Select this check box to exclude the Widget from being filtered by any filter (Filter Widget)
being used on a Dashboard. (Dashboard filters limit multiple Widgets/data series at once).
Typically, this is selected if the Widget has its own Date/Time filter.

4. Define the following properties:
◦ Criteria: Data/records to include in the gauge (Ex: Open Incidents). Data is located/filtered

using a saved Search Query (Search Group) or a custom Search Query.

◦ Values: Value to display in the gauge (example: Number of records, Function, Duration, or
Metric).

◦ Properties (Scale): Minimum/maximum values to use for the gauge's scale, as well as scale
orientation and direction.

◦ Threshold: Thresholds/threshold colors for the gauge (example: Start, Middle, and End
ranges).

-or-

◦ Number: Text and number formats for the gauge (example: Decimals, leading zeroes, etc.).
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◦ Drill-Down: Drill-down behavior (example: Go to a Record List, Execute a command, or Go to
a Dashboard).

◦ Display: Enable animation, and color and style overrides.

5. Click OK.5. 
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Define Criteria (Data) for a Gauge Widget
Use the Criteria page (accessed within the Gauge Widget Properties window) to define which data/
records to include in a Gauge Widget (example: Open Incidents). Properties include:

• Search criteria: Data to include in the gauge (example: Open Incidents). Data is located using a
saved Search Query (Search Group) or a custom Search Query.

• Date range: Timeframe for the Search Query (example: Any Time, Within Last 1 Year, User-
selectable, etc.).

Note: The Gauge Widget Properties window is accessed from within the Widget Manager
when you create or edit a Gauge Widget.

Good to know:

• If you use a Metric value, do not define any criteria; the Metric has the criteria built in.

To define data for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Criteria page.

4. Define the search criteria (what to include in the gauge—example: Open Incidents). Data is located/
filtered using one the following options:

◦ Saved Search Query (Search Group): Click the Ellipses button  to open the Search Group
Manager, and then select an existing Search Group (saved Search Query) or create a Search
Group. Saved Searches can be used over and over in numerous places.

◦ Custom Search Query: Click the Custom Query button  to open the Custom Query
Builder, and then create a custom Search Query to use only for this scenario.

5. Define a timeframe for the Search Query (Date Range area):
a. Select a range option, either:

◦ Range: Select this radio button to define a date range for the Query, and then select an
existing timeframe (example: Anytime or Previous Year), or click the New button to
define a new timeframe.

◦ User Selectable: Select this radio button to allow the User/Customer to select the date

range from a drop-down. Then, click the Ellipses button  to open the Multiple Date
Ranges window and select the date ranges to include in the drop-down.

b. Field used for date range: Select the Field to use to give the range perspective (example:
LastModDateTime gives Previous Year perspective).

6. Click OK.6. 
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Define a Value for a Gauge Widget
Use the Values page (accessed within the Gauge Widget Properties window) to define the value to
display in a Gauge Widget. Values can be based on:

• Number of records.

• Function: Calculated average, maximum, minimum, or total (ex: Average customer satisfaction
rating).

• Duration: Calculated average, maximum, minimum, or total based on an amount of time (ex:
Average amount of time that Incidents take to resolve each day).

• Metric: Metric value, either simple Query or calculated.

• Secondary value: Value calculated using a secondary value (ex: What percentage of Incidents are
P1 (P1 Incidents/All Incidents x 100 = WHAT%)). If you had 70 Incidents and 43 were closed, your
P1 percentage would be 61.4%.

Note: The Gauge Widget Properties window is accessed from within the Widget Manager
when you create or edit a Gauge Widget.

Good to know:

• A Metric is a reusable measurement query that can be used in place of the other calculated values
(ex: Function, Duration, Calculated value). For more information, refer to the Metrics documentation.

To define a value for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Values page.
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4. Define the value to display in the gauge. A value can be:
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◦ Number of records: Select this option to display the number of records that match the criteria
(ex: 15 Open Incidents).

◦ Function: Select this option to display a value that calculates an average, maximum, minimum,
or total value based on a selected Field, and then select the function and Field (ex: Average
customer satisfaction rating).

◦ Duration Function: Select this option to display a value that is calculated based on an amount
of time (ex: Average amount of time that Incidents take to resolve each day), and then select
the Start/End Fields and the units (duration).

Example: Display the average amount of time that Incidents take to resolve each day (ex:
Start Field = Created Date/Time, End Field = Closed Date/Time, and Units = Days).

Note: A percent gauge is calculated by [Value]/[Secondary Value] * 100. If you are defining a
percent gauge, define the numerator (value) here and the denominator (secondary value) in
the next step. For example, for the calculation P1 Incidents/All Incidents x 100 = WHAT%,
define P1 Incidents here.

◦ Metric: Select this option to use a Metric value, and then select an existing CSM Metric in the
drop-down; or, click the Metric button to launch the Metric Manager, and then create a Metric.

Note: If you select a Metric, the Metric Properties window pops up, prompting you to
select which value you would like to retrieve for use in the gauge. The value can be
retrieved from the local cache or from the database. You can also access the Metric
Properties window by pressing the Metric icon . For more information about Metrics
and caching, refer to the Metrics documentation.

5. (Optional) Define a secondary value to use for a calculation:

Note: The calculation for a percentage is (Criteria) / (Secondary Criteria) * 100. If you want a
percentage of Open Incidents out of all Incidents, your Criteria would be Open Incidents and
your Secondary Criteria would be All Incidents.

a. Use Secondary Value to Calculate Final Result: Select this check box to display a calculated
value on the Widget, and then define how to calculate the value by selecting an option in the
drop-down (currently, percentage is the only option).

The Secondary Criteria and Secondary Values pages appear in the Options list.
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b. Define the secondary criteria/value to use in the calculation.

6. Click OK.6. 
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Define a Scale for a Gauge Widget
Use the Properties page (accessed within the Gauge Widget Properties window) to define the scale for a
Gauge Widget. Properties include:

• Minimum and maximum scale values.

• Auto-raise value: Enables the gauge to automatically raise the maximum scale value if the value
exceeds this limit.

• Logarithmic scale (Linear, Speedometer, and Thermometer gauges only): Use a logarithmic scale to
use intervals corresponding to orders of magnitude rather than a standard linear scale. This is
helpful when the data covers an exceedingly large range of values.

• Display properties for the gauge and scale (example: Text alignment, Horizontal orientation, and
scale direction).

To define a scale for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Properties page.

4. Define the scale for the gauge:
a. Minimum/Maximum values: Define the minimum and maximum values for the gauge's scale

(example: 1-99). Some scales are physical (example: Thermometer and Speedometer
displays); on Text and Numeric gauges, min/max values represent the limit of legal values
(example: Min and max number of records to display on a Text gauge).

Note: Numeric gauges display an error if the value is out of range. Other gauges "top out."

b. Auto-Raise Value: Select this check box to enable the gauge to automatically raise the
maximum if its values exceed this limit.

c. Logarithmic scale: Select this check box to define the scale using intervals corresponding to
orders of magnitude rather than a standard linear scale. This is helpful when the data covers
an exceedingly large range of values.

5. Define display properties for the gauge and scale (these vary by the type of gauge):
a. Text Alignment (Text gauge only): Select the alignment for the scale, with respect to the

Widget's bounding box (example: Bottom Center).

b. Flip the horizontal orientation (Angle Speedometers only): Select this check box to flip the
angle of the speedometer so that it opens to the left (flipped) instead of the right (default).

c. Reverse the scale direction (Angle Speedometers only): Select this check box to flip the scale
so that it displays values from maximum-to-minimum (reversed; example: 5-1) rather than
minimum-to-maximum (default; example: 1-5).

6. Click OK.6. 
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Define Thresholds for a Gauge Widget

Note: Linear, Speedometer, and Thermometer gauges display the Thresholds page. Text and
Numeric gauges display the Number Properties page.

Use the Thresholds page (accessed within the Gauge Widget Properties window) to define boundaries
that visually alert you through color changes if Gauge Widget values cross a defined threshold. For
example, set up thresholds to alert you when:

• Too many Incidents accumulate in the new Queue.

• An initial response time is too long.

• Actions/tasks required for an incident are not being completed.

• Sales figures are about to cross the goal mark.

• Customer survey ratings fall below an acceptable rating.

Threshold properties include:

• Start Range.

• Middle Range.

• End Range.

• Theme color overrides.

• Use of solid colors.

Good to know:

• On Desktop Client Dashboards, thresholds are purely visual.

• On Browser Client Dashboards, thresholds display only start and end ranges.

• When Widgets are used in Cherwell Mobile, the thresholds are used to determine if a gauge is in an
alert state.

• If you want Actions to take place based on thresholds, you can define threshold-based Automation
Processes. For more information, refer to the Automation Processes documentation.

• Stay within your scale (example: If min is 0 and max is 100, a threshold of 150 would be outside
your scale) and take into consideration the direction of the scale (max-to-min or min-to-max).

• By default, threshold colors come from the defined Dashboard Theme; however you can override
the colors and use a Web or Custom color instead.

Note: Gauge items vary by gauge type (example: Thermometer ticks are different than
speedometer ticks). Also note that the Dashboard styles (Legacy, Flat, and Chrome) affect
how the colors are applied.

• Dashboard Theme colors/styles can also be overridden on a per Widget basis (see Display tab).
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Note: The Gauge Widget Properties window is accessed from within the Widget Manager
when you create or edit a Gauge Widget.

To define thresholds for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Thresholds page.

4. Enable using thresholds on the gauge:
a. Use thresholds: Select this check box to use thresholds, and then define the ranges

(following).

5. Define one or more threshold ranges/colors:
a. Start range: Specify the low threshold. On a gradient, this starts your low zone (example:

Green zone).

b. Middle range: Specify the middle threshold. On a gradient, this is the middle of your middle
zone (example: Orange zone).

c. End range: Specify your high threshold. On a gradient, this is the highest value of your high
zone (example: Red zone).

Note: By default, threshold colors come from the defined Dashboard Theme colors;
however, you can override the colors and use Web or Custom colors instead. To
override the colors, select the Override theme default value check box, and then
click the Color Selector button to select a different color.

d. Use solid colors: Select this check box to show more distinct color changes, rather than a
gradual gradient.

6. Click OK.6. 
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Define Number Properties for a Gauge Widget

Note: Text and Numeric gauges display the Number Properties page. Linear, Speedometer, and
Thermometer gauges display the Thresholds page.

Use the Number Properties page (accessed within the Gauge Widget Properties window) to define how to
format text and numbers in a Gauge Widget. Formatting options vary by category (Number, Currency,
Percentage, or Custom):

• Number: Define decimal places and enable 1000 separator, negative sign, and leading zeros.

• Currency: Define decimal places and symbol.

• Percentage: Define decimal places.

• Custom: Define a custom format string.

Note: The Gauge Widget Properties window is accessed from within the Widget Manager
when you create or edit a Gauge Widget.

To define number properties for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Number Properties page.

4. Select a category (select one).

5. Define the following number properties (properties vary by category):
◦ Decimal Places: Specify the number of decimal places to display to the right of a decimal point

(example: 5.0 has one decimal place, 5.00 has two decimal places). Zero (0) indicates a whole
number (no decimal place).

◦ Use 1000 Separator: Select this check box to add a separator (example: Comma) when a
number value reaches 1000. Separators vary depending on locale (example: USA, Europe,
etc.).

◦ Show Leading Zeroes: Select this check box to display zeroes (if any) before a decimal place
(example: 0.7 has a leading zero).

◦ Show Negative Sign: Select this check box to display a negative sign (when applicable) before
a number string (example: -5.0).

◦ Currency Symbol: By locale (example: English, United States).

◦ Custom: Define a custom format or use an existing one (example:
0,0.00,#.##0,0%,0.00%,0.00E+00, ##0.0E+0).

6. Click OK.6. 
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Define Drill-Down for a Gauge Widget
Use the Drill-Down Properties page (accessed within the Gauge Widget Properties window) to define drill-
down behaviors for a Gauge Widget. Drill-down options include:

• Go to a Record List: Drill-down displays a Grid list of pertinent records. Use the CSM Grid
capabilities (example: Print, export, run an Action, sort, filter, group, size, move/reorder, and add/
remove columns) to display only the data you want and in a way that is meaningful to you. Click a
record to view it in detail.

• Execute a command: Drill-down executes a command/Action (example: Display an Action Catalog,
Calendar, Dashboard, Document Repository, HTML Page or Visualization, or run a command, One-
Step, search, or report).

• Go to a Dashboard: Drill-down displays another Dashboard (example: A Dashboard dedicated to
the Widget data). Filtering can be honored so that the filtering criteria on the source Dashboard is
extended to the drill-down Dashboard (example: If Widget is being filtered by month, the drill-down
Dashboard will initially be filtered by month, as well).

• None: Drill-down is not allowed.

Note: The Gauge Widget Properties window is accessed from within the Widget Manager
when you create or edit a Gauge Widget.

Good to know:

• Dashboard drill-down is configurable, so behaviors can vary. For more information, see Dashboard
Drill-Down.

• Dashboard drill-down can be defined to honor filtering. For example, if the drill-down honors filtering
(Filter Dashboard is selected on the Dashboard's Drill-Down page), when you filter a Dashboard to
show only Today's data and then drill down into another Dashboard, then the drill-down Dashboard
will also be filtered to show only Today's data. A Filter bar at the top of a drill-down Dashboard
displays any filtering criteria. Users can remove the filter by clearing the filters.

To define drill-down properties for a Gauge Widget:

1. Create a Widget

2. In the Type drop-down, select Gauge.

3. Click the Drill-Down page.

4. Define a drill-down option for the gauge:
◦ Go to a Record List: Select this radio button to drill-down into a list of pertinent records.

◦ Execute a command: Select this radio button to execute a command/Action upon drill-down.

Click the Ellipses button  to open the Action Manager, and then select the command to
execute or create a new command/Action.

◦ Go to a Dashboard: Select this radio button to drill-down into another Dashboard. Click the

Ellipses button  to open the Dashboard Manager, and then select an existing Dashboard
or create a new Dashboard.
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5. Click OK.5. 
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Define Display Properties for a Gauge Widget
Use the Display page (accessed within the Gauge Widget Properties window) to:

• Allow animation: Paints the gauge items as they display (example: Thermometer grows to its value).
Note that chart widgets might paint differently in the Browser Client.

• Define advanced options:
◦ Override Dashboard Theme colors.

◦ Override the Dashboard style.

Note: The Gauge Widget Properties window is accessed from within the Widget
Manager when you create or edit a Gauge Widget.

Good to know:

• By default, gauge colors (banner, labels, face, grid line/tick, and threshold) and style (flat, chrome, or
none) come from the defined Dashboard Theme; however, you can override some of the properties.

• Typically, the Advanced options are used to maintain legacy Dashboard themes and styles (these
are themes and styles that were created prior to CSM 5.00 and its Theme Manager). Ideally you
want to create and use Dashboard Themes that are created with 5.00+ capabilities. For more
information about Dashboard colors and styles, see Dashboard Themes. Overriding the Dashboard
Theme colors and styles affects your Threshold colors.

To define display properties for a Gauge Widget:

1. Create a Widget.

2. In the Type drop-down, select Gauge.

3. Click the Display page.

4. Define the following display options:
a. Allow Animation: Select this check box to paint the gauge items as they display (example:

Thermometer grows to its value).

b. Advanced Options:
i. Override Dashboard Theme Colors: Select this check box to override the colors from the

defined Dashboard Theme with the colors from another Theme, and then select the
Theme that will override the default Theme, either:

◦ From Legacy Theme: Select a legacy Theme from previous versions of CSM.

◦ From Specific Theme: Select another defined Dashboard Theme.

ii. Override Dashboard Styles: Select this check box to override the defined Dashboard
Theme's style (Chrome, Flat, or Legacy) with another Theme style, and then select the
Theme style that will override the default Theme:

◦ Legacy

◦ Flat

◦ Chrome
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5. Click OK.5. 
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Create a Matrix Widget
Use the Matrix Widget Properties window (accessed from within the Widget Manager) to create a Matrix
Widget.

To create a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Define general properties:
a. Default title:

Provide the title to display above the Widget. The font, style, and color is inherited from the
Dashboard on which this Widget resides.

Note: You can change this title (Controls text box) when you put the Widget on a Dashboard;
however, the title is not dynamic so changes will not be pushed back to this field. Likewise, if
you later change this title in Widget Properties, the changes will NOT be pushed out to all the
places it resides on Dashboards. For more formatting flexibility, use a "floating" Text Widget to
display a label or title for a Widget.

b. Default Business Object:

Select the Business Object whose data you want to include on the Widget (ex: Incident).

Only one type of Business Object can be selected. The drop-down displays only Major
Business Objects. To display all Business Objects, select the Show All check box.

c. Refresh Every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

d. Allow Drill Down:

Select this check box to allow Users to double-click the Widget and be taken to data
represented by that Widget.

Only certain cells in a Matrix support drill-down.

e. Exclude From filters:

Select this check box to exclude the Widget from being filtered by any filter (Filter Widget)
being used on a Dashboard. (Dashboard filters limit multiple Widgets/data series at once).
Typically, this is selected if the Widget has its own Date/Time filter.

4. Define the following properties:
◦ Rows: Rows for the Matrix Widget.

◦ Columns: Columns for the Matrix Widget.

◦ Appearance: How the Matrix looks (colors, fonts, etc.).
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5. Click OK.5. 
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Define Rows for a Matrix Widget
Use the Rows page (accessed from within the Matrix Widget Properties window) to define how the rows
look and behave on a Matrix Widget. Properties include:

• Where to get the data for the rows, either:
◦ List of Rows Come From a Field: Rows come from values in a Field (example: A row for each

status).

◦ List of Rows are Based on Date: Bases rows on periods within a date range (example: If your
range is a year, and your periods are months, you will have a row for each month of the
specified year).

• Totaling/averaging options:
◦ Total Row: Adds a row to total other rows in the matrix.

◦ Average Row: Adds a row to average other rows in the matrix.

• Visibility: When to hide the row (example: Use an Expression to hide the row when the values are
negligible).

• Field for List of Rows: Business Object and Field that provide the values for the row. You can also
define sorting (Sort By field and ascending/descending) and a limiting Expression.

• Limit Values by Date: Limit values to a specific date range (example: All, Today, Yesterday, Within
last 1 week/month/quarter/year, custom range, etc.).

Note: The Matrix Widget Properties window is accessed from within the Widget Manager
when you create or edit a Matrix Widget.

To define rows that come from a Field for a Matrix Widget:

1. Create a Widget..

2. In the Type drop-down, select Matrix.

3. Click the Rows page.

4. Select the List of Rows come from a Field radio button.

Note: When you select List of rows come from a Field, you specify the Lookup table that will
provide the values to display. For example, if you want a row for each status, you might
select the Status field from the Incident Status Lookup table. You are not limited to Lookup
tables; however, performance will be better if you select a cacheable Lookup table rather
than the Status field from the Incident Business Object.

5. Define totaling/averaging options:
a. Total Row: Select this check box to add a row to total other rows in the matrix.

b. Average Row: Select this check box to add a row to average other rows in the matrix.

6. Define visibility:
a. Define an Expression to conditionally hide a row, using either:

CSM 9.3.0 Features 1568

CSM 9.3.0 Features

https://help.cherwell.com/bundle/csm_features_930_help_only/page/oxy_ex-1%2Fcontent%2Fsuite_features%2Fwidgets%2F..%2Fexpressions%2Fabout_expressions.html


◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

7. Define the values for the row:
a. Business Object/Field:

Select the Lookup table and Field that supply all the possible values (example: For Incident,
it might be the Status field in the Incident Status Lookup table, with Status values like New, In
Progress, Assigned, etc.).

b. Order By:

Select the Field to use to order the values, as well as an ascending (ex: 0-10, A-Z) or
descending (10-0, Z-A) order. Rarely will the alphabetical order match the order in which the
values should appear in your item, unless you prefix the values with numbers or letters
(example: For status, you would likely want lifecycle order, not alphabetical order); therefore, it
is common to define a field that contains a sequence number purely for controlling the order
(ex: Status Order).

c. Limit Rows:

Define a Search Group or Custom Query to limit the rows (example: Limit the rows to only
those where the Department = Network Support).

8. Limit values by date:

Note: This does not affect the list of rows; instead, it adds an additional criteria to the data in
each column. If you select to set up a User selectable option, then a small drop-down is
displayed to show the various options.

a. Provide a date range limit for your data, using either:
◦ Range: Select this radio button to use a single date range to limit the data. Then, select

the date range (example: Any time, Today, etc.), or click New to open the Custom Date
Range window where you can define a custom date range.

◦ User-Selectable: Select this radio button to display a drop-down list on the matrix so that

Users can select how to limit the data. Then, click the Ellipses button  to open the
Multiple Date Ranges window, where you can select one or more date ranges to
include in the drop-down.

b. Field Used for Date Range: Select the Field to use to give the range perspective (example:
"LastModDateTime" gives "Previous Year" perspective).

9. Click OK.9. 

To define rows that are based on a date for a Matrix Widget:
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1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Rows page.

4. Select the List of Rows are Based on Date radio button.

5. Define totaling/averaging options:
a. Total Row: Select this check box to add a row to total other rows in the matrix.

b. Average Row: Select this check box to add a row to average other rows in the matrix.

6. Define visibility:
a. Define an Expression to conditionally hide a row, using either:

◦ Custom Expression: Click the Custom Expression button  to open the Custom
Expression Builder, and then create a custom Expression specifically for this scenario.

◦ Stored Expression: Click the Ellipses button  to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

7. Define the date range:
a. Provide a date range limit for your data, using either:

◦ Range: Select this radio button to use a single date range to limit the data. Then, select
the date range (example: Any time, Today, etc.), or click New to open the Custom Date
Range window, where you can define a custom date range.

◦ User-Selectable: Select this radio button to display a drop-down list on the matrix so that

Users can select how to limit the data. Then, click the Ellipses button  to open the
Multiple Date Ranges window, where you can select one or more date ranges to
include in the drop-down.

Note: This option works differently for date-based rows. Instead of limiting the data that
is pulled, it modifies the rows that are displayed (example: If you allow the User to select
between Last Year, This Year, and Next Year, the rows change to show the months from
the specified year).

b. Break Range Into Periods: Select the range covered by each row. If your date range does not
contain complete periods (example: You select monthly, but have a range that starts halfway
through a month), the date range automatically expands to make up complete periods.

8. Click OK.8. 
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Define Columns for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how the columns look and
behave on a Matrix Widget. You can define the following types of columns:

• Numeric column: Query-based column that determines the number of records available for each
row that fit the specified query.

• Calculated column: Lets you do math against other columns (example: Add up two other column’s
values).

• Image column: Displays an appropriate image based on an Expression (example: If Incidents
Closed > 10, show a smiley face).

• Text column: Displays text based on an Expression (example: If Open Incidents > 0, show Out of
Compliance).

• Value bar column: Shows a bar whose width represents a value (example: Show a bar comparing
the number of changes approved each month).

• Ratings column: Shows a number of images based on a value (example: Show a star for each
Incident closed by a technician).

Note: The Matrix Widget Properties window is accessed from within the Widget Manager
when you create or edit a Matrix Widget.
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Define a Numeric Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how a numeric column looks
and behaves on a Matrix Widget.

A numeric column is a query-based column whose data is retrieved and then split out among the different
rows. For example, if you have a row for each support Incident category, you can have a numeric column
that counts the number of Incidents for Software, Hardware, Network Support, etc. You might have
another column that limits the records returned to Open Incidents only and another for Closed Incidents
only, etc.

The display of a numeric column is simply a number. Numeric columns are the only ones that support
drill-down (because other columns are all calculated in some way, there is no reasonable way to know
what data to show when drilling down).

To define a numeric column for a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Numeric Column.

5. Define general properties:
a. Title: Provide a title for the column.

b. Fixed Width: Select this check box to specify a fixed width for the column. Then, specify the
width, in pixels. If not selected, the column width adjusts to the Widget width.

c. Visible: Select this check box to display the title of the column in the matrix.

6. Define the records to include in the column:
a. Click the Search page.

b. Define the records to include:
i. Business Object: Select the Business Object whose data you want to display in the

columns. This defaults to the same set for the Widget as a whole; however, you can
have different columns pulled from different Business Objects (so one matrix could show
data from Incidents, Problems, and Changes side-by-side).

ii. Field to Use to Split Business Objects Between Rows: Select the Field in the source
Business Object that contains the matching value for each row. For example, if you have
a row for each category (pulled from the Incident Category table), specify the Field in
your Business Object that contains Categories.

iii. Search Criteria: Define a Search Query to locate the records to include on the Widget
(example: In a Closed column, show Closed incidents). You have two options:

◦ Click the Ellipses button  to open the Search Group Manager, and then select
an existing Search Group (saved Search Query) or create a Search Group. Saved
Searches can be used over and over in numerous places.
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◦ Click the Custom Query button  to open the Custom Query Builder, and then
create a custom Search Query to use only for this scenario.

iv. Field Used for Date Range: Select the Field to use if there is a date filter applied to the
matrix. By default, this will be the same Field set on the Rows page of the main matrix
setup, but because Business Objects other than the primary can be displayed, the
behavior might be different from column to column. This is not used when you have rows
based on date. In that situation, the Field used to split records between rows will be a
date field for that purpose.

7. Define the values to display in the column:
a. 

b. Define the value to display. A value can be:
◦ Number of records: Select this option to display the number of records that match the

criteria (example: 15 Open Incidents).

◦ Function: Select this option to display a value that calculates an average, maximum,
minimum, or total value based on a selected Field, and then select the function and
Field (example: Average cost for each row).

◦ Duration Function: Select this option to display a value that is calculated based on an
amount of time (example: Average amount of time that Incidents take to resolve each
day), and then select the Start/End Fields and the units (duration).

◦ Metric: Select this option to use a Metric value, and then select an existing CSM Metric
in the drop-down; or, click the Metric button to launch the Metric Manager, and then
create a Metric.

8. Define the format for the column:
a. 

b. Define formatting options:
i. Format: Select a format for the number (example: Number, Percent, Currency/locale

symbol).

ii. Decimal places: Specify the number of decimal places to show for each value.

iii. Text Position: Select how to align the value in the column (example: Centered, left-
justified, or right-justified).

iv. Color Text: Select this check box to define an Expression to conditionally change the
color of the text (example: If the value is negative, show it as red). You cannot use a
Stored Expression here because regular Stored Expressions do not have access to
column values.

9. Click OK.9. 
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Define a Calculate Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how a calculated column looks
and behaves on a Matrix Widget.

A calculated column displays a calculated value that is determined by executing a calculation against
other columns in the Matrix (example: Add up open and closed Incidents for a grand total).

The following figure shows an example of how a Matrix Widget uses a calculated column on a Dashboard.

Good to know:

• Calculated columns are calculated after all numeric columns have been retrieved.

• Calculated columns cannot query themselves.

To define a calculated column for a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Calculated column.

5. Define how the value in the column will be calculated:
a. Click the Calculated Value page.

b. Click the Selector button , and then select the Tokens (System Functions, Expressions,
Stored Values, Metrics, and/or Counters) and math operators to build the calculation.

6. Define the format for the column:
a. Click the Format page.

b. Define formatting options:
i. Format: Select a format for the number (example: Number, Percent, Currency/locale

symbol).

ii. Decimal places: Specify the number of decimal places to show for each value.

iii. Text Position: Select how to align the value in the column (example: Centered, left-
justified, or right-justified).

iv. Color Text: Select this check box to define an Expression that controls the color of the
text (example: If the value is negative, show it as red. You cannot use stored
Expressions here because regular stored Expressions do not have access to column
values).

CSM 9.3.0 Features 1574

CSM 9.3.0 Features



7. Click OK.7. 
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Define an Image Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how an image column looks
and behaves on a Matrix Widget.

An Image Column displays a conditional image based on a defined Expression. For example, display a
green check if your overall customer satisfaction rating is 4 or 5, and a warning icon if it is below 4.

The following figure shows an example of how a Matrix Widget uses an image column on a Dashboard.

Note: You can use a value from another column in your Expression. In the above example, the
value in the Overall column (Numeric Column) determines which image to display in the Good or
Bad column.

To define an image column for a Matrix Widget:

1. Create a Widget

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Image column.

5. Define image properties:
a. Image Width and Image Height control: Specify the width and height of the image, in pixels.

Consider proportion when specifying the size. For example, for a square graphic, adjust the
size and width by the same measurement to avoid distortion. To help, CSM provides several
OOTB graphics, organized by pixel size.

b. Image: Select the image to use or define an Expression to conditionally determine the image.

6. Click OK.6. 
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Define a Text Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how a text column looks and
behaves on a Matrix Widget.

A text column displays conditional text based on a defined Expression. For example, display the word
GOOD if your overall customer satisfaction rating is 4 or 5, and the word BAD if it is below 4. You can also
conditionally change the color of the text based on an Expression.

The following figure shows an example of how a Matrix Widget uses a text column on a Dashboard.

Note: You can use a value from another column in your Expression. In the above example, the
value in the Overall column (numeric column) determines the text to display in the Good or Bad
column.

To define a text column for a Matrix Widget:

1. Create a Widget

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Text column.

5. Define text properties:

a. Text: Click the Custom Expression button  to open the Custom Expression Builder, and
then create the Expression to determine the text to display.

b. Color Text: Select this check box to change the color of the text based on an Expression. Click

the Custom Expression button  to open the Custom Expression Builder, and then create
the Expression to determine when to change the text color.

6. Click OK.6. 

CSM 9.3.0 Features 1577

CSM 9.3.0 Features



CSM 9.3.0 Features 1578

CSM 9.3.0 Features



Define a Value Bar Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how a value bar column looks
and behaves on a Matrix Widget.

A value bar column displays a bar whose width represents a value. For example, display a value bar
comparing the number of changes approved for each row.

Good to know:

• Calculated columns are calculated after all numeric columns have been retrieved.

• Calculated columns cannot query themselves.

To define a value bar column for a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Calculated column.
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5. Define how the value will be calculated:
a. Click the Calculated Value page.

b. Click the Selector button , and then select the Tokens (System Functions, Expressions,
Stored Values, Metrics, and/or Counters) and math operators to build the calculation.

6. Define how the value bar looks:
a. Click the Value-Line page.
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b. Define the width of the value bar, either:
◦ Set Complete Line Based on Largest Value: Select this radio button to auto-determine

the maximum width; the width of the value bars is based on the largest value of any row.
For example, if the Hardware category has a value of 10, which is the largest, then the
value bar for Hardware category will fill the entire width, and all other bars will be a
percentage of that width.

◦ Set Specific Threshold: Select this radio button to specify a maximum width. You can
then select the following options:

◦ Show Values That Exceed the Threshold: Select this check box to show overages
on the value bar (values that are greater than the specified threshold). Overages
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can be displayed in a different color (see Overage Color below). If not selected,
value bars that exceed the maximum width appear cut off.

◦ Draw a Line to Indicate the Threshold Position: Select this check box to draw a
short vertical line to indicate the specific threshold to make it easier to see.

c. Draw a Border Around the Value Bar: Select this check box to draw a box around the whole
value bar. If not selected, the value bar is free-floating.

d. Define the colors of the value bar:
i. Bar Color: Select the primary color for the value bar.

ii. Bar Color Expression: Select this check box to use an Expression to conditionally
change the color of the value bar. Then, define the Expression.

iii. Overage Color: Select this check box to use a specific color for overages (bars that
exceed the maximum width). Then, select a color.

iv. Overage Expression: Select this check box to use an Expression to conditionally change
the color of the overage. Then, define the Expression.

v. Use Solid Colors: Select this option to use a solid color on the value bar. By default,
values bars are drawn using gradients, darkening towards the bar color as they get
longer.

e. Fixed Height: Select this check box to use a fixed height for the value bar. Then, specify the
height. By default, the value bar takes up a calculated percentage of the available space for
the row.

7. Click OK.7. 
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Define a Ratings Column for a Matrix Widget
Use the Columns page (in the Matrix Widget Properties window) to define how a ratings column looks and
behaves on a Matrix Widget.

A ratings column shows a number of images based on a value. For example, you could show a star for
each Incident closed by a technician.

Good to know:

• Calculated columns are calculated after all numeric columns have been retrieved.

• Calculated columns cannot query themselves.

To define a ratings column for a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Columns page.

4. Click Add>Calculated column.

5. Define how the rating will be calculated:
a. Click the Calculated Value page.

b. Click the Selector button , and then select the Tokens (System Functions, Expressions,
Stored Values, Metrics, and/or Counters) and math operators to build the calculation.

6. Define how the ratings column will look:
a. 

b. Define the following:
◦ Image Width:

Specify the width of the image for display.

◦ Image Height:

Specify the height of the image for display.

◦ Image:

Click the Image button to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

◦ Select the Image Expression check box to use an Expression to change the

image based on conditions. Then, click the Custom Expression button  to
open the Custom Expression Builder and create a custom Expression. If no special
condition applies, then the default image is used.

◦ Maximum rating:
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Select this check box to impose a cap on the number of images to show, and then
specify the maximum number.

◦ Show partial ratings:

Select this check box to show fractions of values (example: 2 ½ stars).

◦ Stretch image:

By default, a new version of the image is shown for each value, so the value 10 would be
represented by 10 stars. However, you can instead have the rating column stretch out a
single version of the image based on the rating. This can be effective with certain images
that stretch well, but might look odd with other images.

7. Click OK.7. 
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Define Appearance for a Matrix Widget
Use the Appearance page (in the Matrix Widget Properties window) to define how the Matrix Widget looks
and behaves, including:

• Custom font and font color.

• Highlighting alternate rows.

• Fixed row height.

• Show/hide column headers.

To define appearance for a Matrix Widget:

1. Create a Widget.

2. In the Type drop-down, select Matrix.

3. Click the Appearance page.
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4. Define the appearance properties:
a. Custom content font: Select this check box to use a specific font for text displayed on the

Matrix. (If not selected, the Widget uses the Theme font currently applied to the Dashboard on
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which the Matrix appears). Click the Ellipses button  to open the Font window, and then
select a Font, Style, and Size.

b. Custom font color: Select this check box to use a custom color to use for all text (that is not
otherwise overridden by Expressions on a per-column basis). Click the Color Selector button

 to open the Color Selector, and then select a color:
◦ System:

Set of colors provided by your Operating System. System colors can greatly vary
depending on the Operating System and browser used to view the color.

◦ Web:

Set of named Web-safe colors.

◦ Custom:

Customized Red, Green, Blue (RGB) colors.

c. Highlight alternate rows: Select this check box to add a color to every other row so that rows
can be differentiated from one another. Then, select the color for the alternate row.

d. Fixed row height: Select this check box to use a specific row height. Then, provide the row
height, in pixels. By default, the height of rows is based on content and available space.

e. Show column headers: Select this check box to display the name of each column above that
column. If unselected, headers will not be displayed.

5. Click OK.5. 
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Create an RSS Feed Widget
Use the RSS Feed Widget Properties window (accessed from within the Widget Manager) to create an
RSS Feed Widget.

To create an RSS Feed Widget:

1. Create a Widget.

2. 

3. Define the feed to show on the RSS Feed Widget:
a. RSS Feed URI: Provide the URI for the RSS feed.

Tip: In most browsers, you can right-click the RSS feed icon  and select Copy Link
Location or Copy Link to copy the URL onto your clipboard. You can then paste it into the
RSS Feed URI text box in the RSS Feed Widget Properties window. A number of technical
tools also expose RSS feeds in various ways (including CSM).

4. Specify the maximum number of entries to show:
a. Max Items to Show: Provide a number. Most sites already limit the number of entries exposed

from a feed, but you can enforce a stricter limit.

5. Specify whether or not to show images in the feed:
a. Display Image from Description if present: Select this check box to show the first found image

included with each entry. If this box is unchecked, images will be suppressed (this might be
done to save space or to make the entries display more quickly).

6. Specify a custom link color to use in the Widget:
a. Custom link color: Select this check box to use an alternate color for Twitter links (by default,

links in the title and the body of each Tweet use the system-defined color for links. However,
depending on the rest of your color selections, these links might be hard to read). Click the
Color Selector button  to open the Color Selector, and then select a color:

◦ Web:

Set of named Web-safe colors.

◦ Custom:

Customized Red, Green, Blue (RGB) colors.

7. Define how often to refresh the Widget:
a. Refresh every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

8. Select one or more One-Steps to initiate from the Widget (Create actions area):
a. Click the Add button to launch the One-Step Manager, and then select one or more existing

One-Steps, or create a new One-Step.
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b. Click OK.b. 

Tip: Click the Remove button to remove a selected One-Step from the list. Use the Up/Down
arrows to reorder the One-Steps in the list.

9. Click OK.9. 
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Create a Search Widget
Use the Search Widget Properties window (accessed from within the Widget Manager) to create a Search
Widget.

To create a Search Widget:

1. Create a Widget.

2. In the Type drop-down, select Search.

3. Define general properties for the Search Widget:
a. Title: This field is not used for a Search Widget. A title can be defined, but is not displayed on

the Widget.

4. Define which type of Search is available (can be run) from the Widget.
a. Select one option:

◦ Quick Search: Select this radio button to allow a Quick Search to be run from the Widget
(allows Users to search multiple Business Objects for all applicable records that contain
specific words or phrases).

◦ Specific search: Select this radio button to allow a Specific Search to be run from the
Widget (allows Users to search one Business Object for all applicable records that
contain specific words or phrases).

◦ Both: Select this radio button to allow both a Quick Search and a Specific Search to be
run from the Widget.

b. If both types of Searches are available in the Widget, select a default Search (either Quick
Search or Specific Search).

5. Define options for Quick Search (if used on Widget):
a. In the Options area, click the Quick Search page.

b. Custom Watermark Text: Select this check box to include a watermark inside the Search
Control's box, and then provide the text to display (example: "Type search words here").

c. Select the items (Business Objects) to include in the search, and then define search options
for each: For each item, click the Add button, and then select a Business Object (or
Document Repository) to include in the search.

i. Define the following search options for each Business Object:i. 

Note: Document Repository options are limited to applicable options.

◦ Name: Auto-fills with the name of the Business Object/Doc Repository.

◦ Custom Watermark: Select this check box to include a watermark inside the
Widget's Search box. Provide the watermarktext to display (example: "Search
Incident").

◦ Search For Any/All Words: Select whether to use any (OR) or all (AND) logic in the
search.
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◦ Open [records] Only: Select this check box to limit the search to records that have
not reached their final state (example: Not closed).

Note: The lifecycle and terminology vary depending on the Business Object
and scenario (example: "Unapproved Changes" is a lifecycle state for
Change, and therefore is only available when searching Changes). If the
Business Object does not have a "final" or closed state, the check box is
not available.

◦ Changed: Select a timeframe to limit the search (example: Any time).

◦ Sort By: Select the Business Object Field (column) to use to sort the search

results. Click the Sort in Descending Order button  to toggle the sort order
between ascending (1-10, A-Z, etc.) and descending (10-1, Z-A, etc.). A non-active

icon  indicates ascending order; an active icon  indicates descending
order.

◦ Search Related: Select this check box to include related Business Objects in the
search (example: If the search word appears in a Journal entry, the Incident to
which it is attached will be included in the search results).

Note: In order to be included in the search, both the related Business
Object and the Relationship must be enabled for Full Text Search
(example: Select the Include in Full Text Search check box on the
Business Object Properties window in a Blueprint (Search Results page)
and the When Searching <bus ob> Include <related bus ob> in Full
Text Search check box on the Relationship Properties window (General
page)).

◦ Search Attachments: Select this check box to include Attachments in the search.

Note: Attachments must be imported and attached to Business Objects in
order to be searched. For example, if an Incident has an attached Word
document that contains the search words, that Incident will be included in
the search results.

◦ Limit Results: Select this check box to limits the results using defined criteria
(example: Show only Incidents created within the last year). Click the Query button
to define a Query that limits the search results.

◦ Default to Limited: Always selected.

◦ Limit Display Text: Provide the text to display above the search results so that
users know how the data was filtered.

6. Define options for the Specific Search (if used on Widget):
a. In the Options area, click the Specific Search page.

b. Define specific search options:
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◦ Include All Of The Items Available In Quick Search As Individual Specific Options: Select
this check box to include the Business Objects that were defined on the Quick Search
page. Each of these objects will be available in a drop-down on the Widget and can be
selected and searched individually.

◦ Include All Standard Options Available To User As Specific Options: Select this check
box to include all Business Objects with Quick Search enabled (Show in Quick Search
is checked on the Search Results page in the Business Object's properties window in a
Blueprint). Each of these objects will be available in a drop-down on the Widget and can
be selected and searched individually.

c. Select the items (Business Objects) to include in the search, and then define search options
for each (same as on the Quick Search page).

7. Click OK.7. 
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Create a Search Results List Widget
Use the Search Results List Widget Properties window (accessed from within the Widget Manager) to
create a Search Results List Widget.

To create a Search Results List Widget:

1. Create a Widget.

2. In the Type drop-down, select Search Results List.
3. Define general properties:

a. Default title:

Provide the title to display above the Widget. The font, style, and color is inherited from the
Dashboard on which this Widget resides.

Note: You can change this title (Controls text box) when you put the Widget on a Dashboard;
however, the title is not dynamic so changes will not be pushed back to this field. Likewise, if
you later change this title in Widget Properties, the changes will NOT be pushed out to all the
places it resides on Dashboards. For more formatting flexibility, use a "floating" Text Widget to
display a label or title for a Widget.

b. Business object:

Select the Business Object to search (example: Incident). Only one type of Business Object
can be selected. The drop-down displays only Major Business Objects. To display all Business
Objects, select the Show All check box.

4. Define display properties:
a. Specify how to display the search results (Grid or clickable links):

◦ Show Results in a Grid: Select this radio button to display the Search Results in a Grid,
and then define:

◦ Custom Grid:

Select this check box to display a custom Grid, rather than the system
administrator-defined default Grid.

Note: The system administrator has defined multiple Grids for the selected
Business Object. If no Grid is selected, the system administrator-selected default
Grid for the Business Object is used.

◦ Default to Showing Grouping:

Select this check box to automatically show Grid Grouping functionality on the
Search Results List Widget.

◦ Allow User to Show/Hide Grouping Options:

Select this check box to allow Users to enable Grid Grouping on Search Results
List Widgets if it is not automatically enabled.
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◦ Allow Drill-Down:

Select this check box to allow Users to double-click the Widget and be taken to
data represented by that Widget.

◦ Show Results as Links: Select this radio button to display each Search Result as a
clickable link.

b. Limit Results: Select this check box to limit the number of results in the Search Results List
Widget to a specified number, and then specify the number.

5. Define the Search Criteria (what to search for—example: Open Incidents). Data is located/filtered
using one the following options:

◦ Saved Search Query (Search Group): Click the Ellipses button  to open the Search Group
Manager, and then select an existing Search Group (saved Search Query) or create a Search
Group. Saved Searches can be used over and over in numerous places.

◦ Custom Search Query: Click the Custom Query button  to open the Custom Query
Builder, and then create a custom Search Query to use only for this scenario.

6. Define a timeframe for the Search Query (Date Range area):
a. Select a range option, either:

◦ Range: Select this radio button to define a date range for the Query, and then select an
existing timeframe (example: Anytime or Previous Year), or click the New button to
define a new timeframe.

◦ User Selectable: Select this radio button to allow the User/Customer to select the date

range from a drop-down. Then, click the Ellipses button  to open the Multiple Date
Ranges window and select the date ranges to include in the drop-down.

b. Field used for date range: Select the Field to use to give the range perspective (example:
LastModDateTime gives Previous Year perspective).

7. Define how often to refresh the Widget:
a. Refresh every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

8. Click OK.8. 
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Create a Twitter Feed Widget
Use the Twitter Feed Widget Properties window (accessed from within the Widget Manager) to create a
Twitter Feed Widget.

To create a Twitter Feed Widget:

1. Create a Widget.

2. In the Type drop-down, select Twitter Feed.

3. Select the CSM Twitter account to use:

a. Account: Click the Ellipses button  to open the Twitter Account Manager, and then select
an existing Twitter Account or create a new Twitter Account.

4. Specify the Tweets to show on the Widget, either:
◦ Show user’s Tweets: Select this radio button to display all the Tweets from the named Twitter

Account. If you select this option, you can also specify whether or not you want to include
Retweets. A Retweet is a Tweet from a different user that the current user re-transmits from
within their own account to their own followers.

◦ Show Search results: Select this radio button to display all Tweets that meet the specified
criteria, and then specify the criteria. The criteria can be simple words, hashtags, or any other
supported Twitter search.

5. Specify the maximum number of Tweets to show:
a. Max Tweet to Show: Provide a number.

6. Specify a custom link color to use in the Widget:
a. Custom link color: Select this check box to use an alternate color for Twitter links (by default,

links in the title and the body of each Tweet use the system-defined color for links. However,
depending on the rest of your color selections, these links might be hard to read). Click the
Color Selector button  to open the Color Selector, and then select a link color, either:

◦ Web:

Set of named Web-safe colors.

◦ Custom:

Customized Red, Green, Blue (RGB) colors.

7. Define how often to refresh the Widget:
a. Refresh every:

Select this check box to refresh the content according to a defined time period, and then
provide the refresh timeframe (every x hours or minutes).

8. Select one or more One-Steps to initiate from the Widget (Create actions area):
a. Click the Add button to launch the One-Step Manager, and then select one or more existing

One-Steps, or create a new One-Step.

b. Click OK.b. 
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Tips: Click the Edit button to Edit a One-Steps in the list; click the Remove button to remove a
selected One-Step from the list. Use the Up/Down arrows to reorder the One-Steps in the list.

9. Click OK.9. 
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Create a Shape Widget
Shape Widgets are not named and saved; they are simply dragged onto a Dashboard and customized for
that particular Dashboard. For detailed information, refer to Add a Shape Widget to a Dashboard.
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Create a Tab Group Widget
Use the Tab Group Properties window (accessed from within the Widget Manager) to create a Tab Group
Widget.

To create a Tab Group Widget:

1. Create a Widget..
2. Select a Tab Position to indicate where the tabs will be oriented on the Widget.
3. Create, populate, and arrange tabs in the Tabs section.

a. Use the New Tab and Delete Tab buttons to create and delete your tabs. Create at least one
tab in order to save the Widget.

b. Enter a name in the Tab Name field.
c. Select a Content Type of Plain Text or Rich Text.
d. Enter display content in the Content Pane. To enter Rich Text content, click the Rich Text

Zoom icon .
4. Click OK.
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Configuring Widgets
Widget security rights are configured in CSM Administrator. See Dashboard Security Rights.

CSM 9.3.0 Features 1599

CSM 9.3.0 Features

https://help.cherwell.com/csh?topicname=configure_dashboard_security_rights

	CSM Features
	Adaptive Layouts
	About Adaptive Layouts
	Using Adaptive Layouts
	Adaptive Forms Scenarios

	Managing Adaptive Layouts
	Design Features for Adaptive Forms
	Managing Controls in Adaptive Layouts

	Adaptive Layout Properties
	Defining Adaptive Layout Properties Using Device-Independent
    Pixels

	Create an Adaptive Layout
	Edit an Adaptive Layout
	Delete an Adaptive Layout
	Adaptive Layout Preset Manager
	Create an Adaptive Layout Preset
	Edit an Adaptive Layout Preset
	Delete an Adaptive Layout Preset



	Approvals
	About 
    Approvals
	Approvals Good to Know

	Using Approvals
	Approval Form

	Managing Approvals
	Approval Editor
	Open the Approval Editor
	Approval Block Editor
	Open the Approval Block Editor
	Add an Approval to a Business Object
	Define an Approval Relationship
	Define an Approval Block ID Field
	Define Approval Configuration for a Business Object
	Define an Approval E-mail
	Create/Edit an Approval Block




	Define Approval Block Condition Properties
	Define Approver Properties
	Define Approval Block Action Properties
	Attachments
	About 
    Attachments
	Attachments Good to Know

	Using Attachments
	View an Attachment
	View Attachment Properties
	E-mail an Attachment
	Record Attachments
	Attach a Record to Another Record
	Import and Attach a File to a Record
	Link a File to a Record
	Attach a Web Page to a Record
	Attach an Image from the Clipboard to a Record
	Create a Shortcut to an Attachment
	Remove an Attachment


	Managing Attachments
	Open the Attachment Manager
	Create a System Attachment
	Import Attachments from a Directory

	Configuring Attachments

	Business Hours
	About 
    Business Hours
	Business Hours Good to Know

	Managing Business Hours
	Open the Business Hours Manager
	View Business Hours
	Create Business Hours

	Configuring Business Hours

	Business Objects
	About 
    Business Objects
	Major Business Objects
	Supporting Business Objects
	Lookup Business Objects
	Group Business Objects
	Business Object Views
	Open the View Manager
	Create/Edit a Business Object View

	Business Objects Good to Know

	Using Business Objects
	Managing Business Objects
	Object Manager
	Open the Object Manager
	Business Object Editor
	Open the Business Object Editor
	Open the Business Object Properties Window
	Create/Edit a Business Object
	Define Basic Business Object Properties




	Define General Properties for a Business Object
	Define Process and Procedure Help Properties for a Business
    Object
	Define Group Properties for a Business Object
	Define Lifecycle Properties for a Business Object
	Define Search Results Properties for a Business Object
	Define Attachments Properties for a Business Object
	Define Database Properties for a Business Object
	Define History Properties for a Business Object
	Define Record Locking Settings for a Business Object
	Define Localization Properties for a Business Object
	Define Advanced Properties for a Business Object
	Define Menu Actions for a Business Object
	Define Task Pane Actions for a Business Object
	Define Toolbar Actions for a Business Object
	Define Context Menu Actions for a Business Object
	Define Print Options for a Business Object
	Define Automatic Actions for a Business Object
	Define General Properties for a Date/Time Field
	Define General Properties for a Number Field
	Define General Properties for a Text Field
	Define General Behaviors for Fields
	Define Field Behaviors Based on Lifecycle State
	Define Validation Properties for a Field
	Define Auto-population Properties for a Field
	Group Map Manager
	Open the Group Map Manager
	Create a Group Map
	Define Group Properties for a Field
	Storing Foreign Keys for Validated and Auto-populated Fields
	Defining Foreign Key Relationships
	Example: Defining a Foreign Key Relationship for Asset Status
    Field
	Blueprint Scan Errors for Foreign Key Relationships
	Create a Relationship Using the Relationship Wizard
	Create a Relationship Using the Relationship Properties Window
	Define General Properties for a Relationship
	Define Link Properties for a Relationship
	Define Database Properties for a Relationship
	Define Auditing Properties for a Relationship
	Define Advanced Properties for a Relationship
	Field Form Controls
	Field Form Control Properties
	Standard Form Controls
	Special Form Controls
	Form Menu Bar Item
	Form Editor Toolbar
	Form Editor Behaviors
	Select a Form Background Color
	Add a Form Control to a Form
	Add a Field Form Control to a Form
	Add a Standard Form Control to a Form
	Add a Banner Control to a Form
	Add a Button Control to a Form
	Add a Group Box Control to a Form
	Add an Image Control to a Form
	Add a Label Control to a Form
	Add a Link Label Control to a Form
	Add a List Box Control to a Form
	Add a Radio Button Control to a Form
	Add a Shape Control to a Form
	Add a Special Form Control to a Form
	Add an Embedded Form Control to a Form
	Add a Matrix Selector Control to a Form
	Add a Related Item Selector Control to a Form
	Define How a Control Looks and Behaves on a Form
	Define and Format Control Text
	Define a Tooltip for a Control
	Size A Control
	Select a Background, Foreground, and Border Color for a
	 Control
	Select a Border Style for a Control
	Add an Image to a Control
	Align a Control
	Anchor a Control
	Layer a Control
	Define Visibility for a Control
	Enable/Disable a Control
	Set Tab Order on a Form
	Make a Form the Default Form
	Define General Tab Properties for a Form Arrangement
	Define Tab Contents Properties for a Form Arrangement
	Define Tab Filter Properties for a Form Arrangement
	Define Tab Relationship Options for a Form Arrangement
	Define General Splitter Properties for the Form Arrangement
	Define Splitter Position Properties for the Form Arrangement
	Define Stacked Zone Options for a Portal Form Arrangement
	Calendars
	About 
    Calendars
	Tour a Calendar

	Using Calendars
	View a Calendar
	Change the Calendar View
	View/Edit a Calendar Item
	Add a Single Calendar Item
	Navigate through Calendar Items
	Show/Hide a Calendar Item
	Adjusting Gantt View Time Scales

	Managing Calendars
	Open the Calendar Manager
	Create a Calendar
	Create a Set of Calendar Items

	Configuring Calendars
	Setting Default Calendars
	Select a Default Global Calendar
	Select a Default Role Calendar
	Select a Default User Calendar



	Color Selector
	About the Color Selector

	Counters
	About 
    Counters
	Counters Good to Know

	Using Counters
	View a Counter
	Add a Counter to a Stored Expression
	Add a Counter to a Custom Expression

	Managing Counters
	Open the Counter Manager
	Create, Reset, or Change a Counter
	Reset a Record ID Counter


	Configuring Counters

	Dashboards
	About 
    Dashboards
	Tour a Dashboard
	Dashboards Good to Know
	Dashboard Filtering
	Dashboard Themes
	Heads-Up Display (HUD)
	Dashboard Drill-Down
	Dashboard Refresh
	OOTB Dashboards
	OOTB Global IT Dashboard
	OOTB My Work Dashboard
	OOTB Reporting Dashboard
	OOTB Technician Dashboards
	OOTB IT Management Dashboards


	Using Dashboards
	View a Dashboard
	Filter a Dashboard
	Drill Down into Dashboard Data
	Initiate a One-Step/Action from a Dashboard
	Manually Refresh a Dashboard
	Select a User Dashboard Theme
	Set the Current Dashboard to be the Default

	Managing Dashboards
	Open the Dashboard Manager
	Dashboard Editor
	Dashboard Editor Toolbar
	Dashboard Editor Behaviors
	Dashboard Editor Keyboard Shortcuts

	Open the Dashboard Editor
	Design a Dashboard
	Dashboard Design Considerations
	Dashboard Design Tips

	Create/Edit a Dashboard
	Select a Dashboard Background Color
	Size a Dashboard Background
	Add a Widget to a Dashboard (General)




	Add a Button Widget to a Dashboard
	Add an Image Widget to a Dashboard
	Add a Link Widget to a Dashboard
	Add a Text Widget to a Dashboard
	Add a Shape Widget to a Dashboard
	Define and Format Widget Text
	Size a Widget
	Select a Background, Foreground, and Border Color for a Widget
	Select a Background Style and Gloss for a Widget
	Select a Border Style for a Widget
	Add an Image to a Widget
	Align a Widget
	Anchor a Widget
	Layer a Widget
	Define Visibility for a Widget
	Dashboard Viewer Menu Bar
	Dashboard Viewer Behaviors
	Document Repositories
	About 
    Document Repositories
	Document Repositories Good to Know

	Using Document Repositories
	View a Document Repository

	Managing Document Repositories
	Open the Document Repository Manager
	Create a Document Repository
	Add a Document (Attachment) to a Document Repository

	Configuring Document Repositories

	E-mail
	About 
    CSM E-mail
	CSM E-mail Good to Know
	CSM E-mail Features
	About 
    CSM E-mail Accounts

	Using E-mail Accounts
	E-mail Message Window
	Send an E-mail from within 
    CSM
	Select E-mail Recipients from the 
    CSM Address Book
	Add an Attachment to an E-mail
	Define Where to Store E-mail History

	Track E-mail Correspondence in Journal - Mail History Records

	Configure a Personal E-mail Account
	Define Personal POP or IMAP Account Settings
	Define Personal Microsoft Exchange Account Settings
	Define Options for a Personal E-mail Account

	About the 
    Cherwell Outlook Add-In
	Outlook Add-In Good to Know
	Cherwell Outlook Add-In Interface
	Tour the 
    Cherwell Outlook Add-In

	Using the 
    Cherwell Outlook Add-In
	Link Outlook E-mails to Customers and 
    CSM Business Objects
	Interact with 
    CSM Business Object Records from Outlook
	Add Links and Attachments to Outgoing E-mails
	Track Outlook E-mail Correspondence in Journal - Mail History
    Records



	Expressions
	About 
    Expressions
	Expressions Good to Know

	View an Expression
	Managing Expressions
	Open the Expression Manager
	Create an Expression
	Define an Aggregate Expression
	Define a Case Expression
	Define a Counter Expression
	Define a Date/Time Expression
	Define a Duration Expression
	Define a Logical Expression
	Define a Numerical Expression
	Define a Text Expression
	Define a User/Customer Data Expression


	Configuring Expressions

	Formats
	About 
    Formats
	Formats Good to Know

	Using Formats
	View a Format
	Add a Format to a Field

	Managing Stored Formats
	Open the Stored Format Manager
	Create a Stored Format


	Grids
	About 
    Grids
	Tour a Grid
	Grid Persistence
	About Grid Filtering
	Grids Good to Know

	Using Grids
	Print a Grid
	Export a Grid
	Filter a Grid
	Group a Grid
	Reset to the System Grid Definition
	Revert to a Personal Grid Definition

	Managing Business Object Grids
	Grid Editor
	Create/Edit a Business Object Grid
	Define Business Object Grid Options
	Make a Grid the Default Grid


	Configuring Grids

	HTML Pages
	About 
    HTML Pages
	HTML Pages Good to Know

	Managing HTML Pages
	Open the HTML Page Manager
	HTML Page Editor
	Create an External HTML Page
	Create an Internal HTML Page

	Using HTML Pages
	Configuring HTML Pages

	Image Manager
	Item Managers
	About 
    CSM Item Managers
	CSM Item Manager Main Window (Typical)
	CSM Item Manager Menu Bar (Typical)
	CSM Item Manager Toolbar (Typical)
	CSM Item Manager Search Control
	CSM Item Manager Tree




	CSM Item Manager Tree Context Menu
	CSM Item Manager Main Pane Context Menu
	Sort a 
    CSM Item Manager Grid Column
	Knowledge
	About 
	 Knowledge
	Knowledge Good to Know

	About Knowledge Articles
	Knowledge Article Good to Know
	Knowledge Article Features and Capabilities
	Knowledge Article Workflow
	Logging Knowledge Articles
	Log a Knowledge Article
	Log a Knowledge Article - Detailed
	Knowledge Article Design Ideas

	Knowledge Article Features
	Knowledge Article Form
	Knowledge Article Portal Form
	Knowledge Article Journals
	Knowledge Article Approval Process
	Knowledge Management Dashboard
	Knowledge Article 
    One-Steps
	Knowledge Article Search Groups
	Knowledge Article Reports
	Knowledge Management Security




	Knowledge Team
	Metrics
	About 
    Metrics
	Metric Caching
	Metric Example
	Metrics Good to Know

	Using Metrics
	View a Metric
	Use Metrics in Gauge Widgets
	Use Metrics in Expressions
	Use Metrics in a Query
	OOTB Metrics
	OOTB Change Metrics
	OOTB Incident and Service Request Metrics
	OOTB Portal Metrics


	Managing Metrics
	Open the Metric Manager
	Create a Metric
	Creating a Query Value Metric
	Creating a Calculated Metric
	Using a Metric Within a Metric


	Configuring Metrics

	Modifiers
	About 
    Modifiers
	Modify/Format Value Window
	Modifier Types
	Text Modifiers
	Date/Time Modifier




	Date/Time Modifier Formats
	Numeric Modifier Formats
	One-Steps/Actions
	About Actions
	Actions Good to Know

	Managing Actions
	Action Manager
	Actions Available from the Action Manager
	Open the Action Manager
	Actions Menu
	Command Manager
	Open the Command Manager
	Add Actions to 
    CSM Areas
	Add an Action to a 
	 CSM Desktop Client Toolbar
	Add an Action to a 
	 CSM Task Pane
	Add an Action to a Dashboard
	Add an Action to a 
    One-Step
	Add an Action to an Automation Process
	Add an Action to a Business Object
	Add an Action to a Customer Portal
	Add an Action to 
    Cherwell Mobile


	About 
    One-Steps
	One-Steps Good to Know
	One-Steps and Record Locking

	Using 
    One-Steps
	View a 
    One-Step
	Run a 
    One-Step from the 
    One-Step Manager
	Run a 
    One-Step from within 
    CSM

	Managing 
    One-Steps
	Open the 
    One-Step Manager
	One-Step Editor
	One-Step Editor Toolbar
	Available 
    One-Step Editor Actions

	Open the 
    One-Step Editor
	Create/Edit a 
    One-Step
	Define General Properties for a 
    One-Step
	Define the Conditions for a One-Step
	Define the Annotations for a One-Step
	Action Attachments
	Define Actions for a 
    One-Step




	Define a Launch a URL Action for a 
    One-Step
	Define a Print Action for a 
    One-Step
	Define a Run a Program Action for a 
    One-Step
	Define a Run a Report Action for a 
    One-Step
	Define a Send a Tweet Action for a 
    One-Step
	Define a Send an E-mail Action for a 
    One-Step
	Define a Show a Pop-Up Action for a 
    One-Step
	Define a Write to a File Action for a 
    One-Step
	Create a Temporary File
	Define a Create a New Business Object Action for a 
    One-Step
	Define a Create a New Child Business Object Action for a 
    One-Step
	Define a Delete a Business Object Action for a 
    One-Step
	Define a Go to a Record Action for a 
    One-Step
	Define a Link/Unlink Business Object Action for a 
	 One-Step
	Define a Step Through Children Action for a 
    One-Step
	Define a Transfer Attachments Action for a 
    One-Step
	Define a Transfer Related Business Objects Action for a 
    One-Step
	Define an Update a Business Object Action for a 
    One-Step
	Define a Work with a Queue Action for a 
    One-Step
	Define a Call a Web Service Action for a 
	 One-Step
	Web Service Good to Know
	Set Up a Web Service
	Open the Web Service Manager
	Define a Decide Between Multiple Cases Action for a 
    One-Step
	Define an Excel Merge Action for a 
    One-Step
	Create an Excel Template
	Excel Merge Template Functions
	Define an Execute a Command Action for a 
    One-Step
	Define a Go to a Field Action for a 
    One-Step
	Define a Go To Action for a 
    One-Step
	Define a Run another 
    One-Step Action for a 
    One-Step
	Define a Step Through Collection Action for a 
    One-Step
	Define an Update a Variable or Stored Value Action for a 
	 One-Step
	Defining Actions Using XML Collections and JSON Arrays
	Prompts
	About 
    Prompts
	Prompts Good to Know

	Using Prompts
	View a Prompt
	Enter Data into a Prompt

	Managing Prompts
	Create a Prompt

	Web Service Lookup Example

	Queues
	About 
    Queues
	Queues Good to Know

	Using Queues
	View a Queue
	Queue Pane
	Define Queue Pane Preferences
	Add a Record to a Queue
	Remove a Record from a Queue
	Check Out a Record from a Queue

	Managing Queues
	Open the Queue Manager
	Create a Queue
	Define General Properties for a Queue
	Define Behavior Properties for a Queue
	Define History Properties for a Queue

	Add a Queue to the Queue Pane
	Open Queue as a Group
	Open Queue as a Specific Group

	Configuring Queues
	Configure Global User Queue Settings
	Open the User Queue Settings Window
	Define User Queue History Settings
	Transfer Ownership When Record is Placed in User Queue


	About Queue Groups
	Queue Groups Good to Know

	Viewing Queue Groups
	Managing Queue Groups
	Open the Queue Group Manager
	Create a Queue Group


	Record Locking
	About 
    Record Locking
	Record Locking Good to Know

	Using Record Locking
	Manually Lock a Record
	Manually Unlock a Locked Record

	Managing Record Locking
	Use the Record Locking Manager
	View and Manually Unlock All User Locks
	View and Manually Unlock All Global Locks

	Configuring Record Locking
	Enable Record Locking

	Troubleshooting Record Locking

	Reporting
	About Reporting
	Out of the Box (OOTB) Reports
	Report Alternatives
	Reporting Good to Know

	Tour the Report Suite
	Report Wizard
	Report Designer
	Report Bands

	Report Runner

	Creating Reports
	Opening the Report Wizard
	Creating a New Report Using the Report Wizard
	Select a Reporting Tool in the Report Wizard
	Select a Business Object and Search Group in the Report Wizard
	Select Fields for the Report in the Report Wizard
	Create Calculated Fields for Reports in the Report Wizard
	Select Sort Fields in the Report Wizard
	Set up Report Grouping in the Report Wizard
	Pick a Date/Time Format for Grouping Fields in the Report
    Wizard
	Set Report Title, Header, and Footer in the Report Wizard
	Add a Chart to the Report in the Report Wizard

	Link an External Report to CSM Using the Report Wizard
	Specify a Report Location in the Report Wizard


	Designing Reports
	Opening the Report Designer
	Working with Bands in Reports
	Adding Fields to a Report
	Formatting a Field
	Changing Styles for Bands
	Adding Relationships to Reports Using Detail Report Bands
	Changing the Visibility of a Band in a Report
	Modifying Page Number Properties

	Working with Groups in Reports
	Adding a Group Using the Report Designer
	Adding a Count to a Report Group

	Working with Charts in Reports
	Add Scripts to a Report
	Change Field Color Based on Value Script
	Chart Shown on Detail Report - Limit to Detail Report Data
    Script
	Chart Shown on Group - Limit to Group Data Script
	Drill Down - Hide/Show Detail Report Script
	Drill Down - Hide/Show Particular Fields Script


	Generating Reports
	Running Reports
	Run a Report from the Report Manager
	Run a Report from a Dashboard
	Run a Report from a One-Step

	Previewing Reports
	Printing Reports
	Print a Report from the Report Manager
	Print a Report from the Report Preview
	Print a Report from a Business Object Record

	Exporting Reports
	Export a Report from the Report Manager
	Export a Report from the Report Designer

	Scheduling a Report

	Managing Reports
	Editing Report Properties
	Opening the Report Manager
	Report Styles Manager
	About Report Styles
	Report Styles Good to Know
	Define Report Styles Using the Report Styles Manager




	Define General Options for Report Styles
	Define Page Options for Report Styles
	Define Group Options for Report Styles
	Define Column Headers for Report Styles
	Define Data Options for Report Styles
	Define Detail Report Options for Report Styles
	Define Chart Options for Report Styles
	Rich Text
	About 
    Rich Text
	Rich Text Good to Know

	Using Rich Text
	Use Rich Text in Business Object Fields
	Use Rich Text in Knowledge Articles
	Create 
    One-Steps that Use Rich Text Fields
	Use Rich Text in E-mails

	Configuring Rich Text
	Enable Rich Text on Business Object Fields
	Define Rich Text Settings for E-mails


	RSS Feeds
	About RSS Feeds
	URLs for RSS Feeds
	Authentication Modes
	Authentication Examples

	Querying RSS Feeds
	Links for RSS Feeds

	Enabling RSS Feeds

	Searching
	About 
    Searching
	Search Queries
	Fields
	Operators
	Use All Words/Any Words

	Query Clauses
	Define a Comparison Clause
	Define a Group Clause
	Define an Ownership Clause
	Define a Related Clause
	Define a Queue Clause




	Define a Specific Queue
	Define a User Queue
	Define a Queue Group
	Define an Any Queue
	Navigate Search Results
	Stored Values
	About 
    Stored Values
	Stored Values Good to Know

	Using Stored Values
	View a Stored Value
	Assign a Value to a Stored Value

	Managing Stored Values
	Open the Stored Value Manager
	Create a Stored Value

	Configuring Stored Values

	System Functions
	About System Functions
	About the CurrentCulture System Function


	Table Management
	About 
    Table Management
	Table Management Interface
	Open the Table Management Interface
	Table Management Interface Behaviors

	Table Management Good to Know

	Using Table Management
	View Values in a Lookup Object
	Search for a Value in a Lookup Object
	Add a Value to a Lookup Object
	Edit a Value in a Lookup Object
	Delete a Value from a Lookup Object

	Configuring Table Management

	Themes
	About 
    Themes
	Dashboard Themes
	Dashboard Theme Properties

	Form Themes
	Forms Theme Properties

	Portal Themes
	Portal Theme Properties

	Themes Good to Know

	Using Themes
	Open the Theme Manager
	Color Palette Manager
	Color Palette Editor
	Configure Color Palette Security Groups
	Create Custom Color Palettes
	Assign a Color Palette to a Chart Widget


	Managing Themes
	Theme Editor
	Theme Editor Behaviors

	Open the Theme Editor
	Design a Theme
	Create a Theme
	Set/Reset a Theme for a View

	Configuring Themes

	Tokens
	About 
    Tokens
	Token Selector
	Open the Token Selector

	Token Context Menu
	Constraints and Operators
	Constraints

	Tokens Good to Know

	Using Tokens
	View a Token
	Add an Existing Token
	Format a Token
	Use a Counter Token
	Use a Prompt Token
	Use a Stored Value Token
	Use a System Function Token

	Managing Tokens
	Create a Token Using the Token Selector


	Visualizations
	About 
	 Visualizations
	Primary Object
	Link Chains
	Tour a Visualization
	Visualizations Good to Know

	Using Visualizations
	View a Visualization
	Change the Visualization Layout
	View Information about a Visualization Node
	Search for a Specific Record in the Visualization Window
	Go to a Record from the Visualization
	Show/Hide Visualization Links and Nodes

	Managing Visualizations
	Open the Visualization Manager
	Create a Visualization
	Define General Visualization Properties
	Define a Visualization Link Chain
	Define a Visualization Alert


	Configuring Visualizations
	Select a Default Global Visualization
	Select a Default Role Visualization
	Configuring Visualization Tooltips


	Widgets
	About 
    Widgets
	Action Catalog Widgets
	Browser Widgets
	Chart Widgets
	Stacked Bar/Column Charts

	Command Palette Widgets
	Filter Widgets
	Gauge Widgets
	Matrix Widgets
	RSS Feed Widgets
	Search Results List Widgets
	Search Widgets
	Twitter Feed Widgets
	Tab Group Widgets
	Standard Widgets
	Widgets Good to Know

	Using Widgets
	View a Widget

	Managing Widgets
	Open the Widget Manager
	Create a Widget (General)
	Create an Action Catalog Widget
	Define General Properties for an Action Catalog Widget
	Define Actions for an Action Catalog Widget
	Define Display Properties for an Action Catalog Widget
	Define Grouping Properties for an Action Catalog Widget




	Define Display Properties for an Action Catalog Group
	Define Options for a Bar, Column, Line, or Scatter Chart
    Widget
	Define Criteria (Data) for a Bar, Column, Line, or Scatter Chart
	 Widget
	Define the X-Axis Values for a Bar, Column, Line, or Scatter Chart
	 Widget
	Define the Y-Axis Values for a Bar, Column, Line, or Scatter Chart
	 Widget
	Define How Values are Grouped for a Bar, Column, Line, or Scatter
	 Chart Widget
	Define a Custom Color for an X-Value in a Bar, Column, Line, or
	 Scatter Chart Widget
	Define How Values are Combined for a Bar, Column, Line, or Scatter
	 Chart Widget
	Define Analysis for a Column, Line, or Scatter Chart Widget
	Define Drill-Down for a Bar, Column, Line, or Scatter Chart
    Widget
	Define Point Label Formats for a Bar, Column, Line, or Scatter Chart
	 Widget
	Define Display Properties for a Bar, Column, Line, or Scatter Chart
    Widget
	Define Options for a Doughnut/Pie Chart Widget
	Define Criteria (Data) for a Doughnut/Pie Chart Widget
	Define Slices for a Doughnut/Pie Chart Widget
	Define the Size of Slices for a Doughnut/Pie Chart Widget
	Define a Custom Color for a Slice in a Doughnut/Pie Chart
	 Widget
	Define How Values are Combined for a Doughnut/Pie Chart Widget
	Define Drill-Down for a Doughnut/Pie Chart Widget
	Define Criteria (Data) for a Pipeline Chart Widget
	Define Slices for a Pipeline Chart Widget
	Define Options for a Pipeline Chart Widget
	Define the Size of Slices for a Pipeline Chart Widget
	Define a Custom Color for a Slice in a Pipeline Chart Widget
	Define Drill-Down for a Pipeline Chart Widget
	Define a Numeric Column for a Matrix Widget
	Define a Calculate Column for a Matrix Widget
	Define an Image Column for a Matrix Widget
	Define a Text Column for a Matrix Widget
	Define a Value Bar Column for a Matrix Widget
	Define a Ratings Column for a Matrix Widget

